HT3 User Guide

HT3 Version 3.1.6 | © 2013 Data Flow Systems, Inc.
# Table of Contents

## Part I Preface

## Part II About Your System

## Part III Getting Started

1. Workstation Configuration
2. Logging In and Out
3. Interface

## Part IV Configuring Your System

1. Configuration Editor Overview
2. Account Lockout Policy
   - How the Lockout Policy Works
   - Creating a Lockout Policy
   - Resetting an Account
   - Editing Your Lockout Policy
   - Configuring the Lockout Alarm
3. User Accounts
   - Creating a User
   - Changing a User’s Partition and Permissions
   - Changing a User’s Password
   - Deleting a User
4. Partitions
   - Creating a Partition
   - Modifying a Partition
   - Deleting a Partition
5. Network Routing
   - Configuring Network Routing
6. Drivers
   - Data Flow Systems (DFS) Driver
   - Derivative Fractional Protocol (DFP)
   - Network Derivative Fractional Protocol (NetDFP) Driver
   - Modbus Driver
   - Network Interface Module (NIM) Driver
   - Motorola Driver
   - Allen-Bradley Driver
7. Stations
   - Adding a DFS or DFP Station
   - Adding a NetDFP Station
   - Adding a Modbus Station
   - Adding a Motorola Station
   - Adding a NIM Station
   - Choosing Station Names
Part V Using Status, Reporting and System Tools

1 Using Status Viewers .......................................................... 234
   System Statistics ............................................................. 235
   Custom Screen Viewer ................................................... 237
   Station Status ............................................................... 238
   Alarm Viewer ................................................................. 241
   Camera Viewer .............................................................. 244

2 Analyzing Data with Trends ................................................ 247
   Opening Trender ............................................................ 247
   Trender's Interface ......................................................... 247
   Creating a Trend ............................................................ 253
   Adding Address(es) to a Trend......................................... 254
   Adjusting Trend Properties ............................................. 255
   Adjusting Start and End Dates ........................................ 257
   Zooming In and Out ....................................................... 257
   Panning Backward and Forward .................................... 257
3 Creating and Viewing Reports ................................................................. 265

- Analog Flow Report ........................................................................... 266
- Comment Log .................................................................................... 268
- Derived Flow Report ......................................................................... 270
- Detail Report ..................................................................................... 271
- Digipeat Map .................................................................................. 273
- Force Main Report ............................................................................ 274
- Min Max Average Report ................................................................ 276
- Modbus Map ................................................................................... 277
- Pulse Report ..................................................................................... 278
- Pump Activity Report ........................................................................ 280
- Snapshot Report ............................................................................... 285
- Station Configuration Report ............................................................ 287

Advanced Reporting Functions and Topics .......................................... 288

- Advanced Reporting Tool................................................................. 288
- Bar and Line Charts ......................................................................... 299
- Purge Schedules ............................................................................... 301

Beta Reports .......................................................................................... 302

- Access Log (Beta Reports) ............................................................... 304
- Accumulator (Beta Reports) ............................................................. 307
- Active Alarms (Beta Reports) .......................................................... 312
- Alarm Log (Beta Reports) ............................................................... 316
- Analog Flow (Beta Reports) ............................................................. 320
- Control Log (Beta Reports) .............................................................. 325
- Derived Flow (Beta Reports) ............................................................ 329
- Detail (Beta Reports) ........................................................................ 334
- Force Main (Beta Reports) ............................................................... 339
- Min Max Average (Beta Reports) .................................................... 343
- Pulse (Beta Reports) ......................................................................... 347
- Pump Activity (Beta Reports) ......................................................... 352
- Radio Errors (Beta Reports) ............................................................. 360
- Snapshot (Beta Reports) .................................................................. 368
- Opening and Deleting Saved Reports ............................................. 373

4 Using System Troubleshooting and Maintenance Tools .................. 375

- Telemetry Traffic Tool ...................................................................... 376
- System Control Center ................................................................... 383
- File Upload Utility ............................................................................ 386
- File Download (and Delete) Utility .................................................. 390

Module Patching Utility ...................................................................... 394

- Opening the Module Patching Utility ............................................. 395
- Importing Patches .......................................................................... 397
- Deleting Imported Patches ............................................................... 398
- Determining if a Module Requires Patching .................................... 398
- Updating a Patch .............................................................................. 400
- Removing a Patch ........................................................................... 402
- Updating a NIM ............................................................................... 403
- Viewing Communication Status ...................................................... 404
- Viewing the Patch Log .................................................................... 405
- Reloading the Database ................................................................... 405
Part VI PCU Editor

1 Introduction .................................................................................................................. 413
   Opening PCU Editor .................................................................................................. 413

2 Getting Around PCU Editor ......................................................................................... 414
   The User Interface .................................................................................................. 414
   Menus ....................................................................................................................... 415
      File Menu ............................................................................................................. 415
      Edit Menu ............................................................................................................ 415
      PCU Menu ........................................................................................................... 415
      Help Menu .......................................................................................................... 415
   Configuration Options ............................................................................................... 417
      Auxiliary Alarm .................................................................................................... 417
      Auxiliary Delay .................................................................................................... 417
      Auxiliary Delay in Seconds ................................................................................... 417
      Auxiliary Trigger .................................................................................................. 417
      Comments ............................................................................................................. 418
      Configurable Values ............................................................................................... 418
      Configuration Name / Lock ................................................................................... 420
      Control ................................................................................................................... 421
      Enable .................................................................................................................... 421
      Fault Cycle .......................................................................................................... 423
      Pumps ..................................................................................................................... 424
      Transducer ............................................................................................................ 424

3 Configuring a PCU ...................................................................................................... 426

4 Saving a PCU Configuration ...................................................................................... 430

5 Downloading and Uploading PCU Configurations .................................................... 432

6 Editing a Configuration .............................................................................................. 434

7 Appendix .................................................................................................................... 435
   Calculating Flow Volume ......................................................................................... 435
   Keyboard Shortcuts ................................................................................................. 436

Part VII PLC Editor

1 Introduction .................................................................................................................. 439

2 Navigating PLC Editor ............................................................................................... 441
   Menus ....................................................................................................................... 441
   Table View .............................................................................................................. 442
   TCU 90000 View ..................................................................................................... 444

3 Using PLC Editor ...................................................................................................... 455
   With a PLC .............................................................................................................. 455
   With a TCU .............................................................................................................. 457

4 Appendix .................................................................................................................... 462
   Changing Timeout and Retries Count ...................................................................... 462
   TCU Address-Option-Value Map .............................................................................. 462
   Methods for Selecting Addresses ............................................................................ 465
   File Naming Conventions ......................................................................................... 465
# Part VIII  Screen Builder

## 1  Introduction

- Starting and Exiting Screen Builder ................................................................................. 470
- The Screen Builder Interface ............................................................................................. 470
  - File Menu ......................................................................................................................... 472
  - Edit Menu ......................................................................................................................... 472
  - Screen Menu ..................................................................................................................... 472
  - Object Menu ..................................................................................................................... 473
  - Align Menu ........................................................................................................................ 473
  - Static Menu ....................................................................................................................... 474
  - Digital Menu ..................................................................................................................... 474
  - Analog Menu ..................................................................................................................... 476
  - Pipe Menu ......................................................................................................................... 477
  - Help Menu ......................................................................................................................... 478

## 2  Object Types

- Common Fields ..................................................................................................................... 479
- Analog Objects ...................................................................................................................... 480
- Digital Objects ...................................................................................................................... 484
- Pipe Objects .......................................................................................................................... 487
- Static Objects ......................................................................................................................... 489

## 3  Screen Building Basics

- The Base and Partition Screens .......................................................................................... 493
- Creating a New Screen ......................................................................................................... 494
- Setting Screen Size ............................................................................................................. 494
- Saving a Screen or Screen File ......................................................................................... 494
- Opening a Screen or Screen File ....................................................................................... 497
- Working with Screen Parts (Template Files) ...................................................................... 498
- Deleting a Custom Screen ................................................................................................. 500
- Importing and Organizing Images ..................................................................................... 500
- Refreshing and Animating Screens .................................................................................... 503
- Changing Station Number References ............................................................................. 504
- Poll After Control ............................................................................................................. 505

## 4  Working with Objects

- Adding Analog Objects ........................................................................................................ 506
- Adding Digital Objects ....................................................................................................... 537
- Adding Pipe Objects .......................................................................................................... 562
- Adding Static Objects ......................................................................................................... 575
- Viewing Object Properties with Inspector ....................................................................... 595
- Editing Objects .................................................................................................................... 596
- Linking to Screens, Trends and Web (HTML) Pages ......................................................... 598
- Choosing Colors and Images .............................................................................................. 604
- Moving and Layering Objects ............................................................................................. 607
- Adding Network Camera Images to Screens ..................................................................... 610

## 5  Appendix

- Analog Object Properties .................................................................................................. 613
- Digital Object Properties .................................................................................................. 632
- Pipe Object Properties ..................................................................................................... 650
- Static Object Properties .................................................................................................... 657
- RGB Color Guide ............................................................................................................... 672
- Keyboard Shortcuts ........................................................................................................... 672
Part IX Virtual Logic Builder

1 Introduction and Overview

Opening Virtual Logic Builder .................................................. 677
Exiting Virtual Logic Builder ...................................................... 677

2 Getting Around Virtual Logic Builder ........................................ 678

The User Interface ...................................................................... 678
Virtual Logic Builder's Inspector .................................................. 679
Menus .......................................................................................... 681
Analog Menu.............................................................................. 681
Compare Menu........................................................................... 682
Digital Menu.............................................................................. 683
Edit Menu................................................................................... 685
File Menu.................................................................................... 685
Help Menu.................................................................................. 687
Ladder Menu.............................................................................. 687
Math Menu.................................................................................. 688
Module Menu.............................................................................. 689
Time/Date Menu........................................................................ 690

3 Ladder Building Components .................................................. 691

The Ladder (Rungs and Branches) .............................................. 691
Comments .................................................................................. 692
The “And” Function ................................................................... 693
The “Or” Function ..................................................................... 694
Analog Objects .......................................................................... 695
Analog Input.............................................................................. 695
Analog Out................................................................................. 696
Constant..................................................................................... 696
Deadband..................................................................................... 696
Examine Analog........................................................................ 697
Flow............................................................................................ 697
Move............................................................................................ 698
PID............................................................................................... 698
Selector....................................................................................... 699
Total............................................................................................ 700
Virtual Out (Analog)................................................................... 700
Digital Objects ........................................................................... 702
4-State....................................................................................... 702
Cycle............................................................................................ 703
Digital Input............................................................................... 703
Examine Off............................................................................... 704
Examine On............................................................................... 704
Latch............................................................................................ 705
Momentary Input........................................................................ 705
On Time...................................................................................... 706
One-Shot (DIFU)........................................................................ 707
Out.............................................................................................. 707
Out Not......................................................................................... 707
Retentive Timer.......................................................................... 708
Time Delay.................................................................................. 708
Virtual Out (Digital).................................................................... 709
Compare Operators .................................................................... 709
Math Operators ........................................................................ 710
4 Working with Ladders

- Saving Ladders
- Configuring Ladder Settings
- Downloading Module Information for Use in Ladders
- Adding Comments
- Adding Cross References to Ladders
- Checking Your Ladder
- Testing Your Logic
- Installing and Uninstalling Ladders
- Printing Ladders
- Duplicating a Ladder
- Deleting All Logic Generated by a Ladder Logic Program

5 Working with Objects

- Establishing a Naming Convention
- Object Address Requirements
- Adding and Deleting Components
- Defining an Object's Properties
- Editing an Object
- Inspector's Edit Menu
- Shortcut for Changing an Object's Name or Telemetry Address
- Selecting and Moving Objects

6 Editing Tools

7 Appendix

- Ladder Logic Examples
- Using Examine Objects
- Using Output Objects
- Using Time/Date Objects
- Using the Cycle Object
- Using the Latch Object
- Using the Move Object
- Sample Ladder - Irrigation System
- Editing Virtual Points and Auto Controls
- Timer and Counter Resets
- Retain Value After HSS Restart
- Keyboard Shortcuts

Part X Appendix

1 External Status Points
2 Modbus Emulation
3 Registry Editor
4 MySQL

- Downloading and Installing the MySQL ODBC Driver
- Overview of HT3's MySQL Tables
- Real-time Tables - Descriptions and Structure
- Configuration Tables - Descriptions and Structure
- Journal and Log Tables - Descriptions and Structure
- Retrieving Data from HT3's Tables
Part I
1 Preface

Purpose of This Guide

This guide provides users with the information needed to set up and operate HT3 -- the telemetry software used with DFS’ Hyper SCADA Server (HSS). HT3 enables you to configure, monitor, and control both network- and radio-based SCADA systems via a client network.

PDF Version

[Download a PDF version] of the HT3 User Guide.

The PDF version is also available on the DFS website. Visit [http://dataflowsys.com/support/literature.php](http://dataflowsys.com/support/literature.php)

Notice

Data Flow Systems assumes no responsibility for any errors which may appear in this document, nor does it make any commitment to update the information contained herein. However, questions regarding the information contained in this document are welcomed.

Data Flow Systems also reserves the right to make changes to the specifications of HT3 and its associated programs, and to the information contained in this document at any time without notice.

Warranty

DFS’ HT3 Telemetry Software program is warranted for as long as the system is in use by the Owner. All Telemetry Software upgrades are provided free of charge.

Contacts

Mail user feedback, bug reports, questions, and software suggestions to:

Data Flow Systems, Inc.
605 N. John Rodes Blvd.
Melbourne, FL 32934

You can also obtain support by:

- Visiting our web site ([http://www.dataflowsys.com](http://www.dataflowsys.com)) and clicking the "Help Desk" link.
- Sending email to: service@dataflowsys.com or sales@dataflowsys.com
- Calling us directly at 321-259-5009
Questions or Comments on This Manual

If you find a problem with any of the information in this manual or have suggestions on how it could be improved, please contact us at the address below:

Data Flow Systems, Inc.
Documentation Department
605 N. John Rodes Blvd.
Melbourne, FL 32934

Alternatively, email us at: documentation@dataflowsys.com
Part II
2 About Your System

HT3

HT3 is network-based SCADA software that can monitor and control remote, unmanned stations from a single location - the Hyper SCADA Server (HSS). The HSS is the central telemetry server and continually communicates with remote stations via a network and/or radio link.

HT3 is installed on the Hyper Server Module (HSM), which is the core component of the HSS. Users access HT3 from Windows-based workstations using a Java-enabled Internet browser, such as Microsoft Internet Explorer, Mozilla Firefox, or Opera. Connections to HT3 can be either via a local TCP/IP network or a PPP dial-up connection. In addition to an Internet browser, the following are required on HT3 workstations: Java Runtime Environment, Java Policy File, and Adobe Reader (see HT3 Plugins for more information).

The architecture of HT3 is open and modular, which enables DFS to easily change and extend the system. This configuration makes it possible for consulting engineers, and even end users, to customize HT3 to a greater extent than is possible with most other telemetry software packages.

At the core of the HT3 system is an HTTP server and the database management system named MySQL. Telemetry data, including configurations and historical information, is kept in a ODBC-compliant database format. This format allows easy access to telemetry data from third-party software, such as Microsoft Access and Excel. All of HT3’s applications communicate with the MySQL database manager. The applications store and retrieve data while the user accesses HTML pages to view status screens or perform system-configuration.

HT3’s interface is browser based. HTML, Java, and JavaScript - languages familiar to many who regularly use the Internet - are used to create the interface. Each application within HT3 is an applet - a small program written in Java that is meant to be used through a browser.

See the following sections for more information:

- Hyper SCADA Server
- Operating System
- Integration Ease
- MySQL
- Telemetry Tools

Hyper SCADA Server (HSS)

The Hyper SCADA Server (HSS) is a self-contained data collection and information server housed in a locked, wall-mounted enclosure. The core of the unit is the Hyper Server Module (HSM), which includes a CPU, two voice-grade modems, and the necessary network hardware. In addition to the HSM, the Hyper SCADA Server also features a Network Switch Module (NIM001-4), Network Fiber Modules (NIM001-3), power supply unit, backup battery, and surge suppressors. This combination of components provides a complete server with integral UPS function.
The HSS is the telemetry system's "command and control center." The HSM communicates via the client network; sending and receiving information from Windows-based workstations and telemetry hardware (network- and radio-based Remote Terminal Units and radio-based Central Terminal Units).

The HSS is compatible with any operating system, and the only additional software required is a Web browser (Microsoft Internet Explorer). For example, a computer that is running Windows NT and has Netscape Communicator installed can communicate with the HSS through HT3’s Web browser-based interface.

**Operating System**

The HSM uses SUSE Linux Enterprise 11 as its operating system. Linux is "open-source" or "free" software, which means its source code can be freely used, viewed, modified, and redistributed. Open-source software traditionally offers flexible licensing and more favorable pricing. Because its source code is available for viewing and modifying, open-source software is more secure, has fewer bugs, and can be tailored for specific applications.

DFS chose SUSE Linux Enterprise 11 as the HSM's operating system for several reasons:

- Efficiency and speed - Linux doesn't consume large amounts of hard drive space and computer resources.
- Robustness - Linux is a stable operating system, which results in fewer computer lockups and crashes.
- Security - Linux features a strong cryptography, which protects the system from hackers and viruses.
- Cost-effectiveness - Linux is a less costly operating system, and it includes many of the tools that must be bought separately when using other operating systems.

**Integration Ease**

The HSM uses Linux as its operating system, but the flexibility of Linux allows it to easily communicate with servers and computers that use other operating systems. In addition, all of the necessary HT3 software is installed on the HSM - not on workstations. A Windows-based computer that is connected to the network and has Internet Explorer 5.0 installed, can communicate with the HSM, and thus configure, control, and monitor telemetry hardware.

**MySQL**

HT3 incorporates an SQL database backend based on the database server engine MySQL. MySQL is ODBC (Open DataBase Connectivity) compliant, which allows external ODBC capable applications (for example, Intellution's iFix and Microsoft's Access) to "query" the HT3 database for current status, "set" control points, and examine alarm activity.
MySQL is a relational database management system, which means data is stored in separate tables, rather than in one large data table. These separate tables can then be linked using defined relationships. Creating relations between tables makes it possible to combine data from several tables when a query is performed. This structure adds speed and flexibility to the acts of retrieving and storing information.

**Telemetry Tools**

HT3 features numerous tools that enable you to configure, monitor, and control your system.

**Status Viewers and Analysis Tools**

These tools enable you to instantly see what's going on in your system.

- The System Stats Viewer (built with Screen Builder) displays information on the current status of important system-level points, including driver loop time, AC power and battery voltage, and CPU usage.
- Custom screens that you've created with Screen Builder.
- HT3-generated status screens for each configured station in your system.
- Trender enables you to create historical data trends for any telemetry point in your system. Users with Configure Telemetry permissions can save trends.
- Alarm activity (includes the ability to acknowledge alarms).
- Video from surveillance cameras installed on your network.

**Reports**

HT3 provides you with a variety of reports that allow you to monitor the activity and performance of your telemetry equipment. The reports gather and filter information, based on parameters you provide in the Report Request Form.

- Calculate the flow at sewage lift stations based on volume.
- Examine a detailed chronological listing of events.
- Totalize pulse counts from equipment such as rain gauges or flow totalizers.
- Evaluate the number of cycles, and average and total accumulated time for digital points.
- Categorize and totalize radio communication errors.
- View average and total flow rates for analog flow meters.
- Review a chronological listing of major events such as alarms and controls.
- View the configuration of a station organized by module (DFS stations) or I/O type (Modbus-type stations).
• View a list of all DFS points that have been mapped to Modbus registers (Modbus Emulation).

Troubleshooting and Maintenance

Included in HT3 are software tools that can aid you in troubleshooting and maintaining your system.

• Monitor radio communications between telemetry drivers and field hardware, control the value of digital and analog points, and set polling priority.
• Troubleshoot radio communication and other system errors from a remote location.
• Perform system functions such as stopping and starting the telemetry system, rebooting the Hyper Server Module, and testing the Hyper SCADA Server’s battery.
• Apply microprocessor code patches to modules.
• Upload custom screen images, HTML images, custom HTML pages, and TCU auto-download configuration files from the Hyper SCADA Server.
• Download report files (in .csv and .txt format) and ladder logic .vlb files from the Hyper SCADA Server.

System Configuration

HT3 provides a user-friendly method for configuring your system.

• Configure drivers, stations, modules, and points.
• Partition your system to reflect your operation’s setup. For example, fresh water and wastewater.
• Set up alarms that will alert you to conditions that require attention.
• Configure auto controls and scheduled controls that can help you further automate your system.
• Create keywords to simplify the reporting process.
• Set up user accounts.
• Create telephone call out lists for critical alarms.

System Building Tools

HT3’s Building Tools provide you with the tools to:

• Create graphical representations of your telemetry system. (Screen Builder)
• Remotely configure and update hardware set points. (PCU Editor and PLC/TCU Editor)
• Develop ladder logic programs that use virtual I/O to monitor and control your system. (Virtual Logic Builder)
Screen Builder lets you create a graphical representation of your telemetry system. By building a screen - using text, images, objects, and animation - and then linking the screen's components to actual telemetry points, you can get a quick, real-time view of your operation.

PCU Editor enables you to modify the operational set points of the Pump Control Unit (PCU), a microprocessor-based, solid-state, multi-pump controller, from the central computer or a networked workstation. The PCU provides all the functions necessary to monitor and control sewage lift stations and fresh-water tank filling operations.

PLC/TCU Editor enables you to configure PLC’s and TCU’s. PLC Editor uses telemetry to send and receive set point values and configuration information to and from the specified hardware, which allows the PLC/TCU to be updated remotely.

Virtual Logic Builder is a user-friendly application that enables you to construct "ladder logic"-style programs that run on the HT3 central computer. Ladder logic is a graphical (symbols and text) language that is used to plan, maintain and control industrial systems. Each rung of the ladder (hence the name - Ladder Logic) is used to control a single output.
3 Getting Started

The topics in this section provide information on configuring your computer to connect to the HT3 server, logging in and out of HT3, and also provides a brief overview of HT3’s interface.

Configuring a Windows Workstation

With the HT3 system, you can use Windows-based computers, or workstations, to access the Hyper Server Module (HSM), a Linux-based server that contains all vital HT3 information and data. You can have multiple Windows workstations connected to the HSM, and they can be located at sites removed from the HSM. A Windows-based workstation provides you with access to all HT3 functions.

Logging In and Out

HT3 is password protected to prevent unauthorized access to the system. A valid user account - login and password - are required. Once logged in, your actions within HT3 are only limited by the permissions assigned to your particular login account.

HT3 includes an optional, user-configurable account lockout mechanism that will lock out a user for a length of time after a number of unsuccessful login attempts. This mechanism will include an alarm that can be triggered when a user has been locked out and a means for unlocking the account using an Admin Reset Password.

HT3’s Interface

HT3’s interface is browser based. HTML, Java, and JavaScript - languages familiar to many who regularly use the Internet - are used to create the interface. Each application within HT3 is an applet - a small program written in Java that is meant to be used through a browser.
Workstation Configuration

A Windows-based computer (workstation) provides you with access to the Hyper SCADA Server (HSS) and the HT3 SCADA software.

Computers selected as workstations:

- Must meet certain requirements
- Must be configured to access HT3
- One computer should be designated as the primary workstation

If you are upgrading from HyperTAC II, review the information in Users Upgrading from HyperTAC II.

IPv4: The Hyper SCADA Server uses Internet Protocol version 4 (IPv4). Internet Protocol version 6 (IPv6) is disabled on the HSS.

<table>
<thead>
<tr>
<th>Primary workstation</th>
<th>We recommend that you designate one computer as a dedicated primary workstation. This computer's primary function is to interface with the HSS. It remains on at all times.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Multiple workstations</td>
<td>Multiple Windows workstations can connect to the HSS and HT3 through a local area network.</td>
</tr>
</tbody>
</table>

Requirements for Workstation Computers

<table>
<thead>
<tr>
<th>Recommended</th>
<th>Windows 7</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Most current version of Internet Explorer</td>
</tr>
<tr>
<td></td>
<td>Most current version of Java SE Runtime Environment (JRE)*</td>
</tr>
<tr>
<td>Minimum</td>
<td>Windows XP with SP2</td>
</tr>
<tr>
<td></td>
<td>Internet Explorer 8</td>
</tr>
<tr>
<td></td>
<td>Most current version of Java SE Runtime Environment (JRE)*</td>
</tr>
</tbody>
</table>

* As of this HT3 release, the JRE is at version 1.7_21. We recommend that you configure Java to update automatically in order to take advantage of new security measures introduced in each release.

Users Upgrading from HyperTAC II

<table>
<thead>
<tr>
<th>Hosts file</th>
<th>You do not need to edit the hosts files of existing workstations.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Java policy file</td>
<td>You will need to download and install a new Java policy file. See &quot;Installing the Java Policy File.&quot;</td>
</tr>
</tbody>
</table>
Verify that the most current version of the JRE is installed on the workstation. Visit http://www.oracle.com/technetwork/java/javase/downloads/index.html to determine what the most current version is.

Changes to Java and firewall settings may be required depending on the computer's current settings.

Review the information in:
- Installing the Java Runtime Environment
- Making Changes to Windows Firewall Settings

**Configuring a Windows Workstation to Access HT3**

Configuring a Windows computer for accessing HT3 requires the following steps:

1. Editing the hosts file
2. Installing the Java policy file
3. Installing the Java Runtime Environment (JRE)
4. Making changes to Windows firewall settings
5. Starting HT3

**Step 1: Editing the hosts file**

The hosts file is a text file on your Windows computer that contains IP address-to-hostname mappings. You can associate a name (for example, ht3) with the IP address of your HSS by adding an entry to the hosts file.

This mapping serves two purposes:

- Allows HT3 applications to save files on the workstation (applications such as Screen Builder, Logic Builder, PCU Editor, and PLC Editor).
- Allows you to use the hostname instead of an IP address to connect to your HSS and HT3 (for example, you will type http://ht3 in the browser’s address bar instead of http://192.168.10.65)

- Upgrading from HyperTAC II
  
  You do not need to edit the hosts files of existing workstations. Review Users Upgrading from HyperTAC II for important information on other changes that are required.

- Selecting a hostname
  
  The name in the hosts file must match a name in the Java policy file. If there isn’t a matching name, you won’t be able to save files from HT3 applications on your computer. The standard Java policy distributed with HT3 includes the following hostnames:
  - ht3
  - hypertacii
If you select a hostname other than one of these, you must edit the Java policy file. (Discussed in Installing the Java Policy File)

### Procedure for Editing the Hosts File

Review [Selecting a hostname](#) (above) before proceeding.

Repeat this procedure for every Windows user who is accessing HT3 from this workstation.

**IMPORTANT:** To edit the hosts file, you must run Notepad as administrator. To do this, you must right click the Notepad shortcut, select **Run as administrator**, and then browse to the hosts file.

1. Open the Windows Start menu.
2. Type *notepad* in the **Search** box.
   
   Notepad is listed at the top of the results under the heading Programs.
3. Right click Notepad and select **Run as administrator**.
4. Open the hosts file.
   
   In Windows 8, 7, Vista, and XP, the path to the hosts file is located at: C:\Windows\system32\drivers\etc\hosts
   
   If you don’t see the hosts file, select **All Files (*.*)** from the drop-down list next to the filename box.
5. Add a mapping entry to the file.
   
   a. Place your cursor on a line below the file’s comments – lines proceeded by a pound/hash sign (#).
   
   b. Type the IP address of the HSS.
   
   c. Press the Tab key.
   
   d. Type the hostname for the HSS (typically ht3).

   Repeat these steps if the user will be accessing more than one HSS (each HSS must have its own unique hostname).
6. Save the file. Use **File -> Save**; don’t use **Save As** (**Save As** saves the file as a text file).

### Step 2: Installing the Java policy file

The Java policy file (.java.policy) gives HT3’s Java applications permission to save and open files in specific directories on your workstation computer. It is designed to protect your computer from hostile Java applications that could try to access or damage the data on your computer (for example, to insert a virus).

The Java policy file affects HT3 Java-based applications:

- Screen Builder
- Logic Builder
- PLC Editor
- PCU Editor
- Module Patching tool

<table>
<thead>
<tr>
<th>Where Files from HT3 Applications Can Be Saved and Opened</th>
<th>HT3’s Java-based applications can only save and open files in the home directory (and all subfolders) of the Windows user currently logged in. (This is the Windows user name; not the HT3 user name.)</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Windows 8, 7, and Vista</strong></td>
<td>C:\Users&lt;username&gt;</td>
</tr>
<tr>
<td></td>
<td>(where <code>&lt;username&gt;</code> is the Windows user name of an individual who is accessing HT3 from this workstation)</td>
</tr>
</tbody>
</table>
You will get an “I/O error reading file…” error if you try to save or open a file from a different directory.

| Hostnames in Policy File and Hosts File Must Match | The policy file must contain a hostname that matches the one you gave to the HSS in the hosts file. If the hostnames do not match, you will get an “I/O error reading file…” error when trying to save or open a file in an HT3 Java application. |

### Downloading and Saving the Java Policy File

The link for downloading the Java Policy file is on the HT3 Plugins page. To get to the HT3 Plugins page, you must know the hostname of your HSS.

The HT3 Plugins page is located at:

```
http://<hostname>/ht3/plugins/
```

(for example, http://ht3/ht3/plugins)

Look for the section titled “Java Policy File.” The first step of the procedure has a link for downloading the policy file. Follow the instructions provided there and then return to this procedure.

If you need to edit the Java policy file (you used a hostname other than ht3, hypertacii, or hsm002), instructions are below. Otherwise, continue to the next step of this procedure, Installing the Java Runtime Environment (JRE).

### Editing the Java Policy File

The .java.policy file that you download from the HSS includes three default hostnames:

- ht3
- hypertacii
- hsm002

If you gave your HSS a different hostname in the hosts file (for example, ht3_north), you must edit the .java.policy file of each Windows user who is accessing HT3 from this workstation.

**IMPORTANT:** To edit the file, you must run a text editor, such as Notepad, as administrator. To do this, you must right click the Notepad shortcut, select Run as administrator, and then browse to the .java.policy file.

1. Open the Windows Start menu.
2. Type `notepad` in the **Search** box.
   
   Notepad is listed at the top of the results under the heading Programs.
3. Right click Notepad and select **Run as administrator**.
4. Open the .java.policy file.

<table>
<thead>
<tr>
<th>Windows 8, 7, and Vista</th>
<th>C:\Users&lt;username&gt;</th>
</tr>
</thead>
<tbody>
<tr>
<td>(where &lt;username&gt; is the Windows user name of the individual who will be accessing HT3 from this workstation; for example, C:\Users\Joe)</td>
<td></td>
</tr>
</tbody>
</table>

| Windows XP | C:\Documents and Settings |

**Note:** If you don’t see the .java.policy file, select All Files (*.*) from the drop-down list next to the filename box.

5. You only need to edit one line. The line takes the format:

```java
grant codebase "http://<hostname>/-"
```

(where <hostname> is the hostname of the HSS you are granting access to)

You will find several occurrences of this line. It appears at the beginning of the block of code for each default hostname (ht3, hypertacii, and hsm002).

A portion of a .java.policy file is shown below.

```java
*/ AUTOMATICALLY GENERATED ON Fri Oct 19 14:20:47 EDT 2001*/

grant codeBase "http://ht3/-" {
  permission java.awt.AWTPermission "accessClipboard";
  permission java.awt.AWTPermission "showWindowWithoutWarningBanner";
  permission java.io.FilePermission "C:\My Documents\-", "read, write";
  permission java.util.PropertyPermission "user.home", "read";
  permission java.lang.RuntimePermission "modifyThread";
  permission java.lang.RuntimePermission "modifyThreadGroup";
  permission java.net.SocketPermission "ht3:\", "accept, connect, listen, resolve";
  permission javax.sound.sampled.AudioPermission "record";
  permission java.io.FilePermission "C:\Documents and Settings\-", "read, write";
  permission java.io.FilePermission "C:\Users\-", "read, write";
  permission java.security.AllPermission;
};

grant codeBase "http://hypertacii/-" {
  permission java.awt.AWTPermission "accessClipboard";
  permission java.awt.AWTPermission "showWindowWithoutWarningBanner";
  permission java.io.FilePermission "C:\My Documents\-", "read, write";
  permission java.util.PropertyPermission "user.home", "read";
  permission java.lang.RuntimePermission "modifyThread";
  permission java.lang.RuntimePermission "modifyThreadGroup";
  permission java.net.SocketPermission "ht3:\", "accept, connect,

6. Find the "grant codebase" line for one of the defaults hostnames that you aren’t using and replace it with the hostname you assigned to your HSS.

**Only change the hostname (highlighted in yellow). Don't make changes to any other part of the code!**
7. Save the file. Use **File -> Save**; don’t use **Save As** (**Save As** saves the file as a text file).

### Step 3: Installing the Java Runtime Environment (JRE)

**Note:** You must have administrative permissions in order to install the JRE.

<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>To install, browse to where you saved the installation file. Double-click the file and follow the prompts.</td>
<td>To take advantage of new security measures introduced in each release, we recommend that you configure Java to update automatically.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Do I need the 32-bit or the 64-bit version?</th>
<th>Read this FAQ to determine if you need the 32-bit or 64-bit version of Java: <a href="http://java.com/en/download/faq/java_win64bit.xml">http://java.com/en/download/faq/java_win64bit.xml</a></th>
</tr>
</thead>
</table>

*Make sure you download the **JRE version not the Server JRE or the JDK version**. The JRE contains everything required to run Java applications on your workstation. The Server JRE is for deploying Java applications on servers; the JDK is for developing Java applications.*

After installation you must make changes to Java’s security settings.

1. Open the Windows Control Panel.
2. On the right side of the Control Panel home page, click **Small Icons** from the **View by** list.
3. Click **Java** to open the Java Control Panel.
4. Click the **Security** tab and verify that **Security Level** is set to **High**.
5. Click the **Advanced** tab. Scroll to the bottom of the list and select **Place Java icon in system tray**.
6. Click **OK**.
7. Close the Control Panel.
Step 4: Making changes to Windows firewall settings

Note: These changes are for Windows 7 and Windows 8 computers only.

Changes must be made to Windows Firewall's settings to allow the Java-based applications access through the firewall.

1. Open the Windows Control Panel.
2. Click **System and Security**.
3. Click **Windows Firewall**.
4. Click **Advanced Settings** (left side of window).
5. Click **Inbound Rules** (left side of window).
6. Right click **Inbound Rules** and choose **New**.
7. Click **Custom** and then click **Next**.
8. Click **This program path**.
9. Click **Browse** and browse to:
   - **For 64-bit Windows, browse to:** C:\Program Files (x86)\Java\jre7\bin\  
   - **For 32-bit Windows, browse to:** C:\Program Files\Java\jre7\bin\  
10. Select the java.exe file and then click **Open**.
11. Click **Next**.
12. Click **Next** again. (Make no changes on the **To which ports and protocols does this rule apply?** page.)
13. Under **Which REMOTE IP addresses does this rule apply to?** click **These IP addresses**.
14. Click **Add**... and type the IP address of the HSS or the IP address of the gateway to the HSS. You can also enter a range of IP addresses if needed. (Talk to your IT administrator if you aren't sure what to enter.)
15. Click **OK**. The IP address should appear in the box.
16. Click **Next**.
17. Click **Next** again. (Make no changes on the **What action should be taken when a connection matches the specified conditions?** page)
18. Click **Next** again. (Make no changes on the **When does this rule apply?** page)
19. Type Java in the **Name** box. The **Description** box is optional.
20. Click **Finish**.
Step 5: Starting HT3

1. If Internet Explorer is open, close it and restart it.

2. In the browser’s address box, enter:

   http://<hostname>

   (where <hostname> is the hostname you assigned to your HSS, for example http://ht3)

3. If you recently updated the Java Runtime Environment, you will see a dialog box similar to this.

   Select the I accept the risk and want to run this app check box and the Do not show this again for this app check box and click Run. (You may see this dialog box each time you update the Java Runtime Environment.)

![Security Warning]

4. Login to HT3.

Before You Call

If you encounter any problems accessing HT3 or saving or opening files, review the steps provided here.

If all your settings appear to be correct and you're still having problems, contact the DFS Service Department at 321-259-5009.
Logging In and Out

HT3 is password protected to prevent unauthorized access to the system. A valid account - login name and password - are required. The accounts and permissions are created and set by the system administrator. (See User Accounts for more information on creating accounts and setting permission levels.)

Because HT3 is based on Internet standards, it can be (although doesn't have to be) accessed via the Internet. An Internet connection is required, but security is not compromised. When connected through the Internet, a firewall is used in conjunction with the login scheme to provide complete security. Without a login/password combination that is verified by the server, an unauthorized user cannot access the system.

To load the login page, open your Internet browser and navigate to HT3’s URL.

Logging In

1. Open your Internet browser and type hypertacii in the Address box. The login page loads.

   Enter your login and password.

   - **Login** - Login is case sensitive and can be a maximum of 8 characters.

   - **Password** - Password is case sensitive and can be a maximum of 8 characters.

   Choose the type of audio that you want to hear when an alarm occurs:

   - To hear voice alarm messages at the workstation, verify that the Enable audio option is checked. This is the default setting.

   - To hear a beep instead of a voice alarm message, check both the Enable audio and Beep only options. This option improves workstation performance when connecting through a low-bandwidth connection (for example, a dial-up connection).

   - To completely disable sound at the workstation, uncheck the Enable audio option (note that this also unchecks the Beep only option). Disabling sound when connecting from a low-bandwidth workstation improves workstation performance.

2. Click OK. If a correct login and password combination was entered, HT3 main page is loaded. The message "Login not found" or "Incorrect password" is displayed in the status bar if an incorrect login or password is entered. Check your login and password and try logging in again.
Logging Out

1. Click **Logout** on the HT3 main menu. The **Logout** dialog box is loaded.

2. Click the dialog box's **Logout** button. (**Note**: You do not need to enter your password.).

3. Click **Yes** at the next dialog box to close the browser window.

You are returned to HT3's Login page. The Login page can be left open or minimized so that you or another user can log in later. (**Note**: If you do not close the Login page, you will not be prompted to close the browser window the next time you log out.)
Interface

HT3’s graphical user interface, or GUI, is made up of the following components:

- **Menus (main and submenus)**
- **Work Space**
- **System Tray**
- **Status bar**

**Menus**

When you click an item on the HT3 main menu, the submenu for that item opens and the main menu item changes color. If you click another item on the main menu, the submenu changes to reflect the choices for that item.

When you click an item on the submenu, the submenu item changes color and the work space displays the interface for the chosen item except if Screen Builder, Logic Builder, or PCU Editor is selected. These applications open up in a new window.
Work Space

The work space, located in the center of the GUI, displays the item you selected from the menu.

System Tray

The system tray is located in the top right corner of the GUI (to the right of the submenu and below the HT3 logo). The system tray consists of three colored bars with a flashing line below them. When you place your mouse pointer over one of these items, information is displayed in the status bar.

- **Current User** - Place your pointer over the left bar to view the login name of the user currently logged in.

- **System Time and Date** - Place your pointer over the middle bar to view the current system time and date.

- **Alarm Information** - Place your pointer over the right bar to view total number of alarms, total number of active alarms, and total number of unacknowledged alarms. Click the right bar to open Alarm Viewer. Alarm Viewer is an application that allows you to view and/or acknowledge alarms. See Alarm Viewer's documentation for more information on this application.

- **Server Connection** - Place your pointer over the flashing line to view server information (i.e., "server is online" or "server is offline").

Status Bar

The status bar, located at the bottom edge of the GUI, displays system information and error messages. Information from the system tray, as well as error messages such as "Incorrect password" and information on what the application is doing such as "applet initialized," are displayed in the status bar.
Part IV
4 Configuring Your System

- Configuration Editor Overview
- Account Lockout Policy
- User Accounts
- Partitions
- Network Routing
- Drivers
- Stations
- Modules
- Points
- Keywords
- Auto Controls
- Scheduled Controls
- Alarms
- Call In and Call Out
- Cameras
- Setting System Date and Time
- Update Polling
## Configuration Editor Overview

Configuration Editor is used to add and configure your system’s components (e.g., users, I/O, alarms, auto and scheduled controls). These tasks can be completed from any configured Windows workstation.

Note that the ability to view, control, and configure telemetry depends on the user’s permission level. See [Creating User Accounts](#) for more information.

### Opening Configuration Editor

1. Click **Configure** on the HT3 main menu.
2. Click **Telemetry** on the Configure submenu.

### Configuration Editor's Interface

Configuration Editor is organized using a "tree" structure. Below the main heading, HT3, is a list of subheadings called branches.

```
   ★ HT3
     ○ Drivers
     ○ Partitions
     ○ Alarms
     ○ Auto Controls
     ○ Scheduled Controls
     ○ Keywords
     ○ Users
     ○ Phone/E-mail
     ○ External Points
     ○ Emulation (dcom)
     ○ Emulation (modbus)
```

Each branch, except Drivers, represents a single HT3 database. Expand a branch on the Configuration Editor tree to view all the items (sub-branches) listed below it.

- Expand the Drivers branch to view all configured drivers.
- Expand each driver branch to view all its configured stations.
- Expand each station branch to view all its configured modules.
- Expand each module branch to view all its configured points.
- Expand a point branch to view its alarm (if one has been configured).
Expanding and Collapsing Branches

When you click a branch that contains sub-branches, the branch expands to show a list of the items beneath it. The branch’s icon changes from a star burst to an open folder with a vertical magnifying glass beside it.

To collapse a branch, double-click the branch’s name or single-click its magnifying glass icon.

The Point Branch

The point branch works a little differently.

- When you click a point that does not have a configured alarm, it is shown with a star burst icon.
- If the point has an alarm configured, it is shown with a closed folder and a magnifying glass.

Double-click the point name or single-click the magnifying glass next to it to view the point’s configured alarm.
Viewing an Item's Properties

When you click an item on the Configuration Editor tree, the selected item is highlighted and its properties panel opens to the right.
Account Lockout Policy

HT3 includes an optional, user-configurable account lockout mechanism that will lock out a user for a length of time after a consecutive number of unsuccessful login attempts. This mechanism includes a system-level point that can be configured to alarm when a user has been locked out and a means for resetting the account using an Admin Reset Password.

The account lockout policy allows you to set a threshold for automatically shutting down an account if too many consecutive incorrect logins are attempted. The account will remain locked out until either the lockout time has expired or the account has been reset using the Admin Reset Password.

The Admin Reset Password cannot be used to login to the HT3 system. It is only used to unlock a user account. This password should not be given out freely. It should only be used by managers, supervisors, and IT personnel.

To enable the lockout policy, you must be logged in as MGR. This predefined user is included with every version of HT3. The MGR user is considered the system administrator and has access to all areas of HT3 and its related applications.

The account lockout settings are configured through the Account panel in the Users branch of Configuration Editor.

Access Log

HT3 includes an Access Log report that provides a chronological history of HT3 access for the specified period of time. This report lists the time access occurred or was attempted, the user name of the individual who entered the system, the action taken by the user, and a description of the action's result. An unsuccessful login attempt will be listed in the Access Log as "Failed Validation."

Lockout Alarm

A system-level (external) digital point (X_LOCKOUT) can be configured to trigger an alarm whenever a user account is locked out.

Like all HT3 alarms:

- It will be listed in Alarm Viewer when it occurs
- Can be configured with a Delay and Snooze time
- Can be set to announce locally via a connected speaker or PA system
- Can be configured to send out an alert via phone and/or email
How the Lockout Policy Works

Utility XYZ has enabled the lockout policy and entered the desired Admin Reset Password. The Maximum Login Attempts and Minutes Disabled have been set to 3 times and 5 minutes, respectively.

The X_LOCKOUT point has been configured with an alarm that sends an email to the MGR user when it is triggered.

**Situation**

User DLMILLER has attempted to login to HT3 three (3) times. Each login is recorded in the Access Log as a failed attempt.

After the third consecutive failed login attempt, HT3 displays a dialog box warning that the number of login attempts has been exceeded and the user account is now locked out.

![Error Dialog](image)

The account will remain locked out until the lockout timer has expired (5 minutes) or the account is reset via the Admin Reset Password. At that time, DLMILLER can attempt to login again.

**Response**

When the lockout threshold is passed and the user is locked out, the external point X_LOCKOUT goes "true" and an alarm is triggered.

The alarm is listed in Alarm Viewer and an email is sent to the MGR user.

MGR views the Access Log to see which account is locked out. MGR then contacts DLMILLER to verify that she was attempting to login, but had forgotten his password.

MGR starts HT3. In the login dialog, she enters DLMILLER in the Login field and the Admin Reset Password in the Password field.
Creating a Lockout Policy

Note: To enable and configure the lockout policy, you must be logged in as MGR.

1. Open Configuration Editor.

2. Expand the Users branch and select Account (the first item listed).

3. Do the following:

   a. Check the Enable Lockouts box.

   b. Enter the Maximum Login Attempts (consecutive login attempts a user is given before their account is locked; default is 8 times).

   c. Enter the Minutes Disabled (number of minutes the account will be locked; default is 15 minutes). Note that this time limit can be bypassed by manually resetting the user’s account.

   d. Enter the desired Admin Reset Password and confirm it in the second password field. (If the passwords do not match, a “passwords do not match” error dialog will display when you try to save the policy.)

You can use the following in the password:

- letters A-Z (passwords are case insensitive)
- numbers 0-9
- special characters ! # % & ( ) * + - / : ; < = > ? @ [ ] ^ { } ~.

**IMPORTANT:** Do not use single quote (‘), double quote ("), or backslash (\) in your login or password.

4. To save the lockout policy settings, right click **Account** and select **Save** from the popup menu.
Resetting an Account

When a user has reached the maximum number of login attempts and is locked out of their account, a supervisor, manager, or member of the IT department can use the Admin Reset Password to unlock the account. Otherwise, the user must wait for the Minutes Disabled timer to expire and then attempt to login again.

1. Start HT3. (If you are already logged into HT3, you must log out before you can unlock an account.)
2. In the login box, enter the username for the account you want to unlock.
3. In the password box, enter the Admin Reset Password.
4. Click OK. The message bar will display "Lockout reset for user...."
Editing Your Lockout Policy

Note: To edit the lockout policy, you must be logged in as MGR.

1. Open Configuration Editor.

2. Expand the Users branch and select Account.

3. Click the Reset Admin Password button and make the desired changes.

   If you are changing the password, follow the same rules used for creating the initial password.

4. To save the changes, right click Account and select Save from the popup menu.

   If you changed the Admin Reset Password and the passwords do not match, a "passwords do not match" error dialog will display when you try to save the policy. Re-enter the passwords and try saving again.
Configuring the Lockout Alarm

1. Open Configuration Editor.

2. Expand the External Points branch and select the Account Lockout (X_LOCKOUT) point.

3. Right click the point and select New from the popup menu.
4. The alarm is added below the Account Lockout point and the panel for configuring the alarm opens.

Configure delay, snooze, Announce locally, and Phone/Email with the desired settings, but leave State set to ON. For more information on these settings, see Alarms and Call In and Call Out.

5. To save the alarm, right click the alarm’s name and select Save from the popup menu.
User Accounts

HT3 includes one predefined user, MGR. The MGR user is considered the system administrator and has access to most areas of HT3 and its related applications. This account has advanced configuration permissions that are not available to other user accounts.

Note that a "user account" comprised of the letters MGR does not grant MGR account permissions.

MGR, and any other accounts given Configure Users permission, can add new user accounts as needed.

Recommendations

When creating user accounts, we highly recommend the following:

- Create an account for each person who will be accessing the system.
- Create good, strong passwords (ones that can’t be easily guessed). Use a combination of letters, numbers, and special characters.
- Change your passwords periodically (every 3-6 months).

User Permission Options

The following permissions are available for HT3 user accounts:

- **Control (enable or disable)** - Manually set control points?
- **Acknowledge Alarms (enable or disable)** - Acknowledge active alarms?
- **Shutdown System (enable or disable)** - Stop and start telemetry (system shutdown), reboot the Hyper Server Module (HSM), test the Hyper SCADA Server's (HSS) backup battery, and reset HSS hardware?
- **Configure Users (Yes, No, or View)** - Create and edit user accounts?
- **Configure Telemetry (Yes, No, or View)** - Add, delete, and edit partitions, keywords, drivers, stations, modules, points, alarms, and auto controls?
- **Configure Ladder Logic (Yes, No, or View)** - Create virtual processes via Virtual Logic Builder?
- **Configure Scheduled Controls (Yes, No, or View)** - Create scheduled controls, events that automatically occur on certain scheduled days and/or times?
- **Configure Screens (Yes, No, or View)** - Create custom screens via Screen Builder?
- **Configure Voice (Yes, No, or View)** - Record voice alarms?

The first three items, Control, Acknowledge Alarms, and Shutdown System, can be enabled or disabled by selecting or unselecting the radio button. The remaining items have three states to choose from:

- **Yes** - User can perform the corresponding function.
• **View** - User can only view the information; cannot create, edit, or delete any of the data.
• **No** - User cannot view or access the information.

In addition to assigning permissions, each user account can be assigned to a partition.

See the sections below for information on configuring users.

- [Creating a User](#)
- [Changing a User's Partition and Permissions](#)
- [Changing a User's Password](#)
- [Deleting a User](#)

## Creating a User

1. [Open Configuration Editor](#).
2. On the Configuration Editor tree, click **Users**. The Users list expands to show all configured users.

   ![Configuration Editor Tree with Users Expanded](image)

3. Right click **Users** and then click **New** on the pop-up menu.

   ![Pop-up Menu with New Selected](image)

4. Complete the boxes in the **New user account** dialog box.

   ![New User Account Dialog Box](image)
Login - The login name must be unique and between 2 and 8 characters.

Password - The password must be between 5 and 20 characters.

Logins and Passwords can include the following:

- letters A-Z (logins and passwords are case insensitive)
- numbers 0-9
- special characters ! # % & ( ) * + , - . / : ; < = > ? @ [ ] ^ { | } ~.

IMPORTANT: Do not use single quote ('), double quote ("), or backslash (\) in your login or password.

5. Click OK. The new account is added to the Users list; the record for the account opens in the right panel.

6. In the user account record, select the settings and permissions for this user.

- Printer - Leave this box blank. It is reserved for future use.

- Partition - Partition to which this user account is assigned. See Configuring Your System: Partitions for more information on this feature. (Note: A user cannot be assigned to more than one partition. To grant an individual permission to more than one partition, configure a different user for each partition to which they should have access. For example, Joe1 has access to Wastewater; Joe2 has access to Stormwater.)

- Skin ID - Skin to which this user account is assigned. (Note: This option, which is part of the legacy HyperTAC II software, is not supported in this release of HT3)

- Control - Select this option to grant this user manual control of control points.

- Acknowledge Alarms - Select this option to grant this user the ability to acknowledge alarms.

- Shutdown System - Select this option to grant this user the ability to shutdown the system (stop and start telemetry), reboot the Hyper Server Module (HSM), test the Hyper SCADA Server's (HSS) backup battery, and reset the HSS' hardware.
- **Configure Users** - Select **No** to block this user from viewing and editing user information. Select **View** to allow this account view-only access to user information. Select **Yes** to grant this account full access to the user list.

- **Configure Telemetry** - Select **No** to block this account from viewing and editing telemetry information (drivers, stations, modules, etc.). Select **View** to allow this account view-only access to telemetry information. Select **Yes** to grant this account full access to the telemetry configurations.

- **Configure Ladder Logic** - Select **No** to block this account from using Virtual Logic Builder. Select **View** to allow this account view-only access to Virtual Logic Builder. Select **Yes** to grant this account full access to Virtual Logic Builder.

- **Configure Scheduled Controls** - Select **No** to block this account from viewing and editing scheduled controls information. Select **View** to allow this account view-only access to scheduled controls information. Select **Yes** to grant this account full access to the scheduled controls database.

- **Configure Screens** - Select **No** to block this account from using Screen Builder. Select **View** to allow this account view-only access to Screen Builder. Select **Yes** to grant this account full access to Screen Builder.

- **Configure Voice** - Select **No** to block this account from recording voice alarms. Select **View** to allow this account view-only access to the voice recordings database. Select **Yes** to grant this account full access to the voice recordings database.

7. When you have the account settings and permissions configured the way you want them, right click the new user on the Users list and click **Save** on the pop-up menu. The status bar displays the message "Save was successful."
Changing a User's Partition and Permissions

Note: You must login to HT3 with an account that has Configure Users permissions to make any changes to a user's account.

1. Open Configuration Editor.
2. On the Configuration Editor tree, select Users to expand the list of configured users.
3. Select the user to be edited. The properties for the selected account are displayed in the right panel.
4. Make the desired changes.
5. On the Users list, right click the user that was modified and click Save on the pop-up menu. The status bar displays the message "Save was successful."

Changing a User's Password

To change the password assigned to your HT3 user account:

1. Login to HT3 using the username and password of the account you want to change.
2. Click Configure on the HT3 main menu.
3. Click Password on the Configure submenu to open the Password Maintenance dialog box.
4. Type your new password in the Password and Retype Password boxes.
5. Click OK. The Success dialog box opens on the screen.
6. Click OK to confirm the change and close the Success dialog box.
7. Use the new password the next time you login to HT3.

Deleting a User

Note: To delete a user, you must login to HT3 with an account that has Configure Users permissions.
1. **Open Configuration Editor.**

2. On the Configuration Editor tree, select **Users** to expand the list of configured users.

3. Right click the user you want to delete and click **Delete** on the pop-up menu.

4. Click **Yes** at the **Delete this record?** dialog box. The account is removed from the Users list.
Partitions

Partitioning allows you to divide your system into logical units based on characteristics you determine, such as function or location. (Multiple partitions are optional; a system can have a single partition.)

Partitions are logical (not physical) divisions of your telemetry system. They don't require additional or separate equipment. All partitions use the same SCADA server, networks, radio frequencies, CTUs, etc.

As an example, a system could be divided into the following functional partitions:

- Wastewater Collections
- Reclaimed Water Distribution
- Water Treatment Plant
- Storm Water Control

Every station and user account must be assigned to a partition. Assign them to the default partition (PART0) if no additional partitions have been created.

In our example above, stations in each functional area and user accounts for personnel who work in each functional area would be assigned to their respective partition. (Stations and personnel working in storm water control would be assigned to the Storm Water Control partition.)

<table>
<thead>
<tr>
<th>Maximum Number of Partitions</th>
<th>Each HT3 system can have up to eight (8) partitions.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>A system can have a single partition. PART0 (partition 0) is the default partition.</td>
</tr>
</tbody>
</table>

Partitions and User Accounts

Every account is given permission to access a specific partition (see Creating User Accounts). When a user logs in, information for the other partitions is hidden.

After you login, the name of your assigned partition is displayed in the title bar of the browser.

See the sections below for information on configuring partitions.

- Creating a Partition
- Editing a Partition
• Deleting a Partition

Creating a Partition

1. Open Configuration Editor.

2. On the Configuration Editor tree, click Partitions.

3. Right click Partitions and select New on the pop-up menu.

4. Enter a name for the partition.

5. Click OK. The partition is added to the Partitions list in the Configuration Editor tree. The partition's properties are displayed in the right panel.

Stations are assigned to a partition when they are configured and are then shown in the Stations in this partition list. Users assigned to this partition are listed under Users in this partition. Refer to the sections on adding Stations and User Accounts for more information.
6. On the Configuration Editor tree, right click the new partition and click **Save** on the pop-up menu. The **status bar** displays the message "Save was successful."

**Editing a Partition**

1. **Open Configuration Editor.**
2. On the Configuration Editor tree, click **Partitions** to open a list of all configured partitions.
3. Select the partition to be edited. The properties for that partition are displayed in the right panel.
4. Make your changes.
5. On the Configuration Editor tree, right click the partition and click **Save** on the pop-up menu. The **status bar** displays the message "Save was successful."

**Deleting a Partition**

**IMPORTANT:** A partition cannot be deleted if stations are assigned to it. Only the MGR user account can delete a partition.

1. **Open Configuration Editor.**
2. On the Configuration Editor tree, click **Partitions** to open a list of all configured partitions.
3. Right click the partition you want to delete and click **Delete** on the pop-up menu.
4. Click **Yes** to confirm. The partition is removed from the Partitions list.
Network Routing

Routing in its simplest form is comprised of three elements:

- **Hosts**
- **Networks**
- **Gateways**

When the Hyper SCADA Server (HSS) needs to transmit a message to a device that is outside its local network, it looks in its routing table for the route through which the message must be sent.

- It first looks for a static route to the target, or host, device.
- It then looks for a static route to the network on which the target device resides.
- Lastly, it looks for a default gateway.

If the HSS hasn't been configured with a static route to the device or a default gateway, an error message is returned indicating that the message could not be sent.

Messages between devices that are on the same private network are not routed. Routing is only necessary when the target is located outside the local network.

See [Networking Examples](#), below, for diagrams and descriptions of some typical network configurations.

For detailed instructions on adding and configuring gateways, hosts, and networks, see Configuring Network Routing.

**Hosts**

A host is a single computer that is connected to a network. Each host on a network has a unique IP address that identifies it and distinguishes it from other devices on the network. If your network uses dynamic addressing and the host doesn’t maintain a static IP address, you can map the host to an alternate station address.

**Networks**

A network is a group of two or more computer systems that are linked together. Local-area networks (LAN), also referred to as private networks, encompass a relatively small area (for example, a single building). A LAN is used to connect workstations so they can share and access data and devices (for example, printers) anywhere on the LAN.
The most widely used network topology is the class C network, which allows up to 254 machines to be on the same network. For computers to be on the same class C network, the first three octets of their IP address must match. For example, two machines, one with the IP address 192.168.1.2 and the other with an IP address 192.168.1.3, would be on the same network. The network number in our example is 192.168.1. The last octet of each machine's IP address is unique to distinguish it from all other machines on the same network.

Network numbers and classes are defined using netmasks. Although there are many custom levels of netmasking, we will only consider four levels here. Netmasking is used to define the range of IP addresses that can be directly connected without using a router. Routers are used to connect individual class C networks or to connect a class C network to the Internet.

<table>
<thead>
<tr>
<th>Network Class</th>
<th>Netmask</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>255.0.0.0</td>
<td>Only the first octet matches. All other octets may be from 1-254.</td>
</tr>
<tr>
<td>B</td>
<td>255.255.0.0</td>
<td>Only the first two octets match.</td>
</tr>
<tr>
<td>C</td>
<td>255.255.255.0</td>
<td>The first three octets match. The fourth octet defines a single machine.</td>
</tr>
<tr>
<td>D</td>
<td>255.255.255.255</td>
<td>Defines a single IP address with no alternatives and no range.</td>
</tr>
</tbody>
</table>

Gateways

Gateways, also referred to as routes, are used to connect one network to another. Through gateways, devices on one network are able to communicate with devices on other networks. Any time that a device needs to communicate outside its local network, it must be configured with the route, or gateway, to the "outside world."

One important concept to remember about routing is that you can only configure one "hop" for each route. To send a message to a device several networks away (one that requires that the message be directed through more than one router to get to its destination), you can only configure the source device to send the message to its local router. The local router, if configured properly, will forward the message to the next router down the line. The message continues in this way until it reaches the target device.

For our purposes, gateways can be one of two kinds:

- **Static** - A static route, or gateway, gives the device a direct route either to a host on another network or to another private network.

- **Default** - The device will use its default gateway when it cannot find a static route to the target host or network. Any messages going to devices for which static routes have not been configured are sent through the default gateway.

When configuring gateways in HT3, it is important to note that each gateway must be on the same local network as the HSS.

Networking Examples

The sections below illustrate five typical network setups.
Standard Private Network

Pictured above is a typical closed network (private network without an Internet connection). This network includes an HSS and three workstations all of which are connected to a single 4-port switch. In order for communications between the machines to take place, all four machines must be addressed on the same network. In our example above, the HSS is addressed at 192.168.1.2. Because this is a class C network, we know that the first three octets represent the network number (192.168.1). This means that the IP addresses of the other three workstations must also start with 192.168.1.

With this type of network, we don't have to configure any gateways. As long as all of the machines are addressed on the same network, they will be able to transmit and receive messages from all other devices on the network.

Standard LAN with Internet Connection

In this example, a private network is connected to the Internet via a router. The private network has an HSS, two workstations, and a router. All four devices are addressed on the same class C network.

For our example, the HSS is addressed at 192.168.1.2, and the router is addressed at 192.168.1.1. The two workstations are .3 and .4. Notice that once the network is defined, individual machines are identified using only the last octet. The network number is assumed.

In order for the HSS or either workstation to reach the internet, they must define 192.168.1.1 as their default gateway. This means that any message that is addressed for a network other than the local network will be routed through the default gateway. Any message that is addressed on the local class C network (192.168.1) will remain on the local network.
In HT3, we would add a gateway with the IP address 192.168.1.1 and choose to make it the default gateway when prompted.

LAN Network to NIM Network Connection

In the previous example (Standard LAN with Internet Connection), a default gateway was configured as a "catch-all". Any network that had not been configured with a static route in HT3 would get routed through the default gateway.

In this example, we are connecting to another class C network that contains a number of NIM's. Each NIM has an IP address on its network. In this case, we will define a static route to the second network.

In HT3, we first construct a gateway record for 192.168.1.1. Although we could make it a default gateway, it is better for several reasons to create a static route to the network. A static route is more efficient because of the way the routing table is searched (host records are searched first, then network records, then gateway records). It also makes it easier to expand the system. If we configure a static route, we won't have to redefine the default gateway if we later add networks to our system. When we are prompted by HT3 if we want to make this a default gateway, we will select No.

After a gateway record is created, we configure a network record for 172.61.2.0 (the last octet must be 0 when defining an entire network), and we select 192.168.1.1 as the gateway. This tells the HSS that any network packets addressed for network 172.61.2 be routed through gateway 192.168.1.1.

Advanced Routing Network (1)
This concept illustrated in the previous example (LAN Network to NIM Network Connection) can be extended as shown above. In this example, the local-area network is connected both to a wide-area network (WAN) and to a private NIM network. The WAN represents a network that spans a relatively large geographical area. It could be, for example, a city-wide network that is made up of several LANs, or it could be the Internet.

For this type of configuration, we define both a static route to the NIM network and a default gateway. Any messages that are not going to the local network or to the NIM network, are routed through the default gateway.

We will assume in our example that the two routers are addressed at 192.168.1.1 (to WAN) and 192.168.1.2 (to NIM network). In HT3, we will first construct two gateway records. The gateway record for 192.168.1.1 should be defined as the default gateway. After we have added the gateways, we add a network for 172.61.2.0 and select 192.168.1.2 as the gateway.

This topology is fairly common and can be extended to many private networks.

**Advanced Routing Network (2)**

![Advanced Routing Network (2)](image)

This diagram shows a similar situation with one additional route to a single host (a CTU that contains a tunneling NIM). Routes do not have to be to entire networks, they may be to a single machine.

In this example, the default route and network route are set up the same as the Advanced Routing Network (1) example, above. Additionally, we must add a third gateway for the host and create a host record that uses this gateway as its static route.

In HT3, we would first add the gateway and be sure that it is not selected as the default. We will assume for this example, that the IP address of the gateway's router is 192.168.1.3. We would then add a host record that has an IP address of 212.44.8.102 and select 192.168.1.3 as the gateway.

**Configuring Network Routing**

Before configuring gateways, networks, and hosts, review the information in [Network Routing](#).

The sections below provide information on the following topics:

- [Opening the Routing Tool](#)
- [Adding and Removing Gateways](#)
Adding and Removing Network Routes

Adding and Removing Hosts

Opening the Routing Tool

Network routing elements can be added from any driver panel in Configuration Editor. Routing elements are not associated with a particular driver; the driver you select for this procedure has no affect on the routing table.

1. Open Configuration Editor and select any driver to view its properties.

2. Click the Route button to open the routing tool. All currently configured gateways are listed under Current Gateways. An asterisk (*) at the beginning of an IP address indicates that it is the HSS' default gateway.
Adding and Removing Gateways

Adding a Gateway

1. Open the routing tool and select Gateways.

![Gateway Add Window]

2. Type the gateway’s IP address in the Add box and click Add. This IP address must be on the same local network as the HSS.

3. If a default gateway hasn’t already been configured, you are prompted to make this gateway the default. Click Yes to make this gateway the default. Otherwise, click No.

4. The new gateway is added to the Current Gateways list.

**IMPORTANT**: After all gateways, networks, and hosts have been added in HT3, telemetry must be restarted. The operating system's routing table will not be updated with the changes until telemetry is restarted. To restart telemetry, you must issue the Stop Telemetry and Start Telemetry commands from the Server Control Center. See Using System Tools: System Control Center for more information.

Removing a Gateway

1. Open the routing tool and select Gateways.

2. From the Current Gateways list, select the gateway to be removed.

3. Click Remove. The gateway is removed from the Current Gateways list.

**IMPORTANT**: After all desired gateways, networks, and hosts have been removed from HT3, you must restart telemetry to remove the entry from the operating system's routing table. See Using System Tools: System Control Center for more information.
Adding and Removing Network Routes

Adding a Network Route

Before adding a network, verify that the gateway that the network will be using is listed in the Current Gateways list. For instructions for adding a gateway, see Adding and Removing Gateways, above.

1. Open the routing tool and select Networks.

2. Type the network's number in the Add box. This should be a class C network address. The address should include all four octets and should end in a zero to indicate that this is a network. For example, 205.241.48.0.

3. Select the network’s gateway from the Current Gateways list. If you don’t select a gateway, the default gateway will be used for this network.

4. Click Add. The route is added to the Networks list.

**IMPORTANT:** After all gateways, networks, and hosts have been added in HT3, telemetry must be restarted. The operating system’s routing table will not be updated with the changes until telemetry is restarted. To restart telemetry, you must issue the Stop Telemetry and Start Telemetry commands from the System Control Center. See Using System Tools: System Control Center for more information.

Removing a Network Route

1. Open the routing tool and select Networks.
2. In the **Networks** list, select the route to be removed.

3. Click *Remove*. The route is removed from the **Networks** list.

**IMPORTANT**: After all gateways, networks, and hosts have been added in HT3, telemetry must be restarted. The operating system's routing table will not be updated with the changes until telemetry is restarted. To restart telemetry, you must issue the **Stop Telemetry** and **Start Telemetry** commands from the System Control Center. See Using System Tools: System Control Center for more information.

---

**Adding and Removing Hosts**

**Adding a Host**

Before adding a host, verify that the gateway that the host will be using is listed in the **Current Gateways** list. For instructions for adding a gateway, see Adding and Removing Gateways, above.

1. Open the routing tool and select **Hosts**.

2. Type the host's IP address in the **Add** box.

3. Select the host’s gateway from the **Current Gateways** list. If you don't select a gateway, the default gateway will be used for this host.

4. Click **Add**. The route is added to the **Hosts** list.
Removing a Host

Open the routing tool and select **Hosts**.

From the **Hosts** list, select the route to be removed.

Click **Remove**. The route is removed from the **Hosts** list.

**IMPORTANT**: After all gateways, networks, and hosts have been added in HT3, telemetry must be restarted. The operating system's routing table will not be updated with the changes until telemetry is restarted. To restart telemetry, you must issue the **Stop Telemetry** and **Start Telemetry** commands from the System Control Center. See **Using System Tools: System Control Center** for more information.
Drivers

A driver is the program that interfaces between the Hyper SCADA Server and the telemetry hardware devices.

The driver:

1. Reads the information that has been entered into the database,
2. translates it into a language that the hardware understands, and
3. communicates with the hardware.

<table>
<thead>
<tr>
<th>Maximum Number of Drivers</th>
<th>Up to seven drivers (0-6) can be configured in a HT3 system. Drivers 7 and 8 are not polled by telemetry; these folders contain DFS and Modbus station templates.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Driver Number</td>
<td>HT3 automatically assigns each driver a number. It will be shown in parentheses after the driver name in the Configuration Editor tree. There must always be a driver 0.</td>
</tr>
<tr>
<td>Driver Types</td>
<td>There are six driver types that can be configured in the HT3 system:</td>
</tr>
<tr>
<td></td>
<td>• Data Flow Systems (DFS) - Select TAC II protocol mode or Derivative Fractional Protocol (DFP) mode</td>
</tr>
<tr>
<td></td>
<td>• Network Derivative Fractional Protocol (NetDFP)</td>
</tr>
<tr>
<td></td>
<td>• Network Interface Module (NIM)</td>
</tr>
<tr>
<td></td>
<td>• Modbus</td>
</tr>
<tr>
<td></td>
<td>• Motorola</td>
</tr>
<tr>
<td></td>
<td>• Allen-Bradley</td>
</tr>
</tbody>
</table>

Data Flow Systems (DFS) Driver

The DFS driver enables network to radio-based communication between the Hyper SCADA Server (a network device) and DFS radio-based Remote Terminal Units (RTUs).

Read the sections below before adding and configuring a DFS driver.
TAC II Protocol and Derivative Fractional Protocol (DFP)

The DFS driver can use either TAC II protocol or DFP. (DFP is not the same as the NetDFP driver that is used for cellular stations.) Stations configured under a DFS driver don’t have to use the same protocol. A single DFS driver can communicate with a combination of TAC II, DFP, and solar DFP stations.

<table>
<thead>
<tr>
<th>TAC II Protocol</th>
<th>TAC II protocol maximizes data collection efficiency by only sending information that has changed. Once the driver in HT3 has obtained the status of a station it will begin to poll it for changes as opposed to requesting full status. For added efficiency the driver will poll groups of stations configured consecutively (up to 12) for changes.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Derivative Fractional Protocol (DFP)</td>
<td>With DFP, HT3 doesn’t send change/no change queries to TIM stations, but instead polls them for table information. In this mode, the overhead of asking for changes and then polling for status is eliminated. Stations equipped with correct model Telemetry Interface Modules (TIMs) or Telemetry Control Modules (TCUs) can use DFP. (TIMs and TCUs that have Atmel processors can used DFP.) DFP also has a solar mode, which is used for all solar powered sites. DFP is enabled on a DFS driver through an entry to the HT3 registry. Read Derivative Fractional Protocol (DFP) for more information.</td>
</tr>
</tbody>
</table>

Tunneling

The DFS driver uses a process called tunneling to send network data over radio to DFS RTU (radio) stations. A Network Interface Module (NIM) or Fiber Interface Module (FIM) is placed in the Central Terminal Unit (CTU) along with either a Radio Interface Module (RIM) or a Telemetry Interface Module (TIM).

The NIM/FIM acts as a "translator" between the Hyper SCADA Server and the radio-based DFS RTUs. The NIM/FIM accepts network data from the Hyper SCADA Server and converts it to a format understood by the RIM/TIM. The converted data is sent to the RIM/TIM, which forwards it to the radio-based RTUs. This process is reversed when the DFS RTUs send communications to the server.

Second CTU Communicating with Modbus Stations

The second port of the NIM/FIM installed in the primary CTU can be connected to a second CTU that is communicating with Modbus stations. In this configuration, a Modbus driver would also have to be configured.

Requirement for FIM in TIM-based CTU

A FIM is only required in a TIM-based CTU if either a T200 radio or a Voyager radio in Legacy Mode is installed on the TIM.
A TIM-based CTU with a Voyager radio in High-speed or Medium-speed mode does not require a FIM. A Voyager radio in either of these modes functions as both the radio and the serial tunneling device. The Voyager’s Ethernet port can be used to provide an Ethernet connection between the HSS and the CTU.

Adding and Configuring a DFS Driver

Note: The instructions provided here apply to both TAC II protocol and DFP. By default, a DFS driver will use TAC II protocol to communicate with a station. In order for the driver to use DFP (standard or solar) to communicate with a station a special entry must be made to the HT3 registry. This entry must be made for each station that is using DFP. See Derivative Fractional Protocol (DFP) for more information.

1. Open Configuration Editor.
2. On the Configuration Editor tree, right click Drivers and then click New.
3. Select DFS RTU as the driver type. Type a name for the driver and click Ok.

<table>
<thead>
<tr>
<th>Driver Name</th>
<th>Maximum of 20 characters. Use any combination of upper- and lower-case letters, numbers, spaces, and special characters except single (’) and double (&quot;) quotation marks.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Driver Number</td>
<td>HT3 automatically assigns a driver number. It will be shown in parentheses after the driver name in the Configuration Editor tree.</td>
</tr>
</tbody>
</table>

4. The new driver is added to the Drivers list. The driver’s default properties are displayed in the right panel.
Configure the following:

<table>
<thead>
<tr>
<th>DFS Driver Name</th>
<th>Leave this field as it is unless you need to edit or change the driver name.</th>
</tr>
</thead>
</table>
| CTU Tunnel IP Address | Complete IP address of the CTU’s NIM/FIM plus a fifth octet that represents the serial port on the NIM/FIM that the RIM is connected to:  
  - network address + NIM/FIM’s node address + number of NIM/FIM port to which the RIM is connected  
  For example, 207.243.62.251.1 would correspond to a network address of 207.243.62, a node address of 251, and a port number of 1. |
| Backup Tunnel IP Address | Complete IP address of the CTU’s backup NIM/FIM. This is only used if the CTU is fully redundant. If redundancy is not being used, enter the CTU Tunnel IP Address (see above) in this box. |
| Baud                  | Rate of data transmission (number of bits of information transmitted per second). This is determined by the type of RIM installed in the CTU. Select 1200 or 9600 from the drop-down list. |
| Parity                | Method of checking for errors in data transmissions. Select Odd, Even, or None from the drop-down list. |
| Stop Bits             | Number of bits used to indicate the end of a data transmission. Select 1 or 2 from the drop-down list. |
| High Priority ratio   | Number of times in one polling loop the system asks a High Priority station for status. A station is assigned a polling priority in its configuration. See the description for the Priority setting in "Adding a DFS or DFP Station" for more information. Use the slider to select a value between 2 and 4. The default setting is 2. |
### Low Priority ratio
Number of polling loops the system makes before requesting status from a Low Priority station. A station is assigned a polling priority in its configuration. See the description for the [Priority setting in "Adding a DFS or DFP Station"](description) for more information.

Use the slider to select a value between 2 and 9. The default setting is 4.

### Minimum loop time
Minimum time that must elapse before starting a new polling loop. Choose a value that optimizes information retrieval while preserving battery power (in the event the station is running on backup battery power).

Use the slider to select a value between 5 and 60 seconds.

### Force poll after control
Require that the system begin a polling loop after a control has been initiated. This applies to all controls - manual, auto, and scheduled.

**Note:** Selecting this option will negatively affect polling time if the system has a large number of controls taking place.

### Auto Switch Redundant CTU
Enable the system to switch to the redundant CTU at a certain time every day or when a specific percentage of stations go offline.

This can only be used if the telemetry system has been configured for complete CTU redundancy. A [Backup Tunnel IP Address](explained above) must be defined.

### At time of day
Time of day to switch to the redundant CTU. When the Auto Switch Redundant CTU option (see above) is enabled, the system will automatically switch CTUs every 24 hours at the time selected. Select a time from the drop-down list.

### For offline station percentage
Percentage of offline stations that force a switch to the redundant CTU. This setting is in addition to the At time of day setting. When the Auto Switch Redundant CTU option (see above) is enabled, the system will automatically switch CTUs every 24 hours and will also switch whenever the number of offline stations is equal to the chosen percentage.

When choosing a setting other than 0 or 100%, select a number that is large enough to prevent constant switching between the primary and redundant central and small enough to catch the appropriate number of offlines.

If you enter 0, the CTU switch will only occur at the time of day specified in At time of day.

Use the slider to select a value between 0 and 100 percent.

5. Verify that all the information entered is correct. On the Configuration Editor tree, right click the new driver and then click **Save**. The status bar displays the message "Save was successful."

**IMPORTANT:** After all drivers have been configured, the system must be restarted.
**Derivative Fractional Protocol (DFP)**

**Note:** DFP is not the same as the NetDFP driver that is used for cellular stations.

DFP is a table-based communication protocol for DFS radio equipment. DFP was introduced in HT3 (it is not included in HyperTAC II).

With DFP, HT3 doesn’t send change/no change queries to TIM stations, but instead polls them for table information. In this mode, the overhead of asking for changes and then polling for status is eliminated.

**IMPORTANT:** DFP can only be used with TIM007s or with TCUs that have Atmel processors (TCU001 Rev D13 and newer).

DFP also requires that the CTU have a TIM007 installed and that the network module installed in the CTU be running the latest NIM001.exe code (263995 bytes or larger). Use the Module Patching Utility to verify the NIM code level. Note that the network module typically installed in the CTU is a Fiber Interface Module (FIM).

DFP is enabled on a DFS driver through an entry to the HT3 registry. The TIM/TCU will not respond to DFP queries until it has been sent the station’s configuration (entry made in HT3’s Registry Editor and Update Polling performed). Once configured for DFP, the TIM/TCU polls the local modules and stores the status and event data internally in a table-based format.

The TIM/TCU will reply to DFP queries from HT3 with status changes and any history it accumulates between polling cycles. If no status changes have occurred since the last query, the TIM will send empty tables to HT3. When HT3 receives an event message, it decodes the message and writes the data to HT3’s journal tables.

**DFP Modes**

**Note:** The information provided below gives a brief overview of how DFP and solar DFP communications operate. Additional information can be found in the TIM007 Installation and Operation Manual and the TCU Installation and Operation Manual. Both are available for download from the DFS website (http://www.dataflowsys.com/support/literature.php).

There are two modes for DFP:

**Standard Mode**

The TIM or TCU stores the current status and any events that have occurred in its internal tables and replies to DFP queries with accumulated status and event information. The TIM or TCU will send a “more data” message to the driver until the event table is empty or the maximum number of messages per loop has been met. This process resumes on the next loop until the event table is empty.

See [Configuring a Station for DFP](#)

**Solar Mode**

The TIM wakes three (3) seconds before the top of each minute and polls the modules on the bus once. Based on battery voltage, the TIM will either wait for a query from HT3 or return to sleep mode. In sleep mode, the TIM powers down all but a clock component on its module, and also switches power off to the module bus.
• Voltage >= 12.8 volts – The TIM will respond once each minute.

• Voltage <= 12.7 volts – The TIM will stay up and respond to the driver at the minute that is equivalent to the modulus (remainder) of its station address divided by 5 (this behavior is described in more detail in the "Solar RTU Application” chapter of the TIM007 Installation and Operation Manual).

See Configuring a Station for Solar DFP

## Configuring a Station for DFP

| IMPORTANT: Configuring a TIM/TCU station to use DFP requires an entry in HT3’s Registry Editor. Editing the registry requires that the user login as DFS. The MGR account and any accounts that have been configured with DFS-type permissions can view the Registry Editor but can’t make changes to any setting other than server time and date. |

1. If you haven’t already added a DFS driver, follow the directions provided in Drivers: DFS Driver.
2. Add a DFS station.
3. Open the Registry Editor (click Configure on HT3’s main menu; click System on the Configure submenu).
4. Expand the Drivers branch and click DFS_DRIVER.
5. In the “Add New Property to DFS_DRIVER” form, enter DFP_TABLE_XXXX in the left form field (where XXXX is the station’s address).
   • For stations configured under driver 1 or up, the station’s address is the driver number followed by three-digit station number. For example, 3017 for station 17 configured under driver number 3 (you must include a leading 0 for a station number that is less than 100).
   • Stations configured under driver 0 do not require a leading 0 in the station number if the station number is less than 100. For example, DFP_TABLE_21 for station number 21 configured under driver 0.
6. In the form field on the right, enter the word TRUE.
7. Click **Submit**.

8. Return to Configuration Editor and perform **Update Polling**.

## Configuring a Station for Solar DFP

**IMPORTANT:** Configuring a TIM/TCU station to use solar DFP requires an entry in HT3’s Registry Editor. Editing the registry requires that the user login as DFS. The MGR account and any accounts that have been configured with DFS-type permissions can view the Registry Editor but can’t make changes to any setting other than server time and date.

1. If you haven’t already added a DFS driver, follow the directions provided in **Drivers: DFS Driver**.

2. Add a **DFS station**.

3. Open the Registry Editor (click **Configure** on HT3’s main menu; click **System** on the Configure submenu).

4. Expand the Drivers branch and click DFS_DRIVER.

5. In the “Add New Property to DFS_DRIVER” form, enter `DFP_SOLAR_XXXX` in the left form field (where `XXXX` is the station’s address).

   - For stations configured under driver 1 or up, the station’s address is the driver number followed by three-digit station number. For example, 3017 for station 17 configured under driver number 3 (you must include a leading 0 for a station number that is less than 100).
Stations configured under driver 0 do not require a leading 0 in the station number if the station number is less than 100. For example, DFP_TABLE_21 for station number 21 configured under driver 0.

6. In the right form field, enter the word TRUE.

7. Click Submit.

8. Return to Configuration Editor and perform Update Polling.

Network Derivative Fraction Protocol (NetDFP) Driver

Note: The material provided here is for informational purposes only. It does not include instructions on adding and configuring a NetDFP driver. The NetDFP driver must be added and configured by qualified DFS Service Personnel. Cellular stations and points (I/O), however, can be added and configured by end users.

More information on the RDP180-C and setting up and configuring a cellular SCADA system can be found in the RDP180-C Cellular RTU Installation and Operation Manual (available for download from the Open Control Solutions website at www.opencontrolsolutions.com/rdp180-cellular-rtu.php)

Requirements

- Verizon data plan (each station must have its own telephone number and data plan)
- Hyper SCADA Server with HT3 3.1.1 or newer installed
- Computer or laptop with PMT version 2.1.1 or newer installed
Operation Overview

The NetDFP driver is used for RDP180-C cellular stations. Each RDP180-C is equipped with a Verizon cell modem for communication and is given a unique mobile telephone number that requires its own data plan.

The NetDFP driver is essentially a Modbus driver with a special flag set in the HT3 registry that causes the driver to operate as a “listener.” The cellular RTUs communicate over the Verizon cellular network using a pop-up scheme.

In a typical radio- or Ethernet-based communication scheme, the remote sites (RTUs) wait to be polled by the central server. With a cellular-based, pop-up scheme, the Hyper SCADA Server (HSS) waits for messages from the RTUs.

Each cellular RTU stores status changes locally in an event table until one of four configured events occur. The cellular RTUs send status updates to the HSS over the Internet / cell phone network. The status update messages are sent to a static IP address assigned to the HSS by your Internet service provider.

The events that will cause the cellular RTU to “pop up” and report to the HSS are:

- Elapsed time limit exceeded (global timer)
- Maximum number of queued events exceeded (event counter)
- A trigger event occurs
- RDP180-C receives a FULL_STATUS request via email/text

When an event occurs, the cellular RTU transmits information from the event table to the HSS, empties the event table, and begins accumulating event data again. Events are configured for each RDP180-C via the Process Management Toolkit (PMT) software.

Before the RDP180-C can begin communicating on the cellular SCADA system, a station must be added to the NetDFP driver in HT3. Once the station (and associated I/O points) has been added in HT3, the cellular RTU’s global settings and events must be configured in the PMT software.

Offline Station

Another difference in a cellular-based system is in how a station’s offline status is determined. The RDP180-C in a cellular RTU sends a minimal “keep alive” message to its corresponding driver in the HSS every 10 minutes. If the driver does not receive a “keep alive” message from the cellular RTU within 25 minutes, it will set the station’s status to OFFLINE. To be alerted when a cellular station goes offline, you can configure the built-in OFFLINE alarm to announce locally and/or callout.

Modbus Driver

This driver enables Modbus protocol-based communications between the Hyper SCADA Server and Modbus slave devices. Polling takes place via a Modbus-compatible radio or over an Ethernet or serial network.

The following Modbus protocols are supported:
• Modbus ASCII
• Modbus RTU
• Modbus TCP

A Modbus driver must be added for each protocol that is to be used.

| Modbus ASCII and RTU | Tunneling is used when communicating with slave devices via Modbus ASCII or RTU protocol. Tunneling enables network-based information to be sent to Modbus-compatible slave devices via a radio or serial network. A tunneling device capable of serial-to-network conversion, such as a Network Interface Module (NIM), Fiber Interface Module (FIM), or RAIL Network Adapter (RNA110), is placed in the Central Terminal Unit (CTU) along with a standard Modbus-compatible central radio. The tunneling device acts as a "translator" between the Hyper SCADA Server and the Modbus-compatible radio. The tunneling device accepts network-based information from the server and translates the information into a language understood by the Modbus central radio. |
| Modbus TCP | Modbus TCP protocol enables the Hyper SCADA Server to poll Modbus slave devices over the network. For this configuration, the driver would have a standard IP address with .255 as the last octet. The Modbus TCP stations that the HSS will be polling can be on the same network as the HSS or on a different network. |

Adding and Configuring a Modbus Driver

1. Open Configuration Editor.

2. On the Configuration Editor tree, right click Drivers and then click New.

3. Select MODBUS as the driver type. Type a name for the driver and click Ok.

| Driver Name | Maximum of 20 characters. Use any combination of upper- and lower-case letters, numbers, spaces, and special characters except single (’) and double (") quotation marks. |
| Driver Number | HT3 automatically assigns a driver number. It will be shown in parentheses after the driver name in the Configuration Editor tree. |
4. The new driver is added to the Drivers list. The driver's default properties are displayed in the right panel.

Configure the following:

<table>
<thead>
<tr>
<th>Modbus Driver Name</th>
<th>Leave this field as it is unless you need to edit or change the driver name.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Default Port (IP)</td>
<td>Follow the instructions below for Modbus TCP or Modbus RTU/ASCII</td>
</tr>
</tbody>
</table>

**Modbus TCP**

For Modbus TCP drivers, you must enter a default network address for all stations configured under this driver. When a station is polled, it will be polled at an IP address consisting of the network address specified in the Default Port (IP) box plus the network node address specified in the station's configuration (the node address will also be the station's ID number).

It is possible for stations under a driver to be on a different network than the default. When a station is not on the default network, you must provide the full IP address of the station in the Station Configuration panel.

If the stations to be configured under the driver are on several different networks, the default network should be the network where the majority of the stations are located. This will make configuration of the stations easier, since you will only have to configure a station number for most of the stations; you won’t have to input a full IP address.
The IP address entered in the **Default Port (IP)** box is the network portion of the default network (first three octets) followed by 255. Entering 255 as the last octet tells the system that Modbus TCP protocol is being used. An example of the address that should be entered in the **Default Port (IP)** box is 192.168.10.255, where 192.168.10 is the default network address for all stations configured under the driver.

**Modbus RTU/ASCII**

For RTU/ASCII drivers, you must enter the complete IP address of the CTU’s serial-to-network converter (e.g., NIM, FIM, or RNA) plus a fifth octet that represents the serial port on the converter to which the Modbus radio is connected.

The format of the IP address entered in the **Default Port (IP)** box must be the network address + converter’s node address + port on converter to which the Modbus radio is connected. For example, 207.243.62.251.1 would correspond to a network address of 207.243.62, a node address of 251, and a port number of 1.

<table>
<thead>
<tr>
<th>Protocol</th>
<th>Select the appropriate protocol for your configuration (ASCII, RTU, or TCP).</th>
</tr>
</thead>
<tbody>
<tr>
<td>Message Limit</td>
<td>Maximum number of registers to be polled for status in a single message. Advanced users may decrease this number if communication problems are encountered.</td>
</tr>
<tr>
<td>Baud (ASCII and RTU only)</td>
<td>Rate of data transmission (number of bits of information transmitted per second). This is determined by the type of Modbus radio equipment installed at the CTU. Select 1200, 9600, 19800, or 38400 from the drop-down list.</td>
</tr>
<tr>
<td>Data Bits (ASCII and RTU only)</td>
<td>Number of bits that represent one character of data. Select 8 or 7.</td>
</tr>
<tr>
<td>Parity (ASCII and RTU only)</td>
<td>Method of checking for errors in data transmissions. Select None, Odd, or Even.</td>
</tr>
<tr>
<td>Stop Bits (ASCII and RTU only)</td>
<td>Number of bits that indicate the end of a data transmission. Select 1 or 2.</td>
</tr>
<tr>
<td>Flow Control (ASCII and RTU only)</td>
<td>Method of hardware flow control for this device driver. Select None, Radio (RTS-CTS), or Bus (CTS).</td>
</tr>
<tr>
<td></td>
<td>• None: This is the default setting. This should be selected when tunneling through an older NIM (Revision C or earlier).</td>
</tr>
<tr>
<td></td>
<td>• Radio: Select this option when the radio being used requires hardware flow control AND the NIM being used for tunneling is Revision D or later. With this method, the driver sends an RTS signal and then sends the message after a brief delay. It does not wait for the modem to send a CTS signal before sending the message. RTS remains asserted while the message is being sent and falls off when the message is complete.</td>
</tr>
</tbody>
</table>
5. Verify that all the information entered is correct. On the Configuration Editor tree, right click the new driver and then click Save. The status bar displays the message "Save was successful."

**IMPORTANT:** After all drivers have been configured, the system must be restarted.

### Network Interface Module (NIM) Driver

The NIM (Network Interface Module) driver is used to enable serial to network-based communication between DFS network RTUs and the Hyper SCADA Server.

The NIM driver is for telemetry systems with network-based RTUs. Each RTU station contains a network module - either a NIM (Network Interface Module) or a FIM (Fiber Interface Module). The network module in each RTU transfers information between the Hyper SCADA Server and its resident modules.

Optionally, the second port of any NIM/FIM can be connected to a CTU that is communicating with remote stations via radio. This configuration uses tunneling and enables the NIM/FIM to handle communications for a local networked station and radio-based remote stations. See DFS Driver and Modbus Driver for configuration instructions.

### Adding and Configuring Network RTUs

1. **Open Configuration Editor.**

2. On the Configuration Editor tree, right click Drivers and then click New.

3. Select DFS NIM as the driver type. Type a name for the driver and click Ok.

<table>
<thead>
<tr>
<th>Driver Name</th>
<th>Maximum of 20 characters. Use any combination of upper- and lower-case letters, numbers, spaces, and special characters except single (') and double (&quot;) quotation marks.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Driver Number</td>
<td>HT3 automatically assigns a driver number. It will be shown in parentheses after the driver name in the Configuration Editor tree.</td>
</tr>
</tbody>
</table>
4. The new driver is added to the Drivers list. The driver's default properties are displayed in the right panel.

Configure the following:

<table>
<thead>
<tr>
<th>NIM Driver Name</th>
<th>Leave this field as it is unless you need to edit or change the driver name.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Network Number</td>
<td>First three octets of the network on which all or a majority of the NIM/FIM stations are located followed by 255 (for example, 207.203.26.255). The number 255, which denotes a Class C network that can hold 1-254 network addresses, is automatically added to the network number; enter the first three octets only. When a station configured under this driver is polled, it will be polled at an IP address consisting of the network address specified in the <strong>Network Number</strong> box plus the network node address specified in the station’s configuration (the node address will also be the station’s number). It is possible for stations under a NIM driver to be on a different network than the one entered here. When a station is not on the default network, you must provide the full IP address of the station in the Station Configuration panel. If the stations to be configured under the driver are on several different networks, the default network entered in the <strong>Network Number</strong> box should be the network where the majority of the stations are located. This will make configuration of the stations easier, since you will only have to configure a station number for most of the stations instead of supplying a full IP address.</td>
</tr>
<tr>
<td>Route</td>
<td>When the Hyper SCADA Server (HSS) needs to transmit a message to a device that is outside its local network, it looks in its routing table for the route through which the message must be sent. For more information, see <strong>Network Routing</strong>.</td>
</tr>
<tr>
<td>Minimum Bus Speed</td>
<td>Minimum baud rate (<strong>1200</strong> or <strong>9600</strong>) at which all modules configured for this driver can communicate. To enable the fastest possible communications (9600 baud), all of the station’s I/O modules must be able to communicate at 9600 baud. I/O modules that meet this requirement are the AMM002, ACM002, DMM002, and all DCM003s.</td>
</tr>
</tbody>
</table>
If any one module at the station communicates at 1200 baud, the entire station can only communicate at that speed. In this situation, 1200 must be selected for **Minimum Bus Speed**. The exception to this is when the station contains a PLC (PLCs communicate at 9600 baud; the function modules in the station communicate through the PLC). In this situation, the communication speed of the I/O modules downstream from the PLC is irrelevant and the **Minimum Bus Speed** can be configured at 9600 baud.

| ZZ poll rate   | Number of minutes after which the system sends a ZZ message (used to synchronize the time of PLCs, PCUs and SCUs) to all network RTUs. The default setting is 2 (two) minutes.  
|               | This setting is not used with standard analog and digital modules. If there are no PLCs, PCUs, SCUs, or TCUs at any of the network RTUs, set ZZ poll rate to 0 (zero). |

5. Verify that all the information entered is correct. On the Configuration Editor tree, right click the new driver and then click **Save**. The **status bar** displays the message "Save was successful."

**IMPORTANT**: After all drivers have been configured, the system must be restarted.

**Motorola Driver**

The Motorola driver enables network- to radio-based communication between the Hyper SCADA Server and Motorola devices.

In a MOTOROLA-based system, a process called tunneling enables information from a network to be sent over radio to Motorola-type devices. A network module - either a Network Interface Module (NIM) or a Fiber Interface Module (FIM) - is placed in the Central Terminal Unit (CTU) along with the standard Motorola central radio.

The NIM/FIM acts as a "translator" between the Hyper SCADA Server and the radio-based Motorola devices. The NIM/FIM accepts network communication from the Hyper SCADA Server and translates the information into a language understood by the Motorola central radio. This "translated" information is sent to the Motorola central radio, which then forwards it to the radio-based Motorola devices. This process is reversed when the Motorola devices send communications to the Hyper SCADA Server.

It is important to note that the only module types that can be configured under a Motorola driver are DMM (SI8), DCM (CO4 & CO8), and AMM (AI6 and CI6). Any other module type will be ignored.

When configuring a Motorola station in HT3, first add a RIM004 with no points configured for it. HT3 requires that a RIM be added before any other modules can be added to a station. After adding a RIM004, use the following Motorola-DFS equivalents to configure the station:

<table>
<thead>
<tr>
<th>Basic Module</th>
<th>DMM at module address A and DCM at module address I (can place dummy DMM modules in addresses B-H)</th>
</tr>
</thead>
<tbody>
<tr>
<td>SI8</td>
<td>DMM</td>
</tr>
</tbody>
</table>
Adding and Configuring a Motorola Tunnel

1. **Open Configuration Editor.**

2. On the Configuration Editor tree, right click **Drivers** and then click **New** menu.

3. Select **MOTOROLA** as the driver type. Type a name for the driver and click **Ok**.

4. The new driver is added to the Drivers list. The driver's default properties are displayed in the right panel.

   | Driver Name                  | Maximum of 20 characters. Use any combination of upper- and lower-case letters, numbers, spaces, and special characters except single (') and double (") quotation marks. |
   | Driver Number                | HT3 automatically assigns a driver number. It will be shown in parentheses after the driver name in the Configuration Editor tree. |

Configure the following:

| Motorola Driver Name | Leave this field as it is unless you need to edit or change the driver name. |
**Tunnel IP Address**
Complete IP address of the NIM/FIM that the Motorola central radio is connected to:
- network address + NIM/FIM’s node address + number of NIM/FIM port that the Motorola central radio is connected to

For example, 207.243.62.251.1 would correspond to a network address of 207.243.62, a node address of 251, and a port number of 1.

**Route**
When the Hyper SCADA Server (HSS) needs to transmit a message to a device that is outside its local network, it looks in its routing table for the route through which the message must be sent. For more information, see [Network Routing](#).

5. Verify that all the information entered is correct. On the Configuration Editor tree, right click the new driver and then click **Save**. The **status bar** displays the message “Save was successful.”

**IMPORTANT**: After all drivers have been configured, the system must be restarted.

**Allen-Bradley Driver**

HT3 supports the Allen-Bradley DF1 serial protocol, a.k.a the Allen-Bradley PLC5 driver. Two special point types are used in Configuration Editor to support this protocol.

The EO (engineering output) and EI (engineering input) are analog-type points for use with Allen-Bradley protocol devices that report status using floating point, or engineering, values rather than raw, or integer, values.

At this time, DFS Engineers and Service Technicians must be involved in the set up and implementation of the Allen-Bradley driver. In the near future, customers and their project engineers will be able to configure HT3 to communicate with Allen-Bradley protocol devices without DFS assistance.
Stations

Stations are software representations of Remote Terminal Units (RTU). When a station is added, you supply HT3 with its logical address (station number) and a user-defined name. You then configure its properties, including its assigned partition, polling frequency, and digipeat path (if applicable). After the station (RTU) is configured and saved, you can begin adding and configuring its I/O modules.

This section includes information on the following topics:

- Adding a DFS Station
- Adding a NetDFP Station
- Adding a Modbus Station
- Adding a Motorola Station
- Adding a NIM Station
- Choosing Station Names
- Printing the Configuration of a Station
- Copying a Station
- Modifying a Station
- Deleting a Station
- Calculating Flow Volume
- Configuring a Station to Digipeat
- Station Templates

Adding a DFS or DFP Station

Review the information in Drivers: Data Flow Systems (DFS) Driver before proceeding.

IMPORTANT: When adding a DFP (Derivative Fractional Protocol) station (standard or solar version), configure the station as you would a DFS TAC II protocol station. After you save the DFP station, you must make an entry in HT3’s registry. See Derivative Fractional Protocol (DFP) for more information.

After you create and save the station, use its configuration to create a station template.

1. Open Configuration Editor.
2. Click the **Drivers** branch to open a list of configured drivers.

3. Right click the DFS driver you want to add this station to and select **New**. A list of currently configured stations opens below the driver name.

4. Enter a number and name for the station.

| **Station Number** | This logical address is obtained from the station address strap at the physical site. The station number must be unique to the driver - no other station configured under the driver can have the same number. (The same number can be used for a station configured under a different driver.)

**Note:** HT3 automatically prefixes all station numbers with their corresponding driver number unless the driver number is 0. The full station number is represented as AXXX, where A is the driver number and XXX is the station number. For example, the full station number of an RTU configured under driver 1 with a station address of 75 is 1075. This is how the station's number is listed in all sections of HT3. |
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Station Name</strong></td>
<td>Enter a descriptive name for the station. Use identifying characteristics such as street address, lift station number, or service area. See <a href="#">Choosing Station Names</a> for important information on how to format station names so that generated reports will be sorted by name rather than number (the default).</td>
</tr>
<tr>
<td></td>
<td>• Maximum of 20 characters</td>
</tr>
<tr>
<td></td>
<td>• Upper- and lower-case letters, numbers, and spaces are acceptable</td>
</tr>
</tbody>
</table>
5. Click **OK**. The station's properties are displayed in the right panel.

At the top of the panel is a button for opening a printer-friendly version of the station’s configuration. See *Printing the Configuration of a Station* for more information.

Configure the following:

<table>
<thead>
<tr>
<th>Name</th>
<th>Leave the <strong>Name</strong> field as it is unless you need to change or edit it.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Partition</td>
<td>Choose the station’s <strong>Partition</strong> from the drop-down list. <em>(Note: If you are logged in under any other than MGR, you can only assign the station to the partition that your user account is assigned to. See <strong>User Accounts</strong> and <strong>Partitions</strong> for more information.)</em></td>
</tr>
</tbody>
</table>
| Priority (DFS RTU stations only) | Station’s polling priority. Selecting an option other than **Normal** causes HT3 to poll the station more or less than the norm.  
- **High** - HT3 will poll the station X times per polling loop, where X is the **High Priority ratio** of the driver this station belongs to.  
- **Low** - HT3 will poll the station after making Y polling loops, where Y is the **Low Priority ratio** of the driver this station belongs to.  
- **Out of Service** - HT3 will not poll the station. This is useful when a station is undergoing maintenance that requires that equipment be disconnected or turned off. *(Note: An offline alarm will not be generated for the station. However, the status of the station will show offline on the **Station Status Viewer**, custom screens, and reports if telemetry is stopped and restarted while the station is out of service.)* |

When selecting a polling priority, consider how it will affect the overall system and the accuracy of the data sent from the station.
Too many stations with a high priority may slow down the polling loop without increasing the accuracy of the data.

Data collected from a station with highly-granular data (values that change frequently) may lose accuracy if the station is given low priority.

| Offline count | Number of consecutive polling errors before an offline status is returned. Type a value in the **Offline count** box or use the arrows to select a value. Value must be between 1 and 99. Default value is 8. |
| Retries | Number of attempts before a control is considered failed. Type a value in the **Retries** box or use the arrows to select a value. |
| Timeout | Length of time (in tenths of a second) to wait for a station to reply. For a DFS station, the default is 2 seconds. The maximum timeout is 5 seconds. |
| Volume | Volume between the OFF and LEAD levels of a well or tank. This figure is required in order to calculate flow rates for the **Derived Flow Report**. Volume can be a value between zero and 9999 gallons. See **Calculating Flow Volume** for instructions on determining tank and well volume. Clicking the arrow next to the **Volume** box brings up a calculator. Use the calculator to compute the well or tank volume or enter a value directly in the **Volume** box. |
| Digipeat path (DFS drivers only) | Digipeating (digitally repeating) uses relay stations (digipeaters) to transmit data between a remote target station and the CTU. Dipeating is useful when radio frequencies are blocked by trees or buildings or when the distance to be traveled is greater than that which can be covered by one direct signal. Use the drop-down lists to select the stations that represent the digipeating path. You must indicate the full digipeating path for the station being configured. Select each station between the CTU and the target station (station being configured) that the signal must pass through. **Notes:**

- **Digipeat path**: The station selected for the first position (1) should be the station that is closest to the CTU (master station).

- It isn’t necessary to increase the **Timeout** value of the target station. The system allows the cumulative timeout value for all the station's digipeaters to pass before issuing a timeout error.

- **Abort** and **No Response** radio errors for this station are logged to the first digipeater (station closest to the CTU). They are not logged to the target station.

See **Configuring a Station to Digipeat** for a more detailed description of digipeating.

6. Verify that all of the information is correct. On the Stations branch, right click the new station and click **Save** on the pop-up menu. The **status bar** displays the message “Save was successful.”
7. If this configuration is for a **standard DFP (Derivative Fractional Protocol) or solar DFP station**, an entry must be made in HT3’s registry. See [Derivative Fractional Protocol (DFP)](#) for more information.

**IMPORTANT:** When configuration is complete, [Update Polling](#) must be performed.
Adding a NetDFP Station

The NetDFP driver must have been added and configured by DFS personnel before you can add a NetDFP (cellular) station. Review the information in Drivers: Network Derivative Fractional Protocol (NetDFP) before proceeding.

### RDP180-C / Cellular SCADA System

More information on the RDP180-C and setting up and configuring a cellular SCADA system can be found in the *RDP180-C Cellular RTU Installation and Operation Manual* (available for download from the Open Control Solutions website at www.opencontrolsolutions.com/rdp180-cellular-rtu.php).

### Station Number

The station number configured in HT3 must be unique (cannot be assigned to any other NetDFP station), and it must match the station number that was configured using the Process Management Toolkit (PMT) software. (Station number is one of the global properties configured in PMT. Refer to the section "Defining Global Properties and Events" in Chapter 3: Configuring RTU Settings of the *RDP180-C Cellular RTU Installation and Operation Manual*.)

Note that there are no hardware settings in the RTU that define the station number.

### Station Name

We suggest using a station naming scheme that combines the RTU’s location and telephone number. For example, Main St 3215551212

> After you create and save the station, use its configuration to create a station template.

1. Open Configuration Editor.
2. Click the **Drivers** branch to open a list of all configured drivers.
3. Right click the NetDFP driver and select **New**. A list of currently configured stations opens below the driver name.
4. Enter a number and name for the station.

![New Station on NET_DFP dialog box](image)

<table>
<thead>
<tr>
<th>Station Number</th>
<th>This must be a unique number (cannot be assigned to any other NetDFP station), and it must match the station number configured for this RTU in PMT.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Station Name</td>
<td>We suggest using a station naming scheme that combines the RTU’s location and telephone number. For example, Main St 3215551212</td>
</tr>
</tbody>
</table>

Enter a descriptive name for the station. Use identifying characteristics such as street address, lift station number, or service area. See Choosing Station Names for important information on how to format station names so that generated reports will be sorted by name rather than number (the default).

- Maximum of 20 characters
- Upper- and lower-case letters, numbers, and spaces are acceptable
- Special characters except single (') and double (") quotation marks can be used

5. Click OK. The station is added to the Configuration Editor tree along with the corresponding Modbus register ranges. The station's properties are displayed in the right panel.

**Leave all properties at their default values.**

At the top of the panel is a button for opening a printer-friendly version of the station's configuration. See Printing the Configuration of a Station for more information.
6. Verify that all of the information is correct. On the Stations branch, right click the new station and click **Save** on the pop-up menu. The **status bar** displays the message "Save was successful."

<table>
<thead>
<tr>
<th>IMPORTANT: When configuration is complete, <strong>Update Polling</strong> must be performed.</th>
</tr>
</thead>
</table>

You are now ready to **add points (I/O)** to your station. Before proceeding, review the information provided in the *RDP180-C Cellular RTU Installation and Operation Manual* (Refer to the section "Adding I/O" in Chapter 3: Configuring RTU Settings).
Adding a Modbus Station

Review the information in Drivers: Modbus Driver before proceeding. Check the Modbus template branch to see if there is a template for the type of Modbus station you are adding.

After you create and save the station, use its configuration to create a station template.

1. Open Configuration Editor.

2. Click the Drivers branch to open a list of all configured drivers.

3. Right click the Modbus driver you want to add this station to and click New. A list of currently configured stations opens below the driver name.

4. Enter a number and name for the station.
Station Number | This is a unique logical ID that is used in conjunction with the **Driver Number** to identify a device (typically a PLC). The station number must be unique to the driver - no other station configured under the driver can have the same number. (The same number can be used for a station configured under a *different* driver.) Certain rules apply depending on the protocol being used to poll the device.

**Modbus RTU or ASCII** | The station number must match the device's unit (or slave) ID.

**Modbus TCP** | In HT3, a station number (not an IP address) is used to identify a device.

In most cases, the station number is the device's node address (fourth octet of a standard IP address). See "Advanced Modbus TCP Settings," below, for information on situations where this does not apply.) The station number is used in ladder logic programs, custom screens, and trends. If the device's IP address changes, you only need to change the Port (IP) address in the station configuration (discussed below). All references to the station in ladder logic, custom screens, and trends can remain as is.

**Note:** HT3 automatically prefixes all station numbers with their corresponding driver number unless the driver number is 0. The full station number is represented as AXXX, where A is the driver number and XXX is the station number (a station number less than three digits is preceded by 0's). For example, 1075 is the full station number of an RTU configured under driver 1 with a station address of 75. This is how the station's number will be listed in all parts of HT3.

Station Name | Enter a descriptive name for the station. Use identifying characteristics such as street address, lift station number, or service area. See **Choosing Station Names** for important information on how to format station names so that generated reports will be sorted by name rather than number (the default).

- Maximum of 20 characters
- Upper- and lower-case letters, numbers, and spaces are acceptable
- Special characters *except* single (') and double (") quotation marks can be used

---

5. Click **OK**. The station is added to the Configuration Editor tree along with the corresponding Modbus register ranges. The station's properties are displayed in the right panel.

At the top of the panel is a button for opening a printer-friendly version of the station's configuration. See **Printing the Configuration of a Station** for more information.
Configure the following:

<table>
<thead>
<tr>
<th>Name</th>
<th>Leave the Name field as it is unless you need to change or edit it.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Port (IP)</td>
<td><strong>Is the device on same network as the driver?</strong></td>
</tr>
<tr>
<td>(optional)</td>
<td>• Yes - Leave this field blank, or enter the device's network node address (fourth octet of its IP address)</td>
</tr>
<tr>
<td></td>
<td>• No - Enter device's full IP address</td>
</tr>
<tr>
<td></td>
<td>See &quot;Advanced Modbus TCP Settings,&quot; below, for more information.</td>
</tr>
<tr>
<td>Device Type</td>
<td><strong>Is the device you are configuring listed in the drop-down menu (HSS, Momentum, RDP033, RIO032, RIO028, TCU, or XG2)?</strong> If so, selecting it will enable the server to poll it more efficiently.</td>
</tr>
<tr>
<td>(optional)</td>
<td></td>
</tr>
<tr>
<td>Partition</td>
<td>Choose the station’s from the drop-down list. (Note: If you are logged in under any other than MGR, you can only assign the station to the partition that your user account is assigned to. See User Accounts and Partitions for more information.)</td>
</tr>
<tr>
<td>Volume</td>
<td>Not applicable.</td>
</tr>
<tr>
<td>Out of Service</td>
<td>Enable this setting to prevent HT3 from polling this station. This is useful when a station is undergoing maintenance that requires that equipment be disconnected or turned off. (Note: An offline alarm will not be generated for the station. However, the status of the station will show offline on the Station Status Viewer, custom screens, and reports if telemetry is stopped and restarted while the station is out of service.)</td>
</tr>
</tbody>
</table>
### Device Address (optional)

This setting is optional unless there are several devices at the same IP address. In that situation, each device must be configured with a unique device address to avoid communication conflicts. (In some Modbus TCP/IP literature, this is referred to as the Unit ID.)

If you leave this field empty, HT3 uses the station number as the device address.

See "Advanced Modbus TCP Settings," below, for more information.

### Poll Rate

Rate (measured in seconds) at which this station should be polled.

- Small number = faster poll rate
- Larger number = slower poll rate
- For "pop-up only" operation, set the poll rate to 0 (zero).

When selecting a poll rate, consider how rapidly the points at the station change and how often you need readings from the points.

- If a point changes rapidly and the poll rate number is too large (slow poll rate), the data gathered may be inaccurate.
- Setting the poll rate to a small number (fast poll rate) may result in unnecessary network traffic without increasing the accuracy of the data.

### Time Out

Length of time (in tenths of a second) to wait for a station to reply.

For a Modbus station, the default is 2 seconds. The maximum timeout is 9.9 seconds.

### Retries

Number of attempts before a control is considered failed. Type a value in the **Retries** box or use the arrows to select a value.

### Offline Count

Number of consecutive polling errors before an offline status is returned. Type a value in the **Offline count** box or use the arrows to select a value.

Value must be between 1 and 99. Default value is 8.

6. Verify that all of the information is correct. On the Stations branch, right click the new station and click **Save** on the pop-up menu. The status bar displays the message "Save was successful."

| IMPORTANT: | When configuration is complete, **Update Polling** must be performed. |
**Advanced Modbus TCP Settings**

To determine the values for **Station Number**, **Port (IP)**, and **Device Address**, you must know the following:

1. **Is the device on the default network?** When a Modbus driver is configured, the network portion of an IP address (the first three octets) is entered in the **Default Port (IP) box** of the driver configuration. The driver's network is referred to as the "default network."

2. **What is the device address of the device you are configuring?** For newer equipment, the Modbus device address is typically set via software. Older equipment may use an address strap or dip switches to set the device address. Check the documentation that came with your device.

3. **Are there several devices at the same IP address?** If so, each one must have a unique device address.

**Station Number**

| Device is on the default network | Use the device's node address (the last octet of its IP address) for the Station Number. |
| Device is on a different network | Select any unused station number for the driver this device is being configured under. |

**Port (IP)**

| Device is on the default network | **Port (IP)** is optional (can be left blank). If the **Port (IP)** box is empty, the IP address is created using the first three octets from the Driver's configuration and the station number as the last octet. Alternatively, you can enter the device's network node address (fourth octet of its IP address). |
| Device is on a different network | Enter the device's full IP address in the **Port (IP)** box |

**Device Address**

**Important:** If you don't enter a **Device Address**, HT3 uses the station number as the **Device Address**

| Single device at this IP address | A device address is optional in this situation. If you leave the Device Address field empty, HT3 uses the station number as the device address. |
| Several devices at same IP address | If there are several devices at the same IP address, each one must have a unique device address. In the **Device Address** box, you must enter the address for the device you are configuring. (In some Modbus TCP/IP literature, this is referred to as the Unit ID.) |
Adding a Motorola Station

Review the information in Drivers: Motorola Driver before proceeding.

After you create and save the station, use its configuration to create a station template.

1. Open Configuration Editor.

2. Click the Drivers branch to open a list of all configured drivers.

3. Right click the Motorola driver you want to add this station to and click New. A list of currently configured stations opens below the driver name.

4. Enter a number and name for the station.

| Station Number | This logical address is obtained from the station address strap at the physical site. The station number must be unique to the driver - no other station configured under the driver can have the same number. (The same number can be used for a station configured under a different driver.) |
Note: HT3 automatically prefixes all station numbers with their corresponding driver number unless the driver number is 0. The full station number is represented as AXXX, where A is the driver number and XXX is the station number. For example, the full station number of an RTU configured under driver 1 with a station address of 75 is 1075. This is how the station's number is listed in all sections of HT3.

**Station Name**
Enter a descriptive name for the station. Use identifying characteristics such as street address, lift station number, or service area. See Choosing Station Names for important information on how to format station names so that generated reports will be sorted by name rather than number (the default).
- Maximum of 20 characters
- Upper- and lower-case letters, numbers, and spaces are acceptable
- Special characters except single (') and double (") quotation marks can be used

5. Click OK. The station's properties are displayed in the right panel.

At the top of the panel is a button for opening a printer-friendly version of the station's configuration. See Printing the Configuration of a Station for more information.

Configure the following:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Leave the Name field as it is unless you need to change or edit it.</td>
</tr>
<tr>
<td>Partition</td>
<td>Choose the station's partition from the drop-down list. (Note: If you are logged in under any other than MGR, you can only assign the station to the partition that your user account is assigned to. See User Accounts and Partitions for more information.)</td>
</tr>
<tr>
<td>Offline Count</td>
<td>Number of consecutive polling errors before an offline status is returned. Type a value in the Offline count box or use the arrows to select a value. Value must be between 1 and 99. Default value is 8.</td>
</tr>
<tr>
<td>Retries</td>
<td>Number of attempts before a control is considered failed. Type a value in the Retries box or use the arrows to select a value.</td>
</tr>
<tr>
<td>Poll Rate</td>
<td>Rate (measured in seconds) at which this station should be polled.</td>
</tr>
<tr>
<td></td>
<td>• Small number = faster poll rate</td>
</tr>
</tbody>
</table>
When selecting a poll rate, consider how rapidly the points at the station change and how often you need readings from the points.

- Larger number = slower poll rate
- For "pop-up only" operation, set the poll rate to 0 (zero).
- If a point changes rapidly and the poll rate number is too large (slow poll rate), the data gathered may be inaccurate.
- Setting the poll rate to a small number (fast poll rate) may result in unnecessary network traffic without increasing the accuracy of the data.

| Volume | Not applicable to Motorola stations. |

6. Verify that all of the information is correct. On the Stations branch, right click the new station and click **Save** on the pop-up menu. The status bar displays the message "Save was successful."

**IMPORTANT:** When configuration is complete, **Update Polling** must be performed.
Adding a NIM Station
Review the information in Drivers: NIM Driver before proceeding.

After you create and save the station, use its configuration to create a station template.

1. Open Configuration Editor.

2. Click the Drivers branch to open a list of all configured drivers.

3. Right click the NIM driver you want to add this station to and click New. A list of currently configured stations opens below the driver name.

4. Enter a number and name for the station.
Station Number | Network interface module's (network) node address, i.e., the fourth octet of a standard IP address (Note: HT3 automatically prefixes all station numbers with their corresponding driver number unless the driver number is 0. Therefore the full station number is represented as AXXX, where A is the driver number and XXX is the station number. For example, the full station number of an RTU that has a station address of 75 and has been configured under driver 1 is 1075. This is how the station's number will be listed in all sections of HT3 after a successful configuration).

Station Name | Enter a descriptive name for the station. Use identifying characteristics such as street address, lift station number, or service area. See Choosing Station Names for important information on how to format station names so that generated reports will be sorted by name rather than number (the default).

- Maximum of 20 characters
- Upper- and lower-case letters, numbers, and spaces are acceptable
- Special characters except single (') and double (") quotation marks can be used

5. Click OK. The station's properties are displayed in the right panel.

At the top of the panel is a button for opening a printer-friendly version of the station's configuration. See Printing the Configuration of a Station for more information.

Configure the following:

<table>
<thead>
<tr>
<th>Name</th>
<th>Leave the Name field as it is unless you need to change or edit it.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Port (IP)</td>
<td>For a station on the default network, Port (IP) is the network node address (fourth octect) of the device. For a station not on the default network, the full IP address of the device must be entered in this box. See the description for Network Number in the section NIM Driver: Adding and Configuring Network RTUs for more information.</td>
</tr>
<tr>
<td><strong>Partition</strong></td>
<td>Choose the station’s partition from the drop-down list. (Note: If you are logged in under any user other than MGR, you can only assign the station to the partition that your user account is assigned to. See User Accounts and Partitions for more information.)</td>
</tr>
<tr>
<td><strong>Volume</strong></td>
<td>Volume between the OFF and LEAD levels of a well or tank. This figure is required in order to calculate flow rates for the Derived Flow Report. Volume can be a value between zero and 9999 gallons. See Calculating Flow Volume for instructions on determining tank and well volume. Clicking the arrow next to the Volume box brings up a calculator. Use the calculator to compute the well or tank volume or enter a value directly in the Volume box.</td>
</tr>
<tr>
<td><strong>Out of Service</strong></td>
<td>Enable this setting to prevent HT3 from polling this station. This is useful when a station is undergoing maintenance that requires that equipment be disconnected or turned off. (Note: An offline alarm will not be generated for the station. However, the status of the station will show offline on the Station Status Viewer, custom screens, and reports if telemetry is stopped and restarted while the station is out of service.)</td>
</tr>
</tbody>
</table>
| **Poll Rate** | Rate (measured in seconds) at which this station should be polled.  
- Small number = faster poll rate  
- Larger number = slower poll rate  
- For "pop-up only" operation, set the poll rate to 0 (zero).  
When selecting a poll rate, consider how rapidly the points at the station change and how often you need readings from the points.  
- If a point changes rapidly and the poll rate number is too large (slow poll rate), the data gathered may be inaccurate.  
- Setting the poll rate to a small number (fast poll rate) may result in unnecessary network traffic without increasing the accuracy of the data. |
| **Time Out** | Length of time (in tenths of a second) to wait for a station to reply.  
The default for a NIM station is 1 second. Time out must be a value between 0.2 and 15 seconds. |
| **Retries** | Number of attempts before a control is considered failed. Type a value in the Retries box or use the arrows to select a value. |
| **Offline count** | Number of consecutive polling errors before an offline status is returned. Type a value in the Offline count box or use the arrows to select a value.  
Value must be between 1 and 99. Default value is 8. |

6. Verify that all of the information is correct. On the Stations branch, right click the new station and click Save on the pop-up menu. The status bar displays the message "Save was successful."

**IMPORTANT:** When configuration is complete, Update Polling must be performed.
Choosing Station Names
Station names can be formatted in a particular way to enable HT3 reports to sort them by station name rather than by station number (the default).

To force reports to sort by the station name field the following format must be used:

[alpha character][numeric string][alphanumeric string]

Examples:
- S 394 Main St. #2
- A7 Elm Park
- H23 State Street

Rules:
The following rules apply when using this format to name stations:

- The alpha character can be any letter, but must only be a single character. You don't have to use the same letter for every station. However, we recommend that you not use the letter V; V is used when naming virtual points.
- You can insert a space between the alpha character and the numeric string. For example, both S 38 and S38 are valid.
- Each numeric string can be of variable length, but cannot extend beyond the sixth character. That is:
  - not all stations have to have strings that are the same length
  - each numeric string can only be 1-5 digits in length unless a space is inserted after the alpha character
  - If a space is inserted after the alpha character, the numeric string can only be 1-4 digits in length
- The following are valid:
  - one letter and a five-digit number
  - one letter, a space, and a four-digit number
- The following are not valid:
  - one letter and a six-digit number
  - one letter, a space, and a five-digit number.
- Inserting a space between the numeric string and the alphanumeric string is optional. For example, both S38Main and S38 Main are valid. Typically, a space would be inserted to improve readability.
IMPORTANT: If any one station does not follow the format, the system reverts to sorting by the station number field.

When stations are named using this format, the system recognizes that it should sort according to the station’s name field. It reads the alpha character, but does not sort by it. The system sorts, in ascending order, based upon the numeric string that follows the alpha character.

For example, the list shown above would be listed in the following order.

- A7 Elm Park
- H23 State Street
- S 394 Main St. #2

When generating reports, the station’s name prefix (the alpha character-numeric string portion of the name, for example S394) can be typed in the Report Source box. The report program will find the station by name instead of by number.

Printing the Configuration of a Station
HT3 provides two methods for printing the configuration of any station in your system:

- Station number button in Configuration Editor
- Station Configuration Report

Print Configuration Using Station Number Button

When you select a station on the Configuration Editor tree, the station's properties are displayed in the right panel. The name of each station is a button (as shown in the example below).
When this button is clicked, a new window with a printer-friendly version of the station's configuration is opened.

- At the top of the page is a table listing the station's settings, including the partition it is assigned to, its polling priority, and its volume.

- The second table lists each module at the station and the module's associated I/O points.

To print the page, select **Print** from the browser's **File** menu. To return to HT3, close or minimize the window that is displaying the station configuration.

### Station Configuration Report

1. Click **Reports** on the HT3 main menu
2. Click **Station Configuration** on the Reports submenu.
3. A table listing all configured stations opens. By default, the stations are listed by station number. To list the stations by station name, click the "Station Listing" title.
4. Click the name or number of a station to view its configuration.
5. To view a printer-friendly version of the configuration, click the **Print Station Configuration** link (located at the top-right and bottom-right of the report). The printer-friendly version opens in a new window.
6. To print the page, select **Print** from the browser's **File** menu. To return to HT3, close or minimize the window that is displaying the station configuration.
Copying a Station

You can copy a station (and all of its corresponding telemetry items) to either the current driver or from the current driver to another driver. For example, if you add a pumping station and its configurations are the same as an existing one, you can copy the existing configuration and simply give it a new station number.

**Note:** The station type must match the driver type. For example, a DFS station can only be copied to a DFS driver.

There are two methods of copying a station - drag-and-drop and copy-and-paste.

**Drag and Drop**

1. **Open Configuration Editor.**
2. On the Configuration Editor tree, browse to the station you want to copy.
3. Hold down the left mouse button and drag the station (the cursor becomes a cross with four arrows) over the name of the driver you want to add this station to.
4. The pointer becomes a hand when it is positioned over a valid driver name. Make sure that the name of the driver is highlighted and then release the mouse button.
5. The **Copy station** dialog box opens. Enter a station number for the new station. Review the information for the type of station you are copying for details on selecting station numbers: DFS Station; Modbus Station; Motorola Station; NIM Station.

6. Click **OK**. The **Copy Station?** dialog box opens.
7. Click **Yes** to complete the copy process. Collapse the Stations list and the expand it to verify that the new station was successfully added.
8. Select the new station and configure its properties. Refer to the instructions provided for the particular station you are adding: DFS Station; Modbus Station; Motorola Station; NIM Station.
9. Verify that all of the information is correct. On the Configuration Editor tree, right click the new station and click **Save** on the pop-up menu. The status bar displays the message "Save was successful."
10. Repeat steps 1-8 to copy additional stations.

| IMPORTANT | When configuration is complete, Update Polling must be performed. |

**Copy and Paste**

1. Open Configuration Editor.

2. On the Configuration Editor tree, browse to the station you want to copy. Right click the station and click **Copy** on the pop-up menu.

3. Select the name of the driver to which you want to copy this station. Right click the driver name and click **Paste** on the pop-up menu.

4. The **Copy station** dialog box opens. Enter a station number for the new station. Review the information for the type of station you are copying for details on selecting station numbers: DFS Station; Modbus Station; Motorola Station; NIM Station.

5. Click **OK**. The **Copy Station?** dialog box opens.

6. Click **Yes** to complete the copy process. Collapse and expand the Stations list. The new station is added to the list.
7. Select the new station and configure its properties. Refer to the instructions provided for the particular station you are adding: DFS Station; Modbus Station; Motorola Station; NIM Station.

8. Verify that all of the information is correct. On the Configuration Editor tree, right click the new station and click Save on the pop-up menu. The status bar displays the message "Save was successful."

9. Repeat steps 1-8 to copy additional stations.

| IMPORTANT: When configuration is complete, Update Polling must be performed. |

### Modifying a Station

1. Open Configuration Editor.

2. On the Configuration Editor tree, select the station you want to edit. Its properties are displayed in the right panel.

3. Make the desired changes.

4. Verify that all of the information is correct. On the Configuration Editor tree, right click the station that was edited and click Save on the pop-up menu. The status bar displays the message "Save was successful."

| IMPORTANT: When configuration is complete, Update Polling must be performed. |

### Deleting a Station

**WARNING:** Deleting a station also deletes all modules and points assigned to it!!

1. Open Configuration Editor.

2. On the Configuration Editor tree, right click the station you want to delete and click Delete on the pop-up menu.

3. Click Yes at the Are you sure? dialog box.

4. If you want to continue with the delete process, click Yes at the Delete Station? dialog box.

| IMPORTANT: When configuration is complete, Update Polling must be performed. |
Calculating Flow Volume

1. Determine the difference between the OFF Level and the LEAD Level (Liquid Height) in feet.

   \[ \text{Liquid Height} = \text{LEAD Level} - \text{OFF Level} \]

2. Calculate the area of the well or tank.

   Rectangular well or tank: \( \text{Area} = \text{Width} \times \text{Length} \)

   Circular well or tank: \( \text{Area} = \pi \times \text{Radius}^2 \)

3. Calculate the volume in cubic feet (ft³).

   \[ \text{Vol (ft}^3) = \text{Liquid Height} \times \text{Area} \]

4. Convert Vol (ft³) to gallons

   \[ \text{Vol (gallons)} = \text{Vol (ft}^3) \times 7.48 \]

Configuring a Station to Digipeat

Note: In the paragraphs below, the station being configured is referred to as the target station.

Digipeating (digitally repeating) is a process by which packets of information (queries and responses) are transmitted to and from a remote target station via relay stations, or digipeaters.

Under normal circumstances, the HT3 computer sends a message to the master station, or Central Terminal Unit (CTU), which then broadcasts to all of the outlying remote stations. See illustration below.
Digipeating provides a way to communicate with stations that otherwise would be unable to receive signals because of obstructions (tall buildings or unique topography) or because the station is at too great a distance from the CTU. In this situation, relay stations are used to pass information from the CTU to the target station. See illustration below.

A station can be configured to digipeat through as many as four (4) relay stations, or digipeaters. These digipeaters are specified in the **Digipeat path** section of the station configuration screen.

The first digipeater listed under **Digipeat path** is the station that is closest to the CTU. In the example above, Main Street is the closest station to the CTU. Main Street receives data from the CTU and then forwards the data to Elm Street. Elm Street forwards the data to the target station, Washington Street (the station we are configuring). The digipeating path is as follows:

**CTU > Main Street > Elm Street > Washington Street**

When Washington Street sends its response back to the CTU, the signal is sent via the following path:

**Washington Street > Elm Street > Main Street > CTU**

**IMPORTANT**: For each station that is using digipeating, you must indicate the full digipeating path.

In the example above, we can see that Washington Street is using the Main Street and the Elm Street stations as digipeaters. (CTU > Main Street > Elm Street > Washington Street)
The screenshot below shows that the Elm Street station is also using Main Street as a digipeater. (CTU > Main Street > Elm Street)

It is incorrect to assume that because Elm Street is configured with Main Street as a digipeater, that you can simply list Elm Street in the configuration for the Washington Street station. Each station configuration is its own entity. The system does not compare the digipeating paths of each station to determine how data should be packaged and routed.

If Elm Street was the only listed digipeater, the system would attempt to route the information as follows:

CTU > Elm Street > Washington Street.

Washington Street would never receive its messages, because the information would not be packaged correctly.

Notes:

- It is not necessary to increase the Timeout value of the target station. The system allows the cumulative Timeout for all the station’s digipeaters to pass before issuing a timeout error.

- If a station that uses digipeating experiences any Abort or No Response radio errors, they will only be logged to the first digipeater in its digipeating path (station closest to the CTU). They will not be logged to the target station.

Station Templates

If your system has multiple stations with the same basic configuration (same or similar modules and points), you can use one station as a template for the others or you can select a preconfigured template from one of the template branches.

There are three station template branches under the Drivers branch:

- Templates - Templates for any non-Modbus stations can be stored here. This branch includes the following default templates: PCU Station, TCU Station, and Module Station. The Module Station template includes one of each module type that DFS offers (digital input and output modules, analog input and output modules, radio module).
• **Modbus templates** - Templates for **Modbus-type stations** can be stored here.

**Note:** Configuration Editor is designed to block a station template from being copied and pasted to the incorrect driver type. For example, a DFS station template can't be copied and pasted to a Modbus driver. The same rules apply when copying and pasting station configurations to the template branches.

## Creating Templates

You can use an existing station as a template or you can create one from scratch. The procedure for creating and using a template is the same for DFS and Modbus stations.

### Using an existing station

Use an existing station as a template by copying the station to the correct template branch. Use **Copy and Paste** or **Drag and Drop**.

### Creating a template from scratch

1. Right click the branch for the type of station you are creating a template for (**Templates** or **Modbus Templates**) and select **New**.

2. Configure the station as you normally would based on its type (DFS, DFP, Solar, NetDFP, Modbus, or NIM). Add the desired modules (DFS-type drivers only) and points.

## Using Templates

1. Expand the branch that contains the template you want to use (**Templates** or **Modbus Templates**).

2. Find the template you want to use. Use **Copy and Paste** or **Drag and Drop** to copy the station template to the appropriate driver.

3. Make any necessary changes to the properties of the station and its associated I/O points.

4. Right click the new station and click **Save** on the pop-up menu. The status bar displays the message "Save was successful."

5. When configuration is complete and the new station has been saved, **Update Polling** must be performed.
Modules

DFS radio and network RTUs (stations) are equipped with modules that provide communication (radio or network) and I/O (analog and digital). For more information on the types of modules DFS offers, download the TAC II SCADA System Installation Planning Guide from the DFS website: http://www.dataflowsys.com/support/literature.php

This section provides instructions for adding and configuring the modules installed in the station. After the modules have been added and configured, their corresponding I/O points are added and configured from the points branch.

The first module added to a station must be a Radio Interface (RIM) module. If the station is a Network RTU - one that uses a Network Interface Module (NIM) or Fiber Interface Module (FIM) in place of a RIM) - select RIM006 for module type. For more information on Network RTUs, see Drivers: NIM Driver.

The sections below provide information on configuring modules:

- Adding and Configuring a Module
- Copying a Module
- Deleting a Module

Adding and Configuring a Module

1. Open Configuration Editor.

2. On the Configuration Editor tree, select the station you want to add a module to. Right click the station name and click New on the pop-up menu.

3. If this is the first module being added to the station, the New module (R) dialog box opens.

Select a RIM type from the drop-down list.
Notes:

- Select RIM006 if configuring modules for a Network RTU - an RTU that uses a NIM or a FIM. (See Drivers: NIM Driver for more information.)
- When configuring for RIM004 and earlier, make your selection based on firmware version.
- TakPak is equivalent to a RIM006 configured under a PCU.

4. If a RIM has already been added, the New module (x) dialog box opens (where x represents the system-assigned letter of the module). The first module added will be A, followed by B, C, etc.

Select the module's type from the drop-down list and click Ok. (Note: A PAM is the equivalent of a DMM002; PCM is equivalent to consecutive modules DMM001 and DCM001.)

5. On the Configuration Editor tree, right click the new module's name and click Save on the pop-up menu. The status bar displays the message "Save was successful."

6. Repeat steps 2-5 to configure more modules.

**IMPORTANT:** When configuration is complete, Update Polling must be performed.

### Copying a Module

You can copy a module - and all of its corresponding telemetry items - to either the current station or from the current station to another.

There are two methods of copying a module:

- Drag and drop
- Copy and paste

### Drag and Drop

1. Open Configuration Editor.
2. On the Configuration Editor tree, select the module you want to copy.
3. Hold down the left mouse button and drag the module (the cursor becomes a cross with four arrows) over the name of the station you want to add this module to.
4. The pointer becomes a hand when it is positioned over the station's name. Make sure that the name of the station is highlighted and then release the mouse button.

5. The Copy module (x) dialog box opens (where x represents the letter of the module being copied). Select the letter you want to assign the module to and click Ok.

![Copy module dialog box](image)

If the chosen letter has already been assigned to a module, an error message opens.

![Error message](image)

Click OK and repeat steps 1-4.

6. Collapse the Modules list and then expand it to verify that module has been copied to the station. Right click the new module's name and click Save on the pop-up menu.

7. Repeat steps 1-6 to copy more modules.

| IMPORTANT: When configuration is complete, Update Polling must be performed. |

## Copy and Paste

1. Open Configuration Editor.

2. On the Configuration Editor tree, right click the module you want to copy and click Copy on the pop-up menu.

![Configuration Editor tree](image)

3. Right click the station you want to copy the module to and click Paste on the pop-up menu.
4. The **Copy module** (x) dialog box opens (where x represents the letter of the module being copied). Select the letter you want to assign the copied module to and click **Ok**.

![Copy module dialog box](image)

If the chosen letter has already been assigned to a module, an error message is displayed.

![Error message](image)

Click **OK** and repeat steps 2 and 3.

5. Collapse the Modules list and then expand it to verify that the module was copied to the station. Right click the new module's name and click **Save** on the pop-up menu. The status bar displays the message "Save was successful."

6. Repeat steps 2-5 to copy more modules.

**IMPORTANT**: When configuration is complete, **Update Polling** must be performed.

### Deleting a Module

**WARNING**: Deleting a module deletes all points assigned to it!!

1. **Open Configuration Editor**.

2. On the Configuration Editor tree, right click the module you want to delete and click **Delete** on the pop-up menu.

3. Click **Yes** at the **Are you sure?** dialog box.

4. To continue with the delete process, click **Yes** at the **Delete Module?** dialog box.
IMPORTANT: When configuration is complete, Update Polling must be performed.
Points

Points are software representations of the analog and digital I/O contained in your telemetry system's RTUs (stations).

Information for each point, including the point's type, user-defined name, and its high and low values are configured.

**IMPORTANT**: HT3 includes support for the Allen-Bradley DF1 serial protocol, a.k.a the Allen-Bradly PLC5 driver. At this time, DFS Engineers and Service Technicians must be involved in the set up and implementation of the Allen-Bradley driver.

The EO (engineering output) and EI (engineering input) are analog-type points for use with Allen-Bradley protocol devices that report status using floating point, or engineering, values rather than raw, or integer, values. These point types should *only* be used with Allen-Bradley devices; do *not* attempt to use them with DFS or Modbus points.

The sections below provide information on configuring your system’s I/O points.

- Adding an Analog Point
- Adding a Digital Point
- Adding a Digital Pulse Point
- Modifying a Point's Configuration
- Deleting a Point

For information on using the PLC/TCU’s unused memory locations as set points, see PLC/TCU Set Points (AKA "Q" Points).
Adding and Configuring an Analog Point

1. Open Configuration Editor.

2. On the Configuration Editor tree, right click the module (DFS) or Modbus register range you want to add a point to and click New on the pop-up menu.

3. In the New Point dialog box, select the point's number and type from the drop-down list and click Ok.

4. The point is listed below the module/range it was added to. Its default properties are displayed in the right panel. The name of the point is listed as "New" until you give it a descriptive name.
Configure the following properties:

- **Name** - User-defined name of this point. The point’s name can be a maximum of 20 characters. (Ex. Well Level, Phase AC Voltage)

- **Low Raw Value** - This value is determined by the number of bits on the device. (0 miliamp = 0 raw, 4 miliamps = 820 raw). Type a value or use the slider to set the value. This box accepts both 12-bit and 16-bit values. For a 16-bit value that exceeds 4095, type the value in the text box. The slider has a maximum value of 4095.

- **Low Engineering Value** - Low value of the device’s range. This is the number displayed on screen. Typically, this value is 0 (zero).

- **High Raw Value** - Number sent over air by card of wired device. This value is determined by the number of bits on the card [20 miliamps = 4095 (12-bit) or 65535 (16-bit)]. Type a value or use the slider to set the value. This box accepts both 12-bit and 16-bit values. For a 16-bit value that exceeds 4095, type the value in the text box. The slider has a maximum value of 4095.

- **High Engineering Value** - Full range of device. This is the number displayed on screen. Typically, this value is 100 (equal to 20 miliamps).

- **Resolution** - Minimum change to be reported (in engineering units). Type a value or click the arrow to the right of the box to use the built-in calculator to compute the resolution. [Note: The minimum resolution recognized by HT3 is 4 (four) raw units.]

- **Units** - Units of measurement for this point. (Ex. FT, %, DegF)

- **Qualifier (analog inputs only)** - Address entered in this box tells the system to only gather report data when the qualifier address (point) is on. When this box is left empty, the point is always qualified and all data is used for report. Type a telemetry address or use the Browse button to locate the qualifier.

- **Slew Rate (analog control points only)** - Must be a value between 0 (default) and 8. A slew rate of 0 results in fast, abrupt changes of voltage or current. Larger numbers let the change occur more slowly and smoothly. Use the slider to set the value for slew rate.
5. Verify that all the information entered is correct. Right click the new point and select **Save** from the pop-up menu. The status bar displays the message "Save was successful."

6. Collapse and open the module/register range to verify that point was successfully added.

7. Repeat steps 1-7 above to configure more points.

**IMPORTANT**: When configuration is complete, **Update Polling** must be performed.

---

### Adding and Configuring a Digital Point

**Note**: For information on adding a pulse point, see [Adding a Digital Pulse Point](#).

1. **Open Configuration Editor**.

2. On the Configuration Editor tree, right click the module (DFS) or Modbus register range you want to add a point to and click **New** on the pop-up menu.

3. In the **New Point** dialog box, select the point's number and type from the drop-down list and click **Ok**.

4. The point is listed below the module/range it was added to. Its default properties are displayed in the right panel. The name of the point is listed as "New" until you give it a descriptive name.
Configure the following properties:

- **Name** - User-defined name of this point. The point’s name can be a maximum of 20 characters (ex. Pump Run, Pump #3 Status).

- **Low state label** - User-defined label that describes the point’s "low" state. Low state label can be a maximum of 8 characters (ex. Off, OK).

- **High state label** - User-defined label that describes the point’s "high" state. High state label can be a maximum of 8 characters (ex. On, Running).

5. Verify that all the information entered is correct. Right click the new point and select **Save** from the pop-up menu. The status bar displays the message “Save was successful.”

6. Collapse and open the module/register range to verify that point was successfully added.

7. Repeat steps 1-7 above to configure more points.

**IMPORTANT**: When configuration is complete, **Update Polling** must be performed.

### Adding and Configuring a Digital Pulse Point

**Notes:**

- Digital pulse points can only be added to DMM002 and DCM003 modules.

- The pulse input must be wired beginning at input 12. If more than one pulse is needed, you must begin at input 12 then wire 11, 10 and 9.

<table>
<thead>
<tr>
<th>For single pulse point:</th>
<th>For two pulse points:</th>
<th>For three pulse points:</th>
<th>For four pulse points:</th>
</tr>
</thead>
</table>

HT3 Version 3.1.6 | © 2013 Data Flow Systems, Inc.
1. **Open Configuration Editor.**

2. On the Configuration Editor tree, select the DMM002 or DCM003 module you want to add a point to.

3. Right click the module and click **New** on the pop-up menu.

4. In the **New Point** dialog box, select the point's number and point type (select DI as the type) from the drop-down list and click **Ok**. **(Note:** For a pulse point, you must select DI as the point type when adding the point. You will change this to DP when configuring the point's properties.)

   ![DFS Module](image)

   The point is added to the module and its default properties are displayed in the right panel. The name of the point is listed as "New" until you give it a descriptive name.

5. Change the point's type to digital pulse by selecting **DP** from the **Point type** drop-down list (the configuration panel's display will change to show the properties of a digital pulse point).
Configure the following properties:

- **Name** - User-defined name of this point. The point's name can be a maximum of 20 characters (ex. Rain Gauge, Precipitation).

- **Pulse units** - The units of measurement for this point (ex. feet, inches).

- **Scale factor** - The scale (amount per pulse) for this point (ex. .1).

- **Time period** - The length of time ("base time") over which you want to accumulate pulse data. The options are "per second," "per minute," "per hour," "per day," and "raw data." The base time is used to calculate the "rate of change" (number of pulses received during the configured time period. For example, 3.5 inches of rain per hour). Time period is always relative to the current time. If we configure a time period of "per hour," then only pulses received in the last 3600 seconds (relative to the current second) are used to calculate the rate of change.

Choosing a **Time Period** other than "raw data" will effectively change this point to display a rate of change (ROC) over the selected time base. This status may be used on custom screens to display the current rate of change for this pulse point. Changing the time base does not affect its use in ladder logic totalizers or pulse total reports. The most common selection is "per Hour" for rain gauges to calculate current rainfall rates and to alarm on heavy rain conditions.

6. Verify that all the information entered is correct. Right click the new point and select **Save** from the pop-up menu. The status bar displays the message "Save was successful."

7. Collapse and open the module to verify the point was successfully added.

8. Repeat steps 1-7 above to configure more points.

**IMPORTANT**: When configuration is complete, **Update Polling** must be performed.
Modifying or Deleting a Point

Modifying a Point

1. Open Configuration Editor.

2. On the Configuration Editor tree, select the point you want to edit. Its properties are displayed in the right panel.

3. Make the desired changes.

4. Verify that all of the information is correct. Right click the point that was edited and click Save on the pop-up menu. The status bar displays the message "Save was successful."

Deleting a Point

1. Open Configuration Editor.

2. On the Configuration Editor tree, right click the station you want to delete. Click Delete on the pop-up menu.

3. Click Yes at the Are you sure? dialog box to confirm.

**IMPORTANT:** When configuration is complete, Update Polling must be performed.

PLC/TCU Set Points (AKA "Q" Points)

Q points, named as such because they always reside at module address Q in Configuration Editor, are a way to create user set points beyond the 15-module limit of the PLC/TCU. Q points allow you to access and use the PLC/TCU's 168 free (unused) memory locations with little effort. PLC developers and system integrators can use these Q points to give users the ability to easily change settings such as float levels and minimum pump run times.

It is important to note that Q points are not designed to be used as status points. They are not polled as often as "normal" I/O, because doing so would negatively impact the polling loop. As a set point variable however, the control is acted on immediately.

- Q points are floating point values and there is no scaling involved. In Configuration Editor, Q points are always engineering-type points (EO/EI) not analog points (AI/AO).

- Q points are not included in default screens. In order for a user to access the set point, it must be included in a custom screen.

- Q points can be added to both DFS radio stations and NIM networks (i.e., DFS driver and NIM driver in Configuration Editor).
Adding Q Points

To add Q points, open Configuration Editor and do the following:

1. Select the DFS radio or NIM station that you want to add Q points to.

2. Right click the station and select New to add a new module.

3. In the New module dialog box, select PLC001 for the module type. A PLC001 is added at address Q (this is the default address and can't be changed).

4. To enter points, right click module Q and enter the point number that corresponds to the memory location you want to access (see the Point-to-Memory Location Map, below).

5. The point is added to the module with its default name: "Param A xxxx-xxxx (A)," where A is the point number and xxxx-xxxx is the memory location. You can rename the point, but should leave all other values at their default settings.

6. Continue adding points as necessary.

Once all points have been added in Configuration Editor, you can create a user interface to the set points by including them in a custom screen.

Point-to-Memory Location Map

<table>
<thead>
<tr>
<th>Q Point</th>
<th>Memory Location</th>
<th>Q Point</th>
<th>Memory Location</th>
<th>Q Point</th>
<th>Memory Location</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>5000-5005</td>
<td>57</td>
<td>5150-5155</td>
<td>113</td>
<td>52A0-52A5</td>
</tr>
<tr>
<td>2</td>
<td>5006-500B</td>
<td>58</td>
<td>5156-515B</td>
<td>114</td>
<td>52A6-52AB</td>
</tr>
<tr>
<td>3</td>
<td>500C-5011</td>
<td>59</td>
<td>515C-5161</td>
<td>115</td>
<td>52AC-52B1</td>
</tr>
<tr>
<td>4</td>
<td>5012-5017</td>
<td>60</td>
<td>5162-5167</td>
<td>116</td>
<td>52B2-52B7</td>
</tr>
<tr>
<td>5</td>
<td>5018-501D</td>
<td>61</td>
<td>5168-516D</td>
<td>117</td>
<td>52B8-52BD</td>
</tr>
<tr>
<td>6</td>
<td>501E-5023</td>
<td>62</td>
<td>516E-5173</td>
<td>118</td>
<td>52BE-52C3</td>
</tr>
<tr>
<td>7</td>
<td>5024-5029</td>
<td>63</td>
<td>5174-5179</td>
<td>119</td>
<td>52C4-52C9</td>
</tr>
<tr>
<td>8</td>
<td>502A-502F</td>
<td>64</td>
<td>517A-517F</td>
<td>120</td>
<td>52CA-52CF</td>
</tr>
<tr>
<td>9</td>
<td>5030-5035</td>
<td>65</td>
<td>5180-5185</td>
<td>121</td>
<td>52D0-52D5</td>
</tr>
<tr>
<td>10</td>
<td>5036-503B</td>
<td>66</td>
<td>5186-518B</td>
<td>122</td>
<td>52D6-52DB</td>
</tr>
<tr>
<td>11</td>
<td>503C-5041</td>
<td>67</td>
<td>518C-5191</td>
<td>123</td>
<td>52DC-52E1</td>
</tr>
<tr>
<td>12</td>
<td>5042-5047</td>
<td>68</td>
<td>5192-5197</td>
<td>124</td>
<td>52E2-52E7</td>
</tr>
<tr>
<td>13</td>
<td>5048-504D</td>
<td>69</td>
<td>5198-519D</td>
<td>125</td>
<td>52E8-52ED</td>
</tr>
<tr>
<td>14</td>
<td>504E-5053</td>
<td>70</td>
<td>519E-51A3</td>
<td>126</td>
<td>52EE-52F3</td>
</tr>
<tr>
<td>15</td>
<td>5054-5059</td>
<td>71</td>
<td>51A4-51A9</td>
<td>127</td>
<td>52F4-52F9</td>
</tr>
<tr>
<td>16</td>
<td>505A-505F</td>
<td>72</td>
<td>51AA-51AF</td>
<td>128</td>
<td>52FA-52FF</td>
</tr>
<tr>
<td>17</td>
<td>5060-5065</td>
<td>73</td>
<td>51B0-51B5</td>
<td>129</td>
<td>5300-5305</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>---</td>
<td>------</td>
<td>---</td>
<td>------</td>
<td>---</td>
<td>------</td>
</tr>
<tr>
<td>18</td>
<td>5066-506B</td>
<td>74</td>
<td>51B6-51BB</td>
<td>130</td>
<td>5306-530B</td>
</tr>
<tr>
<td>19</td>
<td>506C-5071</td>
<td>75</td>
<td>51BC-51C1</td>
<td>131</td>
<td>530C-5311</td>
</tr>
<tr>
<td>20</td>
<td>5072-5077</td>
<td>76</td>
<td>51C2-51C7</td>
<td>132</td>
<td>5312-5317</td>
</tr>
<tr>
<td>21</td>
<td>5078-507D</td>
<td>77</td>
<td>51C8-51CD</td>
<td>133</td>
<td>5318-531D</td>
</tr>
<tr>
<td>22</td>
<td>507E-5083</td>
<td>78</td>
<td>51CE-51D3</td>
<td>134</td>
<td>531E-5323</td>
</tr>
<tr>
<td>23</td>
<td>5084-5089</td>
<td>79</td>
<td>51D4-51D9</td>
<td>135</td>
<td>5324-5329</td>
</tr>
<tr>
<td>24</td>
<td>508A-508F</td>
<td>80</td>
<td>51DA-51DF</td>
<td>136</td>
<td>532A-532F</td>
</tr>
<tr>
<td>25</td>
<td>5090-5095</td>
<td>81</td>
<td>51E0-51E5</td>
<td>137</td>
<td>5330-5335</td>
</tr>
<tr>
<td>26</td>
<td>5096-509B</td>
<td>82</td>
<td>51E6-51EB</td>
<td>138</td>
<td>5336-533B</td>
</tr>
<tr>
<td>27</td>
<td>509C-50A1</td>
<td>83</td>
<td>51EC-51F1</td>
<td>139</td>
<td>533C-5341</td>
</tr>
<tr>
<td>28</td>
<td>50A2-50A7</td>
<td>84</td>
<td>51F2-51F7</td>
<td>140</td>
<td>5342-5347</td>
</tr>
<tr>
<td>29</td>
<td>50A8-50AD</td>
<td>85</td>
<td>51F8-51FD</td>
<td>141</td>
<td>5348-534D</td>
</tr>
<tr>
<td>30</td>
<td>50AE-50B3</td>
<td>86</td>
<td>51FE-5203</td>
<td>142</td>
<td>534E-5353</td>
</tr>
<tr>
<td>31</td>
<td>50B4-50B9</td>
<td>87</td>
<td>5204-5209</td>
<td>143</td>
<td>5354-5359</td>
</tr>
<tr>
<td>32</td>
<td>50BA-50BF</td>
<td>88</td>
<td>520A-520F</td>
<td>144</td>
<td>535A-535F</td>
</tr>
<tr>
<td>33</td>
<td>50C0-50C5</td>
<td>89</td>
<td>5210-5215</td>
<td>145</td>
<td>5360-5365</td>
</tr>
<tr>
<td>34</td>
<td>50C6-50CB</td>
<td>90</td>
<td>5216-521B</td>
<td>146</td>
<td>5366-536B</td>
</tr>
<tr>
<td>35</td>
<td>50CC-50D1</td>
<td>91</td>
<td>521C-5221</td>
<td>147</td>
<td>536C-5371</td>
</tr>
<tr>
<td>36</td>
<td>50D2-50D7</td>
<td>92</td>
<td>5222-5227</td>
<td>178</td>
<td>5372-5377</td>
</tr>
<tr>
<td>37</td>
<td>50D8-50DD</td>
<td>93</td>
<td>5228-522D</td>
<td>149</td>
<td>5378-537D</td>
</tr>
<tr>
<td>38</td>
<td>50DE-50E3</td>
<td>94</td>
<td>522E-5233</td>
<td>150</td>
<td>537E-5383</td>
</tr>
<tr>
<td>39</td>
<td>50E4-50E9</td>
<td>95</td>
<td>5234-5239</td>
<td>151</td>
<td>5384-5389</td>
</tr>
<tr>
<td>40</td>
<td>50EA-50EF</td>
<td>96</td>
<td>523A-523F</td>
<td>152</td>
<td>538A-538F</td>
</tr>
<tr>
<td>41</td>
<td>50F0-50F5</td>
<td>97</td>
<td>5240-5245</td>
<td>153</td>
<td>5390-5395</td>
</tr>
<tr>
<td>42</td>
<td>50F6-50FB</td>
<td>98</td>
<td>5246-524B</td>
<td>154</td>
<td>5396-539B</td>
</tr>
<tr>
<td>43</td>
<td>50FC-5101</td>
<td>99</td>
<td>524C-5251</td>
<td>155</td>
<td>539C-53A1</td>
</tr>
<tr>
<td>44</td>
<td>5102-5107</td>
<td>100</td>
<td>5252-5257</td>
<td>156</td>
<td>53A2-53A7</td>
</tr>
<tr>
<td>45</td>
<td>5108-510D</td>
<td>101</td>
<td>5258-525D</td>
<td>157</td>
<td>53A8-53AD</td>
</tr>
<tr>
<td>46</td>
<td>510E-5113</td>
<td>102</td>
<td>525E-5263</td>
<td>158</td>
<td>53AE-53B3</td>
</tr>
<tr>
<td>47</td>
<td>5114-5119</td>
<td>103</td>
<td>5264-5269</td>
<td>159</td>
<td>53B4-53B9</td>
</tr>
<tr>
<td>48</td>
<td>511A-511F</td>
<td>104</td>
<td>526A-526F</td>
<td>160</td>
<td>53BA-53BF</td>
</tr>
<tr>
<td>49</td>
<td>5120-5125</td>
<td>105</td>
<td>5270-5275</td>
<td>161</td>
<td>53C0-53C5</td>
</tr>
<tr>
<td>50</td>
<td>5126-512B</td>
<td>106</td>
<td>5276-527B</td>
<td>162</td>
<td>53C6-53CB</td>
</tr>
<tr>
<td>51</td>
<td>512C-5131</td>
<td>107</td>
<td>527C-5281</td>
<td>163</td>
<td>53CC-53D1</td>
</tr>
<tr>
<td>52</td>
<td>5132-5137</td>
<td>108</td>
<td>5282-5287</td>
<td>164</td>
<td>53D2-53D7</td>
</tr>
<tr>
<td>53</td>
<td>5138-513D</td>
<td>109</td>
<td>5288-528D</td>
<td>165</td>
<td>53D8-53DD</td>
</tr>
<tr>
<td>54</td>
<td>513E-5143</td>
<td>110</td>
<td>528E-5293</td>
<td>166</td>
<td>53DE-53E3</td>
</tr>
<tr>
<td>55</td>
<td>5144-5149</td>
<td>111</td>
<td>5294-5299</td>
<td>167</td>
<td>53E4-53E9</td>
</tr>
<tr>
<td>56</td>
<td>514A-514F</td>
<td>112</td>
<td>529A-529F</td>
<td>168</td>
<td>53EA-53EF</td>
</tr>
</tbody>
</table>
Keywords

Keyword definitions are used to logically group I/O points for reporting purposes. Logically grouping specific types of points (e.g., lift station pumps or analog flow meters) simplifies the reporting process. Instead of entering individual addresses in the report from, you select a keyword from a drop-down list.

For example, you can create a keyword definition that includes the addresses of all lift station pumps in the northwest region of your system. You can then create a report that shows when the pumps at those stations came on and went off, and how long each of these events occurred.

Faster Reports from Cached Data

In addition to simplifying reports, keywords also allow reports to be generated faster. In previous versions of HT3 (and in HyperTAC II), reports were generated using data stored in daily journals. Because the journals can get quite large, reports generated by querying the journals could take some time. Additionally, because analog data is stored as raw data in the journals, the data for analog point reports had to be converted to floating point values each time the report was generated.

In HT3 version 3.0.5, DFS has added cached reports. The data for all points assigned to a keyword is cached every day after midnight and stored in the reports database; analog point data for keyword-assigned points is converted and stored as floating point values. When you run a report on a keyword, the data is extracted from the reports database instead of the journal. We strongly suggest that you create keywords for all your reports to take advantage of the efficiencies of cached report data.

See the sections below for information on creating keyword definitions and adding I/O points to keywords.

- Creating a Keyword Definition
- Adding Addresses to a Keyword
- Deleting a Keyword Address
- Deleting a Keyword Definition

Creating a Keyword Definition

When you create a keyword definition, you give it a unique name and select the type of report the keyword is for (e.g., pump activity or derived flow). Only the keywords assigned to that report type are listed when you fill out the report form. See Creating and Viewing Reports for more information (note that keywords do not apply to the Comment Log, Digipeat Map, Modbus Map or Station Configuration reports).

After a keyword definition is created, you assign I/O points to it by right clicking the keyword name in Configuration Editor and using the Address Selection Tool to browse to the point. There is no limit on the number of points that can be assigned to a keyword. However, to get the most useful information from the reports, it is better to organize the points in small, logical groups. For example, if your system has 500 lift stations, you may want to organize pump status points by region or area. Note that a point can be assigned to more than one keyword.
All I/O points assigned to a keyword are listed below the keyword in the Configuration Editor tree. The points assigned to the keyword can also be viewed in the right panel of Configuration Editor when a keyword is selected. The points assigned to the keyword are listed in a box below the keyword name.

1. **Open Configuration Editor.**

2. Click **Keywords** on the Configuration Editor tree. The Keywords list expands to show all configured keywords.

3. Right click the word **Keywords** and click **New** on the pop-up menu.

4. Enter a name for the keyword in the **New Keyword Definition** dialog box. From the **Select new key type** list, choose the type of report to associate with this keyword. For more information on the report types, see Analog Flow Report, Derived Flow Report, Detail Report, Min Max Average Report, Pulse Report, Pump Activity Report, and Snapshot Report.

   **Note Regarding Snapshot Keywords:** The Snapshot report can be generated using either the standard SNAPSHOT key type or the SNAPINVQ key type.

   - The SNAPSHOT key type is either always qualified (no qualifier configured) or only uses "qualified" data. A **qualifier** is an address associated with an analog point. When an analog point is configured with a qualifier, the system only uses "qualified" data when generating a report (the only data reported is for times when the qualifier address is *on*).

   - The SNAPINVQ key type is for creating a Snapshot report using an inverted qualifier. The SNAPINVQ key type causes the system to only use data gathered when the qualifier point was *off*. This is useful for creating turbidity analysis reports where data is gathered when a pump is off.

   Both the SNAPSHOT and SNAPINVQ key types use the same **Snapshot report** interface.
5. Click OK. The new keyword definition is saved and added to the Keywords list. The properties for this keyword definition are displayed in the right panel.

When telemetry addresses are added to this keyword definition, they will be listed under Points in this keydef. See the next section, Add Addresses to a Keyword for instructions on how to add telemetry addresses to a Keyword Definition.

### Adding Addresses to a Keyword

After a keyword definition has been created, you must associate points with it. When a report based on a keyword is generated, the results show information only on the addresses associated with the keyword. You don’t have to enter each individual address when completing the report form.

1. Open Configuration Editor.

2. From the Keywords list, right click the keyword definition you want to add addresses to and select New from the pop-up menu. The Select address dialog box opens.
3. In the Select address dialog box, click Browse to open the Address Selection Tool.

4. On the Configuration Editor tree, find the point you want to add to the keyword definition. Verify that the correct address is listed in the Selection box and click OK to return to the Select address dialog box.

5. Verify that the correct address is listed in the Select address dialog box and click OK.

6. The new address is added to the Keywords list below its assigned keyword definition.

7. Repeat steps 1-6 to add additional addresses to the keyword definition.

Deleting a Keyword Address

1. Open Configuration Editor.

2. Select Keywords on the Configuration Editor tree to expand the Keywords list and view all configured keywords.

3. Select the keyword definition that contains that address to be deleted. The Keyword Address list opens below it.

4. Right click the address you want to delete and click Delete on the pop-up menu.

5. Click Yes at the Delete this record? dialog box to confirm. The address is removed from the keyword address list.

Deleting a Keyword Definition

1. Open Configuration Editor.

2. Select Keywords on the Configuration Editor tree to expand the Keywords list and view all configured keywords.

3. Right click the keyword definition to be deleted and click Delete on the pop-up menu.
4. Click Yes at the Delete this record? dialog box to confirm. The definition is removed from the Keywords list.
Auto Controls

Auto Controls instruct the system to perform a particular function when a specific event occurs. For example, when a well reaches a specified high level, a pump will be turned on to reduce the water level. This occurs automatically; the point doesn’t need to be manually monitored. Each status point in your system can be used as the source of up to 64 auto controls.

Auto Controls can use a specific point as their source, or the status of a module (OFFLINE or ONLINE) can be selected as the source.

To view a list of all auto controls that have been configured for your telemetry system, click Auto Controls on the Configuration Editor tree.

Each entry in the list shows:

- The name of the point being controlled.
- The address of the point being controlled followed by its type (in parentheses).
- The address of the source point followed by its type (in parentheses). The source point is the point that is being monitored. When the status of the source point reaches a specific value or state, the auto control is activated.

The sections below provide information on configuring auto controls for your system:

- Creating an Auto Control
- Modifying an Auto Control
- Deleting an Auto Control

Creating an Auto Control

**IMPORTANT:** Before creating an auto control, verify that the source point is properly configured. An improperly configured source point will prevent the auto control from behaving as expected.
**Note:** The steps below instruct you to navigate to the point under the driver's branch to add an auto control. You can also add an auto control by expanding the Auto Controls branch and right-clicking the word Auto Control. Select *New* from the pop-up menu and browse to the point that you want to add an auto control to. Configure the auto control as described in step 3, below.

1. **Open Configuration Editor**.

2. On the Configuration Editor tree, right click the point you want to add an auto control to and click *New* on the pop-up menu. (**Note:** The point selected in this step is the output of the auto control; i.e., the point controlled by a change in status of the source point, which is identified in the next step.)

3. The new auto control is added to the **Auto Control** branch and its properties are displayed in the right panel.

Complete the following:

- **Controlled by** - Address of the source (monitoring) point or module.

  Type the address of the source point or click **Browse** to navigate to the point. (**Note** that each status point in your system can be used as the source for up to 64 auto controls.)

  If you are using a module's ONLINE or OFFLINE status as the source, enter the module's address (station number + module letter) in the **Controlled by** box. Type the address of the source module or click **Browse** to navigate to it. (**Note** that when using a module as a source of an auto control OFFLINE has a value of 0 and ONLINE has a value of 0.)

- **Low control value and High control value** - Determined as follows:

<table>
<thead>
<tr>
<th>Source</th>
<th>Targ</th>
<th>Low control</th>
<th>High control</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
In this configuration, the state of the digital output follows the state of the digital source point unless the Invert control logic option is selected. When the logic is inverted, the digital output point is controlled to the state opposite that of the digital source point. The values for Low control value and High control value can't be edited in this configuration.

In this configuration, the state of the analog output mirrors the state of the analog source point. Whenever the source point changes, the analog output is controlled to that value. The Invert control logic option is not available to this configuration; and the values for Low control value and High control value can't be edited.

In this configuration, the state of a digital output is controlled whenever the value of an analog source point crosses the Low or High control value thresholds. Specifically, when the value of the analog source point falls below the Low control value, the digital output is controlled to the 0 state. When the value of the analog source point rises above the High control value, the digital output is controlled to the 1 state. If the Invert control logic option is selected, this relationship is inverted. The state of the digital output is not affected when the value of the analog source point is between the Low and High control values.

In this configuration, the analog output can only have two values that correspond to the digital source. When the digital source is in the 0 state, the analog output is controlled to the Low control value. When the digital source is in the 1 state, the analog output is controlled to the High control value. The Invert control logic option is not available to this configuration.

<table>
<thead>
<tr>
<th>(Controlled by)</th>
<th>et</th>
<th>value</th>
<th>value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>DI/DO</td>
<td>DO</td>
<td>0</td>
<td>1</td>
<td>In this configuration, the state of the digital output follows the state of the digital source point unless the Invert control logic option is selected. When the logic is inverted, the digital output point is controlled to the state opposite that of the digital source point. The values for Low control value and High control value can't be edited in this configuration.</td>
</tr>
<tr>
<td>AI/AO</td>
<td>AO</td>
<td>0</td>
<td>1</td>
<td>In this configuration, the state of the analog output mirrors the state of the analog source point. Whenever the source point changes, the analog output is controlled to that value. The Invert control logic option is not available to this configuration; and the values for Low control value and High control value can't be edited.</td>
</tr>
<tr>
<td>AI/AO</td>
<td>DO</td>
<td>Low level (0 state)</td>
<td>High level (1 state)</td>
<td>In this configuration, the state of a digital output is controlled whenever the value of an analog source point crosses the Low or High control value thresholds. Specifically, when the value of the analog source point falls below the Low control value, the digital output is controlled to the 0 state. When the value of the analog source point rises above the High control value, the digital output is controlled to the 1 state. If the Invert control logic option is selected, this relationship is inverted. The state of the digital output is not affected when the value of the analog source point is between the Low and High control values.</td>
</tr>
<tr>
<td>DI/DO</td>
<td>AO</td>
<td>output of 0 state</td>
<td>output of 1 state</td>
<td>In this configuration, the analog output can only have two values that correspond to the digital source. When the digital source is in the 0 state, the analog output is controlled to the Low control value. When the digital source is in the 1 state, the analog output is controlled to the High control value. The Invert control logic option is not available to this configuration.</td>
</tr>
</tbody>
</table>
• **Invert control logic** - Typically, the control point exactly follows the state of its assigned monitor point. Selecting **Invert control logic** enables the system to invert, or reverse, this relationship. **Note**: Only available to AI/AO -> DO and DI/DO -> DO auto controls.

• **Push value** - Allow the system to attempt to maintain output states when the two points are out of sync. With **Push value** enabled, manual control is disabled.

• **Log changes** - Write the activity of the auto control to the control log table. By default, this option is disabled. Note that logging all auto control activity can cause the control log table to become large in a short period of time. This may result in table corruption.

If you believe you are having a problem with an auto control, run trends or a detailed report on both the point being controlled and the controlling point. The trends, when viewed simultaneously, will show you if the two points are following each other as they should. Analyzing a detailed report accomplishes the same thing except with numbers and text instead of an illustration. If your analysis of the trends/detailed report shows there may be a problem, use the Telemetry Traffic Tool to look for communication errors. Alternatively, you can temporarily turn on logging and run a Control Log report. When you've finished troubleshooting the auto control, you should turn off logging.

4. Right click the new auto control and click **Save** on the pop-up menu. The status bar displays the message "Save was successful."

---

**Modifying an Auto Control**

1. Open Configuration Editor.

2. Select the auto control you want to edit. Its properties are displayed in the right pane.

3. Make the desired changes. See step 3 of **Creating an Auto Control**, above, for detailed information.

4. Right click the auto control and click **Save** on the pop-up menu. The status bar displays the message "Save was successful."

---

**Deleting an Auto Control**

1. Open Configuration Editor.

2. Right click the auto control you want to delete and click **Delete** on the pop-up menu.

3. Click **Yes** at the Are you sure? dialog box to confirm.
Scheduled Controls

Scheduled controls allow you to program an event to occur automatically on particular days and/or times. For example, a sprinkler system that turns on at 5:00 AM and turns off at 7:00 AM every Monday, Wednesday, and Friday.

- You can configure a digital point to come on at a specific time and go off at a specific time.
- An analog point can be configured to reach a desired engineering value on certain days and/or times.

The following rules apply to Scheduled Controls:

- Before any scheduled controls can operate, a special user account must be created. The login name for this account must be SCHEDULE and the account must have control permission. (Note: It is not necessary to log in to HT3 with this user account when creating scheduled controls. This account is only used by the system to initiate scheduled controls that have been configured.)
- Only digital control points (outputs) can be scheduled.
- Only real, physical points can be scheduled. Virtual points created with Virtual Logic Builder cannot be scheduled.
- Scheduled controls can be created for any valid point located under a DFS, MODBUS, or NIM driver.
- To configure a schedule control, you must log in to HT3 with an account that has permission to configure scheduled controls. See User Accounts for more information on permissions.
- Control Log report entries for scheduled controls show SCHEDULED in the username column, not the login name of the account that created the scheduled control.
- When a scheduled control is created, the system is updated immediately. It isn't necessary to save the scheduled control or perform update polling.
- Points are controlled on the minute. If a point is configured to come on at 11:35 AM, it comes on immediately when the time changes from 11:34 AM to 11:35 AM. If you save the scheduled control at 11:35:20 AM, it will not come on until the following day at 11:35 AM.
- If for some reason the scheduled control fails, the system retries the scheduled control the number of times set in the station's retries count. (See Adding a DFS Station; Adding a Modbus Station; or Adding a NIM Station.)
- A point can have both an auto control and a scheduled control, as long as the auto control does not have Push value enabled. If Push value is enabled, the scheduled control fails and is indicated as such in the Control Log report. (See Auto Controls for information on the Push value option.)
- You can have a maximum of 24 entries per day for each scheduled control.

The sections below provide instructions for using scheduled controls in your system:

- Creating a Scheduled Control
Modifying a Scheduled Control
Deleting a Single Record from a Scheduled Control
Deleting All Records from a Scheduled Control

Creating a Scheduled Control

IMPORTANT: Review the rules listed above before creating a scheduled control.

1. Open Configuration Editor.

2. On the Configuration Editor tree, right click Scheduled Controls and select New on the pop-up menu.

3. In the Select Address dialog box, enter the complete address of the point to be controlled and click OK. You can type the point’s address in the box or click Browse to open the Address Selection Tool (locate the point and click OK).

4. The new scheduled control is added to the Scheduled Controls list. The scheduled controls configuration panel opens in the right panel.
The Scheduled Controls panel features the following:

- At the top of the panel is a table that lists all the entries for the selected day. Each row represents a single control record for that point. Up to 24 records can be entered for each day of the week.

- The time and value for each control record are entered in the **HH:MM** and **Value** boxes.

- Each day of the week, along with its corresponding scheduled control trend, are displayed at the bottom of the panel. The trend is a visual representation of the changes scheduled for that point for that day.

5. Click a day. Enter the time when the point's value should change (using a 24-hour clock, or "military" time), and enter the value (0 or 1) it should change to. Click **Update**. The system is updated immediately. It isn't necessary to save the record or perform **update polling**.

- To add more control records for this day (up to 24), click the day again and enter a new time and value.

- To add control records for other days of the week, click the appropriate day and enter times and values.

- Each time a record is added, the trend for that day is updated to reflect the controls, or changes, scheduled for the point.

- The table at the top of the panel shows all the controls scheduled for the selected day. To see the control records for a different day, click the button for the desired day.
Modifying a Scheduled Control

1. Open Configuration Editor.

2. On the Scheduled Controls branch of the Configuration Editor tree, select the scheduled control to be edited. It's properties are displayed in the right panel.

3. Click the day that requires editing. From the table at the top of the panel, select the record to be changed. Make the desired time and value changes and click Update.

4. The scheduled controls table and the trend line for that day are updated to reflect the changes made.

Deleting a Single Record from a Scheduled Control

Follow the instructions below to delete one record from a scheduled control. Remember that each line in the scheduled control table represents one record. If you want to delete all records from the scheduled control, see Deleting All Records from a Scheduled Control, below.

1. Open Configuration Editor.

2. On the Scheduled Controls branch of the Configuration Editor tree, select the scheduled control that contains the record to be deleted. Its properties are displayed in the right panel.

3. Select the day that contains the record to be deleted. On the scheduled controls table, click the record you want to delete (the line should be highlighted). Click Clear.

4. The scheduled controls table and the trend line for that day are updated to reflect the changes made.
Deleting all Records from a Scheduled Control

Follow the instructions below to delete all records from a scheduled control. Remember that each line in the Scheduled Control box represents one record. If you want to delete a single record from the scheduled control, see Deleting a Single Record from a Scheduled Control, above.

1. Open Configuration Editor.

2. On the Scheduled Controls branch of the Configuration Editor tree, right click the scheduled control you want to delete and click Delete on the pop-up menu.

3. The Are you sure? dialog box opens on the screen with the message "Delete this record?". Click Yes to confirm.

4. The Continue? dialog box opens with the message "This will delete all records for this address!". Click Yes to delete all records for the scheduled control. The scheduled control is removed from the list.
Alarms

Alarms are used to alert operators of conditions that need attention (e.g., high well level, pump didn’t start when called to run, station is offline). Once configured, alarms can be viewed and acknowledged using HT3’s Alarm Viewer. The ability to view and acknowledge alarms is based on the user’s permission level. For more information on permission levels, see User Accounts.

Alarm information can be accessed via the Drivers branch and the Alarms branch of the Configuration Editor tree.

Configuring, Editing and Deleting Alarms

When configuring, editing, or deleting alarms, use the Drivers branch of the Configuration Editor tree. The Drivers branch provides a clear picture of the relationship of all the telemetry system components. See Add an Analog Point Alarm and Add a Digital Point Alarm.

To view all configured alarms, expand the Alarms branch of the Configuration Editor tree. The Alarms branch provides a complete list of all alarms that have been configured. See Viewing All Configured Alarms.

Monitoring Alarm Activity

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>System Tray</strong></td>
<td>When an alarm occurs, the alarm button on HT3’s system tray turns red and begins blinking. A button that is red, but not blinking, indicates that there are active alarms, but they have all been acknowledged. When you place the mouse pointer over the button, the status bar displays the total number of alarms and also shows the number of active alarms and the number of unacknowledged alarms.</td>
</tr>
<tr>
<td><strong>Alarm Viewer</strong></td>
<td>Alarm activity can be viewed in HT3’s Alarm Viewer. Alarm Viewer lists all active, acknowledged, and cleared alarms, and gives you the ability to acknowledge the active and cleared alarms. You can open Alarm Viewer by clicking the alarm button in the system tray or by clicking View on the HT3 main menu and then clicking Alarms on the View submenu.</td>
</tr>
<tr>
<td><strong>Announce Locally / Send Alarm Notifications</strong></td>
<td>Alarms can be configured to play a pre-recorded alarm message (via a speaker or PA system) or alert users via phone or email. There are five phone/email notification options that include having the system leave a message on an answering machine or on a numeric pager. By having the system announce locally or send out alarm notifications, you'll always know when alarms occur - even if you're away from the computer or away from the plant. See Call In and Call Out for more information on these features.</td>
</tr>
</tbody>
</table>

**IMPORTANT:** Before enabling Announce Locally and/or Phone/Email for an alarm, verify that all necessary alarm message recordings have been created. If any messages are missing, you must record the messages before enabling Announce Locally and/or Phone/Email. See Recording Messages for instructions on creating recordings.
See the sections below for information on viewing and configuring alarms:

- Viewing All Configured Alarms
- The Offlines Alarm
- Adding an Alarm to a Control Point
- Adding an Analog Point Alarm
- Adding a Digital Point Alarm
- Modifying an Alarm
- Deleting an Alarm

**Viewing All Configured Alarms**

To view a list of all configured alarms, expand the Alarms branch of the Configuration Editor tree. *(Note: This is a list of points that have been configured to alarm, not a list of active alarms.)*

When the branch is expanded, a list of configured alarms in your assigned partition is displayed in the left panel. Each entry shows the name and telemetry address of the alarm’s point. Click an alarm to view its properties.

If your user account is assigned to the "main" partition (partition 0) or if you are logged in as MGR or have management level permissions, the first alarm listed is OFFLINES. The OFFLINES alarm determines how all offline station alarms are handled. See The Offlines Alarm below, for more information.

We suggest that you use the Alarms branch for viewing purposes only. If you need to add, edit, or delete an alarm, use the Drivers branch of the Configuration Editor tree. The Drivers branch provides a clear picture of the relationship of all the telemetry system components.

**Station Offline Alarm**

**IMPORTANT:** This alarm can be edited, but it cannot be deleted.
HT3 includes a built-in station offline alarm (OFFLINES). This alarm's settings determine how all of your telemetry system's station offline alarms are handled. For example, should the system wait a specific length of time (Delay) before logging the alarm? Should this alarm announce locally? Send an email?

The OFFLINES alarm is the first alarm listed if your user account is assigned to the "main" partition (partition number 0) or if you are logged in as MGR (or have management level permissions). If you are assigned to a different partition, you will not see the OFFLINES alarm. However, the OFFLINES alarm settings applies to all stations regardless of the partition they are assigned to.

![OFFLINES alarm settings](image)

Although it is displayed in an analog alarm panel, OFFLINES is a digital-type alarm with 1 (one) being offline and 0 (zero) being online. (The alarm's Low and High settings must not be changed.)

The Delay, Snooze, Announce locally, and Phone/Email settings work the same as with other alarms. See Adding an Alarm to a Digital Point.

HT3 determines if a station is offline based on the communication settings configured for the station (e.g., Offline Count, Timeout, Retries). (Note that NetDFP stations use different criteria for flagging a station as offline.)

See Adding a DFS Station, Adding a Modbus Station, Adding a Motorola Station, Adding a NIM Station for information on configuring a station’s communication settings.

### Adding an Alarm to a Control Point

#### Adding an Alarm to a Control Point

If you want to add an alarm to a digital output (DO) or analog output (AO) point, you must do so via the Alarms branch. This is necessary because right-clicking a DO or AO point and choosing New opens the dialog for configuring an auto control.

To add an alarm to a DO/AO point:

1. Expand the Alarms branch of the Configuration Editor tree.
2. Right-click the word Alarms and choose New on the pop-up menu.
3. Browse to the point you want to add an alarm to and click OK.
4. Configure the alarm as described below in steps 4-6 of Adding an Analog Point Alarm and Adding a Digital Point Alarm.

Adding an Alarm to an Analog Point

1. Open Configuration Editor.

2. From the Drivers branch of the Configuration Editor tree, select the point you want to add an alarm to. Right click the point and click New on the pop-up menu.

3. The alarm is listed beneath the point and the alarm’s properties are displayed in the right panel.

Complete the following:

- **Low** - Low level (engineering value) at which the specified point enters a low alarm state. Enter 0 (zero) in this box if a low alarm is not required. If you need the point to alarm when its level reaches 0 (zero), enter a small number, for example, .01. This is necessary because entering 0 disables the low alarm.

- **High** - High level (engineering value) at which the specified point enters a high alarm state. Enter 0 (zero) in this box if a high alarm is not required.

- **delay** - Length of time (in seconds) that the specified point is allowed to be in an alarm state before being recognized and logged as an alarm. Type a length of time in the delay box or use the slider to set the delay time.

- **snooze** - Length of time (in seconds) allowed to pass before an acknowledged alarm that is still active is reannounced. Type a length of time in the snooze box or use the slider to set the snooze time. (Note: The alarm is reannounced only if the point is still in an alarm state.)
• **Announce locally** - Enables the system to announce an alarm at the Hyper SCADA Server via a connected speaker or PA system. **IMPORTANT**: Read "Note on Alarm Announcement Recordings," below.

• **Phone/Email** - Enables the system to send out an alarm announcement by telephone and/or email. **IMPORTANT**: Read "Note on Alarm Announcement Recordings," below. To use the Phone/Email feature, you will also need to provide the system with a list of contacts and a notification schedule. See [Call In and Call Out](#) for more information.

4. Verify that all the information for the alarm is correct. On the Configuration Editor tree, right click the alarm and click **Save** on the pop-up menu.

5. The status bar displays the message "Save was successful."

**Note on Alarm Announcement Recordings**: Before enabling **Announce Locally** and/or **Phone/Email** for an alarm, verify that all necessary alarm message recordings have been created. If any messages are missing, you need to record the messages before enabling **Announce Locally** and/or **Phone/Email**. If HT3 attempts to play an alarm announcement and the necessary messages are absent from the recordings database, system performance may be adversely affected. See [Recording Messages](#) for instructions on creating recordings.

## Adding an Alarm to a Digital Point

1. Open **Configuration Editor**.

2. From the Drivers branch of the Configuration Editor tree, select the point you want to add an alarm to. Right click the point and click **New** on the pop-up menu.

3. The alarm is listed beneath the point and the alarm's properties are displayed in the right panel.
Complete the following:

- **State** - Correlates to the Low and High state labels configured for the point. Choose the label that represents the point's alarm state from the drop-down list.

- **Delay** - Length of time (in seconds) that the specified point is allowed to be in an alarm state before being recognized and logged as an alarm. Type an amount of time in the delay box or use the slider to set the delay time.

- **Snooze** - Length of time (in seconds) allowed to pass before an acknowledged alarm that is still active is reannounced. Type an amount of time in the snooze box or use the slider to set the snooze time. (Note: The alarm is reannounced only if the point is still in an alarm state.)

- **Announce locally** - Enables the system to announce an alarm at the Hyper SCADA Server via a connected speaker or PA system. **IMPORTANT:** Read "Note on Alarm Announcement Recordings," below.

- **Phone/Email** - Enables the system to send out an alarm announcement by telephone. **IMPORTANT:** Read "Note on Alarm Announcement Recordings," below. To use the Phone/Email feature, you will also need to provide the system with a list of contacts and a notification schedule. See Call In and Call Out for more information.

4. Verify that all the information for the alarm is correct. On the Configuration Editor tree, select and right click the alarm. Click **Save** on the pop-up menu.

5. The status bar displays the message "Save was successful."

**Note on Alarm Announcement Recordings:** Before enabling **Announce Locally** and/or **Phone/Email** for an alarm, verify that all necessary alarm message recordings have been created. If any messages are missing, you need to record the messages before enabling **Announce Locally** and/or **Phone/Email**. If HT3 attempts to play an alarm announcement and the necessary messages are absent from the recordings database, system performance may be adversely affected. See **Recording Messages** for instructions on creating recordings.
Modifying or Deleting an Alarm

Modifying an Alarm

1. Open Configuration Editor.

2. On the Configuration Editor tree, select the alarm to be edited. The properties for this alarm are displayed in the right panel.

3. Make the desired changes. For an analog alarm, see step 4 of Add an Analog Point Alarm for detailed information. For a digital point, see step 4 of Add a Digital Point Alarm. 

4. After verifying that all the information is correct, right click the alarm and click Save on the pop-up menu. The status bar displays the message "Save was successful."

Deleting an Alarm

1. Open Configuration Editor.

2. On the Configuration Editor tree, right click the alarm you want to delete and click Delete on the pop-up menu.

3. Click Yes at the Are you sure? dialog box to confirm.
Call In (411) and Call Out (911)

Call Out (911) and Call In (411) let you gather system information and perform system functions when you're out of the plant or temporarily away from your HT3 workstation.

- **Call Out (911)** sends out phone or email notifications when an alarm that has Call Out (911) enabled occurs.
- **Call In (411)** lets you call into the system to perform functions such as checking status and changing the value of control points.

**IMPORTANT:** Before you can use HT3’s local alarm announce, Call Out (911), and Call In (411), you must configure your system’s **global voice alarm options**.

**Call Out (911)**

Call Out (911) attempts to contact a list of individuals whenever a Call Out (911)-enabled alarm occurs. When you add an **alarm condition** to a telemetry point, you can turn on the Call Out (911) feature by checking the **Phone/Email** option.

Call Out (911) is comprised of four elements:

<table>
<thead>
<tr>
<th><strong>Alarms</strong></th>
<th>Alarms that have the <strong>Phone/Email</strong> option enabled. See <a href="#">Adding an Alarm</a>.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>List of Contacts</strong></td>
<td>A list of contacts. Contacts can be one of five types: human, answering machine, numeric pager, text pager, or email. See <a href="#">Creating Contacts</a>.</td>
</tr>
<tr>
<td><strong>Schedule</strong></td>
<td>A schedule that tells the system on what days and during which hours to send alarm notifications to a list of contacts. The schedule includes a box that enables you to configure a delay for each contact that forces the system to wait a specified time before attempting the contact. See <a href="#">Creating Call Out (911) Schedules</a>.</td>
</tr>
<tr>
<td><strong>Recordings</strong></td>
<td>Recordings that are played when sending out notifications to human and answering machine contacts. See <a href="#">Recording Messages</a>.</td>
</tr>
</tbody>
</table>

**Call Out (911) Procedure**

When a Call Out (911)-enabled alarm occurs, the system retrieves the appropriate schedule (based on the current day and time) and begins trying to contact the listed individuals using the notification method configured for that contact. "Human" contacts can acknowledge the alarm while they are on the phone. If the notification is sent by a different method (for example, email or text pager), the contact can use Call In (411) or **Alarm Viewer** to acknowledge the alarm.

Acknowledging an alarm lets the system know that someone is aware of the alarm. Call Out (911) continues through the list of contacts until the alarm is acknowledged. If it reaches the last contact and the alarm has not been acknowledged, it starts again with the first contact on the list.
Once an alarm has been acknowledged, Call Out (911) removes it from the call out list. If an acknowledged alarm is still active after a certain length of time (Snooze), the alarm’s status will revert to unacknowledged and it will be re-added to the call out list. (See Adding an Alarm for more information on configuring a “snooze” time for an alarm.)

Once the call is finished, Call Out (911) will wait a predetermined length of time before contacting the next individual. This delay, which is part of the contact’s configuration, gives the contact time to listen to the message and use Call In (411) to acknowledge the alarms.

**Call Out (911) Procedure: Human**

The system waits the configured delay time and then dials the contact’s number. When the contact answers, they are prompted for the Dial In Code. The contact is given three chances to enter the correct code before Call Out (911) moves to the next contact on the list.

If the contact enters a correct dial-in code, the system states the alarm situation (See Recording Messages for information on recording voice alarms) and prompts the user to enter 1 (one) to acknowledge the alarm or 2 (two) to have the alarm message repeated.

If any alarms remain unacknowledged after the next contact's configured delay has expired, the system will attempt to contact the next individual on the schedule list.

**Call Out (911) Procedure: Answering Machine**

The system waits the configured delay time and then dials the contact’s number. When the answering machine answers the call, Call Out (911) pauses before announcing the name of the station and then each alarm at that station. This is done for each station that has an unacknowledged alarm (See Recording Messages for information on recording voice alarms).

Call Out (911) will announce a limited number of alarms. The maximum number of alarms announced during each call is part of the contact’s configuration.

If any alarms remain unacknowledged after the next contact's configured delay has expired, the system will attempt to contact the next individual on the schedule list.

**Call Out (911) Procedure: Numeric Pager**

The system waits the configured delay time and then dials the contact’s number. When the pager answers the call, Call Out (911) pauses before sending the pre-configured alarm message. The message could include the Call In (411) telephone number, as well as the station, module, and point address of the first alarm.

If any alarms remain unacknowledged after the next contact's configured delay has expired, the system will attempt to contact the next individual on the schedule list.

**Call Out (911) Procedure: Text Pager**

The system waits the configured delay time and then dials the contact’s number. When the pager answers the call, the Call Out (911) application pauses before sending the alarm message.

Messages sent to text pagers first provide the number of unacknowledged alarms. They then show the letter s followed by the station number, the point name, and the alarm state. If there are other alarms at that station, Call Out (911) doesn’t repeat the station number; it only gives each point’s name and their alarm state. The next station number is shown, followed by the point name and alarm state of each alarm at the station. An example of a text pager message is "2 alarms s5 High Level ON s6 Intrusion ON".
Call Out (911) will include a limited number of alarms in the text message. The maximum number of alarms included in each message is part of the contact’s configuration.

If the alarm(s) remain unacknowledged after the next contact’s configured delay has expired, the system will attempt to contact the next individual on the schedule list.

**Call Out (911) Procedure: Email**

The system waits the configured delay time and then sends an email to the contact’s email address. The From and Subject lines display the information provided in the global voice alarm settings configuration panel (see Configuring Global Voice Alarm Settings for more information).

The body of the messages includes a station name followed by the names and alarms states of all alarms at that station. The name of the next station with alarms will be provided followed by the names and alarm states of all alarms at that station.

Call Out (911) will include a limited number of alarms in the text message. The maximum number of alarms included in each message is part of the contact’s configuration.

If the alarm(s) remain unacknowledged after the next contact’s configured delay has expired, the system will attempt to contact the next individual on the schedule list.

**Call In (411)**

Call In (411) is an application that runs on the HT3 server that makes it possible for you to call into your system to:

- check status
- acknowledge alarms
- change the value of control points
- configure new stations

You place a call to the system and, after you have been granted access, use the telephone’s keys to navigate through the menu system and take any desired actions. Call In (411) works from any touch-tone phone, including a cellular phone, and uses a Dial In Code (similar to a PIN code) to limit access to authorized users.

Call In (411) is comprised of three parts:

<table>
<thead>
<tr>
<th>Accounts</th>
<th>Accounts for users who can access the application. See Creating Contacts.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Recorded</td>
<td>Recorded messages that are played when prompting callers for information (for example, dial-in code, menu selections) or providing callers with the information they requested (for example, current status of all points at a station). See Recording Messages.</td>
</tr>
<tr>
<td>Messages</td>
<td></td>
</tr>
<tr>
<td>Commands</td>
<td>Commands (for example, request for status, acknowledge alarms, control telemetry). With Call In (411), you can have up to 90 unique commands on your system. See Creating Call In (411) Commands.</td>
</tr>
</tbody>
</table>

**Call In (411) Procedure**

The caller dials the telephone number assigned to the Call In (411) application.
Call In (411) answers and plays a greeting and prompts the caller for their dial-in code (for example, "Welcome to HT3. Please enter your code."). The caller is given three opportunities to enter a correct code.

When a correct code is entered, Call In (411) plays a menu of recordings (for example, "Press 2 for station status summary, press 3 for status by name,...")

To end the session, the caller can press 9. The Call In (411) application will play the "hangup" recording, and the caller can then hang up the phone.

**Configuring Global Voice Alarm Settings**

You must configure your system's global voice alarm options before you can use HT3's local alarm announce, 911 (alarm call out), and 411 (call in) features.

After configuring these global settings for call in and call out, you must create accounts for each contact that will be using these features.

The global voice alarm settings are included in the Voice Recording tool. To open this tool:

1. Click Configure on the HT3 main menu.
2. Click Voice on the Configure submenu. The Voice Recording tool opens in the right panel.
3. Click the Configure tab to access and configure the global voice alarm settings. (For information on the Record tab, see Recording Messages.)

<table>
<thead>
<tr>
<th>1 Phone Line or 2 Phone Lines</th>
<th>Number of phone lines being used for call out and call in.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Announce on local speaker</td>
<td>Select the <strong>Announce on local speaker</strong> check box to allow the system to announce alarms at the Hyper SCADA Server via a connected speaker or PA system.</td>
</tr>
</tbody>
</table>
### Notify by Phone and/or Email

Select the **Notify by Phone and/or Email** check box to allow the system to call out and/or send an email when an alarm occurs. For email alerts, you must also supply a subject, a "from" address and the email relay (all discussed below).

### Disconnect dial-in when calling out (1 line)

This option applies to single-line systems only and has no affect on Hyper411 calls (call in).

Select the **Disconnect dial-in when calling out (1 line)** check box to allow the system to disconnect a modem-to-modem maintenance call whenever it needs to call out for an alarm.

### Email Subject

Enter the text that you want to appear in the subject line of all alarm alert emails. If this is left blank, the Subject line will read "Alarms from computer.name," where `computer.name` is the machine name of the Hyper Server Module (HSM).

### Email From

Email address that will be shown in the **From** line of all alarm alert emails. If this is left blank, the **From** line will read "root@computer.name," where `computer.name` is the HSM's machine name. We advise entering a valid email address, since most people will be hesitant about opening an email from "root@computer.name."

### Email Relay

The name or IP number of your email relay computer. The relay computer is often called the outgoing mail server.

### TAP number

**IMPORTANT:** HT3 uses Telocator Alphanumeric Protocol (TAP) to send alarm notification messages to a text pager. Many paging service providers are planning to discontinue or have already discontinued allowing dialup text messaging due to the cost of maintaining thousands of modems in large data centers. Contact your service provider to find out if they support this protocol. Ask them about alternative messaging methods if they do not.

Text messages sent from HT3 to a pager are routed through a modem at the pager’s service provider. To send the message, HT3 must know the telephone number of the modem (referred to as a TAP Dialup Number). (TAP dialup numbers are only required for text pagers; they are not required for numeric pagers.)

- **All Text Pagers Use Same Provider (Global Tap Dialup Number):** If all the text pagers use the same provider, enter it in the **Tap number** field.

- **Text Pagers Use Different Providers:** If the text pagers use different providers, leave this box blank. You will enter a TAP dialup number when you configure each text pager contact.

Your service provider can provide you with the correct TAP dialup number or you can use one of the directories listed below.

- **http://www.avtech.com/Support/TAP/index.htm**
Cleared Alarms
Select how you want call out to handle alarms that have cleared, but have not yet been acknowledged.

- **CALLOUT** - Cleared (but unacknowledged) alarms will call out as long as they are not acknowledged. This is the default setting.

- **ANNOUNCE** - Cleared (but unacknowledged) alarms will not force a call out, but they will be announced if another alarm forces a call out.

- **NEITHER** - Cleared (but unacknowledged) alarms will not force a call out. Additionally, they will not be announced by the call out program even if another alarm forces a call out.

4. Click **Save**.

## Creating Contacts
Before using HT3’s call in and call out features, you must create accounts for each contact that will be using these features.

Contacts can be one of five types:

- **Human**
- **Answering machine**
- **Numeric pager**
- **Text pager**
- **Email**

Creating contacts is just one step in configuring 911 and 411. The entire process is described in *Call In and Call Out*.

## Adding a New Contact
1. Expand the Phone/Email branch of the Configuration Editor tree and click **Contacts**. If there are any existing records, the Contacts branch will expand and the records will be listed.

2. Right-click the word **Contacts** and select **New** from the pop-up menu.

3. In the **New Phone or Email Contact** dialog box, enter a tag name for this contact. The tag name can be a maximum of 16 characters. The name can be composed using the letters A-Z, numbers 0-9, and any special characters except semicolons (;), and single (‘) and double (") quote marks.
4. Click OK. The new record is added to the Contacts branch and the contact configuration panel opens.

5. Configure the contact. See the sections human, answering machine, numeric pager, text pager, and email for instructions for configuring each of these contact types.

6. When configuration is complete, right-click the contact's tag name on the Contacts branch and select Save from the pop-up menu.

**Editing a Tag Name**

Tag names are edited directly from the Contacts branch, not from the configuration panel.

1. On the Contacts branch, click the tag name to be edited. Once selected, wait a few seconds and click the tag name again. A box surrounds the name and you should be able to change it.

2. Type the new name and press Enter.

3. Click OK at the Remember to update your schedules dialog box.

4. Collapse the Contacts branch and re-expand it to complete the edit.

After editing the tag name, update all schedules that use the contact.

1. Open the schedule and select the line that contains the old tag name.
2. From the Contact drop-down list, select the new tag name and click Update.
3. Click Save to save your changes.

For more information on schedules, see Creating 911 Schedules.

**Configuring Contacts**

**Human**

For instructions on adding a contact, see Adding a New Contact.
| **Number/Address** | Telephone number for this contact.  
• You can use dashes in the phone number to make it more readable (dashes are ignored by the system when it dials the number).  
• If you have to dial a number to get an outside line, enter that before the telephone number.  
• Enter commas (,) to force the system to pause before dialing the number. Multiple commas can be entered if you find that one comma doesn't provide a long enough pause.  
In the example above, the system will dial 9, wait a few seconds, and then dial 555-1212. |
| **Contact type** | Select Human. |
| **Machine delay** | Not applicable; only used for answering machine and numeric pager contacts. |
| **Dial In Code** | All Human contacts require a Dial In Code (similar to a PIN code) that allows users to access HT3’s call in and call out functions.  
When a user calls in, they are prompted for their Dial In Code and must enter a correct code before they can access the application. Human contacts are also prompted for their Dial In Code when they receive a 911 call.  
Dial In Code can be a maximum of 8 (eight) alphanumeric characters and is case insensitive. |
| **User** | The functions that call-in users are allowed to perform are determined by the permission settings of the User (HT3 Login) they are assigned to.  
• Select the User that has the correct permissions for this contact.  
  For example, if your HT3 system has a Login named OPER and OPER has permission to Acknowledge Alarms only, contacts that have a user name of OPER will only be allowed to acknowledge alarms. They cannot perform manual controls or configure telemetry.  
For more information on HT3 logins and permission levels, see [User Accounts](#). |
| **Partition** | Name of partition that this contact is allowed to access. |
Select a partition from the drop-down list.

Select All to allow this contact access to all configured partitions.

For more information on partitions, see Configuring Your System: Partitions.

<table>
<thead>
<tr>
<th>Alarm Limit</th>
<th>Not applicable; only used for answering machine, text pager, and e-mail contacts.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Test Call-Out</td>
<td>Click this button to test the contact. A properly configured contact will receive a phone call from the 911 application.</td>
</tr>
</tbody>
</table>

### Answering Machine

For instructions on adding a contact, see Adding a New Contact.

The example above shows how to set up an answering machine contact:

- **Number/Address**: Tel. 9,555-1313
- **Contact type**: Answering machine
- **Machine delay**: 3
- **Dial In Code**: MGR
- **Partition**: All
- **Alarm Limit**: 3

#### Number/Address

Telephone number for this contact.

- You can use dashes in the phone number to make it more readable (dashes are ignored by the system when it dials the number).
- If you have to dial a number to get an outside line, enter that before the telephone number.
- Enter commas (,) to force the system to pause before dialing the number. Multiple commas can be entered if you find that one comma doesn't provide a long enough pause.

In the example above, the system will dial 9, wait a few seconds, and then dial 555-1313.

#### Contact type

Select Answering machine.

#### Machine delay

Use to increase the pause before the system begins playing the alarm message. The system has a built-in delay, but it can be adjusted with this setting if you find that it isn't long enough.

#### Dial In Code

Only applicable if the person associated with this contact will be calling into the system. If this contact will only be receiving messages on an answering machine, leave this box empty.
The **Dial In Code** (similar to a PIN code) allows users to access HT3’s call in and call out functions.

When users call in, they are prompted for their **Dial In Code** and must enter a correct code before they can access the application.

**Dial In Code** can be a maximum of 8 (eight) alphanumeric characters and is case insensitive.

**User**

The functions that call-in users are allowed to perform are determined by the permission settings of the User (HT3 Login) they are assigned to.

- If this contact will only be receiving messages on an answering machine, this setting can be ignored.
- If this contact will be calling into the system, select the User that has the correct permissions for this contact.

For example, if your HT3 system has a Login named OPER that has permission to only **Acknowledge Alarms**, contacts assigned to OPER can only acknowledge alarms. They cannot perform manual controls or configure telemetry.

For more information on HT3 logins and permission levels, see [User Accounts](#).

**Partition**

Only applicable if the person associated with this contact will be calling into the system. If this contact will only be receiving messages on an answering machine, this setting can be ignored.

- Select the partition that this contact is allowed to access from the drop-down list.
- Select All to allow this contact access to all configured partitions.

For more information on partitions, see [Configuring Your System: Partitions](#).

**Alarm Limit**

Used to set the maximum number of alarms reported to this contact during each call.

**Test Call-Out**

Click this button to test the contact. A properly configured contact will receive a phone call from the 911 application.

---

**Numeric Pager**

For instructions on adding a contact, see [Adding a New Contact](#).
### Configuring Your System

#### Number/Address

Telephone number for this contact and the format of the message to be sent to this contact.

**Telephone number:**

- You can use dashes in the phone number to make it more readable (dashes are ignored by the system when it dials the number).
- If you have to dial a number to get an outside line, enter that before the telephone number.
- Enter commas (,) to force the system to pause before dialing the number. Multiple commas can be entered if you find that one comma doesn't provide a long enough pause.

**Message Format**

Insert a space directly after the telephone number and then the format of the message you want to receive:

- The message can contain the letters A-D, numbers 0-9, and the characters * and #.
- s (lowercase) returns the station number of the first alarm
- m (lowercase) returns the module letter of the first alarm
- p (lowercase) returns the point number of the first alarm

**Example:** The **Number/Address** box in our example includes:

- 9 to get an outside line
- Two commas (,,) to add a delay
- Contact's telephone number
- Message format. In this case, the telephone number that this contact calls to reach the HT3 system followed by #smp (smp provides the station number, module letter, and point address of the first alarm).

**Note on Module Letters in Messages**

When you receive a message, the modules A-D appear as letters A-D. Module E appears as DA, module F as DB, module G as DC, and all others as DD.

<table>
<thead>
<tr>
<th>Contact type</th>
<th><strong>Select</strong> Numeric Pager.</th>
</tr>
</thead>
</table>

| Machine delay | Use to increase the pause before the system begins sending the alarm message. The system has a built in delay, but it can be adjusted with this setting if you find that it isn't long enough. |

| Dial In Code | Only applicable if the person associated with this contact will be calling into the system. If this contact will only be receiving numeric page alerts, leave this box empty. |

The **Dial In Code** (similar to a PIN code) allows users to access HT3’s call in and call out functions.
When users call in, they are prompted for their **Dial In Code** and must enter a correct code before they can access the application.

**Dial In Code** can be a maximum of 8 (eight) alphanumeric characters and is case insensitive.

<table>
<thead>
<tr>
<th><strong>User</strong></th>
<th>The functions that call-in users are allowed to perform are determined by the permission settings of the User (HT3 Login) they are assigned to.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>• If this contact will only be receiving numeric page alerts, this setting can be ignored.</td>
</tr>
<tr>
<td></td>
<td>• If this contact will be calling into the system, select the User that has the correct permissions for this contact.</td>
</tr>
<tr>
<td></td>
<td>For example, if your HT3 system has a Login named OPER that has permission to only Acknowledge Alarms, contacts assigned to OPER can only acknowledge alarms. They cannot perform manual controls or configure telemetry.</td>
</tr>
<tr>
<td></td>
<td>For more information on HT3 logins and permission levels, see <a href="#">User Accounts</a>.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>Partition</strong></th>
<th>Only applicable if the person associated with this contact will be calling into the system. If this contact will only be receiving numeric page alerts, this setting can be ignored.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>• Select the partition that this contact is allowed to access from the drop-down list.</td>
</tr>
<tr>
<td></td>
<td>• Select All to allow this contact access to all configured partitions.</td>
</tr>
<tr>
<td></td>
<td>For more information on partitions, see <a href="#">Configuring Your System: Partitions</a>.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>Alarm Limit</strong></th>
<th>Not applicable; only used for answering machine, text pager, and email contacts.</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th><strong>Test Call-Out</strong></th>
<th>Click this button to test the contact. A properly configured contact will receive a page from the 911 application.</th>
</tr>
</thead>
</table>

## Text Pager

For instructions on adding a contact, see [Adding a New Contact](#).

**IMPORTANT:** HT3 uses Telocator Alphanumeric Protocol (TAP) to send alarm notification messages to a text pager. Many paging service providers are planning to discontinue or have already discontinued allowing dialup text messaging due to the cost of maintaining thousands of modems in large data centers. Contact your service provider to find out if they support this protocol. Ask them about alternative messaging methods if they do not.
The **Number/Address** field accepts the following information:

- Number used to get an outside line (if required).
- Commas (,) that force the system to pause before dialing the number. Multiple commas can be entered if you find that one comma doesn’t provide a long enough pause.
- **TAP dialup number** for your service provider followed by a space.
- Pager’s telephone number.

You can use dashes in the TAP dialup number and the pager telephone number to make it more readable (dashes are ignored by the system when it dials the number).

**TAP Dialup Number**

Text messages sent from HT3 to a pager are routed through a modem at the pager’s service provider. To send the message, HT3 must know the telephone number of the modem (referred to as a TAP dialup number).

- If you have multiple pagers using the same service provider, you can omit the TAP dialup number from the contact’s configuration and enter a global TAP dialup number in the global voice alarm settings.
- If the text pagers use different providers, you must enter the correct TAP dialup number in each contact’s **Number/Address** field.

Your service provider can provide you with the correct TAP dialup number or you can click the **Find TAP number** button to open a website that lists TAP dialup numbers for many service providers.

If your service provider isn't listed, you may find it in one of these directories:

- http://www.notepage.net/tap-phone-numbers.htm
- http://www.tapgateway.com/

**Example:**

In our example, the contact is configured to:

- Dial 9 to get an outside line
- Pause for two seconds
- Use the TAP dialup number 866-823-0501 to reach the service provider's modem
- Call the pager at telephone number 321-555-1212

<table>
<thead>
<tr>
<th>Contact type</th>
<th>Select Text Pager.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Machine delay</td>
<td>Not applicable; only used for answering machine and numeric pager contacts.</td>
</tr>
<tr>
<td>Dial In Code</td>
<td>Only applicable if the person associated with this contact will be calling into the system. If this contact will only be receiving text page alerts, leave this box empty. The <strong>Dial In Code</strong> (similar to a PIN code) allows users to access HT3’s call in and call out functions. When users call in, they are prompted for their <strong>Dial In Code</strong> and must enter a correct code before they can access the application. <strong>Dial In Code</strong> can be a maximum of 8 (eight) alphanumeric characters and is case insensitive.</td>
</tr>
</tbody>
</table>
| User | The functions that call-in users are allowed to perform are determined by the permission settings of the User (HT3 Login) they are assigned to.  
- If this contact will only be receiving text page alerts, this setting can be ignored.  
- If this contact will be calling into the system, select the User that has the correct permissions for this contact.
  
  For example, if your HT3 system has a Login named OPER that has permission to only **Acknowledge Alarms**, contacts assigned to OPER can only acknowledge alarms. They cannot perform manual controls or configure telemetry.

  For more information on HT3 logins and permission levels, see [User Accounts](#). |
| Partition | Only applicable if the person associated with this contact will be calling into the system. If this contact will only be receiving text page alerts, this setting can be ignored.  
- Select the partition that this contact is allowed to access from the drop-down list.  
- Select All to allow this contact access to all configured partitions.  

  For more information on partitions, see [Configuring Your System: Partitions](#). |
| Alarm Limit | Used to set the maximum number of alarms reported to this contact in each text message. |
| Find TAP number | If you have internet access, click **Find TAP number** to open a website that lists TAP dialup numbers for many service providers. |
| Test Call-Out | Click this button to test the contact. A properly configured contact will receive a page from the 911 application. |
Email

For instructions on adding a contact, see Adding a New Contact.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number/Address</td>
<td>Email address for this contact.</td>
</tr>
<tr>
<td>Contact type</td>
<td>Select Email.</td>
</tr>
<tr>
<td>Machine delay</td>
<td>Not applicable; only used for answering machine and numeric pager contacts.</td>
</tr>
<tr>
<td>Dial In Code</td>
<td>Only applicable if the person associated with this contact will be calling into the system. If this contact will only be receiving email alerts, leave this box empty. The Dial In Code (similar to a PIN code) allows users to access HT3’s call in and call out functions. When users call in, they are prompted for their Dial In Code and must enter a correct code before they can access the application. Dial In Code can be a maximum of 8 (eight) alphanumeric characters and is case insensitive.</td>
</tr>
</tbody>
</table>
| User                | The functions that call-in users are allowed to perform are determined by the permission settings of the User (HT3 Login) they are assigned to. 
  - If this contact will only be receiving email alerts, this setting can be ignored. 
  - If this contact will be calling into the system, select the User that has the correct permissions for this contact. For example, if your HT3 system has a Login named OPER that has permission to only Acknowledge Alarms, contacts assigned to OPER can only acknowledge alarms. They cannot perform manual controls or configure telemetry. For more information on HT3 logins and permission levels, see User Accounts. |
| Partition           | Only applicable if the person associated with this contact will be calling into the system. If this contact will only be receiving email alerts, this setting can be ignored. Select the partition that this contact is allowed to access from the drop-down list. |
Creating Call Out (911) Schedules

The Schedules database is a list of contacts (organized by time and day) that are notified when a Phone/Email-enabled alarm occurs. When a contact receives an alarm alert (either by phone, email or page), they can acknowledge the alarm by calling into the system, or, if the contact is configured as Human, the individual can acknowledge the alarm during the 911 call. Once a contact has been notified of the alarm situation, they can take the necessary corrective action. For more information on the Phone/Email option, see Alarms.

When you create a schedule, you are giving the system instructions on who to contact on what days and during which hours whenever a Phone/Email-enabled alarm occurs. There can be multiple schedules to cover different days of the week and different hours of the day, and each schedule can contain multiple contacts. For each contact in the schedule you can configure a delay that forces the system to wait a specified time before attempting the contact. Contacts can be one of five types: human, answering machine, text pager, numeric pager, or email. Information on creating contacts can be found in Call In and Call Out: Creating Contacts.

When an alarm occurs, the system tries each contact in the schedule in succession until the alarm is acknowledged. As soon as a contact acknowledges the alarm(s), the system stops the notification process.

For contact types other then human, you can add a delay to the next contact on the list that gives the current contact enough time to receive and review the alarm notification and call into the system to acknowledge the alarm. This delay should be long enough to allow the contact sufficient time to respond before the system tries to notify the next contact. If you want multiple contacts to be immediately notified at the same time* when an alarm occurs, configure each with a delay of 0 (zero). For example, if you want the system to send out email messages to two individuals and a text page to a third all at the same time*, you would configure each contact with a 0 (zero) delay. (* The system is unable to actually send out notifications simultaneously since there is only one phone line dedicated to call out, but it will send them in rapid succession.)

Note: To create or modify a call out list, you must be logged in to HT3 with an account that has Configure Voice permission. For more information on permissions, see User Accounts.

Refer to the sections below for information on setting up alarm call out schedules:

- Creating a Schedule
- Modifying a Schedule

Creating a Schedule

1. Open Configuration Editor.
2. On the Configuration Editor tree, expand the Phone/Email branch. The subcategories Schedules, Contacts, and Commands are listed.

3. Click Schedules. If any schedules have been configured, they will be listed below the word Schedules.

4. Right-click Schedules and select New from the pop-up menu.

5. The New Callout Schedule dialog box opens. Enter a descriptive name for the schedule and click OK. For example, East (AM) for a schedule that covers the early hours for stations on the east side of town.

6. Configure the following:

   **Days, Time & Partition**

   - **Days** - Select the days of the week these contacts should be notified (called, emailed, paged).

   - **From/To** - Select the schedule's time range (hours during which these contacts should be notified). Enter a time or use the slider bar to adjust the time.

   - **Partition** - Select the partition to which this schedule applies. Select All to grant these contacts access to all system partitions. For more information on partitions, see Configuring Your System: Partitions.

   These settings apply to all contacts in this schedule. They only need to be configured once; not each time a contact is added.

   **Contacts & Delays**

   a. From the drop-down list, select the first contact that should be notified.

   b. Select a delay. Delay is the number of minutes before the contact should be notified. When an alarm occurs, the appropriate schedule is activated and a timer is started. The timer is reset after each successful contact (phone call was answered, email didn’t bounce, contact didn’t respond with a busy signal, etc). For unsuccessful contacts, the system doesn't wait the entire time allotted for the next contact's delay; it only waits any excess time over the previous delay.
c. Click **Insert**. The contact tag name and its corresponding delay are added to **Delay-Contact** list. They are also added to the **Sequence of Delays and Contact tags** box (note that this box is for information purposes only; it can’t be edited).

d. To add another contact, click in the row below the first contact and repeat steps a-c, above. This contact will only be notified if the first contact either can’t be reached or there are still unacknowledged alarms after the previous call is complete. To insert a contact in the middle of the **Delay-Contact** list, click the row below where you want the contact to be added and then click **Insert**.

e. Continue this process until all the desired contacts have been added. Up to 25 contacts can be added for each schedule.

7. To save the list, select the corresponding schedule name from the Phone/Email -> Schedules branch of the Configuration Editor tree and right click. Click **Save** on the pop-up menu. The status bar displays the message "Save was successful."

**Notes:**
To insert a contact in the middle of the **Delay-Contact** list, click the row below where you want the contact to be added and then click **Insert**.

To modify a row in the schedule (for example, to change the contact or the delay), click the row to be changed, make the desired edits, and click **Update**.

To remove a contact, click the row of the contact to be deleted and click **Remove**.

**Modifying a Schedule**

1. Expand the Schedules branch and click the name of the schedule you want to edit.

2. Make the desired changes.
   - Change the days, times, and partition for this schedule if necessary.
   - To insert a contact, click the row below where you want the contact to be added and then click **Insert**.
   - To modify a row in the schedule (for example, to change the contact or the delay), click the row to be changed, make the desired edits, and click **Update**.
   - To remove a contact, click the row of the contact to be deleted and click **Remove**.

3. To save the edited schedule, select the corresponding schedule name from the Phone/Email -> Schedules branch of the Configuration Editor tree and right click. Click **Save** on the pop-up menu. The status bar displays the message "Save was successful."

**Creating Call In (411) Commands**

411 is a HT3 application that enables you to call into your system, using a standard touch-tone phone, and perform actions such as checking status and acknowledging alarms. For an overview of how 411 works and how to use it, see Call In and Call Out.
Each command is assigned a code and a prompt. The prompt is a recording that explains the command’s function. This is what the caller hears when they are given the menu options during their call. For information on the default recordings that are included with HT3 and instructions on how to create prompt recordings for custom 411 commands, see Recording Messages. The code is the key pad entry the caller must make to access the command. Other configuration options available to commands are explained in detail in the sections below.

411 features nine command types:

- Acknowledge
- List Alarms
- Status Summary
- Status by Name
- Status by Label
- Status by Address
- Status by Keyword
- Control by Name
- Control by Address
- Configure New Station
- Exit

Commands for Acknowledge and Exit come preloaded with 411. Typically, there is no need for additional Acknowledge- or Exit-type commands. With 411, you can have up to 90 unique commands on your system. All command types except Configure new station can be used for virtual points. When accessing information on virtual points, use a station number of 0 (zero).

### Acknowledge Command

411’s preloaded acknowledge command (pendingalarms) is assigned a code of 1 (one). Pressing 1 on your telephone keypad during a 411 session enables you to listen to a listing of current alarms and acknowledge them. This functions much the same as the Alarm Call Out feature. After you select the Acknowledge command, the system announces the first alarm. You are then prompted to press 1 to acknowledge the alarm or 2 to have the alarm message repeated. After an alarm has been acknowledged, the system announces the next active alarm. When all alarms have been acknowledged, the system tells you that there are no new alarms.
Exit Command

411’s preloaded exit command (hangup) is assigned a code of 9 (nine). This command provides you with a graceful way to end the current 411 session before you physically hang up the phone. When you are ready to exit 411, press 9 on the keypad. The system tells you "good bye" and you can now hang up the phone.

List Alarms

With the List Alarms command, you can hear a list of all alarms (unacknowledged and acknowledged alarms). You can hear alarms at all stations or at a specific station. When 411 announces the alarms, it first states the name of the station, and then states the point name and alarm state for each alarm. It then announce the name of the next station and the point names and alarm states for each of its alarms.

Example: You want to be able to call in and hear a list of alarms at a chosen station. You would add a List Alarms command and leave the Stations box empty. When you call in and enter the code assigned to the List Alarms command, you will be prompted for a station number. Enter the number of the desired station to hear all current acknowledged and unacknowledged alarms at that station.

1. Open Configuration Editor.
2. On the Configuration Editor tree, select Phone/Email. The Phone/Email branch expands to show Schedules, Contacts and Commands.
3. Right click Commands and click New on the pop-up menu.
4. In the New 411 command dialog box, enter a code for this command and click OK.
Code is a unique number that users key in to access this command. This code can be a single digit or any two-digit combination (for example, 5, 8, 14, 37). We recommend that you not use the numbers 11, 22, 33, ... 88, 99. If a caller holds down a key, the system may register the number two times or more. This could result in the caller getting, for example, Command 11 when they wanted Command 1.

5. The new 411 command is added to the Commands branch and its configuration screen opens.

Configure the following:

- **Type** - This command's type. Select **List Alarms** from the drop-down list.

- **Prompt** - Name of the voice file that you want the system to play when it lists all available commands as part of a help message. See **Command Prompt Recordings**.

- **Stations** - Leave this box blank to allow the command to be used with any station. When callers phone in they will be prompted to key in a station number. Callers can press 0 (zero) to hear information on virtual points.

  To restrict the stations that can be used with the command, list station numbers (or ranges of station numbers) separated by commas. For example, entering 1,5,10-12 in the **Stations** box restricts the use of this command to stations 1, 5, 10, 11, and 12. If only one station number is listed, callers will not be prompted for a station number. **Note**: Enter 0 (the number zero) in the **Stations** box to use this command with virtual points.

  See **Configuring Your System: Stations** for more information on stations.

- **Points** - The points box should be left empty; 411 ignores this field when processing a **List Alarms** command.

- **Partition** - Partition to which you want to restrict this command. Select a partition from the drop-down list. For more information on partitions, see **Configuring Your System: Partitions**.

6. On the Commands branch, right click the new command's name and click **Save** on the pop-up menu.
7. The status bar displays the message "Save was successful."

**Status Summary Command**

With the Status Summary command, you can hear a list of all points in the selected station that are in the alarm state, including those alarms that have been acknowledged. You can also configure this command to give you the status of any points that have associated keywords.

**Examples:** You have several stations with points that represent pumps. You have linked these points to the keyword PUMPS. (For more information on keywords, see Configuring Your System: Keywords.) In the command’s Points box, you enter the word PUMPS. When you call 411 and enter the code for this Status Summary command, you first hear a list of the selected station’s alarms. You are then given the status of any points at the station that are linked to the keyword PUMPS.

It is also possible to enter a keyword and label (High state label or Low state label) combination in the Points box. This enables you to hear a list of only those keyword-related points whose current status matches the label. For example, if you entered the keyword PUMPS and the label RUNNING, you would be given a list of points that are linked to the keyword PUMPS and whose current status matches the label RUNNING. For more information on keywords, see Configuring Your System: Keywords. See Configuring Your System: Adding a Digital Point for more information on high and low state labels.

1. **Open Configuration Editor.**

2. On the Configuration Editor tree, select Phone/Email. The Phone/Email branch expands to show Schedules, Contacts and Commands.

3. Right click **Commands** and click **New** on the pop-up menu.
4. In the **New 411 command** dialog box, enter a code for this command and click **OK**.

**Code** is a unique number that users key in to access this command. This code can be a single digit or any two-digit combination (for example, 5 8, 14, 37). We recommend that you not use the numbers 11, 22, 33, ... 88, 99. If a caller holds down a key, the system may register the number two times or more. This could result in the caller getting, for example, Command 11 when they wanted Command 1.

5. The new 411 command is added to the Commands branch and its configuration screen opens.

Configure the following:

- **Type** - This command’s type. Select **Status Summary** from the drop-down list.
- **Prompt** - Name of the voice file that you want the system to play when it lists all available commands as part of a help message. See **Command Prompt Recordings**.
- **Stations** - Leave this box blank to allow the command to be used with any station. When callers phone in they will be prompted to key in a station number. Callers can press 0 (zero) to hear information on virtual points.

To restrict the stations that can be used with the command, list station numbers (or ranges of station numbers) separated by commas. For example, entering 1,5,10-12 in the **Stations** box restricts the use of this command to stations 1,5,10,11, and 12. If only one station number is listed, callers will not be prompted for a station number. **Note:** Enter 0 (the number zero) in the **Stations** box to use this command with virtual points.

See **Configuring Your System: Stations** for more information on stations.
Points - Keywords and/or point status labels, including those of virtual points, for this command. Multiple keywords separated by commas can be listed in this box. You can also associate a High or Low state label with a keyword by entering the keyword, a space, and then the label. For example, PUMPS RUNNING, will give you a list of all of the PUMPS that are RUNNING at the selected station. PUMPS RUNNING,WELLS will give you a list of all of the PUMPS that are RUNNING at the selected station, and will also give you the status of the station's WELLS. Note: Leave this box empty to hear a list of all alarms at this station.

For more information on keywords, see Configuring Your System: Keywords. See Configuring Your System: Add a Digital Point for more information on high and low state labels.

Partition - Partition to which you want to restrict this command. Select a partition from the drop-down list. For more information on partitions, see Configuring Your System: Partitions.

6. On the Commands branch, right click the new command's name and click Save on the pop-up menu.

7. The status bar displays the message "Save was successful."

Status by Name Command

Status by Name commands enable you to retrieve the status of only those points whose name matches the word listed in the command's Points box. When you configure a point in the HT3 system (see Configuring Your System: Points), you assign it a user-defined name. This enables you to access the point using an easily-remembered word rather than a telemetry address. When you enter a point name in the command's Points box, the command only reports the status of those points whose name matches what is entered in the Points box.

Example: You only want to know the status of the pumps at a station and you have named the points PUMP1, PUMP2, and PUMP3. You can create a Status by Name command and enter PUMP* in the Points box. (See the description of the Points field, below, for more information on the pattern matching characters, *, ?, and [ ]). This command would only retrieve the status of points at the station whose name begins with PUMP. In our example, PUMP1, PUMP2, and PUMP3.

1. Open Configuration Editor.

2. On the Configuration Editor tree, select Phone/Email. The Phone/Email branch expands to show Schedules, Contacts and Commands.
3. Right click **Commands** and click **New** on the pop-up menu.

4. In the **New 411 command** dialog box, enter a code for this command and click **OK**.

   **Code** is a unique number that users key in to access this command. This code can be a single digit or any two-digit combination (for example, 5 8, 14, 37). We recommend that you not use the numbers 11, 22, 33, ... 88, 99. If a caller holds down a key, the system may register the number two times or more. This could result in the caller getting, for example, Command 11 when they wanted Command 1.

5. The new 411 command is added to the Commands branch and its configuration screen opens.

Configure the following:

- **Type** - This command’s type. Select **Status by Name** from the drop-down list.
- **Prompt** - Name of the voice file that you want the system to play when it lists all available commands as part of a help message. See **Command Prompt Recordings**.
• **Stations** - Leave this box blank to allow the command to be used with any station. When callers phone in they will be prompted to key in a station number. Callers can press 0 (zero) to hear information on virtual points.

To restrict the stations that can be used with the command, list station numbers (or ranges of station numbers) separated by commas. For example, entering 1,5,10-12 in the **Stations** box restricts the use of this command to stations 1,5,10,11, and 12. If only one station number is listed, callers will not be prompted for a station number. **Note:** Enter 0 (the number zero) in the **Stations** box to use this command with virtual points.

See [Configuring Your System: Stations](#) for more information on stations.

• **Points** - Name, including those of virtual points, to associate with this command. Multiple names separated by commas can be listed in this box. You can also use pattern matching characters:

  *  - Match 0 or more characters. For example, P* would match PUMP, PUMPS, PUMP1, and PUMP2.

  ?  - Match any one character. For example, PUMP? would match PUMPS, PUMP1, and PUMP2, but would not match PUMP.

  [ ] - Match any one of the characters inside the brackets. For example, PUMP[123] would match PUMP1, PUMP2, and PUMP3.

• **Partition** - Partition to which you want to restrict this command. Select a partition from the drop-down list. For more information on Partitions, see [Configuring Your System: Partitions](#).

6. On the Commands branch, right click the new command's name and click **Save** on the pop-up menu.

7. The status bar displays the message "Save was successful."

### Status by Label Command

**Status by Label** commands enable you to retrieve the status of only those points whose current status label matches the word listed in the command's **Points** box. When you configure a digital point in the HT3 system (see [Configuring Your System: Adding a Digital Point](#)), you can assign it a **Low state label** and a **High state label**. This lets you assign easily-remembered terms to a digital point's "zero" and "one" states.

For analog points, you can enter units of measurement in the **Points** box. When you configure an analog point in the HT3 system (see [Configuring Your System: Adding an Analog Point](#)), you assign it a unit of measurement (**Units**). For example, FT, %, DegF.
When you enter a label or unit of measurement in the command's **Points** box, the command only reports the status of those points whose current status label (digital point) or unit of measurement (analog point) matches what is entered in the **Points** box.

**Example 1** You have three pumps at a station. Each pump has a pump status point with a **Low state label** of OFF and a **High state label** of RUNNING. If you create a **Status by Label** command with the word RUNNING in the **Points** box, 411 only reports the pumps that are RUNNING.

**Example 2** You have two stations that each have a point that monitors the level of a well (**Units** equal to FEET). If you create a **Status by Label** command with the word FEET in the **Points** box, 411 only reports on the points at the station that have **Units** equal to FEET.

1. **Open Configuration Editor.**

2. On the Configuration Editor tree, select **Phone/Email**. The Phone/Email branch expands to show Schedules, Contacts and Commands.

3. Right click **Commands** and click **New** on the pop-up menu.

4. In the **New 411 command** dialog box, enter a code for this command and click **OK**.

**Code** is a unique number that users key in to access this command. This code can be a single digit or any two-digit combination (for example, 5 8, 14, 37). We recommend that you not use the numbers 11, 22, 33, ... 88, 99. If a caller holds down a key, the system may register the number two times or more. This could result in the caller getting, for example, Command 11 when they wanted Command 1.
5. The new 411 command is added to the **Commands** branch and its configuration screen opens.

![Configuration Screen](image)

Configure the following:

- **Type** - This command's type. Select **Status by Label** from the drop-down list.

- **Prompt** - Name of the voice file that you want the system to play when it lists all available commands as part of a help message. See [Command Prompt Recordings](#).

- **Stations** - Leave this box blank to allow the command to be used with any station. When callers phone in they will be prompted to key in a station number. Callers can press 0 (zero) to hear information on virtual points.

  To restrict the stations that can be used with the command, list station numbers (or ranges of station numbers) separated by commas. For example, entering 1,5,10-12 in the **Stations** box restricts the use of this command to stations 1,5,10,11, and 12. If only one station number is listed, callers will not be prompted for a station number. **Note**: Enter 0 (the number zero) in the **Stations** box to use this command with virtual points.

  See [Configuring Your System: Stations](#) for more information on stations.

- **Points** - Label or unit of measurement, including those of virtual points, to associate with this command. You can also use pattern matching characters:
  
  - `*` - Match 0 or more characters. For example, `F*` would match FT, FEET, and FOOT.
  
  - `?` - Match any one character. For example, `DEG?` would match DegF and DegC, but would not match Deg.
  
  - `[ ]` - Match any one of the characters inside the brackets. For example, `DEG[FC]` would match DegF and DegC.

- **Partition** - Partition to which you want to restrict this command. Select a partition from the drop-down list. For more information on partitions, see [Configuring Your System: Partitions](#).

6. On the **Commands** branch, right click the new command's name and click **Save** on the pop-up menu.
7. The status bar displays the message "Save was successful."

**Status by Address Command**

**Status by Address** commands enable you to retrieve the status of telemetry points based on their address. You can specify a particular station number in the **Stations** box or leave the box blank if you want to use this command with multiple stations. If the **Stations** box is left blank, callers are prompted for a station number unless you have entered full telemetry addresses (station + module + point) in the **Points** box. In this situation, you are immediately provided with the status of the listed addresses.

**Note:** If you need the same type of command (e.g., pump status) for more than one station, leave the **Stations** box empty. You cannot retrieve status from more than one station in a single command by listing multiple stations in the **Stations** box.

**Example:** You have three stations that have pump status points (pumps running or off) configured at addresses A10, A11, and A12. You can create a **Status by Address** command, leave the **Stations** box empty, and list the three points (A10, A11, and A12) in the **Points** box. When you call 411, you enter the command’s code and a station number when prompted, and are then given the status of the three pumps at that station.

1. **Open Configuration Editor.**

2. On the Configuration Editor tree, select **Phone/Email**. The Phone/Email branch expands to show Schedules, Contacts and Commands.

3. Right click **Commands** and click **New** on the pop-up menu.

4. In the **New 411 command** dialog box, enter a code for this command and click **OK**.
Code is a unique number that users key in to access this command. This code can be a single digit or any two-digit combination (for example, 5 8, 14, 37). We recommend that you not use the numbers 11, 22, 33, ... 88, 99. If a caller holds down a key, the system may register the number two times or more. This could result in the caller getting, for example, Command 11 when they wanted Command 1.

5. The new 411 command is added to the Commands branch and its configuration screen opens.

![Configuration Screen]

Configure the following:

- **Type** - This command's type. Select Status by Address from the drop-down list.

- **Prompt** - Name of the voice file that you want the system to play when it lists all available commands as part of a help message. See Command Prompt Recordings.

- **Stations** - This box can be left blank, and either a full telemetry address (station + module + point) or partial address (module + point) can be entered in the Points box. If a full telemetry address is entered, callers are immediately given the status of the listed addresses. If the Stations box is left empty and a partial address is entered in the Points box, callers are prompted for a station address. Callers can press 0 (zero) to hear information on virtual points.

If a number is entered in the Stations box, callers are not prompted for a station number. They can only hear the status of the points (as listed in the Points box) that are located at the given station (as listed in the Stations box).

- **Notes**: You cannot list more than one station number in a single command. If you need the same type of command (e.g., pump status) for multiple stations, leave the Stations box empty. Enter 0 (the number zero) in the Stations box to use this command with virtual points.

See Configuring Your System: Stations for more information on stations.

- **Points** - Telemetry address of point(s), including virtual points, to associate with this command. Do not include the station portion of the address unless the point is a virtual point (station address of virtual points is 0). You can enter multiple addresses separated by commas. You can also use pattern matching characters:

  * - Match 0 or more characters. For example, A* would match A10, A11, and A12.

  ? - Match any one character. For example, A? would match A10, A11, and A12, but would not match A112.
[ ] - Match any one of the characters inside the brackets. For example, A1[012] would match A10, A11, and A12.

- **Partition** - Partition to which you want to restrict this command. Select a partition from the drop-down list. For more information on partitions, see Configuring Your System: Partitions.

6. On the Commands branch, right click the new command’s name and click **Save** on the pop-up menu.

7. The status bar displays the message "Save was successful."

**Status by Keyword Command**

The **Status by Keyword** command enables you to retrieve the status of telemetry points based on their associated keyword. You can specify a particular station number in the **Stations** box, multiple stations separated by commas, or leave the box blank if you want to be prompted for a station number when you call in.

When you enter a **Keyword** in the command’s **Points** box, the command only reports the status of those points whose keyword matches what is entered in the **Points** box.

**Example 1** You have several stations with points that represent pumps. You have linked these points to the keyword PUMPS. (For more information on keywords, see Configuring Your System: Keywords.) In the command’s **Points** box, you enter the word PUMPS. When you call 411 and enter the code for this **Status by Keyword** command, you hear the status of all points at the station that are linked to the keyword PUMPS.

**Example 2:** It is also possible to enter a keyword and label (High state label or Low state label) combination in the **Points** box. This enables you to hear a list of only those keyword-related points whose current status matches the label. For example, if you entered the keyword PUMPS and the label RUNNING, you would be given a list of points that are linked to the keyword PUMPS and whose current status matches the label RUNNING. For more information on keywords, see Configuring Your System: Keywords. See Configuring Your System: Adding a Digital Point for more information on high and low state labels.

1. **Open Configuration Editor.**
2. On the Configuration Editor tree, select **Phone/Email**. The Phone/Email branch expands to show Schedules, Contacts and Commands.
3. Right click **Commands** and click **New** on the pop-up menu.

4. In the **New 411 command** dialog box, enter a code for this command and click **OK**.

   **Code** is a unique number that users key in to access this command. This code can be a single digit or any two-digit combination (for example, 5 8, 14, 37). We recommend that you not use the numbers 11, 22, 33, ... 88, 99. If a caller holds down a key, the system may register the number two times or more. This could result in the caller getting, for example, Command 11 when they wanted Command 1.

5. The new 411 command is added to the Commands branch and its configuration screen opens.

   Configure the following:
   
   - **Type** - This command's type. Select **Status by Keyword** from the drop-down list.
   - **Prompt** - Name of the voice file that you want the system to play when it lists all available commands as part of a help message. See [Command Prompt Recordings](#).
Configuring Your System

**Stations** - Leaving this box blank allows the command to be used with any station. When callers phone in they will be prompted to key in a station number. Callers can press 0 (zero) to hear information on virtual points.

To restrict the stations that can be used with the command, list station numbers (or ranges of station numbers) separated by commas. For example, entering 1,5,10-12 in the **Stations** box restricts the use of this command to stations 1,5,10,11, and 12. If only one station number is listed, callers will not be prompted for a station number. **Note:** Enter 0 (the number zero) in the **Stations** box to use this command with virtual points.

See Configuring Your System: Stations for more information on stations.

**Points** - Keywords and/or point status labels, including those of virtual points, for this command. Multiple keywords separated by commas can be listed in this box. You can also associate a **High** or **Low state label** with a keyword by entering the keyword, a space, and then the label. For example, PUMPS RUNNING, will give you a list of all of the PUMPS that are RUNNING at the selected station. PUMPS RUNNING,WELLS will give you a list of all of the PUMPS that are RUNNING at the selected station, and will also give you the status of the station’s WELLS.

For more information on keywords, see Configuring Your System: Keywords. See Configuring Your System: Adding a Digital Point for more information on high and low state labels.

**Partition** - Partition to which you want to restrict this command. Select a partition from the drop-down list. For more information on partitions, see Configuring Your System: Partitions.

6. On the Commands branch, right click the new command’s name and click **Save** on the pop-up menu.

7. The status bar displays the message "Save was successful."

**Control by Name Command**

**Control by Name** commands search the selected station for the first match between a point's **Name** box and the command’s **Points** box. When you configure a point in the HT3 system (see Configuring Your System: Points), you assign it a user-defined name. This enables you to access the point using an easily-remembered word rather than a telemetry address.

When you enter a point name in the command's **Points** box, the command only retrieves points whose name matches what is entered in the **Points** box. **Control by Name** commands enable you to first hear the current status of a control point and then change the point’s value.
**Example:** You have three stations that each have a control point for disabling a pump that is designated Pump1. This control point is named Pump1 Disable. To create a command that allows you to change this point’s value, you create a **Control by Name** command and leave the **Stations** box blank and enter *Pump1 Disable* in the **Points** box. When you call 411 and select this command, you are prompted for a station number. The current status of the control point is reported and you are given the opportunity to change the control point’s value.

For digital controls, you are asked to confirm the new value by its label. For analog controls, you type in a new value and then press the pound (#) key. The star (*) key is used to insert a decimal point.

**Note:** Although you can enter multiple names separated by commas in the **Points** box, only the first matching point is acted on.

1. **Open Configuration Editor.**

2. On the Configuration Editor tree, select **Phone/Email**. The Phone/Email branch expands to show Schedules, Contacts and Commands.

3. Right click **Commands** and click **New** on the pop-up menu.

4. In the **New 411 command** dialog box, enter a code for this command and click **OK**.

**Code** is a unique number that users key in to access this command. This code can be a single digit or any two-digit combination (for example, 5 8, 14, 37). We recommend that you not use the numbers 11, 22, 33, ... 88, 99. If a caller holds down a key, the system may register the number two times or more. This could result in the caller getting, for example, Command 11 when they wanted Command 1.
5. The new 411 command is added to the Commands branch and its configuration screen opens.

Configure the following:

- **Type** - This command’s type. Select **Control by Name** from the drop-down list.

- **Prompt** - Name of the voice file that you want the system to play when it lists all available commands as part of a help message. See **Command Prompt Recordings**.

- **Stations** - Leaving this box blank allows the command to be used with any station. When callers phone in they will be prompted to key in a station number. Callers can press 0 (zero) to hear information on virtual points.

To restrict the stations that can be used with the command, list station numbers (or ranges of station numbers) separated by commas. For example, entering 1,5,10-12 in the **Stations** box restricts the use of this command to stations 1,5,10,11, and 12. If only one station number is listed, callers will not be prompted for a station number. **Note:** Enter 0 (the number zero) in the **Stations** box to use this command with virtual points.

See **Configuring Your System: Stations** for more information on stations.

- **Points** - Name, including those of virtual points, to associate with this command. Multiple names separated by commas can be listed in this box, but only the first matching point is acted on. You can also use pattern matching characters:

  - * - Match 0 or more characters. For example, *Disable would match Pump #1 Disable, Pump #2 Disable, and Pump #3 Disable.

  - ? - Match any one character. For example, Pump ? Override would match Pump 1 Override, Pump 2 Override, and Pump 3 Override, but not Pump #1 Override.

  - [] - Match any one of the characters inside the brackets. For example, Pump #[123] Override would match Pump #1 Override, Pump #2 Override, and Pump #3 Override.

- **Partition** - Partition to which you want to restrict this command. Select a partition from the drop-down list. For more information on partitions, see **Configuring Your System: Partitions**.

6. On the Commands branch, right click the new command's name and click **Save** on the pop-up menu.
7. The status bar displays the message "Save was successful."

## Control by Address Command

Control by Address commands search the selected station for the first match between a point's address and the command's Points box. Control by Address commands enable you to first hear the current status of a control point and then change the point's value. You can specify a particular station number in the Stations box or leave the box blank, which allows you to use the command with multiple stations. If the Stations box is left blank, callers are prompted for a station number after selecting the command.

**Example:** You have three stations that each have a control point for disabling a pump. This control point has a telemetry address (module letter + point number) of A65. To create a command that allows you to change this point's value, you create a Control by Address command, leave the Stations box empty, and enter the telemetry address A65 in the Points box. When you call 411 and select this command, you are prompted for a station number. The current status of the control point is reported and you are given the opportunity to change the control point's value.

For digital controls, you are asked to confirm the new value by its label. For analog controls, you type in a new value and then press the pound (#) key. The star (*) key is used to insert a decimal point.

**Note:** Although you can enter multiple addresses separated by commas in the Points box, only the first matching point is acted on.

1. **Open Configuration Editor.**

2. On the Configuration Editor tree, select **Phone/Email**. The Phone/Email branch expands to show Schedules, Contacts and Commands.

3. Right click **Commands** and click **New** on the pop-up menu.
4. In the **New 411 command** dialog box, enter a code for this command and click **OK**.

   ![New 411 command dialog box]

   **Code** is a unique number that users key in to access this command. This code can be a single digit or any two-digit combination (for example, 5 8, 14, 37). We recommend that you not use the numbers 11, 22, 33, ... 88, 99. If a caller holds down a key, the system may register the number two times or more. This could result in the caller getting, for example, Command 11 when they wanted Command 1.

5. The new 411 command is added to the Commands branch and its configuration screen opens.

   ![New 411 command configuration screen]

Configure the following:

- **Type** - This command's type. Select **Control by Address** from the drop-down list.

- **Prompt** - Name of the voice file that you want the system to play when it lists all available commands as part of a help message. See **Command Prompt Recordings**.

- **Stations** - Leaving this box blank allows the command to be used with any station. When callers phone in they will be prompted to key in a station number. Callers can press 0 (zero) to hear information on virtual points.

   To restrict the stations that can be used with the command, list station numbers (or ranges of station numbers) separated by commas. For example, entering 1,5,10-12 in the **Stations** box restricts the use of this command to stations 1,5,10,11, and 12. If only one station number is listed, callers will not be prompted for a station number. **Note**: Enter 0 (the number zero) in the **Stations** box to use this command with virtual points.

   See **Configuring Your System: Stations** for more information on stations.
• **Points** - Telemetry address of point, including virtual points, to associate with this command. Do not include the station portion of the address unless the point is a virtual point (station address is 0 for virtual points). You can enter multiple addresses separated by commas, but only the first matching point is acted on. You can also use pattern matching characters:

  * - Match 0 or more characters. For example, A* would match A10, A11, and A12.

  ? - Match any one character. For example, A1? would match A10, A11, and A12, but would not match A112.

  [ ] - Match any one of the characters inside the brackets. For example, A1[012] would match A10, A11, and A12.

• **Partition** - Partition to which you want to restrict this command. Select a partition from the drop-down list. For more information on partitions, see Configuring Your System: Partitions.

6. On the Commands branch, right click the new command’s name and click **Save** on the pop-up menu.

    ![Commands Menu](image)

7. The status bar displays the message "Save was successful."

**Configure New Station Command**

**Configure New Station** commands allow you to configure a new station by copying the configuration of an existing one. You can enter the existing station's number in the **Stations** box. Or, leave the **Stations** box empty, and 411 will prompt you for the telemetry address of both the existing and the new station.

**Example**: You've installed a new Pump Control Unit that controls a pumping station and its telemetry configuration is exactly the same as an existing station. As soon as the physical installation is complete, you can use 411 to configure this new station's telemetry - right from the site. This makes it possible for you to begin testing the equipment immediately.

1. Open Configuration Editor.

2. On the Configuration Editor tree, select **Phone/Email**. The Phone/Email branch expands to show Schedules, Contacts and Commands.
3. Right click **Commands** and click **New** on the pop-up menu.

4. In the **New 411 command** dialog box, enter a code for this command and click **OK**.

**Code** is a unique number that users key in to access this command. This code can be a single digit or any two-digit combination (for example, 5, 8, 14, 37). We recommend that you not use the numbers 11, 22, 33, ... 88, 99. If a caller holds down a key, the system may register the number two times or more. This could result in the caller getting, for example, Command 11 when they wanted Command 1.

5. The new 411 command is added to the Commands branch and its configuration screen opens.

Configure the following:

- **Type** - This command’s type. Select **Configure new station** from the drop-down list.
- **Prompt** - Name of the voice file that you want the system to play when it lists all available commands as part of a help message. See **Command Prompt Recordings**.
Stations - Leaving this box blank allows the command to be used with any station. When callers phone in they will be prompted to key in the number of the station whose configuration they want to copy.

To restrict the station that can be used with the command, enter the station number in this box. For example, if 10 was entered in the Stations box, callers would not be prompted for a station number; they could only copy the configuration of station 10.

See Configuring Your System: Stations for more information on stations.

Points - The Points box is not used for this command.

Partition - Partition to which you want to restrict this command. Select a partition from the drop-down list. For more information on partitions, see Configuring Your System: Partitions.

6. On the Commands branch, right click the new command’s name and click Save on the pop-up menu.

7. The status bar displays the message “Save was successful.”

Recording Messages

With HT3’s Voice Recording tool, you can create custom recordings for local and Call Out (911) alarm announcements and prompts for Call In (411) commands. Prompts are recordings that describe the function of the command. They are played when a caller selects * (star) to hear a listing of all available commands.

Alarms are still announced even if custom recordings are not created, but recording custom messages makes alarm announcements more meaningful.

For example, an alarm occurs at station 1, module A, point 12. This address represents the well level at the Main Street station. If we don't create custom recordings, the system will announce "station one, module A, point twelve, low." This message tells us that an alarm has occurred. But, unless we’ve memorized the location of station 1, module A, point 12, the message is meaningless. With custom recordings, we can have the system announce “Main Street, well level low.”

For Call In (411), you must create prompt recordings for each custom command. Recordings for the prepackaged commands pendingalarms and hangup are included in HT3.

Any recordings created with the Voice Recording tool are available for local and Call Out (911) alarm announcements and Call In (411).

Refer to the sections below for information on creating recordings for alarm and Call In (411) messages.

- Opening the Voice Recording Tool
- The Record Tab
• Prepackaged Recordings
• Suggested Recordings
• Recording Alarm Announcements Overview
• Recording Station Messages
• Recording Point Messages
• Recording Label Messages
• Upgrade Recordings to New Scheme
• Command Prompt Recordings
• Re-Recording Messages
• Trimming Recordings
• Remove Files from the Recordings Database
• Renaming Voice Recordings
• Linking Voice Recordings
• File Naming Conventions

Opening the Voice Recording Tool

1. Click Configure on the HT3 main menu.

2. Click Voice on the Configure submenu. The Voice Recording tool opens in the right panel.

   The Voice Recording tool has two tabs - Record and Configure.

   A description of the Record tab is below. For information on the Configure tab, see Configuring Global Voice Alarm Settings.
The Record Tab

| Sound Wave | This box displays the wave form of the sound recording. This visual representation of the recording is useful when trimming silence from the beginning and/or end of a recording (displayed as a straight line) or making sure that the recording isn't distorted (wave touches or exceeds the top and bottom bounds of the box). |
| Current Target | This box shows the name of the currently selected recording. If you are creating a new recording for a system component (for example, a station or point), the system will automatically generate a file name and display it as the Current Target. If you are using the old method where you create a recording and then link it to a component, you can type a file name in the Current Target box. |
| Current Recordings | This shows a list of recordings. When you click a file name in this list, it is displayed in the Current Target box. The list displayed depends on the category that has been loaded (All, Numbers, Letters, Labels and Units, Standard Recordings, By Prefix). See Load Recordings for more information. |
| Audio | The Audio section has buttons for the following functions: |

- **Play** - Click this button to play the selected recording. (**Note**: If you select Enable audio when you login to HT3, you may hear the alarm announcement and the recording simultaneously if there are unacknowledged alarms.)

- **Record** - Click this button to create a recording. This recording will be saved with the file name listed in the Current Target box.

- **Trim** - This is used to remove unwanted portions of the recording. In the wave form box, highlight the part of the recording you want to remove and click Trim. See Trimming Recordings for more information.
Save - Click this button to save your recording. If you’ve created a new recording or edited an existing one, a NOT SAVED message is displayed next to the Current Target box until you click Save.

Commands

- Rename - This command is used to give the currently selected recording a new file name. Enter the new name in the Current Target box before clicking Rename.

- Upgrade - This command enables you to easily update your sound files to the new naming scheme. Under the previous system, file names of recordings for stations and points were based on their addresses (for example, a recording for station 25 had a file name of stn_25). The new scheme uses the user defined station or point name for the file name (for example, if station 25 had a user defined name of "Main Street," the name of the recording would be mainstreet (all lowercase, all punctuation and spaces removed). To update an old file name, select the recording and click Upgrade.

- Make Link - Click this button to link a recording to a telemetry component. This command was retained for users who want to continue using the old method of creating recordings and manually linking them to telemetry components.

- Delete - Click this button to remove a recording from the Current Recordings database.

Load Recordings

Options for filter recordings when linking, re-recording, or removing recordings.*

- All - List all recordings.

- Numbers - List all number recordings.

- Letters - List all letter recordings.

- Labels and Units - List all label and unit recordings.

- Standard Recordings - List all standard (prepackaged) HT3 recordings.

- By Prefix - List all recordings that start with the specified character or character string. For example, all recordings that start with “stn.”

* If there are a large number of voice recordings, not all of the files can be displayed in the Current Recordings list. This is due to a packet limitation by the call out server program.

Prepackaged Recordings

HT3 comes prepackaged with a library of recordings that are played alone, or in conjunction with other recordings, when a user places an incoming 411 call or HT3 makes an outgoing 911 call.

The following is a list of HT3’s prepackaged recordings:
## Numbers & Letters

<table>
<thead>
<tr>
<th>File Name</th>
<th>Spoken Message</th>
</tr>
</thead>
<tbody>
<tr>
<td>0-20 and 30, 40, 50, 60, 70, 80, and 90</td>
<td>For example, &quot;one&quot; and &quot;nineteen&quot;</td>
</tr>
<tr>
<td>A-Z</td>
<td>For example, &quot;bee&quot; and &quot;gee&quot;</td>
</tr>
<tr>
<td>HUNDRED</td>
<td>&quot;hundred&quot;</td>
</tr>
<tr>
<td>minus</td>
<td>&quot;minus&quot;</td>
</tr>
<tr>
<td>THOUSAND</td>
<td>&quot;thousand&quot;</td>
</tr>
</tbody>
</table>

## Labels & Units

<table>
<thead>
<tr>
<th>File Name</th>
<th>Spoken Message</th>
</tr>
</thead>
<tbody>
<tr>
<td>AUTO</td>
<td>&quot;auto&quot;</td>
</tr>
<tr>
<td>DISABLE</td>
<td>&quot;disable&quot;</td>
</tr>
<tr>
<td>DISABLED</td>
<td>&quot;disabled&quot;</td>
</tr>
<tr>
<td>ENABLE</td>
<td>&quot;enable&quot;</td>
</tr>
<tr>
<td>ENABLED</td>
<td>&quot;enabled&quot;</td>
</tr>
<tr>
<td>FAILED</td>
<td>&quot;failed&quot;</td>
</tr>
<tr>
<td>FEET</td>
<td>&quot;feet&quot;</td>
</tr>
<tr>
<td>GPM</td>
<td>&quot;gpm&quot;</td>
</tr>
<tr>
<td>HAND</td>
<td>&quot;hand&quot;</td>
</tr>
<tr>
<td>HIGH</td>
<td>&quot;high&quot;</td>
</tr>
<tr>
<td>LOW</td>
<td>&quot;low&quot;</td>
</tr>
<tr>
<td>OFF</td>
<td>&quot;off&quot;</td>
</tr>
<tr>
<td>ON</td>
<td>&quot;on&quot;</td>
</tr>
<tr>
<td>OVERRIDE</td>
<td>&quot;override&quot;</td>
</tr>
<tr>
<td>RUNNING</td>
<td>&quot;running&quot;</td>
</tr>
<tr>
<td>STOPPED</td>
<td>&quot;stopped&quot;</td>
</tr>
<tr>
<td>UPDATED</td>
<td>&quot;updated&quot;</td>
</tr>
</tbody>
</table>
# Standard Recordings

<table>
<thead>
<tr>
<th>File Name</th>
<th>Spoken Message</th>
</tr>
</thead>
<tbody>
<tr>
<td>1moment</td>
<td>&quot;One moment, please&quot;</td>
</tr>
<tr>
<td>ack</td>
<td>&quot;Press one to acknowledge, press two to replay&quot;</td>
</tr>
<tr>
<td>ALARM</td>
<td>&quot;alarm&quot;</td>
</tr>
<tr>
<td>alarms</td>
<td>&quot;alarms&quot;</td>
</tr>
<tr>
<td>allalarms</td>
<td>&quot;All alarms have been acknowledged&quot;</td>
</tr>
<tr>
<td>badcode</td>
<td>&quot;That code is incorrect&quot;</td>
</tr>
<tr>
<td>BEEP</td>
<td>a beep sound</td>
</tr>
<tr>
<td>command</td>
<td>&quot;Enter a command and press star&quot;</td>
</tr>
<tr>
<td>entercode</td>
<td>&quot;Please enter your code&quot;</td>
</tr>
<tr>
<td>error</td>
<td>&quot;Error&quot;</td>
</tr>
<tr>
<td>goodbye</td>
<td>&quot;Thank you for using HT3. Good-bye.&quot;</td>
</tr>
<tr>
<td>havebeenackd</td>
<td>&quot;have been acknowledged&quot;</td>
</tr>
<tr>
<td>help</td>
<td>&quot;Press star for help&quot;</td>
</tr>
<tr>
<td>MODULE</td>
<td>&quot;module&quot;</td>
</tr>
<tr>
<td>newnumber</td>
<td>&quot;Enter the new station number and press pound&quot;</td>
</tr>
<tr>
<td>newvalue</td>
<td>&quot;Enter new value and press pound. Use star for decimal point.&quot;</td>
</tr>
<tr>
<td>OFFLINE</td>
<td>&quot;offline&quot;</td>
</tr>
<tr>
<td>or</td>
<td>&quot;or&quot;</td>
</tr>
<tr>
<td>orpound</td>
<td>&quot;or pound to cancel&quot;</td>
</tr>
<tr>
<td>plant</td>
<td>&quot;There is an alarm at the plant&quot;</td>
</tr>
<tr>
<td>POINT</td>
<td>&quot;point&quot;</td>
</tr>
<tr>
<td>press1</td>
<td>&quot;Press one for&quot;</td>
</tr>
<tr>
<td>snumber</td>
<td>&quot;Enter a station number and press pound&quot;</td>
</tr>
<tr>
<td>start</td>
<td>&quot;Welcome to HT3&quot;</td>
</tr>
<tr>
<td>STATION</td>
<td>&quot;station&quot;</td>
</tr>
<tr>
<td>stillmore</td>
<td>&quot;Not all alarms have been acknowledged&quot;</td>
</tr>
<tr>
<td>thankyou</td>
<td>&quot;All alarms have been acknowledged. Thank you for using HT3. Good-bye.&quot;</td>
</tr>
<tr>
<td>thereare</td>
<td>&quot;There are&quot;</td>
</tr>
<tr>
<td>unalarms</td>
<td>&quot;unacknowledged alarms&quot;</td>
</tr>
</tbody>
</table>
Suggested Recordings

The following are suggestions (file names and spoken message) that may be helpful in customizing your alarm announcements.

<table>
<thead>
<tr>
<th>File Name</th>
<th>Spoken Message</th>
</tr>
</thead>
<tbody>
<tr>
<td>acpower</td>
<td>&quot;AC power&quot;</td>
</tr>
<tr>
<td>CLOSED</td>
<td>&quot;closed&quot;</td>
</tr>
<tr>
<td>dcbias</td>
<td>&quot;DC bias&quot;</td>
</tr>
<tr>
<td>hsuacpower</td>
<td>&quot;Hyper SCADA Server AC power&quot;</td>
</tr>
<tr>
<td>hsubatteryvoltage</td>
<td>&quot;Hyper SCADA Server battery voltage&quot;</td>
</tr>
<tr>
<td>IDLE</td>
<td>&quot;idle&quot;</td>
</tr>
<tr>
<td>NEEDED</td>
<td>&quot;needed&quot;</td>
</tr>
<tr>
<td>OPEN</td>
<td>&quot;open&quot;</td>
</tr>
<tr>
<td>REQUIRED</td>
<td>&quot;required&quot;</td>
</tr>
<tr>
<td>RESET</td>
<td>&quot;reset&quot;</td>
</tr>
<tr>
<td>STARTED</td>
<td>&quot;started&quot;</td>
</tr>
</tbody>
</table>

Recording Alarm Announcements Overview

After configuring a point to locally announce and/or call out when an alarm occurs, you can create custom alarm announcement messages. Recording voice alarm messages is a simple procedure, but requires some planning before it's undertaken.

To record alarm announcements, you must be logged in to HT3 with an account that has Configure Voice permissions and all alarms must be acknowledged. Before you begin, verify that a microphone and speakers are connected to the computer.

The information needed before recording messages is a list of stations, point types (pumps, well levels, etc.), and alarm labels (on, off, failed, etc.) that you need recordings for.

We suggest you complete the recording process in the following order:

1. Record a message for each station.

2. Create a library of recordings that contains a message for each type of point in the system. It isn't necessary to record a message for each point. For example, for each station there may be a point that has been named HOA Switch 1. Make one recording that says "hoa switch one." The system will automatically play this recording for each point in the system named HOA Switch 1 provided the point names are exactly the same except for capitalization, punctuation, and spaces. For example, the recording hoeswitch1 will play for points named HOA Switch 1, HOA_Switch_1, and hoa switch 1, but not for hoa switch 1 or HOA SW 1.

3. Record one message for each unique label (enabled, disabled, closed, etc.)
When an alarm occurs at a point that has **Announce Locally** and/or **Phone/Email** enabled, the system scans the recordings database for the files necessary to create a complete message.

1. It first searches for `stn_x` (where x represents the station number. For example, stn_12 for station number 12). If `stn_x` doesn't exist, it searches for `stationname` (where stationname represents the name of the station, for example `mainstreet` for a station named Main Street). If neither recording exists, HT3 creates a message for the station using its [prepackaged recordings](#). In this case, it would play the recordings `STATION` and 12.

2. It next searches for `addr` (where addr represents the point's complete address - station number, module letter, and point number, for example, 12C5 for a point located at station 12, module C, point 5). If `addr` doesn't exist, it then searches for `pointname` (where pointname represents the point's name, for example, `hoaswitch1` for a point named HOA Switch 1). If neither recording exists, HT3 creates a message for the point address (module letter and point number) using its [prepackaged recordings](#). Using our example, the system would play `POINT`, `C`, and `5`.

**Note:** If the point is located under a Modbus module and neither `pointname` nor `addr` exists, HT3 creates a message for the point, but skips the module portion of the message. If the point in question is a virtual point and neither `pointname` nor `addr` exists, HT3 creates a message for the point, but skips the station portion of the message.

3. Last, it searches for `labelname` (where `labelname` represents the point's alarm label. For example, `DISABLED` for a point whose alarm label is Disabled). If `labelname` doesn't exist, the default `ALARM` ("alarm") is played.
Recording Station Messages

**Note:** The Voice Recording tool cannot be used if there are unacknowledged alarms. The system uses the same device to announce alarms as it does to record voice messages. Monitor the alarm light in the system tray. If the light is red and blinking, you will need to acknowledge the alarms before continuing. If you try to record a message when there are unacknowledged alarms, a network error message will be displayed in the status bar. If you receive this message, open Alarm Viewer and acknowledge the alarms. To reload the Voice Recording tool, click the Voice button.

1. Open the Voice Recording tool.

2. Expand the Configuration Editor tree and select the station for this recording.

3. The default file name for this recording is displayed in the Current Target box. For example, the Current Target box displays mainstreet when the station named Main Street is selected. System generated file names for station recordings are all lower case and have all punctuation and spaces removed. So "Main Street" becomes mainstreet and "LS #9" becomes ls9. (See File Naming Conventions for important information on file names.)

   ![Configuration Editor](image)

4. Click Record and begin speaking into the microphone. Notice that the Record button turns red and displays the text Stop.

5. When you have completed speaking your message, click Stop. The message "Not Saved" is displayed next to the Current Target box.

6. Click Play to listen to the recording. If you are not satisfied with the recording, repeat steps 4-6.

7. To trim the recording, use your mouse cursor to highlight the portion of the wave form you want to remove and click Trim. This is useful for removing unwanted silence at the beginning or end of the recording. Silence is represented by a straight line in the sound wave box. See Trimming Recordings for more information.

8. When you are satisfied with the recording, click Save. The file name of the recording is added to the All list.

9. Repeat steps 2-8 to record additional station messages.
Recording Point Messages

**Note:** The Voice Recording tool cannot be used if there are unacknowledged alarms. The system uses the same device to announce alarms as it does to record voice messages. Monitor the alarm light in the **system tray**. If the light is red and blinking, you will need to acknowledge the alarms before continuing. If you try to record a message when there are unacknowledged alarms, a network error message will be displayed in the **status bar**. If you receive this message, open **Alarm Viewer** and acknowledge the alarms. To reload the Voice Recording tool, click the **Voice** button.

Points without alarms may not need recordings. Recorded messages for these points will only be used if you ask for their status in 411 calls.

1. **Open the Voice Recording tool.**
2. Expand the Configuration Editor tree and select the point for this recording.
3. The default file name for this recording is displayed in the **Current Target** box. For example, the **Current Target** box displays `flowrate` when the point named Flow Rate is selected. System generated file names for point recordings are all lower case and have all punctuation and spaces removed. So "Flow Rate" becomes `flowrate` and "Power" becomes `power`. (See [File Naming Conventions](#) for important information on file names.)

![Voice Recording Tool](image)

4. Click **Record** and begin speaking into the microphone. Notice that the **Record** button turns red and displays the text **Stop**.
5. When you have completed speaking your message, click **Stop**. The message "Not Saved" is displayed next to the **Current Target** box.
6. Click **Play** to listen to the recording. If you are not satisfied with the recording, repeat steps 4-6.
7. To trim the recording, use your mouse cursor to highlight the portion of the wave form you want to remove and click **Trim**. This is useful for removing unwanted silence at the beginning or end of the recording. Silence is represented by a straight line in the sound wave box. See [Trimming Recordings](#) for more information.
8. When you are satisfied with the recording, click **Save**. The file name of the recording is added to the **All** list.

9. Repeat steps 2-8 to record additional station messages.

**Recording Label Messages**

**Note**: When announcing alarms for analog points, the system will only play the alarm messages LOW ("low") or HIGH ("high"). These files are packaged with the HT3 system. It is only necessary to record label messages for analog points if you ask for the status of analog points during 411 calls.

Only the alarm state label is used when the system announces alarms for a digital point. If no recording exists for the label, the system plays the default ALARM. It isn't necessary to create label recordings for a point's normal state or for points that are not configured with alarms. Only create these recordings if you will be asking for their status during 411 calls.

The Voice Recording tool cannot be used if there are unacknowledged alarms. The system uses the same device to announce alarms as it does to record voice messages. Monitor the alarm light in the **system tray**. If the light is red and blinking, you will need to acknowledge the alarms before continuing. If you try to record a message when there are unacknowledged alarms, a network error message will be displayed in the **status bar**. If you receive this message, open **Alarm Viewer** and acknowledge the alarms. To reload the Voice Recording tool, click the **Voice** button.

1. **Open the Voice Recording tool**.

2. Expand the Configuration Editor tree and double-click the name of the digital point you are creating a label recording for. Its **Low state** and **High state labels** are listed below it.

3. Select the label you want to create a recording for. The default file name for this recording is displayed in the **Current Target** box.

For example, the **Current Target** box displays RUNNING if the point's **High state label** (which, in this example, represents its alarm state) has been configured as "RUNNING." (See **File Naming Conventions** for important information on file names.)

4. Click **Record** and begin speaking into the microphone. Notice that the **Record** button turns red and displays the text **Stop**.
5. When you have completed speaking your message, click **Stop**. The message "Not Saved" is displayed next to the **Current Target** box.

6. Click **Play** to listen to the recording. If you are not satisfied with the recording, repeat steps 4-6.

7. To trim the recording, use your mouse cursor to highlight the portion of the wave form you want to remove and click **Trim**. This is useful for removing unwanted silence at the beginning or end of the recording. Silence is represented by a straight line in the sound wave box. See [Trimming Recordings](#) for more information.

8. When you are satisfied with the recording, click **Save**. The file name of the recording is added to the **All** list. If the recording's file name is the default and is all upper case, the recording will also be listed in the **Labels and Units** list.

9. Repeat steps 2-8 to record additional station messages.

### Upgrade Recordings to New Scheme

In HyperTAC II 2.2.0, we introduced a new naming scheme for the voice recordings. In previous versions of the software, file names for station and point recordings were identified by their address. For example, `stn_12` for a station at address 12 or `12A15` for a point located at station 12, module A, point 15. If point 12A15 represented an H-O-A Switch 1, you may have created a recording that said "HOA Switch 1," saved it with the file name of `12A15` and then linked that recording to every point in your system named H-O-A Switch 1.

The new scheme uses the user defined name of the station or point when creating the file name. Using the new scheme, if station 12 is named "Main Street," the file name for its recording will be `mainstreet`. If the name of point 12A15 is "H-O-A Switch 1," the file name of the recording will be `hoaswitch1`. When the system creates file names for stations and points, it removes all punctuation and spaces from the user defined named and converts all letters to lower case. For every point in the system named "H-O-A Switch 1," the system will play the recording with the matching file name of `hoaswitch1`. It is no longer necessary for you to link each point to the recording.

To help you quickly and easily change your recordings to the new naming scheme, we are providing an upgrade tool.

1. From the list of telemetry components in the left panel, select the station or point you want to upgrade. In the example below, we have selected point 2A2, which has a user defined name of "Pressure." Notice that the **Current Target** box shows the file name is `2A2`. 


2. Click the Upgrade button.

3. The file name in the Current Target box now shows the file name using the new scheme. In this example, the file name 2A2 is removed from the Current Target box and the Current Recordings list and is replaced with the file name pressure.

Additionally, all points that have the same point name now default to the new file name and all links are removed. You do not have to repeat this process for each point that was linked to the old-style recording.

Command Prompt Recordings

Each 411 command requires a recording. The commands pendingalarms and hangup, which are included in HT3, already have recordings (pendingalarms and hangup). You can re-record the messages for these commands, but you must not change the file names of the recordings. The system will be unable to locate and play the recordings if the file names are changed.
All custom commands that are created require that a prompt recording also be created. These recordings are played whenever a caller presses * for Help. Help plays each command’s prompt recording and provides the command’s access code.

For example, you create a **Status by Name** command with an access code of 5 (five) that retrieves the status of pumps. You must also create a recording with a spoken message that describes the command. The message could simply say "pump status." Then, when a caller requests help, the system tells them to "press 5 for pump status."

For simplicity's sake, it is recommended that the command's prompt and the recording's file name be the same. For example, *pump_status* for the command prompt and *pump_status* for the recording's file name.

For more information, see [Creating 411 Commands](#).

**Note:** The Voice Recording tool cannot be used if there are unacknowledged alarms. The system uses the same device to announce alarms as it does to record voice messages. Monitor the alarm light in the system tray. If the light is red and blinking, you will need to acknowledge the alarms before continuing. If you try to record a message when there are unacknowledged alarms, a network error message will be displayed in the status bar. If you receive this message, open Alarm Viewer and acknowledge the alarms. To reload the Voice Recording tool, click the *Voice* button.

1. **Open the Voice Recording tool.**

2. Expand the 411 Commands branch of the Configuration Editor tree and select the name of the command you are creating a prompt recording for. The default file name for this recording is displayed in the **Current Target** box.

   For example, the **Current Target** box displays *pump_status* if the command's prompt has been configured as "pump_status." (See [File Naming Conventions](#) for important information on file names.)

3. Click **Record** and begin speaking into the microphone. Notice that the **Record** button turns red and displays the text **Stop**.
4. When you have completed speaking your message, click **Stop**. The message "Not Saved" is displayed next to the **Current Target** box.

5. Click **Play** to listen to the recording. If you are not satisfied with the recording, repeat steps 3 and 4.

6. To trim the recording, use your mouse cursor to highlight the portion of the wave form you want to remove and click **Trim**. This is useful for removing unwanted silence at the beginning or end of the recording. Silence is represented by a straight line in the sound wave box. See **Trimming Recordings** for more information.

7. When you are satisfied with the recording, click **Save**. The file name of the recording is added to the **All** list.

---

**Re-recording Messages**

If there are recordings that you are not satisfied with, you can re-record the messages.

**IMPORTANT**: Do not change the file names of 911 alarm call out messages. The system will be unable to play the message if the file name has been changed. The recordings themselves can be changed, but the file name must remain the same.

1. Use one of the **Load Recordings** options (All, Numbers, Letters, Labels and Units, Standard Recordings, By Prefix) to populate the **Current Recordings** list. For example, type "lag" in the **By Prefix** box and click **Load** to see a list of all recordings that start with "lag."

2. Select the file to be re-recorded. Verify that the **Current Target** box contains the file name of the recording you want to change.

3. Click **Record** and begin speaking into the microphone. Notice that the **Record** button turns red and displays the text **Stop**.

4. When you have completed speaking your message, click **Stop**. The message "Not Saved" is displayed next to the **Current Target** box.

5. Click **Play** to listen to the recording. If you are not satisfied with the recording, repeat steps 3 and 4.

6. To trim the recording, use your mouse cursor to highlight the portion of the wave form you want to remove and click **Trim**. This is useful for removing unwanted silence at the beginning or end of the recording. Silence is represented by a straight line in the sound wave box. See **Trimming Recordings** for more information.

7. When you are satisfied with the recording, click **Save**. The file name of the recording is added to the **All** list.

8. Repeat the above steps to re-record additional 911 call out messages.

---

**Trimming Recordings**

HT3’s voice tool has a command that enables you to trim the beginning and end of a recording. This can be used to remove unwanted silence or excess noise at the beginning or end of a recording. Trimming allows for smoother transitions from one message to another when alarms or commands are played, which gives a more natural sound.
Recordings can be trimmed as you create them or at a later time.

1. Select the recording you want to trim and click **Play**. The recording's wave form is displayed. A straight line represents silence that can be trimmed.

2. With your mouse cursor, highlight the portion of the recording that you want to trim. Alternately, you can highlight the middle of the wave form (the portion you want to keep).

3. Click **Trim** or press Backspace on your keyboard to remove the highlighted portion from the recording. If you highlighted the middle of the wave form in step 2, you'll be prompted with "Delete both ends instead of the selection?." Click **Yes** to accept.

4. Repeat the process if you need to trim the other end of the recording.

5. Click **Save** to save your changes.

---

**Remove Files from the Recordings Database**

HT3 provides you with the ability to remove unwanted recordings from your recordings database, but it is important that you not remove any of the default recordings that come prepackaged with HT3.
For example, if you removed the file *entercode* ("Please enter your code") and the system called out to announce an alarm, you would never be asked for your code and would be unable to acknowledge the alarm. Or, if you removed the default recordings *STATION*, *MODULE*, and *POINT* and an alarm occurred at a point that didn't have custom recordings, the system would be unable to announce the alarm.

1. **Open the Voice Recording tool.**

2. Use one of the **Load Recordings** options (All, Numbers, Letters, Labels and Units, Standard Recordings, By Prefix) to populate the **Current Recordings** list. For example, type "line" in the By Prefix box and click Load to see a list of all recordings that start with "line."

3. In the **Current Recordings** list, select the file to be removed. The file name is displayed in the **Current Target** box.

4. Click **Delete**. The Remove? dialog box opens.

5. Verify that the correct file name is displayed in the Remove? dialog box and click **Yes**. The file is removed from the **Current Recordings** list.

### Renaming Voice Recordings

Renaming enables you to correct the name of a voice recording file. This is useful if the recording speaks the right words, but has the wrong file name. This could happen when linking voice recordings if you type the point’s address incorrectly in the **Current Target** box. By renaming the file, you don’t have to re-record the file; you simply give it the correct name.

1. **Open the Voice Recording tool.**
2. Use the All or By Prefix option to populate the Current Recordings list. For example, type "3" in the By Prefix box and click Load to see a list of all recordings that start with the number three.

3. From the Current Recordings list, select the recording you want to rename. The recording’s file name is displayed in the Current Target box.

4. In the Current Target box, type the new name for the recording and click Rename. In our example, we type 2C2.

5. The Current Recordings list is updated to show the recording's new name.
Linking Voice Recordings

Linking enables you to create a single recording and then link it to multiple telemetry points.

1. **Open the Voice Recording tool.**

2. Use the **All** or **By Prefix** option to populate the **Current Recordings** list. For example, type 3 in the **By Prefix** box and click **Load** to see a list of all recordings that start with the number three.

3. From the **Current Recordings** list, select the recording you are linking to. The recording’s file name is displayed in the **Current Target** box.

4. From the Configuration Editor tree, locate the target (the telemetry component you are linking the recording to) but do not select it.

5. In the **Current Target** box, type the point’s address. In our example, we type 2A3 to link the recording 3C2 to a point with the address 2A3.

6. Click **Make Link**. The **Make Link?** dialog box opens.
7. In the **Make Link?** dialog box, verify that the target and source are correct, and then click **Yes**. The target's address (in our example, 2A3) is added to the **Current Recordings** list.

---

**File Naming Conventions**

Keep the following file naming conventions in mind when creating voice recordings:

- There may be times when it is necessary to use link recordings to points because of the way file names are created by the system. If you had a point named Pump 1 (23) and another named Pump 12 (3), the system generated file name for each point's recording would be the same - *pump123* - even though the points are unrelated. In this case, it would be useful to create unique file names for each point's recording and then link the recording to its corresponding point.

- File names for stations must be of the format *stationname* (all lower case, punctuation and spaces removed) unless you are using the linking method. When you select a station to create a recording for, the file name is automatically converted to this format. The system makes all letters lowercase and removes all punctuation and spaces from the user defined name of the station. A recording for a station named Lift Station #5 would have a file name of *liftstation5*.

- File names for points must be of the format *pointname* (all lower case, punctuation and spaces removed) unless you are using the linking method. When you select a point to create a recording for, the file name is automatically converted to this format. The system makes all letters lowercase and removes all punctuation and spaces from the user defined name of the point. A recording for a point named HOA Switch #1 would have a file name of *hoaswitch1*.

- File names for specific point addresses, including virtual, external, and Modbus points, must match the point's user-defined name exactly, including case - uppercase or lowercase. Normally, point addresses are forced to be all uppercase, so the corresponding voice file name must also be all uppercase, such as *V_AUTO*.

- For each label that will be announced via an alarm or 411, there must be a corresponding recording. The file name must be spelled exactly like the label except for spaces and punctuation. For example, the labels "alarm_state" and "alarm state," would both play the recording *ALARMSTATE*. 
• Case is also important when create recordings for labels. The default format for label recordings is all uppercase. A recording that is all caps will match any label regardless of case as long as the spelling (except for spaces and punctuation) is the same. If the label is all uppercase, the file name for the recording must be all uppercase (label: ON; recording ON). If the label is spelled On (initial cap), the file name for the recording may be On or ON. If the label is spelled on (all lowercase), the file name for the recording may be on or ON.

• If there is no recording for a label, the default message ALARM will be played instead.

• Names for label recordings must be all uppercase in order for them to be displayed in the Labels and Units list in addition to being in the All list. When you select a label to create a recording for, the system automatically creates a file name with this format for you.

• Do not change the file names of call out messages. The system will be unable to play the message if the file name has been changed. The spoken messages themselves can be changed, but the file name must remain the same.

• File names for 411 command recordings must be spelled exactly like the Prompt in the corresponding 411 command and should be all lower case.
Cameras

When integrating network cameras into your telemetry system, you can access the camera directly or add the DVR option, which will archive video snapshots for up to 30 days.

In addition to offering access to historical data, the DVR option optimizes the performance of cameras that are transmitting over VDR radio links.

Refer to:

- Standard Camera Monitoring for information on using the standard method of monitoring video in real time.
- DVR Option for information on monitoring real-time video images while also archiving video snapshots.

Switching Existing Camera to DVR Option (Recommended)

We suggest that any existing cameras on your system be configured to use the DVR option to benefit from the improved radio traffic performance. If the cameras are also used in custom screens, you must edit the URL to image path in the standard camera configuration tool (see DVR Option: Editing Configuration of a Camera Used in a Custom Screen).

Standard Camera Monitoring

Note: The instructions provided here are for cameras that are not using the DVR option. The DVR option allows you to view images that are updated in real time and will archive video snapshots for up to 30 days.

The instructions provided here will allow you to:

- Directly access the camera and view live video through HT3's Camera Viewer (see Viewing Status: Camera Viewer for more information on viewing video feed).
- View snapshots by linking a static image in a custom screen to the camera's URL (see Screen Builder for more information).

Note that the same camera can be configured more than once if you want to have different resolutions displayed in Camera Viewer and custom screens. For example, you could configure a camera with a resolution of 640x480 for viewing video in Camera Viewer, and configure the same camera again but with a different name and resolution (e.g., 320x240). This second configuration could be used to view snapshots in a custom screen.

If you are unable to view your camera's images from HT3 after following the instructions provided here, first check that the camera is operational. This can be done by browsing to the camera's home page (enter the IP address of the camera preceded by http:// in your web browser's address bar, for example, http://207.243.62.22).
If you are able to view video from the camera's home page, you may need a different URL argument. For assistance with this, contact DFS:

- visit DFS' Help Desk
- send email to service@dataflowsys.com
- call 321-259-5009 and ask for the Service Department

Adding Camera Information to HT3

1. Click **Configure** on the HT3 main menu.

2. Click **Cameras** on the Configure submenu. The camera configuration form opens. The screen shot below shows the configuration for a Canon model camera with a resolution of 520x470 pixels. The drop-down list at the top of the form is provides the names of all existing configured cameras.

3. Select **New** from the camera name drop-down list.

4. Enter a name for this camera configuration in the **Name** box. Names can be a maximum of 20 characters. Valid characters are the letters Aa-Zz, 0-9, - (hyphen), _ (underscore).

5. Enter a width and height (in pixels) for the video display. This setting only affects how video is displayed in Camera Viewer; it does not affect snapshot images in custom screens.

6. Enter the camera's URL in the **URL to camera** box. Check the documentation for your camera for the proper URL statement. (Note that the http:// is optional.)

   Example: http://192.168.1.8/top/liveapplet.html

7. Enter the camera's **URL to image** argument (used for placing static camera images in custom screens). Check the documentation for your camera for the proper URL statement including image size. (Note that the http:// is optional.)

   Example: 207.243.62.22/cgi-bin/image320x240.jpg for a snapshot resolution of 320x240 pixels.

8. Click **Save**. The status bar displays the message "Save was successful." and the camera is added to Camera Viewer's list of available cameras.
DVR Option

The DVR option does not provide a live video feed. It provides a series of standard-definition snapshots that are updated in real time and archived for up to 30 days.

Any camera used with the DVR option must provide browser access to still images. (See Requirements for Using the DVR Option)

Contact the DFS Sales or Service Department if you have questions or need assistance.

Requirements for Using the DVR Option

<table>
<thead>
<tr>
<th>HT3 version</th>
<th>The DVR option requires HT3 3.1.5 or later.</th>
</tr>
</thead>
<tbody>
<tr>
<td>HT3 registry entry</td>
<td>Enabling the DVR option requires an entry in the HT3 registry. This step is performed by DFS personnel.</td>
</tr>
<tr>
<td>Camera requirements</td>
<td>The DVR option should work with any network camera that provides browser access to still images. (Camera manufacturers refer to this function differently as discussed in Before You Begin - Obtain Path to Still Image.)</td>
</tr>
<tr>
<td></td>
<td>If you need assistance selecting a camera, contact DFS' Sales Department or Service Department.</td>
</tr>
<tr>
<td>Network hardware</td>
<td>Additional network hardware may be required.</td>
</tr>
</tbody>
</table>

About the Image Archive

The snapshots are archived in a special folder (cache) on the Hyper SCADA Server. Images are cleared from the cache after 30 days. Images older than 30 days can typically be retrieved from the camera. Check your camera’s documentation.

Each camera has a unique cache folder on the Hyper SCADA Server.

The folder name is the name configured for the camera in DVR Viewer:

/ht3/dvr/cache/<camera name>

For example:

/ht3/dvr/cache/FrontGate

Note: Cached images can only be viewed in the DVR Viewer or on custom screens. You cannot browse to the cached images directly.
Interval Between Snapshots

Snapshots are typically taken in 1-15 second intervals. The interval is affected by network traffic and the quality of the communications link between the camera and HT3.

To optimize image retrieval, HT3 does not use a fixed refresh rate. Instead, HT3 requests the next image as soon as it receives the previous one. This minimizes radio traffic by preventing HT3 from sending multiple requests to the camera before receiving a response.

- An interval of less than 2 seconds is typical in a LAN environment where the camera and HT3 are communicating over an Ethernet connection.
- In a high-speed radio environment, the interval is contingent on the integrity of the radio link and the amount of network traffic.

Viewing Camera Images

Images can be viewed in the DVR Viewer or in custom screens.

DVR Viewer

The DVR Viewer provides:

- Current image that is updated in real time
- Up to 30 days of historical data

Custom Screens

HT3 uses cached images in custom screens. This eliminates the bottlenecks that occur when multiple users are accessing the camera simultaneously.

Camera images in custom screens are refreshed at the rate configured in Screen Builder (see Adding Network Camera Images to Screens in the Screen Builder help).

Only the most recent image can be viewed in custom screens. There is no option for viewing historical images.

Adding and Configuring a Camera for DVR Operation

You need the following information:

- User-defined name for the camera (up to 64 characters; no spaces or special characters)
Configuring Your System

- IP address of the camera
- Path to still image (see Before You Begin – Obtain Path to Still Image)
- Password (optional – some cameras require a user name and password in order to access their image directory)

Configuring the Same Camera with Different Resolutions

A camera can be configured more than once if you want a different resolution displayed in DVR Viewer than the resolution displayed in custom screens.

The resolution parameters are included in the still image path (as discussed in Before You Begin - Obtain Path to Still Image).

Each configuration requires a unique camera name.

For example, configure a camera with a resolution of 640x480 for viewing in DVR Viewer. Configure the same camera with a different name and a lower resolution (e.g., 320x240) for viewing in custom screens.

Before You Begin – Obtain Path to Still Image

HT3 needs the path for getting a still JPEG image from the camera. You can find this information in the documentation that came with your camera.

Each camera manufacturer refers to this differently.

- Axis cameras may refer to this as “Alternative methods of accessing the video stream: Still JPEG images in a browser.”

- Canon may refer to it as “Displaying the Live Video at Access as a Still Picture.”

You only need the portion that comes after the IP address. The path must be prefixed with a forward slash.

You can also include arguments for such things as image resolution, compression, and date and time display. This information can be found in your camera’s documentation. (See also Configuring the Same Camera with Different Resolutions)

Axis camera example:

```
/axis-cgi/jpg/image.cgi?resolution=320x240&compression=50&date=1&clock=1
```

Canon camera example:

```
/-wvhttp-01-/GetStillImage
```

Need help? If you are unable to find the still image path, contact DFS’ Service Department for assistance.
Configuring (or Editing) for Display in DVR Viewer

Configuration is done through the DVR Viewer.

1. Click **View** on the HT3 main menu.

2. Click **DVR** to open the DVR Viewer. (If this menu item isn’t visible, contact DFS’ Service Department.)

3. Click **Add Camera** if this is the first camera to be configured. Otherwise, click **Configure Cameras** (link is below the plus and minus buttons), and then click either **Add Camera** or the Edit button next to the camera you want to edit.

4. Enter or edit values for the following:

   - **Name** – User-defined name for this camera. Maximum of 64 characters. Letters and numbers only; no spaces or special characters, such as # % & { } ; : < > ? / +
   
   - **IP Address** – IP address assigned to this camera by your network administrator.
   
   - **URL Query String** – Path provided by the camera manufacturer for viewing still images from the camera. Must be prefixed with a forward slash. See Before You Begin – Obtain Path to Still Image.
   
   - **Password (Optional)** – If the camera requires a password for viewing still images, enter a Y in the **Password** box, and enter the username and password your network administrator assigned to the camera.

5. Click **Save**. The camera’s images can now be viewed in the DVR Viewer or be added to a custom screen.

Configuring for Display in Custom Screens

This configuration is done in the standard camera configuration tool (not the DVR Viewer). You must provide a name and the path to the camera’s cache folder.

1. Click **Configure** on the HT3 main menu.

2. Click **Camera**.

3. Verify that New is selected in the camera list.

4. Enter a name for the camera. To avoid confusion, enter the same name that you assigned this camera when you added it to DVR Viewer.

5. Enter the path to the camera’s cache folder in the **URL to image** box.

   The path includes:
• IP address of your Hyper SCADA Server

• Name of the camera (the one given to it in the DVR Viewer configuration).

The path takes the format:

   http://<ip address of Hyper SCADA Server>/ht3/dvr/cache/<camera name>/image.jpg

The only variables you change in the path statement above are the IP address and the camera name.

For example:

   http://192.168.10.24/ht3/dvr/cache/FrontGate/image.jpg

6. Click Save. The camera's images can now be added to a custom screen. See Adding Network Camera Images to Screens in the Screen Builder help.

Editing the Configuration of a Camera Used in a Custom Screen

This configuration is done in the standard camera configuration tool (not the DVR Viewer).

1. Click Configure on the HT3 main menu.

2. Click Camera.

3. Select the camera’s name from the list.

4. Make the desired changes (see Configuring for Display in Custom Screens) and click Save.

Viewing Images in the DVR Viewer

The DVR Viewer provides options for viewing:

• Most recent image (Current), which is updated as new images are received and cached.

• Archived images (History), with tools for playing, pausing, stopping, rewinding, and fast-forwarding.

The current view is shown by default.

1. Click View on the HT3 main menu.

2. Click DVR to open the DVR Viewer. (If this menu item isn’t available, contact DFS’ Service Department.)

3. Select a camera from the list. The DVR Viewer shows the most recent image saved in the cache.

   The DVR Viewer is updated in real time as the camera responds to queries from HT3. (Note that the interval between updates is affected by network traffic and the quality of the communications link between the camera and HT3.)

   Each image is date and time stamped.

4. Use the plus and minus buttons to make the image larger or smaller.
Viewing History

HT3 stores up to 30 days of archived images.

1. With the DVR Viewer open, click History.

2. Select a date on the calendar to view a 24-hour loop of the images captured that day.
   Each image is date and time stamped (top right corner of the image).
   Timers below the image show when during the 24-hour period the first image was taken, the current image was taken, and the last image was taken.

3. Use the control buttons to play, pause, stop, rewind, fast-forward, go to the beginning, or go to the end.

4. Use the slider controls to advance through the images or go to a specific time.
   You can also use the slider controls to focus on a specific segment of the 24-hour period. Define a time span using the beginning and ending slider controls and then click the Play button.

5. Use the plus and minus buttons to make the image larger or smaller.
Troubleshooting

If you are unable to view your camera's images from HT3 after following the instructions provided here, first check that the camera is operational. This can be done by browsing to the camera's home page (enter the IP address of the camera preceded by http:// in your web browser's address bar, for example, http://207.243.62.22).

If you are able to view video from the camera's home page, you may need a different URL argument. For assistance with this, contact DFS:

- visit DFS' Help Desk
- send email to service@dataflowsys.com
- call 321-259-5009 and ask for the Service Department
Setting System Date and Time

Changing Your System's Time Zone

All Hyper SCADA Servers leave the factory set to the Eastern time zone. Use these instructions to set your system's time zone if the Hyper SCADA Server is being installed in the Central, Mountain or Pacific time zones.

**IMPORTANT**: You must be logged in as **MGR** to make any changes to your system's time zone, time, or date settings.

1. Click **Configure** on the HT3 main menu.
2. Click **System** on the Configure submenu.
3. Expand the SYSTEM and TIME_AND_DATE branches and select TIME_ZONE.
4. Enter the desired time zone (Eastern, Central, Mountain or Pacific) and click Submit. (**IMPORTANT**: This setting is case sensitive; the selected time zone must be typed with the first letter capitalized and the rest of the word lower case."

![](image)

Changing Your System's Time and Date

Use these instructions to change your system's date and time if your system is set up to use the "manual" time sync method. See Registry Editor for more information on setting the time sync method.

**IMPORTANT**: You must be logged in as **MGR** to make any changes to your system's time zone, time, or date settings.

1. Click **Configure** on the HT3 main menu.
2. Click **System** on the Configure submenu.
3. Verify that the TIME_SYNC_METHOD is set to manual by expanding the SYSTEM and TIME_AND_DATE branches.
4. Click the **Set Time and Date** link (can be found below the HT3 Properties tree) to open the **Set Server Time & Date** form.

5. Enter the correct time and date using the format shown on the form: **HH:MM** for time; **MM/DD/YYYY** for date. Click **Submit**.

6. To verify the changes, navigate to the **System Stats** screen (or a custom screen that displays the time). Because time is updated at the top of each minute, it may take up to 2 minutes before any changes are displayed.
Critical Data Redundancy

- **Configuring Remote Backup Site** - HT3 features an automated backup routine that protects your system from critical data loss. Data is copied and stored locally in a designated backup folder on the Hyper Server Module (HSM). For additional protection, a Windows workstation can be configured as a backup site. A remote backup site protects you from loss of data in the event of an HSM hardware failure (the HSM itself stops functioning).

- **Configuring a Redundant System (HSS002-2)** - A redundant system uses an HSS002-2, which is a Hyper SCADA Server (HSS) with two Hyper Server Modules (HSMs). The goal of redundancy is to allow the two HSMs to operate as one. One HSM acts as primary and runs HT3 and the MySQL database server. The other HSM runs in secondary mode and monitors the primary HSM.

- **Configuring Purge Schedules** - This utility enables you to define a purge schedule for HT3’s logs and journals. After the configured number of days has passed, the data is moved from the active databases to an archive location on the server.

Configuring Remote Backup Site

HT3 features an automated backup routine that protects your system from critical data loss. Data is copied and stored locally in a designated backup folder on the Hyper Server Module (HSM).

As an additional protection against data loss, a Windows workstation can be configured as a remote backup location. A remote backup site protects you from loss of data in the event of an HSM hardware failure (the HSM itself stops functioning). The designated backup workstation should be equipped with a hard drive large enough to hold all of the system’s backup data and must be configured as a remote backup location. (We recommend that the remote Windows backup machine have at least 5 gigabytes of free disk space.)

Backup is performed daily at a few minutes after midnight. The system first makes a local copy of the data (stored on the Hyper Server Module). It then attempts to locate the remote backup computer.

For remote backup to occur, the designated Windows workstation must be on and running. It is recommended that all power management be disabled (i.e., the network card is not allowed to sleep).

If HT3 does not find the remote location, it skips the creation of a remote copy. It will not attempt another remote backup until the following midnight. An entry is made in the current day’s Access Log to indicate if the previous day’s backup succeeded or failed (see Advanced Reporting Tool for information on generating an Access Log report).

When the system performs a backup, all of the configuration databases, and the logs and journals for the previous day are backed up. The configuration databases are kept for one week in directories named for each day of the week. That is, Monday’s data is placed in a backup directory named Mon. Logs and journals are backed up daily and kept until the hard drive reaches full capacity. Data is archived and condensed based on the Purge settings. When the amount of hard drive space used approaches 100 percent, HT3 deletes the oldest logs and journals.

If you need to retain older data (configurations, logs, journals), copy it to external media (for example, a folder on the backup Windows workstation or a flash drive) prior to it being deleted.

**Restoring Data** - In the event you need to restore data, contact DFS.
Procedure for Configuring Backup Site

1. If the backup directory is to be on a Windows NT/2000, or Windows XP or newer machine, it is recommended that a new user account be created on the machine.

2. Create a backup folder, or directory, on the Windows workstation that has been designated as the remote backup.

3. Share the backup folder. (Refer to your Windows Help for information on sharing folders.)
   - **Windows 98 / ME:**
     A. Select **Full** for **Access Type**.
     B. Enter **HSS** for the **Shared as** name.
     C. Enter a password in the **Full Access Password** box.
   - **Windows 2000 / NT, or Windows XP or newer**
     A. Change the share name of the folder to **HSS**.
     B. Set all shared folder permissions to **Full Control**.
     C. Give the user account created in step one, above, **Full access** to the shared folder.

4. Login to HT3 and open the System Backup tool by clicking **Configure** on the HT3 main menu and then clicking **Backup** on the Configure submenu.

5. Configure the following:
   - **Enable Remote Backup** - Select this option to turn on automated backup.
• Remote Machine Name - Enter the IP address of the Windows workstation that has been
designated the remote backup location.

• Remote Share Name - Enter the share name of the backup folder. This should be HSS.

• Remote User Name - Enter the name of the user account created in step 1, above (Windows
2000/NT or Windows XP or newer machines only).

• Remote Share Password
  - Windows 98/ME: Enter the Full Access Password assigned to the shared backup folder.
  - Windows 2000/NT or Windows XP or newer: Enter the password of the user account
    created in step one, above.

6. Verify that all of the above information is correct and click Ok.

Configuring a Redundant System

Principals of Redundancy

A redundant system uses an HSS002-2, which is a Hyper SCADA Server (HSS) with two Hyper Server
Modules (HSMs) installed. The goal of redundancy is to allow the two HSMs to operate as one. One
HSM acts as primary and runs HT3 and the MySQL database server. The other HSM runs in secondary
mode and monitors the primary HSM. The primary HSM always uses a shared IP address as well as a
dedicated IP address.

If the secondary HSM senses a loss of telemetry from the primary HSM, the secondary HSM reboots the
primary, assumes the shared IP address, and begins to run the HT3 and MySQL servers.

The roles of primary and secondary are not dependent upon the HSM's configured IP address or the
backplane in which the HSM is installed. Either can operate as the primary or secondary server.

You can determine the current role of an HSM (primary or secondary) by viewing the flashing pattern of
the HSM's ACT LED.

• Single Flash - A single flash indicates that the HSM is the primary server.

• Double Flash - A double flash indicates that the HSM is the secondary server.

Primary Server

The HSM acting as the primary server runs normal HT3 software, including infoserver, all drivers, web
server, MySQL server, and replication server.

The replication server is new in redundancy. Its function is to replicate (backup, copy) two hard drives
over a network. In the Hyper SCADA Server, the replication server is responsible for backing up all
configuration data to the secondary server. The replication process takes place every two minutes, and
keeps the secondary up to date in case a switch over is required.
The primary also performs normal routines including backups to the remote windows machine and system purges. A single-flashing ACT LED on the HSM indicates that it is the acting primary server.

**Secondary Server**

The HSM acting as the secondary server runs the redundancy program only. Its sole purpose is to accept replication files from the primary, continuously check for proper network connectivity to the primary, and check for network responses from infoserver on the primary. A double-flashing ACT LED on the HSM indicates that it is the acting secondary server.

**IP Sharing**

Redundancy uses a function called IP sharing that allows two or more network devices to communicate at one shared IP while retaining their own unique address. In the HSS002-2 application, the primary HSM "masquerades" as the shared IP address. Additionally, client computers are configured to communicate with the primary HSM using the shared IP (not the configured address). (**Note:** Both HSMs can be accessed via their configured IP. The acting primary HSM can be accessed using either its configured IP or the shared IP. This may be useful during troubleshooting or when doing system maintenance.)

IP sharing makes redundancy virtually transparent to devices on the network, because they communicate with the primary HSM at the shared IP address not its configured address. When the primary and secondary HSMs switch roles, the new primary begins masquerading as the shared IP; there is no need to reconfigure clients to communicate with the new primary HSM.

Implementing redundancy requires that you have three (3) unused IP addresses on the same class C network: one for each HSM and one designated as the shared IP.

All clients should access the server using the shared IP address - not the configured IP address for either HSM. Clients should set up their hosts file to associate HT3 with the shared IP address.

**Safe IP Address**

A Safe IP Address is one that is on the same network as the HSS and is always "up." The secondary HSM uses this IP to determine if it should take over as primary after not getting a response from the acting primary. When it pings the Safe IP, it is trying to determine where the communication problem originated: with the primary HSM or with itself.

If a gateway is configured on the HSMs, it will be the Safe IP address by default. Examples of other Safe IPs are the addresses of routers, print servers, and voice-over-DSL devices. A workstation computer, although valid, is not the best selection since it can be easily turned off. A workstation computer can be used if no other devices are available, but it is important that it remain on at all times.

**Switch Over Process**

In a redundant system, the secondary HSM "pings" the primary HSM approximately every ten seconds. If the secondary does not get a response from the primary for a period of 120 seconds, it attempts to contact the designated Safe IP. If there is no response from the Safe IP, the secondary uses the hardware sledgehammer function to reboot the primary.
While the primary is rebooting, the secondary will switch to primary mode, start all servers, and begin to masquerade the shared IP address. As the original primary reboots, it notices the partner HSM running as primary and enters secondary mode.

Alternatively, if the secondary HSM does not get a response from the Safe IP, the problem may be with the secondary HSM itself. In this case, no switch over takes place, the timers are reset, and the secondary begins pinging the primary again. The secondary will not take over the primary role if it can't reach the Safe IP address.

**Takeover Alarm**

HT3 includes an external point named X_TAKEOVER (HSS Redundancy). When the secondary server shuts down the primary to initiate a switch over, it starts by setting the X_TAKEOVER point (HSS Redundancy) to its high (alarm) state (TAKEOVER).

**Configuration Options Overview**

**IMPORTANT:** The information presented below is for informational purposes only. Redundancy should only be implemented by qualified DFS Service personnel. Contact Data Flow Systems for more information.
### Redundancy Mode

<table>
<thead>
<tr>
<th>Redundancy Mode</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Redundant</strong></td>
<td>This mode enables all redundancy functions and requires a second HSM in order to operate properly.</td>
</tr>
<tr>
<td><strong>Stand_Alive</strong></td>
<td>This mode is used to run a single HT3 server. This is the default mode for single HSM installations. No redundant software will run.</td>
</tr>
<tr>
<td><strong>Idle</strong></td>
<td>This mode does not run any HT3 related software, including drivers, voice, infoserver, and redundancy programs. This mode is used when performing maintenance. If you need to change the IP addresses of the HSMs or replace an HSM, it is important that you first place the system in IDLE mode.</td>
</tr>
</tbody>
</table>

### Partner IP

This is the IP address of the "other" HSM. In a redundant configuration, two HSM's operate as partners. In order for the HSMs to automatically switch roles (primary to secondary or vice versa), each HSM must know the IP address of its partner.

### Shared IP

The Shared IP address is an address that is used by the acting primary HSM. The primary HSM can be accessed by its configured IP address or the Shared IP address. When HSMs switch operating modes (primary to secondary or vice versa), the HSM becoming primary will operate as the shared address. This allows the servers to act like one and allows the clients to contact the servers by using one IP address rather than the individual IP addresses. The shared IP address must be a free/unused IP address on the same network. See Principles of Redundancy: IP Sharing, above.

### Safe IP

This is a configured IP address on the network that is always "up." The Safe IP address is an extremely important part of redundancy. This address will be routinely pinged by the secondary server when it performs network communication testing. If the Safe IP address cannot be contacted, redundancy will not work properly. If a gateway is configured on the HSMs, it will be the Safe IP address by default; the system will ignore the address entered in the Safe IP field. See Principals of Redundancy: Safe IP Address, above.
Configuring Purge Schedules

When the system performs a backup, all of the configuration databases, and the logs and journals for the previous day are backed up. The configuration databases are kept for one week in directories named for each day of the week (e.g., Monday's data is placed in a backup directory named Mon).

Logs and journals are backed up daily. Data is archived and condensed based on the purge settings; after the configured number of days has passed, the data is moved from the active databases to an archive location on the server.

 Archived data can be restored at any time and is only deleted when the Hyper Server Module's hard drive is full. When hard disk space usage approaches 100 percent, the oldest logs and journals are deleted to make room for new data.

If you need to retain older data (configurations, logs, journals), copy it to external media (for example, a folder on the backup Windows workstation or a CD) prior to it being deleted.

In the event you need to restore data, contact DFS.

It is important to note that the default purge settings are optimal. Setting the purge times too high can adversely affect the performance of the server and the clients. We advise keeping the settings at their default values unless absolutely necessary. If you find that the purge values are too short, contact DFS' Service Department before making any changes.
Update Polling

After changes have been made to telemetry, you must execute "Update Polling." This operation transmits updated information from the Hyper SCADA Server to the telemetry hardware.

If Update Polling isn't performed, telemetry changes will not become active until the system is restarted.

Update Polling may be performed after all changes have been made. It isn't necessary to perform it after each change.

1. On the Configuration Editor tree, right click the name of the driver you made changes to and click **Update Polling** on the pop-up menu.

2. The status bar displays the message "Drivers have been updated."
Part V
5 Using Status, Reporting and System Tools

- **Using Status Viewers**
  - System Statistics
  - Custom Screen Viewer
  - Station Status
  - Alarm Viewer
  - Camera Viewer

- Analyzing Data with Trends

- Creating and Viewing Reports

- Using System Tools
  - Telemetry Traffic Tool
  - System Control Center
  - File Upload Utility
  - File Download (and Delete) Utility
  - Module Patching Utility
Using Status Viewers

HT3 provides you with several tools for examining - and from certain viewers, controlling - the status of your telemetry equipment. All of these viewers are accessed by clicking View link on the HT3 main menu and then selecting the corresponding submenu item.

Brief descriptions for HT3's viewing tools are provided below. Click a viewer's name for more information on its use.

**System Stats Viewer**
This screen (built with Screen Builder) displays information on the current status of important system-level points, including driver loop time, Hyper SCADA Server (HSS) AC power and battery voltage, active Hyper Server Module (HSM) CPU usage, and length of time primary HSM has been running since its last reboot.

1. Click View on the HT3 main menu.
2. Click Stats on the View submenu.

**Custom Screen Viewer**
This viewer displays the custom screens (graphical representations of telemetry) that you create using HT3's Screen Builder application. When you click the Custom Screens button, your base, or initial, screen is loaded. If you have not created a base custom screen, the default HT3 base screen (an example of a custom screen) is loaded.

1. Click View on the HT3 main menu.
2. Click Screens on the View submenu.

**Station Status Viewer**
The station status viewer provides a tabular listing of all configured stations. Clicking a station's address or name loads a page that displays all modules and points configured for that station and their current status.

1. Click View on the HT3 main menu.
2. Click Stations on the View submenu.

**Alarm Viewer**
With Alarm Viewer, you can view and/or acknowledge alarm activity. The alarm list can be sorted by several different variables, including time, address, and description, and is color coded to enable you to quickly identify an alarm's status.

1. Click View on the HT3 main menu.
2. Click Alarms on the View submenu.

**Camera Viewer**
HT3 provides you with the ability to install an unlimited number of surveillance cameras on your network and view their video feed. These cameras can be used to visually monitor important equipment or entrances to your plant.

1. Click View on the HT3 main menu.
2. Click Cameras on the View submenu.

**System Statistics**

This screen (which comes with your system and is built with Screen Builder) displays information on the current status of important system-level points, including driver loop time, Hyper SCADA Server (HSS) AC power and battery voltage, active Hyper Server Module (HSM) CPU usage, and length of time active HSM has been running since its last reboot.

The points used in this screen are built-in **external status points** that monitor the health of your system.

**To open the System Stats Viewer:**

1. Click View on the HT3 main menu.
2. Click Stats on the View submenu.

**Note:** The descriptions below refer to the "active Hyper Server Module." For a redundant system (one with dual Hyper Server Modules), the active Hyper Server Module (HSM) is the one currently acting as the primary; for a non-redundant system, the active Hyper Server Module is the single HSM installed in your Hyper SCADA Server.

<table>
<thead>
<tr>
<th><strong>CPU Usage</strong></th>
<th>Current CPU use (as a percentage) of the active Hyper Server Module.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>System Date and Time</strong></td>
<td>Current date and time for the active Hyper Server Module. If the date and/or time is incorrect, you can change it using the System Configure tool.</td>
</tr>
<tr>
<td><strong>Backup Status</strong></td>
<td>Indicates the success (green icon) or failure (red icon) of the most recent backup to the Windows workstation that has been configured as the remote backup location. Backup occurs each night at midnight. If the system is rebooted after midnight, the icon will be gray until the next time backup is attempted.</td>
</tr>
<tr>
<td>--------------------</td>
<td>--------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>CPU Temperature</strong></td>
<td>Current temperature of the active Hyper Server Module's CPU. Ideal temperature is approximately 175°F. If CPU temperature enters the yellow or red range, the CPU throttles back and the performance of the HSM may degrade.</td>
</tr>
<tr>
<td><strong>Redundant HSM (2nd HSM) Status</strong></td>
<td>For redundant systems, the icon will be green to indicate that the acting primary Hyper Server Module can &quot;see&quot; the secondary HSM (primary sends a network ping to the secondary and gets a response). If the primary doesn't get a response from the secondary, the icon will be red. A gray icon indicates that the Hyper SCADA Server is not running in redundant mode.</td>
</tr>
<tr>
<td><strong>Hard Disk Driver (HDD) Usage</strong></td>
<td>Amount of hard disk drive being used on the active Hyper Server Module. This information is provided as a percentage and in gigabytes (GB).</td>
</tr>
<tr>
<td><strong>RAM Memory Usage</strong></td>
<td>Amount of RAM that is currently being used on the acting Hyper Server Module.</td>
</tr>
<tr>
<td><strong>HSM Up Time</strong></td>
<td>The length of time (measured in days, hours and minutes) the active Hyper Server Module has been running since its last reboot.</td>
</tr>
<tr>
<td><strong>AC Power Status</strong></td>
<td>Indicates AC power status of the active Hyper Server Module (HSM). A green icon indicates AC power is present; a red icon indicates that AC power is absent and the active HSM is running on battery power.</td>
</tr>
<tr>
<td><strong>Number of Drivers</strong></td>
<td>Number of drivers configured on your system. If you are running a partitioned system, note that this is the total number of drivers, not just the ones configured for the partition you are logged into.</td>
</tr>
<tr>
<td><strong>Number of Stations</strong></td>
<td>Number of stations configured on your system. If you are running a partitioned system, note that this is the total number of stations, not just the ones configured for the partition you are logged into.</td>
</tr>
<tr>
<td><strong>Number of Points</strong></td>
<td>Number of points configured on your system. If you are running a partitioned system, note that this is the total number of points, not just the ones configured for the partition you are logged into.</td>
</tr>
<tr>
<td><strong>Number of TCP Connections</strong></td>
<td>Number of current TCP connections. This number includes all workstations currently logged into the system as well as network devices, such as Network Interface Modules (NIM), communicating with the Hyper SCADA Server over the network.</td>
</tr>
<tr>
<td><strong>Battery Voltage</strong></td>
<td>Voltage measurement for active Hyper Server Module's (HSM) backup battery. A voltage of 13.6 volts indicates that AC power is present; a voltage less than 12.0 volts indicates that the active HSM is running on battery power. If the voltage drops to 11.1 volts, the HSM will begin a safe shutdown.</td>
</tr>
</tbody>
</table>
Using Status, Reporting and System Tools

Driver Loop Times
Loop time (measured in minutes and seconds) for each driver configured on your system. If you are running a partitioned system, note that the loop times for all drivers are provided, not just the ones configured for the partition you are logged into.

Custom Screen Viewer
Custom Screen Viewer displays image-based screens that are graphical representations of your system. Custom Screens can display current status, trends and alarm conditions. Objects in custom screens can also be used to perform controls (for example, turn a pump on or off).

These screens are created using HT3's Screen Builder application. The System Stats viewer is an example of the type of screen that can be built with Screen Builder.

To open the Custom Screen Viewer:
1. Click View on the HT3 main menu.
2. Click Screens on the View submenu.

Custom Screen Viewer first determines if there is a screen for the partition that the user is logged into (a custom screen with a file name that matches the name of the partition). If no such file exists, the main base screen is opened (screen with a file name of "base"). If you have not created a base screen, the default HT3 base screen (an example of a custom screen) is loaded.

Below is an example of a custom screen created with Screen Builder.
Station Status

The Station Status Viewer allows you to quickly view the status of:

- All points at a specific station
- All non-local virtual points

You can also:

- Control the value of a digital or analog output (including all non-local virtual points)
- View a 24-hour activity trend for a digital or analog input (including all non-local virtual points)

Opening Station Status Viewer:

1. Click View on the HT3 main menu.
2. Click Station on the View submenu. A table listing all stations in the partition that user is logged into is displayed. If your system has non-local virtual points, a heading named "Virtual Points" is at the bottom of the table.

Sorting the Station Listing

By default, the station listing is sorted in ascending order by station address (number).

To sort the list alphabetically according to station name, click the "Station Listing" heading. Click "Station Listing" again to resort the list by address.
Station Level Information

Click a station number or name to view a table that lists all modules and points configured for that particular station.

Note: If you select a Modbus station with more than 99 points configured, the page that loads is a table that groups the points into banks of 99. Click a bank of points to view their status.

Point Level Information

- **Inputs** - When a monitor (input) point is clicked, a 24-hour activity trend is displayed (See Trender for more information).

- **Outputs** - Digital and analog outputs can be controlled by clicking them. Clicking a digital output enables you to change its state (for example, from ON to OFF or from AUTO to DISABLED). When a digital output is clicked, it flashes and its value changes (e.g., from ON to OFF). When an analog output (control) point is clicked, the value box becomes active and you can type the desired value.

Virtual Points

If your system has non-local virtual points, a heading named "Virtual Points" is at the bottom of the table.

This application is another method of seeing the value of a non-local virtual point (other methods being Logic Builder and custom screens).

**Local vs Non-local Virtual Points**

When you build a ladder and create virtual points, there is an option to set the point to be local only. A local point can only be viewed and used within the ladder. Setting the point as non-local makes its value available to HT3, so it can be used in custom screens and other ladders.

**Opening Virtual Points List**

Click Virtual Points to view an alphabetical list of all non-local virtual points.
If there are more than 99 non-local virtual points, the page that loads is a table that groups the points into banks of 99 (as shown below).

**Virtual Points**

Click a bank of points to view their status.

### Virtual Points

<table>
<thead>
<tr>
<th>Address</th>
<th>Name</th>
<th>Address</th>
<th>Name</th>
<th>Address</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>3009</td>
<td>RTU 9</td>
<td>3010</td>
<td>RTU 10</td>
<td>3011</td>
<td>#1 Symphony TCU 11</td>
</tr>
<tr>
<td>3012</td>
<td>#1 Symphony TCU 12</td>
<td>3013</td>
<td>#2 Symphony TCU 13</td>
<td>3014</td>
<td>#2 Symphony TCU 14</td>
</tr>
<tr>
<td>3015</td>
<td>TIM Solar Station</td>
<td>3017</td>
<td>Symphony PCU 17</td>
<td>3018</td>
<td>TIM Temp Station</td>
</tr>
<tr>
<td>6048</td>
<td>Routed RNA</td>
<td>6173</td>
<td>VDR Hub</td>
<td>6178</td>
<td>RDR Hub Radio</td>
</tr>
<tr>
<td>6188</td>
<td>RDP 180</td>
<td>6199</td>
<td>FTD VDR2 Radio</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Controlling Values and Viewing Trends**

As with all "real" points, you can:

- Click a virtual monitor (input) point to view a 24-hour activity trend
- Click a virtual digital or analog output point to control its value
Alarm Viewer

Alarm Viewer provides you with up-to-the-moment, alarm-activity information, which enables you to respond to critical situations quickly.

Alarm Viewer allows you to acknowledge alarms if your user account has been granted acknowledgement permission. See User Accounts for more information on accounts and permission levels.

Acknowledging an alarm does not clear the condition. It is simply an indication to the system and to other users that someone is aware of the condition.

When an alarm is acknowledged, Alarm Viewer logs the user name of the person who acknowledged the alarm and the date and time the alarm was acknowledged. This information can be viewed in Alarm Viewer by clicking the telemetry address of the acknowledged alarm.

See the following sections for more information:

- Opening Alarm Viewer
- Alarm Viewer’s Interface
- Sorting Alarms
- Delay and Snooze
- Acknowledging Alarms
- Alarm Log

Opening Alarm Viewer

There are two methods of opening Alarm Viewer:

**Method 1:**
1. Click View on the HT3 main menu.
2. Click Alarms on the View submenu.

**Method 2:**
- On the System Tray, click the bar on the far right.
Alarm Viewer's Interface

- **Column Headers** - Click a header (Time, Address, Name or Description) to sort alarms by that property. Click the same header again to switch between descending and ascending order.

- **Alarm List** - Displays the time the alarm occurred, telemetry address of point, user-defined name of point, description of alarm (user-defined alarm label as provided in Configuration Editor). The color of an alarm indicates its status: red (active unacknowledged alarm); yellow (active acknowledged alarm); green (cleared unacknowledged alarm).

- **Sort by Status Button** - Sorts the alarm list by status. Click the button to display the alarm list in the following order: Alarm (red), Acknowledged (yellow), Cleared (green). Click the button again to reverse the order.

- **Message Bar** - Located beneath the Alarm List, the Message Bar provides the following information:
  - Date alarm occurred
  - User name of person who acknowledged the selected alarm
  - Date and time the alarm was acknowledged

### Alarm Types and Colors

There are three alarm categories: Alarm (red), Acknowledged (yellow) and Cleared (green).

<table>
<thead>
<tr>
<th>Status</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>ALARM</strong></td>
<td>The point is currently in the alarm state and has not been acknowledged. These alarms are red.</td>
</tr>
<tr>
<td><strong>ACKNOWLEDGED</strong></td>
<td>The point is currently in the alarm state and has been acknowledged. These alarms are yellow.</td>
</tr>
<tr>
<td><strong>Cleared</strong></td>
<td>The point was in an alarm state, is now cleared, but has not been acknowledged. These alarms are green.</td>
</tr>
</tbody>
</table>
Sorting Alarms

Alarms can be sorted by the following:

- **Time** - Time alarm occurred
- **Address** - Telemetry address of point
- **Name** - User-defined name of point
- **Description** - User-defined alarm label for point
- **Status** - Current status (Alarm, Acknowledged, Cleared)

- **Sort by Time, Address, Name, or Description** - Click the column header. Click the same header again to switch between descending and ascending order.

- **Sort by Status** - Click the **Sort by Status** button. The alarms are listed in the following order: Alarm, Acknowledged, Cleared. Click the button again to reverse the order.

Delay and Snooze

When alarms are configured, you have the option of specifying a Delay and/or Snooze time.

- **Delay** is the length of time (in seconds) the point is allowed to be in the alarm state before it appears in Alarm Viewer.

- **Snooze** is the length of time (in seconds) that is allowed to pass before an Acknowledged alarm that has not cleared is returned to Alarm status.

An alarm configured with a Delay or Snooze time is not displayed in Alarm Viewer until the configured time has elapsed. For more information on these options, see Alarms.

Acknowledging Alarms

To acknowledge alarms, you must be logged in with an account that has Acknowledge Alarms permission. See User Accounts for more information.

To acknowledge an alarm:

1. Click the telemetry address of the alarm you want to acknowledge.
   
   - Alarms with Alarm status change from red to yellow.
   
   - Alarms with Cleared status are removed from the alarm list when they are acknowledged.

2. The Message bar displays who the alarm was acknowledged by and the time the alarm was acknowledged.
This information is maintained in a log and can be viewed for current, individual alarms in Alarm Viewer or for all alarms by creating a Log Report. See Alarm Log for more information).

Note: When an Acknowledged alarm clears (is no longer in an alarm state), it is removed from the alarm list.

## Alarm Log

HT3 maintains a log of all alarm activity, including information on who an alarm was acknowledged by and the time the alarm was acknowledged. This information can be viewed for an individual alarm from Alarm Viewer or for all alarms by creating an Alarm Log Report (see Advanced Reporting Tool for more information on Log Reports).

To view information on an acknowledged alarm:

1. Click the telemetry address of the acknowledged alarm (Note: Acknowledged alarms are yellow). The selected address is surrounded by a broken, yellow line and the alarm’s color changes to yellow.

2. If you click the telemetry address of the acknowledged alarm, the Message bar displays the date the alarm occurred, the login of the person who acknowledged the alarm, and the date and time the alarm was acknowledged.

## Camera Viewer

If you have surveillance cameras on your network, you can view their video feed from within Camera Viewer. See Configuring Your System: Cameras for more information on adding cameras to your system.

To open Camera Viewer:

1. Click View on the HT3 main menu.

2. Click Cameras on the View submenu.
3. From the list of configured cameras, click the name of a camera to view its video feed.
Analyzing Data with Trends

With Trender you can view and analyze historical information for any telemetry point in your system.

A trend can contain data from a single point or multiple points.

Multiple points can be displayed in separate panels in the same window... … or they can be combined to display in the same panel.

Trender features tools for zooming in and out (to see more detail or more data) and for panning backward and forward in time.

Note that although any user can create and view a trend, only users with "Configure Telemetry" permission can save a trend. For more information on permissions, see User Accounts.

Opening Trender

1. Click View on the HT3 main menu.
2. Click Trends on the View submenu.
   - To add points to the empty trend, click the Add Address icon and browse to the point you want to add. See Creating a Trend for information on setting the properties of the trend and adding additional points to the trend.
   - To open an existing trend, select Open from the File menu and choose a trend from the drop-down list. The name of the trend is displayed in the bottom left corner of the trend window.
   - To view Trender in full-screen mode, click the Detach icon. Trender opens in a new window.

Trender's Interface

- File menu
- Recent Trends menu (lists the last five trends that have been opened in Trender)
- Icon toolbar
- Date and time information
- Point name, address and value information
File menu

Located in the top-right corner, the File menu features the following commands:

- **New** - Create a new trend.
- **Open** - Open an existing trend.
- **Save** - Save the current trend (requires "Configure Telemetry" permission; see User Accounts for more information).
- **Save As** - Save the current trend and assign it a file name (requires "Configure Telemetry" permission; see User Accounts for more information).
- **Remove** - Delete a saved trend (requires "Configure Telemetry" permission; see User Accounts for more information).
- **Settings** - Define default and global default settings for your trends. These settings effect the behavior and appearance of trends created in Trender as well as trends opened from outside Trender (for example, from links in custom screens or from the Station Status Viewer).
  - **Default settings** (Interpolate Values and Auto Range) are only applied to new trends. They do not change the settings of saved trends or trends that are currently open.
  - **Global settings** are applied to all new trends, but they also have an immediate effect on saved trends and any trends that are currently open. The global settings are Show Details (Interpolate Mode Only), Show Address Name Only, and Use 12-Hour Clock.
• Print - Print the current trend.

Recent Trends menu
Click Recent Trends to open a list of the last five trends that have been opened in Trender.

Icon toolbar
Located along the top of the interface next to the File menu, the Icon toolbar features buttons for the following commands:

- Delete address from current trend
- Add address(es) to the current trend
- Edit the address of a trend line.
- Create a combined trend - multiple points all displayed in the same trend panel. There is no limit on how many points can be added, but performance and visual interpretation may degrade if more than 10 or 12 points are added to a single trend.
- Create a multi trend - multiple points each displayed in their own panel. There is no limit on how many points can be added, but performance and visual interpretation may degrade if more than 10 or 12 points are added to a single trend.
- Display a single point. While in Multi Trend mode, select the trend you want to view and then click this icon.
- Zoom in to see more detail. Each time the Zoom In icon is clicked, the length of time being displayed is cut in half. You can also zoom in using the mouse scroll button. Roll the mouse wheel forward (away from you). Minimum time span is one minute.*
- Zoom out to see more data. Each time the Zoom Out icon is clicked, the length of time being displayed is doubled. You can also zoom out using the mouse scroll button. Roll the mouse wheel backward (towards you). Maximum time span is 30 days and/or 25,000 data samples.*
- Pan backward in time. Each time the Pan Backward icon is clicked, the time span being displayed is moved backward by a length of time equivalent to what is currently being shown. You can also pan backward by clicking the left side of the trend and dragging your mouse to the right.*
- Pan forward in time. Each time the Pan Forward icon is clicked, the time span being displayed is moved forward by a length of time equivalent to what is currently being shown. You can also pan forward by clicking the right side of the trend and dragging your mouse to the left.*
- After zooming or panning, use Reset to return the trend to the default time span and the current date and time.
- Detach Trender - opens in a new window and allows Trender to be viewed in full-screen mode.
- Increase the font size of all text displayed on the trend.
Decrease the font size of all text displayed on the trend.

*A spinning beach ball may appear in the lower right corner to indicate data is being retrieved and the trend is being updated.*

## Date and time information

Dates and times are displayed at the top of the trend just below the menu/icon toolbar. Time is displayed using a 24-hour clock.

![Screen shot of trend display](image)

### Time Span (top-left corner)

The length of time currently being displayed is shown in the top-left corner (the screen shot above shows a time span of one hour). The minimum time span that can be displayed is one (1) minute; the maximum time span is 30 days and/or 25,000 data samples (i.e., if the point's value changes more than 25,000 times during the selected time span, only the last 25,000 changes will be shown).

### Current Date (center)

When you move your mouse over the trend, the date shown in the center of the window changes to correspond to the position of your mouse pointer. In the screen shot above, the position of the mouse pointer corresponds to the date and time of Wednesday, May 19, 2010 at 13:56:41 EDT.

Additionally, the value that corresponds to that date and time is displayed in the top-right corner just below the end date (3 mph in the screen shot).

If this is a saved trend, the name of the trend is shown just to the left of the current date (Daily_Wind in the screenshot); otherwise the word "untitled" is displayed.

### End Date and Time (top-right corner)

The ending date and time for the viewable time span is shown in the top-right corner. When a trend is opened, the current date and time is displayed. The end date and time is updated when the panning functions are used.
Point name, address and value information

Name and address

The point's name and telemetry address are displayed in the top-left corner just below the current time span. They are displayed in the same color as the trend line. This is useful when viewing a combined trend.

If the point's address is not displayed, the Show Address Name Only option may have been set. To turn the option off, go to File -> Settings and uncheck the box next to Show Address Name Only.

In the screen shot below, the point's user-defined name is Wind Speed; its address is 6018.30014.

Values and Range

The value and units of the point is displayed in the top-right corner just below the ending date and time. The displayed value corresponds to the position of your mouse pointer. As you move your mouse over the trend, the value and the current date are changed accordingly. The value is displayed in the same color as the trend line. This is useful when viewing a combined trend.

If the trend has the Interpolate Values (smoothing) option turned on and your mouse is positioned between two points on the trend line, the value shown in the top-right corner is the interpolated (estimated) value for that date and time. To see the real logged values for the interpolated span, hold down the right mouse button (or turn on the Show Details setting).

The minimum and maximum values of the trend (the trend's range) are displayed on the bottom left and top left of the trend.

- If the Auto Range option is turned on, these numbers represent the minimum and maximum values logged for the point during the time span being displayed.
If the Auto Range option is turned off, these are either the low and high engineering values configured for the point in Configuration Editor or the values entered in the Min and Max Range boxes.

In the screen shot below, the trend has a range of 0.15 (minimum value) to 8.06 (maximum value). The interpolated value of 4 mph is displayed in the top-right corner (below the ending date and time). It represents the interpolated value for the point named Wind Speed on Wednesday, May 19, 2010 at 14:42:47 EDT (the date and time corresponding to the position of the mouse pointer). The values 3 mph and 5 mph are the real logged values for Wind Speed at the beginning and end of the interpolated span.

![Interpolated Value Example](image)

**Settings panel**

The settings panel is accessed by clicking the information icon (circled in yellow below). The information icon does not appear until a trend is selected (simply click anywhere in the trend’s panel).

![Settings Panel](image)

In the settings panel (shown below), you can
• Set the trend’s range
• Turn the smoothing option on or off
• Select the color for the trend
• Add reference lines/values
• Turn the grid display on and off

For more information on trend settings, see Creating a Trend.

Creating a Trend

1. Open Trender. (To view Trender in full-screen mode, click the Detach icon 🔄. Trender opens in a new window.)

2. Click the Add Address icon 🔄 to open the Address Selection Tool and add address(es) to the trend.
   - Browse and click the point you want to add.
   - CTRL+click to add multiple points simultaneously.
   - Type the full address of the point in the Selection box. Separate multiple individual addresses with commas.

Note on Multiple Points - There is no limit on how many points can be added, but performance and visual interpretation may degrade if more than 10 or 12 points are added to a single trend. Trends with multiple points can be viewed as a Combined Trend or a Multi Trend.

3. To save the trend, choose Save As from the File menu (requires "Configure Telemetry" permission; see User Accounts for more information).
By default, one hour of data (ending at the current date and time) is displayed for a new trend. If HT3 isn’t receiving any data for a point, the trend for that point will display the message "No Data."

- You can adjust the amount of data that is shown by zooming in and out. If you save the trend after zooming in or out, the trend will use that time span each time it is opened.
- You can adjust the start and end times for the trend display by panning backward and forward.
- You can manually set the time span using the Range Picker.
- To return the trend to its default time span and the current date and time, click the Reset icon.

Other settings, such as range, smoothing, and trend line color, can be adjusted from the settings panel. See also Removing a Point from a Multi or Combined Trend.

### Adding Address(es) to a Trend

Click the Add Address icon to open the Address Selection Tool.

There are several methods for adding addresses:

- Browse and click the point you want to add.
- CTRL+click to add multiple points simultaneously.
- Type the full address of the point in the Selection box. Separate multiple individual addresses with commas.
Adjusting Trend Properties

Settings such as range (minimum and maximum y-axis values), smoothing, and trend line color can be adjusted from the settings panel.

When a trend is selected (click anywhere on the trend), the Information icon (circled in yellow in the screen shot below) is displayed in the bottom right corner of the trend.

**Note:** Settings cannot be changed in Combined Trend mode. Select the Multi Trend option (represented by this icon: \[ \square \square \square \]) and then choose the trend you want to change the settings for.

Click the Information icon to open the settings panel.
Range (Auto Range or user-defined values)

Range allows you to set the minimum and maximum values for the trend’s y-axis.

- **Auto Range** sets the upper and lower range of the trend to the minimum and maximum values recorded for the point during the current time span. These are not the minimum and maximum possible values for the point (as set in Configuration Editor), but the minimum and maximum actual recorded values for the time span. This setting causes the trend to fill the entire vertical area of the trend.

- You can define your own range for the trend by clearing the **Auto Range** option and entering your own values in the **Min** and **Max** boxes.

Smoothing

Select the **Interpolate Values** option to create a smooth trend (the Trender estimates the values between each logged value to create a smooth trend).

Trend Color

Use the **Select** button to choose the display color for the trend line and the point’s corresponding data (current value, name and address of point). This is especially useful when viewing multiple points in a combined trend.

Reference Values

You can add reference lines to your trend that represent critical values you are looking for. This allows you to see at a glance when the value for the point reaches this value or rises above or falls below it.

Grid

Select the **Display Grid** option to display the trend with a grid in the background.

Time Span

By default, one hour of data (ending at the current date and time) is displayed for a new trend. You can adjust the amount of data that is shown by **zooming in and out**. If you save the trend after zooming in or out, the trend will use that time span each time it is opened. To return the trend to its default time span and the current date and time, click the **Reset** icon. 

Adjusting Start and End Dates

Trender features three methods for changing the start and end dates of trends:

- **Zoom**
- **Pan**
- **Range Picker** (used to set the time span of the trend; x-axis)

Zooming In and Out

By default, one hour of data is displayed. The zoom functions let you see more detail (zoom in to decrease the time span) or more data (zoom out to increase the time span).

**Zoom In**

Click the **Zoom In** icon. You can also zoom out using the mouse scroll button. Roll the mouse wheel forward (away from you).

Each time the **Zoom In** icon is clicked, the length of time being displayed is cut in half. (e.g., If four hours of data are displayed, clicking the **Zoom In** icon will shorten the time span to two hours. Clicking the **Zoom In** icon again will shorten the time span to one hour.) The minimum time span for a trend is one (1) minute.

**Zoom Out**

Click the **Zoom Out** icon. You can also zoom out using the mouse scroll button. Roll the mouse wheel forward (away from you).

Each time the **Zoom Out** icon is clicked, the length of time being displayed is doubled. (e.g., If two hours of data are displayed, clicking the **Zoom Out** icon will lengthen the time span to four hours. Clicking the **Zoom Out** icon again, will lengthen the time span to eight hours.)

The maximum time span is 30 days and/or 25,000 data samples (i.e., if the point's value changes more than 25,000 times during the selected time span, only the last 25,000 changes will be shown).

Notes:

- A spinning beach ball may appear in the lower right corner to indicate data is being retrieved and the trend is being updated.
- To return the trend to its default time span and the current date and time, click the **Reset** icon.
- If you save the trend after zooming in or out, the trend will use that time span each time it is opened.

Panning Backward and Forward

When a trend is opened or created, it defaults to the current date and time. The pan functions let you move backward and forward in time.
• **Pan Backward** - Click the **Pan Backward** icon. You can also pan backward by clicking the left side of the trend and dragging your mouse to the right.

• **Pan Forward** - Click the **Pan Forward** icon. You can also pan forward by clicking the right side of the trend and dragging your mouse to the left.

**Notes:**

• Each time the **Pan Backward** or **Pan Forward** icons are clicked, the time span displayed is moved backward or forward by a length of time equivalent to the current time span. (e.g., If five hours of data are being displayed, clicking the **Pan Backward** icon will change the trend to display the previous five hours of data.)

• A spinning beach ball may appear in the lower right corner to indicate data is being retrieved and the trend is being updated.

• To return the trend to its default time span and the current date and time, click the **Reset** icon.

### Manually Setting the Time Span (Range Picker)

To manually select specific dates and times for a trend, use the Range Picker.

To open the Range Picker, click the time span (top left corner) or the end date (top right corner) - circled in red in the image below.

- **Start Date** - Click the **Start Date** radio button. Use the up and down scroll arrows to adjust the hour, minutes, AM/PM, month, day, and year. You can also edit the start date and time by typing values in the field.
• **Span** - Select the length of time you want the trend to display by selecting a value from the drop-down list (15 minutes, 30 minutes, 1 hour, 2 hours, 8 hours, 12 hours, or 1 day) or type a value in the field.

• **End Date** - Click the **End Date** radio button. Use the up and down scroll arrows to adjust the hour, minutes, AM/PM, month, day, and year. You can also edit the end date and time by typing values in the field.

• **Current** - Click the **Current** radio button to set the End Date of the trend to the current date and time.

**Notes:**

• Setting a specific Start Date and changing the Span will automatically change the End Date value.

• Setting a specific End Date and changing the Span will automatically change the Start Date value.

• Setting a specific Start Date and End Date will automatically change the Span value.

• For trends with multiple points, the values entered here will apply to all trend lines.

**Editing the Address of a Trend**

After you’ve created and saved a trend, you may find it necessary to change the address for a point in the trend. If the trend contained only a single point, it would be easy to just create a new trend. But for trends that include multiple points, it is much easier to just edit the address of the point that changed.

This is also helpful to create a template that you can use for multiple stations (for example, a trend that tracks the well level and pump run status at a triplex station). Create and save a trend with the time span, trend line colors, reference values, etc. that you want to use. Then edit the point addresses and save the trend with a new file name.

1. Open the trend you want to edit.

2. Select the trend line of the point you want to edit. A yellow border around the trend line and the display of the information icon indicates which line is selected.
3. Click the **Edit Address** button and browse to locate the new point address.

4. Save the trend (select **Save** or **Save As** from the **File** menu).
Multiple and Combined Trends

Trender offers two options for viewing historical data for more than one point.

There is no limit on how many points can be added, but performance and visual interpretation may degrade if more than 10 or 12 points are added to a single trend.

To simultaneously add multiple points to a trend, click the Add Address icon (looks like a star) to open the Address Selection Tool. Hold down the Ctrl key on your keyboard while clicking the name of each point you want to add.

- The Multi Trend option (represented by this icon: ) displays each point in a separate panel. In Multi Trend mode, you can change the order of the trend points by dragging and dropping them.

- The Combined Trend option (represented by this icon: ) displays all points in a single panel.

Multi Trend Option

When the Multi Trend option is selected, historical data for each point is displayed in separate panels.

Drag and drop trends to change their order:

1. Click the trend you want to move.
2. Move it to the new location while holding down the mouse button.
3. Release the mouse button to place the trend in the new location.

To view a single point in a Multi Trend:

1. Select the trend for the point you want to view.
2. Click the **One Trend** icon. Note that you cannot adjust the trend’s settings in One Trend mode. You must be in Multi Trend mode.

**Combined Trend Option**

When the Combined Trend option is selected, historical data from all points is displayed in a single panel.

![Trend Graph](image)

**Range**

The range for a combined trend is based on the lowest and highest value recorded for *any one point during* the currently displayed time span. For example, if four analog points were combined in a single trend and the lowest value recorded for any point during the current time span was 3 and the highest value reported by any point during the current time span was 45.98, the range for the combined trend would be 3 to 45.98.

**Legend**

A color-coded legend is displayed in the top-left corner. The legend lists the name of each point in the color configured for the point. To see the telemetry address of the points, hold down the right mouse button anywhere on the trend. The address will be shown in parentheses next to the point name.

**Point Values**

In the top-right corner is a color-coded list of the points’ current values. When you place your mouse over the trend, the list changes to reflect the values recorded for that point at the date and time that corresponds to the location of your mouse pointer.

**To view a single point from this trend:**

1. Click the **Multi Trend** icon.
2. Select the trend for the point you want to view.

3. Click the **One Trend** icon \( \icon \). Note that you cannot **adjust the trend's settings** in One Trend mode. You must be in Multi Trend mode.

### Removing a Point from a Multi or Combined Trend

1. If you are in Combined Trend mode, change to Multi Trend mode by clicking the \( \icon \) icon.

2. Click the trend of the point you want to remove - the information icon (lowercase i) appears and the trend is surrounded by a blue line.

3. Click the **Delete Address** icon \( \icon \).

4. Save the trend if desired. (Requires "Configure Telemetry" permission; see **User Accounts** for more information.)

### Defining Default and Global Trend Settings

From the **File** menu, select **Settings**.

These settings affect the behavior and appearance of trends created in Trender as well as trends opened from outside Trender (for example, from links in custom screens or from the Station Status Viewer).

- Default settings are only applied to new trends. They do not change the settings of saved trends or trends that are currently open.

- Global settings are applied to all new trends, but they also have an immediate effect on saved trends and any trends that are currently open.

![Settings](settings.png)

**Default Settings**

- **Interpolate Values** - Creates a smooth trend (the Trender estimates the values between each logged value to create a smooth trend).
• **Auto Range** - Sets the upper and lower range of the trend to the minimum and maximum values recorded for the point during the current time span. These are not the minimum and maximum possible values for the point (as set in Configuration Editor), but the minimum and maximum actual recorded values for the time span. This setting causes the trend to fill the entire vertical area of the trend.

**Global Settings**

• **Show Details (Interpolate Mode Only)** - Display the logged values for the interpolated span. Position your mouse pointer over the trend line to see the values.

• **Show Address Name Only** - Only the point's name will be displayed in the top-left corner of the trend. The point address will not be shown.

• **Use 12-Hour Clock** - Display all times using a 12-hour clock instead of the default 24-hour clock.
Creating and Viewing Reports

HT3 provides you with a variety of reports that allow you to monitor the activity and performance of your telemetry equipment.

- **Analog Flow** - The Analog Flow Report averages and totalizes analog flow meters and provides the total time the pump was on, average GPM, and total gallons.

- **Comment Log** - The Comment Log is an electronic journal for recording notes about activities and events that affect your utility's operation. For example, you can note a heavy period of rainfall or explain that a pump's extended run time was the result of the mechanical failure of a backup pump. This information can be easily retrieved using queries based on station number and/or dates.

- **Derived Flow** - The Derived Flow report calculates the flow at sewage lift stations that aren't equipped with analog flow meters. This report can only be generated for TCU or PCU stations.

- **Detail** - The Detail Report generates a chronological listing of all events that occurred at the requested telemetry addresses for the specified time period.

- **Digipeat Map** - The Digipeat Map lists all DFS stations that are digipeating and provides their relay paths. Information on digipeating can be found in Configuring a Station to Digipeat.

- **Force Main Report** - This report compiles data on the run status of all pumps feeding into a common force main for the selected day. The report can be used to identify times when pumping efficiency decreases and energy consumption increases because too many pumps that feed into a common force main are running simultaneously.

- **Min Max Average** - The Min Max Average report lists the daily minimum, maximum and average values of each point included in the report. It is designed for analyzing analog data such as pressure and flow measurements, chlorine residuals, turbidity, and tank levels.

- **Modbus Map** - The Modbus Map lists information on each DFS point that is emulating Modbus. Modbus emulation enables the Hyper SCADA Server (HSS) to respond as a Modbus TCP client by allowing DFS-type points to be queried as registers via the Modbus TCP protocol.

- **Pulse** - The Pulse report provides daily pulse count totals for equipment, such as rain gauges or flow totalizers, that provide a pulse signal that represents a specific amount. Points selected for this report must be configured as digital pulse points (See Configuring Your System: Adding and Configuring a Digital Pulse Point).

- **Pump Activity** - The Pump Activity report provides data on the activity of a digital point (usually a pump). The report provides the minimum length of time the point was on, the maximum length of time the point was on, the average length of time the points was on and the total number of times the point came on.

- **Snapshot** - The Snapshot report returns values in 15 minute intervals for each point included in the report. The value returned is the last value recorded for the point prior to the interval. The Snapshot report is designed for analyzing analog data such as water plant turbidity measurements and chlorine and PH levels.
• **Station Configuration** - The Station Configuration report lists the selected station's settings, including its partition, polling priority, volume, each module configured at the station, and the module's associated I/O points.

**Beta Interface**

Our new report interface is currently in beta testing, and we are collecting feedback. To access the beta report interface, click Reports from the main HT3 menu and then click *(BETA Interface)*. Send your questions, suggestions, and comments to engineering@dataflowsys.com.

**Advanced Reporting Tool**

See Advanced Reporting Tool for information on creating access, alarm and control logs and radio error reports, and using advanced features to create analog flow, derived flow, detail, pulse, and pump activity reports.

**Analog Flow Report**

The Analog Flow report is used specifically for totalizing flow measurements taken in a real-time GPM (gallons per minute) rate. The report provides average GPM and total gallons for the report period. It also provides the total time the source point's qualifier point was on. The flow signal can come from any type of station (DFS, Modbus, Motorola).

The Analog Flow report can be generated for a specific station, an individual address, multiple addresses, or a keyword grouping. We strongly suggest using keywords when generating reports to take advantage of the speed provided by cached report data. See Configuring Your System: Keywords for more information.

The Analog Flow report can also be generated from the Advanced Reporting Tool.

See also: Bar and Line Charts

**To create an Analog Flow report:**

1. Click Reports on the HT3 main menu.
2. Click Create on the Reports submenu.
4. Select the report’s Source. Choose the appropriate keyword from the Keyword list or enter an address, list of addresses, or station name in the Address box.

   - If the stations have been named using the specific format discussed in Choosing Station Names, you can enter station names in the Address box. Results will be returned sorted in ascending order according to the entries in the station name box.

   - You can combine station numbers with keywords. For example, to limit the report data to only those points assigned to the keyword Pumps that are located at station number 1187, you would select PUMPS from the Keyword list and type 1187 in the Address box.

   - To generate a report on multiple stations or telemetry addresses, enter the desired station numbers or telemetry addresses separated by commas.

The Telemetry Address structure in HT3 is as follows:

<table>
<thead>
<tr>
<th>RTU Type</th>
<th>Station #</th>
<th>Module Letter</th>
<th>Point #</th>
</tr>
</thead>
<tbody>
<tr>
<td>DFS</td>
<td>1187</td>
<td>C</td>
<td>4</td>
</tr>
<tr>
<td>Modbus</td>
<td>6018</td>
<td>.</td>
<td>3</td>
</tr>
</tbody>
</table>

To run a report on the DFS point above, you would enter 1187C4 in the Address box; to run a report on the entire station, you would enter 1187. To run a report on the Modbus point, you would enter 6018.3 in the Address box; to run a report on the entire station, you would enter 6018.

5. Select the Start date and End date using the calendar buttons to the right of each box.

6. Click the Run report button. The requested report opens in a new window. For each day requested, the report provides:

   - Total on time of qualifier point
• Average flow (GPM)
• Total gallons

Comment Log
The Comment Log is an electronic journal for recording notes about activities and events that affect your utility's operation. For example, you can note a heavy period of rainfall or explain that a pump's extended run time was the result of the mechanical failure of a backup pump. This information can be easily retrieved using queries based on station number and/or dates.

• Comments can be a maximum of 255 characters.
• Each entry in the comment log includes the user who entered it.
• Comments can be entered with today's date or a previous date. Comments entered with today's date are time stamped with the current time; comments entered with a previous date are time stamped with midnight (12:00am).
• Comments can be assigned a station number or the station field can be left for comments that are generic or system-wide.
• By default, the last 30 comments are listed below the Comment Log form. However, the comment list can be filtered by station number and/or date.
• Comments can be included in the output of a Alarm Log, Control Log, Access Log or Radio Errors report by selecting the Include Comments option on the Advanced Reporting Tool form.
• Comment Log entries are kept in the system for 9999 days before being moved to an archive location.
• Comment Log entries cannot be modified or deleted. If you need to edit or nullify an entry, create a new comment that references the previous entry and explains the change.
• To view a print-friendly version of the comments, click the Print Comments link that is displayed at the top and bottom of the Comment Log entries.

See the sections below for information on using Comment Log:

• Opening Comment Log
• Entering a Comment
• Filter Comments by Station and/or Date

Opening Comment Log
1. Click Reports on the HT3 main menu.
2. Click Comment on the Report submenu.
Entering a Comment

1. Type your comment in the Enter Comment box (entries can be a maximum of 255 characters).
   
   If you aren’t satisfied with your comment, click Clear to erase it from the Enter Comment box and then retype your note.

2. If the comment is for a specific station, type the station number in the Station Number box. Otherwise, leave the Station Number box empty. The station number is the one-digit driver number plus the three-digit station number (e.g., 6018 for station 18 under driver number 6).

3. Click Submit. Your note is entered in the Comment Log.
   
   Note: Comment Log entries cannot be modified or deleted. If you need to edit or nullify an entry, create a new comment that references the previous entry and explains the change.

Filter Comments by Station and/or Date

1. To look for comments for a specific station, type the station number in the Station box. To view all comments for the time span, leave the Station box empty.

2. Type dates in the From and To boxes (must be in the format MM/DD/YYYY), or click the calendar icon next to the From and To boxes to select dates.

3. Click Submit. Comments for the selected time span are listed in reverse chronological order below the Comment Log form.

4. To view a print-friendly version of the comments, click the "Print Comments" link that is displayed at the top and bottom of the Comment Log entries.
Derived Flow Report

The Derived Flow report calculates the flow at sewage lift stations that aren’t equipped with analog flow meters. This report can be generated for any DFS radio or network station with pumps configured.

The report performs its calculations using the pump addresses in its keyword and the volume in the station panel. The addresses can be individual pumps, which can come from any DFS module with digital inputs, or the Any Pump signal from the PCM, PCU or TCU. This report is generally used for stations with pumps that empty a well, but could also be used for pumps that fill a tank.

For each station that you want to run a Derived Flow report on, you must:

- Calculate the station’s flow volume and enter that volume in the station’s configuration. See Configuring Your System: Adding a DFS Station for more information.

- Create a Derived Flow keyword definition and assign the station’s pump points or Any Pump point (PCM, PCU or TCU only) to the keyword definition. See Configuring Your System: Keywords for more information.

Using the configured flow volume and the station’s reported date, the Derived Flow report calculates the number of cycles, average inflow rate, average outflow rate, and totalizes the flow.
The Derived Flow report can also be generated from the Advanced Reporting Tool.

See also: Bar and Line Charts

To create a Derived Flow report:

1. Click Reports on the HT3 main menu.
2. Click Create on the Reports submenu.

![Report Type]

4. Select the report's Source. Choose the appropriate keyword from the Keyword list. The Derived Flow report requires a keyword. You cannot run a Derived Flow Report on a telemetry address.

5. Select the Start date and End date using the calendar buttons to the right of each box.

6. Click the Run report button. The requested report opens in a new window. For each day requested, the report provides:
   - Number of cycles
   - Average inflow (GPM)
   - Average pump rate (GPM)
   - Total gallons

**Detail Report**

The Detail Report generates a chronological listing of all events that occurred at the requested telemetry addresses for the specified time period.

**Note:** This report has the potential for being quite large. To avoid reports that are too large, limit the selection to only the needed telemetry addresses instead of generating a report on an entire station.
The Detail report can be generated for a specific station, an individual address, multiple addresses, or a keyword grouping.

The Detail report can also be generated from the Advanced Reporting Tool.

See also: Bar and Line Charts

To create a Detail report:

1. Click Reports on the HT3 main menu.
2. Click Create on the Reports submenu.
3. Select Detail for Report Type.
4. Select the report’s Source. Choose the appropriate keyword from the Keyword list or enter an address, list of addresses, or station name in the Address box.
   - If the stations have been named using the specific format discussed in Choosing Station Names, you can enter station names in the Address box. Results will be returned sorted in ascending order according to the entries in the station name box.
   - You can combine station numbers with keywords. For example, to limit the report data to only those points assigned to the keyword Pumps that are located at station number 1187, you would select PUMPS from the Keyword list and type 1187 in the Address box.
   - To generate a report on multiple stations or telemetry addresses, enter the desired station numbers or telemetry addresses separated by commas.

The Telemetry Address structure in HT3 is as follows:

<table>
<thead>
<tr>
<th>RTU Type</th>
<th>Station #</th>
<th>Module Letter</th>
<th>Point #</th>
</tr>
</thead>
</table>

[Diagram of Report Type with options for Analog Flow, Derived Flow, Detail, Pulse, Pump Activity, Min Max Average, Snapshot, Keyword input for ZONES, Address, Start date 08/16/2010, End date 08/16/2010, Run Report, Clear form, Advanced options]
To run a report on the DFS point above, you would enter 1187C4 in the Address box; to run a report on the entire station, you would enter 1187. To run a report on the Modbus point, you would enter 6018.3 in the Address box; to run a report on the entire station, you would enter 6018.

5. Select the Start date and End date using the calendar buttons to the right of each box.

6. Click the Run report button. The requested report opens in a new window. For each day requested, the report provides:
   - Digital Points - change in status and time the change occurred.
   - Analog points - change in value and time the change occurred.

**Digipeat Map**

The Digipeat Map lists all DFS stations that are digipeating and provides their digipeating paths. Information on digipeating can be found in Configuring Your System: Stations and Tutorials: Set Up a Digipeating Station.

1. Click Reports on the HT3 main menu.

2. Select Digipeat Map on the Reports submenu. A table similar to the one below is displayed.

<table>
<thead>
<tr>
<th>Station</th>
<th>Name</th>
<th>D1</th>
<th>D2</th>
<th>D3</th>
<th>D4</th>
</tr>
</thead>
<tbody>
<tr>
<td>1010</td>
<td>Internet TCU</td>
<td>68</td>
<td>202</td>
<td>191</td>
<td>241</td>
</tr>
<tr>
<td>1020</td>
<td>TIM Monitor Station</td>
<td>192</td>
<td>168</td>
<td>1</td>
<td>20</td>
</tr>
<tr>
<td>3003</td>
<td>3 Phase TCU</td>
<td>3007</td>
<td>3009</td>
<td>0</td>
<td>0</td>
</tr>
</tbody>
</table>

- The first two columns list the number and name of each station uses digipeating.
- The third column, D1, is the number of the first relay station. Similarly, D2, D3, and D4 are the second, third, and fourth relay stations.
- A zero (0) is displayed in the column if the station isn’t using a second, third, or fourth relay station.

If we were to look at the configuration screen for station 3003 (select Configure from the HT3 menu, then select Telemetry and browse to the target station), we would see that Station 3003 (3 Phase TCU) is configured to use RTU 7 (station #3007) and RTU 9 (station #3009) as relay stations. Zeros are listed for "3 Phase TCU" in columns D3 and D4 because it only digipeats through two stations.
Force Main Report

This report compiles data on the run status of all pumps feeding into a common force main for the selected day (24-hour period that starts at midnight of the selected to day to 11:59pm of the same day). Before you can generate a Force Main report, you must create a keyword for the force main and assign all the pumps that feed into the force main to the keyword. See Configuring Your System: Keywords for more information.

The Force Main report provides the following information:

- Number of pumps running simultaneously (presented as a line chart and a list)
- Pump runtime by station ordered from longest total runtime to shortest (presented as a step chart)

The report can be used to identify times when pumping efficiency decreases and energy consumption increases because too many pumps that feed into a common force main are running simultaneously. On a system running Symphony Pump and Flow Management, the report can be used to analyze how Symphony is performing and determine if any fine tuning is necessary.

Symphony is an optional upgrade to HT3. This pump and flow management software uses SCADA to coordinate the activities of wastewater pump stations operating on a common force main. Symphony replaces pump stations’ random controls with a synchronization scheme that prevents pump stations from working against each other. For more information on Symphony, visit the DFS website at www.dataflowsys.com

To create a Force Main report:

Note: The Force Main report can only be run for one day at a time.

1. Click Reports on the HT3 main menu.
2. Click Create on the Reports submenu.
3. Select Force Main for Report Type.
4. An alert box will pop up with the message "The Force Main report can only be run 1 day at a time. Only the START date is used! This report may take several seconds to generate." Click OK to close the alert.

5. For the Source, select the keyword of the force main you want to run the report on.

6. In the Start date field, select the date you want to run the report for (the Force Main report ignores the date in the End date field).

7. Click Run Report. The requested report opens in a new window. Below is an example of the report’s output.
Min Max Average Report

The Min Max Average report is designed for analyzing analog data such as pressure and flow measurements, chlorine residuals, turbidity, and tank levels.

The Min Max Average report lists daily minimum, maximum and average values recorded during the selected time span for each point included in the report.

If the point has a qualifier, only the qualified values are included in the calculation. When an analog point is configured with a qualifier, the HT3 system only gathers report data when the qualifier address (point) is on. See Configuring Your System: Adding and Configuring an Analog Point for information on adding a qualifier.
The Min Max Average report can be generated for a specific station, an individual address, multiple addresses, or a keyword grouping. We strongly suggest using keywords when generating reports to take advantage of the speed provided by cached report data. See Configuring Your System: Keywords for more information.

See also: Bar and Line Charts

**To create a Min Max Average report:**

1. Click **Reports** on the HT3 main menu.
2. Click **Create** on the Reports submenu.
3. Select **Min Max Average** for Report Type.

4. Select the report’s Source. Choose the appropriate keyword from the **Keyword** list or enter an address, list of addresses, or station name in the **Address** box.

5. Select the **Start date** and **End date** using the calendar buttons to the right of each box.

6. Click the **Run report** button. The requested report opens in a new window. For each day requested, the report provides the minimum, maximum and average values for the points included in the report.

**Modbus Map**

Modbus emulation enables the Hyper SCADA Server (HSS) to respond as a Modbus TCP client by allowing DFS-type points to be queried as registers via the Modbus TCP protocol.

To view a complete list of DFS-to-Modbus mapped points:

1. Click **Reports** on the HT3 main menu.
2. Click **Modbus Map** on the Reports submenu.

For each mapped point, the table lists station number, station name, point name, point address, Modbus device number and Modbus register. Analog registers include the point's low and high range values and unit of measurement; digital registers include the point's 0 and 1 labels.

Directly above the map on the right side is a link to a printer-friendly version of the map.

---

**Pulse Report**

The Pulse report provides daily pulse count totals for equipment (e.g., rain gauge or flow meter) that provides a pulse signal that represents a specific amount. Points selected for this report must be configured as digital pulse points (See **Configuring Your System: Adding and Configuring a Digital Pulse Point**).

The output generated for the report is based on the scale factor and pulse units configured for the point. For a pulse point with a scale factor of 1, the report will output the total number of pulses counted during the requested report period. For a point with a scale factor other than 1, the report will use the scale factor to calculate the cumulative output for the time period (e.g., rain fall or flow).

A Pulse report can be generated for a specific station, an individual address, multiple addresses, or a keyword grouping.

The Pulse report can also be generated from the **Advanced Reporting Tool**.

See also: **Bar and Line Charts**

**To create a Pulse report:**

1. Click **Reports** on the HT3 main menu.
2. Click **Create** on the Reports submenu.
3. Select **Pulse** for Report Type.
4. Select the report’s Source. Choose the appropriate keyword from the **Keyword** list or enter an address or list of addresses in the **Address** box.

- You can combine station numbers with keywords. For example, to limit the report data to only those points assigned to the keyword Rain that are located at station number 1187, you would select RAIN from the **Keyword** list and type 1187 in the **Address** box.
- To generate a report on multiple stations or telemetry addresses, enter the desired station numbers or telemetry addresses separated by commas.

The Telemetry Address structure in HT3 is as follows:

<table>
<thead>
<tr>
<th>RTU Type</th>
<th>Station #</th>
<th>Module Letter</th>
<th>Point #</th>
</tr>
</thead>
<tbody>
<tr>
<td>DFS</td>
<td>1187</td>
<td>C</td>
<td>4</td>
</tr>
<tr>
<td>Modbus</td>
<td>6018</td>
<td></td>
<td>3</td>
</tr>
</tbody>
</table>

To run a report on the DFS point above, you would enter 1187C4 in the **Address** box; to run a report on the entire station, you would enter 1187. To run a report on the Modbus point, you would enter 6018.3 in the **Address** box; to run a report on the entire station, you would enter 6018.

5. Select the **Start date** and **End date** using the calendar buttons to the right of each box.

6. Click the **Run report** button. The requested report opens in a new window. The output generated for the report is based on the **scale factor** and **pulse units** configured for the point. For a pulse point with a scale factor of 1, the report will output the total number of pulses counted during the requested report period. For a point with a scale factor other than 1, the report will use the scale factor to calculate the cumulative output (e.g., rain fall or flow).
Pump Activity Report

The Pump Activity report provides data on the activity of a digital point. This report is typically used to calculate run times and monitor behavior of pumps and wells, but it can be used for any digital point. The Pump Activity report provides highly-accurate results for DFS points, because the DFS protocol time stamps messages. A Pump Activity report can be generated for Modbus and other non-time tagged points, but it is important to note that the results will be less accurate in the absence of time stamping.

The report provides

- The minimum length of time the point was on.
- The maximum length of time the point was on.
- The average length of time the points was on.
- The total number of times the point came on.

From the report, you can view the following charts (see step 7, below):

- Pie chart showing the total runtime and total starts for each of the points.
- Bar chart of the minimum, average, and maximum run times for each of the points.
- Line chart of the point's on and off activity.

This report can be generated for a specific station, an individual address, multiple addresses, or a keyword grouping.

The Pump Activity report can also be generated from the Advanced Reporting Tool.

To create a Pump Activity report:

1. Click Reports on the HT3 main menu.
2. Click Create on the Reports submenu.
3. Select Pump Activity for Report Type.
4. Select the report’s Source. Choose the appropriate keyword from the **Keyword** list or enter an address, list of addresses, or station name in the **Address** box.

- If the stations have been named using the specific format discussed in [Choosing Station Names](#), you can enter station names in the **Address** box. Results will be returned sorted in ascending order according to the entries in the station name box.

- You can combine station numbers with keywords. For example, to limit the report data to only those points assigned to the keyword Pump that are located at station number 1187, you would select PUMP from the **Keyword** list and type 1187 in the **Address** box.

- To generate a report on multiple stations or telemetry addresses, enter the desired station numbers or telemetry addresses separated by commas.

The Telemetry Address structure in HT3 is as follows:

<table>
<thead>
<tr>
<th>RTU Type</th>
<th>Station #</th>
<th>Module Letter</th>
<th>Point #</th>
</tr>
</thead>
<tbody>
<tr>
<td>DFS</td>
<td>1187</td>
<td>C</td>
<td>4</td>
</tr>
<tr>
<td>Modbus</td>
<td>6018</td>
<td>.</td>
<td>3</td>
</tr>
</tbody>
</table>

To run a report on the DFS point above, you would enter 1187C4 in the **Address** box; to run a report on the entire station, you would enter 1187. To run a report on the Modbus point, you would enter 6018.3 in the **Address** box; to run a report on the entire station, you would enter 6018.

5. Select the **Start date** and **End date** using the calendar buttons to the right of each box.

6. Click the **Run report** button. The requested report opens in a new window. For each day requested, the report provides:

- The minimum length of time the point was on.
7. Several charts are available from the report:

Point Activity:

Place the mouse pointer over a point name to see a line chart of the point’s on and off activity during the selected time period. Click the point’s name to open the same chart in a new window.
### Activity Report

**PUMPLS Report**

From 00:00 03/15/11 To 00:00 03/15/11 Time Filter 00:00 - 24:00

March 15, 2011

<table>
<thead>
<tr>
<th>Station Name</th>
<th>Address</th>
<th>Min On Time</th>
<th>Max On Time</th>
<th>Total On Time</th>
<th>Avg On Time</th>
<th>Times On</th>
</tr>
</thead>
<tbody>
<tr>
<td>Symphony TCU 11</td>
<td>Pump 2 Status</td>
<td>00:00:03</td>
<td>00:07:16</td>
<td>00:49:56</td>
<td>00:02:42</td>
<td>62</td>
</tr>
<tr>
<td>Symphony TCU 17</td>
<td>Pump 3 Status</td>
<td>00:00:04</td>
<td>00:30:42</td>
<td>00:05:21</td>
<td>00:00:39</td>
<td>47</td>
</tr>
</tbody>
</table>

![Station Activity Chart]

**Station Activity:**

Click the station's name to view information on the activity of the points during the selected time period:

- Pie chart showing the total runtime and total starts for each of the points.
- Bar chart of the minimum, average, and maximum run times for each of the points.
- Line chart of the point's on and off activity.
Snapshot Report

The Snapshot report is designed for analyzing analog data such as water plant turbidity measurements and chlorine and PH levels.

For the selected time span, the Snapshot report returns values in 15 minute intervals for each point included in the report. The value returned is the last value recorded for the point prior to the interval.

The report returns values starting at midnight of the report’s start date and ends at midnight of the end date (or the current time if the report’s end date is the present day).

Data Sources

- The Snapshot report can be generated for an individual address, multiple addresses, or a keyword grouping.

- We strongly suggest using keywords when generating reports to take advantage of the speed provided by cached report data.

- You must use a keyword to run the report on an inverted qualifier (see Qualifiers, below).

For more information on creating and defining keywords, see Configuring Your System: Keywords.
Qualifiers

When an analog point is configured with a qualifier, the HT3 system only returns report data that was gathered when the qualifier address (point) was on. See Configuring Your System: Adding and Configuring an Analog Point for information on adding a qualifier.

- If the data source for the Snapshot report has been configured with a qualifier, only the qualified data is included in the report.
- If the data source has not been configured with a qualifier, all data is considered qualified and is included in the report.
- For turbidity measurements, where you want to see data samples for the times when a pump was off, the Snapshot report can be generated using an inverted qualifier (only return data for those times that the qualifier address was off). To generate an inverted qualifier Snapshot report, you must create a keyword with a key type of SNAPINVQ. For more information on creating and defining keywords, see Configuring Your System: Keywords.

For information on creating charts from your report, see Bar and Line Charts

To create a Snapshot report:

1. Click Reports on the HT3 main menu.
2. Click Create on the Reports submenu.
4. Select the report’s Source. Choose the appropriate keyword from the Keyword list or enter an address, list of addresses, or station name in the Address box.
5. Select the Start date and End date using the calendar buttons to the right of each box.
6. Click the Run report button. The requested report opens in a new window. For each day requested, the report provides point values in 15 minute intervals.

Station Configuration Report

The Station Configuration report lists the selected station’s settings, including its partition, polling priority, volume, each module configured at the station, and the module’s associated I/O points.

A station configuration report can also be created from the Station panel in Configuration Editor.

To view the configuration of a station:

1. Click Reports on the HT3 main menu.
2. Click Station Configuration on the Reports submenu. A table listing all configured stations opens.
3. By default, the stations are listed by station number. To list the stations by station name, click the "Station Listing" title.
4. Click the name or number of a station to view its configuration.
5. The Station Configuration report is displayed. The report includes the station's driver number, partition, offline count, retries setting, time out setting, and poll rate. Below the station information are tables containing information on each module configured at the station.

To view a printer-friendly version of the configuration, click the "Print Station Configuration" link (located at the top-right and bottom-right of the report). The printer-friendly version opens in a new window.
Advanced Reporting Functions and Topics

- **Advanced Reporting Tool** - Use the Advanced Reporting Tool to create access, alarm and control logs and radio error reports, and to use advanced features to create analog flow, derived flow, detail, pulse, and pump activity reports.

- **Bar and Line Charts** - Column (bar) charts and detail (line) charts are available from HTML-formatted reports.

- **Purge Schedules** - The data stored in HT3’s journals and logs is maintained in the active system for a limited period of time. After this time, it is moved to an archive in order to optimize hard drive space and system communication time.

Advanced Reporting Tool

Use the Advanced Reporting Tool to create access, alarm and control logs and radio error reports, and to use advanced features to create analog flow, derived flow, detail, pulse, and pump activity reports.

- **Opening the Advanced Reporting Tool**

- **Available Reports**
Using Status, Reporting and System Tools

- Overview of Report Form Fields
- Saving, Scheduling, Loading and Deleting Reports

See also Bar & Line Charts and Purge Schedules.

Opening the Advanced Reporting Tool

1. Click **Reports** on the HT3 main menu.
2. Click **Create** on the Reports submenu.
3. Click **Advanced** on the bottom of the standard report form (circled in red below).

The form for the Advance Reporting Tool opens.
Available Reports

The following reports are available from the Advanced Reporting Tool:

- **Access Log** - The Access Log report provides a chronological history of HT3 access for the specified period of time. This report lists the time access occurred or was attempted, the user name of the individual who entered the system, the action taken by the user (e.g., Login, Logout, Config), and a description of the action's result (e.g., Add/Modify User, Failed Validation [unsuccessful login attempt]).

- **Active Alarms** - Provides a listing of all current active alarms (acknowledged and unacknowledged) as well as cleared alarms that have not been acknowledged. Information provided includes time alarm occurred, type of alarm, username of the individual who acknowledged the alarm and the time the alarm was acknowledged. This report can be filtered by telemetry address.

- **Alarm Log** - Provides information on alarm activity, including the time the alarm occurred, the state that caused the alarm, and, if applicable, the user name of the individual who acknowledged the alarm. Unlike the Active Alarms report, the Alarm Log shows all alarm activity for the specified time period regardless of the alarm's current state (active, acknowledged, cleared).

- **Analog (Flow)** - The Analog Flow report is used specifically for totalizing flow measurements taken in a real-time GPM (gallons per minute) rate. The report provides average GPM and total gallons for the report period. It also provides the total time the source point's qualifier point was on. The flow signal can come from any type of station (DFS, Modbus, Motorola). This report can also output the data as MGD (millions of gallons per day).

- **Control Log** - Provides information on any control that was exercised at the selected address(es) during the specified period.

- **Derived Flow** - The Derived Flow report calculates the flow at sewage lift stations that aren’t equipped with analog flow meters. This report can be generated for any DFS radio or network station with pumps configured. The report performs its calculations using the telemetry addresses in its keyword and the volume in the station panel. The addresses can be individual pumps, which can come from any DFS module with digital inputs, or the Any Pump signal from the PCM, PCU or TCU. This report is generally used for stations with pumps that empty a well, but could also be used for pumps that fill a tank.

- **Detail** - The Detail Report generates a chronological listing of all events that occurred at the requested telemetry addresses for the specified time period. (Note: This report has the potential for being quite large. To avoid reports that are too large, limit the selection to only the needed telemetry addresses instead of generating a report on an entire station.)

- **Pulse** - The Pulse report provides daily pulse count totals for equipment (e.g., rain gauge or flow meter) that provides a pulse signal that represents a specific amount. Points selected for this report must be configured as digital pulse points (See Configuring Your System: Adding and Configuring a Digital Pulse Point). The output generated for the report is based on the scale factor and pulse units configured for the point. For a pulse point with a scale factor of 1, the report will output the total number of pulses counted during the requested report period. For a point with a scale factor other than 1, the report will use the scale factor to calculate the cumulative output for the time period (e.g., rain fall or flow).
• **Pump Activity** - The Pump Activity report provides data on the activity of a digital point. This report is typically used to calculate run times and monitor behavior of pumps and wells, but it can be used for any digital point. This report should only be used with DFS radio and network stations; data from Modbus and Motorola stations is not time stamped. The report provides: minimum length of time the point was on, maximum length of time the point was on, average length of time the points was on, and the total number of times the point came on.

• **Radio Errors** - Provides a means of analyzing and diagnosing the HT3 radio communication system. The report counts and categorizes all radio errors that occur, and provides the option of viewing a categorized analysis or a detailed chronological listing.

### Overview of Report Form Fields

The sections below, Saved Parameters, Report Selection, Report Options, and Special Features, describe in detail each of the fields on the Report Request Form.

### Saved Parameters

For reports that are run on a regular basis (daily, weekly, monthly, etc.), you can set the report parameters (type of report, telemetry address(es) for which you are creating the report, report period, etc.) and save it. The next time you want to run the report, you simply load its parameters and run it. Optionally, you can delete a report that has become obsolete.

The **Run at hour** box is an option for automatically generating a daily report at the same time each day. Enter an hour in the box using a 24-hour clock (0-23 where 0 = midnight and 23 = 11:00pm) and then save the report.

When configuring a report to run at a certain hour, it makes more sense to use relative dates in the **From** and **To** boxes. (For example, -0 for today, -1 for yesterday, or -7 for a day a week ago.)

For specific instructions on saving, loading, and deleting report properties, see Saving, Scheduling, Loading and Deleting Reports.
Report Selection

In this section, you select the type of report you want to generate. Your options are:

- **Detail** - detailed chronological listing of events
- **Derived Flow** - calculate the flow at sewage lift stations
- **Pump Activity** - information on pumping cycles
- **Analog (Flow)** - information regarding analog flow meters
- **Pulse** - totalize pulse counts for equipment, such as rain gauges or flow totalizers
- **Active Alarms** - information on current active alarms and cleared alarms that have not been acknowledged
- **Alarm Log** - information on alarm activity
- **Control Log** - information on controls
- **Access Log** - information on system access
- **Radio Errors** - information on radio errors that have occurred
- **Include Comments** (Alarm Log, Control Log, Access Log and Radio Errors reports only) - Option to include all Comment Log entries entered during the report's time span.

Report Options

Report options vary according to report type. Each of the report options are described below. To access these options, click **Report Options** on the Report Request form. Detailed information on each type of report can be found by selecting a report from the list provided in **Report Selection**, above.

In the sections below, the type of report that the option applies to is listed in parentheses after the option name.
For **Report Source**, you can enter station numbers, station names or telemetry addresses, and/or select a keyword. For more information on keywords, see Configuring Your System: Keywords. You can manually type in the telemetry addresses, or use the **Browse** button to navigate to the address and select it.

If the stations have been named using the specific format discussed in Choosing Station Names, you can enter station names in the **Report Source** box. Results will be returned sorted in ascending order according to the entries in the station name box.

To gather information on multiple stations or telemetry addresses, enter the desired station numbers or telemetry addresses separated by commas. For example, to retrieve information on stations 1, 5, and 7, enter 1,5,7 in the **Report Source** box. You can only select one address at a time using **Browse**, but you can create a comma-separated list of addresses by using **Browse** multiple times to select the desired addresses.

To retrieve information on all telemetry addresses assigned to a specific keyword, select the desired keyword from the **Keyword** drop-down list. (Note: The Derived Flow Report requires a keyword. You cannot run a Derived Flow Report on a telemetry address.)

You can also combine station numbers with keywords. For example, to retrieve information on pumps at stations 1 and 5 only, select PUMPS from the **Keyword** list and type 1,5 in the **Report Source** box.

The Telemetry Address structure in HT3 is as follows:

<table>
<thead>
<tr>
<th>RTU Type</th>
<th>Station #</th>
<th>Module Letter</th>
<th>Point #</th>
</tr>
</thead>
<tbody>
<tr>
<td>DFS</td>
<td>7</td>
<td>C</td>
<td>4</td>
</tr>
<tr>
<td>Modbus</td>
<td>10</td>
<td>.</td>
<td>3</td>
</tr>
</tbody>
</table>

To run a report on the DFS point above, you would enter 7C4 in the **Report Source** box. To run a report on the Modbus point, you would enter 10.3.

**Special Notes on the Report Source Box:**

- Entering only a station number in this box generates a report on all points at that station.
- Entering a station number and a module letter generates a report on all points at that module and station.
- Entering a station number, module letter, and point number generates a report on only that point.
- Use a comma between station numbers or telemetry addresses when making multiple entries.
- To gather information on every station and point, leave the **Report Source** box empty or type the word "ALL," and select **none** for **Keyword**.

**Keyword (All reports except Log reports)** - Select a keyword from the **Keyword** list. Keywords are logical groupings of points that allow for the selection of all of a specific type of point (for example, lift station pumps or analog flow meters). Only keywords that have been configured are available in the **Keyword** list. See Configuring Your System: Keywords for more information. (Note: The Derived Flow Report requires a keyword. You cannot run a Derived Flow Report on a telemetry address.)
Report Period (All reports)

In this section, you enter the date and/or time span of the report. The **From** and **To** boxes accept both dates and times (measured in hours).

**Special Notes on the Report Period Parameters:**

- This field has no affect on the Active Alarm report. This report always displays all currently active alarms (acknowledged and unacknowledged) as well as cleared alarms that have not been acknowledged.

- The **From** and **To** boxes can be left empty. Leaving both boxes empty causes the system to gather information from the start of the current day (today) until the present time (today).

- To generate a report for an entire day, enter the desired date in the **From** box and leave the **To** box empty.

- Date can be formatted as MM/DD/YY (for example, 07/22/01) or DD-mmm-YY, where mmm is the first three letters of the month's name (for example, 22-jul-01).

- These fields also support relative dates. For example, -1 for yesterday and -0 for today. To get a week’s worth of data, you could enter -7 in the **From** box and -1 in the **To** box.

- Omitting the year from the date causes the report to default to the current year (for example, 07/22 or 22-jul, would output data from July 22nd of the current year).

- Omitting the month causes the report to default to the current month and outputs data for the specified date (for example, /22 or 22- would output data from the 22nd day of the current month).

- If only hours are specified in the **From** and **To** boxes, today's date is assumed. Note that time filters can also be specified using the **Stop Daily Filter** and **Start Daily Filter** boxes in the **Special Features** section. For example, to get information between the hours of 7:00 am and 4:00 pm, you could enter 7 in the **From** box and 16 in the **To** box OR you could enter 7 in the **Start Daily Filter** box and 16 in the **Stop Daily Filter** box.

- To specify both a date and time, type the date, a space, and the time (for example 22-jul 15).

- If a date and time is entered in the **From** box and the **To** box is left empty, the report starts at the time and date specified in the **From** box and stops at the end of the date entered in the **From** box. For example, if 07/22 6 is entered in the **From** box and the **To** box is left empty, the report starts at July 22, 6:00 AM and ends at July 22, 11:59 PM.

- To generate a report for a specific time span of a previous date, enter the date and the start time in the **From** box and only the stop time in the **To** box. For example, you could enter 3-May 18 in the **From** box and 24 in the **To** box to generate a report that begins at 6:00 pm on May 18 of the current year and ends at midnight the same day. You could also just enter the date in the **From** box, leave the **To** box empty, and enter the start and stop times in the **Start Daily Filter** and **Stop Daily Filter** boxes.
To get information for a 24-hour period that begins at a specific time, enter the desired dates in the **From** and **To** boxes and follow the dates with the desired start and stop times. For example, to get information for the 24-hour period that began at 7:00 am on October 1 and ended at 7:00 am on October 2, you would enter 10/01 7 in the **From** box and 10/02 7 in the **To** box.

- If a date is included in the **From** box, but only an hour is entered in the **To** box, the same end date is assumed.
- Time is always a simple integer between 0 (zero) and 23. Midnight is represented by the number 0 (zero). The number 15 would represent 3:00 PM.

**Title (All reports)**

You can add a custom title to your report by typing a text string in the **Title** box. The custom title is in bold-face text and is centered near the top of HTML reports. Custom titles are left justified on text reports.

**Output [Derived Flow, Pump Activity, Analog (Flow), Pulse]**

Used for reports that span more than one day. Select **Daily** or **Totalized**. Daily produces a report that presents the data on a day-by-day basis. Totalized provides aggregate output for the time span.

**Units [Derived Flow, Analog (Flow)]**

Select **GPM** or **MGD**. **GPM** produces a report displayed in gallons per minute. **MGD** produces a report displayed in millions of gallons per day.

**Driver [Radio Errors]**

Select a driver number or "all" from the **Driver** drop-down list to filter the results of a Radio Errors report.
**Format [Radio Errors]**

Select **Summary** or **Detailed**.

- **Summary** generates a report that is listed by address and gives the total for each type of radio error (e.g., No Response, Abort Response, etc.), the total of all errors, and the off-line count and time.

- **Detailed** generates a report that is listed by time of error and gives the address at which the communication error occurred and the message that was returned (i.e., 01 or no response).

**Special Features**

The Special Features section of the Report Request Form allows you to perform actions such as including a header and date on reports, creating a text or spreadsheet file, and assigning a time filter.

To access these features, click **Special Features** on the Report Request Form.

**Display**

Select **Text** or **HTML**.

- **Text** generates a plain-text report. Text display reports automatically include the date the report was generated. *(Note: Large reports are automatically output in plain-text format.)*

- **HTML** generates a report in a table format, which includes graphics, shading, and column headers. Additional options for HTML-formatted reports are:
  - **Header** - Select this option to generate a report with a header that displays the report type.
  - **Title** - Select this option to include the title in the HTML header.
  - **Date** - Select this option to include the date the report was generated in the HTML header.
Enables you to gather data over a period of time between specific hours. The time format is 0 to 24 hours. For a report that starts at midnight, enter 0 in the Start box. For a report that ends at midnight, enter 24 in the Stop box.

Type the report's beginning hour in the Start box. Type the report's ending hour in the Stop box.

For example, you need to generate a report for the month of May for the hours between midnight and 6:00 am. You would type "05/01/01" in the Report Period From box and "05/31/01" in the Report Period To box; type "0" in the Daily Filter Start box; and type "6" in the Daily Filter Stop box.

Note that this field has no affect on the Active Alarms report, which always displays a list of all currently active alarms as well as cleared alarms that have not been acknowledged.

**Text File**

Select the Create check box in the Text File section to save your report as a text file (Note: The report is formatted as a Text display report). If this option is selected, you must type a name in the File Name box. The .txt extension is automatically added; you do not need to include it with the file name. Report files are saved on the Hyper Server Module (HSM) and can be downloaded to your workstation with HT3's file download tool. See Using System Tools: File Download (and Delete) Utility for more information.

**Spreadsheet File**

Select the Create check box in the Spreadsheet File section to save your report as a comma-delimited .csv file. Once saved, this file can be opened in any spreadsheet program. If this option is selected, you must type a name in the File Name box. The .csv extension is automatically added; you do not need to include it with the file name. Report files are saved on the Hyper Server Module (HSM) and can be downloaded to your workstation with HT3's file download tool. See Using System Tools: File Download (and Delete) Utility for more information.

**Print**

This option allows you to send your reports to a printer that has been configured as the default. Instead of pressing Ctrl-P and selecting a printer after running a report, the report will automatically be printed to the default printer when you click Run. Additionally, if you have a report set to run automatically at a specific hour of the day, you can select this option to have the report run and be printed to the default printer without any user input.

The default printer can be a Windows network printer or one shared from a PC. Contact DFS' Service Department for information on how to configure a default printer.
If you don't have a default printer configured, you can print a report at a local printer by pressing CTRL + P in Windows or Alt-P in Linux/Unix. Note that these instructions are displayed along the top of the generated report's window.

**Saving, Scheduling, Loading and Deleting Reports**

**Saving and Scheduling a Report**

1. Complete the report request form.
2. Enter a name for the report in the *Saved Parameters* box.

![Saved Parameters](image)

3. To schedule a daily report to run at a specific time each day, enter an hour between 0 and 23 in the *Run at hour* box. Otherwise, leave the box empty.

   Scheduled reports can be sent to a printer, and saved to a text or spreadsheet file.

   - To send to a printer, select the Print Text at Server option. (Contact DFS' Service Department for information on how to configure a default printer.)
   - To save a report to a text or spreadsheet file without printing it, select the Create Text File or Create Spreadsheet File option and enter a file name. Verify that the Print Text at Server option is unchecked.
   - To save a report to a text or spreadsheet file AND print it to a network printer, select the Print Text at Server option and the Create Text File or Create Spreadsheet File option and enter a file name.

4. Click *Save*. The status bar displays the message "report parameters saved as XXX," where XXX is the user-defined name of the report.

**Loading a Saved Report**

1. Click *Load* to open the *Report Builder: Load* dialog box.
2. Select a saved report and click Load. The report form is filled with the parameters of the saved report. If you would like to change any of the options, make the desired changes and then click Run to generate the report. (Note: Any changes made are not saved unless you save the report again. See Modify a Report, below.)

Modifying a Saved Report

1. Open the Report Request Form by selecting Reports on the HT3 main menu and then selecting Create on the Reports submenu. At the bottom of the Report form, click the Advanced link.


3. From the list of saved reports, select the report you want to modify and click Load.

4. Make the desired changes.

5. Click Save.

6. Click Replace to overwrite the existing saved report. The status bar displays the message "report parameters saved as XXX," where XXX is the user-defined name of the report.

Deleting a Saved Report

1. Open the Report Request Form by selecting Reports on the HT3 main menu and then selecting Create on the Reports submenu. At the bottom of the Report form, click the Advanced link.

2. On the Report Request Form, click Delete.

3. From the list of saved reports, select the report to be deleted and click Delete.

4. The status bar displays the message "XXX has been deleted" (where XXX is the user-defined name of the report that was deleted).

Bar and Line Charts

Two types of charts can be output from reports: column (bar) charts and detail (line) charts. Charts are only available from HTML-formatted reports; they cannot be output from plain-text reports. If your report is output in plain-text format because it contains a large amount of data, try reducing the time period or run the report on fewer points.
The example below shows a Pump Activity Report for all points at station 1510 that are assigned to keyword PUMP.

### Column Charts (Bar Graph)

With column charts, you can compare data from a column of a report. Column charts, or bar graphs, are available from Pump Activity, Derived Flow, Pulse, and Analog reports. In these reports, the column headings are underlined and in color instead of plain text (see the column headings Min Ontime, Max Ontime, Total Ontime in the example above).

When a column heading is clicked, a bar chart of the data from that column opens in a new window. When a report is daily rather than totalized, there are separate column headings for each day and a final set of column headings for the totals. The column heading from each section produces bar charts for the data in that section. Time increments are provided along the y-axis of the graph. The x-axis shows each column's corresponding date.

The example below shows the bar graph that results from clicking the Max Ontime heading. This chart enables you to compare the maximum amount of time each pump was running during the selected date/time span.

![Max Ontime Station 1510](image)

### Detail Charts (Line Graph)

With detail charts, you can view the detailed activity of a point. Detail charts, or line graphs, are available from Pump Activity, Derived Flow, Analog, and Detail reports. In these reports, row labels on the left side of the report are underlined and in color to indicate that a detail chart is available.
When a label is clicked, a line graph (similar to a trend) of that row's data opens in a new window. The data for each point is graphed on a separate line and is color coded for easy identification. Status labels (ON/OFF, HIGH/LOW, etc) are shown along the graph’s y-axis. Time increments are provided along the x-axis.

The example below shows the line graph that is displayed when the 15 Card Plate row label is clicked. This chart enables you to compare when each pump was running and when it was off during the selected date/time span.

![Line Graph Example](image)

**Notes on Detail Charts**

- The Detail report produces detail charts only; column charts are not available from a Detail report.
- When a report is run on multiple points, the links for detail charts are in separate row labels for each point as explained above.
- When a report covers a single point, only one detail chart is available. The link to the chart appears at the top of the "Status" column instead of in the row labels.

**Purge Schedules**

The data stored in HT3's journals and logs is maintained in the active system for a limited period of time. After this time, it is moved to an archive in order to optimize hard drive space and system communication time. Contact DFS for information on retrieving archived data.

<table>
<thead>
<tr>
<th>Data Type</th>
<th>Archived After</th>
</tr>
</thead>
<tbody>
<tr>
<td>Access log</td>
<td>1 year</td>
</tr>
<tr>
<td>Comment log</td>
<td>1 year</td>
</tr>
<tr>
<td>Journals*</td>
<td>1 year</td>
</tr>
<tr>
<td>Alarm log</td>
<td>6 months</td>
</tr>
<tr>
<td>Control log</td>
<td>3 months</td>
</tr>
<tr>
<td>Radio error log</td>
<td>14 days</td>
</tr>
</tbody>
</table>

*A Journal is created for each 24 hour period beginning at midnight. Journals contain all system data except for that stored in HT3's Logs.*
Beta Reports

This interface builds on our standard reporting interface and includes:

- One new report (Accumulator),
- Reports from the Advanced interface (Access Log, Active Alarms, Alarm Log, Control Log, and Radio Errors), and
- Several new features (start and end hour, time filter, output, units, report format, daily report option, and save report option).

Report Types:

- **Access Log** – Provides a chronological history of user access (e.g., logged in, logged out, configured a setting) during the selected time period.

- **Accumulator** – Designed to calculate a cumulative total for a PLC that stores analog data as an accumulating value and resets this figure when a maximum value is reached. The PLC could be monitoring the number of times a pump has cycled, the length of time a pump has run, or the amount of rainfall.

- **Active Alarms** – Provides a listing of all current active alarms (acknowledged and unacknowledged) as well as cleared alarms that have not been acknowledged. Information provided includes time alarm occurred, type of alarm, username of the individual who acknowledged the alarm and the time the alarm was acknowledged. You can filter this report by telemetry address.

- **Alarm Log** – Unlike the Active Alarms report, the Alarm Log shows all alarm activity regardless of the alarm’s current state (active, acknowledged, cleared). You can choose to see a list of all of the system’s active alarms or only alarms at a specific station or for a specific point.

- **Analog Flow** – Averages and totalizes analog flow meters and provides the total time the pump was on, average GPM, and total gallons

- **Control Log** – Provides information on any controls that were attempted at the selected address(es). You can generate this report for a station (or stations) or a specific point (or points).

- **Derived Flow** – Calculates the flow at sewage lift stations that aren’t equipped with analog flow meters. You can only generate this report on a TCU or PCU station.

- **Detail** – Generates a chronological listing of all events that occurred at the requested telemetry addresses for the selected time period.

- **Force Main** – Compiles data on the run status of all pumps feeding into a common force main for the selected day. You can use this report to identify times when too many pumps that feed into a common force main are running simultaneously. This causes pumping efficiency to decrease and energy consumption to increase.

- **Min Max Average** – Lists the daily minimum, maximum and average values of each point included in the report. It is designed for analyzing analog data such as pressure and flow measurements, chlorine residuals, turbidity, and tank levels.
- **Pulse** – Provides daily pulse count totals for equipment, such as rain gauges or flow totalizers, that provide a pulse signal that represents a specific amount. Points selected for this report must be configured as digital pulse points (See Configuring Your System: Adding and Configuring a Digital Pulse Point).

- **Pump Activity** – Provides data on the activity of a digital point (usually a pump). The report provides the minimum length of time the point was on, the maximum length of time the point was on, the average length of time the points was on, and the total number of times the point came on.

- **Radio Errors** – Tool for troubleshooting radio communication errors. You typically turn to this report if you start receiving large numbers of radio errors or offline alarms. The report counts and categorizes all radio errors that occur and provides either a categorized analysis or a detailed chronological listing.

- **Snapshot** – The Snapshot report is designed for analyzing analog data such as water plant turbidity measurements and chlorine and PH levels. It returns values in 15 minute intervals for each point included in the report. The value returned is the last value recorded for the point prior to the interval.

See also Opening and Deleting Saved Reports.
Access Log (Beta Reports)

The Access Log provides a chronological history of user access (e.g., logged in, logged out, configured a setting) for the selected time period.

The Access Log Report Form

Report Options and Variables

Show Comments (Optional)

The Comment Log is an electronic journal for recording notes about activities and events that affect your utility’s operation.

Select the Show Comments check box to include entries from the Comment Log in your report.

Date and Time

Enter dates manually in the Start date and End date boxes or click the calendar icon to select a date.

(Optional) Select the time you want the report to start and end by selecting hours from the Start Hour and End Hour lists. Start Hour and End Hour both default to Midnight.

Time Filter (Optional)

This filter is for reports that span several days. It allows you to limit your results to specific hours each day.
For example, to filter results to only see what happened between midnight and 6:00 a.m. each day of a seven-day report, select midnight from the **Start Hour** list and 6:00am from the **End Hour** list.

**Report Format**

- HTML – View the report in a new browser window.
- Export .csv – Create a file that can be opened in spreadsheet programs such as Microsoft Excel or OpenOffice Calc.
- Export .txt – Create a file that can be opened in any program that can read plain text files.

**Generating the Report**

1. Click **Reports** on the HT3 main menu.
2. Click **Create** on the **Reports** submenu.
3. Select **Access Log** for **Report Type**.
4. Select the desired report options and variables and click **Run Report**.

**Reading the Report**

The Access Log provides:

- Time action occurred or was attempted
- User name of the individual who performed the action
- Action taken by the user (e.g., Login, Logout, Config, Callout, Shutdown, Startup)
- Description of the action (e.g., add/modify, updated station, answered, system startup, failed validation [unsuccessful log in attempt]).
- Login (includes the name and IP address of the computer used to log in to the system. For example, 003-23F02/192.168.36.87)
- Config (includes what was added, modified, or updated. For example, Add/Modify User, Add/Modify Virtual, Updated Station)

**Saving the Report (Optional)**

For a report you run on a regular basis, you can save the report settings:

1. In the Save Report section, enter a name in the **Save** box (below the Run daily at list).
2. Click the **Save** button.

The next time you want to run this report:
1. In the Existing Reports section, select the report name from the Open list.
2. Click Open.
3. Make any desired changes (optional).

**Scheduling a Daily Report (Optional)**

You can schedule a report to run automatically at a specific time every day.

1. Open an existing report or create a new one.
2. Select a time from the Run daily at list.
3. Enter a name in the Save box.
4. Click Save.
**Accumulator (Beta Reports)**

The Accumulator report is designed to calculate a cumulative total for a PLC that stores analog data as an accumulating value and resets this figure when a maximum value is reached. The PLC could be monitoring the number of times a pump has cycled, the length of time a pump has run, or the amount of rainfall.

As data is received, the PLC adds it to the previous value. The PLC continues to add to the value (typically stored as an integer) until it reaches the maximum integer value it can store. The PLC then "rolls over" and resets the value to 0.

Although this report is designed to account for a reset, it can be used even if the PLC has not reset the value.

**How the Cumulative Total is Calculated**

The Accumulator report recognizes when a point has been reset and uses values recorded before and after the reset to calculate the cumulative total.

The report uses the point’s configured resolution and engineering values to generate the result (e.g., 6.64 for the amount of rain that fell in a month).

When reading the descriptions below, keep in mind that if **Daily Time Filters** have been selected, the report uses the values recorded between those hours if their scope is smaller than that of the **Date and Time** hours.

<table>
<thead>
<tr>
<th>No resets during report period</th>
<th>The value recorded at the beginning of the report period is subtracted from the last value recorded before the end of the report period.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Single reset during report period</td>
<td>For the time period prior to the reset, the value recorded at the beginning of the report period is subtracted from the last value recorded before the reset. This total is added to the last value recorded after the reset (and before the end of the report period).</td>
</tr>
<tr>
<td>Several resets during report period</td>
<td>Cumulative totals for each reset span are calculated using the process described in “Single reset during report period.” The sum of these totals are added to the last value recorded after the most recent reset (and before the end of the report period).</td>
</tr>
</tbody>
</table>
The Accumulator Report Form

Report Options and Variables

Source

The source for this report is the analog point in the PLC that stores the cumulative value for an event such as the number of times a pump has cycled, the length of time a pump has run, or how much rainfall has occurred.

You can run the report on a single point, a multiple point, or a keyword.

Selecting or Creating a Keyword

If you are not familiar with keywords, read the information in Configuring Your System: Keywords.

If you’ve previously created a keyword for this report type, select it from the Keyword list. Optionally, you can create a keyword in the report form itself.

Note that the keywords listed in the Keyword list are only those assigned to the currently selected report type.

Creating a Keyword from Within the Report Form

The keyword you create here will be assigned to the type of report you are creating. (If you have the Detail report form loaded and create a keyword, the keyword will be associated with the Detail report type when you view the keyword in Configuration Editor.)
1. Enter point addresses using the steps shown in Using the Address Selector to Browse to an Address or Manually Entering an Address. (Note: Only points and Modbus registers can be assigned to a keyword. You cannot assign an entire station to a keyword.)

2. Click Create Keyword.

3. Enter a name in the Keyword Name box.

4. Click Save Keyword.

   The status bar (lower left corner of the browser window) displays a “failed” or “success” message.

   The keyword is added to the Keyword list in Configuration Editor and is available for creating reports.

Using the Address Selector to Browse to an Address

1. Select a driver from the Address Selector list. A list of that driver’s stations is added to the form.

2. Select a station. A list of points for that station is added to the form. (To list points alphabetically by point name instead of address, select the Show Address Names Only option.)

3. Add the address(es):

   • To run the report on the entire station, click Add. The station is added to the Address box.

     You can add an additional station (or stations) by selecting a station from the list and clicking Add. Repeat this process until you’ve added all the desired stations. Multiple stations are displayed as a comma separated list.

   • To run the report on a particular point (or points), select a point and click Add. (Optional: To view the point list by name instead of by point address, select the Show Address Names Only box.)

     You can add another point (or points) by selecting another point and clicking Add. Repeat this process until you’ve added all the desired points. Multiple points are displayed as a comma separated list.

Show Address Names Only Option

By default, points are listed in numerical order by their point address. The name of the point is shown in parentheses [e.g., 1010A1 (Pump 1 Status)].

To list the points alphabetically by their name [e.g., Pump 1 Status], select the Show Address Names Only option. In this view, the point address is excluded.

Manually Entering an Address

Type the station number, point number, or register address in the Address box:

• Station number = driver number + three-digit station number (e.g., 4001)
• Point number = driver number + three-digit station number + module letter + point number (e.g., 1186A1)

• Register address = driver number + three-digit station number + Modbus register number (e.g., 6045.12552)

Multiple addresses are separated with a comma. For example:

• 4001,4026 to run a report on stations 1 and 26 under driver number 4

• 1186A1,1186A2,1186A3 to run a report on points 1, 2, and 3 at driver 1, station 1186, module A.

**Date and Time**

Enter dates manually in the **Start date** and **End date** boxes or click the calendar icon to select a date.

(Optional) Select the time you want the report to start and end by selecting hours from the **Start Hour** and **End Hour** lists. **Start Hour** and **End Hour** both default to Midnight.

**Daily Time Filter (Optional)**

This filter is for reports that span several days. It allows you to limit your results to specific hours each day.

For example, to filter results to only see what happened between midnight and 6:00 a.m. each day of a seven-day report, select midnight from the **Start Hour** list and 6:00am from the **End Hour** list.

**Report Format**

• **HTML** – View the report in a new browser window.

• **Export .csv** – Create a file that can be opened in spreadsheet programs such as Microsoft Excel or OpenOffice Calc.

• **Export .txt** – Create a file that can be opened in any program that can read plain text files.

**Generating the Report**

1. Click **Reports** on the HT3 main menu.

2. Click **Create** on the **Reports** submenu.

3. Select **Accumulator** for **Report Type**.

4. Select the desired report options and variables and click **Run Report**.
**Reading the Report**

The report lists:

- Point name (as defined in HT3)
- Point address
- Accumulated total (See How the Cumulative Total is Calculated)

**Saving the Report (Optional)**

For a report you run on a regular basis, you can save the report settings:

1. In the Save Report section, enter a name in the **Save** box (below the **Run daily at** list).
2. Click the **Save** button.

The next time you want to run this report:

1. In the Existing Reports section, select the report name from the **Open** list.
2. Click **Open**.
3. Make any desired changes (optional).
4. Click **Run Report**.

**Scheduling a Daily Report (Optional)**

You can schedule a report to run automatically at a specific time every day.

1. Open an existing report or create a new one.
2. Select a time from the **Run daily at** list.
3. Enter a name in the **Save** box.
4. Click **Save**.
Active Alarms (Beta Reports)

This reports list all currently active alarms (acknowledged and unacknowledged) and cleared alarms that have not been acknowledged.

Leave the Source Address box empty to see a list of all of the system’s active alarms. Filter the results by providing an address - station(s), point(s), or a combination of both.

**Note:** To view all alarm activity (not just active alarms and unacknowledged cleared alarms), run an Alarm Log Report.

The Active Alarms Report Form

---

**Report Options and Variables**

**Source (Optional)**

The settings in this section are optional for the Active Alarms report. If you do not select an address, all of the system’s active alarms are listed in the report.

Filter results to the station level or point level by manually entering an address in the Address box or using the Address Selector to browse to the address.

**Note:** You can run the report on a combination of stations and points.

**Using the Address Selector to Browse to an Address**

1. Select a driver from the Address Selector list. A list of that driver’s stations is added to the form.

2. Select a station. A list of points for that station is added to the form. (To list points alphabetically by point name instead of address, select the Show Address Names Only option.)

3. Add the address(es):
To run the report on the entire station, click **Add**. The station is added to the **Address** box.

You can add an additional station (or stations) by selecting a station from the list and clicking **Add**. Repeat this process until you’ve added all the desired stations. Multiple stations are displayed as a comma separated list.

To run the report on a particular point (or points), select a point and click **Add**. (Optional: To view the point list by name instead of by point address, select the **Show Address Names Only** box.)

You can add another point (or points) by selecting another point and clicking **Add**. Repeat this process until you’ve added all the desired points. Multiple points are displayed as a comma separated list.

**Show Address Names Only Option**

By default, points are listed in numerical order by their point address. The name of the point is shown in parentheses [e.g., 1010A1 (Pump 1 Status)].

To list the points alphabetically by their name [e.g., Pump 1 Status], select the **Show Address Names Only** option. In this view, the point address is excluded.

**Manually Entering an Address**

Type the station number, point number, or register address in the **Address** box:

- Station number = driver number + three-digit station number (e.g., 4001)
- Point number = driver number + three-digit station number + module letter + point number (e.g., 1186A1)
- Register address = driver number + three-digit station number + Modbus register number (e.g., 6045.12552)

Multiple addresses are separated with a comma. For example:

- 4001,4026 to run a report on stations 1 and 26 under driver number 4
- 1186A1,1186A2,1186A3 to run a report on points 1, 2, and 3 at driver 1, station 1186, module A.

**Report Format**

- **HTML** – View the report in a new browser window.
- **Export .csv** – Create a file that can be opened in spreadsheet programs such as Microsoft Excel or OpenOffice Calc.
- **Export .txt** – Create a file that can be opened in any program that can read plain text files.
Generating the Report

1. Click **Reports** on the HT3 main menu.
2. Click **Create** on the **Reports** submenu.
3. Select **Active Alarms** for **Report Type**.
4. Select the desired report options and variables and click **Run Report**.

Reading the Report

The Active Alarms report lists:
- All currently active alarms (acknowledged and unacknowledged)
- Cleared alarms that have not been acknowledged

The report provides:
- Time alarm occurred
- Alarm type
- For acknowledged alarms, the report lists the user name of the individual who acknowledged the alarm and the time the alarm was acknowledged.

Saving the Report (Optional)

For a report you run on a regular basis, you can save the report settings:

1. In the Save Report section, enter a name in the **Save** box (below the **Run daily at** list).
2. Click the **Save** button.

The next time you want to run this report:

1. In the Existing Reports section, select the report name from the **Open** list.
2. Click **Open**.
3. Make any desired changes (optional).
4. Click **Run Report**.

Scheduling a Daily Report (Optional)

You can schedule a report to run automatically at a specific time every day.

1. Open an existing report or create a new one.
2. Select a time from the **Run daily at** list.
3. Enter a name in the **Save** box.
4. Click **Save**.
Alarm Log (Beta Reports)

Unlike the Active Alarms report, the Alarm Log shows all alarm activity regardless of the alarm’s current state (active, acknowledged, cleared).

You can create a report that lists all of the system’s active alarms (leave Source Address box empty) or you can filter results to the station or point level.

**The Alarm Log Report Form**

![Alarm Log Report Form](image)

**Report Options and Variables**

**Source (Optional)**

The settings in this section are optional for the Alarm Log report. If you do not select an address, all of the system’s active alarms are listed in the report.

You can filter results to the station level or point level by either manually entering an address in the Address box or using the Address Selector to browse to the address.

You can also include entries from the Comment Log in your report.

**Using the Address Selector to Browse to an Address**

1. Select a driver from the Address Selector list. A list of that driver’s stations is added to the form.
2. Select a station. A list of points for that station is added to the form. (To list points alphabetically by point name instead of address, select the **Show Address Names Only** option.)

3. Add the address(es):

   - To run the report on the entire station, click **Add**. The station is added to the **Address** box.
     
     You can add an additional station (or stations) by selecting a station from the list and clicking **Add**. Repeat this process until you’ve added all the desired stations. Multiple stations are displayed as a comma separated list.

   - To run the report on a particular point (or points), select a point and click **Add**. (Optional: To view the point list by name instead of by point address, select the **Show Address Names Only** box.)
     
     You can add another point (or points) by selecting another point and clicking **Add**. Repeat this process until you’ve added all the desired points. Multiple points are displayed as a comma separated list.

**Show Address Names Only Option**

By default, points are listed in numerical order by their point address. The name of the point is shown in parentheses [e.g., 1010A1 (Pump 1 Status)].

To list the points alphabetically by their name [e.g., Pump 1 Status], select the **Show Address Names Only** option. In this view, the point address is excluded.

**Manually Entering an Address**

Type the station number, point number, or register address in the **Address** box:

- Station number = driver number + three-digit station number (e.g., 4001)

- Point number = driver number + three-digit station number + module letter + point number (e.g., 1186A1)

- Register address = driver number + three-digit station number + Modbus register number (e.g., 6045.12552)

Multiple addresses are separated with a comma. For example:

- 4001,4026 to run a report on stations 1 and 26 under driver number 4

- 1186A1,1186A2,1186A3 to run a report on points 1, 2, and 3 at driver 1, station 1186, module A.

**Show Comments (Optional)**

The **Comment Log** is an electronic journal for recording notes about activities and events that affect your utility's operation.

Select the **Show Comments** check box to include entries from the Comment Log in your report.
**Date and Time**

Enter dates manually in the **Start date** and **End date** boxes or click the calendar icon to select a date.

(Optional) Select the time you want the report to start and end by selecting hours from the **Start Hour** and **End Hour** lists. **Start Hour** and **End Hour** both default to Midnight.

**Daily Time Filter (Optional)**

This filter is for reports that span several days. It allows you to limit your results to specific hours each day.

For example, to filter results to only see what happened between midnight and 6:00 a.m. each day of a seven-day report, select midnight from the **Start Hour** list and 6:00am from the **End Hour** list.

**Report Format**

- **HTML** – View the report in a new browser window.
- **Export .csv** – Create a file that can be opened in spreadsheet programs such as Microsoft Excel or OpenOffice Calc.
- **Export .txt** – Create a file that can be opened in any program that can read plain text files.

**Generating the Report**

1. Click **Reports** on the HT3 main menu.
2. Click **Create** on the **Reports** submenu.
3. Select **Alarm Log** for **Report Type**.
4. Select the desired report options and variables and click **Run Report**.

**Reading the Report**

The Alarm Log provides:

- Time alarm occurred
- State that caused the alarm
- Username of the individual who acknowledged the alarm (if applicable)

**Saving the Report (Optional)**

For a report you run on a regular basis, you can save the report settings:

1. In the Save Report section, enter a name in the **Save** box (below the **Run daily at** list).
2. Click the Save button.

The next time you want to run this report:

1. In the Existing Reports section, select the report name from the Open list.
2. Click Open.
3. Make any desired changes (optional).

**Scheduling a Daily Report (Optional)**

You can schedule a report to run automatically at a specific time every day.

1. Open an existing report or create a new one.
2. Select a time from the Run daily at list.
3. Enter a name in the Save box.
4. Click Save.
Analog Flow (Beta Reports)

The Analog Flow report totalizes flow measurements taken in a real-time GPM (gallons per minute) rate. The flow signal can come from any type of station (DFS, Modbus, Motorola). The report also provides the total time the source point's qualifier point was on.

Output can be viewed as:

- Average GPM (gallons per minute) and total gallons for the report period, or
- Average MGD (million gallons per day) and total MGAL (millions of gallons)

**IMPORTANT:** The analog point that monitors the flow meter must be configured in GPM

**The Analog Flow Report Form**

![Image of the Analog Flow Report Form]

**Report Options and Variables**

**Source**

We strongly suggest using keywords when generating Analog Flow reports to take advantage of the speed provided by cached report data.
If you elect to not use a keyword, you can use the Address Selector or manually enter a specific station, an individual address, or multiple addresses.

**Selecting or Creating a Keyword**

If you are not familiar with keywords, read the information in Configuring Your System: Keywords.

If you’ve previously created a keyword for this report type, select it from the **Keyword** list. Optionally, you can create a keyword in the report form itself.

Note that the keywords listed in the **Keyword** list are only those assigned to the currently selected report type.

**Creating a Keyword from Within the Report Form**

The keyword you create here will be assigned to the type of report you are creating. (If you have the Detail report form loaded and create a keyword, the keyword will be associated with the Detail report type when you view the keyword in Configuration Editor.)

1. Enter point addresses using the steps shown in Using the Address Selector to Browse to an Address or Manually Entering an Address. (Note: Only points and Modbus registers can be assigned to a keyword. You cannot assign an entire station to a keyword.)

2. Click **Create Keyword**.

3. Enter a name in the **Keyword Name** box.

4. Click **Save Keyword**.

   The status bar (lower left corner of the browser window) displays a “failed” or “success” message.

   The keyword is added to the **Keyword** list in Configuration Editor and is available for creating reports.

**Using the Address Selector to Browse to an Address**

1. Select a driver from the **Address Selector** list. A list of that driver’s stations is added to the form.

2. Select a station. A list of points for that station is added to the form. (To list points alphabetically by point name instead of address, select the **Show Address Names Only** option.)

3. Add the address(es):

   - To run the report on the entire station, click **Add**. The station is added to the **Address** box.

     You can add an additional station (or stations) by selecting a station from the list and clicking **Add**. Repeat this process until you’ve added all the desired stations. Multiple stations are displayed as a comma separated list.

   - To run the report on a particular point (or points), select a point and click **Add**. (Optional: To view the point list by name instead of by point address, select the **Show Address Names Only** box.)
You can add another point (or points) by selecting another point and clicking Add. Repeat this process until you’ve added all the desired points. Multiple points are displayed as a comma separated list.

**Show Address Names Only Option**
By default, points are listed in numerical order by their point address. The name of the point is shown in parentheses [e.g., 1010A1 (Pump 1 Status)].

To list the points alphabetically by their name [e.g., Pump 1 Status], select the Show Address Names Only option. In this view, the point address is excluded.

**Manually Entering an Address**
Type the station number, point number, or register address in the Address box:

- Station number = driver number + three-digit station number (e.g., 4001)
- Point number = driver number + three-digit station number + module letter + point number (e.g., 1186A1)
- Register address = driver number + three-digit station number + Modbus register number (e.g., 6045.12552)

Multiple addresses are separated with a comma. For example:

- 4001,4026 to run a report on stations 1 and 26 under driver number 4
- 1186A1,1186A2,1186A3 to run a report on points 1, 2, and 3 at driver 1, station 1186, module A.

**Date and Time**
Enter dates manually in the Start date and End date boxes or click the calendar icon to select a date.

(Optional) Select the time you want the report to start and end by selecting hours from the Start Hour and End Hour lists. Start Hour and End Hour both default to Midnight.

**Daily Time Filter (Optional)**
This filter is for reports that span several days. It allows you to limit your results to specific hours each day.

For example, to filter results to only see what happened between midnight and 6:00 a.m. each day of a seven-day report, select midnight from the Start Hour list and 6:00am from the End Hour list.

**Output**
- Select **Daily** to create a report that shows daily totals for each point. An aggregate total is provided at the end of the report.
- Select **Totalized** to create a report that shows the aggregate total for each point over the time span.
Units

- Select **GPM** to see average gallons per minute (GPM) and total gallons.
- Select **MGD** to see average millions of gallons per day (MGD) and total millions of gallons (MGAL).

Report Format

- **HTML** – View the report in a new browser window.
- **Export .csv** – Create a file that can be opened in spreadsheet programs such as Microsoft Excel or OpenOffice Calc.
- **Export .txt** – Create a file that can be opened in any program that can read plain text files.

Generating the Report

1. Click **Reports** on the HT3 main menu.
2. Click **Create** on the **Reports** submenu.
3. Select **Analog Flow** for **Report Type**.
4. Select the desired report options and variables and click **Run Report**.

Reading the Report

Daily Output (GPM or MGD)

A report with Daily selected for the Output option lists the following information for each day of the report. Totals for each point are shown at the end of the report.

<table>
<thead>
<tr>
<th>Name</th>
<th>Name of station where source point is configured</th>
</tr>
</thead>
<tbody>
<tr>
<td>Address</td>
<td>Name of point that data was collected from (source point)</td>
</tr>
<tr>
<td>Time On</td>
<td>Total time the source point's qualifier point was on</td>
</tr>
<tr>
<td>Average GPM / Average MGD</td>
<td>Depends on Units option selected - GPM or MGD</td>
</tr>
<tr>
<td>Average MGD / Total MGAL</td>
<td>Depends on Units option selected - GPM or MGD</td>
</tr>
<tr>
<td>Total Gallons</td>
<td></td>
</tr>
</tbody>
</table>
**Totalized Output (GPM or MGD)**

A report with Totalized selected for the Output option lists the following information for the report's time span.

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of station where source point is configured</td>
</tr>
<tr>
<td>Address</td>
<td>Name of point that data was collected from (source point)</td>
</tr>
<tr>
<td>Time On</td>
<td>Total time the source point’s qualifier point was on</td>
</tr>
<tr>
<td>Average GPM / Average MGD</td>
<td>Depends on Units option selected - GPM or MGD</td>
</tr>
<tr>
<td>Average MGD / Total MGAL</td>
<td>Depends on Units option selected - GPM or MGD</td>
</tr>
<tr>
<td>Total Gallons</td>
<td></td>
</tr>
</tbody>
</table>

**Saving the Report (Optional)**

For a report you run on a regular basis, you can save the report settings:

1. In the Save Report section, enter a name in the **Save** box (below the **Run daily at** list).
2. Click the **Save** button.

The next time you want to run this report:

1. In the Existing Reports section, select the report name from the **Open** list.
2. Click **Open**.
3. Make any desired changes (optional).
4. Click **Run Report**.

**Scheduling a Daily Report (Optional)**

You can schedule a report to run automatically at a specific time every day.

1. Open an existing report or create a new one.
2. Select a time from the **Run daily at** list.
3. Enter a name in the **Save** box.
4. Click **Save**.
Control Log (Beta Reports)

This report provides information on any controls attempted during the selected time period. You can generate the report for a station, a point, multiple stations, multiple points, or a combination of these.

The Control Log Report Form

Report Options and Variables

Source

You can generate the report for a station, a point, multiple stations, multiple points, or a combination of these.

Using the Address Selector to Browse to an Address

1. Select a driver from the Address Selector list. A list of that driver’s stations is added to the form.

2. Select a station. A list of points for that station is added to the form. (To list points alphabetically by point name instead of address, select the Show Address Names Only option.)

3. Add the address(es):
   - To run the report on the entire station, click Add. The station is added to the Address box.
You can add an additional station (or stations) by selecting a station from the list and clicking Add. Repeat this process until you’ve added all the desired stations. Multiple stations are displayed as a comma separated list.

- To run the report on a particular point (or points), select a point and click Add. (Optional: To view the point list by name instead of by point address, select the Show Address Names Only box.)

You can add another point (or points) by selecting another point and clicking Add. Repeat this process until you’ve added all the desired points. Multiple points are displayed as a comma separated list.

**Show Address Names Only Option**

By default, points are listed in numerical order by their point address. The name of the point is shown in parentheses [e.g., 1010A1 (Pump 1 Status)].

To list the points alphabetically by their name [e.g., Pump 1 Status], select the Show Address Names Only option. In this view, the point address is excluded.

**Manually Entering an Address**

Type the station number, point number, or register address in the Address box:

- Station number = driver number + three-digit station number (e.g., 4001)
- Point number = driver number + three-digit station number + module letter + point number (e.g., 1186A1)
- Register address = driver number + three-digit station number + Modbus register number (e.g., 6045.12552)

Multiple addresses are separated with a comma. For example:

- 4001,4026 to run a report on stations 1 and 26 under driver number 4
- 1186A1,1186A2,1186A3 to run a report on points 1, 2, and 3 at driver 1, station 1186, module A.

**Show Comments (Optional)**

The Comment Log is an electronic journal for recording notes about activities and events that affect your utility’s operation.

Select the Show Comments check box to include entries from the Comment Log in your report.

**Date and Time**

Enter dates manually in the Start date and End date boxes or click the calendar icon to select a date.

(Optional) Select the time you want the report to start and end by selecting hours from the Start Hour and End Hour lists. Start Hour and End Hour both default to Midnight.
**Daily Time Filter (Optional)**

This filter is for reports that span several days. It allows you to limit your results to specific hours each day.

For example, to filter results to only see what happened between midnight and 6:00 a.m. each day of a seven-day report, select midnight from the **Start Hour** list and 6:00am from the **End Hour** list.

**Report Format**

- **HTML** – View the report in a new browser window.
- **Export .csv** – Create a file that can be opened in spreadsheet programs such as Microsoft Excel or OpenOffice Calc.
- **Export .txt** – Create a file that can be opened in any program that can read plain text files.

**Generating the Report**

1. Click **Reports** on the HT3 main menu.
2. Click **Create** on the **Reports** submenu.
3. Select **Analog Flow** for **Report Type**.
4. Select the desired report options and variables and click **Run Report**.

**Reading the Report**

The results of a single control are shown on two lines:

- One line shows the time the control was attempted and the state or value that the point was controlled to. Look for the word "ATMP" in the **Result** column.

- A second line indicates if the control passed or failed (along with the time and the state/value of the point). Look for the word “Failed” or “Passed” in the **Result** column.

The “user” who initiated the control is also listed:

- **Auto Control** – For an auto control, the source point of the auto control is shown in the User column.

- **Scheduled Control** – For a scheduled control, the word SCHEDULE is shown in the User column.

- **Manual Control** – For a manual control (e.g., one initiated from a custom screen), the login name of the user who initiated the control is shown in the User column.

**Saving the Report (Optional)**

For a report you run on a regular basis, you can save the report settings:
1. In the Save Report section, enter a name in the Save box (below the Run daily at list).
2. Click the Save button.

The next time you want to run this report:
1. In the Existing Reports section, select the report name from the Open list.
2. Click Open.
3. Make any desired changes (optional).

*Scheduling a Daily Report (Optional)*
You can schedule a report to run automatically at a specific time every day.

1. Open an existing report or create a new one.
2. Select a time from the Run daily at list.
3. Enter a name in the Save box.
4. Click Save.
Derived Flow (Beta Reports)

The Derived Flow report calculates the flow at sewage lift stations that aren't equipped with analog flow meters. You can generate this report for any DFS radio or network station that has pumps configured. This report is typically used for stations with pumps that empty a well, but can also be used for pumps that fill a tank.

The report performs its calculations using the pump addresses in its keyword and the volume in the station panel.

Configurations Required to Run a Derived Flow Report

For each station that you want to run a Derived Flow report on, you must:

- Calculate the station's flow volume and enter that volume in the station’s configuration. (See Configuring Your System: Adding a DFS Station for more information.)
- Create a Derived Flow keyword definition. The addresses assigned to the keyword can be:
  - Individual pumps, which can come from any DFS module with digital inputs, or
  - The Any Pump signal from the PCM, PCU or TCU.

See Configuring Your System: Keywords for more information.

Using the configured flow volume and the station's reported date, the Derived Flow report calculates the number of cycles, average inflow rate, average outflow rate, and totalizes the flow.
The Derived Flow Report Form

The report performs its calculations using the pump addresses in its [keyword] and the [volume in the station panel]. The addresses can be individual pumps, which can come from any DFS module with digital inputs, or the Any Pump signal from the PCM, PCU or TCU.

Selecting or Creating a Keyword

If you are not familiar with keywords, read the information in Configuring Your System: Keywords.

If you’ve previously created a keyword for this report type, select it from the Keyword list. Optionally, you can create a keyword in the report form itself.

Note that the keywords listed in the Keyword list are only those assigned to the currently selected report type.

Creating a Keyword from Within the Report Form
The keyword you create here will be assigned to the type of report you are creating. (If you have the Detail report form loaded and create a keyword, the keyword will be associated with the Detail report type when you view the keyword in Configuration Editor.)

1. Enter point addresses using the steps shown in Using the Address Selector to Browse to an Address or Manually Entering an Address. (Note: Only points and Modbus registers can be assigned to a keyword. You cannot assign an entire station to a keyword.)

2. Click Create Keyword.

3. Enter a name in the Keyword Name box.

4. Click Save Keyword.

The status bar (lower left corner of the browser window) displays a “failed” or “success” message.

The keyword is added to the Keyword list in Configuration Editor and is available for creating reports.

**Date and Time**

Enter dates manually in the Start date and End date boxes or click the calendar icon to select a date.

(Optional) Select the time you want the report to start and end by selecting hours from the Start Hour and End Hour lists. Start Hour and End Hour both default to Midnight.

**Daily Time Filter (Optional)**

This filter is for reports that span several days. It allows you to limit your results to specific hours each day.

For example, to filter results to only see what happened between midnight and 6:00 a.m. each day of a seven-day report, select midnight from the Start Hour list and 6:00am from the End Hour list.

**Output**

- Select Daily to create a report that shows daily totals for each point. An aggregate total is provided at the end of the report.

- Select Totalized to create a report that shows the aggregate total for each point over the time span.

**Units**

- Select GPM to see average gallons per minute (GPM) and total gallons.

- Select MGD to see average millions of gallons per day (MGD) and total millions of gallons (MGAL).
Report Format

- **HTML** – View the report in a new browser window.

- **Export .csv** – Create a file that can be opened in spreadsheet programs such as Microsoft Excel or OpenOffice Calc.

- **Export .txt** – Create a file that can be opened in any program that can read plain text files.

Generating the Report

1. Click **Reports** on the HT3 main menu.
2. Click **Create** on the **Reports** submenu.
3. Select **Derived Flow** for **Report Type**.
4. Select the desired report options and variables and click **Run Report**.

Reading the Report

**Daily Report**

A daily report displays the following information for each day of the report:

- Station Name
- Station Number
- Cycles
- Average Inflow (GPM or MGD – depending on output selected)
- Avg Pump Rate (GPM or MGD – depending on output selected)
- Total Gallons

The end of the report lists cumulative data for cycles, average inflow, average pump rate, and total gallons for the time period.

**Totalized Report**

A totalized report displays the following aggregate data for the time period:

- Station Name
- Station Number
- Cycles
- Avg Inflow  (GPM or MGD – depending on output selected)
- Avg Pump Rate  (GPM or MGD – depending on output selected)
- Total Gallons

The station name and the column labels **Cycles**, **Avg Inflow GPM**, **Avg Pump Rate GPM**, and **Total Gallons** are links that open bar charts of the data.
**Saving the Report (Optional)**

For a report you run on a regular basis, you can save the report settings:

1. In the Save Report section, enter a name in the Save box (below the Run daily at list).
2. Click the Save button.

The next time you want to run this report:

1. In the Existing Reports section, select the report name from the Open list.
2. Click Open.
3. Make any desired changes (optional).

**Scheduling a Daily Report (Optional)**

You can schedule a report to run automatically at a specific time every day.

1. Open an existing report or create a new one.
2. Select a time from the Run daily at list.
3. Enter a name in the Save box.
4. Click Save.
Detail (Beta Reports)

The Detail Report generates a chronological listing of events. It lists all events that occurred at the requested telemetry addresses for the selected time period.

The Detail Report Form

**Report Options and Variables**

**Source**

You can generate a Detail report for:

- A single address
- Multiple addresses
- A keyword grouping
- A single station*
- Multiple stations*

* This report can become quite large, especially if the report spans several days or more. Minimize the report's size by only selecting the telemetry addresses you need instead of generating the report on an entire station.
**Selecting or Creating a Keyword**

If you are not familiar with keywords, read the information in Configuring Your System: Keywords.

If you’ve previously created a keyword for this report type, select it from the **Keyword** list. Optionally, you can create a keyword in the report form itself.

Note that the keywords listed in the Keyword list are only those assigned to the currently selected report type.

**Creating a Keyword from Within the Report Form**

The keyword you create here will be assigned to the type of report you are creating. (If you have the Detail report form loaded and create a keyword, the keyword will be associated with the Detail report type when you view the keyword in Configuration Editor.)

1. Enter point addresses using the steps shown in Using the Address Selector to Browse to an Address or Manually Entering an Address. (Note: Only points and Modbus registers can be assigned to a keyword. You cannot assign an entire station to a keyword.)

2. Click **Create Keyword**.

3. Enter a name in the **Keyword Name** box.

4. Click **Save Keyword**.

   The status bar (lower left corner of the browser window) displays a “failed” or “success” message.

   The keyword is added to the Keyword list in Configuration Editor and is available for creating reports.

**Using the Address Selector to Browse to an Address**

1. Select a driver from the **Address Selector** list. A list of that driver’s stations is added to the form.

2. Select a station. A list of points for that station is added to the form. (To list points alphabetically by point name instead of address, select the **Show Address Names Only** option.)

3. Add the address(es):
   - To run the report on the entire station, click **Add**. The station is added to the **Address** box.
     - You can add an additional station (or stations) by selecting a station from the list and clicking **Add**. Repeat this process until you’ve added all the desired stations. Multiple stations are displayed as a comma separated list.
   - To run the report on a particular point (or points), select a point and click **Add**. (Optional: To view the point list by name instead of by point address, select the **Show Address Names Only** box.)
     - You can add another point (or points) by selecting another point and clicking **Add**. Repeat this process until you’ve added all the desired points. Multiple points are displayed as a comma separated list.
Show Address Names Only Option

By default, points are listed in numerical order by their point address. The name of the point is shown in parentheses [e.g., 1010A1 (Pump 1 Status)].

To list the points alphabetically by their name [e.g., Pump 1 Status], select the Show Address Names Only option. In this view, the point address is excluded.

Manually Entering an Address

Type the station number, point number, or register address in the Address box:

- Station number = driver number + three-digit station number (e.g., 4001)
- Point number = driver number + three-digit station number + module letter + point number (e.g., 1186A1)
- Register address = driver number + three-digit station number + Modbus register number (e.g., 6045.12552)

Multiple addresses are separated with a comma. For example:

- 4001,4026 to run a report on stations 1 and 26 under driver number 4
- 1186A1,1186A2,1186A3 to run a report on points 1, 2, and 3 at driver 1, station 1186, module A.

Date and Time

Enter dates manually in the Start date and End date boxes or click the calendar icon to select a date. (Optional) Select the time you want the report to start and end by selecting hours from the Start Hour and End Hour lists. Start Hour and End Hour both default to Midnight.

Daily Time Filter (Optional)

This filter is for reports that span several days. It allows you to limit your results to specific hours each day.

For example, to filter results to only see what happened between midnight and 6:00 a.m. each day of a seven-day report, select midnight from the Start Hour list and 6:00am from the End Hour list.

Report Format

- HTML – View the report in a new browser window.
- Export .csv – Create a file that can be opened in spreadsheet programs such as Microsoft Excel or OpenOffice Calc.
- Export .txt – Create a file that can be opened in any program that can read plain text files.
Generating the Report

1. Click Reports on the HT3 main menu.
2. Click Create on the Reports submenu.
3. Select Detail for Report Type.
4. Select the desired report options and variables and click Run Report.

Reading the Report

Each line in the report lists the following information for the point or Modbus register:

- **Time** - Time that the status was recorded
- **Address** - Full address: driver, station, module letter (DFS protocols only), point or Modbus register
- **Name** - User-defined name
- **Status** - Digital state or analog value
- **Raw** - Prior to HT3 version 3.0.5, data was stored as raw values (integers) and converted to floating point values. Journal data is now stored as the point’s real floating point value. Any data collected after your system was updated to version 3.0.5 will show the number 0 in the Raw column. Data collected prior to the upgrade list the integer value stored in the journal.

Saving the Report (Optional)

For a report you run on a regular basis, you can save the report settings:

1. In the Save Report section, enter a name in the Save box (below the Run daily at list).
2. Click the Save button.

The next time you want to run this report:

1. In the Existing Reports section, select the report name from the Open list.
2. Click Open.
3. Make any desired changes (optional).

Scheduling a Daily Report (Optional)

You can schedule a report to run automatically at a specific time every day.

1. Open an existing report or create a new one.
2. Select a time from the Run daily at list.
3. Enter a name in the Save box.
4. Click Save.
**Force Main (Beta Reports)**

This report compiles data on the run status of all pumps feeding into a common force main for the selected day (24-hour period that starts at midnight of the selected to day to 11:59pm of the same day).

The report can be used to identify times when pumping efficiency decreases and energy consumption increases because too many pumps that feed into a common force main are running simultaneously. On a system running Symphony Pump and Flow Management, the report can be used to analyze how Symphony is performing and determine if any fine tuning is necessary.

Symphony is an optional upgrade to HT3. This pump and flow management software uses SCADA to coordinate the activities of wastewater pump stations operating on a common force main. Symphony replaces pump stations’ random controls with a synchronization scheme that prevents pump stations from working against each other. For more information on Symphony, visit the DFS website at [www.dataflowsys.com](http://www.dataflowsys.com)

**Configurations Required to Run a Force Main Report**

Before you can generate a Force Main report, you must create a keyword for the force main. All the pumps that feed into the force main must be assigned to the keyword. See Configuring Your System: Keywords for more information.

**The Force Main Report Form**

![Force Main Report Form](image)
Report Options and Variables

Source

This report compiles data on the run status of all pumps feeding into a common force main. It requires a keyword grouping of all the pumps that feed into the force main. See Configuring Your System: Keywords for more information.

Selecting or Creating a Keyword

If you are not familiar with keywords, read the information in Configuring Your System: Keywords.

If you’ve previously created a keyword for this report type, select it from the Keyword list. Optionally, you can create a keyword in the report form itself.

Note that the keywords listed in the Keyword list are only those assigned to the currently selected report type.

Creating a Keyword from Within the Report Form

The keyword you create here will be assigned to the type of report you are creating. (If you have the Detail report form loaded and create a keyword, the keyword will be associated with the Detail report type when you view the keyword in Configuration Editor.)

1. Enter point addresses using the steps shown in Using the Address Selector to Browse to an Address or Manually Entering an Address. (Note: Only points and Modbus registers can be assigned to a keyword. You cannot assign an entire station to a keyword.)

2. Click Create Keyword.

3. Enter a name in the Keyword Name box.

4. Click Save Keyword.

The status bar (lower left corner of the browser window) displays a “failed” or “success” message.

The keyword is added to the Keyword list in Configuration Editor and is available for creating reports.

Date and Time Range

The Force Main report can only be run for a single day (a 24-hour period that starts at midnight of the selected day to 11:59pm of the same day). The report only uses the Start date.

When Force Main is selected for Report Type, the alert message shown below is displayed.
Click OK to close the message. Enter a date in the **Start date** box or click the calendar icon to select a date.

**Report Format**

- **HTML** – View the report in a new browser window.
- **Export .csv** – Create a file that can be opened in spreadsheet programs such as Microsoft Excel or OpenOffice Calc.
- **Export .txt** – Create a file that can be opened in any program that can read plain text files.

**Generating the Report**

1. Click **Reports** on the HT3 main menu.
2. Click **Create** on the **Reports** submenu.
3. Select **Force Main** for **Report Type** and click **OK** to close the Start date alert message.
4. Select the desired report options and variables and click **Run Report**.

**Reading the Report**

The Force Main report provides the following information:

- Number of pumps running simultaneously (presented as a line chart and a list).
- Pump runtime by station. This is presented as a step chart (longest total runtime to shortest).

DFS will analyze this information with you to help you optimize your system's pumping efficiency and energy consumption.
**Saving the Report (Optional)**

For a report you run on a regular basis, you can save the report settings:

1. In the Save Report section, enter a name in the **Save** box (below the **Run daily at** list).
2. Click the **Save** button.

The next time you want to run this report:

1. In the Existing Reports section, select the report name from the **Open** list.
2. Click **Open**.
3. Make any desired changes (optional).
4. Click **Run Report**.

**Scheduling a Daily Report (Optional)**

You can schedule a report to run automatically at a specific time every day.

1. Open an existing report or create a new one.
2. Select a time from the **Run daily at** list.
3. Enter a name in the **Save** box.
4. Click **Save**.
Min Max Average (Beta Reports)

The Min Max Average report is designed for analyzing analog data such as pressure and flow measurements, chlorine residuals, turbidity, and tank levels.

Use of Qualifiers

If a point has a qualifier, only the qualified values are included in the calculation. When an analog point is configured with a qualifier, the HT3 system only gathers report data when the qualifier address (point) is on. See Configuring Your System: Adding and Configuring an Analog Point for information on adding a qualifier.

The Min Max Average Report Form

![Min Max Average Report Form]

Report Options and Variables

Source

We strongly suggest using a keyword to generate the report to take advantage of the speed provided by cached report data.

If you elect to not use a keyword, you can run the Min Max Average report on a specific station, an individual address, or multiple addresses.

Selecting or Creating a Keyword

If you are not familiar with keywords, read the information in Configuring Your System: Keywords.
If you’ve previously created a keyword for this report type, select it from the **Keyword** list. Optionally, you can create a keyword in the report form itself.

Note that the keywords listed in the **Keyword** list are only those assigned to the currently selected report type.

**Creating a Keyword from Within the Report Form**

The keyword you create here will be assigned to the type of report you are creating. (If you have the Detail report form loaded and create a keyword, the keyword will be associated with the Detail report type when you view the keyword in Configuration Editor.)

1. Enter point addresses using the steps shown in Using the Address Selector to Browse to an Address or Manually Entering an Address. *(Note: Only points and Modbus registers can be assigned to a keyword. You cannot assign an entire station to a keyword.)*

2. Click **Create Keyword**.

3. Enter a name in the **Keyword Name** box.

4. Click **Save Keyword**.

   The status bar (lower left corner of the browser window) displays a “failed” or “success” message.

   The keyword is added to the **Keyword** list in Configuration Editor and is available for creating reports.

**Using the Address Selector to Browse to an Address**

1. Select a driver from the **Address Selector** list. A list of that driver’s stations is added to the form.

2. Select a station. A list of points for that station is added to the form. *(To list points alphabetically by point name instead of address, select the Show Address Names Only option.)*

3. Add the address(es):

   - To run the report on the entire station, click **Add**. The station is added to the **Address** box.

     You can add an additional station (or stations) by selecting a station from the list and clicking **Add**. Repeat this process until you’ve added all the desired stations. Multiple stations are displayed as a comma separated list.

   - To run the report on a particular point (or points), select a point and click **Add**. *(Optional: To view the point list by name instead of by point address, select the Show Address Names Only box.)*

     You can add another point (or points) by selecting another point and clicking **Add**. Repeat this process until you’ve added all the desired points. Multiple points are displayed as a comma separated list.

**Show Address Names Only Option**

By default, points are listed in numerical order by their point address. The name of the point is shown in parentheses [e.g., 1010A1 (Pump 1 Status)].
To list the points alphabetically by their name [e.g., Pump 1 Status], select the Show Address Names Only option. In this view, the point address is excluded.

**Manually Entering an Address**

Type the station number, point number, or register address in the Address box:

- Station number = driver number + three-digit station number (e.g., 4001)
- Point number = driver number + three-digit station number + module letter + point number (e.g., 1186A1)
- Register address = driver number + three-digit station number + Modbus register number (e.g., 6045.12552)

Multiple addresses are separated with a comma. For example:

- 4001,4026 to run a report on stations 1 and 26 under driver number 4
- 1186A1,1186A2,1186A3 to run a report on points 1, 2, and 3 at driver 1, station 1186, module A.

**Date and Time**

Enter dates manually in the Start date and End date boxes or click the calendar icon to select a date.

(Optional) Select the time you want the report to start and end by selecting hours from the Start Hour and End Hour lists. Start Hour and End Hour both default to Midnight.

**Report Format**

- HTML – View the report in a new browser window.
- Export .csv – Create a file that can be opened in spreadsheet programs such as Microsoft Excel or OpenOffice Calc.
- Export .txt – Create a file that can be opened in any program that can read plain text files.

**Generating the Report**

1. Click Reports on the HT3 main menu.
2. Click Create on the Reports submenu.
3. Select Detail for Report Type.
4. Select the desired report options and variables and click Run Report.

**Reading the Report**

The report lists daily minimum, maximum, and average values for each point.
Note: If a point has a qualifier, only the qualified values are included in the calculations.

**Saving the Report (Optional)**

For a report you run on a regular basis, you can save the report settings:

1. In the Save Report section, enter a name in the **Save** box (below the **Run daily at** list).
2. Click the **Save** button.

The next time you want to run this report:

1. In the Existing Reports section, select the report name from the **Open** list.
2. Click **Open**.
3. Make any desired changes (optional).
4. Click **Run Report**.

**Scheduling a Daily Report (Optional)**

You can schedule a report to run automatically at a specific time every day.

1. Open an existing report or create a new one.
2. Select a time from the **Run daily at** list.
3. Enter a name in the **Save** box.
4. Click **Save**.
Pulse (Beta Reports)

The Pulse report provides daily pulse count totals for equipment such as rain gauges and flow meters that provide a pulse signal. Points selected for this report must be configured as digital pulse points (See Configuring Your System: Adding and Configuring a Digital Pulse Point).

The Pulse Report Form

Report Options and Variables

Source

A Pulse report can be generated for a specific station, an individual address, multiple addresses, or a keyword grouping.

Selecting or Creating a Keyword

If you are not familiar with keywords, read the information in Configuring Your System: Keywords.

If you’ve previously created a keyword for this report type, select it from the Keyword list. Optionally, you can create a keyword in the report form itself.
Note that the keywords listed in the Keyword list are only those assigned to the currently selected report type.

Creating a Keyword from Within the Report Form
The keyword you create here will be assigned to the type of report you are creating. (If you have the Detail report form loaded and create a keyword, the keyword will be associated with the Detail report type when you view the keyword in Configuration Editor.)

1. Enter point addresses using the steps shown in Using the Address Selector to Browse to an Address or Manually Entering an Address, (Note: Only points and Modbus registers can be assigned to a keyword. You cannot assign an entire station to a keyword.)

2. Click Create Keyword.

3. Enter a name in the Keyword Name box.

4. Click Save Keyword.

The status bar (lower left corner of the browser window) displays a “failed” or “success” message.

The keyword is added to the Keyword list in Configuration Editor and is available for creating reports.

Using the Address Selector to Browse to an Address

1. Select a driver from the Address Selector list. A list of that driver’s stations is added to the form.

2. Select a station. A list of points for that station is added to the form. (To list points alphabetically by point name instead of address, select the Show Address Names Only option.)

3. Add the address(es):

   • To run the report on the entire station, click Add. The station is added to the Address box.

     You can add an additional station (or stations) by selecting a station from the list and clicking Add . Repeat this process until you’ve added all the desired stations. Multiple stations are displayed as a comma separated list.

   • To run the report on a particular point (or points), select a point and click Add. (Optional: To view the point list by name instead of by point address, select the Show Address Names Only box.)

     You can add another point (or points) by selecting another point and clicking Add. Repeat this process until you’ve added all the desired points. Multiple points are displayed as a comma separated list.

Show Address Names Only Option

By default, points are listed in numerical order by their point address. The name of the point is shown in parentheses [e.g., 1010A1 (Pump 1 Status)].

To list the points alphabetically by their name [e.g., Pump 1 Status], select the Show Address Names Only option. In this view, the point address is excluded.
Manually Entering an Address

Type the station number, point number, or register address in the Address box:

- Station number = driver number + three-digit station number (e.g., 4001)
- Point number = driver number + three-digit station number + module letter + point number (e.g., 1186A1)
- Register address = driver number + three-digit station number + Modbus register number (e.g., 6045.12552)

Multiple addresses are separated with a comma. For example:

- 4001,4026 to run a report on stations 1 and 26 under driver number 4
- 1186A1,1186A2,1186A3 to run a report on points 1, 2, and 3 at driver 1, station 1186, module A.

Date and Time

Enter dates manually in the Start date and End date boxes or click the calendar icon to select a date.

(Optional) Select the time you want the report to start and end by selecting hours from the Start Hour and End Hour lists. Start Hour and End Hour both default to Midnight.

Daily Time Filter (Optional)

This filter is for reports that span several days. It allows you to limit your results to specific hours each day.

For example, to filter results to only see what happened between midnight and 6:00 a.m. each day of a seven-day report, select midnight from the Start Hour list and 6:00am from the End Hour list.

Output

- Select Daily to create a report that shows daily totals for each point. An aggregate total is provided at the end of the report.
- Select Totalized to create a report that shows the aggregate total for each point over the time span.

Report Format

- HTML – View the report in a new browser window.
- Export .csv – Create a file that can be opened in spreadsheet programs such as Microsoft Excel or OpenOffice Calc.
- Export .txt – Create a file that can be opened in any program that can read plain text files.
Generating the Report

1. Click Reports on the HT3 main menu.
2. Click Create on the Reports submenu.
3. Select Pulse for Report Type.
4. Select the desired report options and variables and click Run Report.

Reading the Report

The report provides the following information for each day:

- Station Name
- Point Name
- Point Number
- Total*
- Units

*The output generated for the report is based on the point’s configured scale factor and pulse units.

- Scale factor of 1 – For a pulse point with a scale factor of 1, the report will output the total number of pulses counted during the selected report period.
- Scale factor other than 1 – For a point with a scale factor other than 1, the report will use the scale factor to calculate the cumulative output for the time period (e.g., rain fall or flow).

Saving the Report (Optional)

For a report you run on a regular basis, you can save the report settings:

1. In the Save Report section, enter a name in the Save box (below the Run daily at list).
2. Click the Save button.

The next time you want to run this report:

1. In the Existing Reports section, select the report name from the Open list.
2. Click Open.
3. Make any desired changes (optional).

Scheduling a Daily Report (Optional)

You can schedule a report to run automatically at a specific time every day.

1. Open an existing report or create a new one.
2. Select a time from the **Run daily at** list.
3. Enter a name in the **Save** box.
4. Click **Save**.
Pump Activity (Beta Reports)

The Pump Activity report provides data on the activity of a digital point. This report is typically used to calculate run times and monitor the behavior of pumps and wells, but it can be used for any digital point.

The Pump Activity report provides highly-accurate results for DFS points, because DFS-protocol messages are time stamped. A Pump Activity report can be generated for Modbus and other non-time tagged points, but it is important to note that the results will be less accurate in the absence of time stamping.

The Pump Activity Report Form

Report Options and Variables

Source

This report can be generated for a specific station, an individual address, multiple addresses, or a keyword grouping.

Selecting or Creating a Keyword

If you are not familiar with keywords, read the information in Configuring Your System: Keywords.
If you’ve previously created a keyword for this report type, select it from the **Keyword** list. Optionally, you can create a keyword in the report form itself.

Note that the keywords listed in the Keyword list are only those assigned to the currently selected report type.

### Creating a Keyword from Within the Report Form

The keyword you create here will be assigned to the type of report you are creating. (If you have the Detail report form loaded and create a keyword, the keyword will be associated with the Detail report type when you view the keyword in Configuration Editor.)

1. Enter point addresses using the steps shown in Using the Address Selector to Browse to an Address or Manually Entering an Address. *(Note: Only points and Modbus registers can be assigned to a keyword. You cannot assign an entire station to a keyword.)*

2. Click **Create Keyword**.

3. Enter a name in the **Keyword Name** box.

4. Click **Save Keyword**.

   The status bar (lower left corner of the browser window) displays a “failed” or “success” message.

   The keyword is added to the Keyword list in Configuration Editor and is available for creating reports.

### Using the Address Selector to Browse to an Address

1. Select a driver from the **Address Selector** list. A list of that driver’s stations is added to the form.

2. Select a station. A list of points for that station is added to the form. (To list points alphabetically by point name instead of address, select the **Show Address Names Only** option.)

3. Add the address(es):

   - To run the report on the entire station, click **Add**. The station is added to the **Address** box.

     You can add an additional station (or stations) by selecting a station from the list and clicking **Add**. Repeat this process until you’ve added all the desired stations. Multiple stations are displayed as a comma separated list.

   - To run the report on a particular point (or points), select a point and click **Add**. (Optional: To view the point list by name instead of by point address, select the **Show Address Names Only** box.)

     You can add another point (or points) by selecting another point and clicking **Add**. Repeat this process until you’ve added all the desired points. Multiple points are displayed as a comma separated list.

### Show Address Names Only Option

By default, points are listed in numerical order by their point address. The name of the point is shown in parentheses [e.g., 1010A1 (Pump 1 Status)].
To list the points alphabetically by their name [e.g., Pump 1 Status], select the Show Address Names Only option. In this view, the point address is excluded.

**Manually Entering an Address**

Type the station number, point number, or register address in the Address box:

- Station number = driver number + three-digit station number (e.g., 4001)
- Point number = driver number + three-digit station number + module letter + point number (e.g., 1186A1)
- Register address = driver number + three-digit station number + Modbus register number (e.g., 6045.12552)

Multiple addresses are separated with a comma. For example:

- 4001,4026 to run a report on stations 1 and 26 under driver number 4
- 1186A1,1186A2,1186A3 to run a report on points 1, 2, and 3 at driver 1, station 1186, module A.

**Date and Time**

Enter dates manually in the Start date and End date boxes or click the calendar icon to select a date. (Optional) Select the time you want the report to start and end by selecting hours from the Start Hour and End Hour lists. Start Hour and End Hour both default to Midnight.

**Daily Time Filter (Optional)**

This filter is for reports that span several days. It allows you to limit your results to specific hours each day.

For example, to filter results to only see what happened between midnight and 6:00 a.m. each day of a seven-day report, select midnight from the Start Hour list and 6:00 am from the End Hour list.

**Output**

- Select Daily to create a report that shows daily totals for each point. An aggregate total is provided at the end of the report.
- Select Totalized to create a report that shows the aggregate total for each point over the time span.

**Report Format**

- HTML – View the report in a new browser window.
- Export .csv – Create a file that can be opened in spreadsheet programs such as Microsoft Excel or OpenOffice Calc.
• **Export .txt** – Create a file that can be opened in any program that can read plain text files.

**Generating the Report**

1. Click **Reports** on the HT3 main menu.
2. Click **Create** on the **Reports** submenu.
3. Select **Pump Activity** for **Report Type**.
4. Select the desired report options and variables and click **Run Report**.

**Reading the Report**

Each row in the report lists the **Point Name** and **Address** followed by the following information:

- **Min Ontime** – Minimum length of time the point was on
- **Max Ontime** – Maximum length of time the point was on
- **Total Ontime** – Total length of time the point was on
- **Avg Ontime** – Average length of time the point was on
- **Times On** – Total number of times the point came on

The **Station Name** where the point is configured is listed above each group of points.

From the report, you can view the following charts:

- Pie chart showing the total runtime and total starts for each of the points.
- Bar chart of the minimum, average, and maximum run times for each of the points.
- Line chart of the point's on and off activity.

**Saving the Report (Optional)**

For a report you run on a regular basis, you can save the report settings:

1. In the Save Report section, enter a name in the **Save** box (below the **Run daily at** list).
2. Click the **Save** button.

The next time you want to run this report:

1. In the Existing Reports section, select the report name from the **Open** list.
2. Click **Open**.
3. Make any desired changes (optional).
4. Click **Run Report**.
**Scheduling a Daily Report (Optional)**

You can schedule a report to run automatically at a specific time every day.

1. Open an existing report or create a new one.
2. Select a time from the **Run daily at** list.
3. Enter a name in the **Save** box.
4. Click **Save**.

**Viewing Charts**

Several charts are available from the report:

- [Point Activity Line Chart for Daily Output Reports](#)
- [Station Activity](#)
- "On Time" Bar Charts for Totalized Output Reports

**Point Activity (Daily Output Reports only)**

Place the mouse pointer over a point name to see a line chart of the point’s on and off activity during the selected time period. Click the point’s name to open the same chart in a new window.
Station Activity
Click the station's name to view information on the activity of the points during the selected time period:

- Pie chart showing the total runtime and total starts for each of the points.
- Bar chart of the minimum, average, and maximum run times for each of the points.
- Line chart of each point's running and off activity.
"On Time" Bar Chart for Totalized Output Reports
Clicking a column heading (Min OnTime, Max OnTime, Total OnTime, Avg OnTime, Times On) opens a bar chart of the report data.
Radio Errors (Beta Reports)

The Radio Error report is a tool for troubleshooting radio communication errors. You typically turn to this report if you start receiving large numbers of radio errors or offline alarms.

It is also a useful tool for proactively monitoring the health of your radio communications system.

HT3 determines if a station is offline based on the communication settings configured for the station (e.g., Offline Count, Timeout, Retries). Refer to the section that covers your station type (e.g., DFS or Modbus) in Configuring Your System: Stations.

You typically generate a Radio Error report for a driver and use the Summary Format option. Detailed reports are designed for stations, modules, and points. Detailed reports are used by DFS Personnel to do high-level radio communication troubleshooting. (Note that a Detailed report on a driver returns the same results as a Summary report.)

The Radio Errors Report Form
Report Options and Variables

Source

You typically generate a Radio Error report for a driver (select a driver from the Driver list) and use the Summary Format option. You can run the report on all drivers by selecting All from the Driver list.

If you need to run a report on a station (for example, if the only errors on the report are Abort Response errors), manually enter the station number or use the Address Selector to browse to the station.

- **Manually Entering an Address**

  Type the station number in the Address box.

  Station number = driver number + three-digit station number (e.g., 4001).

- **Using the Address Selector**

  1. Select a driver from the Address Selector list. A list of that driver’s stations is added to the form.
  2. Select a station and click Add. The station is added to the Address box.

Date and Time

Enter dates manually in the Start date and End date boxes or click the calendar icon to select a date.

(Optional) Select the time you want the report to start and end by selecting hours from the Start Hour and End Hour lists. Start Hour and End Hour both default to Midnight.

Daily Time Filter (Optional)

This filter is for reports that span several days. It allows you to limit your results to specific hours each day.
For example, to filter results to only see what happened between midnight and 6:00 a.m. each day of a seven-day report, select midnight from the **Start Hour** list and 6:00am from the **End Hour** list.

**Report Format**

You typically select **Summary** for the **Format** option. Detailed reports are designed for stations, modules, and points. Detailed reports are used by DFS Personnel to do high-level radio communication troubleshooting.

- **HTML** – View the report in a new browser window.
- **Export .csv** – Create a file that can be opened in spreadsheet programs such as Microsoft Excel or OpenOffice Calc.
- **Export .txt** – Create a file that can be opened in any program that can read plain text files.

**Generating the Report**

You typically generate a Radio Error report for a driver and use the **Summary Format** option.

1. Click **Reports** on the HT3 main menu.
2. Click **Create** on the **Reports** submenu.
3. Select **Radio Errors** for **Report Type**.
4. Select a driver from the **Driver** list. (Or select **All** to run the report on all drivers in your system.)
5. Select **Summary** for the **Format** option.
6. Select any other desired report options and variables and click **Run Report**. See *Using the Radio Error Report* for information on reading and interpreting the report.

**Saving the Report (Optional)**

For a report you run on a regular basis, you can save the report settings:

1. In the Save Report section, enter a name in the **Save** box (below the **Run daily at** list).
2. Click the **Save** button.

The next time you want to run this report:

1. In the Existing Reports section, select the report name from the **Open** list.
2. Click **Open**.
3. Make any desired changes (optional).
4. Click **Run Report**.
Scheduling a Daily Report (Optional)

You can schedule a report to run automatically at a specific time every day.

1. Open an existing report or create a new one.
2. Select a time from the Run daily at list.
3. Enter a name in the Save box.
4. Click Save.

Using the Radio Error Report

First Step Establishing a Baseline

It isn’t unusual for even a properly operating radio to experience occasional radio errors. For this reason, it is useful to know the typical number of errors for each station.

To establish a baseline, run a radio error report when the station is first installed. By comparing future reports to this baseline, you can determine if the reported error counts are unusual.

Monitoring Radio Communications Health

After a baseline has been established, run a radio error report on all of your system’s drivers on a routine basis. We recommend you run the report weekly.

To run a report on your entire system, select All from the Driver list. This generates a report that lists all your system’s stations and their corresponding errors.

Compare the error counts to the baseline to determine if the reported numbers are higher than normal.

Determining the Cause of Radio Communication Problems

The Radio Error report can help you determine the cause of offline alarms and a higher-than-normal number of radio errors.

The screenshot below shows a report on driver 3. All options have been left at their default values, including the Format option. (Note that a Detailed report on a driver returns the same results as a Summary report; Detailed reports are designed for stations, modules, and points. Detailed reports are used by DFS Personnel to do high-level radio communication troubleshooting.)
The resulting report is organized by station and provides a count for each type of error that occurred at the station during the report period.

Review the report to pinpoint which station (or stations) are experiencing unusual numbers of errors. In the example below, station 3001 (highlighted in yellow) is returning a larger-than-normal number of Bad Checksum or CRC errors. These errors typically indicate a fade margin, interference, or radio hardware problem.

The report also shows 18 No Response errors, which by themselves would indicate a problem with either the radio (dead radio) or absence of power (no AC or battery power). However, because there are also Bad Message Format and Bad Checksum or CRC errors, the errors are likely the result of a fade margin, interference, or radio hardware problem.
Reading the Report and Troubleshooting Radio Communication Errors

The remedies provide in the table below are the most basic steps involved in troubleshooting radio communication errors. Although troubleshooting errors isn’t complicated, there are many variables involved in pinpointing the cause of radio communication errors.

We suggest users who are interested in learning more about this topic take our “Hyper SCADA System (HSS) Telemetry Radio Frequency (RF) Troubleshooting” course. Visit the training page of the DFS website or call our Service and Training Department to learn more.

System Wide Errors

If the errors appear at only one or a few stations, the problem is likely at the station itself. However, if the errors appear to be system wide (many or most stations are reporting errors), the problem is likely with the Central Terminal Unit (CTU) radio.

Radio Error Descriptions, Causes and Remedies

<table>
<thead>
<tr>
<th>Error</th>
<th>Description</th>
<th>Possible Causes</th>
<th>Remedies</th>
</tr>
</thead>
<tbody>
<tr>
<td>No Response</td>
<td>The station did not respond when queried by the driver.</td>
<td>If these are the only errors returned, then the problem is likely a “down” condition such as no power or a dead radio. A mixture of error types indicates a fade margin, interference, or radio hardware problem.</td>
<td>If a &quot;down&quot; condition is indicated, verify that the station has AC power and that the battery is charging properly. If power is OK, try swapping out the radio.</td>
</tr>
<tr>
<td>Abort Response</td>
<td>The station responded, but one or more of the modules at the station did not.</td>
<td>If these are the only errors returned, then the problem is likely a &quot;down&quot; condition such as a bad module. A mixture of error types indicates a fade margin, interference, or radio hardware problem.</td>
<td>If the only errors on the report are Abort Response errors, run a Radio Error report on the station to determine which module is bad. (The report returns a list of modules and their corresponding errors.) Scan the list to find the module that has a large number of errors. Visit the site and replace the module.</td>
</tr>
<tr>
<td>Bad Address Format</td>
<td>The station or module address in the response was formatted incorrectly.</td>
<td>Typically indicates a fade margin, interference, or radio hardware problem.</td>
<td>Inspect the site:</td>
</tr>
<tr>
<td>Error</td>
<td>Description</td>
<td>Possible Causes</td>
<td>Remedies</td>
</tr>
<tr>
<td>---------------------</td>
<td>------------------------------------------------------</td>
<td>--------------------------------------------------------------------------------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Bad Message Format</td>
<td>There were bad characters in the message.</td>
<td>Typically indicates a fade margin, interference, or radio hardware problem.</td>
<td>See Remedies for Bad Address Format</td>
</tr>
<tr>
<td>Bad Checksum or CRC</td>
<td>The checksum or CRC were incorrect or missing.</td>
<td>Typically indicates a fade margin, interference, or radio hardware problem.</td>
<td>See Remedies for Bad Address Format</td>
</tr>
<tr>
<td>Total Errors</td>
<td>The sum of all the errors for that station or module.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Offline Count*</td>
<td>The number of times the station or module went offline during the report period.</td>
<td>A high offline count indicates that the station or module had enough consecutive bad or no responses to repeatedly reach its offline count. This condition suggests a bad margin or a radio with a problem.</td>
<td>Check the fade margin. If the fade margin is OK, the problem is likely with the radio itself. Remove the radio and replace it with a like model and type.</td>
</tr>
<tr>
<td>Offline Time*</td>
<td>The length of time the station or module was offline during the report period.</td>
<td>See Offline Count.</td>
<td>See Offline Count.</td>
</tr>
</tbody>
</table>
* HT3 determines if a station is offline based on the communication settings configured for the station (e.g., Offline Count, Timeout, Retries). Refer to the section that covers your station type (e.g., DFS or Modbus) in Configuring Your System: Stations.
Snapshot (Beta Reports)

The Snapshot report is designed for analyzing analog data such as water plant turbidity measurements and chlorine and PH levels.

The report takes snapshots of a point's value at an interval you specify. The value it returns is the last value recorded for the point prior to the end of the interval.

Notes on Data Sources and Qualifiers

Data Sources

- We strongly suggest using a keyword when generating a Snapshot report to take advantage of the speed provided by cached report data.

- You must use a keyword to run the Snapshot report on an inverted qualifier (see Qualifiers, below).

- If you elect to not use a keyword, the report can be generated for an individual address or multiple addresses.

For more information on creating and defining keywords, see Configuring Your System: Keywords.

Qualifiers

When an analog point is configured with a qualifier, HT3 only returns report data that was gathered when the qualifier address (point) was on. See Configuring Your System: Adding and Configuring an Analog Point for information on adding a qualifier.

- If the data source for the Snapshot report is configured with a qualifier, only the qualified data is included in the report.

- If the data source is not configured with a qualifier, all data is considered qualified and is included in the report.

Inverted Qualifier

For turbidity measurements, where you want to see data samples for the times when a pump was off, the Snapshot report can be generated using an inverted qualifier (it will only return data for those times when the qualifier address was off). To generate an inverted qualifier Snapshot report, you must create a keyword with a key type of SNAPINVQ. For more information on creating and defining keywords, see Configuring Your System: Keywords.
The Snapshot Report Form

Report Options and Variables

Source
Review the information in Notes on Data Sources and Qualifiers before proceeding.

In general:

- We strongly suggest using a keyword when generating a Snapshot report to take advantage of the speed provided by cached report data.

- You must use a keyword to run the Snapshot report on an inverted qualifier.

Selecting or Creating a Keyword
If you are not familiar with keywords, read the information in Configuring Your System: Keywords.

If you’ve previously created a keyword for this report type, select it from the Keyword list. Optionally, you can create a keyword in the report form itself.

Note that the keywords listed in the Keyword list are only those assigned to the currently selected report type.
Creating a Keyword from Within the Report Form

The keyword you create here will be assigned to the type of report you are creating. (If you have the Detail report form loaded and create a keyword, the keyword will be associated with the Detail report type when you view the keyword in Configuration Editor.)

1. Enter point addresses using the steps shown in Using the Address Selector to Browse to an Address or Manually Entering an Address. (Note: Only points and Modbus registers can be assigned to a keyword. You cannot assign an entire station to a keyword.)

2. Click Create Keyword.

3. Enter a name in the Keyword Name box.

4. Click Save Keyword.

   The status bar (lower left corner of the browser window) displays a “failed” or “success” message.

   The keyword is added to the Keyword list in Configuration Editor and is available for creating reports.

Using the Address Selector to Browse to an Address

1. Select a driver from the Address Selector list. A list of that driver’s stations is added to the form.

2. Select a station. A list of points for that station is added to the form. (To list points alphabetically by point name instead of address, select the Show Address Names Only option.)

3. Add the address(es):
   - To run the report on the entire station, click Add. The station is added to the Address box.

     You can add an additional station (or stations) by selecting a station from the list and clicking Add. Repeat this process until you’ve added all the desired stations. Multiple stations are displayed as a comma separated list.

   - To run the report on a particular point (or points), select a point and click Add. (Optional: To view the point list by name instead of by point address, select the Show Address Names Only box.)

     You can add another point (or points) by selecting another point and clicking Add. Repeat this process until you’ve added all the desired points. Multiple points are displayed as a comma separated list.

Show Address Names Only Option

By default, points are listed in numerical order by their point address. The name of the point is shown in parentheses [e.g., 1010A1 (Pump 1 Status)].

To list the points alphabetically by their name [e.g., Pump 1 Status], select the Show Address Names Only option. In this view, the point address is excluded.
**Manually Entering an Address**

Type the station number, point number, or register address in the **Address** box:

- Station number = driver number + three-digit station number (e.g., 4001)
- Point number = driver number + three-digit station number + module letter + point number (e.g., 1186A1)
- Register address = driver number + three-digit station number + Modbus register number (e.g., 6045.12552)

Multiple addresses are separated with a comma. For example:

- 4001,4026 to run a report on stations 1 and 26 under driver number 4
- 1186A1,1186A2,1186A3 to run a report on points 1, 2, and 3 at driver 1, station 1186, module A.

**Date and Time**

Enter dates manually in the **Start date** and **End date** boxes or click the calendar icon to select a date.

(Optional) Select the time you want the report to start and end by selecting hours from the **Start Hour** and **End Hour** lists. **Start Hour** and **End Hour** both default to Midnight.

**Daily Time Filter (Optional)**

This filter is for reports that span several days. It allows you to limit your results to specific hours each day.

For example, to filter results to only see what happened between midnight and 6:00 a.m. each day of a seven-day report, select midnight from the **Start Hour** list and 6:00am from the **End Hour** list.

**Time Interval**

Enter the desired interval. The report defaults to 15 minutes, but any whole number is accepted.

**Report Format**

- **HTML** – View the report in a new browser window.
- **Export .csv** – Create a file that can be opened in spreadsheet programs such as Microsoft Excel or OpenOffice Calc.
- **Export .txt** – Create a file that can be opened in any program that can read plain text files.

**Generating the Report**

1. Click **Reports** on the HT3 main menu.
2. Click **Create** on the **Reports** submenu.

3. Select **Snapshot** for **Report Type**.

4. Select the desired report options and variables and click **Run Report**.

**Reading the Report**

Each row of the report lists:

- Time
- Name (point’s user-defined name)
- Address (point’s telemetry address)
- Value
- Units – (e.g., feet or %)

**Viewing Report Output as Line Chart**

Click the station name (listed directly above the first row of data) to open a line chart.

**Saving the Report (Optional)**

For a report you run on a regular basis, you can save the report settings:

1. In the Save Report section, enter a name in the **Save** box (below the **Run daily at** list).

2. Click the **Save** button.

The next time you want to run this report:

1. In the Existing Reports section, select the report name from the **Open** list.

2. Click **Open**.

3. Make any desired changes (optional).

4. Click **Run Report**.

**Scheduling a Daily Report (Optional)**

You can schedule a report to run automatically at a specific time every day.

1. Open an existing report or create a new one.

2. Select a time from the **Run daily at** list.

3. Enter a name in the **Save** box.

4. Click **Save**.
Opening and Deleting Saved Reports

Opening a Saved Report

Note: The reports listed next to the Open button are not limited to the ones that match the Report Type you selected. All saved reports are included in the list.

1. In the Existing Reports section, select a report from the Open list and click Open.

2. Make any desired changes (optional). Changes do not affect the saved version of the report unless the report is saved after changes are made.

3. Click Run Report.

Deleting a Saved Report

Note: The reports listed next to the Delete button are not limited to the ones that match the Report Type you selected. All saved reports are included in the list.
1. In the Existing Reports section, select a report from the **Delete** list and click **Delete**.

2. Click **OK** to confirm (Are you sure you wish to delete this report?).
Using System Troubleshooting and Maintenance Tools

HT3 includes tools to aid you in troubleshooting and maintaining your system. Although these tools are most effective in the hands of experienced DFS service technicians, system administrators and end users can benefit from their proper use.

HT3’s troubleshooting and maintenance tools include.

**Telemetry Traffic Tool**
The Telemetry Traffic Tool lets you monitor radio and network communications between your radio- and network-telemetry drivers, and the field hardware.

You can also control the value of digital and analog points, set polling priority, and create a communications log. The Inject feature allows DFS Technicians to troubleshoot communication and other system errors from a remote location.

**System Control Center**
The Server Control Center allows users with "Shutdown System" permission to:

- Stop and start telemetry.
- Reboot the Hyper Server Module (HSM).
- Test the Hyper SCADA Server’s (HSS) battery power.
- Reset hardware in the HSS.
- Check the status of the MySQL database and repair any errors that exist in the database tables.

These actions are necessary, for example, when hardware or software changes are made or, possibly, when troubleshooting the system. Special care and consideration should be taken when initiating these commands. Server actions should only be initiated when absolutely necessary. When telemetry is stopped, or shutdown, no polling takes place, no alarms are announced, and there is no access to data.

**File Upload Utility**
This easy-to-use utility enables you to browse your Windows workstation or network and upload one of the following types of files to your Hyper SCADA Server:

- Custom screen image
- HT3 update
- HTML image
- Custom HTML file

**File Download (and Delete) Utility**
This utility allows you to download files from the Hyper SCADA Server. This utility can also be used to delete report .csv and .txt files.

- Report .csv files (download and delete)
- Report .txt files (download and delete)
- Ladder logic .vlb files (download)
- Custom Screen images (download)
- Driver log files (download)

Module Patching Utility
HyperPatch is designed to help maintain the latest patch levels (updates to the original program) on all DFS function modules. HyperPatch can also be used to ensure that all network interface modules are running the latest program.

Ladder Manager
This utility provides statistics and tools for analyzing and organizing your ladders. It includes:

- Statistics on the ladder logic files on your system (e.g., total number of ladders, ladders not installed, ladders with duplicate points)
- List of ladder files that are installed
- List of ladder files on the server that are not installed
- List of ladder files that are in the trash
- List of ladder files that contain duplicate points

Telemetry Traffic Tool
The Telemetry Traffic Tool enables you to monitor radio and network communications between your radio- and network-telemetry drivers, and the field hardware. You can also control the value of digital and analog points, set polling priority, and create a communications log. The inject command allows DFS Technicians to troubleshoot communication and other system errors from a remote location.

See the following sections for more information:
- Opening Telemetry Traffic Tool
- Viewing Communication Status
- Injecting a Message
- Controlling a Point
- Changing Polling Priority
- Logging Communications
- Filtering Traffic
Opening the Telemetry Traffic Tool

1. Click **Tools** on the HT3 main menu.

2. Click **Traffic** on the Tools submenu.

At the bottom of the Telemetry Traffic Tool, is a **Start** button and a drop-down list of all configured drivers. Select a driver and click **Start** to view the communication status of all stations configured for the selected driver.

The Telemetry Traffic Tool includes the following utilities:

- **Inject** - Troubleshoot communication and other system errors from a remote location
- **Control** - Control a digital or analog point
- **Priority** - Change the polling priority for any configured station
- **Logging** - Create a communications log for a specific driver
- **Filter** - Use specific criteria to narrow results for telemetry traffic messages
Viewing Communication Status

1. Choose a driver from the drop-down list and click **Start**. The **Start** button becomes a **Stop** button after it is clicked. (Note: You can use the Filter tab to refine results. For example, to only see messages for a specific station or messages that contain a particular string of characters.)

2. Messages begin appearing in the pane on the left. The messages are color coded.

   - **Send** and **Repeat** messages are white. Send messages indicate that the polling message was sent to the station. Repeat indicates that the polling message is being transmitted from station to station when the station has a **Digipeat Path** configured.

   - **Reply** messages are green. A Reply message indicates that the station received the polling message and has sent its response.

   - **Error** messages are red. An Error message indicates that there is a problem with the polled station.

   - A **Send** message without a **Reply** or **Error** message indicates that the station did not respond. The system sends out another message immediately. If the station does not respond the system tries again during the next polling loop. If the station eventually goes off line, the system then polls that station every fourth polling loop.

3. Click **Stop** to end monitoring traffic or when you need to view a particular message sequence. Click **Start** to resume radio traffic monitoring. The monitor begins where it left off.
Injecting a Message

The Inject tab features the following four functions:

- **Convert** - Converts a station number into its hexadecimal equivalent and vice versa.
  1. To find the hexadecimal equivalent for a station, enter a station number in the Station box and click Convert.
  2. The hexadecimal equivalent appears in the Hex box.
  3. Follow the same procedure to find the station number for a hexadecimal, but enter the hexadecimal number in the Hex box and click Convert. The station number appears in the Station box.

- **Inject** - This is used by DFS technicians when troubleshooting the system. It allows them to remotely inject a message in order to pinpoint problems.

- **Version** - Enables you to find out what version of software this station is running.
  1. Enter the station number in the Station box and click Version.
  2. The message "your version request was sent to the driver" appears in the pane on the left.
  3. If an invalid station number is entered, the message "Error: invalid station entered" appears. Check the station number and try again.

- **Status** - Enables you to view the communication status of a particular station and module.
  1. Enter the station number and module letter in the Station and Module boxes, and click Status.
  2. The message "your status request was sent to the driver" appears in the pane on the left.
  3. If you enter an invalid module letter, the message "Error: invalid module text" appears. Check the module letter and try again.
Controlling a Point

The **Control** tab enables you to control a digital or analog point from the Telemetry Traffic Tool.

1. Enter the address (station # - module letter - point #, e.g., 17A5) of the point to be controlled in the **Address** box.

2. For a digital point, select either 0 or 1 and click **Control**.

3. For an analog control point:
   
   A. Select the **Analog** check box. The **Control Value** box (located to the right of the **Analog** check box) becomes enabled.

   B. Type the desired value in the **Control Value** box. Any value can be entered into the **Control Value** box, but will only be accepted if the point is a control point and if the value is within the range of that point.

   C. Click **Control**.

   D. An error message appears if the value is not a valid one for that point. Check the point's configuration and try again.
Changing Polling Priority

The **Priority** tab enables you to change the polling priority for any configured station.

1. Enter the number of the station whose polling priority is to be changed in the **Station** box.

2. Choose the polling priority.

   - **Out of Service** - Removes the station from the polling loop. This is useful when a station is being worked on and you don't want to receive alarms while it is off line. Polling must be reset when station is active again. If it is not reset, polling will not resume until the system is rebooted.

   - **Low** - Sets polling priority to low based on the station's configured **Low Priority Rate** (polls/loop). See [Adding a DFS Station: Priority](#) for more information.

   - **Normal** - Sets polling priority to normal (polled once per polling loop).

   - **High** - Sets polling priority to high based on the station's configured **High Priority Rate** (polls/loop). See [Adding a DFS Station: Priority](#) for more information.

   - **Very High** - Used for test purposes. Specified station is polled after each of the other stations in the loop is polled. For example, if station 1’s polling priority is set to **Very High**, polling takes places as follows:
     - Station 1
     - Station 2
     - Station 1
     - Station 3
     - Station 1
     - Station 4
     - Station 1
     - etc.

3. Click **Set**.
Logging Communications

Logging enables you to collect communications information for a particular driver over a span of time. (Note: Only one driver can be logging at a time.)

The log shows each sent and received message, and each entry in the log is time stamped using the "seconds past midnight" method. The log is created when logging is started and is constantly being written to until either logging is turned off or the configured log time expires.

Information from the logging session is saved to a text file named drvlog.txt. This text file is saved in a directory on the Hyper Server Module. The file can be downloaded to your workstation with HT3’s file download utility. See File Download Utility for more information.

Note: Each time the log is started, it overwrites the previous log. If you want to archive the current log, download it to your local machine.

To begin a logging session:

1. Enter the number of hours for which you want to collect information.
2. Select a driver from the drop-down list at the bottom of the screen.
3. Click Log. The system begins collecting information and writing it to drvlog.txt. Logging will automatically turn off when its configured log time expires.

Note: You can continue to use the other traffic tools while creating a log file. The logging operation works independently of the others. Also, you do not have to keep the Telemetry Traffic Tool open to generate a log file.
Filtering Traffic

The Traffic Filter allows you to specify criteria (for example, station number, module letter, message string) so that only the messages that meet the traffic filter criteria are displayed.

Filter looks for any messages that contain the string entered in the Traffic Filter box. Multiple strings separated by spaces can be entered in the Traffic Filter box. Any character string that appears in a message can be used as a filter. (Note: The traffic filter is case sensitive. It will not find messages that contain, for example, the string 10R if 10r is entered in the Traffic Filter box.)

For example, if you only wanted to see messages for station 10, you would enter {10 in the Traffic Filter box. If the Telemetry Traffic tool was being used to view communication status, Send messages for station 10 would appear as Send {10... Reply messages for station 10 would appear as Reply {10... Since only the Send and Reply messages for this station contain the string {10, only those messages would be displayed. If you wanted to see messages for station 10 and station 12, you would enter {10 {12 in the Traffic Filter box.

To use the filter command, enter a character string (or multiple strings separated by spaces) in the Traffic Filter box, and click Set Filter. If the Telemetry Traffic tool isn't already running, click Start.

To stop filtering messages, click Clear Filter.

System Control Center

The System Control Panel allows users with "Shutdown System” permission to stop and start telemetry, reboot the Hyper Server Module (HSM), test the Hyper SCADA Server's (HSS) battery power, and reset hardware in the HSS.

These actions are necessary, for example, when hardware or software changes are made or, possibly, when troubleshooting the system.

Special care and consideration should be taken when initiating these commands. Server actions should only be initiated when absolutely necessary. When telemetry is stopped, or shutdown, no polling takes place, no alarms are announced, and there is no access to data.
See the following sections for more information:

- Opening the System Control Panel
- Stopping Telemetry
- Starting Telemetry
- Rebooting the Hyper Server Module
- Testing the Server Battery
- Returning the Server to AC Power
- Resetting the Server Bus
- Checking the Server Database

### Opening the System Control Panel

1. Click **Tools** on the HT3 main menu.
2. Click **System** on the Tools submenu.

![System Control Panel](image)

### Stopping Telemetry

When the **Stop Telemetry** command is issued, all HT3 functions, including accessing telemetry data, polling, and registering alarm conditions, are halted. This does not affect the operating system, which continues to run while telemetry is stopped.

This command is used when software updates are made and when drivers are added or edited. It can also be initiated when troubleshooting the system.

After the **Stop Telemetry** command is issued, the System Control Panel will be unavailable until everything is completely shutdown. At that time, the System Control Panel will become active again and telemetry can be restarted using the **Start Telemetry** command.
Starting Telemetry

The **Start Telemetry** command is used to restart HT3 after a **Stop Telemetry** command has been issued.

Rebooting the Hyper Server Module

The **Reboot Server Module** command reboots the Linux operating system on the Hyper Server Module (HSM). Under normal circumstances, this command is only issued after hardware or software upgrades have been made. In rare cases, it can be used to troubleshoot the system or reset the HSM from a "bad" state (for example, if the operating system locks up).

Testing the Server Battery

The **Test Server Battery** command is used to test the condition of the Hyper Server Module's (HSM) backup battery. When the command is issued, AC power is removed and the HSM is forced to run on battery power for one minute. If the HSM successfully runs on battery power for the entire one minute, the battery test is considered "passed." If the voltage drops below a known threshold, the HSM is returned to AC power and the battery test is considered "failed." Results of the battery test are recorded in the Access Log and can be viewed by running an Access Log report. See **Advanced Reporting Tool** for more information on the Access Log report.

If, for some reason, you need to terminate the battery test before a full minute has passed, use the **Return Server to AC Power** command to manually return the HSM to AC power.

Returning the Server to AC Power

The **Return Server to AC Power** command is used to manually return the Hyper Server Module (HSM) to AC power after a battery test (**Test Server Battery** command) has been initiated. When a **Test Server Battery** command is issued, the HSM's AC power is removed and it is forced to run on battery power for one minute. (Note: If the voltage level drops below a predetermined level, AC power is reapplied.) If you need to return the HSM to AC power before the battery test is completed, you can issue the **Return Server to AC Power** command.

Resetting the Server Bus

The **Reset Server Bus** command resets the hardware that is located on the bus in the Hyper SCADA Server (HSS). This hardware includes, but is not limited to, Network Switch Modules, Network Fiber Modules, and Fiber Interface Modules. This command is used when troubleshooting the system and should only be initiated by DFS personnel or by those who have obtained instruction directly from DFS' service and technical support team.
Checking the Server Database

This utility allows you to view the status of all tables in the database and also to repair any tables that are in error.

To run this utility, select **Check Server Database** and click OK. After a few seconds, a page listing the status of each table will be displayed (see the example below).

Below the name of each table, is a status message.

- "Status: OK" indicates that the table contains no errors
- "Warning: 1 clients is using or hasn’t closed the table properly" is not an error. It simply indicates that there is a client currently connected to the table.

If the table contains errors, the error will be listed under the table name and HT3 will attempt to repair it. After the table has been repaired, the window will update to show the table's status as OK.

File Upload Utility

HT3’s easy-to-use file upload utility allows you to browse your Windows workstation or network, and upload one of the following file types to your Hyper Server Module (HSM):

- Custom screen image
- HT3 update
- HTML image
- Custom HTML file
- TCU AutoCFG (auto configuration) file
Note: There are no special permissions requirements for uploading files. Any valid HT3 account can use this utility.

See the following sections for more information:

- Opening the File Upload Utility
- Uploading a Screen Image
- Uploading an HTML Image
- Uploading a Custom HTML File
- Uploading a TCU AutoCFG file

Opening the File Upload Utility

1. Click **Tools** on the HT3 main menu.
2. Click **Upload** on the Tools submenu.

Uploading a Custom Screen Image

HT3 features a library of images for use in custom screens created with Screen Builder, but you can also create your own images or obtain images from other sources, such as the Internet. Image files can be uploaded to the image library using HT3’s Upload tool.

- Images can be .gif, .jpg or .png files.

- Image filenames **must not** contain spaces. Use a dash (-) or underscore (_) in file names. For example, filled-tank.png

- Filenames **must be no more than 21 characters** not including the dot and filename extension - .gif, .jpg, .png (total of 25 characters including the dot and filename extension)

After you've uploaded your custom screen images, you can use Screen Builder's **Image Picker** to organize them by placing them in categories that you create.

1. Open the file upload utility.
2. Click **Custom Screen Images**. The **Upload** dialog box opens.
3. Click Browse to open the Choose File dialog box.

4. From the Choose File dialog box, browse your system for the desired image file. Select the file and click Open.

5. The file's path appears in the File box. Click Submit.

6. Information on the file transfer is displayed (name, size, type, success of upload).

**Uploading an HTML Image**

HT3 offers you the flexibility of linking from custom screens created with Screen Builder to custom HTML files created with another application. In order to do this, your HTML files and any images used within them must be uploaded to the Hyper Server Module. HT3 accepts any image file type that is supported by Internet browsers.

1. [Open the file upload utility](#).

2. Click HTML Images. The Upload dialog box opens.

3. Click Browse to open the Choose File dialog box.

4. From the Choose File dialog box, browse your system for the desired image file. Select the file and click Open.

5. The file's path appears in the File box. Click Submit.

6. Information on the file transfer is displayed (name, size, type, success of upload).
Uploading a Custom HTML File

HT3 offers you the flexibility of linking from custom screens created with Screen Builder to custom HTML files created with another application. In order to do this, your HTML files and any images used within them must be uploaded to a directory on the Hyper Server Module.

1. Open the file upload utility.
2. Click Custom HTML Pages. The Upload dialog box opens.

3. Click Browse to open the Choose File dialog box.
4. From the Choose File dialog box, browse your system for the desired HTML file. Select the file and click Open.
5. The file's path appears in the File box. Click Submit.
6. Information on the file transfer is displayed (name, size, type, success of upload).

Uploading a TCU Auto-Download Configuration File

An AutoCFG file stores a TCU pump controller configuration in a special format and allows it to be broadcast to a specified TCU when the TCU is powered up in Auto Download mode. This allows installation of a new or replacement TCU with only minimal user interaction. An installer can replace a TCU with a new one (factory default settings), power it up, and have the configuration automatically download over the radio link. For more information on creating an AutoCFG file, see PLC Editor.

1. Open the file upload utility.
2. Click TCU Auto-Download Configuration File. The Upload dialog box opens.

3. Click Browse to open the Choose File dialog box.
4. From the Choose File dialog box, browse your system for the desired TCU AutoCFG file. Select the file and click Open.
5. The file's path appears in the File box. Click Submit.
6. The screen displays the message "File transfer successful" along with information on the file submitted (file name, size, and type).
The AutoCFG file is now stored on the server and will automatically be sent to the corresponding TCU when that TCU is powered up with the "3" on the keypad held down.

**File Download (and Delete) Utility**

HT3’s easy-to-use file download utility allows you to download files from the Hyper Server Module (HSM) to your local Windows workstation. This utility is also used to delete report files (.csv and .txt files) from the HSM. The following files can be downloaded and/or deleted:

- Report .csv files (download and delete)
- Report .txt files (download and delete)
- Ladder logic .vlb files for ladders that have been installed on the server (download only)
- Custom screen images (download only)
- Driver log files (download only)

For more information on generating reports and creating .csv and .txt files, see [Creating and Viewing Reports](#). For more information on creating ladder logic files, see [Virtual Logic Builder](#). For more information on creating driver log files, see [Telemetry Traffic Tool: Logging Communications](#).

**Note:** There are no special permissions requirements for downloading files. Any valid HT3 account can use this utility.

See the following sections for more information:

- **Opening the File Download Utility**
- **Downloading a File**
- **Downloading a Custom Screen Image**
- **Deleting a Report File**

**Opening the File Download Utility**

1. Click **Tools** on the HT3 main menu.
2. Click **Download** on the Tools submenu.
Files available for download are listed. (Note: If a file type does not exist on the HSM, the heading for that file type does not appear in the list. For example, if there are no driver log files, the heading "Driver Log" does not appear on the screen.)

## Downloading a Report File

**Note:** If you left click the file name of a report (.csv or .txt) or a driver log file, the file will be displayed in the HT3 window. Report .csv files will be displayed in a spreadsheet if a spreadsheet program is installed on your computer. Otherwise, the report will be displayed as plain text. Clicking a ladder logic (.vlb) file will simply open a file download prompt.

1. **Open the file download utility.**
2. Right click the name of the file to be downloaded. Select **Save Target As...** from the pop-up menu.
3. In the **Save As** dialog box, select the folder you wish to save the file in. You can change the file name or leave it at the default.

4. Click **Save**.

5. In the **Download Complete** dialog box, click **Open** (to open the file), **Open Folder** (to open the folder that the file was saved in), or **Close** (to close the dialog box).

---

**Downloading a Custom Screen Image**

All of the images in your Custom Screen library are available for download from your HT3 server. Image files are uploaded to the server with the **File Upload Utility**.

1. **Open the file download utility**.
2. Click the "Download Custom Screen Images" link.

3. The Download Custom Screen Images page opens in a new window. If you have used Screen Builder's Image Picker to organize your images, they will be displayed under the category headings you assigned them to.

4. Right click the image you want to download. Select **Save image as** from the pop-up menu to save the image to your computer.

**Deleting a Report File**

**IMPORTANT:** A deleted file cannot be recovered. Make sure that you're deleting the correct file when following this procedure. Ladder logic (.vlb) files cannot be deleted using this utility. Use Virtual Logic Builder or the Ladder Manager.

1. Open the file download utility.
2. Click the delete link that is next to the file you want to remove.
3. The message "Delete (filename)? Are you sure?" appears. Click Yes to delete the file. Click No to cancel.

4. The deleted file is removed from the file list.

Module Patching Utility

A patch is a piece of code that updates the module's original executable program. HT3’s module patching tool is designed to help maintain the latest patch levels on all DFS function modules. The module patch tool can also be used to ensure that all network interface modules are running the latest program.

With the module patch tool you can patch or update all of your remote modules from any Windows computer that has been configured as an HT3 client. There is no need to visit the site to update the module's program.

**IMPORTANT**: Module patching should only be undertaken by qualified personnel. For this reason, patching is typically done by DFS Service Department employees. For assistance in patching modules yourself, contact DFS at 321-259-5009.

To install or remove a module patch, or update the program on a network interface module, you must be logged in to HT3 with an account with Configure Telemetry permission. You must also enter the correct Security password when prompted. The Security password adds an additional layer of security to ensure that non-authorized personnel don’t patch or update modules.

The module patch tool includes the following:

- **Module Database** - Provides information on all configured modules in your system, including module type, serial number, and patch level.

- **Traffic Monitor** - View communication traffic (sent and received messages) for a selected driver.

- **Patches** - Displays a list of patches available for import and patches that have been imported and are ready for use. From here you can import new patches and delete imported patches that are obsolete.
• **Nim** - Provides a simple way to update the program on any network interface modules in your system.

• **Logs** - Displays important information, including logins, patches updated or removed, and error messages.

The module patch tool also features the following utilities:

• **Reload Database** - Provides you with a manual way of refreshing the module patch database.

• **Check Status** - Provides you with a way of checking the status of a process if you leave and then return to the module patch tool.

• **Set Retry Count** - Allows you to configure how many times the server attempts to communicate with a module.

See the following sections for more information:

- Opening the Module Patching Tool
- Importing Patches
- Deleting Imported Patches
- Determining if a Module Requires Patching
- Updating a Patch
- Removing a Patch
- Updating a NIM
- Viewing Communication Status
- Viewing the Patch Log
- Reloading the Database
- Checking the Status of a Patch Process
- Setting the Retry Count

---

**Opening the Module Patching Tool**

1. Click **Tools** on the HT3 main menu.
2. Click **Patch** on the Tools submenu.
Across the top of the patching tool are the following menus:

**Actions**
- Query
- Update
- Remove Patch
- Abort

**Tools**
- Reload Database
- Check Status
- Set Retry Count

**Select**
- All
- None
- Needs Patching
- By Module
- By Module Type

Below the menus, are the following tabs:

- **Module Database** - View a list of all modules in your system and determine which need patching.
- **Traffic Monitor** - A pared down version of HT3’s Telemetry Traffic Tool that enables you to view the communication status of all stations configured for the selected driver.
- **Patches** - Import new patches from the Hyper Server Module’s "New Patches" directory to the appropriate patching directory (based on patch type).
- **Nim** - Update the program of selected network interface modules.
- **Logs** - View a history of all module patching activity.
Importing Patches

Before the module patch tool can determine if a module requires patching and initiate the patching process, the new patch must exist in the appropriate directory.

After new patches are released by DFS, they are downloaded to a patch "clearinghouse" directory on the Hyper Server Module (HSM). This is a holding area that contains patches that haven't been imported into their corresponding directories. There is a unique directory for each module based on its type (e.g., ACM001, AMM002, DCM003, etc.) and its Rom date. When patches are created, they are installed on older model modules and incorporated into the program for newer models.

When a query is executed to determine if a new patch is available, the module patch tool examines the module's current patch and compares it to patches located in its corresponding patch directory. Additionally, before a module can be patched, the new patch must be imported from the "clearinghouse" directory into the appropriate patch directory for that module type and Rom date.

To import patches:

1. Click the Patches tab. Patches currently stored in the HSM's patch "clearinghouse" directory are listed under New patches waiting for import.

   ![Screenshot of Patches tab]

2. Select one or more patches and click Import. The selected patch(es) are moved from New patches waiting for import to Imported patches ready for use.

   Use the keyboard’s Shift key to select a range of patches. Use the Ctrl key to select multiple individual patches.

   **IMPORTANT:** Files can be corrupted during a download. If a corrupt patch is uploaded to a module, the module may not function properly. To ensure that the patch is error free, the module patch tool checks it before importing it. If the module patch tool finds any errors, it will display an error message. If this occurs, contact DFS so that a new copy of the patch can be downloaded to your HSM.
Deleting Imported Patches

Once a patch has been imported and applied to all affected modules and the modules are functioning properly, it is safe to delete older patches. We recommend that you keep the two latest patches for each module type. If it became necessary to remove the newest patch from a module, you could then easily step the module back to its previous state. Deleting older patches on a regular basis preserves disk space on the HSM.

To delete a patch, click the Patches tab and select the desired patch in the Imported patches ready for use list and click Delete.

If you discover at a future date that you need the deleted patch, contact DFS to have the patch re-downloaded to your HSM. You can then import the downloaded patch and apply it to affected modules.

Determining if a Module Requires Patching

Before you can perform a query to see if any of your system's modules need patching, ensure that all new patches have been imported. See Importing Patches for more information.

The module patch tool compares the module's current patch level to patches in the Imported patches ready for use list to determine if a new patch is available for the module.

**IMPORTANT**: It may take the module patch tool several hours to perform a query to see which modules need patching. This time will vary depending on how many modules you are querying. For this reason, we recommend that you begin this process at the end of the day and let it run over night.

1. Click the Module Database tab.
A table listing all configured modules and their characteristics appears on screen. The patching data is sorted first by station number and then by module letter. Stations are sorted numerically from lowest to highest. In the **Module** column, modules R and Q appear first, followed by modules A - O, which are sorted alphabetically. Modules are sorted in this manner because of the order in which modules must be patched when a PLC or SCU is involved.

- **Station** - Station number to which the module belongs.
- **Module** - Module's address.
- **Defined** - The module type as defined in the configuration database.
- **Physical** - The module's physical type. This is what the module responds as when polled for version. The physical type is the actual module type and, therefore, is used when determining what patches to install for that module. When N/A appears in the **Physical** column, it means that the module has not been polled for version, and its physical type has not yet been stored in the patch database.
- **Serial Number** - Each module is assigned a serial number before leaving the factory. This data is used for tracking and organizing purposes only. It is not involved in the patching process.
- **Rom** - The ROM level of the module. ROM (read-only memory) contains the original program for that particular module. Each module patch is specific to a ROM version. The data in the **Rom** field is used to determine what patches are available for the module. N/A indicates that this module has not been polled for version, and its ROM version has not yet been stored in the patch database.
- **Patch** - The current patch level of the module. This data is checked against the most recent patches to determine if a new patch is available for this ROM version. N/A indicates that either the module has not been polled for version and its patch version has not yet been stored in the patch database, or the module has no patch on it.
- **Needs Patching** - Indicates if the module needs patching. This is determined by comparing the module's current patch to the latest patches available in the system. A N in this field indicates that the module has the latest patch. A dash (-) signifies that the module patch tool cannot determine if a patch is available because the Module Database has not yet been queried. A Y in this field indicates that a new patch is available for this module.

1. [Select the modules to be queried. This can be done in several ways.](#)

- Click a row to select a single module
- Use your keyboard's Shift key to select multiple, consecutive rows
- Use your keyboard's Ctrl key to select multiple, nonconsecutive rows
- Use the **Select** menu. From this menu you can choose:
  - **All** - Select every row in the table.
  - **None** - Clear all selections.
  - **By Module** - Select every module in the table at a certain module address.
  - **By Module Type** - Select every module in the table of a certain module type.
  - **Needs Patching** - Select all entries that have been determined to need patching (the letter Y is listed in the **Needs Patching** column).
3. Once a selection has been made, choose **Query** from the **Actions** menu. The module patch tool's status bar lets you know exactly what is happening with the server. The status field, bottom left of the module patch tool's window, indicates what the server is doing right now. The possible states are **Idle**, **Query**, and **Update**. When the system is idle, any function can be performed. When it is in the query or update state, only the following functions can be performed:

- Stop the current query or update using the **Abort** command.
- Force the module patch tool to check the patch server for status using the **Check Status** command.
- View communications traffic using the module patch tool's **Traffic Monitor**.

The progress bar, located to the right of the status field, "fills" from left to right as the current operation is executed. (Note: In large operations, this may take quite some time, and the bar may appear as if it is not moving.) The progress bar can be used to determine the estimated time of completion so that you can exit the module patch tool and check back later to see the query's progress.

To the right of the progress bar is a "working" indicator. This indicator flashes the word "working" in red text when the server is communicating to the driver(s).

When the module patch tool finishes its query, a Y is listed in the **Needs Patching** field for each module for which there is a patch available. You are now ready to apply any available patches to their corresponding modules. See **Updating a Patch**.

### Updating a Patch

Once you have determined which modules require patching (see **Determining if a Module Requires Patching** for more information), you are ready to apply all the necessary patches.
Before starting an update, it may be useful to note the module's current patch level as listed in the Patch column. If for some reason you need to remove the patch, you will know what the module's state was before it was patched.

Under the best circumstances, patching a single module can take approximately 5 minutes. Patches are sent via radio, which means that a limited amount of information can be sent in each message. This requires that patch data be sent as a series of messages. Patching a single module or a handful of modules will not adversely affect polling time. However, if more than a few modules are being patched at one time, polling time may be affected. For this reason, we recommend that patching be done at off-peak times or over night.

**IMPORTANT:** Only one type of module can be patched at a time. You cannot patch RIM006s at the same time you are patching AMM002s. If more than one type of module requires patching, select all of those type (for example, all of your RIM006s) and patch them.

1. Open the Module Patching utility.
2. Click the Module Database tab.
3. Select the modules to be updated. This can be done several ways.
   - Click a row to select a single module
   - Use your keyboard's Shift key to select multiple, consecutive rows
   - Use your keyboard's Ctrl key to select multiple, nonconsecutive rows
   - Use the Select menu. From this menu you can choose:
     - **All** - Select every row in the table.
     - **None** - Clear all selections.
     - **Needs Patching** - Select all entries that have been determined to need patching (Y in Needs Patching column).
     - **By Module** - Select every module in the table at a certain module address.
     - **By Module Type** - Select every module in the table of a certain module type.
4. Choose Update from the Action menu and enter the Security password when prompted. The module patch tool's status bar shows that it is in update mode and flashes the message "Working." The progress bar indicates how far the patching process has progressed. To halt the patching process, choose **Abort** from the Action menu. See Important Information Regarding Abort, below.
5. When patching is complete, the module patch tool returns to idle, the progress bar clears, the "Working" message disappears, and the module database reloads. For the modules being patched, verify that all of the Y’s in the Needs Patching column have become N’s. If any have not changed, view the module patch tool’s log. A pass/fail entry is made for each module. For those modules listed as failed, attempt the patching process again. It may be helpful to use the Traffic Monitor to verify that the module is responding.

**Important Information Regarding Abort**

- Once the patching process has started, any existing patches on the module are removed.
- If an **Abort** is issued while patching a single module, the result will be that the module has no patch.
• If you were patching multiple modules that had been patched at some previous date, some of the modules would have the new patch, some would remain at previous patch level, and one module would have no patch.

• If the modules you were patching had never been patched (nothing listed for them in the Patch column), some modules would have the new patch, and the rest would remain unchanged.

• If you have to abort, first issue a query on the modules that you were patching to determine their current state and take any necessary corrective actions (for example, select the modules that did not receive the patch and attempt to patch them again). To perform a query, select Query from the Action menu.

Removing a Patch

The module patch tool gives you the ability to remove a patch. This may be necessary if the module does not function properly after a patch is applied.

**IMPORTANT:** Reverting a module to its previous state is a two step process if the module had previously been patched. You must first remove the current patch and then update the module to its previous patch. This is necessary because when a patch is applied to a module, it removes the previous patch before installing itself. The previous patch must then be reapplied to revert the module to its prior state.

1. Open the Module Patching utility.
2. Click the Module Database tab.
3. Select the module(s) whose patches are to be removed. This can be done several ways.
   • Click a row to select a single module
   • Use your keyboard's Shift key to select multiple, consecutive rows
   • Use your keyboard's Ctrl key to select multiple, nonconsecutive rows
   • Use the Select menu. From this menu you can choose:
     • All - Select every row in the table.
     • None - Clear all selections.
     • By Module - Select every module in the table at a certain module address.
     • By Module Type - Select every module in the table of a certain module type.
4. Choose Remove from the Action menu and enter the Security password when prompted. The module patch tool's status bar shows that it is in update mode and flashes the message "Working." The progress bar indicates how far the removal process has progressed. To halt the removal, choose Abort from the Action menu. See Important Information Regarding Abort, below.
5. When removal is complete, the module patch tool returns to idle, the progress bar clears, the "Working" message disappears, and the module database reloads. For the modules having patches removed, verify that all of the N's in the Needs Patching column have become Y's or dashes (-). If any have not changed, view the module patch tool's log. A pass/fail entry is made for each module. For those modules listed as failed, attempt the removal process again. It may be helpful to use the Traffic Monitor to verify that the module is responding.

**Important Information Regarding Abort**
- Once the removal process has started, any existing patches on the module are removed.
- If an abort is issued while removing a patch from a single module, the result will be that the module has no patch.
- If you were removing patches from multiple modules that had been patched at some previous date, some of the modules would have no patch and some would remain at their previous patch level.
- If you have to abort, first issue a query on the modules that you were removing patches from to determine their current state and take any necessary corrective actions (for example, select the modules that did not have their patches removed and attempt to remove the patches again). To perform a query, select **Query** from the **Action** menu.

**Updating a NIM**

The programs on the network interface modules that enable them to perform such functions as converting serial data to network data (tunneling), can be updated via the module patch tool.

1. **Open the Module Patching utility**.
2. Click the **NIM** tab.

<table>
<thead>
<tr>
<th>Actions</th>
<th>Tools</th>
<th>Selected</th>
</tr>
</thead>
<tbody>
<tr>
<td>Module Database</td>
<td>Traffic Monitor</td>
<td>Patches</td>
</tr>
<tr>
<td>Available NIM Files</td>
<td>Configure NIM Settings</td>
<td>NIM Directory</td>
</tr>
</tbody>
</table>

`NIMinstup`  
Tunnel - 2250  
Tunnel - 2000

The module patch tool's NIM section is divided into three parts:
- **Available NIM Files** - Lists all NIM files that are stored on the HSM. Click Refresh to get an up-to-date listing of all available files. Select a file and click Delete to remove the file from the HSM.

- **Configured NIM Stations** - Lists all configured NIM stations in your telemetry system. Update is used to copy the selected Nim file to the selected Nim Station.

- **NIM Directory** - Lists all files on the selected NIM. Select a station from the Configured Nim Stations list and click Directory Check. A list of files currently loaded on the network interface module is listed.

Below these columns are the **Refresh**, **Delete**, **Update** and **Directory Check** buttons.

3. From the **Available NIM Files** list, select the file(s) you want to upload to the network interface module.

4. From the **Configured NIM Stations** list, select the network interface modules to which you want to upload the file(s). Only one module can be updated at a time.

   Verify that you have the correct files and correct module selected. Once an update has started, it can not be halted.

5. Click **Update** and enter the Security password when prompted.

   A NIM update should take approximately 10-15 seconds. After 10-15 seconds, perform a **Directory Check** on the module to verify that the update was successful. The module patch tool's log will show the date and time that the update was initiated.

### Viewing Communication Status Using the Traffic Monitor

At the bottom of the Traffic Monitor, is a **Start** button and a drop-down list of all configured drivers. Selecting a driver and clicking **Start**, enables you to view the communication status of all stations configured for the selected driver.

1. Choose a driver from the drop-down list and click **Start**. The **Start** button becomes a **Stop** button after it is clicked.

2. Messages begin appearing in the pane on the left. The messages are color coded.

   - Send and Repeat messages are white. Send messages indicate that the polling message was sent to the station. Repeat indicates that the polling message is being transmitted from station to station when the station has a Digipeat Path configured.

   - Reply messages are green. A Reply message indicates that the station received the polling message and has sent its response.

   - Error messages are red. An Error message indicates that there is a problem with the polled station.
A Send message without a Reply or Error message indicates that the station did not respond. The system sends out another message immediately. If the station does not respond the system tries again during the next polling loop. If the station eventually goes off line, the system then polls that station every fourth polling loop.

3. Click **Stop** to end monitoring traffic or when you need to view a particular message sequence. Click **Start** to resume radio traffic monitoring. The monitor begins where it left off.

### Viewing the Module Patch Tool's Log

The module patch tool's Log displays important activity that has occurred, including logins, patches performed or removed, network interface module updates, and other useful information.

The log maintains 1000 lines of activity. As the event log grows, the oldest items are deleted.

To view the module patch tool's event log, click the **Log** tab.

![Log Tab](image)

### Reloading the Database

The **Reload Database** command (choose **Reload Database** from the **Actions** menu) provides you with a manual way of refreshing the module patch tool's module database. If you have added stations or modules during the current HT3 session, they will not appear in the **Module Database** list until you reload the database. Logging out of HT3 and logging back in will also refresh the **Module Database** list.

### Checking the Status of a Patch Process

If you start a patch or removal process, leave the module patch tool and then return while the module patch tool is still in the middle of a process, the Module Database will display the message "server is busy and cannot respond." Additionally, the status bar will not be responsive.
To check the status of a process, choose **Check Status** from the **Actions** menu. The module patch tool will activate the status bar - the "Update" message will appear, progress bar will fill to show how far the process has progressed, and the "Working" message will flash. Note that the Module Database will not be reloaded. It will continue to display the message "server is busy and cannot respond."

## Setting the Retry Count

The **Set Retry Count** command is used to adjust the number of times the module patch tool attempts to communicate with a module.

1. Choose **Set Retry Count** from the **Actions** menu.

   ![Set Retry Count dialog box](image1)

2. The dialog box shows the current setting (displays the message "Retries currently set to X"). Additionally, the number at the top of the drop-down list is the current setting (therefore, that number will appear in the list twice).

   ![Set Retry Count dialog box](image2)

3. The default retry setting is 2 (two). To change the retry count, select a number from the drop-down list and click **OK**.

## Ladder Manager

This utility provides statistics and tools for analyzing and organizing your ladders.

To open the ladder manager:

1. Click **Tools** on the HT3 main menu.
2. Click **Manage Ladders** on the Tools submenu.

The ladder manager includes:
- **Virtual Point Search**
- **Ladder statistics**
- **List of installed ladders**
- **Ladders with duplicate points defined**
- **List of ladders on the server that are not installed**
- **List of ladders in the trash**

## Virtual Point Search

Enter the name of a virtual point and click **Submit** to see a list of all ladders that contain the point (the search is *not* case sensitive). The list includes a link to download the ladder logic file.

![Virtual Point Search](image)

## Ladder Statistics

![Ladder Stats](image)

This section of the ladder manager lists:

- Total number of ladder files
- Number of **installed ladders**
- Number of **ladders that are not installed**
- Number of **ladders with duplicate point definitions**
- Number of **ladders in the trash**
Installed Ladders

This section provides a list of all the ladders that are installed on your system.

Click the ladder’s name to download a copy of the ladder logic file that can be opened in Logic Builder.

Ladders that are not installed

This section provides a list of all the ladders that have been uninstalled. When a ladder is uninstalled, the points generated by the ladder are removed from the system’s database when a telemetry restart occurs, but a copy of the ladder itself is kept on the server.

You can move the ladder to the trash by selecting the check box next to the ladder name and then clicking the Move to Trash button.

To download a copy of the ladder logic file, click the ladder’s name. The downloaded ladder logic file can be opened in Logic Builder.

Ladders with duplicate points defined

Note: This section will only display if there are ladders that meet this condition.
This section lists ladder files that contain duplicate points. The section lists the ladder names and the names of the duplicate points.

Duplicate points may occur if you've created a backup copy of a ladder or created two or more similar ladders for testing purposes.

You have the option to move a duplicate ladder to the trash, but you should analyze the ladders before doing this to ensure you send the correct ladder to the trash. If you move an installed ladder to the trash, you may encounter problems or unexpected behavior after a telemetry restart. During a telemetry restart, data and points for uninstalled and trashed ladders are removed from the system's database.

**Trash**

This section lists ladders that have been uninstalled and moved to the trash. To restore one or more ladders (move to the "Ladders that are not installed" section), select the check box next to the each of the ladders' names and then click **Restore Ladders**.

Once a ladder has been restored, you can download it from the "Ladders that are not installed" section.
Part VI
The Pump Control Unit (PCU) is a microprocessor-based, solid-state, multi-pump controller that is designed as a self-contained, stand-alone unit. The PCU provides all the functions necessary to monitor and control sewage lift stations and fresh-water tank filling operations.

PCU Editor enables you to modify the operational set points of the PCU from the central computer or a networked workstation.

Start with PCU Editor's default values, values from a saved PCU configuration file or values uploaded from an already-configured PCU; modify the values to meet the specific needs of the PCU being configured; and save the new configuration to a file and/or download them to the PCU.

For more information on the PCU, refer to the *Pump Control Unit Installation and Operation Manual* (available for download from the DFS website: www.dataflowsys.com).

- Introduction
- Getting Around PCU Editor
- Configuring a PCU
- Saving a PCU Configuration
- Downloading and Uploading PCU Configurations
- Editing a Configuration
Introduction

The Pump Control Unit (PCU) is a microprocessor-based, solid-state, multi-pump controller that is designed as a self-contained, stand-alone unit. The PCU provides all the functions necessary to monitor and control sewage lift stations and fresh-water tank filling operations.

PCU Editor enables you to modify the operational set points of the PCU from the central computer or a networked workstation.

Start with PCU Editor's default values, values from a saved PCU configuration file or values uploaded from an already-configured PCU; modify the values to meet the specific needs of the PCU being configured; and save the new configuration to a file and/or download them to the PCU.

For more information on the PCU, refer to the *Pump Control Unit Installation and Operation Manual* (available for download from the DFS website: [www.dataflowsys.com](http://www.dataflowsys.com)).

Opening PCU Editor

**Note:** To configure a PCU with PCU Editor, you must be logged in to HT3 with an account that has Configure Telemetry permission. See "Configuring Your System: User Accounts" in the *HT3 User Guide* for more information on permissions.

Click "Build" on the top-level HT3 menu.

Click "PCU Editor" on the Build submenu. PCU Editor opens in a new browser window.
Getting Around PCU Editor

- **The User Interface**
- **Menus**
- **Configuration Options**

**The User Interface**

PCU Editor's interface includes the following:

- **Menu Toolbar** - Features the following menus: **File**, **Edit**, **PCU** and **Help**. Choose a menu item to view its corresponding commands.

- **Configuration Options** - Features the following PCU configuration options: **Configuration Name/Lock**, **Comments**, **Pumps**, **Control**, **Transducer**, **Enable**, **Aux Delay**, **Aux Trigger**, **Aux Alarm**, **Fault Cycle**, **Auxiliary Delay in Seconds**, and **Configurable Values**.

- **Message Bar** - Displays messages, such as prompting messages and error messages, that provide you with additional information and instructions on PCU Editor functions. (Located at the bottom of the PCU Editor interface.)
Menus

File Menu

The File menu features the following commands:

- **New** - Reset PCU Editor's current configuration options to the default values.
- **Open** - Open an existing PCU configuration file.**
- **Save** - Save the active PCU configuration with the current file name.**
- **Save As** - Save the active PCU configuration and assign it a file name. (See File Naming Conventions for important information on creating filenames for your configurations.)**
- **Exit** - Exit PCU Editor.

**Note:** Valid File Locations for important information on opening and saving files.
Edit Menu

The Edit menu features the following commands:

- **Cut** - Remove the selected text and place it on the clipboard.
- **Copy** - Copy the selected text and place it on the clipboard.
- **Paste** - Insert the clipboard contents at the cursor location.
- **Delete** - Permanently remove the selected text.

PCU Menu

The PCU menu features the following commands:

- **Driver** - Specify a driver number and driver host for uploads and downloads. All subsequent uploads and downloads reference this driver number and host until you use this command to change them.

- **Upload** - Upload an existing PCU configuration file from the PCU hardware to PCU Editor. You are prompted for the station number and module letter of the PCU you want to upload the file from. The driver number can be included when entering the station number. For example, 1234 for Station Address 234 on Driver 1.

- **Download** - Download the current PCU configuration file to the PCU hardware. You are prompted for the station number of the PCU to which you want to download the configuration. The driver number can be included when entering the station number. For example, 1234 for Station Address 234 on Driver 1.

Help Menu

The Help menu features the following commands:

- **About** - Gives you information on the version of PCU Editor being run. This information is displayed in the Message bar.

- **Browse Help** - Launches PCU Editor’s online documentation.

- **Test Server** - Tests communication with the server. Use this command if the server seems slow or if you are having difficulty uploading or downloading PCU configuration files. Results are displayed in the Message bar.

- **Reclaim Memory** - Reclaims memory from the cache and returns it to the operating system. Use this command when your system seems sluggish. Results are displayed in the Message bar.
Configuration Options
The configuration options below are listed in alphabetical order.

Auxiliary Alarm

The **Aux Alarm** setting defines when to activate the Auxiliary Alarm: does the alarm horn and/or light activate during the **High** or **Low** input state.

Auxiliary Delay

If implemented, the timer delays the action of opening (turning off) or closing (turning on) the auxiliary output.

- **On** delays the action of turning on (closing) the auxiliary output.
- **Off** delays the action of turning off (opening) the auxiliary output.

The length of the delay is set in **Auxiliary Delay in Seconds**. This can be used to control any piece of hardware, including a pump, alarm light or horn, or a chlorinator. See Auxiliary Output.

Auxiliary Delay in Seconds

The length of time that output is delayed when it changes state (turns On or Off as set in **Aux Delay**). **Auxiliary Delay in Seconds** can be set between zero and 510 seconds. A setting of zero creates continual output; there is no delay time.

Auxiliary Trigger
This option works in conjunction with Auxiliary Output.

- When Aux Trigger is Closed, the state of the auxiliary output follows the state of the auxiliary input.

- If Aux Trigger is Open, the relationship is inverted (the state of the auxiliary output is the opposite of the auxiliary input).

Comments

Comments allows you to add notes to the file that briefly describe the configuration. For example, if different configurations are used in the dry season and the rainy season, you could note which season this configuration is for. Comments are not downloaded to the PCU; they are only stored in the file that holds the configuration.

Configurable Values

<table>
<thead>
<tr>
<th>Configurable Values</th>
<th>Value</th>
<th>Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Module</td>
<td>A</td>
<td></td>
</tr>
<tr>
<td>Xdcr Height</td>
<td>0.0</td>
<td>FT</td>
</tr>
<tr>
<td>Xdcr Low</td>
<td>0.0</td>
<td>FT</td>
</tr>
<tr>
<td>Xdcr High</td>
<td>0.0</td>
<td>FT</td>
</tr>
<tr>
<td>Low Alarm</td>
<td>0.0</td>
<td>FT</td>
</tr>
<tr>
<td>Off</td>
<td>0.0</td>
<td>FT</td>
</tr>
<tr>
<td>Lead</td>
<td>0.0</td>
<td>FT</td>
</tr>
<tr>
<td>Lag 1</td>
<td>0.0</td>
<td>FT</td>
</tr>
<tr>
<td>Lag 2</td>
<td>0.0</td>
<td>FT</td>
</tr>
<tr>
<td>Hi Alarm</td>
<td>0.0</td>
<td>FT</td>
</tr>
</tbody>
</table>

Module

Module address of the PCU. In most instances, the PCU is configured as Module A because it is the only module-type hardware located at a wet well site. This address must match the address configured in Configuration Editor (see the HT3 User Guide for more information).

Xdcr Height (Ultrasonic transducers only)

Not currently being used.

Xdcr Low (Analog transducers only)

Water level at which the transducer is delivering a 1 volt or 4 miliamp signal to the PCU. This is measured in feet and ranges from zero to 60 feet (in one-tenth foot increments). The PCU uses this value in calculating the well or tank level.

Xdcr High (Analog transducers only)
Water level at which the transducer is delivering a 5 volt or 20 miliamp signal to the PCU. This is measured in feet and ranges from zero to 60 feet (in one-tenth foot increments). The PCU uses this value in calculating the well or tank level. (Note: This level can be less than the Xder Low level when using transducers that provide signals that decrease when the measured distance increases.)

**Low Alarm (Analog transducers only)**
- For control Up (pump up) mode this is the level above which pumps are started and alarms are activated. This level must be set below all other levels.
- For control Down (pump down) mode this is the level below which pumps are shut down and alarms are activated. This level must be set below all other levels.

**Off (Analog transducers only)**
- For control Up (pump up) mode this is the desired maximum operational tank level. The PCU stagger-stops all pumps when the tank level rises above Off.
- For control Down (pump down) mode this is the desired minimum operational well level. The PCU shuts down all pumps when the well level drops below Off.

**Lead (Analog transducers only)**
- For control Up (pump up) mode this is the level below which the PCU starts the Lead, or first, pump.
- For control Down (pump down) mode this is the level above which the PCU starts the Lead, or first, pump.

**Lag 1 (Analog transducers only)**
Note: This setting is for duplex (two-pump) and triplex (three-pump) stations only.
- For control Up (pump up) mode this is the level below which the PCU starts the Lag 1, or second, pump.
- For control Down (pump down) mode this is the level above which the PCU starts the Lag 1, or second, pump.

**Lag 2 (Analog transducers only)**
Note: This setting is for triplex (three-pump) stations only.
- For control Up (pump up) mode this is the level below which the PCU starts the Lag 2, or third, pump.
- For control Down (pump down) mode this is the level above which the PCU starts the Lag 2, or third, pump.

**Hi Alarm (Analog transducers only)**
- For control Up (pump up) mode this is the level below which the PCU starts all three pumps and activates alarms. This level must be set above all other levels.
- For control Down (pump down) mode this is the level above which the PCU starts all three pumps and activates alarms. This level must be set above all other levels.
Phase High
High limit of the PCU’s phase monitor, which is designed to detect high and low phase-to-phase voltage faults. Phase High and Phase Low limits are provided to allow for the usual variations in voltage from the power company. Limits can be set between zero and 300 volts in one-volt increments.

Phase Low
Low limit of the PCU’s phase monitor, which is designed to detect high and low phase-to-phase voltage faults. Phase High and Phase Low limits are provided to allow for the usual variations in voltage from the power company. Limits can be set between zero and 300 volts in one-volt increments.

Start Delay
Length of time the PCU waits to receive the motor-run signal after attempting to start the motor. If the Start Delay timer expires, the motor starter alarm is activated and the PCU shuts down the starter. Time can be set between zero and 510 seconds.

Stop Delay
Length of time the PCU waits to receive a signal that the motor has stopped after attempting to stop the motor. If the Stop Delay timer expires, the motor starter alarm is activated.

Min Run
Minimum length of time that a started pump must remain running before it can be turned off. This setting is used to prevent short cycling of the pumps. Time can be set between zero and 120 minutes in 30-second increments.

Min Off
Minimum length of time that a stopped pump must remain off before being started again. This setting is used to prevent short cycling of the pumps. Time can be set between zero and 120 minutes in 30-second increments.

Flow Volume
The volume between the Off and Lead levels of a well or tank. This figure is required in order to calculate flow rates for HT3’s Derived Flow Report. Volume can be a value between zero and 9999 gallons. Calculating Flow Volume provides instructions for determining tank and well volume.

Ultra Gain
Not currently being used.

Ultra Blanking
Not currently being used.

Ultra Sensitivity
Not currently being used.

Configuration Name / Lock
Configuration Name
User-defined name that describes the PCU configuration. For example, DupUpFlt, for a duplex, tank (two-pump, "pump up" mode) system using a float transducer. When a configuration is uploaded from a PCU, this name describes what type of configuration is stored there. You can enter up to eight alphanumeric characters in the Configuration Name box.

Lock
Disables the ability to make configuration changes in the field at the PCU. Changes to the configuration can only be done from the central computer. If Configuration Lock is disabled, configuration changes made at the PCU will overwrite configurations that were made using PCU Editor.

Control
Control defines the PCU’s pumping mode.

- **Up** (pump up) mode is used to fill a tank by maintaining the tank level between the OFF and Lead staging levels.
- **Down** (pump down) mode is used to empty a well by maintaining the well level between the OFF and Lead staging levels.

Enable
Fault Cycle Mode
Indicates what action is to be taken in the event a transducer fault occurs.

- If enabled, you must select either the Float or Timer option for Fault Cycle.
- If disabled, the system shuts down when a transducer fault occurs in either "pump up" or "pump down" mode.
Failed Pump Restart

Enables the PCU to retry a faulted pump after a ten-minute delay. Each time a pump motor fails to start, the Failed Pump Restart timer is initiated. The Failed Pump Restart and Alternator (discussed below) options work together to create the action taken when a pump motor fails to start. Refer to the table below:

<table>
<thead>
<tr>
<th>Failed Pump Restart</th>
<th>Alternator</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enabled</td>
<td>Enabled</td>
<td>Faulted pump is skipped in the alternator cycle until the timer expires. In situations that require all pumps, the faulted motor is retried every ten minutes.</td>
</tr>
<tr>
<td>Enabled</td>
<td>Disabled</td>
<td>Faulted pump is retried every ten minutes</td>
</tr>
<tr>
<td>Disabled</td>
<td>Enabled</td>
<td>Faulted pump is taken out of alternation cycle.</td>
</tr>
<tr>
<td>Disabled</td>
<td>Disabled</td>
<td>Level in the well or tank must reach the next staging level in order to start the next pump. For example, if the Lead pump is out of service, no pumping takes place until the level reaches Lag 1.</td>
</tr>
</tbody>
</table>

Backup High Float

Enable or disable the Backup High Float alarm option. If an analog transducer is being used, high and low floats can be used as a backup control in the event the PCU detects a failed transducer. This option is not used if floats are being used as the primary control device for the system. If this option is enabled and a backup high float is not connected to the PCU, there is no effect on the operation of the PCU.

Backup Low Float

Enable or disable the Backup Low Float alarm option. If an analog transducer is being used, high and low floats can be used as a backup control in the event the PCU detects a failed transducer. This option is not used if floats are being used as the primary control device for the system.

**IMPORTANT:** This option must be disabled if a backup low float is not connected to the PCU. Failure to do so will interfere with station operation.

Alarm Horn

Enable or disable the alarm horn at the PCU. If this option is disabled and an alarm condition occurs, the horn that is located at the PCU is not activated. Disabling this function does not prevent the alarm from being reported to Alarm Viewer.

Alarm Light

Enable or disable the alarm light at the PCU. If this option is disabled and an alarm condition occurs, the light that is located at the PCU is not activated. Disabling this function does not prevent the alarm from being reported to Alarm Viewer.

Alternator

Enable or disable (bypass) the PCU’s Alternator function. When enabled, the PCU alternates between available pumps each time it is necessary to start a pump. If disabled, pump 1 becomes the Lead pump, pump 2 the Lag 1 pump and pump 3 the Lag 2 pump. See also Failed Pump Restart.
Auxiliary Output
When this option is enabled, the PCU’s auxiliary input terminal controls the auxiliary output terminal (i.e., the terminals are functioning as an auxiliary relay). When disabled, the auxiliary output and auxiliary input terminals function as standard control and monitor points for the telemetry system.

Aux Trigger is used to set the relationship between the auxiliary output and auxiliary input. Aux Delay and Auxiliary Delay in Seconds can be used to turn the auxiliary output On or Off for a specified number of seconds after the auxiliary input turns On or Off. The following are examples of auxiliary use: to cause a local light alarm; to provide a backup bubbler function; to switch ON a backup bubbler compressor when an air-flow switch detects a fault in the primary compressor.

Auxiliary Alarm
Configure the PCU’s auxiliary input to activate the alarm horn and light. Auxiliary Alarm is configured for a high or low state through the Aux Alarm option.

Fault Cycle
The type of action to be taken when a transducer fault occurs. Before selecting a Fault Cycle type, verify that Fault Cycle Mode is enabled.

Float
A transducer fault signals a low-level alarm and overrides pump control. The following table applies:

<table>
<thead>
<tr>
<th>Pump Mode</th>
<th>Transducer</th>
<th>Active Float</th>
<th>Pump Control (ALL)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Up</td>
<td>OK</td>
<td>Low</td>
<td>Stagger On</td>
</tr>
<tr>
<td>Up</td>
<td>OK</td>
<td>High</td>
<td>Stagger Off</td>
</tr>
<tr>
<td>Up</td>
<td>Fault</td>
<td></td>
<td>Stagger On</td>
</tr>
<tr>
<td>Up</td>
<td>Fault</td>
<td>High</td>
<td>Stagger Off</td>
</tr>
<tr>
<td>Down</td>
<td>OK</td>
<td>Low</td>
<td>Off</td>
</tr>
<tr>
<td>Down</td>
<td>OK</td>
<td>High</td>
<td>Stagger On</td>
</tr>
<tr>
<td>Down</td>
<td>Fault</td>
<td></td>
<td>Off</td>
</tr>
<tr>
<td>Down</td>
<td>Fault</td>
<td>High</td>
<td>Stagger On</td>
</tr>
</tbody>
</table>

Timer
A transducer fault signals a low-level alarm.

- If Alternator is enabled, pumps run alternately (each one in turn comes on for the minimum run time and goes off for the minimum off time) until the fault condition is resolved. (Minimum run time and minimum off time are defined in PCU Editor’s Configurable Values section.)
If Alternator is disabled, only the Lead pump is cycled on and off.

**Pumps**

Select the number of pumps being used at this station: one pump (Simplex), two pumps (Duplex) or three pumps (Triplex) system. One of these options must be selected.

**Transducer**

Transducer defines the type of level sensing transducer that is being used by the PCU. The PCU is designed to accommodate either a Digital device (Floats) or an Analog device (0-5 Volts or 4-20 ma). Ultra is not available at this time.

For analog devices, you can set the transducer low (Xdr Low) and transducer high (Xdr High) set points in the Configurable Values section. The low and high transducer values are based on the transducer's location and calibrated range.

The analog set points for the transducer (Low Alarm, Off, Lead, Lag 1, Lag 2, Hi Alarm) must also be configured in the Configurable Values section. The set points required depend upon the number of pumps included in the system. (See Configuring a PCU: Define Analog Set Points for more information.)

One of the options below must be selected.
- **Floats** - A digital device, such as a contact closure, float switch or pressure switch is being used. Analog set points can be ignored when using this device.

- **0-5 Volts** - An analog device that supplies a 0-5 volt signal is being used.

- **4-20 ma** - An analog device that supplies a 4-20 miliamp signal is being used.

- **Ultra** - This option is not currently being used.
Configuring a PCU

**Note:** To configure a PCU with PCU Editor, you must be logged in to HT3 with an account that has Configure Telemetry permission. See "Configuring Your System: User Accounts" in the *HT3 User Guide* for more information on permissions.

See also Saving a PCU Configuration and Downloading and Uploading PCU Configurations.

For more information on the configuration settings discussed below, see Configuration Options.

### User-Defined Name
Enter a descriptive name for this configuration in the **Configuration Name** box.

### Configuration Lock
Prevent configuration changes from being made at the PCU hardware site by enabling **Configuration Lock**.

### Comments
Add any desired notes regarding the configuration in the **Comments** box.

### Pump System Mode
Configure the PCU as a one-, two- or three-pump system by selecting a **Pumps** option.
Configure the PCU's mode as being either "pump up" (maintains a fill level in a tank system) or "pump down" (keeps a well below a specified level) by selecting a Control option.

**Transducer Type**
Configure the PCU's transducer type as either digital (Float) or analog (0-5 Volts or 4-20 ma) by selecting a Transducer type.

If 0-5 Volts or 4-20 ma is selected, you are able to set the transducer low (Xdcr Low) and transducer high (Xdcr High) set points based on the transducer's location and calibrated range. In addition, the Analog set points for the transducer must be configured. The set points that are required depend upon the number of pumps included in the system.

**Define Transducer Fault Action**
Define what action is to be taken in the event a transducer fault occurs by enabling or disabling Fault Cycle Mode. If Fault Cycle Mode is enabled, you must select a Fault Cycle type.

**Define Failed Pump Action**
Allow the PCU to retry a faulted pump after a brief period of time by enabling Failed Pump Restart. The action the PCU takes also depends on the Alternator setting. See the table at Configuration Options: Failed Pump Restart for detailed descriptions of how the PCU reacts, based on the Failed Pump Restart and Alternator settings, to a faulted pump condition.

**Enable Backup High/Low Float**
Enable these backup options if your primary control device is an analog transducer and you want to use the high and low floats as a backup control in the event the PCU detects a failed transducer.

**Disable Alarm Horn/Light**
PCU Editor provides you with the option of disabling the PCU's alarm horn and/or light. If these options are disabled and an alarm condition occurs, the horn and light that are located at the PCU are not activated. Disabling this function does not prevent the alarm from being reported to Alarm Viewer.

**Enable Alternator Function**
Enable or disable (bypass) the PCU's Alternator function.

- When enabled, the PCU alternates between available pumps each time it is necessary to start a pump.
- If disabled, pump 1 becomes the Lead pump, pump 2 the Lag 1 pump and pump 3 the Lag 2 pump. See also Define Failed Pump Action, above.

**Create an Auxiliary Relay**
When the **Auxiliary Output** option is enabled, the PCU’s auxiliary input and auxiliary output terminals function as an auxiliary relay. Use **Aux Trigger** to define the relationship between the two - does the auxiliary output exactly follow the state of the auxiliary input, or is the relationship inverted. You can delay the opening or closing of the auxiliary output by selecting an **Aux Delay** option and defining the **Auxiliary Delay in Seconds**.

**Enable Auxiliary Alarm**
Enable **Auxiliary Alarm** if you want to configure the PCU’s auxiliary input to activate the alarm horn and/or light.

- To activate the alarm during a high-input state, select **High** for **Aux Alarm**.
- Select **Low** for **Aux Alarm** to activate during a low-input state.

**Assign the PCU to a Module**
In most instances, the PCU is configured as Module A because it is the only module-type hardware located at a wet well site. This address must match the address configured in Configuration Editor.

**IMPORTANT**: Do not skip module addresses. Use the next available module letter when configuring a PCU.

**Define Analog Set Points**
Staging levels for analog systems are defined by set points. When the well or tank level reaches a defined set point value, the PCU enters that staging level and the corresponding action or response occurs. For example, if the Lead set point is configured for 10 feet and the transducer senses a well level above 10 feet, the Lead pump is started.

The PCU’s six analog set points are: Low Alarm, Off, Lead, Lag 1, Lag 2 and Hi Alarm. These set points can be ignored if a float control device is being used.

- Simplex stations require that the following set points be defined: Low Alarm, Off, Lead and High.
- Duplex stations require that the following set points be defined: Low Alarm, Off, Lead, High and Lag 1.
- Triplex stations require all six set points be defined.

**Set Phase Monitor Limits**
The PCU is equipped with a phase monitor that is designed to detect high- and low-phase voltage faults. The **Phase High** and **Phase Low** settings are provided to allow for your power company’s usual variations in voltage.

**Set Motor Start and Stop Delay Times**
The PCU is designed to detect a pump motor that fails to start or stop. **Start Delay** is the length of time the PCU waits to receive the motor-run signal after attempting to start the motor. **Stop Delay** is the length of time the PCU waits to receive a signal that the motor has stopped after attempting to stop the motor.
Set Minimum Pump Run and Off Times
To prevent short cycling of the pumps, you can define a minimum pump run time. **Min Run** is the minimum amount of time that a started pump must remain running before it can be turned off. You can also define a minimum off time for the pump(s) using **Min Off**.

Define Flow Volume
In order for average flow rates and total station flows to be calculated for HT3’s Derived Flow Report, you must configure a **Flow Volume** into the PCU. [Calculating Flow Volume](#) provides instructions for determining tank and well volume.
Saving a PCU Configuration

After all necessary configuration options and settings are completed, you must save the file. Saving the file places a copy of it on your computer. It is not saved to the PCU until you download the configuration file to the PCU. PCU configuration files end with the extension .pcu.

**IMPORTANT:** Before saving your file, review the information in File Naming Conventions and Valid File Locations.

1. Choose **Save As** from the **File** menu. You are prompted for a filename.
2. Navigate to where you want to save the configuration file. Type a name for it and click **Save**.

File Naming Conventions

It is good practice to make the configuration's filename descriptive of the PCU’s telemetry location. Use the driver number, station number and module letter to create the filename. For example, a PCU located at Driver 0, Station 1, Module A would be given the filename 0-001-A.pcu ([driver#]-[station#]-[module letter].pcu).

In the future, if you need to make any changes to the PCU's configuration, it will be easy to locate the exact file that you need. Also, if you want to use this same configuration for another PCU, you can easily locate the file, make any necessary changes, and then save it with a new filename that reflects the second PCU’s telemetry location.

Valid File Locations

PCU Editor files can only be saved in and opened from one of the directories listed below (or a subdirectory contained therein). If you try to save a file to a different directory, you will get an "I/O error writing file ..." error. Attempting to open a file from a different directory results in an "I/O error reading file ..." error.

- **Windows 95/98/ME** - For computers running Windows 95/98/ME, the files can only be saved to the C: \My Documents directory.
- **Windows 2000 / NT / XP / Vista / 7** - For computers running these versions of the Windows operating system, the files can only be saved to the home directory (C:Documents and Settings) of the user that is currently logged in. For example, C:Documents and Settings\jane, where jane is the Windows user name of the individual currently logged in.

The Java policy file that you installed on your computer when it was first set up to connect to HT3 controls where files can be saved to and opened from. The Java policy file is designed to protect your computer from "hostile" Java applets that could try to access or damage the data on your computer (for example, to insert a virus). The HT3 policy file gives HT3's Java applets permission to write to specific directories on your computer. In effect, the policy file says that only Java applets from this server can write to this computer’s drive; and this server can only write to this specific directory (and any subdirectories contained therein).
If you want to keep your files in their own directory, you can create a folder within either the C:\My Documents directory (95/98/ME) or the C:\Documents and Settings\xyz_user (2000/NT/XP/Vista/7), where xyz_user is the Windows user name of the individual currently logged on to the computer, and save the files there.

If you need to store a file in another location (for example, a backup location on your network server), save the file to the correct directory (i.e., My Documents or Documents and Settings) and then copy it to the backup location. Additionally, to open a file that is stored in another directory, you must first copy the file to the correct directory (i.e., My Documents or Documents and Settings).
Downloading and Uploading PCU Configurations

Before Downloading or Uploading a PCU configuration, you must select the driver number and host.

Select Driver Number/Host

The Driver command enables you to select the driver number and/or host for the PCU you want to upload from or download to.

- **Driver number** is the driver to which the PCU was assigned in Configuration Editor.
- **Driver Host** is the name assigned to your server (HT3 is the default name). Enter the driver host name for the server that controls the PCU you are downloading to or uploading from.

1. Choose **Driver** from the PCU menu. The Driver dialog box appears.
2. In the **Driver** dialog box, enter the correct driver number and/or host for the PCU.
3. Click **OK**. Click **Cancel** to exit the dialog box without making any changes.

Download to a PCU

To save the configuration file to the PCU:

1. Select the Driver Number/Host for this PCU as described above.
2. Choose **Download** from the PCU menu.
3. In the **Download** dialog box, enter the PCU’s **Station number**. (**Note:** The driver number can be included when entering the station number. For example, 1234 for Station Address 234 on Driver 1.)
4. Click OK. To exit the Download dialog box without downloading the configuration file to the PCU, click Cancel.

Upload from a PCU

PCU Editor provides you with the ability to upload a configuration from a PCU into PCU Editor. This enables you to verify how a particular PCU is configured, or to use an existing configuration as the base for a new PCU's configuration.

1. Select the Driver Number/Host for the PCU as described above.
2. Choose Upload from the PCU menu.
3. In the Upload dialog box, enter the station number and module letter of the PCU from which you want to upload the configuration. (Note: The driver number can be included when entering the station number. For example, 1234 for Station Address 234 on Driver 1.)
4. Click Upload. The configuration appears in PCU Editor.
Editing a Configuration

1. Upload the PCU’s configuration; or, choose Open from the File menu and locate the .pcu file for the configuration you want to edit.

2. Make any necessary or desired changes.

3. If working from a .pcu file, choose Save from the File menu to save your changes. (IMPORTANT: This overwrites the existing .pcu file. To save the configuration with a new file name, choose Save As from the File menu and give the configuration a new filename.)

4. Download the new configuration to the PCU.
Appendix

- Calculating Flow Volume
- Keyboard Shortcuts

Calculating Flow Volume

Step 1. Determine the difference between the OFF Level and the LEAD Level (Liquid Height) in feet.

Liquid Height = LEAD Level - OFF Level

Step 2. Calculate the area of the well or tank.

For a rectangular well or tank:
Area = Width x Length

For a circular well or tank:
Area = Radius² x 3.14

Step 3. Calculate the volume in cubic feet (ft³).

Vol (ft³) = Liquid Height x Area

Step 4. Convert Vol (ft³) to gallons

Vol (gallons) = Vol (ft³) x 7.48

Example

In this example, we are calculating the volume for a well with the following characteristics:

- Circular well with a diameter of 10 feet (radius = 5 feet)
- Off Level is 2 feet
- Lead Level is 5 feet
Step 1: Calculate Liquid Height
Liquid Height = Lead Level - Off Level
5 feet - 2 feet = 3 feet

Step 2: Calculate Area
Area = Radius² x 3.14
5² x 3.14 = 78.5 ft²

Step 3: Calculate Volume in Cubic Feet (ft³)
Vol (ft³) = Liquid Height x Area
3 x 78.5 ft² = 235.5 ft³

Step 4: Convert Vol (ft³) to Gallons
Vol (gallons) = Vol (ft³) x 7.48
235.5 ft³ x 7.48 = 1761.54 gallons

Keyboard Shortcuts
The table below lists PCU Editor's keyboard shortcuts. Print out this page to use as a quick reference guide.

The plus (+) sign indicates the keys must be pressed at the same time. Press and continue to hold down the first key listed and then press the next listed key.

<table>
<thead>
<tr>
<th>Function</th>
<th>Keyboard Shortcut</th>
</tr>
</thead>
<tbody>
<tr>
<td>Copy</td>
<td>CTRL + C</td>
</tr>
<tr>
<td>Cut</td>
<td>CTRL + X</td>
</tr>
<tr>
<td>Delete</td>
<td>Backspace key</td>
</tr>
<tr>
<td>Download</td>
<td>CTRL + D</td>
</tr>
<tr>
<td>Driver</td>
<td>CTRL + R</td>
</tr>
<tr>
<td>Exit</td>
<td>CTRL + Q</td>
</tr>
<tr>
<td>New</td>
<td>CTRL + N</td>
</tr>
<tr>
<td>Open</td>
<td>CTRL + O</td>
</tr>
<tr>
<td>Paste</td>
<td>CTRL + V</td>
</tr>
<tr>
<td>Save</td>
<td>CTRL + S</td>
</tr>
<tr>
<td>Upload</td>
<td>CTRL + U</td>
</tr>
</tbody>
</table>
7 PLC Editor

PLC Editor is used to transfer set point values to and from the non-volatile memory locations of both the PLC (Programmable Logic Controller) and the TCU (TAC Pack Telemetry Control Unit). Values are transferred between the unit and the server via telemetry (radio and/or network) by updating (Send) and requesting (Get) the configuration from PLC Editor. For the TCU, configurations can also be automatically uploaded to the unit from the field by saving the file as an auto configuration file and performing a specific key sequence at the TCU.

For more information on the PLC, see the *PLC Operations Guide*. More information on the TCU can be found in the *TCU Quick Start Guide, TCU Installation and Operation Manual*, and the *TCU Programming Reference*. All are available for download from the DFS website: [www.dataflowsys.com](http://www.dataflowsys.com).

- Introduction
- Navigating PLC Editor
- Using PLC Editor
- Appendix
Introduction

PLC Editor is used to transfer set point values to and from the non-volatile memory locations of both the PLC (Programmable Logic Controller) and the TCU (TAC Pack Telemetry Control Unit). Values are transferred between the unit and the server via telemetry (radio and/or network) by updating (Send) and requesting (Get) the configuration from PLC Editor. For the TCU, configurations can also be automatically uploaded to the unit from the field by saving the file as an auto configuration file and performing a specific key sequence at the TCU.

For more information on the PLC, see the PLC Operations Guide. More information on the TCU can be found in the TCU Quick Start Guide, TCU Installation and Operation Manual, and the TCU Programming Reference. All are available for download from the DFS website: www.dataflowsys.com.

PLC Editor features two "views" that are accessed by selecting one of the tabs on the interface: Table View or TCU 90000 View.

Table View

Table View features three columns – Address, Description, and Value – for configuring a PLC or TCU’s set point values.
TCU 90000 View

TCU 90000 View features a more intuitive interface for configuring a TCU that is using the pump control process. This view includes 5-tabbed pages that can be used to configure such things as the type of transducer being used, the number of pumps at the station, the pumping mode ("pump up" or "pump down"), and the well or tank's staging levels.
Navigating PLC Editor

- **Menus**
  - File Menu
  - Select Menu
  - PLC Menu
  - Help Menu

**Menus**

**File Menu**

- **New** - Create a new PLC/TCU memory map, or configuration. If a configuration is already open and it has not been saved, a "Save Changes?" prompt is displayed.

- **Open** - Open a previously saved PLC/TCU memory map, or configuration, file.

- **Save** - Save the current memory map, or configuration, to a file. If the file has not been previously saved, a file name prompt is displayed.

- **Save As** - Save the current memory map, or configuration, to a new, user-defined file name. The file name must conform to Microsoft Windows naming standards.

**Select Menu**

- **All** - Select the entire memory map (all rows in the current configuration). This is used to determine what addresses to request (Get) or update (Send) when communicating with a PLC or TCU.

- **None** - Clear all selected memory map rows.

- **TCU Addresses** - Select only the rows (memory locations) that apply to a TCU. This selection is used to request or update an entire TCU configuration.

- **Station** - Select the physical station to which all requests (Get) and updates (Send) will be sent.
PLC Menu

- **Get** - Update (get) all currently selected rows from the PLC/TCU at the chosen station. This process updates the onscreen memory table and prompts you to save the file when the Get is completed. During the Get process, the progress bar will reflect the completion percentage and a terminal window will display communications traffic. Closing the traffic window and confirming the close, will cause the Get operation to be terminated. With both Get and Send (discussed above), you can change the length of time to wait for a response (timeout; default = 20 seconds) and the number of times to send the message before considering it failed (retries; default = 1).

- **Send** - Request (send) all currently selected rows to the PLC/TCU at the chosen station. Send updates the PLC/TCU’s memory map and issues a rest of that unit. If no station is chosen, an error will occur and you will be prompted to select a target station. During the Send process, the progress bar will reflect the completion percentage and a terminal window will display communications traffic. With both Send and Get (discussed below), you can change the length of time to wait for a response (timeout; default = 20 seconds) and the number of times to send the message before considering it failed (retries; default = 1).

- **Reset** - Remotely reset the PLC/TCU.

- **Make AutoCFG** - Format the current memory table into a special file for the currently selected station. The filename is automatically generated as stn#.autcfg and should not be changed. You are prompted to save this file. After saving, you should use the File Upload tool to send the file to the server. This file can then be used for the TCU auto-configuration download feature. See Using PLC Editor: Create TCU Auto Config File for more information on this feature.

Help Menu

- **About** - Provides information on the version of PLC Editor currently installed, including version number and release date.

- **Browse Help** - Opens PLC Editor’s online documentation.

Table View

Table View includes three columns: Address, Description, and Value. Each row in Table View represents one address record.

When you first open PLC Editor, Table View opens in PLC mode. See TCU Table View for information on viewing in TCU mode.
**Address** - Displays the six-byte addresses that have been set aside for the purpose of storing and retrieving the PLC/TCU’s floating set point values.

**Description** - Displays any user-defined descriptions or comments that have been entered for the corresponding address. Enter or edit a description for an address by typing directly in the corresponding Description field.

**Value** - Displays the floating set point values that have been stored in the corresponding address. Enter or edit a value for an address by typing directly in the corresponding Value field.

At the bottom of the window are the Station field and the Progress bar.

- Station displays 0 until you have selected a station (select **Station** from the **Select** menu).
- When you request a configuration file from a PLC/TCU (select **Get** from the **PLC** menu) or update a PLC/TCU’s configuration (select **Send** from the **PLC** menu), the Progress bar shows the completion progress.

**TCU Table View**

When you first open PLC Editor, Table View opens in PLC mode. To view Table View in TCU mode, click the TCU 90000 View tab and then click the Table View tab.

The TCU mode of Table View lists all the TCU addresses, a description of the address (including definitions of the possible values where applicable), and the default value.
Using Table View to Configure a PLC or TCU

For instructions on using Table View to configure a PLC or TCU, see Using PLC Editor with a PLC or Using PLC Editor with a TCU.

See TCU Address-Option-Value Map for a list of the address and possible values for each of the TCU Pump Controller options. Detailed descriptions for each of the pump controller configuration options can be found in Navigating PLC Editor: TCU 90000 View.

TCU 90000 View

IMPORTANT: Refer to the TCU Installation and Operation Manual when configuring a TCU. The manual can be downloaded from the DFS website. Visit http://www.dataflowsys.com/support/literature.php

The TCU 90000 View provides an intuitive user interface for configuring the TCU’s built-in pump control process. This user interface is similar to the TCU’s own configuration screen as well as the TCU Module Config form in WinRTU Test.

The TCU 90000 View features five tabs:

- General
- Pumps
When changes are made in TCU 90000 View, they are instantly visible in Table View and vice versa.

Descriptions for the configuration options for each of the tabs are provided below. To aid you in identifying each option’s six-byte address (as displayed in Table View), the address range is shown in parentheses following the option name. The possible values for each address range can be found in TCU Address-Option-Value Map.

For instructions on using TCU 90000 View to configure the TCU’s pump control process, see Using PLC Editor with a TCU.

## General Tab

### Configuration ID (5006->500B)

User-defined label that uniquely identifies this configuration. For example, you could assign an ID of 2000.1 to a configuration for a duplex station that uses floats; 2000.2 could identify a duplex station that uses an analog-type device. Config ID can be a maximum of nine characters (nine numbers, or eight numbers and a decimal point).

### BEM Modules (50FC->5101)

The number (0-8) of real modules that are already on the RTU bus and connected by the BEM (Bus Extender Module). Configuring the TCU with the number of BEM modules enables it to assign itself to the next available module address(es). For example, if there are already four modules on the bus (A, B, C, D), the TCU will start at module E.

### Transducer Type (5012-5017)

- **Auxiliary**
- **Modbus**
- **Analog**
The type of transducer being used by the TCU.

- **4-20mA** - analog current-type device.
- **0-5Vlt** - analog voltage-type device (pressure or linear resistive).
- **Remote** - device located at a remote location; data is sent to the TCU via telemetry.
- **Floats** - digital-type device, such as contact closures, float switches, and pressure switches.

**Fault Mode (5024->5029)**
This setting is only for stations using an analog transducer as the primary method of pump control. If you are using floats as the primary method of pump control, leave Transducer Fault Mode at the default setting (Disable).

The TCU provides four options for operation when a transducer fault occurs.

- **Disable** - Select this option if the primary transducer type is Floats, or if no transducer fault mode behavior is desired. High and Low Float options are still available for backup.
- **Timer** - For each pump, the TCU maintains a log of average run time and average off time for each hour of the day. When the Timer option is selected and a transducer fault occurs, the TCU will turn the pumps on and off based on the averages for each hour recorded in the log.
- **Transducer2** - When an auxiliary transducer is connected and this option is selected, transducer control is switched to the second analog input when a transducer fault occurs. High and low values for the secondary transducer’s range must be configured (see Analog 2, below).
- **Floats** - When float level switches are wired to the TCU and the Floats option is selected, a fault with the primary transducer will cause the TCU to switch transducer control to Float inputs. (IMPORTANT: Floats Fault Mode requires an OFF float to shut off pumps, and a minimum of one float - Lead to High - to start pumps.)

**Volume (50CC->50D1)**
Calculations for total station flow and average pump flow require that a volume be specified in the TCU. The volume, a configured value from 0 to 9999 is calculated between the Lead Off and Lead levels of a well or tank. If the volume is configured as 0 (zero), the meters for total pump flow and average pump flow are not displayed. Information on calculating the volume can be found in the TCU Installation and Operation Manual in the appendix titled "Flow Volume Calculations."

**Flow Units (50D2->50D7)**
The TCU allows you to specify if flow is measured in millions of gallons per day (MGD) or gallons per minute (GPM).

**Trend Rate (5102->5107)**
Trend rate (2-999 seconds) is the update frequency for the default status screen’s trend. The default trend rate is 30 seconds; the trend can display the last eleven (11) updates. At the default trend update rate of 30 seconds, the length of time that can be displayed is 5 ½ minutes (11 x 30 seconds). Shorten or lengthen the trend rate as suits your needs.

**High Float (501E->5023) and Low Float (5018->501D)**
The TCU is designed to accommodate a high-level float and low-level float for backup alarms. These are recommended in both discrete and analog level detection systems.

- If a high level float is being used, **High Float** must be enabled.
- If a high level float is not connected and **High Float** is enabled, there is no effect on the operation of the TCU.
- If a low level float is being used, **Low Float** must be enabled.
- **Low Float** must be disabled if a low level float is not connected. If **Low Float** is not disabled in this situation, the Low Well alarm will interfere with station operation.

**Xdcr High Flt Fault (5228->5228)**
When this option is enabled, a High Float condition generates a transducer fault and switches control to the **configured fault mode**. When this option is disabled, control remains with the primary transducer when a High Float condition occurs.

**Xdcr Lo Lvl Fault (522E->5233)**
When this option is enabled, a Low Float condition generates a transducer fault and switches control to the **configured fault mode**. When this option is disabled, control remains with the primary transducer when a Low Float condition occurs.

**Xdcr Noise Fault (5234->5239)**
This option is used with bubbler systems only. Leave this option disabled if the transducer is not a bubbler system.

Enabling this option allows the TCU to detect an air pump failure. If the TCU does not sense air pump-induced noise on its analog input while the pumps are not running (between the off and lead levels) for a duration of 5 minutes, it will generate a transducer fault and switch control to the **configured fault mode**.

**Hi Flt Override (523A->523F)**
Enable this option to give the High Float precedence in the event of an Off Float failure in float control mode. Pumps will be staggered on and remain on as long as the High Float condition exists. **Minimum run and off timers** should be configured to prevent short cycling the pumps on High Float transitions.

Leave this option disabled to give the Off float precedence in the event of a High Float condition without an Off Float condition. Pumps will not be allowed to run in the absence of the Off Float.

**Restart Faulted Pump (5036->503B)**
The TCU can be configured to retry a faulted pump after a user-defined delay (see **Pump Minimums: Off**, below). Each time a pump motor fails to start, the retry function will start a timer. The faulted pump will be skipped in the alternation cycle until the timer expires. In a situation that requires all pumps, the faulted pump motor will be retried every XX minutes (Pump Minimum Off time). If the pump motor starts, the alarm condition will be cleared.

If the retry function is disabled, the faulted pump will be taken out of the alternation cycle. If Restart Faulted Pump and **Alternate** (found on the Pumps tab) are both disabled, the level in the well or tank will have to reach the next staging level to start the next pump. For example, if the Lead pump goes out of service, no pumping will take place until the level reaches the Lag level.

**Alarm Horn (502A->502F) and Alarm Light (5030->5035)**
The TCU's auxiliary input terminal can be configured to activate the alarm horn and light. To enable the alarm horn and light, click the corresponding box.

**Pumps Tab**

**Pumps (5000C->5011)**
The TCU can be configured to control one, two, or three pumps for simplex, duplex, or triplex stations, respectively.

**Mode (50E4->50E9)**
The TCU can operate in two pump arrangements: Up (Tank) or Down (Well).

- **Up (Tank)** is used to maintain a fill level in a tank system.
- **Down (Well)** is used to keep a well below a set level.

**Alternate (503C->5041)**
The TCU features an option that enables it to start a different pump each time the station is called to pump.

- **All** alternates among all available pumps.
- **Pmp1&2** alternates between pumps 1 and 2 (High Service mode). In this mode, pump 3 will come on if the tank level reaches the Lag2 level.
- **Pmp2&3** alternates between pumps 2 and 3 (Jockey Pump mode). In this mode, pump 1 always comes on with the Lead level. If the Lag1 level is reached, pump 2 or 3 comes on.
- **None** disables pump alternation. When **Alternate** is set to None, pump 1 becomes the Lead pump, pump 2 becomes the Lag pump, and pump 3 becomes the Lag2 pump.
Pump Minimums
The TCU can be configured with the minimum time that a pump should run, as well as the minimum time that it should stay turned off.

- **Run (50B4->50B9)** - This causes a started pump to run for the specified time before it can be turned off. A value of 0 (zero) disables the function and allows the pump to be turned off at any time after it has been started. [Note: In Down (Well) mode, the minimum run timer is overridden by the low float or low-level set point being reached. In Up (Tank) mode, this timer is overridden by the high float or high-level set point being reached.]

- **Off (50BA->50BF)** - This option causes a pump that has been turned off to remain off for the specified time before it can be started again. A value of 0 (zero) disables the function and allows the pump to be turned on at any time after it has been stopped. [Note: In Down (Well) mode, the minimum off timer is overridden by the high float or high-level set point being reached. In Up (Tank) mode, this timer is overridden by the low float or low-level set point being reached.]

Pump Fault Delay
The TCU is designed to detect a motor that fails to start or stop. The start and stop pump fault delays allow the TCU to control solid-state starters with "soft-start" and "soft-stop" features. [Note: Due to the TCU’s process loop time, the start and stop delays may take up to 2 seconds longer than the configured setting.]

- **Start (5048->504D)** - Length of time the TCU waits to receive the motor-run signal after it has attempted to start the motor. If the start-delay timer expires, the motor-starter alarm for that motor is activated, and the TCU shuts down the starter.

- **Stop (504E->5053)** - Length of time the TCU waits to receive the motor-stop signal after it has attempted to stop the motor. If the stop-delay timer expires before the run signal goes away, the motor-starter alarm for that motor is activated.

Phase Monitor (VAC)
The TCU can accommodate a 240 VAC or 480 VAC phase monitor and can be configured to detect low and high phase-to-phase voltage.

- **Range (50EA->50EF)** - The TCU’s phase monitor enables adjustments to phase imbalance and low and high voltage trip points. Select the range option that describes the type of phase monitor being implemented.

- **High Alarm (50C6->50CB) and Low Alarm (50C0->50C5)** - These limits are provided to allow for the usual variations in voltage from the power company. Phase voltage alarms will disable pump controls unless the external phase monitor point or internal phase monitor bypass point is turned on. High Alarm and Low Alarm can be set in one-volt increments between 151 and 300.
Auxiliary Tab

Output turns Off/On (505A->505F) x.x seconds after (5060->5065) input turns Off/On (5066->506B)

The TCU’s auxiliary input and output can be programmed to function together as a time delay auxiliary relay. The auxiliary output can be configured as a time-delayed output based on the ON or OFF state of the auxiliary input. This enables the auxiliary input to control one edge of the auxiliary output.

Together, the settings Output turns (On/Off) and input turns (On/Off) define how the TCU’s auxiliary output responds when the state of the auxiliary input changes.

The delay, or length of time allowed to pass before turning the auxiliary output on or off, (seconds after), can be between 0 and 510 seconds in one-second increments. Setting the delay to 0 (zero) disconnects the auxiliary input and the auxiliary output and makes them available to telemetry as general monitor and control points.

Enable Auxiliary Alarm (50F0->50F5)
Select this option to enable an alarm for the auxiliary input.

Alarm when input is (50F6->50FB)
Define the auxiliary input ‘s alarm state (Open or Closed).
Modbus Tab

When the TCU is using the pump control process, it can poll Modbus slave devices and place their register data in the TCU’s unused DFS modules (modules H-O). Modbus polling is activated by using the Modbus tab to enter the Modbus information (address and length) into the TCU’s configuration registers. The TCU will then poll the device(s) automatically.

- Digital Status registers: (10000-19999) and Analog Status (30000-39999) registers are polled continually.
- Digital Control (0-9999) and Analog Control (40000-49999) registers are updated using the multiple register update command. At TCU power up, the status of Control registers is read once.

Enter the Modbus address and length in the appropriate row for the module letter being used.

- Address is the combined station and register in dot format (for example, station 23, register 4 would be 23.00004).
- Length must be 1-12 for digital registers (0-19999) and 1-4 for analog registers (30000-49999).

For example, if you wanted to monitor registers 10001-10005 on a Modbus unit with bus address 9, you would use the Modbus tab to set the following for Module H:

- Address = 9.10001
- Length = 5

The TCU would then poll these registers and put them in Module H as digital status points.

Addresses for the Modbus fields (as viewed in Table View) are as follows:
Module Letter | Station Address | Length
---|---|---
Module H | 5108->510D | 510E->5113
Module I | 5114->5119 | 511A->511F
Module J | 5120->5125 | 5126->512B
Module K | 512C->5131 | 5132->5137
Module L | 5138->513D | 513E->5143
Module M | 5144->5149 | 514A->514F
Module N | 5150->5155 | 5156->515B
Module O | 515C->5161 | 5162->5167

### Analog Tab

![Analog Tab Image]

**Note that the Flow EQ configuration is for DFS use only.**

**20 mA / 5v (5072->5077)**

High calibration point (in feet) of primary analog transducer’s range.

**High (50AE->50B3)**

Level (in feet) at which all pumps are stopped/started (depending on pumping mode) and the alarm is activated.

- In **Up (Tank) mode**, the TCU stops all three pumps and activates alarms when the tank’s level rises above this set point. This level must be set above all other levels.
• In **Down (Well) mode**, the TCU starts all three pumps and activates alarms when the well's level rises above this set point. This level must be set above all other levels.

**Lag 2 On (50A8->50AD)**

Level (in feet) at which the Lag 2, or third pump, is stopped/started (depending on pumping mode). [Used for triplex (three-pump) stations only.]

- In **Up (Tank) mode**, the TCU starts the Lag 2, or third, pump when the tank's level falls below this set point.
- In **Down (Well) mode**, the TCU starts the Lag 2, or third, pump when the well's level rises above this set point.

**Lag 1 On (50A2->50A7)**

Level (in feet) at which the Lag, or second pump, is stopped/started (depending on pumping mode). [Used for duplex (two-pump) and triplex (three-pump) stations only.]

- In **Up (Tank) mode**, the TCU starts the Lag, or second, pump when the tank's level falls below this set point.
- In **Down (Well) mode**, the TCU starts the Lag, or second, pump when the well's level rises above this set point.

**Lead On (509C->50A1)**

Level (in feet) at which the Lead, or first, pump is stopped/started (depending on pumping mode).

- In **Up (Tank) mode**, the TCU starts the Lead, or first, pump when the tank's level falls below this set point.
- In **Down (Well) mode**, the TCU starts the Lead, or first, pump when the well's level rises above this set point.

**Lag 2 Off (5096->509B)**

Level (in feet) at which the Lag 2, or third pump, is stopped/started (depending on pumping mode); can be set to the same value as Lead Off for either mode. [Used for triplex (three-pump) stations only.]

- In **Up (Tank) mode**, the TCU turns off the Lag2, or third, pump when the tank's level rises above this set point.
- In **Down (Well) mode**, the TCU turns off the Lag2, or third, pump when the well's level falls below this set point.

**Lag 1 Off (5090->5095)**

Level (in feet) at which the Lag, or second, pump is stopped/started (depending on pumping mode); can be set to the same value as Lead Off for either mode. [Used for duplex (two-pump) and triplex (three-pump) stations only.]

- In **Up (Tank) mode**, the TCU turns off the Lag, or second, pump when the tank's level rises above this set point.
- In **Down (Well) mode**, the TCU turns off the Lag, or second, pump when the well's level falls below this set point.
Lead Off (508A->508F)
Level (in feet) at which the Lead, or first, pump is stopped/started (depending on pumping mode).

- In **Up (Tank) mode**, this is the tank's maximum operational level. The TCU turns off the Lead, or first, pump when the tank's level rises above this set point.
- In **Down (Well) mode**, this is the well's minimum operational, or Off, level. The TCU turns off the Lead, or first, pump when the well's level falls below this set point.

Low (5084->5089)
Level at which all pumps are stopped/started (depending on pumping mode) and the alarm is activated.

- In **Up (Tank) mode**, all pumps are running and alarms are activated when the tank's level falls below this set point. This level must be set below all other levels.
- In **Down (Well) mode**, pumps are shut down and alarms are activated when the well's level falls below this set point. This level must be set below all other levels.

4 mA / 1v (506C->5071)
Low calibration point, in feet, of primary analog transducer's range.

Analog 2
High and low values of the secondary transducer's range.

- **20 mA / 5v (5072->5077)** - High calibration point (in feet) of secondary analog transducer's range
- **4 mA / 1v (5078->507D)** - Low calibration point (in feet) of secondary analog transducer's range.
Using PLC Editor

- Using PLC Editor with a PLC
- Using PLC Editor with a TCU

With a PLC

**IMPORTANT:** Refer to the appropriate PLC manual (*PLC033 Installation and Operation Manual* or *PLC001/SCU001 Operations Guide and DFS BASIC-52 Reference*) when configuring a PLC. Both manuals can be downloaded from the DFS website. Visit [http://www.dataflowsys.com/support/literature.php](http://www.dataflowsys.com/support/literature.php)

In this section, you will find instructions for doing the following:

- Getting (downloading) and editing a configuration
- Sending (uploading) the configuration to the PLC

Getting (Downloading) and Editing a Configuration

If you need to make a change to an existing PLC configuration, you can download (Get) the configuration to PLC Editor, make the change, and then send the edited configuration back to the PLC.

1. Open PLC Editor.
2. Select Station from the Select menu and browse to the station you want to download the configuration of.
3. Select the station and click Ok.
4. Select the addresses to Get. (See [Methods for Selecting Addresses](#) for alternative methods for selecting addresses.)
5. To download the selected addresses to PLC Editor, select Get from the PLC menu. A Get PLC data from station? dialog box opens.

Before clicking Yes you can change the length of time to wait for a response (timeout; default = 20 seconds) and the number of times to send the message before considering it failed (retries; default = 1).

When you are ready, click Yes to begin retrieving data.

A radio traffic window that shows messages being sent and received opens, and the progress bar shows the completion progress.

5. When the Get process is complete, a Query is complete, save now? dialog opens. Click Yes to save the configuration file. PLC Editor automatically creates a file name with the format stn#.plc (where # is the number of the station from which you retrieved data).

6. Click Save. (IMPORTANT: Review Valid File Locations for important information on where files can be saved.)

7. Use Table View to make the desired changes to the configuration's address values and descriptions.

8. Save the edited configuration file.
   - If you are going to send this configuration back to the same PLC, you can use the Save command to save the file with the same file name.
   - If the configuration is going to be sent to a different PLC, use the Save As command to give the file a name that uniquely identifies it.

9. Send the configuration to the PLC.

Sending (Uploading) the Configuration to the PLC

1. If the configuration is going back to the same PLC, you don't need to select the station. However, if the configuration is going to a different station, select Station from the Select menu to browse to the target station.
2. Select the addresses to be sent using one of the methods discussed in Methods for Selecting Addresses.

3. Select Send from the PLC menu. A Send data and reset station? dialog box opens.

4. Before proceeding you can change the length of time to wait for a response (timeout; default = 20 seconds) and the number of times to send the message before considering it failed (retries; default = 1).

5. Click Yes to begin sending data. A radio traffic window that shows messages being sent and received opens, and the progress bar shows the completion progress.

6. When the send process is complete, an "Update is complete" message is displayed. Click OK to close the message window.

With a TCU

**IMPORTANT**: Refer to the TCU Installation and Operation Manual when configuring a TCU. The manual can be downloaded from the DFS website. Visit [http://www.dataflowsys.com/support/literature.php](http://www.dataflowsys.com/support/literature.php)

In this section, you will find instructions for doing the following:

- Creating and sending (uploading) a new pump control configuration
- Getting (downloading) and editing a configuration
- Sending (uploading) a configuration
- Creating, storing, and using an AutoCFG file

An Address-Option-Value map that identifies the corresponding address for each of the configuration options of a TCU using the built-in pump control process can be found in TCU Address-Option-Value Map.

Creating and Sending (Uploading) a New Pump Control Configuration

These instructions are for configuring a TCU that is using the standard 90000 built-in pump controller program. Instructions for editing a custom TCU program can be found in the section titled Getting and Editing a Configuration.

1. Open PLC Editor and select New from the File menu.

2. Click the TCU 90000 View tab and configure the TCU’s pump control process with the desired options (see Navigating PLC Editor: TCU 90000 View for information on the available configuration options).

3. Select Save from the File menu and save the file with a descriptive name. See File Naming Conventions and Valid File Locations for information on naming and saving your files.
4. Select the memory addresses to send by clicking the **Table View** tab and then selecting **TCU Addresses** from the **Select** menu. The **TCU Addresses** option selects only the memory locations used by a pump controller TCU.

5. Choose the station to send the configuration to by selecting **Station** from the **Select** menu and browsing to the target station. Select the desired station and click **Ok**.

![Address Selection Text](image1)

6. Send the configuration to the TCU by selecting **Send** from the **PLC** menu. A **Send data and reset station?** dialog box opens.

   Before clicking **Yes** to begin sending data, you can change the length of time to wait for a response (**timeout**; default = 20 seconds) and the number of times to send the message before considering it failed (**retries**; default = 1).

   When you are ready, click **Yes** to begin sending data.

   A radio traffic window that shows messages being sent and received opens, and the progress bar shows the completion progress.

![Radio Traffic](image2)

7. When the send process is complete, an "Update is complete" message is displayed. Click **OK** to close the message window.

8. To send this same configuration to a second TCU, repeat steps 5-7, above. Note that you may also want to save the file to your computer with a different file name that uniquely identifies the station.
Getting (Downloading) and Editing a Configuration

If you need to make a change to an existing TCU configuration, you can download (Get) the configuration to PLC Editor, make the change, and then send the edited configuration back to the TCU.

1. Open PLC Editor.
2. Select Station from the Select menu and browse to the station you want to download the configuration of.
3. Select the station and click Ok.
4. Select the addresses to get.
   - If you are editing a TCU that is using the built-in pump control program, select TCU Addresses from the Select menu.
   - If you are editing a TCU that is running a custom program, select All from the Select menu.
   See Methods for Selecting Addresses for alternative methods for selecting addresses.
5. To download the selected addresses to PLC Editor, select Get from the PLC menu. A Get PLC data from station? dialog box opens.
   Before clicking Yes to begin retrieving data, you can change the length of time to wait for a response (timeout; default = 20 seconds) and the number of times to send the message before considering it failed (retries; default = 1).
   When you are ready, click Yes to begin retrieving data.
   A radio traffic window that shows messages being sent and received opens, and the progress bar shows the completion progress.
6. When the Get process is complete, a **Query is complete, save now?** dialog opens. Click **Yes** to save the configuration file. PLC Editor automatically creates a file name with the format stn#.plc (where # is the number of the station from which you retrieved data).

7. Click **Save**. (IMPORTANT: Review **Valid File Locations** for important information on where files can be saved.)

8. Use **Table View** or **TCU 90000 View** to make the desired changes to the configuration.

9. Save the edited configuration file.
   - If you are going to send this configuration back to the same TCU, you can use the **Save** command to save the file with the same file name.
   - If the configuration is going to be sent to a different TCU, use the **Save As** command to give the file a name that uniquely identifies it.

10. **Send the configuration to the TCU.**

---

### Sending (Uploading) a Configuration

1. If the configuration is going back to the same TCU, you don't need to select the station. However, if the configuration is going to a different station, select Station from the Select menu to browse to the target station.

2. Select the addresses to be sent using one of the methods discussed in **Methods for Selecting Addresses**.

3. Select **Send** from the **PLC** menu. A **Send data and reset station?** dialog box opens.

4. Before clicking **Yes** to begin sending data, you can change the length of time to wait for a response (*timeout*: default = 20 seconds) and the number of times to send the message before considering it failed (*retries*: default = 1). When you are ready, click **Yes** to begin sending data. A radio traffic window that shows messages being sent and received opens, and the progress bar shows the completion progress.

5. When the send process is complete, an "Update is complete" message is displayed. Click **OK** to close the message window.
Creating, Storing, and Using an AutoCFG File

An AutoCFG file stores a TCU pump controller configuration in a special format and allows it to be broadcast to a specified TCU when the TCU is powered up in Auto Download mode. This allows installation of a new or replacement TCU with only minimal user interaction. An installer can replace a TCU with a new one (factory default settings), power it up, and have the configuration automatically download over the radio link.

This method of sending a configuration to a TCU can only be used with a TCU that is using the standard 90000 built-in pump controller program. It cannot be used with a TCU running a custom or VFD (90001) program.

1. Open PLC Editor.
2. Open a saved configuration file (select Open from the File menu) or create a new TCU pump controller configuration.
3. Select Station from the Select menu to browse to the station you are creating the AutoCFG file for.
4. Select Make AutoCFG from the PLC menu. Click Yes on the Make autocfg file for stn? dialog box that opens.
5. In the Save As dialog box that opens, a file name is automatically generated as stn#.autocfg (where stn# represents the actual station number, for example, 4511.cfg for a station numbered 4511).
6. Click Save (review the information in Valid File Locations for important information on saving files).
7. Click OK on the AutoCFG has been saved dialog that opens.
8. Close PLC Editor and upload the AutoCFG file to the server using HT3’s File Upload tool (see "Using Status, Reporting and System Tools" in the HT3 User Guide for information on this tool).
   a. Select Upload from HT3’s Tools menu.
   b. Click TCU Auto-Download Configuration File from the Send Files to the Server list.
   c. Click Browse and select the .autocfg file you saved in step 5. Click Submit.
   d. The screen displays the message "File transfer successful" along with information on the file submitted (file name, size, and type).
   e. The AutoCFG file is now stored on the server and will automatically be sent to the corresponding TCU when that TCU is powered up with the "3" on the keypad held down.

**IMPORTANT**: AutoCFG files need to be stored for each station even if they use the same configuration. Repeat the steps above for each TCU station that you want to create an AutoCFG file for.
Appendix

- **Changing Timeout and Retries Count**
- **TCU Address-Option-Value Map**
- **Methods for Selecting Addresses**
- **File Naming Conventions**
- **Valid File Locations**

**Changing Timeout and Retries Count**
When performing a **Send or a Get**, you can change the length of time to wait for a response (timeout) and the number of times to send the message before considering it failed (retries).

- Timeout can be set to 10, 20, 30, 40, 50, or 60 seconds by selecting a value from the **timeout** drop-down list before clicking Yes. The default timeout is 20 seconds.
- Retries can be set to 1, 2, 3, 4, 5, or 6 by selecting a value from the **retries** drop-down list before clicking Yes. The default retries setting is 1.

**TCU Address-Option-Value Map**
The table below (TCU Address-Option-Value Map) lists the address and possible values for each of the TCU Pump Controller options. Detailed descriptions for each of the pump controller configuration options can be found in **Navigating PLC Editor: TCU 90000 View**.

<table>
<thead>
<tr>
<th>Address</th>
<th>Option</th>
<th>Values / Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>5000-&gt;5005</td>
<td>TCU Reset</td>
<td>90000</td>
</tr>
<tr>
<td>5006-&gt;500B</td>
<td>Configuration ID</td>
<td>Maximum of nine characters (nine numbers, or eight numbers and a decimal point).</td>
</tr>
<tr>
<td>500C-&gt;5011</td>
<td>Number of pumps</td>
<td>1, 2, or 3</td>
</tr>
<tr>
<td>5012-&gt;5017</td>
<td>Transducer type</td>
<td>1=Float; 2=4-20mA; 3=5v; 4=Remote</td>
</tr>
<tr>
<td>5018-&gt;501D</td>
<td>Enable Low Float</td>
<td>5=Disable; 6=Enable</td>
</tr>
<tr>
<td>501E-&gt;5023</td>
<td>Enable High Float</td>
<td>5=Disable; 6=Enable</td>
</tr>
<tr>
<td>5024-&gt;5029</td>
<td>Fault Mode</td>
<td>31=Disable; 32=Timer; 33=Analog 2; 50=Floats</td>
</tr>
<tr>
<td>502A-&gt;502F</td>
<td>Enable Alarm Horn</td>
<td>5=Disable; 6=Enable</td>
</tr>
<tr>
<td>5030-&gt;5035</td>
<td>Enable Alarm Light</td>
<td>5=Disable; 6=Enable</td>
</tr>
<tr>
<td>5036-&gt;503B</td>
<td>Enable Auto Retry</td>
<td>5=Disable; 6=Enable</td>
</tr>
<tr>
<td>503C-&gt;5041</td>
<td>Alternate Mode</td>
<td>34=None; 35=All; 36=pumps 1 and 2; 37=pumps 2 and 3</td>
</tr>
<tr>
<td>5042-&gt;5047</td>
<td>Flow Equalization (feet)</td>
<td>DFS only</td>
</tr>
<tr>
<td>5048-&gt;504D</td>
<td>Pump Start Fault Delay</td>
<td>0-510 seconds</td>
</tr>
<tr>
<td>504E-&gt;5053</td>
<td>Pump Stop Fault Delay</td>
<td>0-510 seconds</td>
</tr>
<tr>
<td>5054-&gt;5059</td>
<td>Unused</td>
<td>999999</td>
</tr>
<tr>
<td>505A-&gt;505F</td>
<td>Auxiliary Output</td>
<td>7=On; 8=Off (used to configure Time Delay Relay)</td>
</tr>
<tr>
<td>5060-&gt;5065</td>
<td>Auxiliary Delay</td>
<td>0-510 seconds (used to configure Time Delay Relay)</td>
</tr>
<tr>
<td>5066-&gt;506B</td>
<td>Auxiliary Input</td>
<td>7=On; 8=Off (used to configure Time Delay Relay)</td>
</tr>
<tr>
<td>506C-&gt;5071</td>
<td>Low Engineering Value (feet)</td>
<td>0-60 feet (low value of the primary analog transducer's range)</td>
</tr>
<tr>
<td>5072-&gt;5077</td>
<td>High Engineering Value (feet)</td>
<td>0-60 feet (high value of the primary analog transducer's range)</td>
</tr>
<tr>
<td>5078-&gt;507D</td>
<td>Analog 2 Low (feet)</td>
<td>0-60 feet (low value of the secondary analog transducer's range)</td>
</tr>
<tr>
<td>507D-&gt;5083</td>
<td>Analog 2 High (feet)</td>
<td>0-60 feet (high value of the secondary analog transducer's range)</td>
</tr>
<tr>
<td>5084-&gt;5089</td>
<td>Low Float</td>
<td>0-60 feet</td>
</tr>
<tr>
<td>508A-&gt;508F</td>
<td>Lead Off</td>
<td>0-60 feet</td>
</tr>
<tr>
<td>5090-&gt;5095</td>
<td>Lag 1 Off</td>
<td>0-60 feet</td>
</tr>
<tr>
<td>5096-&gt;509B</td>
<td>Lag 2 Off</td>
<td>0-60 feet</td>
</tr>
<tr>
<td>509C-&gt;50A1</td>
<td>Lead On</td>
<td>0-60 feet</td>
</tr>
<tr>
<td>50A2-&gt;50A7</td>
<td>Lag 1 On</td>
<td>0-60 feet</td>
</tr>
<tr>
<td>50A8-&gt;50AD</td>
<td>Lag 2 On</td>
<td>0-60 feet</td>
</tr>
<tr>
<td>50AE-&gt;50B3</td>
<td>High Float</td>
<td>0-60 feet</td>
</tr>
<tr>
<td>50B4-&gt;50B9</td>
<td>Minimum Run</td>
<td>0-120 minutes in 1/10 minute increments (minimum time a pump must run before it can be turned off)</td>
</tr>
<tr>
<td>50BA-&gt;50BF</td>
<td>Minimum Off</td>
<td>0-120 minutes in 1/10 minute increments (minimum time a pump must stay off before it can be started)</td>
</tr>
<tr>
<td>Address Range</td>
<td>Description</td>
<td>Details</td>
</tr>
<tr>
<td>---------------</td>
<td>----------------------------------</td>
<td>----------------------------------------------</td>
</tr>
<tr>
<td>50C0-&gt;50C5</td>
<td>Phase Monitor Lo Alarm</td>
<td>151-300 volts in 1-volt increments</td>
</tr>
<tr>
<td>50C6-&gt;50CB</td>
<td>Phase Monitor Hi Alarm</td>
<td>151-300 volts in 1-volt increments</td>
</tr>
<tr>
<td>50CC-&gt;50D1</td>
<td>Well Volume</td>
<td>0-9999 gallons</td>
</tr>
<tr>
<td>50D2-&gt;50D7</td>
<td>Flow Units</td>
<td>9=MGD; 10=GPM</td>
</tr>
<tr>
<td>50D8-&gt;50DD</td>
<td>Unused</td>
<td>999999</td>
</tr>
<tr>
<td>50DE-&gt;50E3</td>
<td>Unused</td>
<td>999999</td>
</tr>
<tr>
<td>50E4-&gt;50E9</td>
<td>Pump Mode</td>
<td>26=Down; 27=Up</td>
</tr>
<tr>
<td>50EA-&gt;50EF</td>
<td>Phase Monitor Range</td>
<td>28=120 VAC; 29=240 VAC; 30=480 VAC</td>
</tr>
<tr>
<td>50F0-&gt;50F5</td>
<td>Aux Alarm</td>
<td>5=Disable; 6=Enable (enable auxiliary input alarm)</td>
</tr>
<tr>
<td>50F6-&gt;50FB</td>
<td>Aux Open/Closed</td>
<td>39=Open; 40=Closed (define alarm state for auxiliary input alarm)</td>
</tr>
<tr>
<td>50FC-&gt;5101</td>
<td>Bus Extender Modules</td>
<td>0-8 (number of modules on the RTU Bus that are connected by the BEM)</td>
</tr>
<tr>
<td>5102-&gt;5107</td>
<td>Trend Rate (sec)</td>
<td>2-999 seconds (frequency that the default status screen’s trend is updated)</td>
</tr>
<tr>
<td>5108-&gt;510D</td>
<td>H Modbus Address</td>
<td>Used when polling Modbus slave devices: 0.0000-99.49999 (device ID/node and starting register to be queried)</td>
</tr>
<tr>
<td>510E-&gt;5113</td>
<td>H Modbus Count</td>
<td>Number of registers to query - Digital status: 1-12; Digital control: 1-8; Analog: 1-4</td>
</tr>
<tr>
<td>5114-&gt;5119</td>
<td>I Modbus Address</td>
<td>Used when polling Modbus slave devices: 0.0000-99.49999 (device ID/node and starting register to be queried)</td>
</tr>
<tr>
<td>511A-&gt;511F</td>
<td>I Modbus Count</td>
<td>Number of registers to query - Digital status: 1-12; Digital control: 1-8; Analog: 1-4</td>
</tr>
<tr>
<td>5120-&gt;5125</td>
<td>J Modbus Address</td>
<td>Used when polling Modbus slave devices: 0.0000-99.49999 (device ID/node and starting register to be queried)</td>
</tr>
<tr>
<td>5126-&gt;512B</td>
<td>J Modbus Count</td>
<td>Number of registers to query - Digital status: 1-12; Digital control: 1-8; Analog: 1-4</td>
</tr>
<tr>
<td>512C-&gt;5131</td>
<td>K Modbus Address</td>
<td>Used when polling Modbus slave devices: 0.0000-99.49999 (device ID/node and starting register to be queried)</td>
</tr>
<tr>
<td>5132-&gt;5137</td>
<td>K Modbus Count</td>
<td>Number of registers to query - Digital status: 1-12; Digital control: 1-8; Analog: 1-4</td>
</tr>
<tr>
<td>5138-&gt;513D</td>
<td>L Modbus Address</td>
<td>Used when polling Modbus slave devices: 0.0000-99.49999 (device ID/node and starting register to be queried)</td>
</tr>
<tr>
<td>513E-&gt;5143</td>
<td>L Modbus Count</td>
<td>Number of registers to query - Digital status: 1-12; Digital control: 1-8; Analog: 1-4</td>
</tr>
</tbody>
</table>
### Methods for Selecting Addresses

- To select a range of addresses, click the first address in the range and then hold down Shift and click the last address in the range.

- To select multiple individual addresses, hold down Ctrl while clicking each desired address.

- To select all addresses, select All from the Select menu.

- To deselect all addresses, select None from the Select menu.

- To select only the addresses used by a TCU using the built-in pump control program, select TCU Addresses from the Select menu.

### File Naming Conventions

It is good practice to make the configuration's filename descriptive of the PLC or TCU's telemetry location. Use the station number and driver number to create the filename. For example, a PLC located at station 16, driver 0, would be given the filename st_0_016.plc (st_[driver#]_[station#].plc).

In the future, if you need to make changes to any of the PLC or TCU's values, it will be easy to locate the exact file that you need. Also, if you want to use this same configuration for another PLC or TCU, you can easily locate the file, make any necessary changes, and then save it with a new filename that reflects the second PLC or TCU's telemetry location.

### Valid File Locations

PLC Editor files can only be saved in and opened from one of the directories listed below (or a subdirectory contained therein). If you try to save a file to a different directory, you will get an "I/O error writing file ..." error. Attempting to open a file from a different directory results in an "I/O error reading file ..." error.
- Windows 95/98/ME - For computers running Windows 95/98/ME, the files can only be saved to the C:\My Documents directory.

- Windows 2000 / NT / XP - For computers running these versions of the Windows operating system, the files can only be saved to the home directory (C:\Documents and Settings) of the user that is currently logged in. For example, C:\Documents and Settings\jane, where jane is the Windows user name of the individual currently logged in.

- Windows Vista / 7 - For computers running these versions of the Windows operating system, the files can only be saved to the home directory (C:\Users) of the user that is currently logged in. For example, C:\Users\jane, where jane is the Windows user name of the individual currently logged in.

The Java policy file that you installed on your computer when it was first set up to connect to HT3 controls where files can be saved to and opened from. The Java policy file is designed to protect your computer from "hostile" Java applets that could try to access or damage the data on your computer (for example, to insert a virus). The HT3 policy file gives HT3's Java applets permission to write to specific directories on your computer. In effect, the policy file says that only Java applets from this server can write to this computer’s drive; and this server can only write to this specific directory (and any subdirectories contained therein).

If you want to keep your files in their own directory, you can create a folder within your user directory (location based on your operating system, see list above) and save the files there.

If you need to store a file in another location (for example, a backup location on your network server), save the file to the correct directory (e.g., Documents and Settings) and then copy it to the backup location. Additionally, to open a file that is stored in another directory, you must first copy the file to the correct directory (e.g., Documents and Settings).
8 Screen Builder

HT3’s Screen Builder application lets you create a graphical representation of your telemetry system. By building a screen - using text, images, objects, and animation - and then linking the screen’s components to actual telemetry points, you can get a quick, real-time view of your operation.

For example, you can build a screen that shows the flow of a pump or the level in a well, and then link it, using the point’s address, to the physical hardware located in the field. This linking lets you create a virtual picture of how the equipment is operating; the screen mimics the activity of the equipment.

- Introduction
- Object Types
- Screen Building Basics
- Working with Objects
- Appendix
Introduction

With HT3’s Screen Builder application, you can create a graphical representation of your telemetry system. Building a screen using text, images, objects, and animation and linking the screen’s components to telemetry points gives you a real-time view of your operation.

For example, you can build a screen that shows the flow of a pump or the level in a well to create a virtual picture of how the equipment is operating – the screen mimics the activity of the equipment.

Screens created in Screen Builder are viewed in HT3’s Custom Screen Viewer. The first screen you must create is the Base screen. The Base screen is similar to the home page of a website. It is the first screen displayed when you start Custom Screen Viewer.

From the Base screen, you link to other custom screens using hyperlinks, or URLs. For example, the Base screen can include an object that links to another custom screen that displays a list of all of your lift stations. This second custom screen could have links to other custom screens that represent the individual lift stations.

Below is a sample of the type of screen you can build with Screen Builder.

To get started with Screen Builder:

- Starting and Exiting Screen Builder
- The Screen Builder Interface (menus, message bar, and workspace)
- Screen Building Basics
- Object Types
- Working with Objects
Starting and Exiting Screen Builder

Starting Screen Builder

**Note:** To save custom screens, you must be logged in to HT3 with an account that has Configure Screens permission. See "Configuring Your System: User Accounts” in the *HT3 User Guide* for more information on permissions.

1. Click **Build** on the HT3 main menu.

2. Click **Screens** on the Build submenu. Screen Builder opens in a new browser window. (**Note:** When you start Screen Builder, the screen most recently viewed in Custom Screen Viewer is opened by default. To have Screen Builder open a new file, hold down Shift while clicking **Screens**.)

Exiting Screen Builder

Choose **Exit** from Screen Builder's File menu.

If you have made changes to a screen and have not saved it, a dialog box opens with the message that the screen has not been saved and prompts you to **Cancel** or **Discard** the changes.

Click **Cancel** to exit the dialog box. Save your work and then try exiting again. If you don't want to save the changes, click **Discard**. Any changes made to the current screen will not be saved when Screen Builder closes.

The Screen Builder Interface

The Screen Builder interface includes:

- **Menu toolbar** - Located along the top of the interface, the menu toolbar contains all of Screen Builders available options, functions and features.

- **Message bar** - Located at the bottom of the Screen Builder interface, the message bar gives you additional information on the functions you are performing (for example, the x- and y-coordinates of an object, the type of object currently selected, or the name of the user logged on).

- **Workspace**
The Menu toolbar contains the following:

- File menu
- Edit menu
- Screen menu
- Object menu
- Align menu
- Static menu
- Digital menu
- Analog menu
- Pipe menu
- Help menu

**Note:** Some menu items have a keyboard shortcut listed next to them. To perform the function from the keyboard instead of through the menu, simply hold down the displayed keys simultaneously. See [Keyboard Shortcuts](#) for a listing of all shortcuts and their functions.
File Menu

From the File menu, you can perform the following actions:

- **New** - Create a new screen.
- **Open** - Open a screen that was saved to the Hyper SCADA Server. To open a screen file that was saved to your computer, use the Open File command.
- **Open File** - Open a screen file that was saved to your computer (see Save As File, below). To open a screen that was saved to the Hyper SCADA Server, use the Open command.
- **Save** - Save the current screen to the Hyper SCADA Server. To save a copy of the screen to your computer, use the Save As File command.
- **Save As** - Give the screen a name and save it to the Hyper SCADA Server. To save a copy of the screen to your computer, use the Save As File command.
- **Save As File** - Use this option to save the screen file to your computer. See Valid File Locations for important information on where screen files can be saved.
- **Remove** - Permanently remove a custom screen from the Hyper SCADA Server. (IMPORTANT: A screen that has been deleted from the Hyper SCADA Server cannot be restored.)
- **Exit** - Exit Screen Builder.

Edit Menu

From the Edit menu, you can perform the following actions:

- **Undo** - Undo the last action.
- **Cut** - Remove the selected item and place it on the clipboard.
- **Copy** - Copy the selected item and place it on the clipboard.
- **Paste** - Paste text from the clipboard to a new location.
- **Delete** - Permanently remove the selected item.

The Cut, Copy, Paste and Delete functions can be simultaneously performed on multiple objects by creating groupings of objects. See Selecting Multiple Objects for instructions on creating object groupings.

For more information on using these commands, see Editing Objects with the Edit Menu.

Screen Menu

From the Screen menu, you can perform the following actions:
• **Refresh** - **Update the status** of all objects on the screen.

• **Animate** - **Animate objects**. Screen reflects status of objects at the time Animate was selected, i.e., status isn’t “live.” *(Note: Animation only occurs for animated objects in the correct state, e.g., a digital spinner spins when its point is on.)*

• **Parts** - Save a screen's objects (all objects or select objects) to a single file. This template can then be inserted into other screens. You can also select groups of objects to save to a file. See **Working with Screen Parts (Template Files)**.

• **Station** - **Change the station number** for all objects on the screen. Performs a search and replace of the database. All addresses that include old station number will be changed to reflect new station number.

• **Size** - **Set the size of the screen** (in pixels). The default screen size is 600 x 420 pixels.

### Object Menu

From the Object menu, you can perform the following actions:

• **Refresh** - **Update the status of the selected object**. If the object is static, the Message bar displays "Cannot refresh STATIC object."

• **Fields** - Open the **Inspector window**, which lists the properties for the selected object. Inspector can also be opened by right clicking an object.

• **to Front** - **Move the selected object to the very front** (top) when objects are layered, or stacked, one on top of the other.

• **Forward** - **Move the selected object forward one layer** when objects are layered, or stacked, one on top of the other.

• **Backward** - **Move the selected object backward one layer** when objects are layered, or stacked, one on top of the other.

• **To Back** - **Move the selected object to the very back** (bottom) when objects are layered, or stacked, one on top of the other.

• **Duplicate** - **Create an exact duplicate of the selected object** or group of objects. See **Selecting Multiple Objects** for instructions on creating object groupings.

• **Select Behind** - **Select the object that is directly behind the selected object**. This function is useful when objects are layered and one object is "hidden" by another object.

### Align Menu

From the Align menu, you can perform the following actions:

• **Left** - **Align the selected object(s) horizontally along the left edge** of the reference object (the first object selected, or clicked).
• **Center** - Align the selected object(s) horizontally in the center of the reference object.

• **Right** - Align the selected object(s) horizontally along the right edge of the reference object.

• **Top** - Align the selected object(s) vertically along the top edge of the reference object.

• **Middle** - Align the selected object(s) vertically in the middle of the reference object.

• **Bottom** - Align the selected object(s) vertically along the bottom edge of the reference object.

## Static Menu

From this menu, you can add static objects to your screen. Static objects are those that have no status, that is, they are not linked to digital, analog, or virtual points. They are added for visual effect.

Each of these objects has properties that affect its appearance.

See [Object Types: Static Objects](#) for graphical examples of each object and links to more detailed information on their fields and instructions for adding them to screens.

- **Text** - Add a static text object. Can be used for screen titles or table headings, for example.

- **3D Text** - Add a static three-dimensional static text object. Similar to the object above, but the border is three-dimensional. You can make the object look like a raised or lowered button.

- **Banner Text** - Add a static scrolling marquee object. This object can accept a text string of up to 90 characters long. The scrolling speed and the color of the background and the text can also be controlled.

- **Image** - Add a static image; file must be available in the HT3 image library. See [Choosing Colors and Images](#).

- **Rectangle** - Add a static rectangle.

- **3D Rectangle** - Add a static three-dimensional rectangle. Similar to the object above, but the border is three-dimensional. You can make the object look like a raised or lowered button.

- **Round Rectangle** - Add a static rectangle that has rounded corners.

- **Oval** - Add a static oval. This circular object can resemble an oval or circle by changing its width and height.

- **Tick Mark** - Add a static measuring tool (resembles a ruler).

- **Grid** - Add a static grid (graph). This object is most often used as a background for an analog trend line.

- **Gradient** - Add a static square, or rectangular, object that gradates from one color to another.

## Digital Menu

From this menu, you can add digital objects to your screen. Digital objects are linked to digital addresses.
Each of these objects has properties that affect its appearance and behavior.

See **Object Types: Digital Objects** for graphical examples of each object and links to more detailed information on their fields and instructions for adding them to screens. (**Note:** CONTROL RECTANGLE and GRAPHIC CONTROL are the only objects that can be used to control a digital point.)

- **Text** - Add a digital text object. The text displayed changes to reflect the status of its associated point.

- **Graphic** - Add a digital image. Variations of the same graphic can be used to indicate the associated point's status. For example, the image has color when the point is on and is gray and/or black when the point is off. Two image files would be required - one with color, one without color. The files must be available in HT3's image library. See **Choosing Colors and Images**.

- **Rectangle** - Add a digital rectangle. This object's color and text can change to reflect the status of its associated point.

- **3D Rectangle** - Add a digital three-dimensional rectangle. Similar to the object above, but the border is three-dimensional. You can make the object look like a raised or lowered button.

- **Round Rectangle** - Add a digital round rectangle. Similar to the rectangle, but has corners that are rounded. The degree to which the corners are rounded can be controlled. Object can appear more square or more round.

- **Oval** - Add a digital oval. This circular object can resemble an oval or circle by changing its width and height. This object's color and text can change to reflect the status of its associated point.

- **Arrow** - Add a digital arrow-shaped LED object that can change color to reflect the digital point's current status. The direction of the arrow can be controlled and the arrow can be displayed with or without a tail.

- **Animation** - Add a digital animated image. This object appears to move when its associated point is on. The system creates animation by taking 2 or more images and displaying them in a continuous loop. Each image is slightly different, so that when they are displayed in this loop it appears as if the object is moving. The process is similar to drawing a ball on a pad of paper with the location of the ball slightly different on each page. When you quickly flip the pages, it appears as if the ball is bouncing along the pages. All files must be available in HT3's image library. See **Choosing Colors and Images**.

- **Switch** - Add a digital switch that can be used to control a digital control. This switch can be one of three types - rocker, lever (toggle switch), or slider - and can be configured with an LED that changes color to reflect the digital point's current state.

- **Graphic Control** - Add a digital control image that represents a control point, e.g., a switch. The point associated with this object can be controlled, by clicking the object, when the screen is viewed in Custom Screen Viewer. The image changes when control is employed - it shows the switch as being off or on. The image file must be available in HT3’s image library. See **Choosing Colors and Images**.

- **Control Rectangle** - Add a digital control rectangle. Similar to a rectangle except that the point associated with this object can be controlled, by clicking the object, when the screen is viewed in Custom Screen Viewer.
• **4-State Rectangle** - Add a digital 4-state rectangle. Similar to a static rectangle except that the point associated with this object can be in one of four states (0, 1, 2, or 3), opposed to one of two states (0 or 1).

• **4-State Graphic** - Add a digital 4-state graphic. Similar to a static graphic except that the point associated with this object can be in one of four states (0, 1, 2, or 3), opposed to one of two states (0 or 1). Variations of the same graphic can be used to indicate the associated point's status. For example, a display light indicator that is blue in 0 state, green in 1 state, yellow in 2 state, violet in 3 state, and red when in alarm. Five image files would be required - one for each state. The file must be available in HT3’s image library. See Choosing Colors and Images.

• **4-State Text** - Add a digital 4-state text object. The text displayed changes to reflect the status of its associated point. Similar to a static text object except that the point associated with this object can be in one of four states (0, 1, 2, or 3), opposed to one of two states (0 or 1).

## Analog Menu

From this menu, you can add analog objects to your screen. Analog objects are linked to analog addresses.

Each of these objects has properties that affect its appearance and behavior.

See Object Types: Analog Objects for graphical examples of each object and links to more detailed information on their fields and instructions for adding them to screens.

• **Text** - Add an analog text object. The text displayed changes to reflect the specified address' current value.

• **LED Text** - Add an analog object that displays the current value of an analog point in a format that mimics an LED text display. This object can also be used to automatically link to another screen after a timer expires.

• **Panel** - Add an analog panel. The text displayed changes to reflect the specified address' current value.

• **Gauge** - Add an analog gauge that has a needle that moves to reflect the specified address' current value.

• **LED Gauge** - Add an analog gauge that displays the current value of an analog point. The tick marks on the gauge can be labeled. The gauge can be configured with low, warning, alarm, and high values; the ranges between these values can be color coded to make it easy to identify the point’s current status.

• **Dial** - Add an analog indicator line that can be used to create a dial. The line moves in a clockwise or counterclockwise direction that reflects the specified address' current value. This object usually has a static rectangle or oval as its background. After you add a DIAL object to your screen, enter a temporary value in the Value field. The DIAL object doesn't show anything while offline. Entering a temporary value enables you to see the DIAL object's indicator line and make any adjustments to line color, width, position and movement.

• **Rotary** - Add an analog rotary gauge that displays the current value of an analog point. If the "rotate" option is enabled, the gauge appears to spin, or rotate.
• **Bar Graph** - Add an analog bar graph. The text displayed and the object's appearance change to reflect the specified address' current value. The graph's properties can be set so that it fills from left to right or top to bottom.

• **LED Bar** - Add an analog LED bar that appears to illuminate as the point's value changes within a specified range. The bar can be configured with low, warning, alarm, and high values; the ranges between these values can be color coded to make it easy to identify the point's current status.

• **Color** - Add an analog object that is rectangular or oval in shape and whose color changes to reflect the specified address' current value.

• **Control** - Add an analog control object. Similar to a digital control rectangle. The analog point associated with this object can be controlled, by clicking the object, when the screen is viewed in Custom Screen Viewer.

• **Slider** - Add an analog slider object that can be used to change the value of an analog control point.

• **Trend** - Add an analog trend line that tracks historical data, similar to that of a chart recorder. This object usually has a static grid as its background.

• **Time** - Add an object that displays the server's current time of day (enter STATIC in the ADDR field) or displays run time (enter the address for a virtual point that calculates the number of seconds a logical input is in the ON state).

• **Time Control** - Add an object that controls, based on time, a telemetry point. This object is linked to a USER virtual point that is used in a comparison (for example, is the current time equal to the value input to the USER virtual point through TIME CONTROL). When the comparison is true, the specified action is taken.

### Pipe Menu

From this menu, you can add pipe and elbow objects to your screen. Certain of these objects can be linked to analog or digital points; others are static.

Each of these objects has properties that affect its appearance and behavior.

See [Object Types: Pipe Objects](#) for graphical examples of each object and links to more detailed information on their fields and instructions for adding them to screens.

• **Gradient Pipe** - Add an analog pipe image that gradates from one color to another. Pipes can be vertical or horizontal. Arrows (animated or static) can be added to the pipe to illustrate flow.

• **Gradient Elbow** - Add a static pipe elbow image that gradates from one color to another. The direction of the elbow's curve can be controlled.

• **Valve** - Add a digital valve that can change color to reflect its current state.

• **Spinner** - Add a digital spinner. This object appears to spin when its associated point is on and can be set up to flash when the point is in alarm.
- **Digital Pipe** - Add a digital pipe image. Joints can be added to one or both ends of a pipe. Pipes can be vertical or horizontal. The color of the pipe can change to reflect the status of the object's address, e.g., the pipe's color changes to blue, it appears filled when the pump it is associated with is on.

- **Digital Elbow** - Add a digital pipe elbow image. The direction of the elbow's curve can be controlled. The color of the elbow can change to reflect the status of the object's address, e.g., the pipe's color changes to blue, it appears filled when the pump it is associated with is on.

- **Static Pipe** - Add a static pipe image. Joints can be added to one or both ends of a pipe. Pipes can be vertical or horizontal.

- **Static Elbow** - Add a static pipe elbow image. The direction of the elbow's curve can be controlled.

### Help Menu

From the Help menu, you can perform the following actions:

- **About** - Gives you information on the version of Screen Builder being run and the server to which you are connected. This information is displayed in the Message bar.

- **Browse Help** - Opens Screen Builder's User Guide.

- **Test Server** - Debugging tool used to test communication with the server if you are having problems, e.g., saving your screens, or if the server seems slow. Results are displayed in the Message bar.

- **Reclaim Memory** - Reclaims memory from the cache and returns it to the operating system. Use this when your system seems sluggish. Results are displayed in the Message bar.
Object Types

Screen Builder features three types of objects:

- **Static** - Objects that aren't linked to an active point. Static objects are used strictly for adding visual interest and depth to your screens. They can be used to create a background, a heading, or to add detail to your screen.

- **Digital** - Objects that are linked to digital points (digital input or digital output). Digital objects mimic the activity, the state, of the digital points to which they are linked. If you have a digital point that tells you that a pump is running and that point is linked to a digital object, for example, a spinner, the spinner will rotate when the pump is on.

- **Analog** - Objects that are linked to analog points (analog input, analog output, or pulse counters). Analog objects, like digital objects, mimic the activity of the analog points to which they are linked. An analog gauge object linked to a point that monitors a live gauge, which is reading a well level, will display the well's real-time level. When the well is at 45 feet, the analog object displays that reading.

**Note**: The Pipe menu contains static and digital objects.

See [Common Fields](#) for definitions of the fields/properties common to all objects.

For graphical examples of each object and links to more detailed information on their fields and instructions for adding them to screens, see:

- Analog Objects
- Digital Objects
- Pipe Objects
- Static Objects

Common Fields

Each object, regardless of its type static, analog, or digital has the following properties:

- **ADDR (field 1)** - Address of the point to which this object is linked. If the object is static, the word STATIC appears in this field and can't be modified.

- **XLOC (field 2)** - X coordinate, or horizontal position, of the object. Zero (0) places the object to the extreme left of the screen. Increasing this number moves the object to the right.

- **YLOC (field 3)** - Y coordinate, or vertical position, of the object. Zero (0) places the object at the top of the screen. Increasing this number moves the object towards the bottom of the screen.

- **TYPE (field 4)** - Type of point to which this object is linked. Valid types are AO, AI, DO, DI, DP (pulse), and ST (static).

- **OBJECT (field 5)** - Type of object selected. This field can't be modified.
Fields 6-9 are common to all objects but differ in their use depending on the object selected. For graphical examples of each object and links to more detailed information on their fields and instructions for adding them to screens, see Static Objects, Digital Objects, Analog Objects, and Pipe Objects.

URL (field 10) address of a Web page that is opened when this object is clicked. Not valid with control objects.

The fields listed after URL (field 10) set the parameters for each object. These fields differ by object. For graphical examples of each object and links to more detailed information on their fields and instructions for adding them to screens, see Static Objects, Digital Objects, Analog Objects and Pipe Objects.

**Analog Objects**

HT3’s Screen Builder provides six analog objects you can use when building a screen. Analog objects are linked to analog points and mimic their activity.

Below is a list of the available analog objects along with an example of each.

The links provided in the Description column open pages that provide information on each object's properties and instructions for adding it to a screen.

<table>
<thead>
<tr>
<th>Object Name</th>
<th>Example</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>BAR GRAPH</td>
<td><img src="image" alt="Bar Graph Example" /></td>
<td>Object resembling a bar graph that can be linked to an analog input (monitor) point. The bar fills as the point's value increases and empties as the value decreases. Variables, including bar color, background color, graph's low and high limits, and units to display (e.g., FT or PSI), can be adjusted. This object can also be configured as a link to another screen or an HTML page. <a href="#">Properties of the Analog Bar Graph object</a> <a href="#">Instructions for adding an Analog Bar Graph object</a></td>
</tr>
<tr>
<td>COLOR</td>
<td><img src="image" alt="Color Example" /></td>
<td>Rectangular object that can be linked to an analog input (monitor) point and whose color and text can change when the point's value changes. As the point's value increases or decreases, the object's color gradually shifts between the start color (the point’s low limit) and the end color (the point’s high limit). This object can also be configured as a link to another screen or an HTML page. <a href="#">Properties of the Analog Color object</a> <a href="#">Instructions for adding an Analog Color object</a></td>
</tr>
<tr>
<td>Object</td>
<td>Description</td>
<td>Properties</td>
</tr>
<tr>
<td>---------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>-------------------------------------------------</td>
</tr>
<tr>
<td>CONTROL</td>
<td>Object that can be used to control the value of an analog output (control) point. The object can be drawn horizontally or vertically and the high and low limits can appear at the top or bottom (for horizontal objects) or left or right (for vertical objects). The object fills left to right, or top to bottom, to show the point's current value. When the object is clicked, an editable field appears in the center of the object. Type the value to control the point to and press enter.</td>
<td>Properties of the Analog Control object</td>
</tr>
<tr>
<td>DIAL</td>
<td>Object that resembles the hand on a gauge. It can be linked to an analog input (monitor) point and paired with another object (e.g., RECTANGLE or OVAL) to create a custom gauge. The high and low degree limits of the dial as well as the high and low value limits to display for the point can be adjusted. This object can also be configured as a link to another screen or an HTML page.</td>
<td>Properties of the Analog Dial object</td>
</tr>
<tr>
<td>GAUGE</td>
<td>Object resembling a gauge that can be linked to an analog input (monitor) point and can display the current value of the point in text and on the gauge’s dial. The lowest and highest limits, including resolution, that should be displayed can be adjusted as well as the type of units to display, for example, FT, PSI, DegF. This object can also be configured as a link to another screen or an HTML page.</td>
<td>Properties of the Analog Gauge object</td>
</tr>
<tr>
<td>LED BAR</td>
<td>Object similar to the BAR GRAPH except the graph is made up of individual bars that light or dim as the point's value increases and decreases. The bars can be color coded to indicate the point is in a safe range or a warning range (elevated but not yet in alarm), or has entered the alarm state. The high and low limits for each range and the colors associated with them can be adjusted. This object can also be configured as a link to another screen or an HTML page.</td>
<td>Properties of the Analog LED Bar object</td>
</tr>
<tr>
<td>Object</td>
<td>Description</td>
<td>Properties</td>
</tr>
<tr>
<td>--------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>LED GAUGE</td>
<td>Similar to the GAUGE except that the dial can be color coded to indicate that the value of the analog input point is in the safe range or warning range (elevated but not yet in alarm), or has entered the alarm state. The high and low limits for each range and the colors associated with them can be adjusted. This object can also be configured as a link to another screen or an HTML page.</td>
<td>Properties of the Analog LED Gauge object</td>
</tr>
<tr>
<td>LED TEXT</td>
<td>LED text object that can display the current value of an analog input (monitor) point. Properties such as the LED color, background color, decimal places to display, and displaying a + or - character to indicate positive and negative values can be adjusted. This object can also be used to create a slide-show affect by configuring it with a countdown time and a URL instead of an analog input point address. The screen will automatically load the page specified in the URL field when the countdown timer has expired. This object can also be configured as a manual link to another screen or an HTML page.</td>
<td>Properties of the Analog LED Text object</td>
</tr>
<tr>
<td>PANEL</td>
<td>Object resembling a control panel display that can be linked to an analog input (monitor) point and can display the current value of the point. The lowest and highest limits, including resolution, that should be displayed can be adjusted as well as the type of units to display, for example, FT, PSI, DegF. This object can also be configured as a link to another screen or an HTML page.</td>
<td>Properties of the Analog Panel object</td>
</tr>
<tr>
<td>ROTARY</td>
<td>Object resembling a rotary gauge that can be linked to an analog input (monitor) point and can display the current value of the point on the gauge’s dial. Colors for the center of the rotary and the outside edges can be adjusted to give the object a curved look. The object can be drawn vertically or horizontally. Variables such as the range of values visible on the rotary's face, value of each of the gauge's major tick marks and minor tick marks can be adjusted. This object can also be configured as a link to another screen or an HTML page.</td>
<td>Properties of the Analog Rotary object</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Instructions for adding an Analog Rotary object</td>
</tr>
<tr>
<td>---</td>
<td>---</td>
<td>---</td>
</tr>
<tr>
<td><strong>SLIDER</strong></td>
<td><img src="image" alt="Slider" /></td>
<td>Similar to the CONTROL object except that the point is controlled by moving the slider. When the slider is moved, a value appears next to it to indicate the value that position represents. Variables such as orientation (horizontal or vertical), pointer and track style, colors (background, track, text), and text size can be adjusted.</td>
</tr>
<tr>
<td><strong>TEXT</strong></td>
<td><img src="image" alt="Text" /></td>
<td>Simple text object that can be linked to an analog input (monitor) point. The object's text can change to reflect the point's current value. When this object's point is in alarm, the text flashes red. Features, including the text to be displayed for each state, text color and size, and background color, can be adjusted. This object can also be configured as a link to another screen or an HTML page.</td>
</tr>
<tr>
<td><strong>TIME</strong></td>
<td><img src="image" alt="Time" /></td>
<td>Object that can display the server's current time or can be linked to a virtual point that calculates the number of seconds a logical input is in the ON state (for example, pump run time). When linked to this type of virtual point, TIME will display (and continually and automatically update) the value of the specified virtual point. The object can be configured to show date and time and can display one of four date formats. Characteristics such as background color and text color can also be adjusted.</td>
</tr>
<tr>
<td><strong>TIME CONTROL</strong></td>
<td><img src="image" alt="Time Control" /></td>
<td>Similar to the TIME object except that TIME CONTROL can be linked to a virtual analog input point that allows a user to enter the time when a certain action should occur (for example turning on an irrigation system). When the TIME CONTROL object is clicked, an editable box appears in the center of the object. The user enters the desired time (in hours and minutes) and presses the Enter key. When that time is reached, the control will occur.</td>
</tr>
</tbody>
</table>
The TIME CONTROL object converts the time entered to seconds after midnight, which is easy to compare to the current time of day in the ladder logic that controls the irrigation system. For example, you want to control when an irrigation system comes on. In Virtual Logic Builder, logic is created where the time to control the event is provided by an Analog Input virtual point (e.g., V_SPRINK_ON). The virtual point is used in a comparison equation (when the current time is equal to the time specified by the virtual point V_SPRINK_ON, the control point that regulates the irrigation system is activated). On the custom screen, the Analog TIME CONTROL object would be linked to the virtual point V_SPRINK_ON.

Properties of the Analog Time Control object
Instructions for adding an Analog Time Control object

| TREND | ![TREND](image) | Object that can be linked to an analog input (monitor) point and that can display changes in the point’s value via a trend line. Variables, including the range of the trend (high and low limits), the span of time (in minutes) to display, and the color of the line, can be adjusted. This object can also be configured as a link to another screen or an HTML page.

Properties of the Analog Trend object
Instructions for adding an Analog Trend object

Digital Objects

HT3’s Screen Builder provides fourteen digital objects you can use when building a screen. Digital objects are linked to digital points and mimic their activity (ON, OFF, ALARM, initial state). (Note: CONTROL RECTANGLE and GRAPHIC CONTROL are the only objects that can be used to control a digital point.)

Below is a list of the available digital objects along with an example of each.

The links provided in the description column open pages that provide information on each object’s properties and instructions for adding it to a screen.

<table>
<thead>
<tr>
<th>Object Name</th>
<th>Example</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>3D RECTANGLE</td>
<td><img src="image" alt="Silenced" /></td>
<td>Similar to a RECTANGLE except that it features a three-dimensional border. The color and width of the border can be adjusted. This object can also be configured as a link to another screen or an HTML page.</td>
</tr>
</tbody>
</table>

Properties of the Digital 3D Rectangle object
Instructions for adding a Digital 3D Rectangle object
<table>
<thead>
<tr>
<th><strong>4-STATE GRAPHIC</strong></th>
<th><img src="image" alt="4-STATE GRAPHIC" /></th>
</tr>
</thead>
<tbody>
<tr>
<td>Similar to a <strong>4-STATE RECTANGLE</strong>, except that the object can be configured to display a different .gif image for each of its four states as well as the initial and alarm states. This object can also be configured as a link to another screen or an HTML page.</td>
<td></td>
</tr>
<tr>
<td><strong>Properties of the Digital 4-State Graphic object</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Instructions for adding a Digital 4-State Graphic object</strong></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>4-STATE RECTANGLE</strong></th>
<th><img src="image" alt="4-STATE RECTANGLE" /></th>
</tr>
</thead>
<tbody>
<tr>
<td>Rectangular object that can be linked to a four-state digital point. This object can display one of four states: 0 (zero), 1 (one), 2 (two) or 3 (three). The object can be configured to display a different color for each of the four states. This object can also be configured as a link to another screen or an HTML page.</td>
<td></td>
</tr>
<tr>
<td><strong>Properties of the Digital 4-State Rectangle object</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Instructions for adding a Digital 4-State Rectangle object</strong></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>4-STATE TEXT</strong></th>
<th><img src="image" alt="4-STATE TEXT" /></th>
</tr>
</thead>
<tbody>
<tr>
<td>Similar to a <strong>4-STATE RECTANGLE</strong>, except that the object can be configured to display a different text label for each of its four states. This object can also be configured as a link to another screen or an HTML page.</td>
<td></td>
</tr>
<tr>
<td><strong>Properties of the Digital 4-State Text object</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Instructions for adding a Digital 4-State Text object</strong></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>ANIMATION</strong></th>
<th><img src="image" alt="ANIMATION" /></th>
</tr>
</thead>
<tbody>
<tr>
<td>Animated object that can be linked to a digital input (monitor) point. The object is animated when the point is in the ON state. The animation is accomplished using a series of .gif images each of which is drawn slightly different to mimic movement when played in sequence. Different .gif files can be specified for the OFF, initial, and alarm states. This object can also be configured as a link to another screen or an HTML page.</td>
<td></td>
</tr>
<tr>
<td><strong>Properties of the Digital Animation object</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Instructions for adding a Digital Animation object</strong></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>ARROW</strong></th>
<th><img src="image" alt="ARROW" /></th>
</tr>
</thead>
<tbody>
<tr>
<td>Arrow-shaped object that can be linked to a digital input (monitor) point and whose color can change to reflect the point’s current status. The ON and OFF colors, arrow direction, and tail size can be adjusted. This object can also be configured as a link to another screen or an HTML page.</td>
<td></td>
</tr>
<tr>
<td><strong>Properties of the Digital Arrow object</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Instructions for adding a Digital Arrow object</strong></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>CONTROL RECTANGLE</strong></th>
<th><img src="image" alt="CONTROL RECTANGLE" /></th>
</tr>
</thead>
<tbody>
<tr>
<td>Rectangular object that can be linked to a digital output (control) point. This object can be used to force a point to a specific state by clicking the object (turning the button on or off). The object’s color and text can change when the point’s state changes. The ON and OFF colors and text can be specified as well as the text color and size, and border color and size.</td>
<td></td>
</tr>
<tr>
<td><strong>Properties of the Digital Control Rectangle object</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Instructions for adding a Digital Control Rectangle object</strong></td>
<td></td>
</tr>
<tr>
<td>Object Type</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>GRAPHIC</td>
<td>Object that can be linked to a digital input (monitor) point and can display a different image for each of the point's possible states (ON, OFF, initialized, alarm). The object can be configured to display an ON and OFF text label, and it can also be configured as a link to another screen or an HTML page.</td>
</tr>
<tr>
<td>Properties of the Digital Graphic object</td>
<td></td>
</tr>
<tr>
<td>Instructions for adding a Digital Graphic object</td>
<td></td>
</tr>
<tr>
<td>GRAPHIC CONTROL</td>
<td>Object that can be linked to a digital output (control) point and can display a different image for each of the point's possible states (ON, OFF, initialized, alarm). This object can be used to force a point to a specific state by clicking the object.</td>
</tr>
<tr>
<td>Properties of the Digital Graphic Control object</td>
<td></td>
</tr>
<tr>
<td>Instructions for adding a Digital Graphic Control object</td>
<td></td>
</tr>
<tr>
<td>OVAL</td>
<td>Round object that can be linked to a digital input (monitor) point and whose color and text can change to reflect the point's current status (ON or OFF). By manipulating the height and the width, the object can be made to have a more circular or more oval shape. The object can be drawn with or without a border. Features such as border color and size, and text color and size can be adjusted. This object can also be configured as a link to another screen or an HTML page.</td>
</tr>
<tr>
<td>Properties of the Digital Oval object</td>
<td></td>
</tr>
<tr>
<td>Instructions for adding a Digital Oval object</td>
<td></td>
</tr>
<tr>
<td>RECTANGLE</td>
<td>Rectangular object that can be linked to a digital input (monitor) point and whose color and text can change when the point's status changes. The ON and OFF colors and text can be specified as well as the text color and size, and border color and size. This object can also be configured as a link to another screen or an HTML page.</td>
</tr>
<tr>
<td>Properties of the Digital Rectangle object</td>
<td></td>
</tr>
<tr>
<td>Instructions for adding a Digital Rectangle object</td>
<td></td>
</tr>
<tr>
<td>ROUND RECTANGLE</td>
<td>Similar to the RECTANGLE except that it features rounded corners. The amount of curve at the corners can be adjusted to make the object appear more square or more round. This object can also be configured as a link to another screen or an HTML page.</td>
</tr>
<tr>
<td>Properties of the Digital Round Rectangle object</td>
<td></td>
</tr>
<tr>
<td>Instructions for adding a Digital Round Rectangle object</td>
<td></td>
</tr>
<tr>
<td>SWITCH (ROCKER)</td>
<td>Object resembling a switch (rocker-, lever-, or slider-type switch) that can be linked to a digital output (control) point. This object can be used to force a point to a specific state by clicking the object (turning the switch on or off). Options such as switch type and color, LED display, and switch border can be adjusted.</td>
</tr>
<tr>
<td>Properties of the Digital Switch object</td>
<td></td>
</tr>
<tr>
<td>Instructions for adding a Digital Switch object</td>
<td></td>
</tr>
<tr>
<td>SWITCH (LEVER)</td>
<td>Object resembling a switch (rocker-, lever-, or slider-type switch) that can be linked to a digital output (control) point. This object can be used to force a point to a specific state by clicking the object (turning the switch on or off). Options such as switch type and color, LED display, and switch border can be adjusted.</td>
</tr>
<tr>
<td>Properties of the Digital Switch (LEVER) object</td>
<td></td>
</tr>
<tr>
<td>Instructions for adding a Digital Switch (LEVER) object</td>
<td></td>
</tr>
</tbody>
</table>
**Switch (Slider)**

Simple text object that can be linked to a digital input (monitor) point. The object's text can change to reflect the point's current state (ON or OFF). When this object's point is in alarm, the text flashes red. Features, including the text to be displayed for each state, text color and size, and background color, can be adjusted. This object can also be configured as a link to another screen or an HTML page.

- Properties of the Digital Text object
- Instructions for adding a Digital Text object

---

**Pipe Objects**

HT3's Screen Builder provides six analog objects you can use when building a screen. Analog objects are linked to analog points and mimic their activity.

Below is a list of the available analog objects along with an example of each.

The links provided in the Description column open pages that provide information on each object's properties and instructions for adding it to a screen.

<table>
<thead>
<tr>
<th>Object Name</th>
<th>Example</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>DIGITAL ELBOW</td>
<td><img src="image1.png" alt="Image" /></td>
<td>Object resembling a pipe elbow that can be linked to a digital input (monitor) point. The object can be configured with a different color for each of its possible states -- on, off, and initial (point isn't off line, but doesn't yet have status). The orientation of the elbow (north-east, north-west, south-east, or south-west) can also be adjusted. This object can also be configured as a link to another screen or an HTML page.</td>
</tr>
<tr>
<td>DIGITAL PIPE</td>
<td><img src="image2.png" alt="Image" /></td>
<td>Object resembling a length of pipe that can be linked to a digital input (monitor) point. The object can be configured with a different color for each of its possible states -- on, off, and initial (point isn't off line, but doesn't yet have status). The pipe can be drawn with joints at one or both ends, or can be drawn with no joints. The orientation of the pipe (horizontal or vertical) can also be adjusted. This object can also be configured as a link to another screen or an HTML page.</td>
</tr>
<tr>
<td>Object Name</td>
<td>Description</td>
<td>Properties of the Object</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>----------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Static Elbow (Static)</td>
<td>Static object (cannot be linked to a point) resembling a length of pipe. The orientation of the elbow (north-east, north-west, south-east, or south-west) and the color of the elbow can be adjusted. This object can also be configured as a link to another screen or an HTML page.</td>
<td>Properties of the Static Elbow object</td>
</tr>
<tr>
<td>Gradient Pipe (Digital)</td>
<td>Animated pipe object that can be linked to a digital input (monitor) point. The object is darker at the edges to make it appear three-dimensional. When the point is on, the arrows in the pipe are animated to mimic movement. The object can be configured to show static arrows when the point is off. Features such as the color of the pipe and the arrows, and the size and orientation of the pipe can be adjusted. This object can also be configured as a link to another screen or an HTML page.</td>
<td>Properties of the (Digital) Gradient Pipe object</td>
</tr>
<tr>
<td>Gradient Elbow (Static)</td>
<td>Static object (cannot be linked to a point) that can be paired with the Gradient Pipe. Features such as the color, size, and orientation of the pipe can be adjusted. This object can also be configured as a link to another screen or an HTML page.</td>
<td>Properties of the (Static) Gradient Elbow object</td>
</tr>
<tr>
<td>Spinner (Digital)</td>
<td>Animated object that can be linked to a digital input (monitor) point. When the point is on, the spinner is animated to mimic rotation. Additionally, the spinner can be configured with a different color for each of its possible states -- on, off, initial (point isn't off line, but doesn't yet have status), and alarm. The spin speed can be adjusted and the object can be configured to flash when the point is in alarm. This object can also be configured as a link to another screen or an HTML page.</td>
<td>Properties of the (Digital) Spinner object</td>
</tr>
</tbody>
</table>

**Instructions for adding a Static Elbow object**

**Instructions for adding a (Digital) Gradient Pipe object**

**Instructions for adding a (Static) Gradient Elbow object**

**Instructions for adding a (Digital) Spinner object**

**Instructions for adding Static Elbow object**
STATIC PIPE

Static object (cannot be linked to a point) resembling a length of pipe. The pipe can be drawn with joints at one or both ends, or can be drawn with no joints. The orientation of the pipe (horizontal or vertical) and the color of the pipe can be adjusted. This object can also be configured as a link to another screen or an HTML page.

Properties of the Static Pipe object

Instructions for adding Static Pipe object

VALVE (Digital)

Object resembling a pipe valve that can be linked to a digital input (monitor) point. The valve can be configured to change color when the point's state changes. Features such as the ON and OFF color, and the size and orientation of the valve can be adjusted. Additionally, the valve can be drawn with or without a handle. This object can also be configured as a link to another screen or an HTML page.

Properties of the (Digital) Valve object

Instructions for adding a (Digital) Valve object

Static Objects

HT3’s Screen Builder provides ten static objects you can use when building a screen. Static objects aren’t linked to an active point, but are useful in creating visual effects.

Below is a list of the available static objects along with an example of each.

The links provided in the Description column open pages that provide information on each object's properties and instructions for adding it to a screen.

<table>
<thead>
<tr>
<th>Object Name</th>
<th>Example</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>3D RECTANGLE</td>
<td><img src="image" alt="3D Rectangle" /></td>
<td>Similar to the RECTANGLE except that it features a three-dimensional border. The color and width of the border can be adjusted. This object can also be configured as a link to another screen or an HTML page.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Properties of the Static 3D Rectangle object</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Instructions for adding a Static 3D Rectangle object</td>
</tr>
<tr>
<td>3D TEXT</td>
<td><img src="image" alt="3D Text" /></td>
<td>Similar to the TEXT object, except that it features a three-dimensional border. The color and width of the border can be adjusted. This object can also be configured as a link to another screen or an HTML page.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Properties of the Static 3D Text object</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Instructions for adding a Static 3D Text object</td>
</tr>
<tr>
<td>OBJECT</td>
<td>DESCRIPTION</td>
<td></td>
</tr>
<tr>
<td>-----------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td></td>
</tr>
<tr>
<td>BANNER TEXT</td>
<td>Text object resembling a scrolling LED marquee that accepts up to 90 characters. Properties such as the LED color, background color, and scrolling speed can be adjusted. This object can also be configured as a link to another screen or an HTML page.</td>
<td></td>
</tr>
<tr>
<td><strong>Properties of the Static Banner Text object</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Instructions for adding a Static Banner Text object</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>GRADIENT</td>
<td>Object that features a background that gradates (or shifts) from one color to another. This object can be used to give shading and depth to items such as tanks, pipes, or the sky. GRADIENT can be rectangular or oval in shape. The beginning and ending colors and the direction of the gradient (top to bottom; left to right) can be adjusted. This object can also be configured as a link to another screen or an HTML page.</td>
<td></td>
</tr>
<tr>
<td><strong>Properties of the Static Gradient object</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Instructions for adding a Static Gradient object</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>GRID</td>
<td>Rectangular object that has a grid as its background and also features high and low limit lines. This object is especially useful as a background for an Analog TREND. Features including the value of the low and high limit lines, the object’s orientation (vertical or horizontal), and the color of the limit lines can be adjusted. This object can also be configured as a link to another screen or an HTML page.</td>
<td></td>
</tr>
<tr>
<td><strong>Properties of the Static Grid object</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Instructions for adding a Static Grid object</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>IMAGE</td>
<td>This object can display a .gif file or a snap shot from a network camera. It can also be configured as a link to another screen or an HTML page.</td>
<td></td>
</tr>
<tr>
<td><strong>Properties of the Static Image object</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Instructions for adding a Static Image object</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>OVAL</td>
<td>A building block object similar to the RECTANGLE. The OVAL can be used as the background for other objects or can be used to represent items such as tanks or ponds. By manipulating the object’s height and width, the object can be made to have a more circular or more oval shape. The object can be drawn with or without a border. Features such as the background color and border color can be adjusted. This object can also be configured as a link to another screen or an HTML page.</td>
<td></td>
</tr>
<tr>
<td><strong>Properties of the Static Oval object</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Instructions for adding a Static Oval object</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>PATTERN (CHECKER)</td>
<td>This rectangular object features eight distinct backgrounds (checker, brick, sand, grass, diamond, steel, rain, and earth) and can be used to add visual interest to your screens. This object can also be configured as a link to another screen or an HTML page.</td>
<td></td>
</tr>
</tbody>
</table>
| PATTERN (BRICK) | Properties of the Static Pattern object  
Instructions for adding a Static Pattern object |
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>PATTERN (SAND)</td>
<td></td>
</tr>
<tr>
<td>PATTERN (GRASS)</td>
<td></td>
</tr>
<tr>
<td>PATTERN (DIAMOND)</td>
<td></td>
</tr>
<tr>
<td>PATTERN (STEEL)</td>
<td></td>
</tr>
<tr>
<td>PATTERN (RAIN)</td>
<td></td>
</tr>
<tr>
<td>PATTERN (EARTH)</td>
<td></td>
</tr>
</tbody>
</table>
| RECTANGLE      | Rectangular object that can be used as a building block for screens. It can be used as the background for an entire screen or to create structures such as buildings or to represent grass or the sky. It can be configured with or without a border. Features such as background color, border color and width can be adjusted. This object can also be configured as a link to another screen or an HTML page.  
Properties of the Static Rectangle object  
Instructions for adding a Static Rectangle object |
| RESIZABLE IMAGE | This object can display a .gif, .jpg, or .png file or a snap shot from a network camera. It can also be configured as a link to another screen or an HTML page. The image can be resized, rotated, and flipped; hue, saturation and brightness can be adjusted; also supports transparency.  
Properties of the Static Resizable Image object  
Instructions for adding a Static Resizable Image object |
<table>
<thead>
<tr>
<th>Object</th>
<th>Description</th>
<th>Properties of the Static Object</th>
<th>Instructions for adding a Static Object</th>
</tr>
</thead>
<tbody>
<tr>
<td>ROUND RECTANGLE</td>
<td>Similar to the RECTANGLE except that it features rounded corners. The amount of curve at the corners can be adjusted to make the object appear more square or more round. This object can also be configured as a link to another screen or an HTML page.</td>
<td><a href="#">Static Round Rectangle</a></td>
<td><a href="#">Instructions for adding a Static Round Rectangle</a></td>
</tr>
<tr>
<td>TEXT</td>
<td>Simple text object that can be used as a label or a short block of text. Up to 4 lines of text with up to 12 characters on each line can be accommodated. Features such as text size and color, and background color can be adjusted. This object can also be configured as a link to another screen or an HTML page.</td>
<td><a href="#">Static Text</a></td>
<td><a href="#">Instructions for adding a Static Text object</a></td>
</tr>
<tr>
<td>TICK MARK</td>
<td>Similar to a ruler in appearance, this object can be used as a visual measurement of an analog value (such as well level or PSI) when paired with an Analog TREND or Analog SLIDER. Features including the direction and number of tick marks can be adjusted. This object can also be configured as a link to another screen or an HTML page.</td>
<td><a href="#">Static Tick Mark</a></td>
<td><a href="#">Instructions for adding a Static Tick Mark object</a></td>
</tr>
</tbody>
</table>
Screen Building Basics

- The Base and Partition Screens
- Creating a New Screen
- Setting Screen Size
- Saving a Screen or Screen File
- Opening a Screen or Screen File
- Opening an Existing Screen
- Working with Screen Parts (Template Files)
- Deleting a Custom Screen
- Adding and Organizing Images
- Refreshing and Animating Screens
- Changing Station Number References
- Poll After Control

The Base and Partition Screens

The Base Screen

The first screen you must create for your system is the Base screen. The Base screen is similar to a home page for a website. It is the first screen displayed when you open Custom Screen Viewer.

From the Base screen, you link - directly or indirectly - to all your other custom screens using hyperlinks, or URLs. See Linking to Screens, Trends and HTML Pages for more information on linking your screens.

For example, on your Base screen you can create an object that links to another custom screen that displays a listing of all of your lift stations. This second custom screen could then contain links to other custom screens that represent the individual lift stations.

Note: The Base screen must be saved with the name base. See Saving a Screen or Screen File.

The Partition Screen

A Partition screen is similar to the Base screen except that only users logged into that partition will see this as their opening screen (the first screen displayed when Custom Screen Viewer is started).
The file name for a Partition screen must match the name of the partition. For a partition named "South," there must be a custom screen with a filename of "South." If no such screen exists, HT3 will open the Base screen.

For more information on partitions, see "Configuring Your System: Partitions" in the HT3 User Guide.

Creating a New Screen

Before you begin building a screen, make sure you are logged in and have the proper permissions. You won't be able to save your work unless you are logged in and have been granted configuration permission by your system administrator. For more information on permissions, see "Configuring Your System: Users" in the HT3 User Guide.

➢ To create a new screen, choose New from the File menu.

If a screen with unsaved changes is already open and you attempt to open another file, a dialog box appears with a message telling you that the current file hasn't been saved and asking if you want to discard these changes.

Click Cancel to exit the dialog box. Save your work and then try creating a new file again. If you don't want to save the changes, click Discard. Any changes made to the current screen are not saved and a new screen is created.

Setting Screen Size

Once you have created a new screen, you can begin setting its specifications, starting with screen size. With the Size command, you can set the dimensions for your screen. The default size is 600x420 (measured in pixels), but you can increase and/or decrease the height and width.

1. Choose Size from the Screen menu.

2. Enter the desired dimensions in the Width and Height boxes.

3. Click Resize to save the setting or Cancel to exit the dialog box without changing the screen size.

Saving a Screen or Screen File

Screens can be saved to the Hyper SCADA Server for viewing in Custom Screen Viewer. They can also be saved to a computer, which is useful for creating a screen template that can be shared with another user or for creating a backup copy of the screen's properties and layout.

Screen Builder has three save commands in the File menu.

• Save As - Use this option when you initially save and name the screen. The screen is saved to the Hyper SCADA Server and can be viewed in Custom Screen Viewer.
- **Save** - Update the current screen on the Hyper SCADA Server after making changes. Use this to periodically save your work as you create and edit the screen.

- **Save As File** - Save the screen's properties to a .csv file on a computer.

**IMPORTANT:** Be careful about synchronizing screens stored on the Hyper SCADA Server and screens stored on a computer to avoid overwriting a screen with an old copy of a .csv file.

### Saving a Screen on the Hyper SCADA Server

1. Choose **Save As** from the **File** menu.

2. Enter a name for your screen and click **OK**. Click **Cancel** to exit the dialog box without saving your screen.

3. If the name already exists, a dialog box appears with the message “[database name] already exists. Replace?”

   ![Save As Dialog](image)

   To replace the existing screen with the new one, click **Replace**. If you don’t want to replace the existing screen, click **Cancel** and then try saving the screen again with another name.

4. To periodically save your work to the Hyper SCADA Server, choose **Save** from the **File** menu.

### Saving a Screen File on Your Computer

You typically save screens on the Hyper SCADA Server, but you can also save a .csv file of the screen's properties on a computer. Saving on a computer is useful for creating a template or for creating a backup of the screen's properties and layout.

**Notes:**

- The **Save As File** command creates a .csv file.

- This method does **not** save the screen's images on your computer. Use HT3’s File Download Utility to download the screen’s images.
Screen files must be saved to a specific location based on the computer's operating system (see Valid File Locations).

Saving a Screen File

**IMPORTANT:** Be careful about synchronizing screens stored on the Hyper SCADA Server and screens stored on a computer to avoid overwriting a screen with an old copy of a .csv file.

1. Choose **Save As File** from the **File** menu.
2. Browse to the **correct file location for your operating system**.
3. Enter a file name for the screen and click **Save**.

Valid File Locations

When a computer is configured to access HT3, a Java policy file is installed. The Java policy controls where screen files (and files from other HT3 Java applets) can be saved to and opened from. The Java policy file is designed to protect the computer from "hostile" Java applets that could try to access or damage the data on the computer (for example, to insert a virus). See Getting Started: Workstation Configuration in the main HT3 Users Guide.

Screen files must be saved to and opened from the home directory (or a subfolder of the home directory) of the Windows user currently logged in. (This is the Windows user name; not the HT3 user name.)

You will get an “I/O error reading file…” error if you try to save or open a file from a different directory.

<table>
<thead>
<tr>
<th>Windows 8, 7, and Vista</th>
<th>C:AUsers&lt;username&gt;</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>(where &lt;username&gt; is the Windows user name of an individual who is accessing HT3 from this workstation)</td>
</tr>
<tr>
<td>Windows XP</td>
<td>C:Documents and Settings</td>
</tr>
</tbody>
</table>
Opening a Screen or Screen File

When you create a screen, you save it on the Hyper SCADA Server so it can be viewed in HT3. You can also save the screen on your computer as a .csv file (useful for making a backup of the screen's properties).

**IMPORTANT:** Be careful about synchronizing screens stored on the Hyper SCADA Server and screens stored on a computer to avoid overwriting a screen with an old copy of a .csv file.

You can open a:

- screen that is stored on the Hyper SCADA Server, or
- screen file (.csv) that is stored on your computer.

Opening a Screen that Is Stored on the Hyper SCADA Server

1. On the **File** menu, click **Open**. The **Screen Builder: Open** dialog box opens. This dialog box lists all of the existing screen files.

![Screen Builder: Open dialog box]

2. Click the name of the screen and then click **Open**, or simply double-click the file name.

3. If a screen with unsaved changes is already open and you attempt to open another file, a dialog box appears with a message telling you that the current file hasn't been saved and asking if you want to discard these changes.
Click **Cancel** to exit the dialog box. Save your work and then try opening the file again.

If you don’t want to save the changes, click **Discard**. Any changes made to the current screen are not saved and the **Screen Builder: Open** dialog box opens.

### Opening a Screen File (.csv) that Is Stored on a Computer

The images for this screen must be uploaded to the Hyper SCADA Server if they are not already stored there. Use HT3’s File Upload utility to upload images.

To open a screen .csv file, it must be located in a specific directory (based on the computer’s operating system). See **Valid File Locations**.

1. On the **File** menu, click **Open File**.
2. Browse to the .csv file and click **Open**.
3. You can now save the file to the Hyper SCADA Server if desired.

### Working with Screen Parts (Template Files)

Screen Builder provides you with a way of saving all or part of a screen to a single file. This allows you to create and save a template that can be used to make other screens. Screen parts are useful for making identical or near identical screens for multiple stations, points, etc.

- **Creating and Saving a Template (Screen Parts)**
- **Inserting a Screen Parts File into a Screen**
- **Deleting a Screen Parts File**

See also **Changing Station Number References** for information on finding a station number referenced in the current screen and replacing it with a new station number.

### Creating and Saving a Template (Screen Parts)

1. Create or open the screen that will be used as the template.
2. Select the objects to be saved to the file. See **Selecting Multiple Objects** for more information.
3. With the objects selected, choose **Parts** from the **Screen** menu.

4. Click **Store**.

   ![Screen Builder screenshot](image)

   5. Type a name for the screen part file and click **Store** again.

### Inserting a Parts File into a Screen

After saving screen parts (multiple screen objects) to a file, you can easily place them in existing or newly created screens.

1. Create a new screen or open an existing screen.

2. Choose **Parts** from the **Screen** menu.

3. From the list of screen parts files, select the file to be inserted and click **Insert**. The selected file's objects are placed in the active screen.

**Note**: Each object in a screen parts file can be edited (moved, sized, etc.) after the file is inserted into the active screen. Although the objects are placed on the screen in a group, they remain individual objects.

### Deleting a Screen Parts File

To delete unused or obsolete screen parts files:

1. Choose **Parts** from the **Screen** menu.

2. From the list of screen parts files, select the file to be deleted and click **Clear**. The selected screen part file is removed from the list.
Deleting a Custom Screen

IMPORTANT: When you remove a custom screen, it is permanently deleted from the server. It cannot be restored. Any screens that include links to the removed screen need to be updated.

1. Choose **Remove** from the **File** menu. The **Remove** dialog box opens.

![Screen Builder: Remove...](image)

2. Locate the screen that you want to remove and click **Remove**. To exit the dialog box, click **Cancel**. If **Remove** is clicked, a dialog box with the message "Remove [screen name]: Are you sure?" opens. The Message bar displays "Removal is permanent and there is no undo."

![Screen Builder: Remove...](image)

To remove the custom screen, click **Remove**. To exit the dialog box without removing the custom screen, click **Cancel**.

Importing and Organizing Images

Importing and Adding Images to the HT3 Screen Builder Library

HT3 provides a library of images to use in your custom screens, but you aren't limited to these. You can add your own images. These can be images you create yourself or images you download from the Internet.

Valid file types are:

- .gif
- .jpg
- .png

Image filenames **must not** contain spaces. Use a dash (-) or underscore (_) in file names. For example, filled-tank.png
Filenames must be no more than 21 characters not including the dot and filename extension - .gif, .jpg, .png (total of 25 characters including the dot and filename extension)

Images can be imported into the image library using HT3’s Upload tool. Once an image has been imported, you can assign it to a category as described in Organizing Images, below.

Organizing Images

You can organize your images into categories using Screen Builder’s Image Picker.

- Opening Image Picker
- Adding and Removing Categories
- Adding an Image to a Category

Opening Image Picker

1. On a blank screen, add a Static Image (select Image from the Static menu). Inspector should open when the object is added. If it does not, choose Fields from the Object menu.

2. To open the Image Picker, click the name of the field that contains the image’s file name. For a Static Image, you would click image. See example below.

3. On the left side of the Image Picker is a list of available categories. The images assigned to the selected category are shown on the right side of the Image Picker. (Note that images can be assigned to multiple categories.)
Adding and Removing Categories

- To add a new category, open Image Picker, click Add, enter a name for the category, and click OK.

- To remove a category, open Image Picker, select the name of the category you want to remove and click Remove. Note that only the category name is removed; images that were assigned to that category are still available from the "All Images" category.

Adding an Image to a Category

When you upload an image using HT3’s upload tool, it is placed in "Uncategorized Images."

You can add an image to one (or more) categories by dragging the image over the desired category name.

1. Locate the image in "Uncategorized Images."
2. Select the image and drag it over the name of the category you want to add it to.

![Image Picker](image1.png)

3. Add the image to a second category (if desired): Locate the image in the category you assigned it to in step 2. Drag it over the name of the second category.

![Image Picker](image2.png)

**Refreshing and Animating Screens**

Screen Builder features two methods for testing the appearance and behavior of your screens.

- With the **Refresh command**, you can update the status of all the objects on your screen or you can refresh a single object. Refreshing is similar to taking a snapshot of your screen showing the current status and activity.

- The **Animate command** allows you to see how the animated objects on your screen will look and behave when receiving live data.
Refreshing Objects

With the Refresh command, you can update the status of all the objects on your screen or you can choose one object to refresh. It's similar to taking a static picture of your screen showing the current status and activity.

Refreshing a Single Object
To refresh the status of a single object:

1. Click the object that you want to refresh that status of.
2. Choose Refresh from the Object menu. The object's current status is visible on the screen.

Refreshing All Objects on a Screen
To refresh the status of the entire screen, choose Refresh from the Screen menu. The current status of all active objects is visible on the screen.

As you are building your screen, periodically choose Refresh from the Screen menu to see how it will look in action.

Animating Objects

The Animate command allows you to see how the animated objects on your screen will look and behave when receiving live data.

1. Click the object you want to animate.
2. If you have entered a live telemetry address for the object, choose Refresh from the Screen menu to update the object's status. If you want to test the animation without entering a live telemetry address, choose Fields from the Object menu, or simply right click the object to open Inspector. Enter a value in Inspector's Value box.
3. Choose Animate from the Screen menu.
4. To turn off animation, click anywhere on your screen.

Changing Station Number References

With the Station command, you can find a specific station number referenced in the currently opened screen and replace it with a new station number prefix.

For example, you've built a screen with points that reference station number 3. You have a second station that has an identical configuration. Instead of creating a screen from scratch or editing the address of each object on the existing screen, you can use the Station command to replace all instances of station number 3 with the new station prefix and save the screen with a new file name.

1. Open the screen you want to edit.
2. Choose Station from the Screen menu to open the Screen Builder: Station dialog box.
3. Enter the old station number in the **Old Prefix** box and the new station number in the **New Prefix** box.

4. Click **Change** to change the station number prefix or **Cancel** to exit without making changes. The Message bar reads "[#] address fields replaced" (where # indicates the number of object addresses changed).

5. Choose **Save As** from the **File** menu and save the screen with a new file name.

### Poll After Control

Control objects have additional parameters to tell the driver to poll a specified module at a station after the control is done. This feature provides operators with quick results of the control regardless of where the driver is in the polling loop.

Note that the system isn't polling an individual point. The system polls the module that the point is on to give you the status of all the points on that module.

This function requires you to specify the station and module to be polled and how long to wait before polling. This function can be used with any control object.

**Examples:**

- An operator turns a pump on at station 17 on driver 1 at digital control point address 1017A1. The operator expects to see a check valve open at digital monitor point 1017B9 within 10 seconds. In this example, you would configure a PollAddr=1017B and PollDelay=10.

- An operator turns a well on at station 5 on driver 0 at digital control point 5A1. The operator expects to see flow increase at station 20 analog monitor point 20C1 within 15 seconds. In this example, you would configure PollAddr=20C and PollDelay=15.
Working with Objects

- Adding Analog Objects
- Adding Digital Objects
- Adding Pipe Objects
- Adding Static Objects
- Viewing Object Properties with Inspector
- Editing Objects
- Linking to Screens, Trends and HTML Pages
- Choosing Colors and Images
- Moving and Layering Objects
- Adding Network Camera Images to Screens
Adding Analog Objects

Below are detailed instructions for adding each of Screen Builder's analog objects.

- **Bar Graph**
- **Color**
- **Control**
- **Dial**
- **Gauge**
- **LED Bar**
- **LED Gauge**
- **LED Text**
- **Panel**
- **Rotary**
- **Slider**
- **Text**
- **Time**
- **Time Control**
- **Trend**

Adding an Analog Bar Graph

See also [Object Types: Analog Objects](#) and [Object Properties: Analog Bar Graph](#).

1. Choose **Bar Graph** from the **Analog** menu. The object appears on the screen and the Inspector window, listing all the default properties for this object, opens. Information on each field displays at the bottom of the Inspector window when you place your cursor within a field's input box.

2. You are now ready to begin manipulating the object's properties. **(Note: You must press the ENTER key each time you make a direct change to any field in the Inspector window. If you enter incorrect data in any Inspector input box, the message "***THAT ENTRY IS NOT VALID***" appears at the bottom of the Inspector window.)**

**Linking to an analog point**

Link this object to an analog point by entering the address (station, module, point number) in the **ADDR** box. You can also click **ADDR** to open the Address Selection Tool and browse to the point. Creating a link to an active point allows the object to mimic its activity. When the well level is at 30 ft, the object displays this level.

**Changing the object's position**
Click on the object and hold down the left mouse button. The pointer turns into a four-headed arrow. You can now move the object in any direction by simply dragging it. For finer control of movement, select the object and use the arrow keys on your keyboard to move the object one pixel at a time.

Move the object to a specific location by changing the XLOC (horizontal position) and the YLOC (vertical position) values. A 0 (zero) in both of these boxes places the object in the top left corner of the screen. Increasing the XLOC value moves the object farther to the right. Increasing the YLOC value moves it farther down the screen.

Setting limits

Set the low and high limits of this point, including resolution, in the lowLimit and highLimit boxes. lowLimit can be the low engineering value of the point or some higher value depending on your needs. The same is true for highLimit. It can be the high engineering value of the point or some lower value.

For example, you have a temperature gauge with a low engineering value of 0 degrees F and a high engineering value of 100 degrees F. You are only concerned with the activity between 0 and 10 degrees F and you want the gauge to display the temperature to one hundredths of a degree, you would set the lowLimit at 0.00 and the highLimit at 10.00.

The type of units to display is set by entering a text string in the units box. Examples of units are FT, PSI, DegF.

Overlaying an image

It is possible to overlay the bar graph with an image, for example, a chlorinator, from HT3’s image library. Click image in Inspector to select an image (see Choosing Colors and Images for more information).

Sizing the object

Click on the object. Handles (small white boxes) appear around the object. "Grab" a handle by clicking on it. Notice that all the other handles become black in color. Hold down the left mouse button and drag the selected handle to increase or decrease the object’s size.

Set the object to a specific size by entering values (measured in pixels) in the widthDim and heightDim boxes.

Setting the object’s orientation

To have the bar graph appear vertically, enter V in the vertical box (limitsPosition must be set to L [left] or R [right]).

To have the bar graph appear horizontally, enter H in the vertical box (limitsPosition must be set to T [top] or B [bottom]).

Selecting the object’s color

Set the color of the "filled" area of the bar graph by clicking foregroundColor in Inspector. When the Color dialog box opens, select a color from the list or enter a hexadecimal number in the RGB boxes. Use Bright and Dark to control the color’s intensity (light or dark).
Set the color of the background (unfilled area) of the bar graph by clicking `backgroundColor` in Inspector. When the `Color` dialog box opens, select a color from the list or enter a hexadecimal number in the RGB boxes. Use `Bright` and `Dark` to control the color's intensity (light or dark).

**Controlling text appearance**

To have text indicating the point's current value display on the bar graph enter `Y` in the `showText` box. Enter `N` to turn off display.

Set the color of the text that displays the point's current value by clicking `textColor` in Inspector. When the `Color` dialog box opens, select a color from the list or enter a hexadecimal number in the RGB boxes. Use `Bright` and `Dark` to control the color's intensity (light or dark).

To have text indicating the point's low and high limits display on the bar graph enter `Y` in the `showLimits` box. Enter `N` to turn off display.

Set the color of the text that displays the point's low and high limits display on the bar graph by clicking `limitsColor` in Inspector. When the `Color` dialog box opens, select a color from the list or enter a hexadecimal number in the RGB boxes. Use `Bright` and `Dark` to control the color's intensity (light or dark).

The font size of the high and low limits text, and the current value text, can be controlled by entering a point size in the `Font Size` box.

The text for the high and low limits, and the current value, can be displayed in bold face text by entering `Y` in the `bold` box. For regular text, enter `N` in the `bold` box.

Set where the limits text displays by entering `L` (left), `R` (right), `T` (top), or `B` (bottom) in the `limitsPosition` box.

**Creating a link**

Create a hyperlink between this object and another screen or web page by:

- Clicking `URL` in Inspector and selecting a destination screen (the screen that loads when this object is clicked) from the Link dialog box.
- Typing the URL address for the destination screen or web page in the `URL` box. The URL address must be in the following format (you don't need to type in http://): [screen name].html For example, station1.html, where station1 is the name of the screen that loads when this object is clicked; or, www.dataflowsys.com to link to the DFS website.

3. Test the object's setup by entering a value in the `VALUE` box. This shows you how the object appears when it's reading actual data. Type an "A" after the value (for example, 10A) to see how the object will look when the point is in alarm.

4. Save your screen by choosing `Save` or `Save As` from the `File` menu.

**Adding an Analog Color Object**

See also **Object Types: Analog Objects** and **Object Properties: Analog Color**.
1. Choose **Color** from the **Analog** menu. The object appears on the screen and the Inspector window, listing all the default properties for this object, opens. Information on each field displays at the bottom of the Inspector window when you place your cursor within a field's input box.

2. You are now ready to begin manipulating the object's properties. (**Note**: You must press the ENTER key each time you make a direct change to any field in the Inspector window.) If you enter incorrect data in any Inspector field, the message "***THAT ENTRY IS NOT VALID***" appears at the bottom of the Inspector window.

### Linking to an analog point

Link this object to an analog point by entering the address (station, module, point number) in the **ADDR** box. You can also click **ADDR** to open the Address Selection Tool and browse to the point. Creating a link to an active point allows the object to mimic its activity. When the well level is at 30 ft, the object displays this level.

### Changing the object's position

Click on the object and hold down the left mouse button. The pointer turns into a four-headed arrow. You can now move the object in any direction by simply dragging it. For finer control of movement, select the object and use the arrow keys on your keyboard to move the object one pixel at a time.

Move the object to a specific location by changing the **XLOC** (horizontal position) and the **YLOC** (vertical position) values. A 0 (zero) in both of these fields places the object in the top left corner of the screen. Increasing the **XLOC** value moves the object farther to the right. Increasing the **YLOC** value moves it farther down the screen.

### Setting limits

Set the low and high limits of this point, including resolution, in the **lowLimit** and **highLimit** boxes. **lowLimit** can be the low engineering value of the point or some higher value depending on your needs. The same is true for **highLimit**. It can be the high engineering value of the point or some lower value.

For example, you have a temperature gauge with a low engineering value of 0 degrees F and a high engineering value of 100 degrees F. You are only concerned with the activity between 0 and 10 degrees F and you want the gauge to display the temperature to one hundredths of a degree, you would set the **lowLimit** at 0.00 and the **highLimit** at 10.00.

The type of units to display is set by entering a text string in the **units** box. Examples of units are FT, PSI, DegF.

### Selecting the object's shape

To give the object an oval shape, enter Y in the **drawOval** box. To give the object an angular, or square, shape, enter N in the **drawOval** box.

### Sizing the object

Click on the object. Handles (small white boxes) appear around the object. "Grab" a handle by clicking on it. Notice that all the other handles become black in color. Hold down the left mouse button and drag the selected handle to increase or decrease the object's size. Hold down the **SHIFT** button while dragging a handle to make the object square (width = height).

Set the object to a specific size by entering values (measured in pixels) in the **widthDim** and **heightDim** boxes.
Positioning the text

Set the text's alignment by entering a horizontal position (C=center, R=right, L=left) and then a vertical position (M=middle, T=top, B=bottom) in the justify box.

Set the horizontal margin (measured from the left or right of the object's edge, depending on its horizontal alignment) by entering an integer value in the insetX box. Set the vertical margin (as measured from the top or bottom of the object's edge, depending on its vertical alignment) by entering an integer value in the insetY box.

For example, entering 10 in both the insetX and insetY boxes and entering LT in the justify box, would position the text in the top left corner, 10 pixels from the left edge and 10 pixels from the top edge of the object.

Controlling text appearance

Set the color of the text by clicking textColor in Inspector. When the Color dialog box opens, select a color from the list or enter a hexadecimal number in the RGB boxes. Use Bright and Dark to control the color's intensity (light or dark).

Set text size by entering an integer value in the fontSize box.

For bold face text, enter Y in the bold box.

To turn off the text display, enter N in the showText box.

Selecting the object's color

Set the color to display when the specified address' value is at its lowLimit by clicking startColor in Inspector. When the Color dialog box opens, select a color from the list or enter a hexadecimal number in the RGB boxes. Use Bright and Dark to control the color's intensity (light or dark).

Set the color to display when the specified address' value is at its highLimit by clicking endColor in Inspector. When the Color dialog box opens, select a color from the list or enter a hexadecimal number in the RGB boxes. Use Bright and Dark to control the color's intensity (light or dark).

As the specified address' value increases or decreases, the object's color gradually shifts between the startColor and the endColor, and vice versa.

Controlling the border

Add a border to the object by entering Y in the drawBorder box.

Set the border's color by clicking borderColor in Inspector. When the Color dialog box opens, select a color from the list or enter a hexadecimal number in the RGB boxes. Use Bright and Dark to control the color's intensity (light or dark).

Creating a link

Create a hyperlink between this object and another screen or web page by:

- Clicking URL in Inspector and selecting a destination screen (the screen that loads when this object is clicked) from the Link dialog box.
• Typing the URL address for the destination screen or web page in the **URL** box. The URL address must be in the following format (you don't need to type in http://): [screen name].html For example, station1.html, where station1 is the name of the screen that loads when this object is clicked; or, www.dataflowsys.com to link to the DFS website.

3. Test the object’s setup by entering a value in the **VALUE** box. This shows you how the object appears when it’s reading actual data.

4. Save your screen by choosing **Save** or **Save As** from the **File** menu.

### Adding an Analog Control

See also **Object Types: Analog Objects** and **Object Properties: Analog Control**.

1. Choose **Control** from the **Analog** menu. The object appears on the screen and the Inspector window, listing all the default properties for this object, opens. Information on each field displays at the bottom of the Inspector window when you place your cursor within a field’s input box.

2. You are now ready to begin manipulating the object’s properties. (**Note:** You must press the ENTER key each time you make a direct change to any field in the Inspector window. If you enter incorrect data in any Inspector input box, the message "***THAT ENTRY IS NOT VALID***" appears at the bottom of the Inspector window.)

#### Linking to an analog point

Link this object to an analog point by entering the address (station, module, point number) in the **ADDR** box. You can also click **ADDR** to open the Address Selection Tool and browse to the point. Creating a link to an active point allows the object to mimic its activity. When the well level is at 30 ft, the object displays this level.

When the object is linked to an analog output point, you can excercise control over the point from within Custom Screen Viewer.

#### Changing the object’s position

Click on the object and hold down the left mouse button. The pointer turns into a four-headed arrow. You can now move the object in any direction by simply dragging it. For finer control of movement, select the object and use the arrow keys on your keyboard to move the object one pixel at a time.

Move the object to a specific location by changing the **XLOC** (horizontal position) and the **YLOC** (vertical position) values. A 0 (zero) in both of these boxes places the object in the top left corner of the screen. Increasing the **XLOC** value moves the object farther to the right. Increasing the **YLOC** value moves it farther down the screen.

#### Setting limits

Set the low and high limits of this point, including resolution, in the **lowLimit** and **highLimit** boxes. **lowLimit** can be the low engineering value of the point or some higher value depending on your needs. The same is true for **highLimit**. It can be the high engineering value of the point or some lower value.
For example, you have a temperature gauge with a low engineering value of 0 degrees F and a high engineering value of 100 degrees F. You are only concerned with the activity between 0 and 10 degrees F and you want the gauge to display the temperature to one hundredths of a degree, you would set the lowLimit at 0.00 and the highLimit at 10.00.

The type of units to display is set by entering a text string in the units box. Examples of units are FT, PSI, DegF.

Overlying an image

It is possible to overlay the control object with an image, for example, a chlorinator, that is stored in HT3's image directory. Click image in Inspector to select an image (see Choosing Colors and Images for more information).

Sizing the object

Click on the object. Handles (small white boxes) appear around the object. "Grab" a handle by clicking on it. Notice that all the other handles become black in color. Hold down the left mouse button and drag the selected handle to increase or decrease the object's size.

Set the object to a specific size by entering values (measured in pixels) in the widthDim and heightDim boxes.

Setting the object's orientation

- For a vertical object, enter V in the vertical box (limitsPosition must be set to L [left] or R [right]).
- For a horizontal object, enter H in the vertical box (limitsPosition must be set to T [top] or B [bottom]).

Selecting the object's color

Set the color of the "filled" area of the control object by clicking foregroundColor in Inspector. When the Color dialog box opens, select a color from the list or enter a hexadecimal number in the RGB boxes. Use Bright and Dark to control the color's intensity (light or dark).

Set the color of the background (unfilled area) of the control object by clicking backgroundColor in Inspector. When the Color dialog box opens, select a color from the list or enter a hexadecimal number in the RGB boxes. Use Bright and Dark to control the color's intensity (light or dark).

To make the object appear transparent, use the same color for both the foregroundColor and the backgroundColor.

Controlling text appearance

To have text indicating the point's current value display on the control object enter Y in the showText box. Enter N to turn off display.

Select a color for the current value text by clicking textColor in Inspector. When the Color dialog box opens, select a color from the list or enter a hexadecimal number in the RGB boxes. Use Bright and Dark to control the color's intensity (light or dark).

To have text indicating the point's low and high limits display on the control object enter Y in the showLimits box. Enter N to turn off display.
Select a color for the low and high limits text by clicking limitsColor in Inspector. When the Color dialog box opens, select a color from the list or enter a hexadecimal number in the RGB boxes. Use Bright and Dark to control the color's intensity (light or dark).

Specify the location of the low and high limits text by entering L (left), R (right), T (top), or B (bottom) in the limitsPosition box.

Set text size by entering an integer value in the fontSize box. This affects the current value text as well as the low and high limits text.

For bold face text, enter Y in the bold box.

**Poll after control**

To poll a module after a control is initiated, enter the module's station and module address in the PollAddr field (e.g., 1025A). Add a delay between when the control is initiated and when the module is polled by entering a value in the PollDelay field. (See Poll After Control.)

3. Test the object’s setup by entering a value in the VALUE box. This shows you how the object appears when it’s reading actual data. To see how the object will appear when the point is in alarm, type an ”A” after the value (for example, 10A).

4. Save your screen by choosing Save or Save As from the File menu.

### Adding an Analog Dial

See also Object Types: Analog Objects and Object Properties: Analog Dial.

1. Choose Dial from the Analog menu. The object is added to the screen and the Inspector window, listing all the default properties for this object, opens. Information on each field displays at the bottom of the Inspector window when you place your cursor within a field's input box.

2. Enter a temporary value in the Value box. The DIAL’s needle doesn't appear while the object is offline. Entering a temporary value enables you to see the DIAL object’s needle and make any adjustments to line color, width, position and movement.

3. You are now ready to begin manipulating the object’s properties. (Note: You must press the ENTER key each time you make a direct change to any field in the Inspector window. If you enter incorrect data in any Inspector input box, the message "***THAT ENTRY IS NOT VALID***" appears at the bottom of the Inspector window.)

**Linking to an analog point**

Link this object to an analog point by entering the address (station, module, point number) in the ADDR box. You can also click ADDR to open the Address Selection Tool and browse to the point. Creating a link to an active point allows the object to mimic its activity. When the well level is at 30 ft, the object displays this level.

**Changing the object's position**

Click on the object and hold down the left mouse button. The pointer turns into a four-headed arrow. You can now move the object in any direction by simply dragging it. For finer control of movement, select the object and use the arrow keys on your keyboard to move the object one pixel at a time.
Move the object to a specific location by changing the **XLOC** (horizontal position) and the **YLOC** (vertical position) values. A 0 (zero) in both of these boxes places the object in the top left corner of the screen. Increasing the **XLOC** value moves the object farther to the right. Increasing the **YLOC** value moves it farther down the screen.

**Setting limits**

Set the low and high limits of this point, including resolution, in the **lowLimit** and **highLimit** boxes. **lowLimit** can be the low engineering value of the point or some higher value depending on your needs. The same is true for **highLimit**. It can be the high engineering value of the point or some lower value.

For example, you have a temperature gauge with a low engineering value of 0 degrees F and a high engineering value of 100 degrees F. You are only concerned with the activity between 0 and 10 degrees F and you want the gauge to display the temperature to one hundredths of a degree, you would set the **lowLimit** at 0.00 and the **highLimit** at 10.00.

**Set range of arc**

Control the dial's arc range by entering an integer value between 0 and 360 degrees in the **lowDegrees** and **highDegrees** boxes. **lowDegrees** is the starting point of the dial's arc. **highDegrees** is the ending point of the dial's arc.

Think of the dial as a clock face where 0 degrees is equivalent to 12, 90 degrees is equivalent to 3, 180 degrees is equivalent to 6, etc. If you wanted to create a dial whose needle sweeps from 9 to 3 (visualize a car speedometer), you would enter 270 in the **lowDegrees** box and 90 in the **highDegrees** box, and verify that **clockwise** is set to Y.

**Sizing the object**

Click on the object. Handles (small white boxes) appear around the object. "Grab" a handle by clicking on it. Notice that all the other handles become black in color. Hold down the left mouse button and drag the selected handle to increase or decrease the object's size. Hold down the SHIFT button while dragging a handle to make the object square (width = height).

Set the object to a specific size by entering values (measured in pixels) in the **widthDim** and **heightDim** boxes.

**Setting the needle's appearance, position and movement**

Set the color of the dial's needle by clicking **dialColor** in Inspector. When the **Color** dialog box opens, select a color from the list or enter a **hexadecimal number** in the **RGB** boxes. Use **Bright** and **Dark** to control the color's intensity (light or dark).

To change the radius of the dial's inner arc, enter an integer value in the **insideRadius** box. This setting controls the needle's starting position in relation to the edge of the object. In the case of a dial with **lowDegrees** set to 0 and **highDegrees** set to 360, it controls the needle's starting position in relation to the center of the object.

To set the width, or thickness, of the dial's needle, enter an integer value in the **lineWidth** box.

To have the dial's needle move in a clockwise direction, enter Y in the **clockwise** box. Enter N to have the needle move counterclockwise.

**Creating a link**

Create a hyperlink between this object and another screen or web page by:
Clicking **URL** in Inspector and selecting a destination screen (the screen that loads when this object is clicked) from the **Link** dialog box.

Typing the **URL** address for the destination screen or web page in the **URL** box. The URL address must be in the following format (you don't need to type in http://): [screen name].html For example, station1.html, where station1 is the name of the screen that loads when this object is clicked; or, www.dataflowsys.com to link to the DFS website.

4. Test the object's setup by entering a value in the **VALUE** box. This shows you how the object appears when it's reading actual data.

5. Save your screen by choosing **Save** or **Save As** from the **File** menu.

### Adding an Analog Gauge

See also **Object Types: Analog Objects** and **Object Properties: Analog Gauge**.

1. Choose **Gauge** from the **Analog** menu. The object appears on the screen and the Inspector window, listing all the default properties for this object, opens. Information on each field displays at the bottom of the Inspector window when you place your cursor within a field's input box.

2. You are now ready to begin manipulating the object’s properties. (**Note:** You must press the ENTER key each time you make a direct change to any field in the Inspector window. If you enter incorrect data in any Inspector input box, the message "***THAT ENTRY IS NOT VALID***" appears at the bottom of the Inspector window.)

   **Linking to an analog point**

   Link this object to an analog point by entering the address (station, module, point number) in the **ADDR** box. You can also click **ADDR** to open the Address Selection Tool and browse to the point. Creating a link to an active point allows the object to mimic its activity. When the well level is at 30 ft, the object displays this level.

   **Changing the object's position**

   Click on the object and hold down the left mouse button. The pointer turns into a four-headed arrow. You can now move the object in any direction by simply dragging it. For finer control of movement, select the object and use the arrow keys on your keyboard to move the object one pixel at a time.

   Move the object to a specific location by changing the **XLOC** (horizontal position) and the **YLOC** (vertical position) values. A 0 (zero) in both of these boxes places the object in the top left corner of the screen. Increasing the **XLOC** value moves the object farther to the right. Increasing the **YLOC** value moves it farther down the screen.

   **Setting limits**

   Set the low and high limits, including resolution, of this point in the **lowlimit** and **highLimit** boxes. **lowlimit** can be the low engineering value of the point or some higher value depending on your needs. The same is true for **highLimit**. It can be the high engineering value of the point or some lower value.
For example, you have a temperature gauge with a low engineering value of 0 degrees F and a high engineering value of 100 degrees F. You are only concerned with the activity between 0 and 10 degrees F and you want the gauge to display the temperature to one hundredths of a degree, you would set the **lowLimit** at 0.00 and the **highLimit** at 10.00.

The type of units to display is set by entering a text string in the **units** box. Examples of units are FT, PSI, DegF.

**Creating a link**

Create a hyperlink between this object and another screen or web page by:

- Clicking **URL** in Inspector and selecting a destination screen (the screen that loads when this object is clicked) from the **Link** dialog box.
- Typing the URL address for the destination screen or web page in the **URL** box. The URL address must be in the following format (you don't need to type in http://): [screen name].html For example, station1.html, where station1 is the name of the screen that loads when this object is clicked; or, www.dataflowsys.com to link to the DFS website.

3. Test the object’s setup by entering a value in the **VALUE** box. This shows you how the object appears when it’s reading actual data.

4. Save your screen by choosing **Save** or **Save As** from the **File** menu.

**Adding an Analog LED Bar**

See also **Object Types: Analog Objects** and **Object Properties: Analog LED Bar**.

1. Choose **LED Bar** from the **Analog** menu. The object appears on the screen and the Inspector window, listing all the default properties for this object, opens. Information on each field displays at the bottom of the Inspector window when you place your cursor within a field's input box.

2. You are now ready to begin manipulating the object’s properties. (**Note**: You must press the ENTER key each time you make a direct change to any field in the Inspector window. If you enter incorrect data in any Inspector input box, the message "***THAT ENTRY IS NOT VALID***" appears at the bottom of the Inspector window.)

**Linking to an analog point**

Link this object to an analog point by entering the address (station, module, point number) in the **ADDR** box. You can also click **ADDR** to open the Address Selection Tool and browse to the point. Creating a link to an active point allows the object to mimic its activity. When the well level is at 30 ft, the object displays this level.

**Changing the object's position**

Click on the object and hold down the left mouse button. The pointer turns into a four-headed arrow. You can now move the object in any direction by simply dragging it. For finer control of movement, select the object and use the arrow keys on your keyboard to move the object one pixel at a time.
Move the object to a specific location by changing the XLOC (horizontal position) and the YLOC (vertical position) values. A 0 (zero) in both of these boxes places the object in the top left corner of the screen. Increasing the XLOC value moves the object farther to the right. Increasing the YLOC value moves it farther down the screen.

Setting color-coded limits

The LED Bar can be configured with four limits: low, warning, alarm, and high. The low, alarm, and high limits can be the same values as the low, alarm, and high limits configured for the corresponding point. An additional limit, warning, can be used to alert you that the point is approaching an alarm state. The ranges between these limits can be color coded, so that you can tell the status at a glance.

- lowColor is used for the range between the low and warning limit.
- mediumColor is used for the range between the warning and alarm limit. This color is also used for the gauge’s major and minor tick marks.
- highColor is used for the range between the alarm limit and the high limit.

When the point’s value is within one of these ranges, the dial of gauge will display the corresponding color.

Enter the bar’s limits, including resolution (for example 10.00 for two decimal places), in the low, warning, alarm, and high boxes. Select colors for the ranges by clicking lowColor, mediumColor, or highColor in Inspector. When the Color dialog box opens, select a color from the list or enter a hexadecimal number in the RGB boxes. Use Bright and Dark to control the color's intensity (light or dark).

Sizing the object

Click on the object. Handles (small white boxes) appear around the object. "Grab" a handle by clicking on it. Notice that all the other handles become black in color. Hold down the left mouse button and drag the selected handle to increase or decrease the object’s size.

Set the object to a specific size by entering values (measured in pixels) in the widthDim and heightDim boxes.

Configuring LED options

spacing sets the amount of space between each LED. Enter the desired number in the spacing field.

count specifies the number of LEDs that appear in the bar. Enter the desired number in the count field.

inverse specifies the direction of the LEDs.

- For a vertical bar, entering a Y in the inverse box will display the lowest values at the top of the bar. Entering an N in this box will display the highest values on the top of the bar.
- For a horizontal bar, entering a Y in the inverse box will display the highest values on the right side of the bar. Entering an N in this box, will display the highest values on the right side of the bar.
**threshold** determines how sensitive the bar is to changes in the point's value. If the threshold is low (threshold = L), the LED will illuminate any time the point's value is in the range of the LED. If the threshold is medium (threshold = M), the point's value will have to meet or exceed the midpoint of the LED's range before the LED will illuminate. If the threshold is high (threshold = H), the point's value will have to reach the maximum of the LED's range in order for the LED to illuminate.

For example, if the bar has a range of 0-100 and there are 10 LEDs, each LED has a range of 10 units (feet, degrees, PSI, etc). If the point's current value is 32:

- **low threshold** - LEDs 1-4 would be illuminated
- **medium threshold** - LEDs 1-3 would be illuminated. The fourth LED wouldn't illuminate until the value reached 35.
- **high threshold** - LEDs 1-3 would be illuminated. The fourth LED wouldn't illuminate until the value reached 40.

**Configuring bar options**

**backgroundColor** specifies the color that appears in the space between the LEDs. Select a color by clicking backgroundColor in Inspector. When the Color dialog box opens, select a color from the list or enter a hexadecimal number in the RGB boxes. Use **Bright** and **Dark** to control the color's intensity (light or dark).

**vertical** specifies the direction of the bar. Enter Y for a vertical bar. N for a horizontal bar. Note that when you change the bar's orientation, you may need to change its width and height. Remember that **widthDim** sets the horizontal size of the object and **heightDim** sets the vertical size of the object.

**barType** specifies the shape and appearance of the LEDs. Options are:

- **R** - rectangular shaped LEDs
- **3D** - three-dimensional, rectangular-shaped LEDs
- **T** - triangular-shaped LEDs
- **C** - circular-shaped LEDs

**Creating a link**

Create a hyperlink between this object and another screen or web page by:

- Clicking **URL** in Inspector and selecting a destination screen (the screen that loads when this object is clicked) from the Link dialog box.
- Typing the URL address for the destination screen or web page in the **URL** box. The URL address must be in the following format (you don't need to type in http://): [screen name].html For example, station1.html where station1 is the name of the screen that loads when this object is clicked; or, www.dataflowsys.com to link to the DFS website.

3. Test the object's setup by entering a value in the **VALUE** box. This shows you how the object appears when it's reading actual data.

4. Save your screen by choosing **Save** or **Save As** from the **File** menu.
Adding an Analog LED Gauge

See also Object Types: Analog Objects and Object Properties: Analog LED Gauge.

1. Choose LED Gauge from the Analog menu. The object appears on the screen and the Inspector window, listing all the default properties for this object, opens. Information on each field displays at the bottom of the Inspector window when you place your cursor within a field’s input box.

2. You are now ready to begin manipulating the object’s properties. (Note: You must press the ENTER key each time you make a direct change to any field in the Inspector window. If you enter incorrect data in any Inspector input box, the message "***THAT ENTRY IS NOT VALID***" appears at the bottom of the Inspector window.)

Linking to an analog point

Link this object to an analog point by entering the address (station, module, point number) in the ADDR box. You can also click ADDR to open the Address Selection Tool and browse to the point. Creating a link to an active point allows the object to mimic its activity. When the well level is at 30 ft, the object displays this level.

Changing the object’s position

Click on the object and hold down the left mouse button. The pointer turns into a four-headed arrow. You can now move the object in any direction by simply dragging it. For finer control of movement, select the object and use the arrow keys on your keyboard to move the object one pixel at a time.

Move the object to a specific location by changing the XLOC (horizontal position) and the YLOC (vertical position) values. A 0 (zero) in both of these boxes places the object in the top left corner of the screen. Increasing the XLOC value moves the object farther to the right. Increasing the YLOC value moves it farther down the screen.

Setting color-coded limits

The LED Gauge can be configured with four limits: low, warning, alarm, and high. The low, alarm, and high limits can be the same values as the low, alarm, and high limits configured for the corresponding point. An additional limit, warning, can be used to alert you that the point is approaching an alarm state. The ranges between these limits can be color coded, so that you can tell the status at a glance.

- **lowColor** is used for the range between the low and warning limit.
- **mediumColor** is used for the range between the warning and alarm limit. This color is also used for the gauge’s major and minor tick marks.
- **highColor** is used for the range between the alarm limit and the high limit.

When the point’s value is within one of these ranges, the dial of gauge will display the corresponding color.

Enter the gauge’s limits in the low, warning, alarm, and high boxes. Select colors for the ranges by clicking lowColor, mediumColor, or highColor in Inspector. When the Color dialog box opens, select a color from the list or enter a hexadecimal number in the RGB boxes. Use Bright and Dark to control the color’s intensity (light or dark).

Sizing the object
Click on the object. Handles (small white boxes) appear around the object. "Grab" a handle by clicking on it. Notice that all the other handles become black in color. Hold down the left mouse button and drag the selected handle to increase or decrease the object’s size. Hold down the SHIFT button while dragging a handle to make the object square (width = height).

Set the object to a specific size by entering values (measured in pixels) in the `widthDim` and `heightDim` boxes.

**Gauge options**

There are several options for configuring the appearance of the gauge.

- **degrees** determines the arc of the gauge. Enter 90, 180, 300 or 360 in the `degrees` box.
- **majorTicks** determines the value of the multiplier and major tick marks (similar to the hours on a clock). Entering 100 in the `majorTicks` box would indicate that each major tick was equal to 100 units, so a gauge reading of 3 would equate to 300. Enter the desired value in the `majorTicks` box.
- **minorTicks** determines how many tick marks should appear between the major ones (similar to the minutes on a clock). Enter the desired value in the `minorTicks` field.
- **clockwise** determines the direction of the gauge’s readings. Enter Y in the `clockwise` box to have the gauge read from left to right. Enter N in the `clockwise` box to have the gauge read from right to left.
- **backgroundColor** is the color that appears behind the gauge. Select a color by clicking `backgroundColor` in Inspector. When the Color dialog box opens, select a color from the list or enter a hexadecimal number in the RGB boxes. Use Bright and Dark to control the color’s intensity (light or dark).
- **Select the color of the gauge’s needle by clicking `needleColor` in Inspector. When the Color dialog box opens, select a color from the list or enter a hexadecimal number in the RGB boxes. Use Bright and Dark to control the color’s intensity (light or dark).**

**Text options**

Enter Y in the `showLabels` field if you want labels to appear beside the gauge's major tick marks. The low and high labels are the low and high limits divided by the `majorTicks` value. For example a gauge with a low limit of 1000, a high limit of 4000, and a major tick value of 200, would have a low label of 5 and a high label of 20. The labels between would be in 1-digit increments.

Additionally:

- **textContent** determines the color of the gauge’s labels and the text that appears in the center of the gauge. The center text includes the multiplier (see `majorTicks` under Gauge options, above), and the text you enter in the `centralText` field.
- **centralHeight** is the font size of the text shown in the center of the gauge. **labelHeight** is the font size used for the gauge's labels.
- **centralText** can be any text that you want to appear in the center of the text. This can be the name of the point or a description of what the gauge is measuring.
- **decimal** is the number of decimal places to include in the gauge’s labels.

**Creating a link**

Create a hyperlink between this object and another screen or web page by:
Clicking URL in Inspector and selecting a destination screen (the screen that loads when this object is clicked) from the Link dialog box.

Typing the URL address for the destination screen or web page in the URL box. The URL address must be in the following format (you don't need to type in http://): [screen name].html For example, station1.html, where station1 is the name of the screen that loads when this object is clicked; or, www.dataflowsys.com to link to the DFS website.

3. Test the object's setup by entering a value in the VALUE box. This shows you how the object appears when it's reading actual data.

4. Save your screen by choosing Save or Save As from the File menu.

Adding an Analog LED Text Object

See also Object Types: Analog Objects and Object Properties: Analog LED Text.

1. Choose LED Text from the Analog menu. The object appears on the screen and the Inspector window, listing all the default properties for this object, opens. Information on each field displays at the bottom of the Inspector window when you place your cursor within a field's input box.

2. You are now ready to begin manipulating the object's properties. (Note: You must press the ENTER key each time you make a direct change to any field in the Inspector window. If you enter incorrect data in any Inspector field, the message "***THAT ENTRY IS NOT VALID***" appears at the bottom of the Inspector window.)

Linking to an analog point

Link this object to an analog point by entering the address (station, module, point number) in the ADDR box. You can also click ADDR to open the Address Selection Tool and browse to the point. Creating a link to an active point allows the object to mimic its activity. When the well level is at 30 ft, the object displays this level.

To use this object as a link timer (causes another screen to load after a specified length of time), enter the word STATIC in the ADDR box. You must also specify the URL of the screen or web page to load and the countDown time (measured in seconds).

Changing the object's position

Click on the object and hold down the left mouse button. The pointer turns into a four-headed arrow. You can now move the object in any direction by simply dragging it. For finer control of movement, select the object and use the arrow keys on your keyboard to move the object one pixel at a time.

Move the object to a specific location by changing the XLOC (horizontal position) and the YLOC (vertical position) values. A 0 (zero) in both of these fields places the object in the top left corner of the screen. Increasing the XLOC value moves the object farther to the right. Increasing the YLOC value moves it farther down the screen.

Setting limits

Set the low and high limits of this point in the lowLimit and highLimit boxes. lowLimit can be the low engineering value of the point or some higher value depending on your needs. The same is true for highLimit. It can be the high engineering value of the point or some lower value.
Displaying decimal and signed numbers

Set the resolution (number of decimal places) that you want the object to display by entering an integer value in the **decimal** field (up to 17).

If you want the LED to display a plus (+) or minus (-) sign to reflect positive and negative values, enter Y in the **signed** field.

Sizing the object

Click on the object. Handles (small white boxes) appear around the object. "Grab" a handle by clicking on it. Notice that all the other handles become black in color. Hold down the left mouse button and drag the selected handle to increase or decrease the object's size.

Set the object to a specific size by entering values (measured in pixels) in the **widthDim** and **heightDim** boxes.

Selecting the object's color

Set the background color of the object by clicking **backgroundColor** in Inspector. When the Color dialog box opens, select a color from the list or enter a hexadecimal number in the RGB boxes. Use **Bright** and **Dark** to control the color's intensity (light or dark).

To select the color of the LED's digits, click **digitColor** and select the desired color.

Make the object appear transparent (its color matches the color of the object directly beneath it) by entering N in the **fillBackground** box.

Creating a link

Create a hyperlink between this object and another screen or web page by:

- Clicking **URL** in Inspector and selecting a destination screen (the screen that loads when this object is clicked) from the Link dialog box.
- Typing the URL address for the destination screen or web page in the **URL** box. The URL address must be in the following format (you don't need to type in http://): [screen name].html For example, station1.html, where station1 is the name of the screen that loads when this object is clicked; or, www.dataflowsys.com to link to the DFS website.

Configure object as a link timer

You can configure the LED Text object to link to another screen after a specified delay. By placing one of these objects on several consecutive pages, you can have Custom Screen Viewer automatically cycle through a series of screens. Every X seconds the next screen would be loaded. The last screen in the series could link back to the first screen to complete the loop.

To create this type of link:

1. Enter STATIC in the **ADDR** box.
2. Enter the URL of the screen to link to in the **URL** box.
3. Enter the time delay (in seconds) in the **countDown** box.

3. Test the object's setup by choosing **Animate** from the **Screen** menu. This shows you how the object appears and behaves when it's viewed in Custom Screen Viewer.

4. Save your screen by choosing **Save** or **Save As** from the **File** menu.
Adding an Analog Panel

See also Object Types: Analog Objects and Object Properties: Analog Panel.

1. Choose Panel from the Analog menu. The object appears on the screen and the Inspector window, listing all the default properties for this object, opens. Information on each field displays at the bottom of the Inspector window when you place your cursor within a field’s input box.

2. You are now ready to begin manipulating the object’s properties. (Note: You must press the ENTER key each time you make a direct change to any field in the Inspector window. If you enter incorrect data in any Inspector input box, the message "***THAT ENTRY IS NOT VALID***" appears at the bottom of the Inspector window.)

  Linking to an analog point

  Link this object to an analog point by entering the address (station, module, point number) in the ADDR box. You can also click ADDR to open the Address Selection Tool and browse to the point. Creating a link to an active point allows the object to mimic its activity. When the well level is at 30 ft, the object displays this level.

  Changing the object's position

  Click on the object and hold down the left mouse button. The pointer turns into a four-headed arrow. You can now move the object in any direction by simply dragging it. For finer control of movement, select the object and use the arrow keys on your keyboard to move the object one pixel at a time.

  Move the object to a specific location by changing the XLOC (horizontal position) and the YLOC (vertical position) values. A 0 (zero) in both of these boxes places the object in the top left corner of the screen. Increasing the XLOC value moves the object farther to the right. Increasing the YLOC value moves it farther down the screen.

  Setting limits

  Set the low and high limits, including resolution, of this point in the lowLimit and highLimit boxes. lowLimit can be the low engineering value of the point or some higher value depending on your needs. The same is true for highLimit. It can be the high engineering value of the point or some lower value.

  For example, you have a temperature gauge with a low engineering value of 0 degrees F and a high engineering value of 100 degrees F. You are only concerned with the activity between 0 and 10 degrees F and you want the gauge to display the temperature to one hundredths of a degree, you would set the lowLimit at 0.00 and the highLimit at 10.00.

  The type of units to display is set by entering a text string in the units box. Examples of units are FT, PSI, DegF.

  Creating a link

  Create a hyperlink between this object and another screen or web page by:

  - Clicking URL in Inspector and selecting a destination screen (the screen that loads when this object is clicked) from the Link dialog box.
• Typing the URL address for the destination screen or web page in the URL box. The URL address must be in the following format (you don't need to type in http://): [screen name].html For example, station1.html, where station1 is the name of the screen that loads when this object is clicked; or, www.dataflowsys.com to link to the DFS website.

3. Test the object's setup by entering a value in the VALUE box. This shows you how the object appears when it's reading actual data. Type the letter "A" after the value (for example, 10A) to see how the object appears when the point is in alarm.

4. Save your screen by choosing Save or Save As from the File menu.

Adding an Analog Rotary

See also Object Types: Analog Objects and Object Properties: Analog Rotary.

1. Choose Rotary from the Analog menu. The object is added to the screen and the Inspector window, listing all the default properties for this object, opens. Information on each field displays at the bottom of the Inspector window when you place your cursor within a field's input box.

2. You are now ready to begin manipulating the object’s properties. (Note: You must press the ENTER key each time you make a direct change to any field in the Inspector window. If you enter incorrect data in any Inspector input box, the message “***THAT ENTRY IS NOT VALID***” appears at the bottom of the Inspector window.)

Linking to an analog point

Link this object to an analog point by entering the address (station, module, point number) in the ADDR box. You can also click ADDR to open the Address Selection Tool and browse to the point. Creating a link to an active point allows the object to mimic its activity. When the well level is at 30 ft, the object displays this level.

Changing the object's position

Click on the object and hold down the left mouse button. The pointer turns into a four-headed arrow. You can now move the object in any direction by simply dragging it. For finer control of movement, select the object and use the arrow keys on your keyboard to move the object one pixel at a time.

Move the object to a specific location by changing the XLOC (horizontal position) and the YLOC (vertical position) values. A 0 (zero) in both of these boxes places the object in the top left corner of the screen. Increasing the XLOC value moves the object farther to the right. Increasing the YLOC value moves it farther down the screen.

Setting limits

Set the low and high limits of this point, including resolution, in the low and high boxes. The value entered in the low box can be the low engineering value of the point or some higher value depending on your needs. The same is true for high. It can be the high engineering value of the point or some lower value.

For example, you have a temperature gauge with a low engineering value of 0 degrees F and a high engineering value of 100 degrees F. You are only concerned with the activity between 0 and 10 degrees F and you want the gauge to display the temperature to one hundredths of a degree, you would set the lowLimit at 0.00 and the highLimit at 10.00.
Selecting colors

There are four aspects of the rotary for which you can configure the color. Select a color by clicking the name of the option in Inspector. When the Color dialog box opens, select a color from the list or enter a hexadecimal number in the RGB boxes. Use Bright and Dark to control the color's intensity (light or dark).

- limitColor - This is the color that appears at the outside edges of the rotary's gradient background. A dark color provides shading that gives the illusion that the rotary is actually curved.
- centerColor - This is the color that appears in the center of the rotary's gradient background. A light color provides shading that gives the illusion that the rotary is actually curved.
- gradient - If you want a gradient background for the rotary, enter Y in this field. For a transparent background, enter N in the gradient field.
- needleColor - Select the desired color of the rotary's needle.

Setting the object's size and orientation

Click on the object. Handles (small white boxes) appear around the object. "Grab" a handle by clicking on it. Notice that all the other handles become black in color. Hold down the left mouse button and drag the selected handle to increase or decrease the object's size. Hold down the SHIFT button while dragging a handle to make the object square (width = height).

Set the object to a specific size by entering values (measured in pixels) in the widthDim and heightDim boxes.

To give the object a horizontal orientation, enter Y in the horizontal field. For a vertically oriented rotary, enter N in the horizontal field. Note that when you change the rotary's orientation, you may need to change its width and height. Remember that widthDim sets the horizontal size of the object and heightDim sets the vertical size of the object.

Configuring tick marks

visibleRange is the range of values that is visible on the rotary's face. If the rotary has a full range of, for example, 60 feet, you may only want to see 10 feet of the range at any one time.

majorTicks is the value of the rotary's major tick marks. The labels displayed next to the major tick marks will be in increments equal to the value entered here. Enter the desired value in the majorTicks field.

minorTicks is the number of tick marks that are displayed between each of the major tick marks. Enter the desired value in the minorTicks field.

direction specifies the direction in which the rotary's values are displayed.

- Vertical rotary - entering a Y in the direction box will display the lowest values at the top of the rotary. Entering an N in this box will display the highest values at the top of the rotary.
- Horizontal rotary - entering a Y in the direction box will display the lowest values on the right side of the rotary. Entering an N in this box, will display the highest values on the right side of the rotary.

leftTicks specifies the location of the rotary's tick marks.
• Vertical rotary - entering a Y in the leftTicks box will display tick marks on the left side of the rotary. Entering an N in this box will display the tick marks on the right side of the rotary.

• Horizontal rotary - entering a Y in the leftTicks box will display the tick marks at the top of the rotary. Entering an N in this box, will display the tick marks on the bottom of the rotary.

**Animating the object**

To have the object appear to turn as the point's value changes, enter a Y in the rotate field.

**Creating a link**

Create a hyperlink between this object and another screen or web page by:

• Clicking URL in Inspector and selecting a destination screen (the screen that loads when this object is clicked) from the Link dialog box.

• Typing the URL address for the destination screen or web page in the URL box. The URL address must be in the following format (you don't need to type in http://): [screen name].html For example, station1.html, where station1 is the name of the screen that loads when this object is clicked; or, www.dataflowsys.com to link to the DFS website.

3. Test the object's setup by entering a value in the VALUE box. This shows you how the object appears when it's reading actual data.

4. Save your screen by choosing Save or Save As from the File menu

**Adding an Analog Slider**

See also Object Types: Analog Objects and Object Properties: Analog Slider.

1. Choose Slider from the Analog menu. The object appears on the screen and the Inspector window, listing all the default properties for this object, opens. Information on each field displays at the bottom of the Inspector window when you place your cursor within a field's input box.

2. You are now ready to begin manipulating the object’s properties. (Note: You must press the ENTER key each time you make a direct change to any field in the Inspector window. If you enter incorrect data in any Inspector input box, the message ***THAT ENTRY IS NOT VALID*** appears at the bottom of the Inspector window.)

**Linking to an analog point**

Link this object to an analog point by entering the address (station, module, point number) in the ADDR box. You can also click ADDR to open the Address Selection Tool and browse to the point. Creating a link to an active point allows the object to mimic its activity. When the well level is at 30 ft, the object displays this level.

When the object is linked to an analog output point, you can exercise control over the point from within Custom Screen Viewer by moving the slider's pointer along the track.

**Changing the object's position**
Click on the object and hold down the left mouse button. The pointer turns into a four-headed arrow. You can now move the object in any direction by simply dragging it. For finer control of movement, select the object and use the arrow keys on your keyboard to move the object one pixel at a time.

Move the object to a specific location by changing the XLOC (horizontal position) and the YLOC (vertical position) values. A 0 (zero) in both of these boxes places the object in the top left corner of the screen. Increasing the XLOC value moves the object farther to the right. Increasing the YLOC value moves it farther down the screen.

**Setting limits**

Set the low and high limits of this point in the lowLimit and highLimit boxes. lowLimit can be the low engineering value of the point or some higher value depending on your needs. The same is true for highLimit. It can be the high engineering value of the point or some lower value. Together, lowLimit and highLimit determine the range of the slider’s values. Specify the resolution by entering an integer value in the decimal field.

**Specifying the object’s size and orientation**

Click on the object. Handles (small white boxes) appear around the object. "Grab" a handle by clicking on it. Notice that all the other handles become black in color. Hold down the left mouse button and drag the selected handle to increase or decrease the object’s size.

Set the object to a specific size by entering values (measured in pixels) in the widthDim and heightDim boxes.

The default orientation for this object is vertical (the vertical box is set to Y). To change the orientation of the slider to horizontal, enter N in the vertical box. When you set the orientation to horizontal, you need to change the widthDim and heightDim values as well as the pointerStyle. widthDim sets the horizontal size of the object and heightDim sets the vertical size of the object. pointerStyle specifies the orientation of the slider’s pointer (up or down, right or left).

By default, the slider’s low values start at the top or left (depending on its orientation) and increase as you go to the bottom or right (reverse option is set to N). If you want the low values to start at the bottom or right of the slider, change the reverse setting to Y.

**Specifying background properties**

There are three options that affect the slider’s background appearance:

- **showBackground** - To make the background of the slider transparent, enter N in this field.
  To use the properties assigned in backgroundColor and backgroundStyle, enter Y in the showBackground field.
- **backgroundColor** - Set the color of the slider’s background by clicking backgroundColor in Inspector. When the Color dialog box opens, select a color from the list or enter a hexadecimal number in the RGB boxes. Use Bright and Dark to control the color’s intensity (light or dark).
- **backgroundStyle** - With this setting, you can make the background of the slider appear three-dimensional (raised or lowered) or flat. For a raised appearance, enter R in this box; for a lowered appearance, enter L in this field. For a flat appearance, enter F in this box.

**Changing pointer appearance**

Three options control the appearance of the slider’s pointer:
• **pointerWidth** - Enter the desired width of the pointer in this box.

• **pointerColor** - Select the color of the pointer by clicking **pointerColor** in Inspector. When the Color dialog box opens, select a color from the list or enter a hexadecimal number in the RGB boxes. Use Bright and Dark to control the color's intensity (light or dark).

• **pointerStyle** - The pointer can be one of five possible styles: B (box shape); U (pointing up; horizontal slider only); D (pointing down; horizontal slider only); L (pointing left; vertical slider only); R (pointing right; vertical slider only). Enter the letter of the desired style in the **pointerStyle** field.

**Changing track appearance**

Two options control the appearance of the slider's track:

• **trackStyle** - enables you to choose the width of the track. Enter S for small, M for medium, or L for large. The size of the track is relative to the overall width of the object.

• **trackColor** - enables you to choose the track's color. Click **trackColor** in Inspector. When the Color dialog box opens, select a color from the list or enter a hexadecimal number in the RGB boxes. Use Bright and Dark to control the color's intensity (light or dark).

**Controlling text appearance**

When viewed in Custom Screen Viewer, the value that corresponds to the pointer's location is displayed next to it whenever the pointer is clicked with the mouse. When you use the slider to control an analog point, the displayed text guides you in controlling the point to the desired value.

There are three options for controlling the appearance of the text display:

• **decimal** - Specify the number of decimal places to display by entering an integer value in the **decimal** field.

• **textSize** - Set text size by entering an integer value in the **textSize** field.

• **textColor** - Set the text's color by clicking **textColor** in Inspector. When the Color dialog box opens, select a color from the list or enter a hexadecimal number in the RGB boxes. Use Bright and Dark to control the color's intensity (light or dark).

**Poll after control**

To poll a module after a control is initiated, enter the module's station and module address in the **PollAddr** field (e.g., 1025A). Add a delay between when the control is initiated and when the module is polled by entering a value in the **PollDelay** field. (See Poll After Control.)

3. Test the object's setup by entering a value in the VALUE box. This shows you how the object appears when it's reading actual data.

4. Save your screen by choosing **Save** or **Save As** from the **File** menu.

**Adding an Analog Text Object**

See also Object Types: Analog Objects and Object Properties: Analog Text.
1. Choose **Text** from the **Analog** menu. The object appears on the screen and the Inspector window, listing all the default properties for this object, opens. Information on each field displays at the bottom of the Inspector window when you place your cursor within a field's input box.

2. You are now ready to begin manipulating the object's properties. **(Note:** You must press the ENTER key each time you make a direct change to any field in the Inspector window. If you enter incorrect data in any Inspector field, the message "***THAT ENTRY IS NOT VALID***" appears at the bottom of the Inspector window.)

**Linking to an analog point**

Link this object to an analog point by entering the address (station, module, point number) in the **ADDR** box. You can also click **ADDR** to open the Address Selection Tool and browse to the point. Creating a link to an active point allows the object to mimic its activity. When the well level is at 30 ft, the object displays this level.

**Changing the object's position**

Click on the object and hold down the left mouse button. The pointer turns into a four-headed arrow. You can now move the object in any direction by simply dragging it. For finer control of movement, select the object and use the arrow keys on your keyboard to move the object one pixel at a time.

Move the object to a specific location by changing the **XLOC** (horizontal position) and the **YLOC** (vertical position) values. A 0 (zero) in both of these fields places the object in the top left corner of the screen. Increasing the **XLOC** value moves the object farther to the right. Increasing the **YLOC** value moves it farther down the screen.

**Setting limits**

Set the low and high limits of this point, including resolution, in the **lowLimit** and **highLimit** boxes. **lowLimit** can be the low engineering value of the point or some higher value depending on your needs. The same is true for **highLimit**. It can be the high engineering value of the point or some lower value.

For example, you have a temperature gauge with a low engineering value of 0 degrees F and a high engineering value of 100 degrees F. You are only concerned with the activity between 0 and 10 degrees F and you want the gauge to display the temperature to one hundredths of a degree. You would set the **lowLimit** at 0.00 and the **highLimit** at 10.00.

The type of units to display is set by entering a text string in the **units** box. Examples of units are FT, PSI, DegF.

**Sizing the object**

Click on the object. Handles (small white boxes) appear around the object. "Grab" a handle by clicking on it. Notice that all the other handles become black in color. Hold down the left mouse button and drag the selected handle to increase or decrease the object's size.

Set the object to a specific size by entering values (measured in pixels) in the **widthDim** and **heightDim** boxes.

**Positioning the text**

Set the text's alignment by entering a horizontal position (C=center, R=right, L=left) and then a vertical position (M=middle, T=top, B=bottom) in the **justify** box. For example, LB to place the text in the lower left corner of the object.
Set the horizontal margin (measured from the left or right of the object's edge, depending on its horizontal alignment) by entering an integer value in the `insetX` box. Set the vertical margin (as measured from the top or bottom of the object's edge, depending on its vertical alignment) by entering an integer value in the `insetY` box.

For example, entering 10 in both the `insetX` and `insetY` boxes and entering LT in the `justify` box, would position the text in the top left corner, 10 pixels from the left edge and 10 pixels from the top edge of the object.

**Controlling text appearance**

Set the color of the text by clicking `textColor` in Inspector. When the `Color` dialog box opens, select a color from the list or enter a hexadecimal number in the RGB boxes. Use `Bright` and `Dark` to control the color's intensity (light or dark).

Set text size by entering an integer value in the `fontSize` box.

For bold face text, enter Y in the `bold` box.

**Selecting the object's color**

Set the color of the object by clicking `backgroundColor` in Inspector. When the `Color` dialog box opens, select a color from the list or enter a hexadecimal number in the RGB boxes. Use `Bright` and `Dark` to control the color's intensity (light or dark).

Make the object appear transparent (its color matches the color of the object directly beneath it) by entering N in the `fillBackground` box.

**Adding a border**

Add a border to the text object by entering Y in the `drawBorder` box.

**Creating a link**

Create a hyperlink between this object and another screen or web page by:

- Clicking `URL` in Inspector and selecting a destination screen (the screen that loads when this object is clicked) from the `Link` dialog box.
- Typing the URL address for the destination screen or web page in the `URL` box. The URL address must be in the following format (you don't need to type in http://): [screen name].html For example, station1.html, where station1 is the name of the screen that loads when this object is clicked; or, www.dataflowsys.com to link to the DFS website.

3. Test the object's setup by entering a value in the `VALUE` box. This shows you how the object appears when it's reading actual data.

4. Save your screen by choosing `Save` or `Save As` from the `File` menu

**Adding an Analog Time Object**

See also Object Types: Analog Objects and Object Properties: Analog Time.

1. Choose `Time` from the Analog menu. The object appears on the screen and the Inspector window, listing all the default properties for this object, opens. Information on each field displays at the bottom of the Inspector window when you place your cursor within a field's input box.
2. You are now ready to begin manipulating the object’s properties. (Note: You must press the ENTER key each time you make a direct change to any field in the Inspector window.) If you enter incorrect data in any Inspector field, the message "***THAT ENTRY IS NOT VALID***" appears at the bottom of the Inspector window.

**Linking to a virtual point**

Link this object to a virtual point that calculates the number of seconds a logical input is in the ON state (for example, pump run time) by entering the appropriate address in the ADDR box. The TIME object will display, and continually and automatically update, the value of the specified virtual point.

To have the object display the server’s current time leave the default setting, STATIC, in the ADDR box.

**Changing the object's position**

Click on the object and hold down the left mouse button. The pointer turns into a four-headed arrow. You can now move the object in any direction by simply dragging it. For finer control of movement, select the object and use the arrow keys on your keyboard to move the object one pixel at a time.

Move the object to a specific location by changing the XLOC (horizontal position) and the YLOC (vertical position) values. A 0 (zero) in both of these fields places the object in the top left corner of the screen. Increasing the XLOC value moves the object farther to the right. Increasing the YLOC value moves it farther down the screen.

**Setting time display options**

To include seconds in the time display, enter Y in the showSeconds box. Enter N to turn off the display of seconds.

To include AM and PM in the time display, enter Y in the showAMPM box. Enter N to turn off AM/PM display.

**Setting date display options**

Enter an option other than N in the dateFormat field to have the Time object display the current system time. dateFormat can be one of four types:

- **S** - short format (MM/DD/YY). For example, 3/8/10.
- **M** - medium format (Mon DD, YYYY). For example, Mar 8, 2010
- **L** - long format (Month DD, YYYY). For example, March 8, 2010.
- **F** - full format (Day of week, Month DD, YYYY). For example, Monday, March 8, 2010

**Sizing the object**

Click on the object. Handles (small white boxes) appear around the object. "Grab" a handle by clicking on it. Notice that all the other handles become black in color. Hold down the left mouse button and drag the selected handle to increase or decrease the object’s size.

Set the object to a specific size by entering values (measured in pixels) in the widthDim and heightDim boxes.

**Positioning the time display text**
Set the text’s alignment by entering a horizontal position (C=center, R=right, L=left) and then a vertical position (M=middle, T=top, B=bottom) in the justify box.

Set the horizontal margin (measured from the left or right of the object’s edge, depending on its horizontal alignment) by entering an integer value in the insetX box. Set the vertical margin (as measured from the top or bottom of the object’s edge, depending on its vertical alignment) by entering an integer value in the insetY box.

For example, entering 10 in both the insetX and insetY boxes and entering LT in the justify box, would position the text in the top left corner, 10 pixels from the left edge and 10 pixels from the top edge of the object.

Controlling appearance of time display text

Set the color of the text by clicking textColor in Inspector. When the Color dialog box opens, select a color from the list or enter a hexadecimal number in the RGB boxes. Use Bright and Dark to control the color’s intensity (light or dark).

Set text size by entering an integer value in the fontSize box.

For bold face text, enter Y in the bold box.

Selecting the object's color

Set the color of the object by clicking backgroundColor in Inspector. When the Color dialog box opens, select a color from the list or enter a hexadecimal number in the RGB boxes. Use Bright and Dark to control the color’s intensity (light or dark).

Make the object appear transparent (its color matches the color of the object directly beneath it) by entering N in the fillBackground box.

Adding a border

Add a border to the time object by entering Y in the drawBorder box.

Creating a link

Create a hyperlink between this object and another screen or web page by:

- Clicking URL in Inspector and selecting a destination screen (the screen that loads when this object is clicked) from the Link dialog box.
- Typing the URL address for the destination screen or web page in the URL box. The URL address must be in the following format (you don't need to type in http://): [screen name].html For example, station1.html, where station1 is the name of the screen that loads when this object is clicked; or, www.dataflowsys.com to link to the DFS website.

3. Save your screen by choosing Save or Save As from the File menu.

Adding an Analog Time Control

See also Object Types: Analog Objects and Object Properties: Analog Time Control.

1. Choose Time Control from the Analog menu. The object appears on the screen and the Inspector window, listing all the default properties for this object, opens. Information on each field displays at the bottom of the Inspector window when you place your cursor within a field’s input box.
2. You are now ready to begin manipulating the object’s properties. (Note: You must press the ENTER key each time you make a direct change to any field in the Inspector window.) If you enter incorrect data in any Inspector field, the message "***THAT ENTRY IS NOT VALID***" appears at the bottom of the Inspector window.

**Linking to a virtual point**

Link this object to a virtual analog input point that allows a user to enter the time when a certain action should occur (for example turning on an irrigation system) by entering the appropriate address in the ADDR box.

When the TIME CONTROL object is clicked, an editable box appears in the center of the object. The user enters the desired time (in hours and minutes) and presses the Enter key. When that time is reached, the control will occur. The TIME CONTROL object converts the time entered to seconds after midnight, which is easy to compare to the current time of day in the ladder logic that controls the irrigation system.

For example, you want to control when an irrigation system comes on. In Virtual Logic Builder, logic is created where the time to control the event is provided by an Analog Input virtual point (e.g., V_SPRINK_ON). The virtual point is used in a comparison equation (when the current time is equal to the time specified by the virtual point V_SPRINK_ON, the control point that regulates the irrigation system is activated). On the custom screen, the Analog TIME CONTROL object would be linked to the virtual point V_SPRINK_ON.

**Changing the object's position**

Click on the object and hold down the left mouse button. The pointer turns into a four-headed arrow. You can now move the object in any direction by simply dragging it. For finer control of movement, select the object and use the arrow keys on your keyboard to move the object one pixel at a time.

Move the object to a specific location by changing the XLOC (horizontal position) and the YLOC (vertical position) values. A 0 (zero) in both of these fields places the object in the top left corner of the screen. Increasing the XLOC value moves the object farther to the right. Increasing the YLOC value moves it farther down the screen.

**Setting time display options**

To have the time display include seconds, enter Y in the showSeconds box. Enter N to turn off the display of seconds.

To have the time display include AM and PM, enter Y in the showAMPM box. Enter N to turn off AM/PM display.

**Sizing the object**

Click on the object. Handles (small white boxes) appear around the object. "Grab” a handle by clicking on it. Notice that all the other handles become black in color. Hold down the left mouse button and drag the selected handle to increase or decrease the object’s size.

Set the object to a specific size by entering values (measured in pixels) in the widthDim and heightDim boxes.

**Positioning the time display text**

Set the text's alignment by entering a horizontal position (C=center, R=right, L=left) and then a vertical position (M=middle, T=top, B=bottom) in the justify box.
Set the horizontal margin (measured from the left or right of the object's edge, depending on its horizontal alignment) by entering an integer value in the insetX box. Set the vertical margin (as measured from the top or bottom of the object's edge, depending on its vertical alignment) by entering an integer value in the insetY box.

For example, entering 10 in both the insetX and insetY boxes and entering LT in the justify box, would position the text in the top left corner, 10 pixels from the left edge and 10 pixels from the top edge of the object.

**Controlling time text appearance**

Set the color of the text by clicking textColor in Inspector. When the Color dialog box opens, select a color from the list or enter a hexadecimal number in the RGB boxes. Use Bright and Dark to control the color's intensity (light or dark).

Set text size by entering an integer value in the fontSize box.

For bold face text, enter Y in the bold box.

**Selecting the object's color**

Set the color of the object by clicking backgroundColor in Inspector. When the Color dialog box opens, select a color from the list or enter a hexadecimal number in the RGB boxes. Use Bright and Dark to control the color's intensity (light or dark).

Make the object appear transparent (its color matches the color of the object directly beneath it) by entering N in the fillBackground box.

**Adding a border**

Add a border to the time object by entering Y in the drawBorder box.

3. Save your screen by choosing Save or Save As from the File menu.

**Adding an Analog Trend**

See also Object Types: Analog Objects and Object Properties: Analog Trend.

1. Choose Trend from the Analog menu. The object appears on the screen and the Inspector window, listing all the default properties for this object, opens. Information on each field displays at the bottom of the Inspector window when you place your cursor within a field's input box.

2. You are now ready to begin manipulating the object's properties. (Note: You must press the ENTER key each time you make a direct change to any field in the Inspector window. If you enter incorrect data in any Inspector input box, the message "***THAT ENTRY IS NOT VALID***" appears at the bottom of the Inspector window.)

**Linking to an analog point**

Link this object to an analog point by entering the address (station, module, point number) in the ADDR box. You can also click ADDR to open the Address Selection Tool and browse to the point. Creating a link to an active point allows the object to mimic its activity. When the well level is at 30 ft, the object displays this level.

**Changing the object's position**
Click on the object and hold down the left mouse button. The pointer turns into a four-headed arrow. You can now move the object in any direction by simply dragging it. For finer control of movement, select the object and use the arrow keys on your keyboard to move the object one pixel at a time.

Move the object to a specific location by changing the XLOC (horizontal position) and the YLOC (vertical position) values. A 0 (zero) in both of these boxes places the object in the top left corner of the screen. Increasing the XLOC value moves the object farther to the right. Increasing the YLOC value moves it farther down the screen.

Setting limits

Set the low and high limits of this point, including resolution, in the lowLimit and highLimit boxes. lowLimit can be the low engineering value of the point or some higher value depending on your needs. The same is true for highLimit. It can be the high engineering value of the point or some lower value.

For example, you have a temperature gauge with a low engineering value of 0 degrees F and a high engineering value of 100 degrees F. You are only concerned with the activity between 0 and 10 degrees F and you want the gauge to display the temperature to one hundredths of a degree, you would set the lowLimit at 0.00 and the highLimit at 10.00.

Sizing the object

Click on the object. Handles (small white boxes) appear around the object. "Grab" a handle by clicking on it. Notice that all the other handles become black in color. Hold down the left mouse button and drag the selected handle to increase or decrease the object's size.

Set the object to a specific size by entering values (measured in pixels) in the widthDim and heightDim boxes.

Setting trend time

Set the span of time (in minutes) over which you want to see data reported by entering a number in the minutes box. For example, if you want to see the point's activity over a 60-minute period, enter 60 in the minutes box.

Setting the trend line color

Set the color of the trend line by clicking color in Inspector. When the Color dialog box opens, select a color from the list or enter a hexadecimal number in the RGB boxes. Use Bright and Dark to control the color's intensity (light or dark).

Smoothing the trend

Smoothed trends display a more gradual transition between sampled values. [Note: This option should only be used with analog points that do not change dramatically between status polling loops. Trends for analog points that experience abrupt changes and trends for digital points will appear distorted (not reflect accurate values) if smooth is enabled.]

Enter Y in the smooth box to turn this option on.

Creating a link

Create a hyperlink between this object and another screen or web page by:

- Clicking URL in Inspector and selecting a destination screen (the screen that loads when this object is clicked) from the Link dialog box.
• Typing the URL address for the destination screen or web page in the URL box. The URL address must be in the following format (you don't need to type in http://): [screen name].html For example, station1.html, where station1 is the name of the screen that loads when this object is clicked; or, www.dataflowsys.com to link to the DFS website.

3. Test the object's setup by entering a value in the VALUE box. This shows you how the object appears when it's reading actual data.

4. Save your screen by choosing Save or Save As from the File menu.

Adding Digital Objects

Below are detailed instructions for adding each of Screen Builder's digital objects.

- 3D Rectangle
- 4-State Graphic
- 4-State Rectangle
- 4-State Text
- Animation
- Arrow
- Control Rectangle
- Graphic
- Graphic Control
- Oval
- Rectangle
- Round Rectangle
- Switch
- Text

Adding a Digital 3D Rectangle

See also Object Types: Digital Objects and Object Properties: Digital 3D Rectangle.

1. Choose 3D Rectangle from the Digital menu. The object appears on the screen and the Inspector window, listing all the default properties for this object, opens. Information on each field displays at the bottom of the Inspector window when you place your cursor within a field's input box.

2. You are now ready to begin manipulating the object's properties. (Note: You must press the ENTER key each time you make a direct change to any input box in the Inspector window. If you enter incorrect data in any Inspector input box, the message "***THAT ENTRY IS NOT VALID***" appears at the bottom of the Inspector window.)
Linking to a digital point

Link this object to a digital point by entering the address (station, module, point number) in the ADDR box. You can also click ADDR to open the Address Selection Tool and browse to the point. Creating a link to an active point allows the object to mimic its activity. When the pump is in the ON state, the object is in the ON state.

Changing the object's position

Click the object and hold down the left mouse button. The pointer turns into a four-headed arrow. You can now move the object in any direction by simply dragging it. For finer control of movement, select the object and use the arrow keys on your keyboard to move the object one pixel at a time.

Move the object to a specific location by changing the XLOC (horizontal position) and the YLOC (vertical position) values. A 0 (zero) in both of these boxes places the object in the top left corner of the screen. Increasing the XLOC value moves the object farther to the right. Increasing the YLOC value moves it farther down the screen.

Entering text

The system automatically inserts the text to be displayed when the point is in the ON or OFF state. You can change these labels by deleting the text in the ON and OFF boxes and entering new text. This only changes the text displayed on the screen when viewed through Screen Builder or Custom Screen Viewer. It does not change the configuration of the point.

Turn off the text display by entering N in the showText box.

Setting the object's color

Select the rectangle's ON-state color by clicking onColor box. When the Color dialog box opens, select a color from the list or type a hexadecimal number in the RGB boxes. Use Bright and Dark to control the color's intensity (light or dark).

Select the rectangle's OFF-state color by clicking offColor box. When the Color dialog box opens, select a color from the list or type a hexadecimal number in the RGB boxes. Use Bright and Dark to control the color's intensity (light or dark).

Make the object appear transparent if its color matches the color of the object directly below it by entering N in the fillBackground box.

Setting the object's size

Click the object. Handles (small white boxes) appear around the object. "Grab" a handle by clicking it. Notice that all the other handles become black in color. Hold down the left mouse button and drag the selected handle to increase or decrease the object's size. Hold down the SHIFT button while dragging a handle to make the object square (width = height).

Set the object to a specific size by entering values (measured in pixels) in the widthDim and heightDim boxes.

Positioning the text

Set the text’s alignment by entering a horizontal position (C=center, R=right, L=left) and then a vertical position (M=middle, T=top, B=bottom) in the justify box.
Set the horizontal margin (measured from the left or right of the object's edge, depending on its horizontal alignment) by entering an integer value in the insetX box. Set the vertical margin (as measured from the top or bottom of the object's edge, depending on its vertical alignment) by entering an integer value in the insetY box.

For example, entering 10 in both the insetX and insetY boxes and entering LT in the justify box, would position the text in the top left corner, 10 pixels from the left edge and 10 pixels from the top edge of the object.

**Controlling text appearance**

Set the color of the text by clicking **textColor** in Inspector. When the **Color** dialog box opens, select a color from the list or type a [hexadecimal number](#) in the **RGB** boxes. Use **Bright** and **Dark** to control the color's intensity (light or dark).

Set text size by entering an integer value in the **fontSize** box.

For bold face text, type Y in the **bold** box.

**Adding a border**

Add a border to the rectangle by entering Y in the **drawBorder** box.

Set the size of the border by entering a value (measured in pixels) in the **borderWidth** box.

Set the color of the border by clicking **borderColor** in Inspector. When the **Color** dialog box opens, select a color from the list or type a [hexadecimal number](#) in the **RGB** boxes. Use **Bright** and **Dark** to control the color's intensity (light or dark).

**Controlling the Three-Dimensional Appearance**

Make the three-dimensional rectangle appear raised (like a button) by entering Y in the **drawRaised** box. Entering N in this box makes the three-dimensional rectangle look lowered (depressed).

**Creating a link**

Create a hyperlink between this object and another screen or web page by:

- Clicking **URL** in Inspector and selecting a destination screen (the screen that loads when this object is clicked) from the **Link** dialog box.
- Typing the URL address for the destination screen or web page in the **URL** box. The URL address must be in the following format (you don't need to type in http://): [screen name].html For example, station1.html, where station1 is the name of the screen that loads when this object is clicked; or, www.dataflowsys.com to link to the DFS website.

3. Test the object's setup by entering a 0 or 1 in the **VALUE** box. When you enter a 0 in the box, you see how the object will appear when the point is OFF. Entering a 1 in the box, shows you how the object will appear when the point is ON. To see how the object will appear during the alarm state, enter an "A" after the value (for example, 0A).

4. Save your screen by choosing Save or Save As from the **File** menu.
Adding a Digital 4-State Graphic

See also Object Types: Digital Objects and Object Properties: Digital 4-State Graphic.

1. Choose 4-State Graphic from the Digital menu. The object appears on the screen and the Inspector window, listing all the default properties for this object, opens. Information on each field displays at the bottom of the Inspector window when you place your cursor within a field’s input box.

2. You are now ready to begin manipulating the object’s properties. (Note: You must press the ENTER key each time you make a direct change to any input box in the Inspector window. If you enter incorrect data in any Inspector input box, the message "***THAT ENTRY IS NOT VALID***" appears at the bottom of the Inspector window.)

   Linking to a digital point

   Link this object to a digital point by entering the address (station, module, point number) in the ADDR box. You can also click ADDR to open the Address Selection Tool and browse to the point. Creating a link to an active point allows the object to mimic its activity. When the point is in the 1 (one) state, the object is in the 1 (one) state.

   Choosing an Image

   To select an image to display during the 0 (zero), 1 (one), 2 (two), 3 (three), initial, and alarm states, click the corresponding field name (image0, image1, image2, image3, INIT, ALARM) and select the image you want to use (see Choosing Colors and Images for more information).

   If you don’t want the screen to display an image during one or more of these states, enter N in the corresponding input box.

   Changing the object’s position

   Click the object and hold down the left mouse button. The pointer turns into a four-headed arrow. You can now move the object in any direction by simply dragging it. For finer control of movement, select the object and use the arrow keys on your keyboard to move the object one pixel at a time.

   Move the object to a specific location by changing the XLOC (horizontal position) and the YLOC (vertical position) values. A 0 (zero) in both of these boxes places the object in the top left corner of the screen. Increasing the XLOC value moves the object farther to the right. Increasing the YLOC value moves it farther down the screen.

   Creating a link

   Create a hyperlink between this object and another screen or web page by:

   - Clicking URL in Inspector and selecting a destination screen (the screen that loads when this object is clicked) from the Link dialog box.
   - Typing the URL address for the destination screen or web page in the URL box. The URL address must be in the following format (you don't need to type in http://): [screen name].html For example, station1.html, where station1 is the name of the screen that loads when this object is clicked; or, www.dataflowsys.com to link to the DFS website.
3. Test the object’s setup by entering a 0, 1, 2 or 3 in the VALUE box. When you enter a 0, 1, 2, or 3 in the box, you see how the object will appear when the point is in those respective states. To see how the object appears in the alarm state, enter an “A” after the value (for example, 3A), and then choose Animate from the Screen menu.

4. To save your screen, choose Save or Save As from the File menu.

Adding a Digital 4-State Rectangle

See also Object Types: Digital Objects and Object Properties: Digital 4-State Rectangle.

1. Choose 4-State Rectangle from the Digital menu. The object appears on the screen and the Inspector window, listing all the default properties for this object, opens. Information on each field displays at the bottom of the Inspector window when you place your cursor within a field’s input box.

2. You are now ready to begin manipulating the object’s properties. (Note: You must press the ENTER key each time you make a direct change to any input box in the Inspector window. If you enter incorrect data in any Inspector input box, the message “***THAT ENTRY IS NOT VALID***” appears at the bottom of the Inspector window.)

Linking to a digital point

Link this object to a digital point by entering the address (station, module, point number) in the ADDR box. You can also click ADDR to open the Address Selection Tool and browse to the point. Creating a link to an active point allows the object to mimic its activity. When the point is in the 1 (one) state, the object is in the 1 (one) state.

Changing the object's position

Click the object and hold down the left mouse button. The pointer turns into a four-headed arrow. You can now move the object in any direction by simply dragging it. For finer control of movement, select the object and use the arrow keys on your keyboard to move the object one pixel at a time.

Move the object to a specific location by changing the XLOC (horizontal position) and the YLOC (vertical position) values. A 0 (zero) in both of these boxes places the object in the top left corner of the screen. Increasing the XLOC value moves the object farther to the right. Increasing the YLOC value moves it farther down the screen.

Setting the object's color

A Digital 4-State Rectangle can display one of four states: 0 (zero), 1 (one), 2 (two) or 3 (three). Set the color for each of these states by clicking on its corresponding field name (color0, color1, color2, color3). When the Color dialog box opens, select a color from the list or type a hexadecimal number in the RGB boxes. Use Bright and Dark to control the color’s intensity (light or dark).

Setting the object's size

Click the object. Handles (small white boxes) appear around the object. “Grab” a handle by clicking it. Notice that all the other handles become black in color. Hold down the left mouse button and drag the selected handle to increase or decrease the object’s size. Hold down the SHIFT button while dragging a handle to make the object square (width = height).
Set the object to a specific size by entering values (measured in pixels) in the **widthDim** and **heightDim** boxes.

**Setting Border Properties**

Set the size of the border by entering a value (measured in pixels) in the **borderWidth** box.

Make the rectangle appear raised (like a button) by entering **Y** in the **drawRaised** box. Entering **N** in this box makes the rectangle look lowered (depressed).

**Creating a link**

Create a hyperlink between this object and another screen or web page by:

- Clicking **URL** in Inspector and selecting a destination screen (the screen that loads when this object is clicked) from the **Link** dialog box.
- Typing the URL address for the destination screen or web page in the **URL** box. The URL address must be in the following format (you don't need to type in http://): `[screen name].html` For example, station1.html, where station1 is the name of the screen that loads when this object is clicked; or, www.dataflowsys.com to link to the DFS website.

3. Test the object's setup by entering a 0, 1, 2 or 3 in the **VALUE** box. When you enter a 0, 1, 2, or 3 in the box, you see how the object will appear when the point is in those respective states.

4. Save your screen by choosing **Save** or **Save As** from the **File** menu.

**Adding a Digital 4-State Text Object**

See also Object Types: Digital Objects and Object Properties: Digital 4-State Text Object.

1. Choose **4-State Text** from the **Digital** menu. The object appears on the screen and the Inspector window, listing all the default properties for this object, opens. Information on each field displays at the bottom of the Inspector window when you place your cursor within a field's input box.

2. You are now ready to begin manipulating the object's properties. (**Note:** You must press the ENTER key each time you make a direct change to any input box in the Inspector window. If you enter incorrect data in any Inspector input box, the message "***THAT ENTRY IS NOT VALID***" appears at the bottom of the Inspector window.)

**Linking to a digital point**

Link this object to a digital point by entering the address (station, module, point number) in the **ADDR** box. You can also click **ADDR** to open the Address Selection Tool and browse to the point. Creating a link to an active point allows the object to mimic its activity. When the point is in the 1 (one) state, the object is in the 1 (one) state.

**Changing the object's position**

Click the object and hold down the left mouse button. The pointer turns into a four-headed arrow. You can now move the object in any direction by simply dragging it. For finer control of movement, select the object and use the arrow keys on your keyboard to move the object one pixel at a time.
Move the object to a specific location by changing the XLOC (horizontal position) and the YLOC (vertical position) values. A 0 (zero) in both of these boxes places the object in the top left corner of the screen. Increasing the XLOC value moves the object farther to the right. Increasing the YLOC value moves it farther down the screen.

**Entering text**

Enter the text for the 0 (zero), 1 (one), 2 (two), and 3 (three) states in the label0, label1, label2, and label3 boxes respectively. The object will display that text when the point is in the corresponding state.

**Setting the object's size**

Click the object. Handles (small white boxes) appear around the object. "Grab" a handle by clicking it. Notice that all the other handles become black in color. Hold down the left mouse button and drag the selected handle to increase or decrease the object's size.

Set the object to a specific size by entering values (measured in pixels) in the widthDim and heightDim boxes.

**Positioning the text**

Set the text's alignment by entering a horizontal position (C=center, R=right, L=left) and then a vertical position (M=middle, T=top, B=bottom) in the justify box.

Set the horizontal margin (measured from the left or right of the object's edge, depending on its horizontal alignment) by entering an integer value in the insetX box. Set the vertical margin (as measured from the top or bottom of the object's edge, depending on its vertical alignment) by entering an integer value in the insetY box.

For example, entering 10 in both the insetX and insetY boxes and entering LT in the justify box, would position the text in the top left corner, 10 pixels from the left edge and 10 pixels from the top edge of the object.

**Controlling text appearance**

Set the color of the text by clicking textColor in Inspector. When the Color dialog box opens, select a color from the list or type a hexadecimal number in the RGB boxes. Use Bright and Dark to control the color's intensity (light or dark).

Set text size by entering an integer value in the fontSize box.

For bold face text, type Y in the bold box.

**Creating a link**

Create a hyperlink between this object and another screen or web page by:

- Clicking URL in Inspector and selecting a destination screen (the screen that loads when this object is clicked) from the Link dialog box.
- Typing the URL address for the destination screen or web page in the URL box. The URL address must be in the following format (you don't need to type in http://): [screen name].html For example, station1.html, where station1 is the name of the screen that loads when this object is clicked; or, www.dataflowsys.com to link to the DFS website.

3. Test the object's setup by entering a 0, 1, 2 or 3 in the VALUE box. When you enter a 0, 1, 2, or 3 in the box, you see how the object will appear when the point is in those respective states.
4. Save your screen by choosing **Save** or **Save As** from the **File** menu.

# Adding a Digital Animation Object

See also [Object Types: Digital Objects](#) and [Object Properties: Digital Animation Object](#).

1. Choose **Animation** from the **Digital** menu. The object appears on the screen and the Inspector window, listing all the default properties for this object, opens. Information on each box displays at the bottom of the Inspector window when you place your cursor within a box's input box.

2. You are now ready to begin manipulating the object’s properties. (**Note:** You must press the ENTER key each time you make a direct change to any box in the Inspector window. If you enter incorrect data in any Inspector box, the message "***THAT ENTRY IS NOT VALID***" appears at the bottom of the Inspector window.)

### Linking to a digital point

Link this object to a digital point by entering the address (station, module, point number) in the **ADDR** box. You can also click **ADDR** to open the Address Selection Tool and browse to the point. Creating a link to an active point allows the object to mimic its activity. When the pump is in the ON state, the object is in the ON state.

### Choosing an Image

To select an image to display during the ON, OFF, initial, and alarm states, click the corresponding field name (**ON**, **OFF**, **INIT**, **ALARM**) and select the image you want to use (see [Choosing Colors and Images](#) for more information). See [Creating Animation](#), below, for more information on animating this image.

If you don't want the screen to display an image during one or more of these states, enter N in the corresponding input box.

### Changing the object's position

Click the object and hold down the left mouse button. The pointer turns into a four-headed arrow. You can now move the object in any direction by simply dragging it. For finer control of movement, select the object and use the arrow keys on your keyboard to move the object one pixel at a time.

Move the object to a specific location by changing the **XLOC** (horizontal position) and the **YLOC** (vertical position) values. A 0 (zero) in both of these boxes places the object in the top left corner of the screen. Increasing the **XLOC** value moves the object farther to the right. Increasing the **YLOC** value moves it farther down the screen.

### Creating Animation

The system creates animation by taking 2 or more images and displaying them in a continuous loop. Each image is slightly different, so that when they are displayed in this loop it appears as if the object is moving. The process is similar to drawing a ball on a pad of paper with the location of the ball slightly different on each page. When you quickly flip the pages, it appears as if the ball is bouncing along the pages.
The numbers (frame count) entered in the **onFrames**, **offFrames**, and **alarmFrames** boxes tell the system to display that number of images to create the animation. Each frame count is appended to the base image name to form the name of the image to draw in each frame. For example, if the ON state has a base image named "pump" and a frame count of 4, then the four images pump1.gif, pump2.gif, pump3.gif, and pump4.gif are used to create the animation for the ON state. All of these image files must be available in the HT3 image library (see Choosing Colors and Images for more information).

If the number of frames entered in these boxes exceeds the number of files that exist, the system uses the files that are available and inserts a time delay for each file not available. In the above example, if a frame count of 6 was entered, the four "pump" images would be drawn and then there would be a length of time (a second or two) when the image was not visible on the screen.

**Note**: The INIT state is not animated.

**Creating a link**

Create a hyperlink between this object and another screen or web page by:

- Clicking **URL** in Inspector and selecting a destination screen (the screen that loads when this object is clicked) from the **Link** dialog box.
- Typing the URL address for the destination screen or web page in the **URL** box. The URL address must be in the following format (you don't need to type in http://): [screen name].html For example, station1.html, where station1 is the name of the screen that loads when this object is clicked; or, www.dataflowsys.com to link to the DFS website.

3. Test the object’s setup by entering a 0 or 1 in the **VALUE** box and then choose **Animate** from the **Screen** menu. When you enter a 0 in the box, you see how the object will appear when the point is OFF. Entering a 1 in the box, shows you how the object will appear when the point is ON. To see how the object will appear during the alarm state, enter an "A" after the value (for example, 0A).

4. To save your screen, choose **Save** or **Save As** from the **File** menu.

**Adding a Digital Arrow**

See also **Object Types: Digital Objects** and **Object Properties: Digital Arrow**.

1. Choose **Arrow** from the **Digital** menu. The object appears on the screen and the Inspector window, listing all the default properties for this object, opens. Information on each field displays at the bottom of the Inspector window when you place your cursor within a field’s input box.

2. You are now ready to begin manipulating the object’s properties. (**Note**: You must press the ENTER key each time you make a direct change to any input box in the Inspector window. If you enter incorrect data in any Inspector input box, the message "***THAT ENTRY IS NOT VALID***" appears at the bottom of the Inspector window.)

**Linking to a digital point**

Link this object to a digital point by entering the address (station, module, point number) in the **ADDR** box. You can also click **ADDR** to open the Address Selection Tool and browse to the point. Creating a link to an active point allows the object to mimic its activity. When the pump is in the ON state, the object is in the ON state.
Changing the object's position

Click the object and hold down the left mouse button. The pointer turns into a four-headed arrow. You can now move the object in any direction by simply dragging it. For finer control of movement, select the object and use the arrow keys on your keyboard to move the object one pixel at a time.

Move the object to a specific location by changing the XLOC (horizontal position) and the YLOC (vertical position) values. A 0 (zero) in both of these boxes places the object in the top left corner of the screen. Increasing the XLOC value moves the object farther to the right. Increasing the YLOC value moves it farther down the screen.

Setting the object's color

Set the color the oval should display as during the ON state by clicking onColor in Inspector. When the Color dialog box opens, select a color from the list or type a hexadecimal number in the RGB boxes. Use Bright and Dark to control the color's intensity (light or dark).

Set the color the oval should display as during the OFF state by clicking offColor in Inspector. When the Color dialog box opens, select a color from the list or type a hexadecimal number in the RGB boxes. Use Bright and Dark to control the color's intensity (light or dark).

Setting the object's size

Click the object. Handles (small white boxes) appear around the object. "Grab" a handle by clicking it. Notice that all the other handles become black in color. Hold down the left mouse button and drag the selected handle to increase or decrease the object's size.

Set the object to a specific size by entering values (measured in pixels) in the widthDim and heightDim boxes.

Setting the arrow's direction and tail size

Change the direction that the arrow is pointing by entering a value in the direction field.

- N (north) - arrow points up
- E (east) - arrow points right
- W (west) - arrow points left
- S (south) - arrow points down

Note that when you change the arrow's direction, you may need to change its width and height. Remember that widthDim sets the horizontal size of the object and heightDim sets the vertical size of the object.

Enter a value in the tailSize field to change the size of the arrow's tail or remove it completely. Enter S for small, M for Medium, L for long, or N for none.

Adding a border

Add a border to the arrow by entering Y in the drawBorder box.

Set the color of the border by clicking borderColor in Inspector. When the Color dialog box opens, select a color from the list or type a hexadecimal number in the RGB boxes. Use Bright and Dark to control the color's intensity (light or dark).

Creating a link
Create a hyperlink between this object and another screen by:

- Clicking URL in Inspector and selecting a destination screen (the screen that loads when this object is clicked) from the **Link** dialog box.
- Typing the URL address for the destination screen in the **URL** box. The URL address must be in the following format (you don't need to type in http://): [screen name].html For example, station1.html, where station1 is the name of the screen that loads when this object is clicked.

3. Test the object's setup by entering a 0 or 1 in the **VALUE** box. When you enter a 0 in the box, you see how the object will appear when the point is OFF. Entering a 1 in the box, shows you how the object will appear when the point is ON. To see how the object will appear during the alarm state, enter an "A" after the value (for example, 0A).

4. Save your screen by choosing **Save** or **Save As** from the **File** menu.

### Adding a Digital Control Rectangle

See also **Object Types: Digital Objects** and **Object Properties: Digital Control Rectangle**.

1. Choose **Control Rectangle** from the **Digital** menu. The object appears on the screen and the Inspector window, listing all the default properties for this object, opens. Information on each field displays at the bottom of the Inspector window when you place your cursor within a field's input box.

2. You are now ready to begin manipulating the object's properties. (**Note:** You must press the ENTER key each time you make a direct change to any input box in the Inspector window. If you enter incorrect data in any Inspector input box, the message "***THAT ENTRY IS NOT VALID***" appears at the bottom of the Inspector window.)

**Linking to a digital point**

Link this object to a digital control point by entering the address (station, module, point number) in the **ADDR** box. You can also click **ADDR** to open the Address Selection Tool and browse to the point. Creating a link to an active point allows the object to mimic its activity. When the pump is in the ON state, the object is in the ON state.

When this object is linked to a digital output point, you can exercise control over the point from within Custom Screen Viewer. Click the object to turn the point on and off.

**Changing the object's position**

Click the object and hold down the left mouse button. The pointer turns into a four-headed arrow. You can now move the object in any direction by simply dragging it. For finer control of movement, select the object and use the arrow keys on your keyboard to move the object one pixel at a time.

Move the object to a specific location by changing the **XLOC** (horizontal position) and the **YLOC** (vertical position) values. A 0 (zero) in both of these boxes places the object in the top left corner of the screen. Increasing the **XLOC** value moves the object farther to the right. Increasing the **YLOC** value moves it farther down the screen.

**Entering text**
The system automatically inserts the text to be displayed when the point is in the ON or OFF state. You can change these labels by deleting the text in the ON and OFF boxes and entering new text. This only changes the text displayed on the screen when viewed through Screen Builder or Custom Screen Viewer. It does not change the configuration of the point.

Turn off the text display by entering N in the showText box.

Setting the object's color

Set the rectangle's ON-state color by clicking onColor in Inspector. When the Color dialog box opens, select a color from the list or type a hexadecimal number in the RGB boxes. Use Bright and Dark to control the color's intensity (light or dark).

Set the rectangle's OFF-state color by clicking offColor in Inspector. When the Color dialog box opens, select a color from the list or type a hexadecimal number in the RGB boxes. Use Bright and Dark to control the color's intensity (light or dark).

Make the object appear transparent if its color matches the color of the object directly below it by entering N in the fillBackground box.

Setting the object's size

Click the object. Handles (small white boxes) appear around the object. "Grab" a handle by clicking it. Notice that all the other handles become black in color. Hold down the left mouse button and drag the selected handle to increase or decrease the object's size. Hold down the SHIFT button while dragging a handle to make the object square (width = height).

Set the object to a specific size by entering values (measured in pixels) in the widthDim and heightDim boxes.

Positioning the text

Set the text's alignment by entering a horizontal position (C=center, R=right, L=left) and then a vertical position (M=middle, T=top, B=bottom) in the justify box.

Set the horizontal margin (measured from the left or right of the object's edge, depending on its horizontal alignment) by entering an integer value in the insetX box. Set the vertical margin (as measured from the top or bottom of the object's edge, depending on its vertical alignment) by entering an integer value in the insetY box.

For example, entering 10 in both the insetX and insetY boxes and entering LT in the justify box, would position the text in the top left corner, 10 pixels from the left edge and 10 pixels from the top edge of the object.

Controlling text appearance

Set the color of the text by clicking.textColor in Inspector. When the Color dialog box opens, select a color from the list or type a hexadecimal number in the RGB boxes. Use Bright and Dark to control the color's intensity (light or dark).

Set text size by entering an integer value in the fontSize box.

For bold face text, type Y in the bold box.

Adding a border

Add a border to the rectangle by entering Y in the drawBorder box.
Set the size of the border by entering a value (measured in pixels) in the `borderWidth` box.

Set the color of the border by clicking `borderColor` in Inspector. When the `Color` dialog box opens, select a color from the list or type a hexadecimal number in the `RGB` boxes. Use `Bright` and `Dark` to control the color's intensity (light or dark).

**Controlling the Three-Dimensional Appearance**

Make the rectangle appear raised (like a button) by entering Y in the `drawRaised` box. Entering N in this box makes the rectangle look lowered (depressed).

**Poll after control**

To poll a module after a control is initiated, enter the module's station and module address in the `PollAddr` field (e.g., 1025A). Add a delay between when the control is initiated and when the module is polled by entering a value in the `PollDelay` field. (See Poll After Control.)

3. Test the object's setup by entering a 0 or 1 in the `VALUE` box. When you enter a 0 in the box, you see how the object will appear when the point is OFF. Entering a 1 in the box, shows you how the object will appear when the point is ON. To see how the object will appear during the alarm state, enter an "A" after the value (for example, 0A).

4. Save your screen by choosing **Save** or **Save As** from the **File** menu.

---

**Adding a Digital Graphic**

See also **Object Types: Digital Objects** and **Object Properties: Digital Graphic**.

1. Choose **Graphic** from the **Digital** menu. The object appears on the screen and the Inspector window, listing all the default properties for this object, opens. Information on each field displays at the bottom of the Inspector window when you place your cursor within a field's input box.

2. You are now ready to begin manipulating the object's properties. *(Note: You must press the ENTER key each time you make a direct change to any input box in the Inspector window. If you enter incorrect data in any Inspector input box, the message "***THAT ENTRY IS NOT VALID***" appears at the bottom of the Inspector window.)*

**Linking to a digital point**

Link this object to a digital point by entering the address (station, module, point number) in the `ADDR` box. You can also click `ADDR` to open the Address Selection Tool and browse to the point. Creating a link to an active point allows the object to mimic its activity. When the pump is in the ON state, the object is in the ON state.

**Choosing an Image**

To select an image to display during the ON, OFF, initial, and alarm states, click the corresponding field name (ON, OFF, INIT, ALARM) and select the image you want to use (see Choosing Colors and Images for more information).

If you don't want the screen to display an image during one or more of these states, enter N in the corresponding box.

**Changing the object's position**
Click the object and hold down the left mouse button. The pointer turns into a four-headed arrow. You can now move the object in any direction by simply dragging it. For finer control of movement, select the object and use the arrow keys on your keyboard to move the object one pixel at a time.

Move the object to a specific location by changing the XLOC (horizontal position) and the YLOC (vertical position) values. A 0 (zero) in both of these boxes places the object in the top left corner of the screen. Increasing the XLOC value moves the object farther to the right. Increasing the YLOC value moves it farther down the screen.

**Adding and Controlling Text**

To have text display when the point is in the ON state, type the desired text in the onLabel box. To have text display when the point is in the OFF state, type the desired text in the offLabel box.

Turn on the text display by entering Y in the showText box. Enter N to turn off display.

Set the color of the text by clicking textColor in Inspector. When the Color dialog box opens, select a color from the list or type a hexadecimal number in the RGB boxes. Use Bright and Dark to control the color's intensity (light or dark).

Set text size by entering an integer value in the fontSize box.

**Creating a link**

Create a hyperlink between this object and another screen or web page by:

- Clicking URL in Inspector and selecting a destination screen (the screen that loads when this object is clicked) from the Link dialog box.
- Typing the URL address for the destination screen or web page in the URL box. The URL address must be in the following format (you don't need to type in http://): [screen name].html For example, station1.html, where station1 is the name of the screen that loads when this object is clicked; or, www.dataflowsys.com to link to the DFS website.

3. Test the object's setup by entering a 0 or 1 in the VALUE box. When you enter a 0 in the box, you see how the object will appear when the point is OFF. Entering a 1 in the box, shows you how the object will appear when the point is ON. To see how the object will appear during the alarm state, type an “A” after the value (for example, 0A).

4. To save your screen, choose Save or Save As from the File menu.

**Adding a Digital Graphic Control**

See also Object Types: Digital Objects and Object Properties: Digital Graphic Control.

1. Choose Graphic Control from the Digital menu. The object appears on the screen and the Inspector window, listing all the default properties for this object, opens. Information on each field displays at the bottom of the Inspector window when you place your cursor within a field's input box.
2. You are now ready to begin manipulating the object’s properties. (Note: You must press the ENTER key each time you make a direct change to any input box in the Inspector window. If you enter incorrect data in any Inspector input box, the message "***THAT ENTRY IS NOT VALID***" appears at the bottom of the Inspector window.)

**Linking to a digital point**

Link this object to a digital point by entering the address (station, module, point number) in the ADDR box. You can also click ADDR to open the Address Selection Tool and browse to the point. Creating a link to an active point allows the object to mimic its activity. When the pump is in the ON state, the object is in the ON state.

When this object is linked to a digital output point, you can exercise control over the point from within Custom Screen Viewer. Click on the object to turn the point on and off.

**Choosing an Image**

To select an image to display during the ON, OFF, initial, and alarm states, click the corresponding field name (ON, OFF, INIT, ALARM) and select the image you want to use (see Choosing Colors and Images for more information).

If you don’t want the screen to display an image during one or more of these states, enter N in the corresponding input box.

**Changing the object's position**

Click the object and hold down the left mouse button. The pointer turns into a four-headed arrow. You can now move the object in any direction by simply dragging it. For finer control of movement, select the object and use the arrow keys on your keyboard to move the object one pixel at a time.

Move the object to a specific location by changing the XLOC (horizontal position) and the YLOC (vertical position) values. A 0 (zero) in both of these boxes places the object in the top left corner of the screen. Increasing the XLOC value moves the object farther to the right. Increasing the YLOC value moves it farther down the screen.

**Adding and Controlling Text**

To have text display when the point is in the ON state, type the desired text in the onLabel box. To have text display when the point is in the OFF state, type the desired text in the offLabel box.

Turn on the text display by entering Y in the showText box. Enter N to turn off display.

Set the color of the text by clicking textColor in Inspector. When the Color dialog box opens, select a color from the list or type a hexadecimal number in the RGB boxes. Use Bright and Dark to control the color’s intensity (light or dark).

Set text size by entering an integer value in the fontSize box.

For bold face text, type Y in the bold box.

**Positioning the text**

Set the text’s alignment by entering a horizontal position (C=center, R=right, L=left) and then a vertical position (M=middle, T=top, B=bottom) in the justify box.
Set the horizontal margin (measured from the left or right of the object's edge, depending on its horizontal alignment) by entering an integer value in the `insetX` box. Set the vertical margin (as measured from the top or bottom of the object's edge, depending on its vertical alignment) by entering an integer value in the `insetY` box.

For example, entering 10 in both the `insetX` and `insetY` boxes and entering LT in the `justify` box, would position the text in the top left corner, 10 pixels from the left edge and 10 pixels from the top edge of the object.

**Poll after control**

To poll a module after a control is initiated, enter the module's station and module address in the `PollAddr` field (e.g., 1025A). Add a delay between when the control is initiated and when the module is polled by entering a value in the `PollDelay` field. (See [Poll After Control](#).)

3. Test the object's setup by entering a 0 or 1 in the `VALUE` box. When you enter a 0 in the box, you see how the object will appear when the point is OFF. Entering a 1 in the box, shows you how the object will appear when the point is ON. To see how the object will appear during the alarm state, enter an "A" after the value (for example, 0A) and then choose **Animate** from the **Screen** menu.

4. To save your screen, choose **Save** or **Save As** from the **File** menu.

### Adding a Digital Oval

See also [Object Types: Digital Objects](#) and [Object Properties: Digital Oval](#).

1. Choose **Oval** from the **Digital** menu. The object appears on the screen and the Inspector window, listing all the default properties for this object, opens. Information on each field displays at the bottom of the Inspector window when you place your cursor within a field's input box.

2. You are now ready to begin manipulating the object’s properties. *(Note: You must press the ENTER key each time you make a direct change to any input box in the Inspector window. If you enter incorrect data in any Inspector input box, the message "***THAT ENTRY IS NOT VALID***" appears at the bottom of the Inspector window.)*

**Linking to a digital point**

Link this object to a digital point by entering the address (station, module, point number) in the `ADDR` box. You can also click `ADDR` to open the Address Selection Tool and browse to the point. Creating a link to an active point allows the object to mimic its activity. When the pump is in the ON state, the object is in the ON state.

**Changing the object's position**

Click the object and hold down the left mouse button. The pointer turns into a four-headed arrow. You can now move the object in any direction by simply dragging it. For finer control of movement, select the object and use the arrow keys on your keyboard to move the object one pixel at a time.

Move the object to a specific location by changing the `XLOC` (horizontal position) and the `YLOC` (vertical position) values. A 0 (zero) in both of these boxes places the object in the top left corner of the screen. Increasing the `XLOC` value moves the object farther to the right. Increasing the `YLOC` value moves it farther down the screen.
**Entering text**

The system automatically inserts the text to be displayed when the point is in the ON or OFF state. You can change these labels by deleting the text in the ON and OFF boxes and entering new text. This only changes the text displayed on the screen when viewed through Screen Builder or Custom Screen Viewer. It does not change the configuration of the point.

Turn off the text display by entering N in the showText box.

**Setting the object's color**

Set the oval's ON-state color by clicking onColor in Inspector. When the Color dialog box opens, select a color from the list or type a hexadecimal number in the RGB boxes. Use Bright and Dark to control the color's intensity (light or dark).

Set the oval's OFF-state color by clicking offColor in Inspector. When the Color dialog box opens, select a color from the list or type a hexadecimal number in the RGB boxes. Use Bright and Dark to control the color's intensity (light or dark).

Make the object appear transparent (its color matches the color of the object directly below it) by entering N in the fillBackground box.

**Setting the object's size**

Click the object. Handles (small white boxes) appear around the object. "Grab" a handle by clicking it. Notice that all the other handles become black in color. Hold down the left mouse button and drag the selected handle to increase or decrease the object's size. Hold down the SHIFT button while dragging a handle to make the object square (width = height).

Set the object to a specific size by entering values (measured in pixels) in the widthDim and heightDim boxes.

**Positioning the text**

Set the text's alignment by entering a horizontal position (C=center, R=right, L=left) and then a vertical position (M=middle, T=top, B=bottom) in the justify box.

Set the horizontal margin (measured from the left or right of the object’s edge, depending on its horizontal alignment) by entering an integer value in the insetX box. Set the vertical margin (as measured from the top or bottom of the object's edge, depending on its vertical alignment) by entering an integer value in the insetY box.

For example, entering 10 in both the insetX and insetY boxes and entering LT in the justify box, would position the text in the top left corner, 10 pixels from the left edge and 10 pixels from the top edge of the object.

**Controlling text appearance**

Set the color of the text by clicking textColor in Inspector. When the Color dialog box opens, select a color from the list or type a hexadecimal number in the RGB boxes. Use Bright and Dark to control the color's intensity (light or dark).

Set text size by entering an integer value in the fontSize box.

For bold face text, type Y in the bold box.

**Adding a border**
Add a border to the rectangle by entering Y in the drawBorder box.

Set the size of the border by entering a value (measured in pixels) in the borderWidth box.

Set the color of the border by clicking borderColor in Inspector. When the Color dialog box opens, select a color from the list or type a hexadecimal number in the RGB boxes. Use Bright and Dark to control the color's intensity (light or dark).

Creating a link

Create a hyperlink between this object and another screen or web page by:

- Clicking URL in Inspector and selecting a destination screen (the screen that loads when this object is clicked) from the Link dialog box.
- Typing the URL address for the destination screen or web page in the URL box. The URL address must be in the following format (you don't need to type in http://): [screen name].html For example, station1.html, where station1 is the name of the screen that loads when this object is clicked; or, www.dataflowsys.com to link to the DFS website.

3. Test the object's setup by entering a 0 or 1 in the VALUE box. When you enter a 0 in the box, you see how the object will appear when the point is OFF. Entering a 1 in the box, shows you how the object will appear when the point is ON. To see how the object will appear during the alarm state, enter an "A" after the value (for example, 0A).

4. Save your screen by choosing Save or Save As from the File menu.

Adding a Digital Rectangle

See also Object Types: Digital Objects and Object Properties: Digital Rectangle.

1. Choose Rectangle from the Digital menu. The object appears on the screen and the Inspector window, listing all the default properties for this object, opens. Information on each field displays at the bottom of the Inspector window when you place your cursor within a field's input box.

2. You are now ready to begin manipulating the object's properties. (Note: You must press the ENTER key each time you make a direct change to any input box in the Inspector window. If you enter incorrect data in any Inspector input box, the message "***THAT ENTRY IS NOT VALID***" appears at the bottom of the Inspector window.)

Linking to a digital point

Link this object to a digital point by entering the address (station, module, point number) in the ADDR box. You can also click ADDR to open the Address Selection Tool and browse to the point. Creating a link to an active point allows the object to mimic its activity. When the pump is in the ON state, the object is in the ON state.

Changing the object's position

Click the object and hold down the left mouse button. The pointer turns into a four-headed arrow. You can now move the object in any direction by simply dragging it. For finer control of movement, select the object and use the arrow keys on your keyboard to move the object one pixel at a time.
Move the object to a specific location by changing the XLOC (horizontal position) and the YLOC (vertical position) values. A 0 (zero) in both of these boxes places the object in the top left corner of the screen. Increasing the XLOC value moves the object farther to the right. Increasing the YLOC value moves it farther down the screen.

**Entering text**

The system automatically inserts the text to be displayed when the point is in the ON or OFF state. You can change these labels by deleting the text in the ON and OFF boxes and entering new text. This only changes the text displayed on the screen when viewed through Screen Builder or Custom Screen Viewer. It does not change the configuration of the point.

Turn off the text display by entering N in the *showText* box.

**Setting the object's color**

Select the rectangle's ON-state color by clicking *onColor* in Inspector. When the *Color* dialog box opens, select a color from the list or type a [hexadecimal number](#) in the RGB boxes. Use *Bright* and *Dark* to control the color's intensity (light or dark).

Select the rectangle's OFF-state color by clicking *offColor* in Inspector. When the *Color* dialog box opens, select a color from the list or type a [hexadecimal number](#) in the RGB boxes. Use *Bright* and *Dark* to control the color's intensity (light or dark).

Make the object appear transparent if its color matches the color of the object directly below it by entering N in the *fillBackground* box.

**Setting the object's size**

Click the object. Handles (small white boxes) appear around the object. "Grab" a handle by clicking it. Notice that all the other handles become black in color. Hold down the left mouse button and drag the selected handle to increase or decrease the object's size. Hold down the SHIFT button while dragging a handle to make the object square (width = height).

Set the object to a specific size by entering values (measured in pixels) in the *widthDim* and *heightDim* boxes.

**Positioning the text**

Set the text's alignment by entering a horizontal position (C=center, R=right, L=left) and then a vertical position (M=middle, T=top, B=bottom) in the *justify* box.

Set the horizontal margin (measured from the left or right of the object's edge, depending on its horizontal alignment) by entering an integer value in the *insetX* box. Set the vertical margin (as measured from the top or bottom of the object's edge, depending on its vertical alignment) by entering an integer value in the *insetY* box.

For example, entering 10 in both the *insetX* and *insetY* boxes and entering LT in the *justify* box, would position the text in the top left corner, 10 pixels from the left edge and 10 pixels from the top edge of the object.

**Controlling text appearance**

Set the color of the text by clicking *textColor* in Inspector. When the *Color* dialog box opens, select a color from the list or type a [hexadecimal number](#) in the RGB boxes. Use *Bright* and *Dark* to control the color's intensity (light or dark).
Set text size by entering an integer value in the **fontSize** box.

For bold face text, type Y in the **bold** box.

**Adding a border**

Add a border to the rectangle by entering Y in the **drawBorder** box.

Set the size of the border by entering a value (measured in pixels) in the **borderWidth** box.

Set the color of the border by clicking **borderColor** in Inspector. When the **Color** dialog box opens, select a color from the list or type a [hexadecimal number](#) in the **RGB** boxes. Use **Bright** and **Dark** to control the color’s intensity (light or dark).

**Creating a link**

Create a hyperlink between this object and another screen or web page by:

- Clicking **URL** in Inspector and selecting a destination screen (the screen that loads when this object is clicked) from the **Link** dialog box.
- Typing the URL address for the destination screen or web page in the **URL** box. The URL address must be in the following format (you don't need to type in http://): [screen name].html For example, station1.html, where station1 is the name of the screen that loads when this object is clicked; or, www.dataflowsys.com to link to the DFS website.

3. Test the object's setup by entering a 0 or 1 in the **VALUE** box. When you enter a 0 in the box, you see how the object will appear when the point is OFF. Entering a 1 in the box, shows you how the object will appear when the point is ON. To see how the object will appear during the alarm state, type an "A" after the value (for example, 0A).

4. Save your screen by choosing **Save** or **Save As** from the **File** menu.

**Adding a Digital Round Rectangle**

See also [Object Types: Digital Objects](#) and [Object Properties: Digital Round Rectangle](#).

1. Choose **Round Rectangle** from the **Digital** menu. The object appears on the screen and the Inspector window, listing all the default properties for this object, opens. Information on each field displays at the bottom of the Inspector window when you place your cursor within a field’s input box.

2. You are now ready to begin manipulating the object’s properties. (**Note**: You must press the ENTER key each time you make a direct change to any input box in the Inspector window. If you enter incorrect data in any Inspector input box, the message "***THAT ENTRY IS NOT VALID***" appears at the bottom of the Inspector window.)

**Linking to a digital point**

Link this object to a digital point by entering the address (station, module, point number) in the **ADDR** box. You can also click **ADDR** to open the Address Selection Tool and browse to the point. Creating a link to an active point allows the object to mimic its activity. When the pump is in the ON state, the object is in the ON state.

**Changing the object's position**
Click the object and hold down the left mouse button. The pointer turns into a four-headed arrow. You can now move the object in any direction by simply dragging it. For finer control of movement, select the object and use the arrow keys on your keyboard to move the object one pixel at a time.

Move the object to a specific location by changing the XLOC (horizontal position) and the YLOC (vertical position) values. A 0 (zero) in both of these boxes places the object in the top left corner of the screen. Increasing the XLOC value moves the object farther to the right. Increasing the YLOC value moves it farther down the screen.

**Entering text**

The system automatically inserts the text to be displayed when the point is in the ON or OFF state. You can change these labels by deleting the text in the ON and OFF boxes and entering new text. This only changes the text displayed on the screen when viewed through Screen Builder or Custom Screen Viewer. It does not change the configuration of the point.

Turn off the text display by entering N in the showText box.

**Setting the object's color**

Set the rectangle’s ON-state color by clicking onColor in Inspector. When the Color dialog box opens, select a color from the list or type a [hexadecimal number](#) in the RGB boxes. Use Bright and Dark to control the color's intensity (light or dark).

Set the rectangle’s OFF-state color by clicking offColor in Inspector. When the Color dialog box opens, select a color from the list or type a [hexadecimal number](#) in the RGB boxes. Use Bright and Dark to control the color's intensity (light or dark).

Make the object appear transparent (its color matches the color of the object directly below it) by entering N in the fillBackgroundColor box.

**Setting the object's size**

Click the object. Handles (small white boxes) appear around the object. "Grab" a handle by clicking it. Notice that all the other handles become black in color. Hold down the left mouse button and drag the selected handle to increase or decrease the object's size. Hold down the SHIFT button while dragging a handle to make the object square (width = height).

Set the object to a specific size by entering values (measured in pixels) in the widthDim and heightDim boxes.

**Positioning the text**

Set the text's alignment by entering a horizontal position (C=center, R=right, L=left) and then a vertical position (M=middle, T=top, B=bottom) in the justify box.

Set the horizontal margin (measured from the left or right of the object's edge, depending on its horizontal alignment) by entering an integer value in the insetX box. Set the vertical margin (as measured from the top or bottom of the object's edge, depending on its vertical alignment) by entering an integer value in the insetY box.

For example, entering 10 in both the insetX and insetY boxes and entering LT in the justify box, would position the text in the top left corner, 10 pixels from the left edge and 10 pixels from the top edge of the object.

**Controlling text appearance**
Set the color of the text by clicking `textColor` in Inspector. When the `Color` dialog box opens, select a color from the list or type a hexadecimal number in the RGB boxes. Use `Bright` and `Dark` to control the color’s intensity (light or dark).

Set text size by entering an integer value in the `fontSize` box.

For bold face text, type Y in the `bold` box.

**Adding a border**

Add a border to the rectangle by entering Y in the `drawBorder` box.

Set the size of the border by entering a value (measured in pixels) in the `borderWidth` box.

Set the color of the border by clicking `borderColor` in Inspector. When the `Color` dialog box opens, select a color from the list or type a hexadecimal number in the RGB boxes. Use `Bright` and `Dark` to control the color’s intensity (light or dark).

**Controlling the Degree of Curve**

Values entered in the `radius` box controls the "roundness" of the object’s corners. Larger numbers make the rectangle’s corners appear rounder; the image is more circular. Smaller numbers make the rectangle’s corners appear sharper; the image is more square.

**Creating a link**

Create a hyperlink between this object and another screen or web page by:

- Clicking `URL` in Inspector and selecting a destination screen (the screen that loads when this object is clicked) from the `Link` dialog box.
- Typing the URL address for the destination screen or web page in the `URL` box. The URL address must be in the following format (you don't need to type in http://): [screen name].html For example, station1.html, where station1 is the name of the screen that loads when this object is clicked; or, www.dataflowsys.com to link to the DFS website.

3. Test the object’s setup by entering a 0 or 1 in the `VALUE` box. When you enter a 0 in the box, you see how the object will appear when the point is OFF. Entering a 1 in the box, shows you how the object will appear when the point is ON. To see how the object will appear during the alarm state, enter an "A" after the value (for example, 0A).

4. Save your screen by choosing `Save` or `Save As` from the `File` menu.

**Adding a Digital Switch**

See also [Object Types: Digital Objects](#) and [Object Properties: Digital Switch](#).

1. Choose `Switch` from the `Digital` menu. The object appears on the screen and the Inspector window, listing all the default properties for this object, opens. Information on each field displays at the bottom of the Inspector window when you place your cursor within a field’s input box.

2. You are now ready to begin manipulating the object’s properties. (**Note**: You must press the ENTER key each time you make a direct change to any input box in the Inspector window. If you enter incorrect data in any Inspector input box, the message "***THAT ENTRY IS NOT VALID***" appears at the bottom of the Inspector window.)
Linking to a digital point

Link this object to a digital point by entering the address (station, module, point number) in the ADDR box. You can also click ADDR to open the Address Selection Tool and browse to the point. Creating a link to an active point allows the object to mimic its activity. When the pump is in the ON state, the object is in the ON state.

When this object is linked to a digital output point, you can exercise control over the point from within Custom Screen Viewer. Click the switch to turn the point on or off.

Changing the object's position

Click the object and hold down the left mouse button. The pointer turns into a four-headed arrow. You can now move the object in any direction by simply dragging it. For finer control of movement, select the object and use the arrow keys on your keyboard to move the object one pixel at a time.

Move the object to a specific location by changing the XLOC (horizontal position) and the YLOC (vertical position) values. A 0 (zero) in both of these boxes places the object in the top left corner of the screen. Increasing the XLOC value moves the object farther to the right. Increasing the YLOC value moves it farther down the screen.

Selecting a switch type and color

The digital switch can be one of three types: ROCKER, LEVER (toggle switch), or SLIDER. Type the name of the switch you want to use in the switchType box.

Set the switch’s color by clicking switchColor in Inspector. When the Color dialog box opens, select a color from the list or type a hexadecimal number in the RGB boxes. Use Bright and Dark to control the color's intensity (light or dark).

Turn on background

To use the switch's default background image, enter Y in the drawBackground box. If you want to create your own background, enter N in this box.

Adding an LED

Each of the three switch types can have an LED that changes color depending on the point’s state. To add an LED to the switch, enter Y in the drawLED box.

Set the LED’s ON-state color by clicking onColor in Inspector. When the Color dialog box opens, select a color from the list or type a hexadecimal number in the RGB boxes. Use Bright and Dark to control the color's intensity (light or dark).

Set the LED’s OFF-state color by clicking offColor in Inspector. When the Color dialog box opens, select a color from the list or type a hexadecimal number in the RGB boxes. Use Bright and Dark to control the color's intensity (light or dark).

Changing the object's orientation

To change an object’s orientation (for example, to make a rocker switch appear horizontal instead of vertical), make the width of the object greater than its height.

Setting the object's size
Click the object. Handles (small white boxes) appear around the object. "Grab" a handle by clicking it. Notice that all the other handles become black in color. Hold down the left mouse button and drag the selected handle to increase or decrease the object's size.

Set the object to a specific size by entering values (measured in pixels) in the \texttt{widthDim} and \texttt{heightDim} boxes.

Select border color (Rocker Switch only)

Set the color of the rocker switch's border by clicking \texttt{borderColor} in Inspector. When the \texttt{Color} dialog box opens, select a color from the list or type a \texttt{hexadecimal number} in the \texttt{RGB} boxes. Use \texttt{Bright} and \texttt{Dark} to control the color's intensity (light or dark).

Poll after control

To poll a module after a control is initiated, enter the module's station and module address in the \texttt{PollAddr} field (e.g., 1025A). Add a delay between when the control is initiated and when the module is polled by entering a value in the \texttt{PollDelay} field. (See Poll After Control.)

3. Test the object's setup by entering a 0 or 1 in the \texttt{VALUE} box. When you enter a 0 in the box, you see how the object will appear when the point is OFF. Entering a 1 in the box, shows you how the object will appear when the point is ON. To see how the object will appear during the alarm state, enter an "A" after the value (for example, 0A).

4. Save your screen by choosing Save or Save As from the File menu.

Adding a Digital Text Object

See also Object Types: Digital Objects and Object Properties: Digital Text.

1. Choose Text from the Digital menu. The object appears on the screen and the Inspector window, listing all the default properties for this object, opens. Information on each field displays at the bottom of the Inspector window when you place your cursor within a field's input box.

2. You are now ready to begin manipulating the object’s properties. (Note: You must press the ENTER key each time you make a direct change to any input box in the Inspector window. If you enter incorrect data in any Inspector input box, the message "***THAT ENTRY IS NOT VALID***" appears at the bottom of the Inspector window.)

Linking to a digital point

Link this object to a digital point by entering the address (station, module, point number) in the \texttt{ADDR} box. You can also click \texttt{ADDR} to open the Address Selection Tool and browse to the point. Creating a link to an active point allows the object to mimic its activity. When the pump is in the ON state, the object is in the ON state.

Changing the object's position

Click the object and hold down the left mouse button. The pointer turns into a four-headed arrow. You can now move the object in any direction by simply dragging it. For finer control of movement, select the object and use the arrow keys on your keyboard to move the object one pixel at a time.
Move the object to a specific location by changing the **XLOC** (horizontal position) and the **YLOC** (vertical position) values. A 0 (zero) in both of these boxes places the object in the top left corner of the screen. Increasing the **XLOC** value moves the object farther to the right. Increasing the **YLOC** value moves it farther down the screen.

### Entering text

The system automatically inserts the text to be displayed when the point is in the ON or OFF state. You can change these labels by deleting the text in the ON and OFF boxes and entering new text. This only changes the text displayed on the screen when viewed through Screen Builder or Custom Screen Viewer. It does not change the configuration of the point.

Turn off the text display by entering N (uppercase) in the ON and/or OFF boxes.

### Setting the object's size

Click the object. Handles (small white boxes) appear around the object. "Grab" a handle by clicking it. Notice that all the other handles become black in color. Hold down the left mouse button and drag the selected handle to increase or decrease the object’s size.

Set the object to a specific size by entering values (measured in pixels) in the **widthDim** and **heightDim** boxes.

### Positioning the text

Set the text’s alignment by entering a horizontal position (C=center, R=right, L=left) and then a vertical position (M=middle, T=top, B=bottom) in the **justify** box.

Set the horizontal margin (measured from the left or right of the object's edge, depending on its horizontal alignment) by entering an integer value in the **insetX** box. Set the vertical margin (as measured from the top or bottom of the object's edge, depending on its vertical alignment) by entering an integer value in the **insetY** box.

For example, entering 10 in both the **insetX** and **insetY** boxes and entering LT in the **justify** box, would position the text in the top left corner, 10 pixels from the left edge and 10 pixels from the top edge of the object.

### Controlling text appearance

Set the color of the text by clicking **textColor** in Inspector. When the Color dialog box opens, select a color from the list or type a hexadecimal number in the RGB boxes. Use Bright and Dark to control the color's intensity (light or dark).

Set text size by entering an integer value in the **fontSize** box.

For bold face text, type Y in the **bold** box.

### Setting the object's color

Set the color of the object by clicking **backgroundColor** in Inspector. When the Color dialog box opens, select a color from the list or type a hexadecimal number in the RGB boxes. Use Bright and Dark to control the color’s intensity (light or dark).

Make the object appear transparent (its color matches the color of the object directly beneath it) by entering N in the **fillBackgroundColor** box.

### Adding a border
Add a border to the text object by entering Y in the drawBorder box.

Creating a link

Create a hyperlink between this object and another screen or web page by:

- Clicking URL in Inspector and selecting a destination screen (the screen that loads when this object is clicked) from the Link dialog box.
- Typing the URL address for the destination screen or web page in the URL box. The URL address must be in the following format (you don't need to type in http://): [screen name].html For example, station1.html, where station1 is the name of the screen that loads when this object is clicked; or, www.dataflowsys.com to link to the DFS website.

3. Test the object's setup by entering a 0 or 1 in the VALUE box. When you enter a 0 in the box, you see how the object will appear when the point is OFF. Entering a 1 in the box, shows you how the object will appear when the point is ON. Enter an "A" after the value (for example, 0A) to see how the object will appear during the alarm state.

4. Save your screen by choosing Save or Save As from the File menu.

Adding Pipe Objects

Below are detailed instructions for adding each of Screen Builder's static objects.

- Digital Elbow
- Digital Pipe
- Gradient Elbow (Static)
- Gradient Pipe (Digital)
- Spinner (Digital)
- Static Pipe
- Static Elbow
- Valve (Digital)

Adding a Digital Elbow

See also Object Types: Pipe Objects and Object Properties: Digital Elbow.

1. Choose Digital Elbow from the Pipe menu. The object appears on the screen and the Inspector window, listing all the default properties for this object, opens. Information on each field displays at the bottom of the Inspector window when you place your cursor within a field's input box.

2. You are now ready to begin manipulating the object's properties. (Note: You must press the ENTER key each time you make a direct change to any input box in the Inspector window. If you enter incorrect data in any Inspector input box, the message "***THAT ENTRY IS NOT VALID***" appears at the bottom of the Inspector window.)

Linking to a digital point
Link this object to a digital point by entering the address (station, module, point number) in the ADDR box. Creating a link to an active point allows the object to mimic its activity. When the point is in the ON state, the object is in the ON state. You can also click ADDR to open the Address Selection Tool and browse to the point.

**Changing the object's position**

Click the object and hold down the left mouse button. The pointer turns into a four-headed arrow. You can now move the object in any direction by simply dragging it. For finer control of movement, select the object and use the arrow keys on your keyboard to move the object one pixel at a time.

Move the object to a specific location by changing the XLOC (horizontal position) and the YLOC (vertical position) values. A 0 (zero) in both of these boxes places the object in the top left corner of the screen. Increasing the XLOC value moves the object farther to the right. Increasing the YLOC value moves it farther down the screen.

**Selecting the object's color**

Set the elbow's color by clicking **backgroundColor** in Inspector. When the **Color** dialog box opens, select a color from the list or type a hexadecimal number in the RGB boxes. Use **Bright** and **Dark** to control the color's intensity (light or dark).

Set the color for the pipe's "contents" during the ON state by clicking **ON**. When the **Color** dialog box opens, select a color from the list or type a hexadecimal number in the RGB boxes. Use **Bright** and **Dark** to control the color's intensity (light or dark).

Set the color for the pipe's "contents" during the OFF state by clicking **OFF**. When the **Color** dialog box opens, select a color from the list or type a hexadecimal number in the RGB boxes. Use **Bright** and **Dark** to control the color's intensity (light or dark).

Set the pipe's initial color (point isn't offline, but doesn't yet have status) and alarm state color by clicking **INIT** in Inspector. When the **Color** dialog box opens, select a color from the list or type a hexadecimal number in the RGB boxes. Use **Bright** and **Dark** to control the color's intensity (light or dark).

**Sizing the object**

Click the object. Handles (small white boxes) appear around the object. "Grab" a handle by clicking it. Notice that all the other handles become black in color. Hold down the left mouse button and drag the selected handle to increase or decrease the object's size. Hold down the SHIFT button while dragging a handle to make the object square (width = height).

Set the object to a specific size by entering values (measured in pixels) in the **widthDim** and **heightDim** boxes.

To set the diameter of the pipe elbow, enter a value in the **diameter** field.

**Setting the direction of the curve**

**quadrant** is used to set the position of the elbow's outside curve. Enter SE (bottom right), SW (bottom left), NE (top right), or NW (top left) in this box.

**Creating a link**

Create a hyperlink between this object and another screen or web page by:
• Clicking URL in Inspector and selecting a destination screen (the screen that loads when this object is clicked) from the Link dialog box.

• Typing the URL address for the destination screen or web page in the URL box. The URL address must be in the following format (you don't need to type in http://): [screen name].html For example, station1.html, where station1 is the name of the screen that loads when this object is clicked; or, www.dataflowsys.com to link to the DFS website.

3. Test the object’s setup by entering a 0 or 1 in the VALUE box. Enter a 0 in the box to see how the object will appear when the point is OFF. Entering a 1 in the box, shows you how the object will appear when the point is ON. To see how the object will appear during the alarm state, enter an "A" after the value (for example, 0A).

4. Save your screen by choosing Save or Save As from the File menu.

Adding a Digital Pipe

See also Object Types: Pipe Objects and Object Properties: Digital Pipe.

1. Choose Digital Pipe from the Pipe menu. The object appears on the screen and the Inspector window, listing all the default properties for this object, opens. Information on each field displays at the bottom of the Inspector window when you place your cursor within a field's input box.

2. You are now ready to begin manipulating the object’s properties. (Note: You must press the ENTER key each time you make a direct change to any input box in the Inspector window. If you enter incorrect data in any Inspector input box, the message "***THAT ENTRY IS NOT VALID***" appears at the bottom of the Inspector window.)

Linking to a digital point

Link this object to a digital point by entering the address (station, module, point number) in the ADDR box. Creating a link to an active point allows the object to mimic its activity. When the point is in the ON state, the object is in the ON state. You can also click ADDR to open the Address Selection Tool and browse to the point.

Changing the object's position

Click the object and hold down the left mouse button. The pointer turns into a four-headed arrow. You can now move the object in any direction by simply dragging it. For finer control of movement, select the object and use the arrow keys on your keyboard to move the object one pixel at a time.

Move the object to a specific location by changing the XLOC (horizontal position) and the YLOC (vertical position) values. A 0 (zero) in both of these boxes places the object in the top left corner of the screen. Increasing the XLOC value moves the object farther to the right. Increasing the YLOC value moves it farther down the screen.

Selecting the object's color

Set the pipe’s color by clicking backgroundColor in Inspector. When the Color dialog box opens, select a color from the list or type a hexadecimal number in the RGB boxes. Use Bright and Dark to control the color’s intensity (light or dark).
Set the ON-state color for the pipe's "contents" by clicking ON. When the Color dialog box opens, select a color from the list or type a hexadecimal number in the RGB boxes. Use Bright and Dark to control the color's intensity (light or dark).

Set the OFF-state color for the pipe's "contents" by clicking OFF. When the Color dialog box opens, select a color from the list or type a hexadecimal number in the RGB boxes. Use Bright and Dark to control the color's intensity (light or dark).

Set the pipe's initial color (point isn't offline, but doesn't yet have status) and alarm state color by clicking INIT in Inspector. When the Color dialog box opens, select a color from the list or type a hexadecimal number in the RGB boxes. Use Bright and Dark to control the color's intensity (light or dark).

**Sizing the object**

Click the object. Handles (small white boxes) appear around the object. "Grab" a handle by clicking it. Notice that all the other handles become black in color. Hold down the left mouse button and drag the selected handle to increase or decrease the object's size. Hold down the SHIFT button while dragging a handle to make the object square (width = height).

Set the object to a specific size by entering values (measured in pixels) in the widthDim and heightDim boxes.

**Specifying the object's orientation**

The default orientation for this object is horizontal; the value in vertical box is set to N. To set the orientation of the pipe to vertical, enter Y in the vertical box. When you set the orientation to vertical, you need to change the widthDim and heightDim values. Remember that widthDim sets the horizontal size of the object and heightDim sets the vertical size of the object.

**Adding a junction**

To add a junction to a pipe at either one or both ends, enter Y in the northEast and/or southWest boxes. A Y entered in the northEast box adds a junction at the north (top) end if the pipe is vertical or at the east (left) end if the pipe is horizontal. A Y entered in the southWest box adds a junction at the south (bottom) end if the pipe is vertical or at the west (right) end if the pipe is horizontal.

**Creating a link**

Create a hyperlink between this object and another screen or web page by:

- Clicking URL in Inspector and selecting a destination screen (the screen that loads when this object is clicked) from the Link dialog box.
- Typing the URL address for the destination screen or web page in the URL box. The URL address must be in the following format (you don't need to type in http://): [screen name].html For example, station1.html, where station1 is the name of the screen that loads when this object is clicked; or, www.dataflowsys.com to link to the DFS website.

3. Test the object's setup by entering a 0 or 1 in the VALUE box. Enter a 0 in the box to see how the object will appear when the point is OFF. Entering a 1 in the box, shows you how the object will appear when the point is ON. To see how the object will appear during the alarm state, enter an "A" after the value (for example, 0A).

4. Save your screen by choosing Save or Save As from the File menu.
Adding a (Static) Gradient Elbow

See also Object Types: Pipe Objects and Object Properties: Gradient Elbow.

1. Choose Gradient Elbow from the Pipe menu. The object appears on the screen and the Inspector window, listing all the default properties for this object, opens. Information on each field displays at the bottom of the Inspector window when you place your cursor within a field's input box.

2. You are now ready to begin manipulating the object’s properties. (Note: You must press the ENTER key each time you make a direct change to any input box in the Inspector window. If you enter incorrect data in any Inspector input box, the message "***THAT ENTRY IS NOT VALID***" appears at the bottom of the Inspector window.)

   Changing the object’s position

   Click the object and hold down the left mouse button. The pointer turns into a four-headed arrow. You can now move the object in any direction by simply dragging it. For finer control of movement, select the object and use the arrow keys on your keyboard to move the object one pixel at a time.

   Move the object to a specific location by changing the XLOC (horizontal position) and the YLOC (vertical position) values. A 0 (zero) in both of these boxes places the object in the top left corner of the screen. Increasing the XLOC value moves the object farther to the right. Increasing the YLOC value moves it farther down the screen.

   Selecting the object’s color

   Set the elbow’s background color by clicking backgroundColor in Inspector. When the Color dialog box opens, select a color from the list or type a hexadecimal number in the RGB boxes. Use Bright and Dark to control the color’s intensity (light or dark). Use the same procedure to change the object’s foreground color. The foreground color is the color that appears in the center of the elbow. Click foregroundColor to select a different color.

   Sizing the object

   Click the object. Handles (small white boxes) appear around the object. "Grab" a handle by clicking it. Notice that all the other handles become black in color. Hold down the left mouse button and drag the selected handle to increase or decrease the object’s size. Hold down the SHIFT button while dragging a handle to make the object square (width = height).

   Set the object to a specific size by entering values (measured in pixels) in the widthDim and heightDim boxes.

   To set the diameter of the pipe elbow, enter a value in the diameter box.

   Setting the direction of the curve

   quadrant is used to set the position of the elbow’s outside curve. Enter SE (bottom right), SW (bottom left), NE (top right), or NW (top left) in this field.

   Creating a link

   Create a hyperlink between this object and another screen or web page by:
Clicking **URL** in Inspector and selecting a destination screen (the screen that loads when this object is clicked) from the **Link** dialog box.

- Typing the URL address for the destination screen or web page in the **URL** box. The URL address must be in the following format (you don't need to type in http://): [screen name].html For example, station1.html, where station1 is the name of the screen that loads when this object is clicked; or, www.dataflowsys.com to link to the DFS website.

3. Save your screen by choosing **Save** or **Save As** from the **File** menu.

# Adding a (Digital) Gradient Pipe

See also [Object Types: Pipe Objects](#) and [Object Properties: Gradient Pipe](#).

1. Choose **Gradient Pipe** from the **Pipe** menu. The object appears on the screen and the Inspector window, listing all the default properties for this object, opens. Information on each field displays at the bottom of the Inspector window when you place your cursor within a field's input box.

2. You are now ready to begin manipulating the object's properties. (**Note:** You must press the ENTER key each time you make a direct change to any input box in the Inspector window. If you enter incorrect data in any Inspector input box, the message "***THAT ENTRY IS NOT VALID***" appears at the bottom of the Inspector window.)

**Linking to a digital point**

Link this object to a digital point by entering the address (station, module, point number) in the **ADDR** box. You can also click **ADDR** to open the Address Selection Tool and browse to the point. Creating a link to an active point allows the object to mimic its activity. When the point is in the ON state, the object is in the ON state.

**Changing the object's position**

Click the object and hold down the left mouse button. The pointer turns into a four-headed arrow. You can now move the object in any direction by simply dragging it. For finer control of movement, select the object and use the arrow keys on your keyboard to move the object one pixel at a time.

Move the object to a specific location by changing the **XLOC** (horizontal position) and the **YLOC** (vertical position) values. A 0 (zero) in both of these boxes places the object in the top left corner of the screen. Increasing the **XLOC** value moves the object farther to the right. Increasing the **YLOC** value moves it farther down the screen.

**Selecting the object's color**

Set the pipe's background color by clicking **backgroundColor** in Inspector. When the **Color** dialog box opens, select a color from the list or type a **hexadecimal number** in the **RGB** boxes. Use **Bright** and **Dark** to control the color's intensity (light or dark). Use the same procedure to change the object's foreground color. The foreground color is the color that appears in the center of the pipe. Click **foregroundColor** to select a different color.

**Sizing the object**
Click the object. Handles (small white boxes) appear around the object. "Grab" a handle by clicking it. Notice that all the other handles become black in color. Hold down the left mouse button and drag the selected handle to increase or decrease the object's size. Hold down the SHIFT button while dragging a handle to make the object square (width = height).

Set the object to a specific size by entering values (measured in pixels) in the widthDim and heightDim boxes.

**Specifying the object's orientation**

The default orientation for this object is horizontal (the value in vertical box is set to N). To orient the pipe vertically, enter Y in the vertical box. When you set the orientation to vertical, you need to change the widthDim and heightDim values. Remember that widthDim sets the horizontal size of the object and heightDim sets the vertical size of the object.

**Configuring arrow behavior**

The gradient pipe features arrows (animated or static) that can mimic, for example, flow through a pipe. The behavior of the arrow depends on three things:

- Is the object linked to a point or is it STATIC?
- Has the showAnimation option been enabled?
- Has the offArrow option been enabled? ("Off" arrows are the darker arrows that appear between animated arrows and are displayed statically when the point is in the off state.)

The table below shows the possible combinations and their results.

<table>
<thead>
<tr>
<th>ADDR</th>
<th>showAnimation</th>
<th>offArrow</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>address of point</td>
<td>Y</td>
<td>Y</td>
<td>Arrows are animated when point is on; &quot;off&quot; arrows are displayed</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>between animated arrows; when point is off, static &quot;off&quot; arrows are</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>displayed</td>
</tr>
<tr>
<td>address of point</td>
<td>Y</td>
<td>N</td>
<td>Arrows are animated when point is on; &quot;off&quot; arrow are not displayed</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>between animated arrows; no arrows are displayed when point is off</td>
</tr>
<tr>
<td>address of point</td>
<td>N</td>
<td>Y</td>
<td>Arrows are static (not animated) and change color depending on the point's</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>state; arrows change from arrowColor (point is on) to one shade darker</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>(point is off)</td>
</tr>
<tr>
<td>address of point</td>
<td>N</td>
<td>N</td>
<td>Static arrows are displayed when point is on; no arrows are</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>displayed when point is off</td>
</tr>
<tr>
<td>STATIC</td>
<td>Y</td>
<td>Y</td>
<td>Arrows are always animated; &quot;off&quot; arrows are displayed between animated</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>arrows</td>
</tr>
<tr>
<td>STATIC</td>
<td>Y</td>
<td>N</td>
<td>Arrows are always animated; &quot;off&quot; arrows are not displayed</td>
</tr>
<tr>
<td>STATIC</td>
<td>N</td>
<td>Y/N</td>
<td>No arrows are displayed</td>
</tr>
</tbody>
</table>
• **Select arrow color** - Click `arrowColor` in Inspector. When the Color dialog box opens, select a color from the list or type a hexadecimal number in the RGB boxes. Use **Bright** and **Dark** to control the color's intensity (light or dark). The color of the "off" arrows will be one shade darker than the color selected here. The "off" arrows appear between the "on" arrows when the pipe is animated. When the pipe uses static arrows, the "off" arrows will be displayed when the point is off.

• **Select arrow direction** - To change the direction that arrows are pointing and moving when animated enter a Y or N in the `direction` box. Enter Y for arrows that move left (horizontal pipe) or down (vertical pipe); N for arrows that move right (horizontal pipe) or up (vertical pipe).

• **Choose arrow type** - To change the size and characteristics of arrows enter the desired option in the `arrowType` field (S for short arrows without tails; L for long arrows without tails; T for short arrows with tails).

**Creating a link**

Create a hyperlink between this object and another screen or web page by:

• Clicking `URL` in Inspector and selecting a destination screen (the screen that loads when this object is clicked) from the Link dialog box.

• Typing the URL address for the destination screen or web page in the `URL` box. The URL address must be in the following format (you don't need to type in http://): [screen name].html For example, station1.html, where station1 is the name of the screen that loads when this object is clicked; or, www.dataflowsys.com to link to the DFS website.

3. Test the object's setup by entering a 0 or 1 in the `VALUE` box. Enter a 0 in the box to see how the object will appear when the point is OFF. Entering a 1 in the box, shows you how the object will appear when the point is ON. To see how the object will appear during the alarm state, enter an "A" after the value (for example, 0A). To view the animation, select **Animate** from the **Screen** menu.

4. Save your screen by choosing **Save** or **Save As** from the **File** menu.

**Adding a (Digital) Spinner**

See also **Object Types: Pipe Objects** and **Object Properties: Spinner**.

1. Choose **Spinner** from the **Pipe** menu. The object appears on the screen and the Inspector window, listing all the default properties for this object, opens. Information on each field displays at the bottom of the Inspector window when you place your cursor within a field's input box.

2. You are now ready to begin manipulating the object’s properties. *(Note: You must press the ENTER key each time you make a direct change to any input box in the Inspector window. If you enter incorrect data in any Inspector input box, the message "***THAT ENTRY IS NOT VALID***" appears at the bottom of the Inspector window.)*

**Linking to a digital point**

Link this object to a digital point by entering the address (station, module, point number) in the `ADDR` box. Creating a link to an active point allows the object to mimic its activity. When the pump is in the ON state, the object is in the ON state. You can also click `ADDR` to open the Address Selection Tool and browse to the point.

**Changing the object's position**
Click the object and hold down the left mouse button. The pointer turns into a four-headed arrow. You can now move the object in any direction by simply dragging it. For finer control of movement, select the object and use the arrow keys on your keyboard to move the object one pixel at a time.

Move the object to a specific location by changing the XLOC (horizontal position) and the YLOC (vertical position) values. A 0 (zero) in both of these boxes places the object in the top left corner of the screen. Increasing the XLOC value moves the object farther to the right. Increasing the YLOC value moves it farther down the screen.

Selecting the object's color

A spinner can display one of four states: on, off, initial (point isn't offline, but doesn't yet have status), or alarm. Set the color for each of these states by clicking its corresponding field name (ON, OFF, INIT, ALARM). When the Color dialog box opens, select a color from the list or type a hexadecimal number in the RGB boxes. Use Bright and Dark to control the color's intensity (light or dark).

Set the base color of the spinner by clicking spinColor in Inspector. When the Color dialog box opens, select a color from the list or type a hexadecimal number in the RGB boxes. Use Bright and Dark to control the color's intensity (light or dark).

Sizing the object

Click the object. Handles (small white boxes) appear around the object. "Grab" a handle by clicking it. Notice that all the other handles become black in color. Hold down the left mouse button and drag the selected handle to increase or decrease the object's size. Hold down the SHIFT button while dragging a handle to make the object square (width = height).

Set the object to a specific size by entering values (measured in pixels) in the widthDim and heightDim boxes.

Setting the speed of spinner

The speed at which the object appears to be spinning can be set by entering an integer into the degree box. Higher numbers make the object spin faster and lower numbers make the object spin slower. The number entered must divide evenly into 180.

Setting the object to flash

To have the object flash during an alarm, enter Y in the flashAlarm box.

Inverting the logic

To invert the logic controlling the spinner's activity, enter Y in the invertState box. This causes the spinner to rotate when the point is OFF and cease rotating when the point is ON.

Creating a link

Create a hyperlink between this object and another screen or web page by:

- Clicking URL in Inspector and selecting a destination screen (the screen that loads when this object is clicked) from the Link dialog box.
- Typing the URL address for the destination screen or web page in the URL box. The URL address must be in the following format (you don't need to type in http://): [screen name].html For example, station1.html, where station1 is the name of the screen that loads when this object is clicked; or, www.dataflowsys.com to link to the DFS website.
3. Test the object’s setup by entering a 0 or 1 in the **VALUE** box. When you enter a 0 in the box, you see how the object will appear when the point is OFF. Entering a 1 in the box, shows you how the object will appear when the point is ON. To see how the object will appear during the alarm state, enter an "A" after the value (for example, 0A).

4. Save your screen by choosing **Save** or **Save As** from the **File** menu.

### Adding a Static Elbow

See also **Object Types: Pipe Objects** and **Object Properties: Static Elbow**.

1. Choose **Static Elbow** from the **Pipe** menu. The object appears on the screen and the Inspector window, listing all the default properties for this object, opens. Information on each field displays at the bottom of the Inspector window when you place your cursor within a field’s input box.

2. You are now ready to begin manipulating the object’s properties. (**Note:** You must press the ENTER key each time you make a direct change to any input box in the Inspector window. If you enter incorrect data in any Inspector input box, the message "***THAT ENTRY IS NOT VALID***" appears at the bottom of the Inspector window.)

**Changing the object's position**

Click the object and hold down the left mouse button. The pointer turns into a four-headed arrow. You can now move the object in any direction by simply dragging it. For finer control of movement, select the object and use the arrow keys on your keyboard to move the object one pixel at a time.

Move the object to a specific location by changing the **XLOC** (horizontal position) and the **YLOC** (vertical position) values. A 0 (zero) in both of these boxes places the object in the top left corner of the screen. Increasing the **XLOC** value moves the object farther to the right. Increasing the **YLOC** value moves it farther down the screen.

**Selecting the object's color**

Set the elbow’s empty color by clicking **backgroundColor** in Inspector. When the **Color** dialog box opens, select a color from the list or type a **hexadecimal number** in the **RGB** boxes. Use **Bright** and **Dark** to control the color’s intensity (light or dark).

Set the elbow’s filled color by clicking **foregroundColor** in Inspector. When the **Color** dialog box opens, select a color from the list or type a **hexadecimal number** in the **RGB** boxes. Use **Bright** and **Dark** to control the color’s intensity (light or dark).

**Sizing the object**

Click the object. Handles (small white boxes) appear around the object. "Grab" a handle by clicking it. Notice that all the other handles become black in color. Hold down the left mouse button and drag the selected handle to increase or decrease the object’s size. Hold down the **SHIFT** button while dragging a handle to make the object square (width = height).

Set the object to a specific size by entering values (measured in pixels) in the **widthDim** and **heightDim** boxes.

To set the diameter of the pipe elbow, enter a value in the **diameter** box.
Setting the direction of the curve

quadrant is used to set the position of the elbow's outside curve. Enter SE (bottom right), SW (bottom left), NE (top right), or NW (top left) in this box.

Creating a link

Create a hyperlink between this object and another screen or web page by:

- Clicking URL in Inspector and selecting a destination screen (the screen that loads when this object is clicked) from the Link dialog box.
- Typing the URL address for the destination screen or web page in the URL box. The URL address must be in the following format (you don't need to type in http://): [screen name].html For example, station1.html, where station1 is the name of the screen that loads when this object is clicked; or, www.dataflowsys.com to link to the DFS website.

3. Save your screen by choosing Save or Save As from the File menu.

Adding a Static Pipe

See also Object Types: Pipe Objects and Object Properties: Static Pipe.

1. Choose Static Pipe from the Pipe menu. The object appears on the screen and the Inspector window, listing all the default properties for this object, opens. Information on each field displays at the bottom of the Inspector window when you place your cursor within a field's input box.

2. You are now ready to begin manipulating the object’s properties. (Note: You must press the ENTER key each time you make a direct change to any input box in the Inspector window. If you enter incorrect data in any Inspector input box, the message "***THAT ENTRY IS NOT VALID***" appears at the bottom of the Inspector window.)

Changing the object’s position

Click the object and hold down the left mouse button. The pointer turns into a four-headed arrow. You can now move the object in any direction by simply dragging it. For finer control of movement, select the object and use the arrow keys on your keyboard to move the object one pixel at a time.

Move the object to a specific location by changing the XLOC (horizontal position) and the YLOC (vertical position) values. A 0 (zero) in both of these boxes places the object in the top left corner of the screen. Increasing the XLOC value moves the object farther to the right. Increasing the YLOC value moves it farther down the screen.

Sizing the object

Click the object. Handles (small white boxes) appear around the object. "Grab" a handle by clicking it. Notice that all the other handles become black in color. Hold down the left mouse button and drag the selected handle to increase or decrease the object’s size. Hold down the SHIFT button while dragging a handle to make the object square (width = height).

Set the object to a specific size by entering values (measured in pixels) in the widthDim and heightDim boxes.

Selecting the object's color
Set the pipe's empty color by clicking `backgroundColor` in Inspector. When the `Color` dialog box opens, select a color from the list or type a hexadecimal number in the RGB boxes. Use `Bright` and `Dark` to control the color's intensity (light or dark).

Set the pipe's filled color by clicking `foregroundColor` in Inspector. When the `Color` dialog box opens, select a color from the list or type a hexadecimal number in the RGB boxes. Use `Bright` and `Dark` to control the color's intensity (light or dark).

**Specifying the object's orientation**

The default orientation for this object is horizontal (the value of the `vertical` field is set to N). To set the orientation of the pipe to vertical, enter Y in the `vertical` box. When you set the orientation to vertical, you need to change the `widthDim` and `heightDim` values. Remember that `widthDim` sets the horizontal size of the object and `heightDim` sets the vertical size of the object.

**Adding a junction**

To add a junction to a pipe at either one or both ends, enter Y in the `northEast` and/or `southWest` boxes. A Y entered in the `northEast` box adds a junction at the north (top) end if the pipe is vertical or at the east (left) end if the pipe is horizontal. A Y entered in the `southWest` box adds a junction at the south (bottom) end if the pipe is vertical or at the west (right) end if the pipe is horizontal.

**Creating a link**

Create a hyperlink between this object and another screen or web page by:

- Clicking `URL` in Inspector and selecting a destination screen (the screen that loads when this object is clicked) from the `Link` dialog box.
- Typing the URL address for the destination screen or web page in the `URL` box. The URL address must be in the following format (you don't need to type in http://): `[screen name].html` For example, station1.html, where station1 is the name of the screen that loads when this object is clicked; or, www.dataflowsys.com to link to the DFS website.

3. Save your screen by choosing `Save` or `Save As` from the `File` menu.

### Adding a (Digital) Valve

See also [Object Types: Pipe Objects](#) and [Object Properties: Valve](#).

1. Choose `Valve` from the `Pipe` menu. The object appears on the screen and the Inspector window, listing all the default properties for this object, opens. Information on each box displays at the bottom of the Inspector window when you place your cursor within a box's input box.

2. You are now ready to begin manipulating the object's properties. **(Note:** You must press the ENTER key each time you make a direct change to any box in the Inspector window. If you enter incorrect data in any Inspector box, the message "***THAT ENTRY IS NOT VALID***" appears at the bottom of the Inspector window.)

**Linking to a digital point**
Link this object to a digital point by entering the address (station, module, point number) in the ADDR box. Creating a link to an active point allows the object to mimic its activity. When the point is in the ON state, the object is in the ON state. You can also click ADDR to open the Address Selection Tool and browse to the point.

**Changing the object's position**

Click the object and hold down the left mouse button. The pointer turns into a four-headed arrow. You can now move the object in any direction by simply dragging it. For finer control of movement, select the object and use the arrow keys on your keyboard to move the object one pixel at a time.

Move the object to a specific location by changing the XLOC (horizontal position) and the YLOC (vertical position) values. A 0 (zero) in both of these boxes places the object in the top left corner of the screen. Increasing the XLOC value moves the object farther to the right. Increasing the YLOC value moves it farther down the screen.

**Specifying the object's orientation**

The default orientation for this object is horizontal (the value in the vertical box is set to N). To make the valve vertical, enter Y in the vertical box. When you set the orientation to vertical, you may need to change the widthDim and heightDim values. Remember that widthDim sets the horizontal size of the object and heightDim sets the vertical size of the object.

**Add or remove a handle**

By default the valve object has a handle. To remove the handle, enter an N in the drawHandle field.

**Add and configure a border**

Enter Y in the drawBorder field to have the valve appear with a thin border around it. You can change the color of the border by clicking borderColor. When the Color dialog box opens, select a color from the list or type a hexadecimal number in the RGB boxes. Use Bright and Dark to control the color's intensity (light or dark).

To remove the border, enter an N in the drawBorder field.

**Sizing the object**

Click the object. Handles (small white boxes) appear around the object. "Grab" a handle by clicking it. Notice that all the other handles become black in color. Hold down the left mouse button and drag the selected handle to increase or decrease the object's size.

Set the object to a specific size by entering values (measured in pixels) in the widthDim and heightDim boxes.

**Selecting the object's color**

Set the valve's ON-state color by clicking onColor in Inspector. When the Color dialog box opens, select a color from the list or type a hexadecimal number in the RGB boxes. Use Bright and Dark to control the color's intensity (light or dark).

Set the valve's OFF-state color by clicking offColor in Inspector. When the Color dialog box opens, select a color from the list or type a hexadecimal number in the RGB boxes. Use Bright and Dark to control the color’s intensity (light or dark).
Creating a link

Create a hyperlink between this object and another screen or web page by:

- Clicking URL in Inspector and selecting a destination screen (the screen that loads when this object is clicked) from the Link dialog box.
- Typing the URL address for the destination screen or web page in the URL box. The URL address must be in the following format (you don't need to type in http://): [screen name].html For example, station1.html, where station1 is the name of the screen that loads when this object is clicked; or, www.dataflowsys.com to link to the DFS website.

3. Test the object's setup by entering a 0 or 1 in the VALUE box. Enter a 0 in the box to see how the object will appear when the point is OFF. Entering a 1 in the box, shows you how the object will appear when the point is ON.

4. To save your screen, choose Save or Save As from the File menu.

Adding Static Objects

Below are detailed instructions for adding each of Screen Builder's static objects.

- 3D Rectangle
- 3D Text
- Banner Text
- Gradient Object
- Grid
- Image
- Oval
- Pattern Object
- Rectangle
- Resizable Image
- Round Rectangle
- Text
- Tick Mark

Adding a Static 3D Rectangle

See also Object Types: Static Objects and Object Properties: Static 3D Rectangle.

1. Choose 3D Rectangle from the Static menu. The object appears on the screen and the Inspector window, listing all the default properties for this object, opens. Information on each field displays at the bottom of the Inspector window when you place your cursor within a field's input box.
2. Make the desired changes to the object's properties. (Note: You must press the ENTER key each time you make a direct change to any box in the Inspector window.) If you enter incorrect data in any Inspector box, the message "***THAT ENTRY IS NOT VALID***" appears at the bottom of the Inspector window.

**Changing the object's position**

Click the object and hold down the left mouse button. The pointer turns into a four-headed arrow. You can now move the object in any direction by simply dragging it. For finer control of movement, select the object and use the arrow keys on your keyboard to move the object one pixel at a time.

Move the object to a specific location by changing the XLOC (horizontal position) and the YLOC (vertical position) values. A 0 (zero) in both of these boxes places the object in the top left corner of the screen. Increasing the XLOC value moves the object farther to the right. Increasing the YLOC value moves it farther down on the screen.

**Sizing the object**

Click the object. Handles (small white boxes) appear around the object. "Grab" a handle by clicking it. Notice that all the other handles become black in color. Hold down the left mouse button and drag the selected handle to increase or decrease the object's size. Hold down the SHIFT button while dragging a handle to make the object square (width = height).

Set the object to a specific size by entering values (measured in pixels) in the widthDim and heightDim boxes.

**Setting the object's color**

Set the color of the object by clicking backgroundColor in Inspector. When the Color dialog box opens, select a color from the list or type a hexadecimal number in the RGB boxes. Use Bright and Dark to control the color's intensity (light or dark).

Make the object appear transparent - its color matches the color of the object directly below it - by entering N in the fillBackground box.

**Adding a border**

Add a border to the rectangle by entering Y in the drawBorder box.

Set the size of the border by entering a value (measured in pixels) in the borderWidth box.

Set the color of the border by clicking borderColor in Inspector. When the Color dialog box opens, select a color from the list or type a hexadecimal number in the RGB boxes. Use Bright and Dark to control the color's intensity (light or dark).

**Controlling the three-dimensional appearance**

Make the three-dimensional rectangle appear raised (like a button) by entering Y in the drawRaised box. Entering N in this box makes the three-dimensional rectangle look lowered (depressed).

**Creating a link**

Create a hyperlink between this object and another screen or web page by:

- Clicking URL in Inspector and selecting a destination screen (the screen that loads when this object is clicked) from the Link dialog box.
• Typing the URL address for the destination screen or web page in the **URL** box. The URL address must be in the following format (you don't need to type in http://): [screen name].html For example, station1.html, where station1 is the name of the screen that loads when this object is clicked; or, www.dataflowsys.com to link to the DFS website.

3. Save your screen by choosing Save or Save As from the File menu.

---

### Adding a Static 3D Text Object

See also [Object Types: Static Objects](#) and [Object Properties: Static 3D Text](#).

1. Choose 3D Text from the Static menu. The object appears on the screen and the Inspector window, listing all the default properties for this object, opens. Information on each field displays at the bottom of the Inspector window when you place your cursor within a field's input box.

2. Make the desired changes to the object's properties. *(Note: You must press the ENTER key each time you make a direct change to any box in the Inspector window.)* If you enter incorrect data in any Inspector box, the message "***THAT ENTRY IS NOT VALID***" appears at the bottom of the Inspector window.

**Changing the object's position**

Click the object and hold down the left mouse button. The pointer turns into a four-headed arrow. You can now move the object in any direction by simply dragging it. For finer control of movement, select the object and use the arrow keys on your keyboard to move the object one pixel at a time.

Move the object to a specific location by changing the **XLOC** (horizontal position) and the **YLOC** (vertical position) values. A 0 (zero) in both of these boxes places the object in the top left corner of the screen. Increasing the **XLOC** value moves the object farther to the right. Increasing the **YLOC** value moves it farther down the screen.

**Entering text**

Enter the text you want the object to display in the **line1**, **line2**, **line3**, and **line4** boxes. Up to 12 characters can be typed in each of these boxes, which allows the object to display a maximum of 48 characters.

To have the text in each of these boxes appear on a separate line, type **N** in the **concatenate** box. Otherwise, leave the default value of **Y**. If you enter **Y** in the **concatenate** box and want a space to appear between the text you entered in any of the line input boxes, type a space at the beginning of the following line's input.

For example, if you want Fresh-Water Management to appear on one line on the object, type Fresh-Water in **line1** and Management (where # represents pressing the spacebar one time) in **line2**, and type **Y** in the **concatenate** box.

**Sizing the object**

Click the object. Handles (small white boxes) appear around the object. "Grab" a handle by clicking it. Notice that all the other handles become black in color. Hold down the left mouse button and drag the selected handle to increase or decrease the object's size.
Set the object to a specific size by entering values (measured in pixels) in the widthDim and heightDim boxes.

**Positioning the text**

Set the text’s alignment by entering a horizontal position (C=center, R=right, L=left) and then a vertical position (M=middle, T=top, B=bottom) in the justify box.

Set the horizontal margin (measured from the left or right of the object’s edge, depending on its horizontal alignment) by entering an integer value in the insetX box. Set the vertical margin (as measured from the top or bottom of the object’s edge, depending on its vertical alignment) by entering an integer value in the insetY box.

For example, entering 10 in both the insetX and insetY boxes and entering LT in the justify box, would position the text in the top left corner, 10 pixels from the left edge and 10 pixels from the top edge of the object.

**Controlling text appearance**

Set the color of the text by clicking textColor in Inspector. When the Color dialog box opens, select a color from the list or type a hexadecimal number in the RGB boxes. Use Bright and Dark to control the color’s intensity (light or dark).

Set text size by entering an integer value in the fontSize box.

For bold face text, type Y in the bold box.

**Setting the object’s color**

Set the object’s color by clicking backgroundColor in Inspector. When the Color dialog box opens, select a color from the list or type a hexadecimal number in the RGB boxes. Use Bright and Dark to control the color’s intensity (light or dark).

Make the object appear transparent (its color matches the color of the object directly beneath it) by entering N in the fillBackground box.

**Adding a border**

Add a border to the three-dimensional text object by entering Y in the drawBorder box.

Set the size of the border by entering a value (measured in pixels) in the borderWidth box.

Set the color of the border by clicking borderColor in Inspector. When the Color dialog box opens, select a color from the list or type a hexadecimal number in the RGB boxes. Use Bright and Dark to control the color’s intensity (light or dark).

**Controlling the three-dimensional appearance**

Make the three-dimensional text object appear raised (like a button) by entering Y in the drawRaised box. Entering N in this box makes the three-dimensional text object look lowered (depressed).

**Creating a link**

Create a hyperlink between this object and another screen or web page by:

- Clicking URL in Inspector and selecting a destination screen (the screen that loads when this object is clicked) from the Link dialog box.
• Typing the URL address for the destination screen or web page in the **URL** box. The URL address must be in the following format (you don't need to type in http://): [screen name].html For example, station1.html, where station1 is the name of the screen that loads when this object is clicked; or, www.dataflowsys.com to link to the DFS website.

3. Save your screen by choosing **Save** or **Save As** from the **File** menu.

### Adding a Banner Text Object

See also [Object Types: Static Objects](#) and [Object Properties: Static Banner Text](#).

1. Choose **Banner Text** from the **Static** menu. The object appears on the screen and the Inspector window, listing all the default properties for this object, opens. Information on each field displays at the bottom of the Inspector window when you place your cursor within a field’s input box.

2. Make the desired changes to the object’s properties. (Note: You must press the ENTER key each time you make a direct change to any box in the Inspector window.) If you enter incorrect data in any Inspector box, the message "***THAT ENTRY IS NOT VALID***" appears at the bottom of the Inspector window.

**Changing the object's position**

Click the object and hold down the left mouse button. The pointer turns into a four-headed arrow. You can now move the object in any direction by simply dragging it. For finer control of movement, select the object and use the arrow keys on your keyboard to move the object one pixel at a time.

Move the object to a specific location by changing the **XLOC** (horizontal position) and the **YLOC** (vertical position) values. A 0 (zero) in both of these boxes places the object in the top left corner of the screen. Increasing the **XLOC** value moves the object farther to the right. Increasing the **YLOC** value moves it farther down the screen.

**Entering text**

Type the desired text in the **textLine** field. This field can accommodate up to 90 characters.

**Select LED and background colors**

Select the color of the LEDs by clicking **LEDcolor** in Inspector. When the **Color** dialog box opens, select a color from the list or type a **hexadecimal number** in the **RGB** boxes. You can select the **Dark** option if you want a darker shade of the color. **Bright** cannot be used for LEDcolor, because the text displayed in the banner text object is always a brighter shade of the selected LED color.

Select the object’s background color by clicking **backgroundColor** and selecting a color in the **Color** dialog box.

**Select marquee and speed options**

If you want the object to behave like a scrolling marquee, enter Y in the **marquee** field. If N is entered in this field, the text will be stationery.

You can control the scrolling speed by entering a value in the **speed** field. The larger the number, the faster the text appears to move. You can experiment by entering a value in the **speed** field and selecting **Animate** from the **Screen** menu.
Sizing the object

Click the object. Handles (small white boxes) appear around the object. "Grab" a handle by clicking it. Notice that all the other handles become black in color. Hold down the left mouse button and drag the selected handle to increase or decrease the object’s size.

Set the object to a specific size by entering values (measured in pixels) in the `widthDim` and `heightDim` boxes.

Creating a link

Create a hyperlink between this object and another screen or web page by:

- Clicking `URL` in Inspector and selecting a destination screen (the screen that loads when this object is clicked) from the `Link` dialog box.
- Typing the URL address for the destination screen or web page in the `URL` box. The URL address must be in the following format (you don't need to type in http://): `[screen name].html` For example, station1.html, where station1 is the name of the screen that loads when this object is clicked; or, www.dataflowsys.com to link to the DFS website.

3. Save your screen by choosing `Save` or `Save As` from the `File` menu.

Adding a Static Gradient Object

See also Object Types: Static Objects and Object Properties: Static Gradient.

1. Choose `Gradient` from the `Static` menu. The object appears on the screen and the Inspector window, listing all the default properties for this object, opens. Information on each field displays at the bottom of the Inspector window when you place your cursor within a field's input box.

2. Make the desired changes to the object's properties. (Note: You must press the ENTER key each time you make a direct change to any box in the Inspector window.) If you enter incorrect data in any Inspector box, the message "***THAT ENTRY IS NOT VALID***" appears at the bottom of the Inspector window.

Changing the object's position

Click the object and hold down the left mouse button. The pointer turns into a four-headed arrow. You can now move the object in any direction by simply dragging it. For finer control of movement, select the object and use the arrow keys on your keyboard to move the object one pixel at a time.

Move the object to a specific location by changing the `XLOC` (horizontal position) and the `YLOC` (vertical position) values. A 0 (zero) in both of these boxes places the object in the top left corner of the screen. Increasing the `XLOC` value moves the object farther to the right. Increasing the `YLOC` value moves it farther down the screen.

Sizing the object

Click the object. Handles (small white boxes) appear around the object. "Grab" a handle by clicking it. Notice that all the other handles become black in color. Hold down the left mouse button and drag the selected handle to increase or decrease the object’s size. Hold down the SHIFT button while dragging a handle to make the object square (width = height).
Set the object to a specific size by entering values (measured in pixels) in the widthDim and heightDim boxes.

**Selecting the object's color**

Set object's start color by clicking startColor in Inspector. When the Color dialog box opens, select a color from the list or type a hexadecimal number in the RGB boxes. Use Bright and Dark to control the color's intensity (light or dark).

Set the object's end color by clicking endColor in Inspector. When the Color dialog box opens, select a color from the list or type a hexadecimal number in the RGB boxes. Use Bright and Dark to control the color's intensity (light or dark).

**Controlling direction of color gradation**

Gradation refers to having the object's color gradually change from one tint or shade to another.

To create a rectangular object that changes from the center of the object to the edges, enter Y in the fillRectangle field. (*Note:* You must enter N in the fillOval field to enable this option. Also, anything entered in the direction field will have no affect on the object's appearance when fillRectangle is enabled.)

To create a circular object that changes from the center of the object to the edges, enter Y in the fillOval field. (*Note:* You must enter N in the fillRectangle field to enable this option. Also, anything entered in the direction field will have no affect on the object's appearance when fillRectangle is enabled.)

To create an object that changes from edge to edge or corner to corner, enter the desired direction in the direction field. (*Note:* fillRectangle and fillOval must both be set to N.)

- N (top to bottom)
- S (bottom to top)
- E (right to left)
- W (left to right)
- NE (bottom left corner to top right corner)
- NW (bottom right corner to top left corner)
- SE (top left corner to bottom right corner)
- SW (top right corner to bottom left corner)

**Creating a link**

Create a hyperlink between this object and another screen or web page by:

- Clicking URL in Inspector and selecting a destination screen (the screen that loads when this object is clicked) from the Link dialog box.
- Typing the URL address for the destination screen or web page in the URL box. The URL address must be in the following format (you don't need to type in http://): [screen name].html For example, station1.html, where station1 is the name of the screen that loads when this object is clicked; or, www.dataflowsys.com to link to the DFS website.

3. Save your screen by choosing Save or Save As from the File menu.
Adding a Static Grid

See also Object Types: Static Objects and Object Properties: Static Grid.

1. Choose Grid from the Static menu. The object appears on the screen and the Inspector window, listing all the default properties for this object, opens. Information on each field displays at the bottom of the Inspector window when you place your cursor within a field's input box.

2. Make the desired changes to the object's properties. (Note: You must press the ENTER key each time you make a direct change to any box in the Inspector window.) If you enter incorrect data in any Inspector box, the message "***THAT ENTRY IS NOT VALID***" appears at the bottom of the Inspector window.

Changing the object's position

Click the object and hold down the left mouse button. The pointer turns into a four-headed arrow. You can now move the object in any direction by simply dragging it. For finer control of movement, select the object and use the arrow keys on your keyboard to move the object one pixel at a time.

Move the object to a specific location by changing the XLOC (horizontal position) and the YLOC (vertical position) values. A 0 (zero) in both of these boxes places the object in the top left corner of the screen. Increasing the XLOC value moves the object farther to the right. Increasing the YLOC value moves it farther down the screen.

Setting the appearance of the grid

Set the number of horizontal segments (area between the grid lines) by entering an integer value in the horizontal box. Set the number of vertical segments by entering an integer value in the vertical box.

Set the color of the grid lines by clicking gridColor in Inspector. When the Color dialog box opens, select a color from the list or type a hexadecimal number in the RGB boxes. Use Bright and Dark to control the color's intensity (light or dark).

Setting the appearance of the limit lines

Set the distance (as a percentage) from the bottom of the grid to the first limit line by entering a value from 0-100 in the limitLine1 box. Set the distance (as a percentage) from the bottom of the grid to the second limit line by entering a value from 0-100 in the limitLine2 box. To have only one line appear on the grid, set the value of either limitLine1 or limitLine2 to 0.

Set the color of the first and second limit lines by clicking the corresponding field name (oneColor, twoColor). When the Color dialog box opens, select a color from the list or type a hexadecimal number in the RGB boxes. Use Bright and Dark to control the color’s intensity (light or dark).

Sizing the object

Click the object. Handles (small white boxes) appear around the object. "Grab" a handle by clicking it. Notice that all the other handles become black in color. Hold down the left mouse button and drag the selected handle to increase or decrease the object's size. Hold down the SHIFT button while dragging a handle to make the object square (width = height).
Set the object to a specific size by entering values (measured in pixels) in the `widthDim` and `heightDim` boxes.

**Setting the object's color**

Set the color of the object by clicking `backgroundColor` in Inspector. When the `Color` dialog box opens, select a color from the list or type a hexadecimal number in the `RGB` boxes. Use `Bright` and `Dark` to control the color's intensity (light or dark).

Make the object appear transparent - its color matches the color of the object directly below it - by entering N in the `fillBackground` box.

**Adding a border**

Add a border to the rectangle by entering Y in the `drawBorder` box.

Set the size of the border by entering a value (measured in pixels) in the `borderWidth` box.

Set the color of the border by clicking `borderColor` in Inspector. When the `Color` dialog box opens, select a color from the list or type a hexadecimal number in the `RGB` boxes. Use `Bright` and `Dark` to control the color's intensity (light or dark).

**Creating a link**

Create a hyperlink between this object and another screen or web page by:

- Clicking `URL` in Inspector and selecting a destination screen (the screen that loads when this object is clicked) from the `Link` dialog box.
- Typing the URL address for the destination screen or web page in the `URL` box. The URL address must be in the following format (you don't need to type in http://): `[screen name].html` For example, station1.html, where station1 is the name of the screen that loads when this object is clicked; or, www.dataflowsys.com to link to the DFS website.

3. Save your screen by choosing `Save` or `Save As` from the `File` menu.

**Adding a Static Image**

See also **Object Types: Static Objects** and **Object Properties: Static Image**.

The Static Resizable Image was introduced with the release of HT3. The Static Image is being retained in Screen Builder for downward compatibility. Any existing screens that use the Static Image will still function properly. If you are creating a new screen or adding an image to an existing screen, we suggest you use the Static Resizable Image, which offers more options (resize, rotate, skew, flip, adjust opacity, hue, saturation and brightness).

**Note:** If this is to be a snapshot from a network camera, see **Adding Network Camera Images to Screens** for detailed instructions.

1. Choose `Image` from the `Static` menu. The object appears on the screen and the Inspector window, listing all the default properties for this object, opens. Information on each box displays at the bottom of the Inspector window when you place your cursor within a box's input box.
2. Make the desired changes to the object's properties. (Note: You must press the ENTER key each time you make a direct change to any box in the Inspector window.) If you enter incorrect data in any Inspector box, the message "***THAT ENTRY IS NOT VALID***" appears at the bottom of the Inspector window.

**Choosing an image**

To select an image to display, click *image* in Inspector and select the image you want to use (see Choosing Colors and Images for more information). To add an image from a remote location (a computer other than the Hyper Server Module), enter an N in the *image* field and enter a URL (without the http:// prefix) in the *remote* field. Displaying an image from a remote computer requires a change to the Java policy file; contact DFS for more information.

**Changing the object's position**

Click the object and hold down the left mouse button. The pointer turns into a four-headed arrow. You can now move the object in any direction by simply dragging it. For finer control of movement, select the object and use the arrow keys on your keyboard to move the object one pixel at a time.

Move the object to a specific location by changing the *XLOC* (horizontal position) and the *YLOC* (vertical position) values. A 0 (zero) in both of these boxes places the object in the top left corner of the screen. Increasing the *XLOC* value moves the object farther to the right. Increasing the *YLOC* value moves it farther down the screen.

**Creating a link**

Create a hyperlink between this object and another screen or web page by:

- Clicking *URL* in Inspector and selecting a destination screen (the screen that loads when this object is clicked) from the Link dialog box.
- Typing the URL address for the destination screen or web page in the *URL* box. The URL address must be in the following format (you don’t need to type in http://): [screen name].html For example, station1.html, where station1 is the name of the screen that loads when this object is clicked; or, www.dataflowsys.com to link to the DFS website.

3. To save your screen, choose *Save* or *Save As* from the *File* menu.

### Adding a Static Oval

See also Object Types: Static Objects and Object Properties: Static Oval.

1. Choose *Oval* from the Static menu. The object appears on the screen and the Inspector window, listing all the default properties for this object, opens. Information on each field displays at the bottom of the Inspector window when you place your cursor within a field's input box.

2. Make the desired changes to the object’s properties. (Note: You must press the ENTER key each time you make a direct change to any box in the Inspector window.) If you enter incorrect data in any Inspector box, the message "***THAT ENTRY IS NOT VALID***" appears at the bottom of the Inspector window.

**Changing the object's position**
Click the object and hold down the left mouse button. The pointer turns into a four-headed arrow. You can now move the object in any direction by simply dragging it. For finer control of movement, select the object and use the arrow keys on your keyboard to move the object one pixel at a time.

Move the object to a specific location by changing the XLOC (horizontal position) and the YLOC (vertical position) values. A 0 (zero) in both of these boxes places the object in the top left corner of the screen. Increasing the XLOC value moves the object farther to the right. Increasing the YLOC value moves it farther down the screen.

Sizing the object

Click the object. Handles (small white boxes) appear around the object. "Grab" a handle by clicking it. Notice that all the other handles become black in color. Hold down the left mouse button and drag the selected handle to increase or decrease the object's size. Hold down the SHIFT button while dragging a handle to make the object square (width = height).

Set the object to a specific size by entering values (measured in pixels) in the widthDim and heightDim boxes.

Setting the object's color

Set the color of the object by clicking backgroundColor in Inspector. When the Color dialog box opens, select a color from the list or type a hexadecimal number in the RGB boxes. Use Bright and Dark to control the color's intensity (light or dark).

Make the object appear transparent (its color matches the color of the object directly beneath it) by entering N in the fillBackground box.

Adding a border

Add a border to the rectangle by entering Y in the drawBorder box.

Set the size of the border by entering a value (measured in pixels) in the borderWidth box.

Set the color of the border by clicking borderColor in Inspector. When the Color dialog box opens, select a color from the list or type a hexadecimal number in the RGB boxes. Use Bright and Dark to control the color's intensity (light or dark).

Creating a link

Create a hyperlink between this object and another screen or web page by:

- Clicking URL in Inspector and selecting a destination screen (the screen that loads when this object is clicked) from the Link dialog box.
- Typing the URL address for the destination screen or web page in the URL box. The URL address must be in the following format (you don't need to type in http://): [screen name].html For example, station1.html, where station1 is the name of the screen that loads when this object is clicked; or, www.dataflowsys.com to link to the DFS website.

3. Save your screen by choosing Save or Save As from the File menu to save your screen, choose Save or Save As from the File menu.
Adding a Static Pattern Object

1. Choose **Pattern** from the **Static** menu. The object appears on the screen and the Inspector window, listing all the default properties for this object, opens. Information on each field displays at the bottom of the Inspector window when you place your cursor within a field's input box.

2. Make the desired changes to the object's properties. *(Note: You must press the ENTER key each time you make a direct change to any box in the Inspector window.)* If you enter incorrect data in any Inspector box, the message "***THAT ENTRY IS NOT VALID***" appears at the bottom of the Inspector window.

**Selecting the object's pattern**

The object's pattern can be one of eight designs: CHECKER, BRICK, SAND, GRASS, DIAMOND, STEEL, RAIN or EARTH. To select one of these designs, type the design's name in the **patternType** field and press Enter. Note that when you position your cursor in the field, the options are listed at the bottom of the Inspector window.

**Selecting the object's color**

Set the background color of the object by clicking **backgroundColor** in Inspector. When the **Color** dialog box opens, select a color from the list or type a **hexadecimal number** in the **RGB** boxes. Use **Bright** and **Dark** to control the color's intensity (light or dark).

Set the foreground color of the object (for example, the rain drops or the individual pieces of sand) by clicking **foregroundColor** in Inspector. When the **Color** dialog box opens, select a color from the list or type a **hexadecimal number** in the **RGB** boxes. Use **Bright** and **Dark** to control the color's intensity (light or dark).

**Controlling size and spacing**

You can control the size and spacing of the pattern by entering integer values in the **patternSize** and **patternSpacing** fields. A larger size, for example, makes each brick or rain drop larger. Increasing spacing would make the rain drops farther apart or make the mortar between the bricks thicker. Type the desired value in the box and press Enter.

**Control the pattern's orientation**

The angle, or orientation, of the pattern's design can be controlled by entering integer values between 0 and 360 in the angle field. This enables you to make the rain appear as if it's coming down on a slant or make the lines in the steel pattern vertical instead of horizontal. Enter the desired value in the angle field and press Enter.

**Changing the object's position**

Click the object and hold down the left mouse button. The pointer turns into a four-headed arrow. You can now move the object in any direction by simply dragging it. For finer control of movement, select the object and use the arrow keys on your keyboard to move the object one pixel at a time.
Move the object to a specific location by changing the **XLOC** (horizontal position) and the **YLOC** (vertical position) values. A 0 (zero) in both of these boxes places the object in the top left corner of the screen. Increasing the **XLOC** value moves the object farther to the right. Increasing the **YLOC** value moves it farther down the screen.

**Sizing the object**

Click the object. Handles (small white boxes) appear around the object. "Grab" a handle by clicking it. Notice that all the other handles become black in color. Hold down the left mouse button and drag the selected handle to increase or decrease the object’s size. Hold down the SHIFT button while dragging a handle to make the object square (width = height).

Set the object to a specific size by entering values (measured in pixels) in the **widthDim** and **heightDim** boxes.

**Animating rain and sand**

Rain and sand pattern objects can be animated by entering **Y** in the **animate** field - rain will look like it is falling; sand will look like it is being blown by the wind. To turn on animation, enter **Y** in the box and press Enter. To see how animation will look when the screen is viewed in Custom Screen Viewer, select **Animate** from the **Screen** menu.

**Creating a link**

Create a hyperlink between this object and another screen or web page by:

- Clicking **URL** in Inspector and selecting a destination screen (the screen that loads when this object is clicked) from the **Link** dialog box.
- Typing the URL address for the destination screen or web page in the **URL** box. The URL address must be in the following format (you don't need to type in http://): [screen name].html For example, station1.html, where station1 is the name of the screen that loads when this object is clicked; or, www.dataflowsys.com to link to the DFS website.

3. Save your screen by choosing **Save** or **Save As** from the **File** menu.

**Adding a Static Rectangle**

See also **Object Types: Static Objects** and **Object Properties: Static Rectangle**.

1. Choose **Rectangle** from the **Static** menu. The object appears on the screen and the Inspector window, listing all the default properties for this object, opens. Information on each field displays at the bottom of the Inspector window when you place your cursor within a field’s input box.

2. Make the desired changes to the object's properties. (**Note**: You must press the ENTER key each time you make a direct change to any box in the Inspector window.) If you enter incorrect data in any Inspector box, the message "***THAT ENTRY IS NOT VALID***" appears at the bottom of the Inspector window.

**Changing the object's position**

Click the object and hold down the left mouse button. The pointer turns into a four-headed arrow. You can now move the object in any direction by simply dragging it. For finer control of movement, select the object and use the arrow keys on your keyboard to move the object one pixel at a time.
Move the object to a specific location by changing the XLOC (horizontal position) and the YLOC (vertical position) values. A 0 (zero) in both of these boxes places the object in the top left corner of the screen. Increasing the XLOC value moves the object farther to the right. Increasing the YLOC value moves it farther down the screen.

**Sizing the object**

Click the object. Handles (small white boxes) appear around the object. "Grab" a handle by clicking it. Notice that all the other handles become black in color. Hold down the left mouse button and drag the selected handle to increase or decrease the object’s size. Hold down the SHIFT button while dragging a handle to make the object square (width = height).

Set the object to a specific size by entering values (measured in pixels) in the widthDim and heightDim boxes.

**Setting the object's color**

Set the color of the object by clicking backgroundColor in Inspector. When the Color dialog box opens, select a color from the list or type a hexadecimal number in the RGB boxes. Use Bright and Dark to control the color's intensity (light or dark).

Make the object appear transparent - its color matches the color of the object directly below it - by entering N in the fillBackground box.

**Adding a border**

Add a border to the rectangle by entering Y in the drawBorder box.

Set the size of the border by entering a value (measured in pixels) in the borderWidth box.

Set the color of the border by clicking borderColor in Inspector. When the Color dialog box opens, select a color from the list or type a hexadecimal number in the RGB boxes. Use Bright and Dark to control the color's intensity (light or dark).

**Creating a link**

Create a hyperlink between this object and another screen or web page by:

- Clicking URL in Inspector and selecting a destination screen (the screen that loads when this object is clicked) from the Link dialog box.
- Typing the URL address for the destination screen or web page in the URL box. The URL address must be in the following format (you don't need to type in http://): [screen name].html For example, station1.html, where station1 is the name of the screen that loads when this object is clicked; or, www.dataflowsys.com to link to the DFS website.

3. Save your screen by choosing Save or Save As from the File menu.

**Adding a Static Resizable Image**

See also Object Types: Static Objects and Object Properties: Static Resizable Image.

**Note:** If this is to be a snapshot from a network camera, see Adding Network Camera Images to Screens for detailed instructions.
1. Choose **Resizable Image** from the Static menu. The default image is added to the screen and the Inspector window, listing all the default properties for this object, opens. Information on each property is displayed at the bottom of the Inspector window when you click the property name or place your cursor within the property's input field.

2. Make the desired changes to the object's properties. (Note: You must press the ENTER key each time you make a direct change to any box in the Inspector window.) If you enter incorrect data in any Inspector box, the message "***THAT ENTRY IS NOT VALID***" appears at the bottom of the Inspector window.

**Choosing an image**

To select an image to display, click **image** in Inspector and select the image you want to use (see Choosing Colors and Images for more information). To add an image from a remote location (a computer other than the Hyper Server Module), enter an N in the **image** field and enter a URL (without the http:// prefix) in the **remote** field. Displaying an image from a remote computer requires a change to the Java policy file; contact DFS for more information.

**Changing the image's position**

Click the object and hold down the left mouse button. The pointer turns into a four-headed arrow. You can now move the object in any direction by simply dragging it. For finer control of movement, select the object and use the arrow keys on your keyboard to move the object one pixel at a time.

Move the object to a specific location by changing the **XLOC** (horizontal position) and the **YLOC** (vertical position) values. A 0 (zero) in both of these boxes places the object in the top left corner of the screen. Increasing the **XLOC** value moves the object farther to the right. Increasing the **YLOC** value moves it farther down the screen.

**Change the image's size**

The size of the image can be changed by entering values in the **widthDim** and **heightDim** fields or by grabbing and dragging a handle on the image's bounding box (the bounding box and the handles appear when the image is selected/clicked).

To constrain the proportions of the image when resizing it using the handles, enter Y in the **constrain** field.

**Changing the image's orientation**

Static resizable images can be rotated, flipped horizontally or vertically, and skewed along the X- or Y-axis.

To rotate the image, enter a value between 0 and 360 degrees in the **rotate** field.

Flipping the image:

- To flip the image horizontally, enter Y in the **invertH** field.
- To flip the image vertically, enter Y in the **invertV** field.
- To skew the image along the X-axis, enter a value in the **shearx** field. Values between 0.1 and 1.0 give the best results.
- To skew the image along the Y-axis, enter a value in the **sheary** field. Values between 0.1 and 1.0 give the best results.

**Adjusting the image’s color and saturation**
Adjust the hue of the image by entering a value between 0 and 359 in the hue field. N keeps the image in its natural state.

Adjust the saturation of the image by entering a value between 0 and 100 in the sat field. N keeps the image in its natural state.

Adjust the brightness of the image by entering a value between 0 and 100 in the bright field. N keeps the image in its natural state.

Overlay the image with a colored filter. The default for this field is black, which displays the image in its natural state. Enter a color name or 6-character HEX string in the fcolor field.

**Changing the image's opacity**

Change the opacity of the image by entering a value between 0 and 100 in the alpha field. Smaller values make the image more transparent.

**Creating a link**

Create a hyperlink between this object and another screen or web page by:

- Clicking URL in Inspector and selecting a destination screen (the screen that loads when this object is clicked) from the Link dialog box.
- Typing the URL address for the destination screen or web page in the URL box. The URL address must be in the following format (you don't need to type in http://): [screen name].html For example, station1.html, where station1 is the name of the screen that loads when this object is clicked; or, www.dataflowsys.com to link to the DFS website.

3. To save your screen, choose Save or Save As from the File menu.

**Adding a Static Round Rectangle**

See also Object Types: Static Objects and Object Properties: Static Round Rectangle.

1. Choose Round Rectangle from the Static menu. The object appears on the screen and the Inspector window, listing all the default properties for this object, opens. Information on each field displays at the bottom of the Inspector window when you place your cursor within a field's input box.

2. Make the desired changes to the object's properties. (Note: You must press the ENTER key each time you make a direct change to any box in the Inspector window.) If you enter incorrect data in any Inspector box, the message "***THAT ENTRY IS NOT VALID***" appears at the bottom of the Inspector window.

**Changing the object's position**

Click the object and hold down the left mouse button. The pointer turns into a four-headed arrow. You can now move the object in any direction by simply dragging it. For finer control of movement, select the object and use the arrow keys on your keyboard to move the object one pixel at a time.
To move the object to a specific location, change the XLOC (horizontal position) and the YLOC (vertical position) values. A 0 (zero) in both of these boxes would place the object in the top left corner of the screen. Increasing the XLOC value moves the object farther to the right. Increasing the YLOC value moves it farther down the screen.

**Sizing the object**

Click the object. Handles (small white boxes) appear around the object. "Grab" a handle by clicking it. Notice that all the other handles become black in color. Hold down the left mouse button and drag the selected handle to increase or decrease the object’s size. Hold down the SHIFT button while dragging a handle to make the object square (width = height).

Set the object to a specific size by entering values (measured in pixels) in the widthDim and heightDim boxes.

**Setting the object's color**

Set the color of the object by clicking backgroundColor in Inspector. When the Color dialog box opens, select a color from the list or type a hexadecimal number in the RGB boxes. Use Bright and Dark to control the color's intensity (light or dark).

Make the object appear transparent - its color matches the color of the object directly below it - by entering N in the fillBackground box.

**Adding a border**

Add a border to the rectangle by entering Y in the drawBorder box.

Set the size of the border by entering a value (measured in pixels) in the borderWidth box.

Set the color of the border by clicking borderColor in Inspector. When the Color dialog box opens, select a color from the list or type a hexadecimal number in the RGB boxes. Use Bright and Dark to control the color's intensity (light or dark).

**Controlling the degree of curve**

To control the "roundness" of the object's corners, enter an integer value in the radius box. Larger numbers make the rectangle's corners appear rounder; the image is more circular. Smaller numbers make the rectangle's corners appear sharper; the image is more square.

**Creating a link**

Create a hyperlink between this object and another screen or web page by:

- Clicking URL in Inspector and selecting a destination screen (the screen that loads when this object is clicked) from the Link dialog box.
- Typing the URL address for the destination screen or web page in the URL box. The URL address must be in the following format (you don't need to type in http://): [screen name].html For example, station1.html, where station1 is the name of the screen that loads when this object is clicked; or, www.dataflowsys.com to link to the DFS website.

3. Save your screen by choosing Save or Save As from the File menu.
Adding a Static Text Object

See also Object Types: Static Objects and Object Properties: Static Text.

1. Choose Text from the Static menu. The object appears on the screen and the Inspector window, listing all the default properties for this object, opens. Information on each field displays at the bottom of the Inspector window when you place your cursor within a field's input box.

2. Make the desired changes to the object’s properties. (Note: You must press the ENTER key each time you make a direct change to any box in the Inspector window.) If you enter incorrect data in any Inspector box, the message "***THAT ENTRY IS NOT VALID***" appears at the bottom of the Inspector window.

Changing the object's position

Click the object and hold down the left mouse button. The pointer turns into a four-headed arrow. You can now move the object in any direction by simply dragging it. For finer control of movement, select the object and use the arrow keys on your keyboard to move the object one pixel at a time.

Move the object to a specific location by changing the XLOC (horizontal position) and the YLOC (vertical position) values. A 0 (zero) in both of these boxes places the object in the top left corner of the screen. Increasing the XLOC value moves the object farther to the right. Increasing the YLOC value moves it farther down the screen.

Entering text

Enter the text you want the object to display in the line1, line2, line3, and line4 boxes. Up to 12 characters can be typed in each of these boxes, which allows the object to display a maximum of 48 characters.

To have the text in each of these boxes appear on a separate line, type N in the concatenate box. Otherwise, leave the default value of Y. If you enter Y in the concatenate box and want a space to appear between the text you entered in any of the line input boxes, type a space at the beginning of the following line's input.

For example, if you want Fresh-Water Management to appear in one line on the object, you would type Fresh-Water in line1 and #Management (where # represents pressing the spacebar one time) in line2, and type Y in the concatenate box.

Sizing the object

Click the object. Handles (small white boxes) appear around the object. "Grab" a handle by clicking it. Notice that all the other handles become black in color. Hold down the left mouse button and drag the selected handle to increase or decrease the object’s size.

Set the object to a specific size by entering values (measured in pixels) in the widthDim and heightDim boxes.

Positioning the text

Set the text's alignment by entering a horizontal position (C=center, R=right, L=left) and then a vertical position (M=middle, T=top, B=bottom) in the justify box.
Set the horizontal margin (measured from the left or right of the object's edge, depending on its horizontal alignment) by entering an integer value in the `insetX` box. Set the vertical margin (as measured from the top or bottom of the object's edge, depending on its vertical alignment) by entering an integer value in the `insetY` box.

For example, entering 10 in both the `insetX` and `insetY` boxes and entering LT in the `justify` box, would position the text in the top left corner, 10 pixels from the left edge and 10 pixels from the top edge of the object.

**Controlling text appearance**

Set the color of the text by clicking `textColor` in Inspector. When the `Color` dialog box opens, select a color from the list or type a hexadecimal number in the RGB boxes. Use `Bright` and `Dark` to control the color's intensity (light or dark).

Set text size by entering an integer value in the `fontSize` box.

For bold face text, type Y in the bold box.

**Setting the object's color**

Set the color of the object by clicking `backgroundColor` in Inspector. When the `Color` dialog box opens, select a color from the list or type a hexadecimal number in the RGB boxes. Use `Bright` and `Dark` to control the color's intensity (light or dark).

Make the object appear transparent (its color matches the color of the object directly beneath it) by entering N in the `fillBackground` box.

**Adding a border**

To add a three-dimensional border to the object, enter Y in the `drawBorder` box.

**Creating a link**

Create a hyperlink between this object and another screen or web page by:

- Clicking `URL` in Inspector and selecting a destination screen (the screen that loads when this object is clicked) from the `Link` dialog box.
- Typing the URL address for the destination screen or web page in the `URL` box. The URL address must be in the following format (you don't need to type in http://): [screen name].html For example, station1.html, where station1 is the name of the screen that loads when this object is clicked; or, www.dataflowsys.com to link to the DFS website.

3. Save your screen by choosing `Save` or `Save As` from the `File` menu.

**Adding a Static Tick Mark**

See also `Object Types: Static Objects` and `Object Properties: Static Tick Mark`.

1. Choose `Tick Mark` from the `Static` menu. The object appears on the screen and the Inspector window, listing all the default properties for this object, opens. Information on each field displays at the bottom of the Inspector window when you place your cursor within a field's input box.
2. Make the desired changes to the object's properties. (Note: You must press the ENTER key each time you make a direct change to any box in the Inspector window.) If you enter incorrect data in any Inspector box, the message "***THAT ENTRY IS NOT VALID***" appears at the bottom of the Inspector window.

**Changing the object's position**

Click the object and hold down the left mouse button. The pointer turns into a four-headed arrow. You can now move the object in any direction by simply dragging it. For finer control of movement, select the object and use the arrow keys on your keyboard to move the object one pixel at a time.

Move the object to a specific location by changing the **XLOC** (horizontal position) and the **YLOC** (vertical position) values. A 0 (zero) in both of these boxes places the object in the top left corner of the screen. Increasing the **XLOC** value moves the object farther to the right. Increasing the **YLOC** value moves it farther down the screen.

**Controlling the appearance of the tick marks**

Set the color of the tick marks by clicking tickColor in Inspector. When the **Color** dialog box opens, select a color from the list or type a hexadecimal number in the **RGB** boxes. Use **Bright** and **Dark** to control the color's intensity (light or dark).

To have the tick marks appear in staggered length, rather than equal lengths, enter Y in the **stagger** box.

Set the number of segments for the object by entering 4, 8, 10, or 16 in the **segments** box.

Set direction of the tick marks by entering L, R, T, or B in the **direction** box. This is the direction from which the tick marks are drawn. L = tick marks start on the left side of the object and point right; R = tick marks start on the right side of the object and point left; T = tick marks start at the top of the object and point down; B = tick marks start at the bottom of the object and point up.

**Sizing the object**

Click the object. Handles (small white boxes) appear around the object. "Grab" a handle by clicking it. Notice that all the other handles become black in color. Hold down the left mouse button and drag the selected handle to increase or decrease the object’s size. Hold down the SHIFT button while dragging a handle to make the object square (width = height).

Set the object to a specific size by entering values (measured in pixels) in the **widthDim** and **heightDim** boxes.

**Creating a link**

Create a hyperlink between this object and another screen or web page by:

- Clicking **URL** in Inspector and selecting a destination screen (the screen that loads when this object is clicked) from the **Link** dialog box.
- Typing the URL address for the destination screen or web page in the **URL** box. The URL address must be in the following format (you don't need to type in http://): [screen name].html For example, station1.html, where station1 is the name of the screen that loads when this object is clicked; or, www.dataflowsys.com to link to the DFS website.

3. Save your screen by choosing **Save** or **Save As** from the **File** menu.
Viewing Object Properties with Inspector

When a new object is added to a screen, the Inspector window opens. If the Inspector window is closed, double-click a screen object or select the object and then select **Fields** from the **Object** menu to open Inspector.

For detailed information on the fields listed in Inspector, see the following sections:

- [Analog Object Properties](#)
- [Digital Object Properties](#)
- [Pipe Object Properties](#)
- [Static Object Properties](#)

The example shown below is for a static text object. The fields displayed in Inspector vary depending on the object type.
Editing Objects

The sections below provide instructions for editing objects using either Inspector or the Edit menu.

For instructions on adding objects to your screen, see:

- Adding Analog Objects
- Adding Digital Objects
- Adding Pipe Objects
- Adding Static Objects

Editing Objects with Inspector

1. Double click the object you want to edit, or select the object and then select Fields from the Object menu.
2. Make the desired changes in any of the object's Inspector fields.
3. Press the ENTER key. (Note: You must press the ENTER key each time you change the value of one of Inspector's fields).
4. Choose Save or Save As from the File menu.

Editing Objects with the Edit Menu

The edit menu features standard commands for:

- Reversing the last action you performed (Undo)
- Cutting, copying, and pasting information from one Inspector field to another (Cut, Copy, Paste) or cutting, copying, and pasting objects or groups of objects
- Deleting objects from your screen (Delete)

Undo
When you perform an action on an object and you want to reverse that action, choose Undo from the Edit menu.

Cut and Paste

To move information from one Inspector field to another:

1. Highlight the data to cut and press CTRL + X.
2. Place your cursor in the destination field and press CTRL + V.
To remove an object or group of objects and paste in another location:

1. Select the object or group of objects and choose **Cut** from the **Edit** menu. See **Selecting Multiple Objects** for instructions on grouping objects.

2. Choose Paste from the Edit menu.

To remove an object or group of objects and paste in another screen:

1. Select the object or group of objects and choose **Cut** from the **Edit** menu. See **Selecting Multiple Objects** for instructions on grouping objects.

2. Open the screen you want to paste to.

3. Choose **Paste** from the **Edit** menu.

Copy and Paste

**To copy an entry from a data field and paste it in another location:**

1. Highlight the data to copy and press CTRL + C.

2. Place your cursor in the destination field and press CTRL + V.

**To copy an object or group of objects and paste in another location:**

1. Select the object or group of objects and choose **Copy** from the **Edit** menu. See **Selecting Multiple Objects** for instructions on grouping objects.

2. Choose **Paste** from the **Edit** menu.

**To copy an object or group of objects and paste in another screen:**

1. Select the object or group of objects and choose **Copy** from the **Edit** menu. See **Selecting Multiple Objects** for instructions on grouping objects.

2. Open the screen you want to paste to.

3. Choose **Paste** from the **Edit** menu.

Delete

**To delete an object or group of objects from your screen:**

1. Select the object group of objects to delete. See **Selecting Multiple Objects** for instructions on grouping objects.

2. Choose **Delete** from the **Edit** menu. The object or group of objects is removed from the screen and the Message bar displays "Delete performed."
Linking to Screens, Trends and Web (HTML) Pages

The sections below provide instructions for:

- Linking to another custom screen
- Linking to a default screen
- Linking to a trend
- Linking to a Web (HTML) page

Linking to Another Custom Screen

1. Select the object that will contain the link. Open Inspector by double clicking the object; or selecting the object and choosing Fields from the Object menu.

2. Click URL to open the Link dialog box.

3. Locate the destination screen, select it and click Link. The URL for the destination screen appears in the URL box.

Editing a Link

1. Select the object that contains the link you want to edit. Open Inspector by double clicking the object; or selecting the object and choosing Fields from the Object menu.

2. Click URL to open the Link dialog box.

3. Locate the new destination screen, select it and click Link. The URL for the new destination screen appears in the URL box. To exit the Link dialog box without making changes, click Cancel.

4. Save the screen by selecting Save or Save As from the File menu.
Linking to a Default Screen

It is possible to create a link to a default station screen from an object in a custom screen. HT3’s Station Status screens are automatically generated for each configured station and present information in a tabular, text-based format. Ordinarily, default screens are opened in HT3 by selecting "Stations" from the "View" menu and choosing a station from the displayed list. You can also view the information for a default screen by linking directly to it from a custom screen object.

Creating a link to a default screen:

1. Select the object that will contain the link. Open Inspector by double clicking the object; or selecting the object and then choosing Fields from the Object menu.

2. In the URL box, type the line below and press Enter (note that in the line below, xxxx represents the station’s number).

   `hypertacii/defscr.cgi?stn=xxxx`

In the screen shot below, we are linking to the default screen for station number 9.

![Screen Screenshot](image)

Editing a Link

To edit a link to a default screen, follow the steps above and make any desired changes in the URL box.

Linking to a Trend

A screen object can be a link to either a saved trend or a default trend.

- **Saved Trend**: After creating and saving a trend using HT3’s Trend Builder, you can add an object to a custom screen and then link the object to the trend by entering the trend’s URL path in the object’s URL box.
- **Default Trend**: In Default Screen Viewer, you can click a digital or analog input to view a trend of its activity over the last 24 hours. You can also create a link to one of these trends in your custom screens.

Creating a link to a saved trend:
1. Select the object that will contain the link. Open Inspector by double clicking the object; or selecting the object and then choosing **Fields** from the **Object** menu.
2. In the URL box, type the following line and press Enter (note that in the line below trendname represents the name given to the trend when it was saved in Trend Builder).

   ```html
   hypertacii/trnd/trendname.html
   ```

   In the screen shot below, we are linking to a trend named Pulse_Input.

   ![Inspector Window](image)

   **Editing a Link to a Saved Trend**

   To edit a link to a saved trend, follow the steps above and make any desired changes in the URL field.

   Creating a link to a default trend:

   Before you can create the link in your custom screen, you must retrieve the link for the desired trend.
   
   1. Open the Station Status Viewer (Click "View" on the main HT3 menu and then click "Stations" on the View submenu).
   2. In the Station Listing, select the station that contains the point you want to link to.
   3. In the station panel, right-click the point you want to link to. The link to the trend will be displayed in the the status bar (see image below).
4. Write down the text between "http://" and the comma (,) that appears before the word "address." This is the text that will be entered in the URL box of your custom screen object. In our example, we would write down:

HyperTACII/cgi-bin/dtv.cgi?AO=127A2

5. Start Screen Builder and open the screen that you want to place the link on.

6. Select the object that will contain the link. Open Inspector by double clicking the object; or selecting the object and then choosing Fields from the Object menu.

7. In the URL box, type the link you obtained from the Default Screen Viewer (example shown below) and press Enter.
Editing a Link to a Saved Trend

To edit a link to a saved trend, follow the steps above and make any desired changes in the URL box.

Linking to a Web (HTML) Page

In addition to linking to other custom screens, default screens, and trends, an object can also be a link to a web (or HTML) page. You can link to:

- A web page that you created and uploaded to the Hyper SCADA Server (HSS)
- The IP address of another Hyper SCADA Server (HSS)
- An external web page (for example, the home page of your city's or utility's website).

By default, these links will open in the same browser window. Add /#new to the end of the URL to have them open in a new window.

Creating a link to a custom HTML page:

1. Select the object that will contain the link. Open Inspector by double clicking the object; or selecting the object and then choosing Fields from the Object menu.

2. In the URL box, type the URL of the page you want the object to open and press Enter. The format of the URL depends on the type of page you are linking to:

   Web page you created and uploaded to the HSS:
hypertacii/scr/pagename.html (where pagename represents the name of the HTML file that you uploaded to the server)

Another Hyper SCADA Server:
http://192.168.10.90/ht3 (where 192.168.10.90 is the IP address of the second HSS)

External website
http://www.dataflowsys.com (to link to the site's home page)
http://www.dataflowsys.com/products/hyper-scada-server.php (to link to a specific page on the site)

In the screen shot below, we are linking to an HTML file named contacts.html that was uploaded to the HSS. This link will open in the same browser window. See the next section for instructions on configuring the link to open in a new window.

Open Link in a New Window

By default, these links will open in the same browser window. To have them open in a new window, add /#new to the end of the URL.

IMPORTANT: The forward slash (/) must be included before #new. Also be sure that your browser's popup blocker is configured to allow links to open in new windows.
Editing a Link to an HTML Page

To edit a link to an HTML page, follow the steps above and make any desired changes in the URL box.

Choosing Colors and Images

The sections below provide instructions for:

- Choosing colors for text and objects
- Choosing an image

Choosing Colors for Text and Objects

Some of Screen Builder’s objects require that you specify the color of the object’s text, or its background or border.

To choose a color:

1. Select the object. Open Inspector by double clicking the object; or selecting the object and choosing Fields from the Object menu.

2. Click the name of the field whose color you want to change. The Color dialog box opens. The color sample box and the RGB boxes show the default color.
3. Choose a color from the list (its hexadecimal RGB number appears in the RGB boxes) or type in an RGB number in the three RGB boxes. The color appears in the color sample box. To brighten or darken the color, select Bright or Dark.

4. Click OK to accept your changes.

Choosing an Image

The following Screen Builder objects allow you to select their associated image, or graphic.

- Static Image
- Static Resizable Image
- Digital Graphic
- Digital Animation
- Digital Graphic Control
- Digital 4-State Graphic
- Analog Bar Graph
- Analog Control

Initially, when you add one of these objects to a custom screen, their default image appears.

To choose an alternate image:

1. Select the object you want to select an image for.
2. Open Inspector by double clicking the object; or selecting the object and choosing **Fields** from the **Object** menu.

3. In Inspector, click the name of the field that contains the image's file name. For example, for a Static Image, you would click **image**. See example below.

   (Note: The Digital objects listed above allow you to select a different image for each possible state. For example, for the Digital Graphic, you can select a separate image for the on, off, and initial states by clicking the ON (1), OFF (0), and INIT field names. See Adding Digital Objects for more information.)

![HyperTD Inspector](image)

4. In the **Image Picker** dialog box, you can browse images by category. To see all of the images, select **All Images**.
5. Select the image you want for the screen object and then click **Select Image**. The selected image appears on your screen. For information on adding your own images to the screen image library and using the Image Picker to organize your library, see **Adding and Organizing Images**.

**Moving and Layering Objects**

The sections below provide instructions for:

- **Working with layered objects**
- **Duplicating an object**
- **Selecting “hidden” objects**
- **Aligning objects**
- **Selecting multiple objects**
- **Moving objects**
- **Moving multiple objects simultaneously**

**Working with Layered Objects**

Screen Builder's Object menu features four commands that aid you in the process of selecting and moving layered objects (those that are "stacked" on top of each other). They are:
• to Front - moves the object to the very top of the "stack"
• Forward - moves the object up one layer
• Backward - moves the object down one layer
• to Back - moves the object to the very bottom of the "stack"

As your screens become more complex, there will be times when they have multiple layers of objects. Layering objects gives your screens more depth and detail. But what do you do when you have three objects layered and you want to move the middle layer to the top of the "stack"? And you want to do this without "unlayering" the objects.

1. Select the object that you want to move. (See Selecting "Hidden" Objects for instructions on selecting objects that are in the middle or on the bottom of the "stack.")

2. Choose one of the commands listed above (to Front, Forward, Backward, to Back) from the Object menu.

Duplicating an Object

The Duplicate command is useful when you want to make an exact copy, or clone, of an object or group of objects. For example, instead of adding a new object and then editing its fields to match those of another object, you simply duplicate it.

1. Select the object or group of objects you want to duplicate by clicking it. See Selecting Multiple Objects for instructions on grouping objects.

2. Choose Duplicate from the Object menu. An exact copy of the original object or group of objects appears on the screen.

Selecting "Hidden" Objects

The Select Behind command is useful when you have a "stack" of layered objects and you're trying to select one that is "hidden" in the stack. It is located somewhere in the middle or at the bottom of the stack, and there isn't any way to simply click on it to select it.

1. Select the object that is on the top of the stack.

2. Choose Select Behind from the Object menu (or hold down the CTRL key and click the object again). This selects the object directly beneath the top object.

3. Continue choosing Select Behind (or holding down the CTRL key and clicking the top object) until you have the desired object selected. The Message bar tells you what type of object is selected. Open Inspector to view the object's properties and to be sure the correct object is selected.

(Note: If you are using Windows, you can use either the CTRL or ALT key to select a hidden object.)
Aligning Objects

The Align menu is a tool that helps create uniformity and add symmetry to your screens.

You may want to align two or more objects so that they are centered exactly on top of one another. Or you may have a row of objects that you want to align so that they are positioned along the same invisible horizontal line.

Objects can be aligned horizontally (Left, Center, Right) and vertically (Top, Middle, Bottom).

1. Select a reference object by clicking it. This is the object to which the others will be aligned.

2. Hold down the SHIFT key and then select the secondary objects. As you do this a black line appears around the selected objects. At the bottom of the Screen Builder window, you will see a message telling you how many objects have been selected.

3. From the Align menu, choose how you want the objects to be aligned (Left, Center, Right, Top, Middle, or Bottom). You can align the objects horizontally and then vertically by keeping them selected (make sure they are still surrounded by the black line) and then selecting another alignment direction from the Align menu.

Selecting Multiple Objects

Grouping objects is useful when you create an arrangement of objects and you want to perform the same function on them simultaneously. For example, you may want to copy that arrangement to another screen or duplicate the arrangement within the current screen. This can be accomplished using the SHIFT key and selecting (clicking) each object, or by drawing a box around the desired objects.

Using SHIFT

1. Select an object in the group.

2. Hold down the SHIFT key and then select the other objects in the group. As you do this a black line appears around the selected objects. The Message bar displays "[#] objects selected," where # is equal to the number of objects that are selected.

3. With the black line still visible, choose the editing command you want to perform, e.g., Copy, Duplicate, etc.

Drawing a Box Around Objects

1. Position your mouse pointer somewhere outside the area where the objects are located. You can use the white margin outside the screen boundaries if necessary. Click, and continue pressing the left mouse button. The pointer becomes a cross hair.

2. Continue holding down the left mouse button and start dragging the cross hair to form a box around the objects.

3. When all the desired objects are within the box, release the mouse button. All the objects within the box are selected and the Message bar displays "[#] objects selected," where # is equal to the number of objects that are selected.

4. With the box still visible, choose the editing command you want to perform, e.g., Copy, Duplicate, etc.
If you need to start your box with the mouse pointer over an object, such as a background picture, do the following:

1. Click in the white screen margin to deselect all objects. Check the Message bar to verify that no objects are selected.

2. Hold down the SHIFT key as you press the mouse button to start your box.

**Moving Objects**

There are two ways to move and position your screen objects.

- Select the object to be moved, continue holding down the left mouse button (the pointer becomes a four-headed arrow) and drag the object to a new location.

- Select the object to be moved, and while it is still selected, use the arrow keys on your keyboard to move the object one pixel at a time.

**Moving Multiple Objects Simultaneously**

It is possible to move a group of objects to a new position. You can keep the objects' relationship to one another the same as you move them. The process is similar to the one used when aligning objects.

1. Select the objects to be moved using one of the techniques described in Selecting Multiple Objects, above.

2. Move the group using one of the procedures below:

   - For finer control of movement, use the arrow keys on your keyboard to move the selected objects one pixel at a time.

   - Click the selected objects and continue holding down the mouse button. The pointer becomes a four-headed arrow. Drag the objects to the new location.

**Adding Network Camera Images to Screens**

If you have surveillance cameras installed on your network, you can add snapshots from these cameras to your custom screens.

Before images from these cameras can be added to custom screens or viewed from Camera Viewer, specific information, including image resolution and the camera's URL, must be provided to HT3. For detailed instructions on configuring cameras, refer to "Configuring Your System: Cameras" in the *HT3 User Guide*.

Images displayed in custom screens are static images (snapshots), although you can specify a refresh rate of as little as 1 second, which would update the image every second. To view true streaming video, use HT3’s Camera Viewer (select Cameras from HT3’s View menu).
Adding a camera image to a custom screen is as simple as adding a static image (either a standard or resizable one), selecting the desired camera, and specifying a refresh rate. Note that you cannot adjust the size of the image displayed from within Screen Builder if a standard image is used. The image's resolution, or size, is determined by how it was configured in HT3 (refer to "Configuring Your System: Cameras" in the HT3 User Guide).

1. **Start Screen Builder.**

2. Select the screen you want to add the camera image to. To place the image on a new screen, click the **Cancel** button on the **Open** dialog box (this dialog opens automatically when Screen Builder is started).

3. Add a static image to the screen by selecting **Image** or **Resizable Image** from the **Static** menu. The default static image is added to the screen and Inspector is opened. Inspector lets you set the attributes of the currently selected object. (The Inspector for a standard static image is shown below, but the same options apply to the resizable image.)

![Inspector for a static image](image)

4. For a camera snapshot to properly display in a custom screen, three fields must be completed:

   - **refresh** - In this field, you set the image's refresh rate (the rate at which the image is updated on the screen). The refresh rate is measured in seconds and indicates how often HT3 should request a new image (snapshot). For example, a refresh rate of 5 seconds would produce a new snapshot every 5 seconds. If this field is left at its default setting of 0 (zero), the image will never be updated. In the example above, we have set the camera's refresh rate to 1 (one) second.

   - **image** - When you first add a static image to a screen, the default image (file name arrowed) is selected. To have the camera image displayed, you must enter an N in this field. The camera's image will not display if anything other than N appears in the **image** field.

   - **camera** - In this field, you specify which camera's images are to be displayed. Clicking on the word camera opens a dialog box that lists the user-defined names of all configured cameras. Select a camera from the list and click **OK**. In the example above, we have selected the camera named labcam.
5. When all fields have been properly configured, the image appears on the screen. You can change the location of the image by selecting it and dragging. The size of the image cannot be adjusted in Screen Builder. The image's resolution, or size, is based on its configuration in HT3 (refer to "Configuring Your System: Cameras" in the *HT3 User Guide*). Below is a screen shot of a sample screen that includes a camera snapshot. The heading (Server Room) and the time are automatically included in the display by the camera's software. To adjust how headings and time are displayed, consult the software included with your camera.
Appendix

- Analog Object Properties
- Digital Object Properties
- Pipe Object Properties
- Static Object Properties
- RGB Color Guide
- Keyboard Shortcuts

Analog Object Properties

This section provides information on the fields and options for the following objects, which are available from the Analog menu

- Bar Graph
- Color
- Control
- Dial
- Gauge
- LED Bar
- LED Gauge
- LED Text Object
- Panel
- Rotary
- Slider
- Text Object
- Time
- Time Control
- Trend

Analog Bar Graph

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Input</th>
<th>Description</th>
</tr>
</thead>
</table>

HT3 Version 3.1.6 | © 2013 Data Flow Systems, Inc.
<table>
<thead>
<tr>
<th><strong>Value</strong></th>
<th><strong>Valid analog value for corresponding point; type an A after the value for alarm state</strong></th>
<th><strong>Enter a valid analog value in this field to see how the object will appear when the corresponding point reaches that value. To see how the object will appear in the alarm state, type an A after the value (e.g., 100A).</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>ADDR</strong></td>
<td><strong>point address</strong></td>
<td><strong>Address of point to which object is linked</strong></td>
</tr>
<tr>
<td><strong>XLOC</strong></td>
<td><strong>integer</strong></td>
<td><strong>Horizontal position of object</strong></td>
</tr>
<tr>
<td><strong>YLOC</strong></td>
<td><strong>integer</strong></td>
<td><strong>Vertical position of object</strong></td>
</tr>
<tr>
<td><strong>TYPE</strong></td>
<td><strong>AI</strong></td>
<td><strong>Type of point this object can be linked to. AI = Analog Input.</strong></td>
</tr>
<tr>
<td><strong>OBJECT</strong></td>
<td><strong>BARGRAPH</strong></td>
<td><strong>Name of object.</strong></td>
</tr>
<tr>
<td><strong>lowLimit</strong></td>
<td><strong>floating decimal value</strong></td>
<td><strong>The lowest limit, including resolution, that you want the system to display. This can be the low engineering value of the point or some higher value depending on your needs.</strong></td>
</tr>
<tr>
<td><strong>highLimit</strong></td>
<td><strong>floating decimal value</strong></td>
<td><strong>The highest limit, including resolution, that you want the system to display. This can be the high engineering value of the point or some lower value depending on your needs.</strong></td>
</tr>
<tr>
<td><strong>units</strong></td>
<td><strong>text string</strong></td>
<td><strong>Type of units to display, for example, FT, PSI, DegF</strong></td>
</tr>
<tr>
<td><strong>image</strong></td>
<td><strong>file name</strong></td>
<td><strong>File name for the image to overlay (place over) the bar graph. For example, an image of a chlorinator.</strong></td>
</tr>
<tr>
<td><strong>URL</strong></td>
<td><strong>N or valid URL address</strong></td>
<td><strong>If a URL address is entered, system is directed to open the specified custom screen of Web page when the object is clicked (http:// is assumed)</strong></td>
</tr>
<tr>
<td><strong>widthDim</strong></td>
<td><strong>integer</strong></td>
<td><strong>Width (horizontal size) of object; measured in pixels</strong></td>
</tr>
<tr>
<td><strong>heightDim</strong></td>
<td><strong>integer</strong></td>
<td><strong>Height (vertical size) of object; measured in pixels</strong></td>
</tr>
<tr>
<td><strong>vertical</strong></td>
<td><strong>V or H</strong></td>
<td><strong>V displays bar graph in vertical position; H displays bar graph horizontally</strong></td>
</tr>
<tr>
<td><strong>foregroundColor</strong></td>
<td><strong>color name or 6-character HEX string</strong></td>
<td><strong>Color of the filled portion of the bar.</strong></td>
</tr>
<tr>
<td><strong>backgroundColor</strong></td>
<td><strong>color name or 6-character HEX string</strong></td>
<td><strong>Background color of the bar (unfilled portion)</strong></td>
</tr>
<tr>
<td><strong>showText</strong></td>
<td><strong>Y or N</strong></td>
<td><strong>Y displays the point’s current value on the graph; N turns off this display</strong></td>
</tr>
<tr>
<td><strong>textColor</strong></td>
<td><strong>color name or 6-character HEX string</strong></td>
<td><strong>Color of text for point’s current value</strong></td>
</tr>
<tr>
<td><strong>showLimits</strong></td>
<td><strong>Y or N</strong></td>
<td><strong>Y displays the low and high limits for the point on the graph; N turns off this display</strong></td>
</tr>
<tr>
<td>Field Name</td>
<td>Input</td>
<td>Description</td>
</tr>
<tr>
<td>------------</td>
<td>-------</td>
<td>-------------</td>
</tr>
<tr>
<td>Value</td>
<td>Valid analog value for corresponding point</td>
<td>Enter a valid analog value in this field to see how the object will appear when the corresponding point reaches that value.</td>
</tr>
<tr>
<td>ADDR</td>
<td>point address</td>
<td>Address of point to which object is linked</td>
</tr>
<tr>
<td>XLOC</td>
<td>integer</td>
<td>Horizontal position of object</td>
</tr>
<tr>
<td>YLOC</td>
<td>integer</td>
<td>Vertical position of object</td>
</tr>
<tr>
<td>TYPE</td>
<td>AI</td>
<td>Type of point this object can be linked to. AI = Analog Input.</td>
</tr>
<tr>
<td>OBJECT</td>
<td>AACOLOR</td>
<td>Name of object.</td>
</tr>
<tr>
<td>lowLimit</td>
<td>floating decimal value</td>
<td>The lowest limit, including resolution, that you want the system to display. This can be the low engineering value of the point or some higher value depending on your needs.</td>
</tr>
<tr>
<td>highLimit</td>
<td>floating decimal value</td>
<td>The highest limit, including resolution, that you want the system to display. This can be the high engineering value of the point or some lower value depending on your needs.</td>
</tr>
<tr>
<td>units</td>
<td>text string</td>
<td>Type of units to display, for example, FT, PSI, DegF</td>
</tr>
<tr>
<td>ALARM</td>
<td>N</td>
<td>Field not used for this object.</td>
</tr>
<tr>
<td>URL</td>
<td>N or valid URL address</td>
<td>If URL address is entered, system is directed to open the specified custom screen or Web page when the object is clicked (http:// is assumed)</td>
</tr>
<tr>
<td>widthDim</td>
<td>integer</td>
<td>Width (horizontal size) of object; measured in pixels</td>
</tr>
<tr>
<td>heightDim</td>
<td>integer</td>
<td>Height (vertical size) of object; measured in pixels</td>
</tr>
<tr>
<td>insetX</td>
<td>integer</td>
<td>Left or right margin (depending on horizontal setting specified in justify) as measured from edge of object to label (measured in pixels). If text label is right aligned, this is the size of the right margin. For a left aligned label, this is the size of the left margin.</td>
</tr>
<tr>
<td>insetY</td>
<td>integer</td>
<td>Top or bottom margin (depending on vertical setting specified in justify) as measured from edge of object to label (measured in pixels). If text label is top aligned, this is the size of the top margin. For a bottom aligned label, this is the size of the bottom margin.</td>
</tr>
<tr>
<td>justify</td>
<td>two-character text string</td>
<td>Vertical and horizontal alignment of the label with respect to the object; horizontal alignment is given first. Horizontal values: C = center; R = right; L = left. Vertical values: M = middle; T = top; B = bottom. (A value of CT would place the text in the center [horizontally] and top [vertically] of the object.)</td>
</tr>
<tr>
<td>textColor</td>
<td>color name or 6-character HEX string</td>
<td>Color of text.</td>
</tr>
<tr>
<td>borderColor</td>
<td>color name or 6-character HEX string</td>
<td>Color of object's border.</td>
</tr>
<tr>
<td>drawBorder</td>
<td>Y or N</td>
<td>Y places a border around the object; N turns off border</td>
</tr>
<tr>
<td>fontSize</td>
<td>integer</td>
<td>Font size (measured in points) to use for text</td>
</tr>
<tr>
<td>showText</td>
<td>Y or N</td>
<td>Y displays the point's current value on the graph; N turns off this display</td>
</tr>
<tr>
<td>bold</td>
<td>Y or N</td>
<td>Y uses boldface type for the text; N uses plain type for the text</td>
</tr>
<tr>
<td>drawOval</td>
<td>Y or N</td>
<td>Field not used for this object.</td>
</tr>
<tr>
<td>startColor</td>
<td>color name or 6-character HEX string</td>
<td>Color to assign to low limit value of object. As the specified address' value increases or decreases, the object's color gradually shifts between the startColor and the endColor, and vice versa.</td>
</tr>
<tr>
<td>endColor</td>
<td>color name or 6-character HEX string</td>
<td>Color to assign to high limit value of object. As the specified address' value increases or decreases, the object's color gradually shifts between the startColor and the endColor, and vice versa.</td>
</tr>
</tbody>
</table>

**Analog Control**

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Input</th>
<th>Description</th>
</tr>
</thead>
</table>


<table>
<thead>
<tr>
<th>Value</th>
<th>Valid analog value for corresponding point; type an A after the value for alarm state</th>
<th>Enter a valid analog value in this field to see how the object will appear when the corresponding point reaches that value. To see how the object will appear in the alarm state, type an A after the value (e.g., 100A).</th>
</tr>
</thead>
<tbody>
<tr>
<td>ADDR</td>
<td>point address</td>
<td>Address of point to which object is linked</td>
</tr>
<tr>
<td>XLOC</td>
<td>integer</td>
<td>Horizontal position of object</td>
</tr>
<tr>
<td>YLOC</td>
<td>integer</td>
<td>Vertical position of object</td>
</tr>
<tr>
<td>TYPE</td>
<td>AO</td>
<td>Type of point this object can be linked to. AO = Analog Output.</td>
</tr>
<tr>
<td>OBJECT</td>
<td>ACONTROL</td>
<td>Name of object.</td>
</tr>
<tr>
<td>lowLimit</td>
<td>floating decimal value</td>
<td>The lowest limit, including resolution, that you want the system to display. This can be the low engineering value of the point or some higher value depending on your needs.</td>
</tr>
<tr>
<td>highLimit</td>
<td>floating decimal value</td>
<td>The highest limit, including resolution, that you want the system to display. This can be the high engineering value of the point or some lower value depending on your needs.</td>
</tr>
<tr>
<td>units</td>
<td>text string</td>
<td>Type of units to display, for example, FT, PSI, DegF</td>
</tr>
<tr>
<td>image</td>
<td>file name</td>
<td>File name for the image to overlay (place over) the bar graph. For example, an image of a chlorinator.</td>
</tr>
<tr>
<td>URL</td>
<td>N</td>
<td>URL option not available for this object</td>
</tr>
<tr>
<td>widthDim</td>
<td>integer</td>
<td>Width (horizontal size) of object; measured in pixels</td>
</tr>
<tr>
<td>heightDim</td>
<td>integer</td>
<td>Height (vertical size) of object; measured in pixels</td>
</tr>
<tr>
<td>vertical</td>
<td>V or H</td>
<td>V displays bar graph in vertical position; H displays bar graph horizontally</td>
</tr>
<tr>
<td>foregroundColor</td>
<td>color name or 6-character HEX string</td>
<td>Color of filled portion of the bar</td>
</tr>
<tr>
<td>backgroundColor</td>
<td>color name or 6-character HEX string</td>
<td>Background color of bar (unfilled portion)</td>
</tr>
<tr>
<td>showText</td>
<td>Y or N</td>
<td>Y displays the point’s current value on the bar; N turns off this display</td>
</tr>
<tr>
<td>textColor</td>
<td>color name or 6-character HEX string</td>
<td>Color of text for point’s current value</td>
</tr>
<tr>
<td>showLimits</td>
<td>Y or N</td>
<td>Y displays the low and high limits for the point on the bar; N turns off this display</td>
</tr>
<tr>
<td>limitsColor</td>
<td>color name or 6-character HEX string</td>
<td>Color of text for low and high limits</td>
</tr>
<tr>
<td>Field Name</td>
<td>Input</td>
<td>Description</td>
</tr>
<tr>
<td>------------</td>
<td>-------</td>
<td>-------------</td>
</tr>
<tr>
<td>Value</td>
<td>Valid analog value for corresponding point</td>
<td>Enter a valid analog value in this field to see how the object will appear when the corresponding point reaches that value.</td>
</tr>
<tr>
<td>ADDR</td>
<td>point address</td>
<td>Address of point to which object is linked</td>
</tr>
<tr>
<td>XLOC</td>
<td>integer</td>
<td>Horizontal position of object</td>
</tr>
<tr>
<td>YLOC</td>
<td>integer</td>
<td>Vertical position of object</td>
</tr>
<tr>
<td>TYPE</td>
<td>AI</td>
<td>Type of point this object can be linked to. AI = Analog Input.</td>
</tr>
<tr>
<td>OBJECT</td>
<td>DIAL</td>
<td>Name of object.</td>
</tr>
<tr>
<td>lowLimit</td>
<td>floating decimal value</td>
<td>The lowest limit, including resolution, that you want the system to display. This can be the low engineering value of the point or some higher value depending on your needs.</td>
</tr>
<tr>
<td>highLimit</td>
<td>floating decimal value</td>
<td>The highest limit, including resolution, that you want the system to display. This can be the high engineering value of the point or some lower value depending on your needs.</td>
</tr>
<tr>
<td>lowDegrees</td>
<td>integer</td>
<td>Low position, or starting point, (0-360 degrees) of needle's arc.</td>
</tr>
<tr>
<td>highDegrees</td>
<td>integer</td>
<td>High position, or ending point, (0-360 degrees) of needle's arc.</td>
</tr>
<tr>
<td>URL</td>
<td>N or valid URL address</td>
<td>If a URL address is entered, system is directed to open the specified custom screen or Web page when the object is clicked (http:// is assumed)</td>
</tr>
<tr>
<td>widthDim</td>
<td>integer</td>
<td>Width (horizontal size) of object; measured in pixels.</td>
</tr>
<tr>
<td>heightDim</td>
<td>integer</td>
<td>Height (vertical size) of object; measured in pixels.</td>
</tr>
<tr>
<td>Field Name</td>
<td>Input</td>
<td>Description</td>
</tr>
<tr>
<td>------------</td>
<td>------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>dialColor</td>
<td>color name or 6-character HEX string</td>
<td>Color of needle</td>
</tr>
<tr>
<td>insideRadius</td>
<td>integer</td>
<td>Radius of dial's inner arc; determines how close to the object's edge the needle begins.</td>
</tr>
<tr>
<td>lineWidth</td>
<td>integer</td>
<td>Width, or thickness, of needle</td>
</tr>
<tr>
<td>clockwise</td>
<td>Y or N</td>
<td>Y makes needle move in clockwise direction. N makes needle move in counterclockwise direction.</td>
</tr>
</tbody>
</table>

**Analog Gauge**

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Input</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Value</td>
<td>Valid analog value for corresponding point; type an A after the value for alarm state</td>
<td>Enter a valid analog value in this field to see how the object will appear when the corresponding point reaches that value. To see how the object will appear in the alarm state, type an A after the value (e.g., 100A).</td>
</tr>
<tr>
<td>ADDR</td>
<td>point address</td>
<td>Address of point to which object is linked</td>
</tr>
<tr>
<td>XLOC</td>
<td>integer</td>
<td>Horizontal position of object</td>
</tr>
<tr>
<td>YLOC</td>
<td>integer</td>
<td>Vertical position of object</td>
</tr>
<tr>
<td>TYPE</td>
<td>AI</td>
<td>Type of point this object can be linked to. AI = Analog Input.</td>
</tr>
<tr>
<td>OBJECT</td>
<td>GAUGE</td>
<td>Name of object.</td>
</tr>
<tr>
<td>lowLimit</td>
<td>floating decimal value</td>
<td>The lowest limit, including resolution, that you want the system to display. This can be the low engineering value of the point or some higher value depending on your needs.</td>
</tr>
<tr>
<td>highLimit</td>
<td>floating decimal value</td>
<td>The highest limit, including resolution, that you want the system to display. This can be the high engineering value of the point or some lower value depending on your needs.</td>
</tr>
<tr>
<td>units</td>
<td>text string</td>
<td>Type of units to display, for example, FT, PSI, DegF</td>
</tr>
<tr>
<td>ALARM</td>
<td>N</td>
<td>Field not used for this object.</td>
</tr>
<tr>
<td>URL</td>
<td>N or valid URL address</td>
<td>If a URL address is entered, system is directed to open the specified custom screen or Web page when the object is clicked (http:// is assumed)</td>
</tr>
<tr>
<td>params</td>
<td>N</td>
<td>Field not used for this object.</td>
</tr>
</tbody>
</table>
# Analog LED Bar

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Input</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Value</td>
<td>Valid analog value for corresponding point</td>
<td>Enter a valid analog value in this field to see how the object will appear when the corresponding point reaches that value.</td>
</tr>
<tr>
<td>ADDR</td>
<td>point address</td>
<td>Address of point to which object is linked</td>
</tr>
<tr>
<td>XLOC</td>
<td>integer</td>
<td>Horizontal position of object</td>
</tr>
<tr>
<td>YLOC</td>
<td>integer</td>
<td>Vertical position of object</td>
</tr>
<tr>
<td>TYPE</td>
<td>AI</td>
<td>Type of point this object can be linked to. AI = Analog Input.</td>
</tr>
<tr>
<td>OBJECT</td>
<td>LEDBAR</td>
<td>Name of object.</td>
</tr>
<tr>
<td>low</td>
<td>floating decimal value</td>
<td>Bar's low value; this can be the low engineering value of the point or some higher value depending on your needs; the LEDs between the low and warning values limits will be displayed in the <code>lowColor</code>.</td>
</tr>
<tr>
<td>warning</td>
<td>floating decimal value</td>
<td>Value at which you want to be alerted that the point is approaching the alarm state; the LED's between the warning and the alarm limits will be displayed in the <code>mediumColor</code>.</td>
</tr>
<tr>
<td>alarm</td>
<td>floating decimal value</td>
<td>Value at which the point enters an alarm state; the LEDs between the alarm and the high limits will be displayed in the <code>highColor</code>.</td>
</tr>
<tr>
<td>high</td>
<td>floating decimal value</td>
<td>Bar's high value; this can be the low engineering value of the point or some higher value depending on your needs.</td>
</tr>
<tr>
<td>URL</td>
<td>N or valid URL address</td>
<td>If a URL address is entered, system is directed to open the specified custom screen or Web page when the object is clicked (http:// is assumed).</td>
</tr>
<tr>
<td>widthDim</td>
<td>integer</td>
<td>Width (horizontal size) of object; measured in pixels</td>
</tr>
<tr>
<td>heightDim</td>
<td>integer</td>
<td>Height (vertical size) of object; measured in pixels</td>
</tr>
<tr>
<td>spacing</td>
<td>integer</td>
<td>Amount of space between each LED</td>
</tr>
<tr>
<td>count</td>
<td>integer</td>
<td>Number of LEDs on the bar</td>
</tr>
<tr>
<td>backgroundColor</td>
<td>color name or 6-character HEX string</td>
<td>Bar’s background color</td>
</tr>
<tr>
<td>lowColor</td>
<td>color name or 6-character HEX string</td>
<td>Color of bar’s LEDs when point’s value is between the low and warning limits</td>
</tr>
<tr>
<td>mediumColor</td>
<td>color name or 6-character HEX string</td>
<td>Color of bar's LEDs when point’s value is between the warning and alarm limits</td>
</tr>
</tbody>
</table>
### Analog LED Gauge

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Input</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Value</td>
<td>Valid analog value for corresponding point</td>
<td>Enter a valid analog value in this field to see how the object will appear when the corresponding point reaches that value.</td>
</tr>
<tr>
<td>ADDR</td>
<td>point address</td>
<td>Address of point to which object is linked</td>
</tr>
<tr>
<td>XLOC</td>
<td>integer</td>
<td>Horizontal position of object</td>
</tr>
<tr>
<td>YLOC</td>
<td>integer</td>
<td>Vertical position of object</td>
</tr>
<tr>
<td>TYPE</td>
<td>AI</td>
<td>Type of point this object can be linked to. AI = Analog Input.</td>
</tr>
<tr>
<td>OBJECT</td>
<td>ANGAUGE</td>
<td>Name of object.</td>
</tr>
<tr>
<td>low</td>
<td>integer</td>
<td>The gauge's low value; this can be the lower engineering value of the point or some higher value depending on your needs; the gauge's dial will display the <strong>lowColor</strong> when the value is between the low and warning limits</td>
</tr>
<tr>
<td>warning</td>
<td>integer</td>
<td>The value at which you want to be alerted that the point is approaching the alarm state; the gauge's dial will display the <strong>mediumColor</strong> when the value is between the warning and alarm limits</td>
</tr>
<tr>
<td>Variable</td>
<td>Type</td>
<td>Description</td>
</tr>
<tr>
<td>--------------</td>
<td>--------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>alarm</td>
<td>integer</td>
<td>The value at which the point enters an alarm state; the gauge's dial will display the <strong>highColor</strong> when the value is between the alarm and high limits</td>
</tr>
<tr>
<td>high</td>
<td>integer</td>
<td>The gauge's high value; This can be the high engineering value of the point or some lower value depending on your needs.</td>
</tr>
<tr>
<td>URL</td>
<td>N or valid URL address</td>
<td>If a URL address is entered, system is directed to open the specified custom screen or Web page when the object is clicked (http:// is assumed)</td>
</tr>
<tr>
<td>widthDim</td>
<td>integer</td>
<td>Width (horizontal size) of object; measured in pixels.</td>
</tr>
<tr>
<td>heightDim</td>
<td>integer</td>
<td>Height (vertical size) of object; measured in pixels.</td>
</tr>
<tr>
<td>degrees</td>
<td>90, 180, 300, 360</td>
<td>Measurement of the gauge's arc (90 for a quarter circle, 180 for a half circle, 300 for a nearly full circle, 360 for a full circle)</td>
</tr>
<tr>
<td>majorTicks</td>
<td>integer</td>
<td>Value of each of the gauge's major tick marks; also the value of the multiplier, which is displayed in the center of the gauge</td>
</tr>
<tr>
<td>decimal</td>
<td>integer</td>
<td>Number of decimal places to display for the gauge's labels</td>
</tr>
<tr>
<td>minorTicks</td>
<td>integer</td>
<td>Value of each of the gauge’s minor tick marks (marks that appear between the major tick marks)</td>
</tr>
<tr>
<td>clockwise</td>
<td>Y or N</td>
<td>Y for a gauge that displays values in a clockwise direction; N for a gauge that displays values in a counter-clockwise direction</td>
</tr>
<tr>
<td>backgroundColor</td>
<td>color name or 6-character HEX string</td>
<td>Color of gauge's background</td>
</tr>
<tr>
<td>lowColor</td>
<td>color name or 6-character HEX string</td>
<td>Color of gauge's dial when point's value is between the low and warning limits</td>
</tr>
<tr>
<td>mediumColor</td>
<td>color name or 6-character HEX string</td>
<td>Color of gauge's dial when point's value is between the warning and alarm limits</td>
</tr>
<tr>
<td>highColor</td>
<td>color name or 6-character HEX string</td>
<td>Color of gauge's dial when point's value is between the alarm and high limits</td>
</tr>
<tr>
<td>needleColor</td>
<td>color name or 6-character HEX string</td>
<td>Color of gauge's needle</td>
</tr>
<tr>
<td>showLabels</td>
<td>Y or N</td>
<td>Y displays major tick value labels along outside of dial; N removes labels from display</td>
</tr>
<tr>
<td>textColor</td>
<td>color name or 6-character HEX string</td>
<td>Color of the gauge’s central text and major tick value labels</td>
</tr>
<tr>
<td>centralHeight</td>
<td>integer</td>
<td>Size of text displayed in gauge's center</td>
</tr>
<tr>
<td>labelHeight</td>
<td>integer</td>
<td>Size of text labels</td>
</tr>
</tbody>
</table>
### Analog LED Text

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Input</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>centralText</td>
<td>text string</td>
<td>Text that will be displayed in the center of the gauge</td>
</tr>
<tr>
<td>Value</td>
<td>Valid analog value for corresponding point</td>
<td>Enter a valid analog value in this field to see how the object will appear when the corresponding point reaches that value.</td>
</tr>
<tr>
<td>ADDR</td>
<td>point address or STATIC</td>
<td>Address of point to which object is linked. Leave at default STATIC is this object is to be used as a countdown timer with a link to another screen or Web page.</td>
</tr>
<tr>
<td>XLOC</td>
<td>integer</td>
<td>Horizontal position of object</td>
</tr>
<tr>
<td>YLOC</td>
<td>integer</td>
<td>Vertical position of object</td>
</tr>
<tr>
<td>TYPE</td>
<td>AI, ST</td>
<td>Type of point this object can be linked to. AI = Analog Input; ST = Static.</td>
</tr>
<tr>
<td>OBJECT</td>
<td>SEGLED</td>
<td>Name of object.</td>
</tr>
<tr>
<td>low</td>
<td>integer</td>
<td>The lowest limit, including resolution, that you want the system to display. This can be the low engineering value of the point or some higher value depending on your needs.</td>
</tr>
<tr>
<td>high</td>
<td>integer</td>
<td>The highest limit, including resolution, that you want the system to display. This can be the high engineering value of the point or some lower value depending on your needs.</td>
</tr>
<tr>
<td>decimal</td>
<td>integer</td>
<td>Number of decimal places that the LED Text object is to display</td>
</tr>
<tr>
<td>signed</td>
<td>Y or N</td>
<td>Y to have the object display a plus (+) or minus (-) to reflect positive and negative values</td>
</tr>
<tr>
<td>URL</td>
<td>N or valid URL address</td>
<td>If URL address is entered, system is directed to open the specified custom screen or Web page when the object is clicked (http:// is assumed)</td>
</tr>
<tr>
<td>widthDim</td>
<td>integer</td>
<td>Width (horizontal size) of text object; measured in pixels</td>
</tr>
<tr>
<td>heightDim</td>
<td>integer</td>
<td>Height (vertical size) of text object; measured in pixels</td>
</tr>
<tr>
<td>backgroundColor</td>
<td>color name or 6-character HEX string</td>
<td>Background color of object</td>
</tr>
<tr>
<td>digitColor</td>
<td>color name or 6-character HEX string</td>
<td>Color of displayed text</td>
</tr>
</tbody>
</table>
countDown | integer | Number of seconds before link (URL) is executed; must enter STATIC in ADDR field to implement this feature

## Analog Panel

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Input</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Value</td>
<td>Valid analog value for corresponding point; type an A after the value for alarm state</td>
<td>Enter a valid analog value in this field to see how the object will appear when the corresponding point reaches that value. To see how the object will appear in the alarm state, type an A after the value (e.g., 100A).</td>
</tr>
<tr>
<td>ADDR</td>
<td>point address</td>
<td>Address of point to which object is linked</td>
</tr>
<tr>
<td>XLOC</td>
<td>integer</td>
<td>Horizontal position of object</td>
</tr>
<tr>
<td>YLOC</td>
<td>integer</td>
<td>Vertical position of object</td>
</tr>
<tr>
<td>TYPE</td>
<td>AI</td>
<td>Type of point this object can be linked to. AI = Analog Input.</td>
</tr>
<tr>
<td>OBJECT</td>
<td>PANEL</td>
<td>Name of object</td>
</tr>
<tr>
<td>lowLimit</td>
<td>floating decimal value</td>
<td>The lowest limit, including resolution, that you want the system to display. This can be the low engineering value of the point or some higher value depending on your needs.</td>
</tr>
<tr>
<td>highLimit</td>
<td>floating decimal value</td>
<td>The highest limit, including resolution, that you want the system to display. This can be the high engineering value of the point or some lower value depending on your needs.</td>
</tr>
<tr>
<td>units</td>
<td>text string</td>
<td>Type of units to display, for example, FT, PSI, DegF</td>
</tr>
<tr>
<td>ALARM</td>
<td>N</td>
<td>Field not used for this object</td>
</tr>
<tr>
<td>URL</td>
<td>N or valid URL address</td>
<td>If a URL address is entered, system is directed to open the specified custom screen or Web page when the object is clicked (http:// is assumed)</td>
</tr>
<tr>
<td>params</td>
<td>N</td>
<td>Field not used for this object</td>
</tr>
</tbody>
</table>

## Analog Rotary

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Input</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Value</td>
<td>Valid analog value for corresponding point</td>
<td>Enter a valid analog value in this field to see how the object will appear when the corresponding point reaches that value.</td>
</tr>
<tr>
<td>ADDR</td>
<td>point address</td>
<td>Address of point to which object is linked</td>
</tr>
<tr>
<td>-------</td>
<td>------------------------</td>
<td>------------------------------------------</td>
</tr>
<tr>
<td>XLOC</td>
<td>integer</td>
<td>Horizontal position of object</td>
</tr>
<tr>
<td>YLOC</td>
<td>integer</td>
<td>Vertical position of object</td>
</tr>
<tr>
<td>TYPE</td>
<td>AI</td>
<td>Type of point this object can be linked to. AI = Analog Input.</td>
</tr>
<tr>
<td>OBJECT</td>
<td>ROTARY</td>
<td>Name of object.</td>
</tr>
<tr>
<td>low</td>
<td>floating decimal value</td>
<td>Rotary's low value; this can be the low engineering value of the point or some higher value depending on your needs.</td>
</tr>
<tr>
<td>high</td>
<td>floating decimal value</td>
<td>Rotary's high value; this can be the high engineering value of the point or some lower value depending on your needs.</td>
</tr>
<tr>
<td>limitColor</td>
<td>color name or 6-character</td>
<td>Color that appears at the outside edges of the rotary's gradient background</td>
</tr>
<tr>
<td>centerColor</td>
<td>color name or 6-character</td>
<td>Color that appears in the center of the rotary's gradient background</td>
</tr>
<tr>
<td>URL</td>
<td>N or valid URL address</td>
<td>If a URL address is entered, system is directed to open the specified custom screen or Web page when the object is clicked (http:// is assumed)</td>
</tr>
<tr>
<td>widthDim</td>
<td>integer</td>
<td>Width (horizontal size) of object; measured in pixels</td>
</tr>
<tr>
<td>heightDim</td>
<td>integer</td>
<td>Height (vertical size) of object; measured in pixels</td>
</tr>
<tr>
<td>visibleRange</td>
<td>integer</td>
<td>Range of values visible on the rotary's face at any one time</td>
</tr>
<tr>
<td>majorTicks</td>
<td>integer</td>
<td>Value of each of the gauge's major tick marks</td>
</tr>
<tr>
<td>minorTicks</td>
<td>integer</td>
<td>Value of each of the gauge's minor tick marks (tick marks that appear between the major tick marks)</td>
</tr>
<tr>
<td>horizontal</td>
<td>Y or N</td>
<td>Orientation of rotary; Y for horizontal; N for vertical</td>
</tr>
<tr>
<td>gradient</td>
<td>Y or N</td>
<td>Specifies if rotary should display a gradient background; Y for gradient background; N for transparent background</td>
</tr>
<tr>
<td>direction</td>
<td>Y or N</td>
<td>Specifies the direction in which rotary's values are displayed (depends on rotary's orientation); Y for down or left (highest values are at the top or highest values start on the left); N for up or right (highest values are at the bottom or highest values start on the right)</td>
</tr>
<tr>
<td>leftTicks</td>
<td>Y or N</td>
<td>Placement of the rotary's tick marks (depends on rotary's orientation); Y for tick marks on the left or top of the rotary; N for tick marks on the left or bottom of the rotary</td>
</tr>
<tr>
<td>Field Name</td>
<td>Input</td>
<td>Description</td>
</tr>
<tr>
<td>-------------</td>
<td>----------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>rotate</td>
<td>Y or N</td>
<td>Specifies if rotary should be animated (appear to turn, or spin, when the point's value changes); Y to turn on animation; N to turn off animation</td>
</tr>
<tr>
<td>needleColor</td>
<td>color name or 6-character HEX string</td>
<td>Color of rotary's needle</td>
</tr>
</tbody>
</table>

### Analog Slider

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Input</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Value</td>
<td>N/A</td>
<td>Not used for this point.</td>
</tr>
<tr>
<td>ADDR</td>
<td>point address</td>
<td>Address of point to which object is linked</td>
</tr>
<tr>
<td>XLOC</td>
<td>integer</td>
<td>Horizontal position of object</td>
</tr>
<tr>
<td>YLOC</td>
<td>integer</td>
<td>Vertical position of object</td>
</tr>
<tr>
<td>TYPE</td>
<td>AO</td>
<td>AO = Analog Output.</td>
</tr>
<tr>
<td>OBJECT</td>
<td>ASLIDER</td>
<td>Name of object.</td>
</tr>
<tr>
<td>low</td>
<td>integer</td>
<td>Low value of the slider</td>
</tr>
<tr>
<td>high</td>
<td>integer</td>
<td>High value of the slider</td>
</tr>
<tr>
<td>decimal</td>
<td>integer</td>
<td>Number of decimal places to include in the text (value) display; this text appears next to the slider as the pointer is moved along the track</td>
</tr>
<tr>
<td>vertical</td>
<td>Y or H</td>
<td>Y displays slider in vertical position; N displays slider horizontally</td>
</tr>
<tr>
<td>URL</td>
<td>N</td>
<td>URL option not available for this object</td>
</tr>
<tr>
<td>widthDim</td>
<td>integer</td>
<td>Width (horizontal size) of object; measured in pixels</td>
</tr>
<tr>
<td>heightDim</td>
<td>integer</td>
<td>Height (vertical size) of object; measured in pixels</td>
</tr>
<tr>
<td>reverse</td>
<td>Y or N</td>
<td>Direction of pointer's movement. Enter Y to have a vertical slider's pointer move from bottom to top, or to have a horizontal slider's pointer move from right to left. Enter N to have a vertical slider's pointer move from top to bottom, or to have a horizontal slider's pointer move from left to right.</td>
</tr>
<tr>
<td>showBackground</td>
<td>Y or N</td>
<td>Y to display a background behind the object; N to make the slider's background transparent</td>
</tr>
<tr>
<td>backgroundColor</td>
<td>color name or 6-character HEX string</td>
<td>Color of slider's background</td>
</tr>
<tr>
<td>backgroundStyle</td>
<td>R, L, F</td>
<td>Style to use for slider's background; R for raised, L for lowered; F for flat</td>
</tr>
<tr>
<td>pointerWidth</td>
<td>integer</td>
<td>Width of slider's pointer; enter an integer value</td>
</tr>
<tr>
<td>Field Name</td>
<td>Input</td>
<td>Description</td>
</tr>
<tr>
<td>-------------</td>
<td>--------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>pointerColor</td>
<td>color name or 6-character HEX string</td>
<td>Color of slider's pointer.</td>
</tr>
<tr>
<td>pointerStyle</td>
<td>L, R, U, D, B</td>
<td>Direction and style of slider's pointer; for vertical sliders, L for left or R for right; for horizontal sliders, U for up or D for down; B for box can be used with either vertical or horizontal sliders</td>
</tr>
<tr>
<td>trackStyle</td>
<td>S, M, L</td>
<td>Width of slider's track (relative to overall width of object); S for small (narrow); M for medium; L for large (wide)</td>
</tr>
<tr>
<td>trackColor</td>
<td>color name or 6-character HEX string</td>
<td>Color of slider's track</td>
</tr>
<tr>
<td>textSize</td>
<td>integer</td>
<td>Size of the text used to display the value the point is being controlled to; this text appears next to the slider as the pointer is moved along the track</td>
</tr>
<tr>
<td>textColor</td>
<td>color name or 6-character HEX string</td>
<td>Color of the text used to display the value the point is being controlled to; this text appears next to the slider as the pointer is moved along the track</td>
</tr>
<tr>
<td>canControl</td>
<td>N</td>
<td>Field not used for this object.</td>
</tr>
<tr>
<td>PollAddr</td>
<td>Station + module address</td>
<td>Station and module address of the module to poll after a control is initiated. For example, 1025A to poll module A and station 1025.</td>
</tr>
<tr>
<td>PollDelay</td>
<td></td>
<td>Delay between when the control is initiated and the module is polled.</td>
</tr>
</tbody>
</table>

### Analog Text

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Input</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Value</td>
<td>Valid analog value for corresponding point</td>
<td>Enter a valid analog value in this field to see how the object will appear when the corresponding point reaches that value.</td>
</tr>
<tr>
<td>ADDR</td>
<td>point address</td>
<td>Address of point to which object is linked</td>
</tr>
<tr>
<td>XLOC</td>
<td>integer</td>
<td>Horizontal position of object</td>
</tr>
<tr>
<td>YLOC</td>
<td>integer</td>
<td>Vertical position of object</td>
</tr>
<tr>
<td>TYPE</td>
<td>AI</td>
<td>Type of point this object can be linked to. AI = Analog Input.</td>
</tr>
<tr>
<td>OBJECT</td>
<td>AATEXT</td>
<td>Name of object.</td>
</tr>
<tr>
<td>lowLimit</td>
<td>floating decimal value</td>
<td>The lowest limit, including resolution, that you want the system to display. This can be the low engineering value of the point or some higher value depending on your needs.</td>
</tr>
<tr>
<td>highLimit</td>
<td>floating decimal value</td>
<td>The highest limit, including resolution, that you want the system to display. This can be the high engineering value of the point or some lower value depending on your needs.</td>
</tr>
<tr>
<td>------------------</td>
<td>------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>units</td>
<td>text string</td>
<td>Type of units to display, for example, FT, PSI, DegF</td>
</tr>
<tr>
<td>ALARM</td>
<td>N</td>
<td>Field not used for this object.</td>
</tr>
<tr>
<td>URL</td>
<td>N or valid URL address</td>
<td>If URL address is entered, system is directed to open the specified custom screen or Web page when the object is clicked (http:// is assumed)</td>
</tr>
<tr>
<td>widthDim</td>
<td>integer</td>
<td>Width (horizontal size) of text object; measured in pixels</td>
</tr>
<tr>
<td>heightDim</td>
<td>integer</td>
<td>Height (vertical size) of text object; measured in pixels</td>
</tr>
<tr>
<td>insetX</td>
<td>integer</td>
<td>Left or right margin (depending on horizontal setting specified in justify) as measured from edge of text object to label (measured in pixels). If text label is right aligned, this is the size of the right margin. For a left aligned label, this is the size of the left margin.</td>
</tr>
<tr>
<td>insetY</td>
<td>integer</td>
<td>Top or bottom margin (depending on vertical setting specified in justify) as measured from edge of text object to label (measured in pixels). If text label is top aligned, this is the size of the top margin. For a bottom aligned label, this is the size of the bottom margin.</td>
</tr>
<tr>
<td>justify</td>
<td>two-character text string</td>
<td>Vertical and horizontal alignment of the label with respect to the text object; horizontal alignment is given first. Horizontal values: C = center; R = right; L = left. Vertical values: M = middle; T = top; B = bottom. (A value of CT would place the text in the center [horizontally] and top [vertically] of the object.)</td>
</tr>
<tr>
<td>textColor</td>
<td>color name or 6-character HEX string</td>
<td>Color of text</td>
</tr>
<tr>
<td>backgroundColor</td>
<td>color name or 6-character HEX string</td>
<td>Background color of text object</td>
</tr>
<tr>
<td>drawBorder</td>
<td>Y or N</td>
<td>Y places a border around the text object; N turns off border</td>
</tr>
<tr>
<td>fontSize</td>
<td>integer</td>
<td>Font size (measured in points) to use for text</td>
</tr>
<tr>
<td>fillBackground</td>
<td>Y or N</td>
<td>Y fills text object with color specified in backgroundColor; N makes the object appear transparent</td>
</tr>
<tr>
<td>bold</td>
<td>Y or N</td>
<td>Y uses boldface type for the text; N uses plain type for the text</td>
</tr>
<tr>
<td>concatenate</td>
<td>N</td>
<td>Field not used for this object.</td>
</tr>
</tbody>
</table>
# Analog Time

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Input</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Value</td>
<td>N/A</td>
<td>Not used for this point.</td>
</tr>
<tr>
<td>ADDR</td>
<td>virtual point address or STATIC</td>
<td>Address of virtual point to which object is linked. This should be a virtual point that calculates the length of time in seconds that a logical input, for example, PUMP RUN TIME, is in the ON state. Type the word STATIC in this field to have the object display the server's time of day.</td>
</tr>
<tr>
<td>XLOC</td>
<td>integer</td>
<td>Horizontal position of object.</td>
</tr>
<tr>
<td>YLOC</td>
<td>integer</td>
<td>Vertical position of object.</td>
</tr>
<tr>
<td>TYPE</td>
<td>AI</td>
<td>Type of point this object can be linked to. AI = Analog Input.</td>
</tr>
<tr>
<td>OBJECT</td>
<td>AATIME</td>
<td>Name of object.</td>
</tr>
<tr>
<td>showSeconds</td>
<td>Y or N</td>
<td>Y displays seconds; N turns off display.</td>
</tr>
<tr>
<td>showAMPM</td>
<td>Y or N</td>
<td>Y displays AM or PM; N turns off display.</td>
</tr>
<tr>
<td>dateFormat</td>
<td>N, S, M, L, F</td>
<td>Format to use for current system date display; S for short (MM/DD/YY); M for medium (Mon DD, YY); L for long (Month DD, YYYY); F for full (Day of week, Month DD, YYYY); enter N to have object display current system time</td>
</tr>
<tr>
<td>ALARM</td>
<td>N</td>
<td>Field not used for this object.</td>
</tr>
<tr>
<td>URL</td>
<td>N or valid URL address</td>
<td>If a URL address is entered, system is directed to open the specified custom screen or Web page when the object is clicked (http:// is assumed)</td>
</tr>
<tr>
<td>widthDim</td>
<td>integer</td>
<td>Width (horizontal size) of time object; measured in pixels.</td>
</tr>
<tr>
<td>heightDim</td>
<td>integer</td>
<td>Height (vertical size) of time object; measured in pixels.</td>
</tr>
<tr>
<td>insetX</td>
<td>integer</td>
<td>Left or right margin (depending on horizontal setting specified in justify) as measured from edge of object to text string (measured in pixels). If string is right aligned, this is the size of the right margin. For a left aligned string, this is the size of the left margin.</td>
</tr>
<tr>
<td>insetY</td>
<td>integer</td>
<td>Top or bottom margin (depending on vertical setting specified in justify) as measured from edge of object to text string (measured in pixels). If string is top aligned, this is the size of the top margin. For a bottom aligned string, this is the size of the bottom margin.</td>
</tr>
</tbody>
</table>
### Justify

two-character text string

Vertical and horizontal alignment of the time string with respect to the time object; horizontal alignment is given first. Horizontal values: C = center; R = right; L = left. Vertical values: M = middle; T = top; B = bottom. (A value of CT would place the time character string in the center [horizontally] and top [vertically] of the object).

### TextColor

color name or 6-character HEX string

Color of time string (server time or date, or value of virtual point).

### BackgroundColor

color name or 6-character HEX string

Background color of time object.

### DrawBorder

Y or N

Y places a border around the time object; N turns off border.

### FontSize

integer

Font size (measured in points) to use for time character string.

### FillBackground

Y or N

Y fills time object with color indicated in `backgroundColor`; N makes the object appear transparent.

### Bold

Y or N

Y uses boldface type for the time character string; N uses plain type for the time character string.

### Concatenate

N

Field not available for this object.

---

### Analog Time Control

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Input</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Value</td>
<td>N/A</td>
<td>Not used for this object.</td>
</tr>
<tr>
<td>ADDR</td>
<td>virtual point address or STATIC</td>
<td>Address of virtual point to which object is linked. This point should be a virtual analog input point that allows a user to enter the time when a certain action should occur. Type STATIC in this field to have the object show the server’s time of day.</td>
</tr>
<tr>
<td>XLOC</td>
<td>integer</td>
<td>Horizontal position of object.</td>
</tr>
<tr>
<td>YLOC</td>
<td>integer</td>
<td>Vertical position of object.</td>
</tr>
<tr>
<td>TYPE</td>
<td>AO</td>
<td>Type of point this object can be linked to. AO = Analog Output.</td>
</tr>
<tr>
<td>OBJECT</td>
<td>CTRLTIME</td>
<td>Name of object.</td>
</tr>
<tr>
<td>showSeconds</td>
<td>Y or N</td>
<td>Y displays seconds; N turns off display.</td>
</tr>
<tr>
<td>showAMPM</td>
<td>Y or N</td>
<td>Y displays AM or PM; N turns off display.</td>
</tr>
<tr>
<td>INIT</td>
<td>N</td>
<td>Field not used for this object.</td>
</tr>
<tr>
<td>ALARM</td>
<td>N</td>
<td>Field not used for this object.</td>
</tr>
<tr>
<td>URL</td>
<td>N</td>
<td>Field not available for this object.</td>
</tr>
</tbody>
</table>
widthDim | integer | Width (horizontal size) of time control object; measured in pixels.

heightDim | integer | Height (vertical size) of time control object; measured in pixels.

insetX | integer | Left or right margin (depending on horizontal setting specified in justify) as measured from edge of object to text string (measured in pixels). If string is right aligned, this is the size of the right margin. For a left aligned string, this is the size of the left margin.

insetY | integer | Top or bottom margin (depending on vertical setting specified in justify) as measured from edge of object to text string (measured in pixels). If string is top aligned, this is the size of the top margin. For a bottom aligned string, this is the size of the bottom margin.

justify | two-character text string | Vertical and horizontal alignment of the time string with respect to the time control object; horizontal alignment is given first. Horizontal values: C = center; R = right; L = left. Vertical values: M = middle; T = top; B = bottom. (A value of CT would place the time character string in the center [horizontally] and top [vertically] of the object.).

textColor | color name or 6-character HEX string | Color of time character string.

backgroundColor | color name or 6-character HEX string | Background color of time control object.

drawBorder | Y or N | Y places a border around the time control object; N turns off border.

fontSize | integer | Font size (measured in points) to use for time character string.

fillBackground | Y or N | Y fills time control object with color indicated in backgroundColor; N makes the object appear transparent.

bold | Y or N | Y uses boldface type for the time character string; N uses plain type for the time character string.

concatenate | N | Field not available for this object.

**Analog Trend**

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Input</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Value</td>
<td>Valid analog value for corresponding point</td>
<td>Enter a valid analog value in this field to see how the object will appear when the corresponding point reaches that value.</td>
</tr>
<tr>
<td>ADDR</td>
<td>point address</td>
<td>Address of point to which object is linked</td>
</tr>
<tr>
<td>---------</td>
<td>---------------</td>
<td>------------------------------------------</td>
</tr>
<tr>
<td>XLOC</td>
<td>integer</td>
<td>Horizontal position of object</td>
</tr>
<tr>
<td>YLOC</td>
<td>integer</td>
<td>Vertical position of object</td>
</tr>
<tr>
<td>TYPE</td>
<td>AI</td>
<td>Type of point this object can be linked to. AI = Analog Input.</td>
</tr>
<tr>
<td>OBJECT</td>
<td>ATREND</td>
<td>Name of object.</td>
</tr>
<tr>
<td>lowLimit</td>
<td>floating decimal value</td>
<td>The lowest limit, including resolution, that you want the system to display. This can be the low engineering value of the point or some higher value depending on your needs.</td>
</tr>
<tr>
<td>highLimit</td>
<td>floating decimal value</td>
<td>The highest limit, including resolution, that you want the system to display. This can be the high engineering value of the point or some lower value depending on your needs.</td>
</tr>
<tr>
<td>minutes</td>
<td>integer</td>
<td>Data width; span of time (in minutes) over which you want to see data reported</td>
</tr>
<tr>
<td>color</td>
<td>color name or 6-character HEX string</td>
<td>Color of trend line</td>
</tr>
<tr>
<td>URL</td>
<td>N or valid URL address</td>
<td>If a URL address is entered, system is directed to open the specified custom screen or Web page when the object is clicked (http:// is assumed)</td>
</tr>
<tr>
<td>widthDim</td>
<td>integer</td>
<td>Width (horizontal size) of object; measured in pixels</td>
</tr>
<tr>
<td>heightDim</td>
<td>integer</td>
<td>Height (vertical size) of object; measured in pixels</td>
</tr>
<tr>
<td>smooth</td>
<td>Y or N</td>
<td>Y smooths the trend; changes are displayed in a more gradual manner. N turns off the smooth option.</td>
</tr>
</tbody>
</table>

### Digital Object Properties

This section provides information on the fields and options for the following objects, which are available from the Digital menu:

- **3D Rectangle**
- **4-State Graphic**
- **4-State Rectangle**
- **4-State Text**
- **Animation**
- **Arrow**
- **Control Rectangle**
- **Graphic**
Graphic Control

Oval

Rectangle

Round Rectangle

Switch

Text

Digital 3D Rectangle

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Input</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Value</td>
<td>0, 1, 0A, 1A</td>
<td>Enter a valid value in this field to see how the object will appear when its corresponding point is in the specified state. To see how the object will look when it is in alarm, type an A after the number.</td>
</tr>
<tr>
<td>ADDR</td>
<td>point address</td>
<td>Address of point to which object is linked</td>
</tr>
<tr>
<td>XLOC</td>
<td>integer</td>
<td>Horizontal position of object</td>
</tr>
<tr>
<td>YLOC</td>
<td>integer</td>
<td>Vertical position of object</td>
</tr>
<tr>
<td>TYPE</td>
<td>DI</td>
<td>Type of point this object can be linked to. DI = Digital Input.</td>
</tr>
<tr>
<td>OBJECT</td>
<td>AD3DRECT</td>
<td>Name of object.</td>
</tr>
<tr>
<td>ON (1)</td>
<td>label or N</td>
<td>Text to display during ON state; system automatically fills this field based on label configured for point. Enter N (uppercase) to turn off text display.</td>
</tr>
<tr>
<td>OFF (0)</td>
<td>label or N</td>
<td>Text to display during OFF state; system automatically fills this field based on label configured for point. Enter N (uppercase) to turn off text display.</td>
</tr>
<tr>
<td>onColor</td>
<td>color name or 6-character HEX string</td>
<td>Color of three-dimensional rectangle during ON state</td>
</tr>
<tr>
<td>offColor</td>
<td>color name or 6-character HEX string</td>
<td>Color of three-dimensional rectangle during OFF state</td>
</tr>
<tr>
<td>URL</td>
<td>N or valid URL address</td>
<td>If a URL address is entered, system is directed to open the specified custom screen or Web page when the object is clicked (http:// is assumed).</td>
</tr>
<tr>
<td>widthDim</td>
<td>integer</td>
<td>Width (horizontal size) of three-dimensional rectangle; measured in pixels</td>
</tr>
<tr>
<td>Field Name</td>
<td>Input</td>
<td>Description</td>
</tr>
<tr>
<td>-------------</td>
<td>---------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>heightDim</td>
<td>integer</td>
<td>Height (vertical size) of three-dimensional rectangle; measured in pixels</td>
</tr>
<tr>
<td>insetX</td>
<td>integer</td>
<td>Left or right margin (depending on horizontal setting specified in justify) as measured from edge of three-dimensional rectangle to label; measured in pixels</td>
</tr>
<tr>
<td>insetY</td>
<td>integer</td>
<td>Top or bottom margin (depending on vertical setting specified in justify) as measured from edge of three-dimensional rectangle to label; measured in pixels</td>
</tr>
<tr>
<td>justify</td>
<td>2-character string</td>
<td>Vertical and horizontal alignment of the label with respect to the three-dimensional rectangle; horizontal alignment is given first. Horizontal values: C = center; R = right; L = left. Vertical values: M = middle; T = top; B = bottom. (A value of CT would place the text in the center horizontally and top vertically of the object.)</td>
</tr>
<tr>
<td>borderColor</td>
<td>color name or 6-character HEX string</td>
<td>Color of three-dimensional rectangle's border</td>
</tr>
<tr>
<td>textColor</td>
<td>color name or 6-character HEX string</td>
<td>Color of text</td>
</tr>
<tr>
<td>drawBorder</td>
<td>Y or N</td>
<td>Y places a border around the three-dimensional rectangle; N turns off border</td>
</tr>
<tr>
<td>fontSize</td>
<td>integer</td>
<td>Font size to use for text</td>
</tr>
<tr>
<td>fillBackground</td>
<td>Y or N</td>
<td>Y fills three-dimensional rectangle with color specified in backgroundColor; N makes the object appear transparent</td>
</tr>
<tr>
<td>bold</td>
<td>Y or N</td>
<td>Y uses boldface type for the text; N uses plain type for the text</td>
</tr>
<tr>
<td>concatenate</td>
<td>N</td>
<td>Field not used for this object.</td>
</tr>
<tr>
<td>showText</td>
<td>Y or N</td>
<td>Y turns on text display; N turns off text display</td>
</tr>
<tr>
<td>borderWidth</td>
<td>integer</td>
<td>Width of border (in pixels)</td>
</tr>
<tr>
<td>drawRaised</td>
<td>Y or N</td>
<td>Y makes three-dimensional rectangle appear raised; N makes three-dimensional rectangle look lowered (depressed)</td>
</tr>
</tbody>
</table>
Value | 0, 1, 2, 3, 0A, 1A, 2A, 3A | Enter a valid value in this field to see how the object will appear when its corresponding point is in the specified state. To see how the object will look when it is in alarm, type an A after the number.

ADDR | point address | Address of point to which object is linked

XLOC | integer | Horizontal position of object

YLOC | integer | Vertical position of object

TYPE | DI | Type of point this object can be linked to. DI = Digital Input.

OBJECT | AD4IMAGE | Name of object.

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Input</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>image0</td>
<td>file name</td>
<td>Image to display during 0 (zero) state - .gif file is assumed; file must be available in the HT3 image library. N turns off image display.</td>
</tr>
<tr>
<td>image1</td>
<td>file name</td>
<td>Image to display during 1 (one) state - .gif file is assumed; file must be available in the HT3 image library. N turns off image display.</td>
</tr>
<tr>
<td>INIT</td>
<td>file name</td>
<td>Image to display during INIT state (point isn't offline, but doesn't yet have status) - .gif file is assumed; file must be available in the HT3 image library. N turns off image display.</td>
</tr>
<tr>
<td>ALARM</td>
<td>file name</td>
<td>Image to display during ALARM state - .gif file is assumed; file must be available in the HT3 image library. N turns off image display.</td>
</tr>
<tr>
<td>URL</td>
<td>N or valid URL address</td>
<td>If a URL address is entered, system is directed to open the specified custom screen or Web page when the object is clicked (http:// is assumed)</td>
</tr>
<tr>
<td>image2</td>
<td>file name</td>
<td>Image to display during two (2) state - .gif file is assumed; file must be available in the HT3 image library. N turns off image display.</td>
</tr>
<tr>
<td>image3</td>
<td>file name</td>
<td>Image to display during 3 (three) state - .gif file is assumed; file must be available in the HT3 image library. N turns off image display.</td>
</tr>
</tbody>
</table>

Digital 4-State Rectangle

Field Name | Input | Description |
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Value</td>
<td>0, 1, 2, 3, 0A, 1A, 2A, 3A</td>
<td>Enter a valid value in this field to see how the object will appear when its corresponding point is in the specified state. To see how the object will look when it is in alarm, type an A after the number.</td>
</tr>
<tr>
<td>ADDR</td>
<td>point address</td>
<td>Address of point to which object is linked</td>
</tr>
<tr>
<td>Field Name</td>
<td>Input</td>
<td>Description</td>
</tr>
<tr>
<td>------------</td>
<td>-------</td>
<td>-------------</td>
</tr>
<tr>
<td>XLOC</td>
<td>integer</td>
<td>Horizontal position of object</td>
</tr>
<tr>
<td>YLOC</td>
<td>integer</td>
<td>Vertical position of object</td>
</tr>
<tr>
<td>TYPE</td>
<td>DI</td>
<td>Type of point this object can be linked to. DI = Digital Input.</td>
</tr>
<tr>
<td>OBJECT</td>
<td>AD4RECT</td>
<td>Name of object.</td>
</tr>
<tr>
<td>color0</td>
<td>color name or 6-character HEX string</td>
<td>Color of 4-state rectangle during 0 (zero) state</td>
</tr>
<tr>
<td>color1</td>
<td>color name or 6-character HEX string</td>
<td>Color of 4-state rectangle during 1 (one) state</td>
</tr>
<tr>
<td>color2</td>
<td>color name or 6-character HEX string</td>
<td>Color of 4-state rectangle during 2 (two) state</td>
</tr>
<tr>
<td>color3</td>
<td>color name or 6-character HEX string</td>
<td>Color of 4-state rectangle during 3 (three) state</td>
</tr>
<tr>
<td>URL</td>
<td>N or valid URL address</td>
<td>If a URL address is entered, system is directed to open the specified custom screen or Web page when the object is clicked (http:// is assumed)</td>
</tr>
<tr>
<td>widthDim</td>
<td>integer</td>
<td>Width (horizontal size) of 4-state rectangle; measured in pixels</td>
</tr>
<tr>
<td>heightDim</td>
<td>integer</td>
<td>Height (vertical size) of 4-state rectangle; measured in pixels</td>
</tr>
<tr>
<td>borderWidth</td>
<td>integer</td>
<td>Width of border (in pixels)</td>
</tr>
<tr>
<td>drawRaised</td>
<td>Y or N</td>
<td>Y makes 4-state rectangle appear raised; N makes 4-state rectangle look lowered (depressed)</td>
</tr>
</tbody>
</table>

### Digital 4-State Text

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Input</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Value</td>
<td>0, 1, 2, 3</td>
<td>Enter a valid value in this field to see how the object will appear when its corresponding point is in the specified state. To see how the object will look when it is in alarm, type an A after the number.</td>
</tr>
<tr>
<td>ADDR</td>
<td>point address</td>
<td>Address of point to which object is linked</td>
</tr>
<tr>
<td>XLOC</td>
<td>integer</td>
<td>Horizontal position of object</td>
</tr>
<tr>
<td>YLOC</td>
<td>integer</td>
<td>Vertical position of object</td>
</tr>
<tr>
<td>TYPE</td>
<td>DI</td>
<td>Type of point this object can be linked to. DI = Digital Input.</td>
</tr>
<tr>
<td>OBJECT</td>
<td>AD4TEXT</td>
<td>Name of object.</td>
</tr>
<tr>
<td>label0</td>
<td>label</td>
<td>Text to display during 0 (zero) state</td>
</tr>
<tr>
<td>Field Name</td>
<td>Input</td>
<td>Description</td>
</tr>
<tr>
<td>------------</td>
<td>-------</td>
<td>-------------</td>
</tr>
<tr>
<td>label1</td>
<td>label</td>
<td>Text to display during 1 (one) state.</td>
</tr>
<tr>
<td>label2</td>
<td>label</td>
<td>Text to display during 2 (two) state</td>
</tr>
<tr>
<td>label3</td>
<td>label</td>
<td>Text to display during 3 (three) state</td>
</tr>
<tr>
<td>URL</td>
<td>N or valid URL address</td>
<td>If URL address is entered, system is directed to open the specified custom screen or Web page when the object is clicked (http:// is assumed)</td>
</tr>
<tr>
<td>widthDim</td>
<td>integer</td>
<td>Width (horizontal size) of 4-state text object; measured in pixels</td>
</tr>
<tr>
<td>heightDim</td>
<td>integer</td>
<td>Height (vertical size) of 4-state text object; measured in pixels</td>
</tr>
<tr>
<td>insetX</td>
<td>integer</td>
<td>Left or right margin (depending on horizontal setting specified in justify) as measured from edge of 4-state text object to label; measured in pixels</td>
</tr>
<tr>
<td>insetY</td>
<td>integer</td>
<td>Top or bottom margin (depending on vertical setting specified in justify) as measured from edge of 4-state text object to label; measured in pixels</td>
</tr>
<tr>
<td>justify</td>
<td>two-character text string</td>
<td>Vertical and horizontal alignment of the label with respect to the 4-state text object; horizontal alignment is given first. Horizontal values: C = center; R = right; L = left. Vertical values: M = middle; T = top; B = bottom. (A value of CT would place the text in the center [horizontally] and top [vertically] of the object.)</td>
</tr>
<tr>
<td>fontSize</td>
<td>integer</td>
<td>Font size to use for text</td>
</tr>
<tr>
<td>textColor</td>
<td>color name or 6-character HEX string</td>
<td>Color of text</td>
</tr>
<tr>
<td>bold</td>
<td>Y or N</td>
<td>Y uses boldface type for the text; N uses plain type for the text</td>
</tr>
</tbody>
</table>

**Digital Animation**

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Input</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Value</td>
<td>0, 1, 0A, 1A</td>
<td>Enter a valid value in this field to see how the object will appear when its corresponding point is in the specified state. To see how the object will look when it is in alarm, type an A after the number.</td>
</tr>
<tr>
<td>ADDR</td>
<td>point address</td>
<td>Address of point to which object is linked</td>
</tr>
<tr>
<td>XLOC</td>
<td>integer</td>
<td>Horizontal position of object</td>
</tr>
<tr>
<td>YLOC</td>
<td>integer</td>
<td>Vertical position of object</td>
</tr>
<tr>
<td>TYPE</td>
<td>DI</td>
<td>Description</td>
</tr>
<tr>
<td>--------</td>
<td>-------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>OBJECT</td>
<td>ANIMATE</td>
<td>Name of object.</td>
</tr>
<tr>
<td>ON</td>
<td>file name</td>
<td>Base image to display during ON state - .gif file is assumed; file must be available in the HT3 image library. Enter N to turn off image display.</td>
</tr>
<tr>
<td>OFF</td>
<td>color name or 6-character HEX string</td>
<td>Base image to display during OFF state - .gif file is assumed; file must be available in the HT3 image library. Enter N to turn off image display.</td>
</tr>
<tr>
<td>INIT**</td>
<td>color name or 6-character HEX string</td>
<td>Base image to display during initial state (point isn’t offline, but doesn’t yet have status - .gif file is assumed; file must be available in the HT3 image library. Enter N to turn off image display.</td>
</tr>
<tr>
<td>ALARM*</td>
<td>color name or 6-character HEX string</td>
<td>Base image to display during ALARM state - .gif file is assumed; file must be available in the HT3 image library. Enter N to turn off image display.</td>
</tr>
<tr>
<td>URL</td>
<td>N or valid URL address</td>
<td>If a URL address is entered, system is directed to open the specified custom screen or Web page when the object is clicked (http:// is assumed)</td>
</tr>
<tr>
<td>onFrames*</td>
<td>integer</td>
<td>Number of frames to use for ON state</td>
</tr>
<tr>
<td>offFrames*</td>
<td>integer</td>
<td>Number of frames to use for OFF state</td>
</tr>
<tr>
<td>alarmFrames*</td>
<td>integer</td>
<td>Number of frames to use for ALARM state</td>
</tr>
</tbody>
</table>

* The ON, OFF, and ALARM states require a base image name and a frame count. Each frame count is appended to the base image name to form the name of the image to draw in each frame. For example, if the ON state has a base image named "pump" and a frame count of 4, then the four images pump1.gif, pump2.gif, pump3.gif, and pump4.gif are used to create the animation for the ON state. All of these image files must be available in the HT3 image library. If the number of frames entered in these fields exceeds the number of files that exist, the system uses the files that are available and inserts a time delay for each file not available. In the above example, if a frame count of 6 was entered, the four "pump" images would be displayed and then there would be a length of time (a second or two) when the image was not visible on the screen.

**The INIT state is not animated.

### Digital Arrow

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Input</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Value</td>
<td>0, 1, 0A, 1A</td>
<td>Enter a valid value in this field to see how the object will appear when its corresponding point is in the specified state. To see how the object will look when it is in alarm, type an A after the number.</td>
</tr>
<tr>
<td>ADDR</td>
<td>point address</td>
<td>Address of point to which object is linked</td>
</tr>
<tr>
<td>XLOC</td>
<td>integer</td>
<td>Horizontal position of object</td>
</tr>
<tr>
<td>YLOC</td>
<td>integer</td>
<td>Vertical position of object</td>
</tr>
<tr>
<td>Field Name</td>
<td>Input</td>
<td>Description</td>
</tr>
<tr>
<td>------------</td>
<td>------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Value</td>
<td>0, 1, 0A, 1A</td>
<td>Enter a valid value in this field to see how the object will appear when its corresponding point is in the specified state. To see how the object will look when it is in alarm, type an A after the number.</td>
</tr>
<tr>
<td>ADDR</td>
<td>point address</td>
<td>Address of point to which object is linked</td>
</tr>
<tr>
<td>XLOC</td>
<td>integer</td>
<td>Horizontal position of object</td>
</tr>
<tr>
<td>YLOC</td>
<td>integer</td>
<td>Vertical position of object</td>
</tr>
<tr>
<td>TYPE</td>
<td>DO</td>
<td>Type of point this object can be linked to. DO = Digital Output.</td>
</tr>
<tr>
<td>OBJECT</td>
<td>DCTRLREC</td>
<td>Name of object.</td>
</tr>
</tbody>
</table>
| ON (1)     | label or N             | Text to display during ON state; system automatically fills this field based on label configured for point. Enter N (uppercase) to turn off text display.
<table>
<thead>
<tr>
<th>Field</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>OFF (0)</td>
<td>label or N</td>
<td>Text to display during OFF state; system automatically fills this field based on label configured for point. Enter N (uppercase) to turn off text display.</td>
</tr>
<tr>
<td>onColor</td>
<td>color name or 6-character HEX string</td>
<td>Color of rectangle in ON state</td>
</tr>
<tr>
<td>offColor</td>
<td>color name or 6-character HEX string</td>
<td>Color of rectangle in OFF state</td>
</tr>
<tr>
<td>URL</td>
<td>N</td>
<td>Not available for this object</td>
</tr>
<tr>
<td>widthDim</td>
<td>integer</td>
<td>Width (horizontal size) of control rectangle; measured in pixels</td>
</tr>
<tr>
<td>heightDim</td>
<td>integer</td>
<td>Height (vertical size) of control rectangle; measured in pixels</td>
</tr>
<tr>
<td>insetX</td>
<td>integer</td>
<td>Left or right margin (depending on horizontal setting specified in justify) as measured from edge of control rectangle to label; measured in pixels</td>
</tr>
<tr>
<td>insetY</td>
<td>integer</td>
<td>Top or bottom margin (depending on vertical setting specified in justify) as measured from edge of control rectangle to label; measured in pixels</td>
</tr>
<tr>
<td>justify</td>
<td>2-character string</td>
<td>Vertical and horizontal alignment of the label with respect to the control rectangle; horizontal alignment is given first. Horizontal values: C = center; R = right; L = left. Vertical values: M = middle; T = top; B = bottom. (A value of CT would place the text in the center [horizontally] and top [vertically] of the object.)</td>
</tr>
<tr>
<td>borderColor</td>
<td>color name or 6-character HEX string</td>
<td>Color of rectangle's border</td>
</tr>
<tr>
<td>textColor</td>
<td>color name or 6-character HEX string</td>
<td>Color of text</td>
</tr>
<tr>
<td>drawBorder</td>
<td>Y or N</td>
<td>Y places a border around the rectangle; N turns off border</td>
</tr>
<tr>
<td>fontSize</td>
<td>integer</td>
<td>Font size to use for text</td>
</tr>
<tr>
<td>fillBackground</td>
<td>Y or N</td>
<td>Y fills rectangle with color specified in onColor/offColor; N makes the object appear transparent</td>
</tr>
<tr>
<td>bold</td>
<td>Y or N</td>
<td>Y uses boldface type for the text; N uses plain type for the text</td>
</tr>
<tr>
<td>concatenate</td>
<td>N</td>
<td>Field not used for this object</td>
</tr>
<tr>
<td>showText</td>
<td>Y or N</td>
<td>Y turns on display of ON/OFF labels; N turns off display.</td>
</tr>
<tr>
<td>borderWidth</td>
<td>integer</td>
<td>Width of border (in pixels)</td>
</tr>
<tr>
<td>Field Name</td>
<td>Input</td>
<td>Description</td>
</tr>
<tr>
<td>-------------</td>
<td>------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>drawRaised</td>
<td>Y or N</td>
<td>Y makes control rectangle appear raised; N makes control rectangle look lowered (depressed)</td>
</tr>
<tr>
<td>PollAddr</td>
<td>Station + module address</td>
<td>Station and module address of the module to poll after a control is initiated. For example, 1025A to poll module A and station 1025.</td>
</tr>
<tr>
<td>PollDelay</td>
<td></td>
<td>Delay between when the control is initiated and the module is polled.</td>
</tr>
<tr>
<td>Value</td>
<td>0, 1, 0A, 1A</td>
<td>Enter a valid value in this field to see how the object will appear when its corresponding point is in the specified state. To see how the object will look when it is in alarm, type an A after the number.</td>
</tr>
<tr>
<td>ADDR</td>
<td>point address</td>
<td>Address of point to which object is linked</td>
</tr>
<tr>
<td>XLOC</td>
<td>integer</td>
<td>Horizontal position of object</td>
</tr>
<tr>
<td>YLOC</td>
<td>integer</td>
<td>Vertical position of object</td>
</tr>
<tr>
<td>TYPE</td>
<td>DI</td>
<td>Type of point this object can be linked to. DI = Digital Input.</td>
</tr>
<tr>
<td>OBJECT</td>
<td>DIGITAL</td>
<td>Name of object.</td>
</tr>
<tr>
<td>ON (1)</td>
<td>file name or N</td>
<td>Image to display during ON state - .gif file is assumed; file must be available in the HT3 image library. N turns off image display.</td>
</tr>
<tr>
<td>OFF (0)</td>
<td>file name or N</td>
<td>Image to display during OFF state - .gif file is assumed; file must be available in the HT3 image library. N turns off image display.</td>
</tr>
<tr>
<td>INIT</td>
<td>file name or N</td>
<td>Image to display during initial state (point isn't offline, but doesn't yet have status) - .gif file is assumed; file must be available in the HT3 image library. N turns off image display.</td>
</tr>
<tr>
<td>ALARM</td>
<td>file name or N</td>
<td>Image to display during ALARM state - .gif file is assumed; file must be available in the HT3 image library. N turns off image display.</td>
</tr>
<tr>
<td>URL</td>
<td>N or valid URL address</td>
<td>If a URL address is entered, system is directed to open the specified custom screen or Web page when the object is clicked (http:// is assumed).</td>
</tr>
<tr>
<td>onLabel</td>
<td>text or N</td>
<td>Text to display during ON state; N turns off text display</td>
</tr>
<tr>
<td>offLabel</td>
<td>text or N</td>
<td>Text to display during OFF state; N turns off text display</td>
</tr>
</tbody>
</table>
### Digital Graphic Control

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Input</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Value</td>
<td>0, 1, 0A, 1A</td>
<td>Enter a valid value in this field to see how the object will appear when its corresponding point is in the specified state. To see how the object will look when it is in alarm, type an A after the number.</td>
</tr>
<tr>
<td>ADDR</td>
<td>point address</td>
<td>Address of point to which object is linked</td>
</tr>
<tr>
<td>XLOC</td>
<td>integer</td>
<td>Horizontal position of object</td>
</tr>
<tr>
<td>YLOC</td>
<td>integer</td>
<td>Vertical position of object</td>
</tr>
<tr>
<td>TYPE</td>
<td>DO</td>
<td>Type of point this object can be linked to. DO = Digital Output.</td>
</tr>
<tr>
<td>OBJECT</td>
<td>DCONTROL</td>
<td>Name of object.</td>
</tr>
<tr>
<td>ON (1)</td>
<td>file name or N</td>
<td>Image to display during ON state - .gif file is assumed; file must be available in the HT3 image library. Enter N to turn off image display.</td>
</tr>
<tr>
<td>OFF (0)</td>
<td>file name or N</td>
<td>Image to display during OFF state - .gif file is assumed; file must be available in the HT3 image library. Enter N to turn off image display.</td>
</tr>
<tr>
<td>INIT</td>
<td>file name or N</td>
<td>Image to display during initial state (point isn't offline, but doesn't yet have status) - .gif file is assumed; file must be available in the HT3 image library. Enter N to turn off image display.</td>
</tr>
<tr>
<td>ALARM</td>
<td>file name or N</td>
<td>Image to display during ALARM state - .gif file is assumed; file must be available in the HT3 image library. Enter N to turn off image display.</td>
</tr>
<tr>
<td>URL</td>
<td>N</td>
<td>Not available for this object</td>
</tr>
<tr>
<td>onLabel</td>
<td>text or N</td>
<td>Text to display during ON state; enter N to turn off text display</td>
</tr>
<tr>
<td>offLabel</td>
<td>text or N</td>
<td>Text to display during OFF state; enter N to turn off text display</td>
</tr>
<tr>
<td>showText</td>
<td>Y or N</td>
<td>Y turns on display of ON/OFF label; N turns off display.</td>
</tr>
<tr>
<td>Field Name</td>
<td>Input</td>
<td>Description</td>
</tr>
<tr>
<td>---------------</td>
<td>----------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Value</td>
<td>0, 1, 0A, 1A</td>
<td>Enter a valid value in this field to see how the object will appear when its corresponding point is in the specified state. To see how the object will look when it is in alarm, type an A after the number.</td>
</tr>
<tr>
<td>ADDR</td>
<td>point address</td>
<td>Address of point to which object is linked</td>
</tr>
<tr>
<td>XLOC</td>
<td>integer</td>
<td>Horizontal position of object</td>
</tr>
<tr>
<td>YLOC</td>
<td>integer</td>
<td>Vertical position of object</td>
</tr>
<tr>
<td>TYPE</td>
<td>DI</td>
<td>Type of point this object can be linked to. DI = Digital Input.</td>
</tr>
<tr>
<td>OBJECT</td>
<td>ADOVAL</td>
<td>Name of object.</td>
</tr>
<tr>
<td>ON (1)</td>
<td>label or N</td>
<td>Text to display during ON state; system automatically fills this field based on label configured for point. Enter N (uppercase) to turn off text display.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
<td></td>
</tr>
<tr>
<td>--------------</td>
<td>-----------------------------------------------------------------------------</td>
<td></td>
</tr>
<tr>
<td>OFF (0)</td>
<td>label or N</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Text to display during OFF state; system automatically fills this field based on label configured for point. Enter N (uppercase) to turn off text display.</td>
<td></td>
</tr>
<tr>
<td>onColor</td>
<td>color name or 6-character HEX string</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Color of oval during ON state</td>
<td></td>
</tr>
<tr>
<td>offColor</td>
<td>color name or 6-character HEX string</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Color of oval during ON state</td>
<td></td>
</tr>
<tr>
<td>URL</td>
<td>N or valid URL address</td>
<td></td>
</tr>
<tr>
<td></td>
<td>If a URL address is entered, system is directed to open the specified custom screen or Web page when the object is clicked (http:// is assumed)</td>
<td></td>
</tr>
<tr>
<td>widthDim</td>
<td>integer</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Width (horizontal size) of oval; measured in pixels</td>
<td></td>
</tr>
<tr>
<td>heightDim</td>
<td>integer</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Height (vertical size) of oval; measured in pixels</td>
<td></td>
</tr>
<tr>
<td>insetX</td>
<td>integer</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Left or right margin (depending on horizontal setting specified in justify) as measured from edge of oval to label; measured in pixels</td>
<td></td>
</tr>
<tr>
<td>insetY</td>
<td>integer</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Top or bottom margin (depending on vertical setting specified in justify) as measured from edge of oval to label; measured in pixels</td>
<td></td>
</tr>
<tr>
<td>justify</td>
<td>2-character string</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Vertical and horizontal alignment of the label with respect to the oval; horizontal alignment is given first. Horizontal values: C = center; R = right; L = left. Vertical values: M = middle; T = top; B = bottom. (A value of CT would place the text in the center [horizontally] and top [vertically] of the object.)</td>
<td></td>
</tr>
<tr>
<td>borderColor</td>
<td>color name or 6-character HEX string</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Color of oval's border</td>
<td></td>
</tr>
<tr>
<td>textColor</td>
<td>color name or 6-character HEX string</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Color of text</td>
<td></td>
</tr>
<tr>
<td>drawBorder</td>
<td>Y or N</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Y places a border around the oval; N turns off border</td>
<td></td>
</tr>
<tr>
<td>fontSize</td>
<td>integer</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Font size to use for text</td>
<td></td>
</tr>
<tr>
<td>fillBackground</td>
<td>Y or N</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Y fills oval with color specified in backgroundColor; N makes the object transparent</td>
<td></td>
</tr>
<tr>
<td>bold</td>
<td>Y or N</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Y uses boldface type for the text; N uses plain type for the text</td>
<td></td>
</tr>
<tr>
<td>concatenate</td>
<td>N</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Field not used for this object.</td>
<td></td>
</tr>
<tr>
<td>showText</td>
<td>Y or N</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Y turns on text display; N turns off text display</td>
<td></td>
</tr>
<tr>
<td>borderWidth</td>
<td>integer</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Width of border (in pixels)</td>
<td></td>
</tr>
</tbody>
</table>
# Digital Rectangle

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Input</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Value</td>
<td>0, 1, 0A, 1A</td>
<td>Enter a valid value in this field to see how the object will appear when its corresponding point is in the specified state. To see how the object will look when it is in alarm, type an A after the number.</td>
</tr>
<tr>
<td>ADDR</td>
<td>point address</td>
<td>Address of point to which object is linked</td>
</tr>
<tr>
<td>XLOC</td>
<td>integer</td>
<td>Horizontal position of object</td>
</tr>
<tr>
<td>YLOC</td>
<td>integer</td>
<td>Vertical position of object</td>
</tr>
<tr>
<td>TYPE</td>
<td>DI</td>
<td>Type of point this object can be linked to. DI = Digital Input.</td>
</tr>
<tr>
<td>OBJECT</td>
<td>ADRECT</td>
<td>Name of object.</td>
</tr>
<tr>
<td>ON (1)</td>
<td>label or N</td>
<td>Text to display during ON state; system automatically fills this field based on label configured for point. Enter N (uppercase) to turn off text display.</td>
</tr>
<tr>
<td>OFF (0)</td>
<td>label or N</td>
<td>Text to display during OFF state; system automatically fills this field based on label configured for point. Enter N (uppercase) to turn off text display.</td>
</tr>
<tr>
<td>onColor</td>
<td>color name or 6-character HEX string</td>
<td>Color of rectangle during ON state</td>
</tr>
<tr>
<td>offColor</td>
<td>color name or 6-character HEX string</td>
<td>Color of rectangle during OFF state</td>
</tr>
<tr>
<td>URL</td>
<td>N or valid URL address</td>
<td>If a URL address is entered, system is directed to open the specified custom screen of Web page when the object is clicked (http:// is assumed).</td>
</tr>
<tr>
<td>widthDim</td>
<td>integer</td>
<td>Width (horizontal size) of rectangle; measured in pixels</td>
</tr>
<tr>
<td>heightDim</td>
<td>integer</td>
<td>Height (vertical size) of rectangle; measured in pixels</td>
</tr>
<tr>
<td>insetX</td>
<td>integer</td>
<td>Left or right margin (depending on horizontal setting specified in justify) as measured from edge of rectangle to label; measured in pixels</td>
</tr>
<tr>
<td>insetY</td>
<td>integer</td>
<td>Top or bottom margin (depending on vertical setting specified in justify) as measured from edge of rectangle to label; measured in pixels</td>
</tr>
<tr>
<td>Field Name</td>
<td>Input</td>
<td>Description</td>
</tr>
<tr>
<td>------------</td>
<td>--------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>justify</td>
<td>2-character string</td>
<td>Vertical and horizontal alignment of the label with respect to the rectangle; horizontal alignment is given first. Horizontal values: C = center; R = right; L = left. Vertical values: M = middle; T = top; B = bottom. (A value of CT would place the text in the center [horizontally] and top [vertically] of the object.)</td>
</tr>
<tr>
<td>borderColor</td>
<td>color name or 6-character HEX string</td>
<td>Color of rectangle's border</td>
</tr>
<tr>
<td>textColor</td>
<td>color name or 6-character HEX string</td>
<td>Color of text</td>
</tr>
<tr>
<td>drawBorder</td>
<td>Y or N</td>
<td>Y places a border around the rectangle; N turns off border</td>
</tr>
<tr>
<td>fontSize</td>
<td>integer</td>
<td>Font size to use for text</td>
</tr>
<tr>
<td>fillBackground</td>
<td>Y or N</td>
<td>Y fills rectangle with color specified in onColor/offColor; N makes the object appear transparent</td>
</tr>
<tr>
<td>bold</td>
<td>Y or N</td>
<td>Y uses boldface type for the text; N uses plain type for the text</td>
</tr>
<tr>
<td>concatenate</td>
<td>N</td>
<td>Field not used for this object.</td>
</tr>
<tr>
<td>showText</td>
<td>Y or N</td>
<td>Y turns on text display; N turns off text display</td>
</tr>
<tr>
<td>borderWidth</td>
<td>integer</td>
<td>Width of border (in pixels)</td>
</tr>
</tbody>
</table>

### Digital Round Rectangle

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Input</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Value</td>
<td>0, 1, 0A, 1A</td>
<td>Enter a valid value in this field to see how the object will appear when its corresponding point is in the specified state. To see how the object will look when it is in alarm, type an A after the number.</td>
</tr>
<tr>
<td>ADDR</td>
<td>point address</td>
<td>Address of point to which object is linked</td>
</tr>
<tr>
<td>XLOC</td>
<td>integer</td>
<td>Horizontal position of object</td>
</tr>
<tr>
<td>YLOC</td>
<td>integer</td>
<td>Vertical position of object</td>
</tr>
<tr>
<td>TYPE</td>
<td>DI</td>
<td>Type of point this object can be linked to. DI = Digital Input.</td>
</tr>
<tr>
<td>OBJECT</td>
<td>ADRRECT</td>
<td>Name of object.</td>
</tr>
<tr>
<td>ON (1)</td>
<td>label or N</td>
<td>Text to display during ON state; system automatically fills this field based on label configured for point. Enter N (uppercase) to turn off text display.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
<td></td>
</tr>
<tr>
<td>--------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
<td></td>
</tr>
<tr>
<td>OFF (0)</td>
<td>Text to display during OFF state; system automatically fills this field based on label configured for point. Enter N (uppercase) to turn off text display.</td>
<td></td>
</tr>
<tr>
<td>onColor</td>
<td>Color of rectangle during ON state</td>
<td></td>
</tr>
<tr>
<td>offColor</td>
<td>Color of rectangle during OFF state</td>
<td></td>
</tr>
<tr>
<td>URL</td>
<td>If a URL address is entered, system is directed to open the specified custom screen or Web page when the object is clicked (http:// is assumed)</td>
<td></td>
</tr>
<tr>
<td>widthDim</td>
<td>Width (horizontal size) of rectangle; measured in pixels</td>
<td></td>
</tr>
<tr>
<td>heightDim</td>
<td>Height (vertical size) of rectangle; measured in pixels</td>
<td></td>
</tr>
<tr>
<td>insetX</td>
<td>Left or right margin (depending on horizontal setting specified in justify) as measured from edge of rectangle to label; measured in pixels</td>
<td></td>
</tr>
<tr>
<td>insetY</td>
<td>Top or bottom margin (depending on vertical setting specified in justify) as measured from edge of rectangle to label; measured in pixels</td>
<td></td>
</tr>
<tr>
<td>justify</td>
<td>Vertical and horizontal alignment of the label with respect to the rectangle; horizontal alignment is given first. Horizontal values: C = center; R = right; L = left. Vertical values: M = middle; T = top; B = bottom. (A value of CT would place the text in the center [horizontally] and top [vertically] of the object.)</td>
<td></td>
</tr>
<tr>
<td>borderColor</td>
<td>Color of rectangle's border</td>
<td></td>
</tr>
<tr>
<td>textColor</td>
<td>Color of text</td>
<td></td>
</tr>
<tr>
<td>drawBorder</td>
<td>Y or N places a border around the rectangle; N turns off border</td>
<td></td>
</tr>
<tr>
<td>fontSize</td>
<td>Font size to use for text</td>
<td></td>
</tr>
<tr>
<td>fillBackground</td>
<td>Y or N fills rectangle with color specified in onColor/offColor; N makes the object appear transparent</td>
<td></td>
</tr>
<tr>
<td>bold</td>
<td>Y or N uses boldface type for the text; N uses plain type for the text</td>
<td></td>
</tr>
<tr>
<td>concatenate</td>
<td>N Field not used for this object.</td>
<td></td>
</tr>
<tr>
<td>showText</td>
<td>Y or N turns on text display; N turns off text display</td>
<td></td>
</tr>
<tr>
<td>borderWidth</td>
<td>Width of border (in pixels)</td>
<td></td>
</tr>
</tbody>
</table>
radius | integer | Larger numbers make the rectangle's corners appear rounder; the image is more circular. Smaller numbers make the rectangle's corners appear sharper; the image is more square.

Digital Switch

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Input</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Value</td>
<td>0, 1, 0A, 1A</td>
<td>Enter a valid value in this field to see how the object will appear when its corresponding point is in the specified state. To see how the object will look when it is in alarm, type an A after the number.</td>
</tr>
<tr>
<td>ADDR</td>
<td>point address</td>
<td>Address of point to which object is linked</td>
</tr>
<tr>
<td>XLOC</td>
<td>integer</td>
<td>Horizontal position of object</td>
</tr>
<tr>
<td>YLOC</td>
<td>integer</td>
<td>Vertical position of object</td>
</tr>
<tr>
<td>TYPE</td>
<td>DO</td>
<td>Type of point this object can be linked to. DO = Digital Output.</td>
</tr>
<tr>
<td>OBJECT</td>
<td>DSWITCH</td>
<td>Name of object.</td>
</tr>
<tr>
<td>switchType</td>
<td>ROCKER, LEVER, SLIDER</td>
<td>Type of switch to display</td>
</tr>
<tr>
<td>switchColor</td>
<td>color name or 6-character HEX string</td>
<td>Color of switch</td>
</tr>
<tr>
<td>drawBackground</td>
<td>Y or N</td>
<td>Y to draw switch's background; N for transparent background</td>
</tr>
<tr>
<td>borderColor</td>
<td>color name or 6-character HEX string</td>
<td>Color of switch's border (ROCKER switch only)</td>
</tr>
<tr>
<td>URL</td>
<td>N</td>
<td>Not available for this object</td>
</tr>
<tr>
<td>widthDim</td>
<td>integer</td>
<td>Width (horizontal size) of oval; measured in pixels</td>
</tr>
<tr>
<td>heightDim</td>
<td>integer</td>
<td>Height (vertical size) of oval; measured in pixels</td>
</tr>
<tr>
<td>drawLED</td>
<td>Y or N</td>
<td>Y to include an LED that changes color depending on the point's state; N to turn off LED display</td>
</tr>
<tr>
<td>onColor</td>
<td>color name or 6-character HEX string</td>
<td>Color of switch's LED during ON state</td>
</tr>
<tr>
<td>offColor</td>
<td>color name or 6-character HEX string</td>
<td>Color of switch's LED during OFF state</td>
</tr>
<tr>
<td>PollAddr</td>
<td>Station + module address</td>
<td>Station and module address of the module to poll after a control is initiated. For example, 1025A to poll module A and station 1025.</td>
</tr>
<tr>
<td>PollDelay</td>
<td></td>
<td>Delay between when control is initiated and module is polled.</td>
</tr>
</tbody>
</table>
## Digital Text

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Input</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Value</td>
<td>0, 1, 0A, 1A</td>
<td>Enter a valid value in this field to see how the object will appear when its corresponding point is in the specified state. To see how the object will look when it is in alarm, type an A after the number.</td>
</tr>
<tr>
<td>ADDR</td>
<td>point address</td>
<td>Address of point to which object is linked</td>
</tr>
<tr>
<td>XLOC</td>
<td>integer</td>
<td>Horizontal position of object</td>
</tr>
<tr>
<td>YLOC</td>
<td>integer</td>
<td>Vertical position of object</td>
</tr>
<tr>
<td>TYPE</td>
<td>DI</td>
<td>Type of point this object can be linked to. DI = Digital Input.</td>
</tr>
<tr>
<td>OBJECT</td>
<td>ADTEXT</td>
<td>Name of object.</td>
</tr>
<tr>
<td>ON (1)</td>
<td>label or N</td>
<td>Text to display during ON state; system automatically fills this field based on label configured for point. Enter N (uppercase) to turn off text display.</td>
</tr>
<tr>
<td>OFF (0)</td>
<td>label or N</td>
<td>Text to display during OFF state; system automatically fills this field based on label configured for point. Enter N (uppercase) to turn off text display.</td>
</tr>
<tr>
<td>INIT</td>
<td>N</td>
<td>Field not used for this object.</td>
</tr>
<tr>
<td>ALARM</td>
<td>N</td>
<td>Field not used for this object.</td>
</tr>
<tr>
<td>URL</td>
<td>N or valid URL address</td>
<td>If a URL address is entered, system is directed to open the specified custom screen or Web page when the object is clicked (http:// is assumed)</td>
</tr>
<tr>
<td>widthDim</td>
<td>integer</td>
<td>Width (horizontal size) of text object; measured in pixels</td>
</tr>
<tr>
<td>heightDim</td>
<td>integer</td>
<td>Height (vertical size) of text object; measured in pixels</td>
</tr>
<tr>
<td>insetX</td>
<td>integer</td>
<td>Left or right margin (depending on horizontal setting specified in justify) as measured from edge of text object to label; measured in pixels</td>
</tr>
<tr>
<td>insetY</td>
<td>integer</td>
<td>Top or bottom margin (depending on vertical setting specified in justify) as measured from edge of text object to label; measured in pixels</td>
</tr>
</tbody>
</table>
justify | two-character text string | Vertical and horizontal alignment of the label with respect to the text object; horizontal alignment is given first. Horizontal values: C = center; R = right; L = left. Vertical values: M = middle; T = top; B = bottom. (A value of CT would place the text in the center [horizontally] and top [vertically] of the object.)

textColor | color name or 6-character HEX string | Color of text

backgroundColor | color name or 6-character HEX string | Color of text object

drawBorder | Y or N | Y places a border around the text object; N turns off border

fontSize | integer | Font size to use for text

fillBackground | Y or N | Y fills text object with color specified in backgroundColor; N makes the object appear transparent

bold | Y or N | Y uses boldface type for the text; N uses plain type for the text

concatenate | N | Field not used for this object.

## Pipe Object Properties

This section provides information on the fields and options for the following objects, which are available from the Pipe menu:

- [Digital Elbow](#)
- [Digital Pipe](#)
- [Gradient Elbow (Static)](#)
- [Gradient Pipe (Digital)](#)
- [Spinner (Digital)](#)
- [Static Elbow](#)
- [Static Pipe](#)
- [Valve (Digital)](#)

## Digital Elbow

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Input</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Value</td>
<td>0 or 1</td>
<td>Enter a value in this field to see how the object will look when its corresponding point is in the specified state.</td>
</tr>
</tbody>
</table>
### ADDR
- **Description**: Address of point to which object is linked.

### XLOC
- **Type**: integer
- **Description**: Horizontal position of object.

### YLOC
- **Type**: integer
- **Description**: Vertical position of object.

### TYPE
- **Value**: DI
- **Description**: Type of point this object can be linked to. DI = Digital Input.

### OBJECT
- **Value**: ADELBO
- **Description**: Name of object.

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Input</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ADDR</td>
<td>point address</td>
<td>Address of point to which object is linked</td>
</tr>
<tr>
<td>XLOC</td>
<td>integer</td>
<td>Horizontal position of object</td>
</tr>
<tr>
<td>YLOC</td>
<td>integer</td>
<td>Vertical position of object</td>
</tr>
<tr>
<td>TYPE</td>
<td>DI</td>
<td>Type of point this object can be linked to. DI = Digital Input.</td>
</tr>
<tr>
<td>OBJECT</td>
<td>ADELBO</td>
<td>Name of object.</td>
</tr>
<tr>
<td>ON (1)</td>
<td>color name or 6-character HEX string</td>
<td>Color of pipe elbow's &quot;contents&quot; during ON state (color that appears in the center of the object)</td>
</tr>
<tr>
<td>OFF (0)</td>
<td>color name or 6-character HEX string</td>
<td>Color of pipe elbow's &quot;contents&quot; during OFF state (color that appears in the center of the object)</td>
</tr>
<tr>
<td>INIT</td>
<td>color name or 6-character HEX string</td>
<td>Color of pipe elbow's &quot;contents&quot; during initial state (point isn't offline, but doesn't yet have status) and ALARM state (color that appears in the center of the object)</td>
</tr>
<tr>
<td>backgroundColor</td>
<td>color name or 6-character HEX string</td>
<td>Color of pipe</td>
</tr>
<tr>
<td>URL</td>
<td>N or valid URL address</td>
<td>If a URL address is entered, system is directed to open the specified custom screen or Web page when the object is clicked (http:// is assumed)</td>
</tr>
<tr>
<td>widthDim</td>
<td>integer</td>
<td>Width (horizontal size) of object; measured in pixels</td>
</tr>
<tr>
<td>heightDim</td>
<td>integer</td>
<td>Height (vertical size) of object; measured in pixels</td>
</tr>
<tr>
<td>diameter</td>
<td>integer</td>
<td>Diameter of pipe elbow</td>
</tr>
<tr>
<td>quadrant</td>
<td>SE, SW, NE, NW</td>
<td>Location of the elbow’s outside curve (SE=bottom right, SW=bottom left, NE=top right, NW=top left)</td>
</tr>
</tbody>
</table>

### Digital Pipe

#### Field Name
- **Value**: Enter a value in this field to see how the object will look when its corresponding point is in the specified state.

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Input</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ADDR</td>
<td>point address</td>
<td>Address of point to which object is linked</td>
</tr>
<tr>
<td>XLOC</td>
<td>integer</td>
<td>Horizontal position of object</td>
</tr>
<tr>
<td>YLOC</td>
<td>integer</td>
<td>Vertical position of object</td>
</tr>
<tr>
<td>TYPE</td>
<td>DI</td>
<td>Type of point this object can be linked to. DI = Digital Input.</td>
</tr>
<tr>
<td>OBJECT</td>
<td>ADPIPE</td>
<td>Name of object.</td>
</tr>
<tr>
<td>Field Name</td>
<td>Input</td>
<td>Description</td>
</tr>
<tr>
<td>------------</td>
<td>------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>ON (1)</td>
<td>color name or color name or 6-character HEX string</td>
<td>Color of pipe’s &quot;contents&quot; during ON state (color that appears in the center of the object)</td>
</tr>
<tr>
<td>OFF (0)</td>
<td>color name or color name or 6-character HEX string</td>
<td>Color of pipe’s &quot;contents&quot; during OFF state (color that appears in the center of the object)</td>
</tr>
<tr>
<td>INIT</td>
<td>color name or color name or 6-character HEX string</td>
<td>Color of pipe’s &quot;contents&quot; during initial (point isn’t offline, but doesn’t yet have status) and ALARM state (color that appears in the center of the object)</td>
</tr>
<tr>
<td>backgroundColor</td>
<td>color name or color name or 6-character HEX string</td>
<td>Color of pipe</td>
</tr>
<tr>
<td>URL</td>
<td>N or valid URL address</td>
<td>If a URL address is entered, system is directed to open the specified custom screen or Web page when the object is clicked (http:// is assumed)</td>
</tr>
<tr>
<td>widthDim</td>
<td>integer</td>
<td>Width (horizontal size) of object; measured in pixels</td>
</tr>
<tr>
<td>heightDim</td>
<td>integer</td>
<td>Height (vertical size) of object; measured in pixels</td>
</tr>
<tr>
<td>vertical</td>
<td>Y or N</td>
<td>Y to draw pipe vertically; N to draw it horizontally</td>
</tr>
<tr>
<td>northEast</td>
<td>Y or N</td>
<td>Y to draw a junction at the north (top) end if pipe is vertical; or at the east (left) end if pipe is horizontal</td>
</tr>
<tr>
<td>southWest</td>
<td>Y or N</td>
<td>Y to draw a junction at the south (bottom) end if pipe is vertical; or at the south (right) end if pipe is horizontal</td>
</tr>
</tbody>
</table>

**Gradient Elbow (Static)**

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Input</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Value</td>
<td>N/A</td>
<td>Not used for static objects.</td>
</tr>
<tr>
<td>ADDR</td>
<td>STATIC</td>
<td>Fixed field; input can’t be modified.</td>
</tr>
<tr>
<td>XLOC</td>
<td>integer</td>
<td>Horizontal position of object</td>
</tr>
<tr>
<td>YLOC</td>
<td>integer</td>
<td>Vertical position of object</td>
</tr>
<tr>
<td>TYPE</td>
<td>ST</td>
<td>Indicates that this object can’t be linked to a point. ST = Static.</td>
</tr>
<tr>
<td>OBJECT</td>
<td>GELBOW</td>
<td>Name of object.</td>
</tr>
<tr>
<td>ON (1)</td>
<td>N</td>
<td>Field not used for this object.</td>
</tr>
<tr>
<td>OFF (0)</td>
<td>N</td>
<td>Field not used for this object.</td>
</tr>
<tr>
<td>INIT</td>
<td>N</td>
<td>Field not used for this object.</td>
</tr>
<tr>
<td>ALARM</td>
<td>N</td>
<td>Field not used for this object.</td>
</tr>
<tr>
<td>URL</td>
<td>N or valid URL address</td>
<td>If a URL address is entered, system is directed to open the specified custom screen or Web page when the object is clicked (http:// is assumed)</td>
</tr>
</tbody>
</table>
widthDim  integer  Width (horizontal size) of text object; measured in pixels
heightDim integer  Height (vertical size) of text object; measured in pixels
foregroundColor color name or 6-character HEX string  Color of center, or bright, part of pipe
backgroundColor color name or 6-character HEX string  Color of outside, or dark, part of pipe
diameter integer  Diameter of pipe elbow
quadrant  SE, SW, NE, NW  Location of the elbow's outside curve (SE=bottom right, SW=bottom left, NE=top right, NW=top left)

Gradient Pipe (Digital)

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Input</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Value</td>
<td>0 or 1</td>
<td>Enter a value in this field to see how the object will look when its corresponding point is in the specified state.</td>
</tr>
<tr>
<td>ADDR</td>
<td>point address</td>
<td>Address of point to which object is linked</td>
</tr>
<tr>
<td>XLOC</td>
<td>integer</td>
<td>Horizontal position of object</td>
</tr>
<tr>
<td>YLOC</td>
<td>integer</td>
<td>Vertical position of object</td>
</tr>
<tr>
<td>TYPE</td>
<td>DI</td>
<td>Type of point this object can be linked to. DI = Digital Input.</td>
</tr>
<tr>
<td>OBJECT</td>
<td>ANIMPIPE</td>
<td>Name of object.</td>
</tr>
<tr>
<td>ON (1)</td>
<td>N</td>
<td>Field not used for this object.</td>
</tr>
<tr>
<td>foregroundColor</td>
<td>color name or 6-character HEX string</td>
<td>Color of center, or bright, part of pipe</td>
</tr>
<tr>
<td>backgroundColor</td>
<td>color name or 6-character HEX string</td>
<td>Color of outside, or dark, part of pipe</td>
</tr>
<tr>
<td>arrowColor</td>
<td>color name or 6-character HEX string</td>
<td>Color of pipe's animated arrows</td>
</tr>
<tr>
<td>URL</td>
<td>N or valid URL address</td>
<td>If a URL address is entered, system is directed to open the specified custom screen or Web page when the object is clicked (http:// is assumed)</td>
</tr>
<tr>
<td>widthDim</td>
<td>integer</td>
<td>Width (horizontal size) of text object; measured in pixels</td>
</tr>
<tr>
<td>heightDim</td>
<td>integer</td>
<td>Height (vertical size) of text object; measured in pixels</td>
</tr>
<tr>
<td>showAnimation</td>
<td>Y or N</td>
<td>Y displays animated arrows (if object is linked to a point) or static arrows (if object is not linked to a point); N displays static arrows (if object is linked to a point) or no arrows (if object is not linked to a point)</td>
</tr>
<tr>
<td>Field Name</td>
<td>Input</td>
<td>Description</td>
</tr>
<tr>
<td>------------</td>
<td>-------</td>
<td>-------------</td>
</tr>
<tr>
<td>Value</td>
<td>0, 1, 0A, 1A</td>
<td>Enter a value in this field to see how the object will look when its corresponding point is in the specified state. Add an A after the value (for example, 1A) to see how the object will look when the point is in alarm.</td>
</tr>
<tr>
<td>ADDR</td>
<td>point address</td>
<td>Address of point to which object is linked</td>
</tr>
<tr>
<td>XLOC</td>
<td>integer</td>
<td>Horizontal position of object</td>
</tr>
<tr>
<td>YLOC</td>
<td>integer</td>
<td>Vertical position of object</td>
</tr>
<tr>
<td>TYPE</td>
<td>DI</td>
<td>Type of point this object can be linked to. DI = Digital Input.</td>
</tr>
<tr>
<td>OBJECT</td>
<td>SPINNER</td>
<td>Name of object.</td>
</tr>
<tr>
<td>ON (1)</td>
<td>color name or 6-character HEX string</td>
<td>Color of spinner during ON state</td>
</tr>
<tr>
<td>OFF (0)</td>
<td>color name or 6-character HEX string</td>
<td>Color of spinner during OFF state</td>
</tr>
<tr>
<td>INIT</td>
<td>color name or 6-character HEX string</td>
<td>Color of spinner during initial state (point isn’t offline, but doesn’t yet have status)</td>
</tr>
</tbody>
</table>

### Orientation of Pipe
- **vertical:** Y or N
  - Orientation of pipe; Y orients the pipe vertically; N orients the pipe horizontally

### Direction
- **direction:** Y or N
  - Direction that arrows point and move when animated; Y for arrows that move left or down (depending on pipe's orientation); N for arrows that move right or up

### Size and Characteristics of Arrows
- **arrowType:** S, L, or T
  - Size and characteristics of arrows; S for short arrows without tails; L for long arrows without tails; T for short arrows with tails

### Display of "Off" Arrows
- **offArrow:** Y or N
  - If object is linked to a point and **animateArrows** is enabled, Y displays "off" arrows (arrows that are a darker shade of the color specified in **arrowColor**) between the animated arrows when the point is on and static "off" arrows when point is off.
  - If object is linked to a point and **animateArrows** is disabled, "off" arrows (static) are only displayed when point is off.
  - If object is not linked to a point (STATIC), Y displays "off" arrows between the animated arrows.
  - N turns off display of "off" arrows (object linked to point or STATIC)
### Static Elbow

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Input</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Value</td>
<td>N/A</td>
<td>Not used with static objects.</td>
</tr>
<tr>
<td>ADDR</td>
<td>STATIC</td>
<td>Fixed field; input can't be modified.</td>
</tr>
<tr>
<td>XLOC</td>
<td>integer</td>
<td>Horizontal position of object</td>
</tr>
<tr>
<td>YLOC</td>
<td>integer</td>
<td>Vertical position of object</td>
</tr>
<tr>
<td>TYPE</td>
<td>ST</td>
<td>Indicates that this object can't be linked to a point. ST = Static.</td>
</tr>
<tr>
<td>OBJECT</td>
<td>ELBOW</td>
<td>Name of object.</td>
</tr>
<tr>
<td>ON (1)</td>
<td>N</td>
<td>Field not used for this object.</td>
</tr>
<tr>
<td>OFF (0)</td>
<td>N</td>
<td>Field not used for this object.</td>
</tr>
<tr>
<td>INIT</td>
<td>N</td>
<td>Field not used for this object.</td>
</tr>
<tr>
<td>ALARM</td>
<td>N</td>
<td>Field not used for this object.</td>
</tr>
<tr>
<td>URL</td>
<td>N or valid URL address</td>
<td>If a URL address is entered, system is directed to open the specified custom screen or Web page when the object is clicked (http:// is assumed)</td>
</tr>
<tr>
<td>widthDim</td>
<td>integer</td>
<td>Width (horizontal size) of text object; measured in pixels</td>
</tr>
<tr>
<td>heightDim</td>
<td>integer</td>
<td>Height (vertical size) of text object; measured in pixels</td>
</tr>
</tbody>
</table>
### Static Pipe

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Input</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Value</td>
<td>N/A</td>
<td>Not used with static objects.</td>
</tr>
<tr>
<td>ADDR</td>
<td>STATIC</td>
<td>Fixed field; input can't be modified.</td>
</tr>
<tr>
<td>XLOC</td>
<td>integer</td>
<td>Horizontal position of object.</td>
</tr>
<tr>
<td>YLOC</td>
<td>integer</td>
<td>Vertical position of object.</td>
</tr>
<tr>
<td>TYPE</td>
<td>ST</td>
<td>Indicates that this object can't be linked to a point. ST = Static.</td>
</tr>
<tr>
<td>OBJECT</td>
<td>SPIPE</td>
<td>Name of object. Fixed field; input can't be modified</td>
</tr>
<tr>
<td>ON (1)</td>
<td>N</td>
<td>Field not used for this object.</td>
</tr>
<tr>
<td>OFF (0)</td>
<td>N</td>
<td>Field not used for this object.</td>
</tr>
<tr>
<td>INIT</td>
<td>N</td>
<td>Field not used for this object.</td>
</tr>
<tr>
<td>ALARM</td>
<td>N</td>
<td>Field not used for this object.</td>
</tr>
<tr>
<td>URL</td>
<td>N or valid URL address</td>
<td>If a URL address is entered, system is directed to open the specified custom screen or Web page when the object is clicked (http:// is assumed).</td>
</tr>
<tr>
<td>widthDim</td>
<td>integer</td>
<td>Width (horizontal size) of object; measured in pixels.</td>
</tr>
<tr>
<td>heightDim</td>
<td>integer</td>
<td>Height (vertical size) of object; measured in pixels.</td>
</tr>
<tr>
<td>foregroundColor</td>
<td>color name or 6-character HEX string</td>
<td>Color of pipe's &quot;contents&quot; (color that appears in the center of the object)</td>
</tr>
<tr>
<td>backgroundColor</td>
<td>color name or 6-character HEX string</td>
<td>Color of the shaded portion of the pipe.</td>
</tr>
<tr>
<td>vertical</td>
<td>Y or N</td>
<td>Y to draw pipe vertically; N to leave horizontally.</td>
</tr>
<tr>
<td>northEast</td>
<td>Y or N</td>
<td>Y to draw a junction at the north (top) end if pipe is vertical or at the east (left) end if pipe is horizontal; type N for a pipe without a junction.</td>
</tr>
<tr>
<td>southWest</td>
<td>Y or N</td>
<td>Y to draw a junction at the south (bottom) end if pipe is vertical or at the south (right) end if pipe is horizontal; type N for a pipe without a junction.</td>
</tr>
</tbody>
</table>
Valve (Digital)

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Input</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Value</td>
<td>0 or 1</td>
<td>Enter a value in this field to see how the object will look when its corresponding point is in the specified state.</td>
</tr>
<tr>
<td>ADDR</td>
<td>point address</td>
<td>Address of point to which object is linked</td>
</tr>
<tr>
<td>XLOC</td>
<td>integer</td>
<td>Horizontal position of object</td>
</tr>
<tr>
<td>YLOC</td>
<td>integer</td>
<td>Vertical position of object</td>
</tr>
<tr>
<td>TYPE</td>
<td>DI</td>
<td>Type of point this object can be linked to. DI = Digital Input.</td>
</tr>
<tr>
<td>OBJECT</td>
<td>DVALVE</td>
<td>Name of object.</td>
</tr>
<tr>
<td>vertical</td>
<td>Y or N</td>
<td>Orientation of pipe; Y orients the pipe vertically; N orients the pipe horizontally</td>
</tr>
<tr>
<td>drawHandle</td>
<td>Y or N</td>
<td>Y draws a handle on the valve; N draws a valve without a handle</td>
</tr>
<tr>
<td>drawBorder</td>
<td>Y or N</td>
<td>Y draws a border around the valve; N draws a valve without a border</td>
</tr>
<tr>
<td>borderColor</td>
<td>color name or 6-character HEX string</td>
<td>Color of valve's border (drawBorder must be set to Y)</td>
</tr>
<tr>
<td>URL</td>
<td>N or valid URL address</td>
<td>If a URL address is entered, system is directed to open the specified custom screen or Web page when the object is clicked (http:// is assumed)</td>
</tr>
<tr>
<td>widthDim</td>
<td>integer</td>
<td>Width (horizontal size) of valve; measured in pixels</td>
</tr>
<tr>
<td>heightDim</td>
<td>integer</td>
<td>Height (vertical size) of valve; measured in pixels</td>
</tr>
<tr>
<td>onColor</td>
<td>color name or 6-character HEX string</td>
<td>Color of valve when point is in the ON state</td>
</tr>
<tr>
<td>offColor</td>
<td>color name or 6-character HEX string</td>
<td>Color of valve when point is in the OFF state</td>
</tr>
</tbody>
</table>

Static Object Properties

This section provides information on the fields and options for the following objects, which are available from the Static menu:

- 3D Rectangle
- 3D Text
- Banner Text
- Gradient Object
- Grid
Image

Oval

Pattern Object

Rectangle

Resizable Image

Round Rectangle

Text

Tick Mark

3D Rectangle

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Input</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Value</td>
<td>N/A</td>
<td>Not used for static objects.</td>
</tr>
<tr>
<td>ADDR</td>
<td>STATIC</td>
<td>Fixed field; input can't be modified.</td>
</tr>
<tr>
<td>XLOC</td>
<td>integer</td>
<td>Horizontal position of object.</td>
</tr>
<tr>
<td>YLOC</td>
<td>integer</td>
<td>Vertical position of object.</td>
</tr>
<tr>
<td>TYPE</td>
<td>ST</td>
<td>Indicates that this object can't be linked to a point. ST = Static.</td>
</tr>
<tr>
<td>OBJECT</td>
<td>S3DRECT</td>
<td>Name of object.</td>
</tr>
<tr>
<td>ON (1)</td>
<td>N</td>
<td>Field not used for this object.</td>
</tr>
<tr>
<td>OFF (0)</td>
<td>N</td>
<td>Field not used for this object.</td>
</tr>
<tr>
<td>INIT</td>
<td>N</td>
<td>Field not used for this object.</td>
</tr>
<tr>
<td>ALARM</td>
<td>N</td>
<td>Field not used for this object.</td>
</tr>
<tr>
<td>URL</td>
<td>N or valid URL address</td>
<td>If a URL address is entered, system is directed to open the specified custom screen or Web page when the object is clicked (http:// is assumed).</td>
</tr>
<tr>
<td>widthDim</td>
<td>integer</td>
<td>Width (horizontal size) of three-dimensional rectangle; measured in pixels.</td>
</tr>
<tr>
<td>heightDim</td>
<td>integer</td>
<td>Height (vertical size) of three-dimensional rectangle; measured in pixels.</td>
</tr>
<tr>
<td>borderWidth</td>
<td>integer</td>
<td>Width of border (in pixels).</td>
</tr>
<tr>
<td>borderColor</td>
<td>color name or 6-character HEX string</td>
<td>Color of three-dimensional rectangle's border.</td>
</tr>
<tr>
<td>backgroundColor</td>
<td>color name or 6-character HEX string</td>
<td>Color of three-dimensional rectangle.</td>
</tr>
<tr>
<td>Field Name</td>
<td>Input</td>
<td>Description</td>
</tr>
<tr>
<td>---------------</td>
<td>----------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Value</td>
<td>N/A</td>
<td>Not used for static points.</td>
</tr>
<tr>
<td>ADDR</td>
<td>STATIC</td>
<td>Fixed field; input can’t be modified.</td>
</tr>
<tr>
<td>XLOC</td>
<td>integer</td>
<td>Horizontal position of object.</td>
</tr>
<tr>
<td>YLOC</td>
<td>integer</td>
<td>Vertical position of object.</td>
</tr>
</tbody>
</table>
| TYPE          | ST             | Indicates that this object can’t be linked to a point.  
ST = Static.                           |
<p>| OBJECT        | S3DTEXT        | Name of object.                                                            |
| line 1        | text string    | First label to display in text object. Can accommodate up to 12 characters.|
| line 2        | text string    | Second label to display in text object. Can accommodate up to 12 characters.|
| line 3        | text string    | Third label to display in text object. Can accommodate up to 12 characters.|
| line 4        | text string    | Fourth label to display in text object. Can accommodate up to 12 characters.|
| URL           | N or valid URL address | If a URL address is entered, system is directed to open the specified custom screen or Web page when the object is clicked (http:// is assumed). |
| widthDim      | integer        | Width (horizontal size) of three-dimensional rectangle; measured in pixels. |
| heightDim     | integer        | Height (vertical size) of three-dimensional rectangle; measured in pixels.  |
| insetX        | integer        | Left or right margin (depending on the horizontal setting specified in justify) as measured from edge of text object to label; measured in pixels. |
| insetY        | integer        | Top or bottom margin (depending on the vertical setting specified in justify) as measured from edge of text object to label; measured in pixels. |</p>
<table>
<thead>
<tr>
<th>Field Name</th>
<th>Input</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Value</td>
<td>N/A</td>
<td>Not used for static objects.</td>
</tr>
<tr>
<td>ADDR</td>
<td>STATIC</td>
<td>Fixed field; input can't be modified.</td>
</tr>
<tr>
<td>XLOC</td>
<td>integer</td>
<td>Horizontal position of object.</td>
</tr>
<tr>
<td>YLOC</td>
<td>integer</td>
<td>Vertical position of object.</td>
</tr>
<tr>
<td>TYPE</td>
<td>ST</td>
<td>Indicates that this object can't be linked to a point. ST = Static.</td>
</tr>
<tr>
<td>OBJECT</td>
<td>MATRLED</td>
<td>Name of object.</td>
</tr>
<tr>
<td>LEDcolor</td>
<td>color name or 6-character HEX string</td>
<td>Color of banner's LEDs</td>
</tr>
</tbody>
</table>
### Gradient Object

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Input</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Value</td>
<td>N/A</td>
<td>Not used for static objects.</td>
</tr>
<tr>
<td>ADDR</td>
<td>STATIC</td>
<td>Fixed field; input can’t be modified.</td>
</tr>
<tr>
<td>XLOC</td>
<td>integer</td>
<td>Horizontal position of object.</td>
</tr>
<tr>
<td>YLOC</td>
<td>integer</td>
<td>Vertical position of object.</td>
</tr>
<tr>
<td>TYPE</td>
<td>ST</td>
<td>Indicates that this object can’t be linked to a point. ST = Static.</td>
</tr>
<tr>
<td>OBJECT</td>
<td>GRADIENT</td>
<td>Name of object.</td>
</tr>
<tr>
<td>fillRectangle</td>
<td>Y or N</td>
<td>Option to fill gradient from center out to edges; Y enables this option; N</td>
</tr>
<tr>
<td></td>
<td></td>
<td>disables the option and causes object to use either the direction specified</td>
</tr>
<tr>
<td></td>
<td></td>
<td>in the direction field, or to use the fillOval option.</td>
</tr>
<tr>
<td>fillOval</td>
<td>Y or N</td>
<td>Option to make object circular and fill from center out to edges; Y enables</td>
</tr>
<tr>
<td></td>
<td></td>
<td>this option; N disables the option and causes object to use either the</td>
</tr>
<tr>
<td></td>
<td></td>
<td>direction specified in the direction field, or to use the fillRectangle</td>
</tr>
<tr>
<td></td>
<td></td>
<td>option.</td>
</tr>
<tr>
<td>INIT</td>
<td>N</td>
<td>Field not used for this object.</td>
</tr>
<tr>
<td>ALARM</td>
<td>N</td>
<td>Field not used for this object.</td>
</tr>
<tr>
<td>URL</td>
<td>N or valid URL address</td>
<td>If a URL address is entered, system is directed to open the specified custom screen or Web page when the object is clicked (http:// is assumed).</td>
</tr>
<tr>
<td>widthDim</td>
<td>integer</td>
<td>Width (horizontal size) of oval; measured in pixels.</td>
</tr>
<tr>
<td>heightDim</td>
<td>integer</td>
<td>Height (vertical size) of oval; measured in pixels.</td>
</tr>
</tbody>
</table>
direction | N, S, E, W, NE, NW, SE, SW | Direction of object's color shift; the startColor begins at the opposite coordinate and gradually changes to the endColor in the direction specified here; this setting has no affect if fillRectangle or fillOval have been enabled.

endColor | color name or 6-character HEX string | Ending color of object's color shift.

startColor | color name or 6-character HEX string | Starting, or initial, color of object's color shift.

**Grid**

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Input</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Value</td>
<td>N/A</td>
<td>Not used for this object.</td>
</tr>
<tr>
<td>ADDR</td>
<td>STATIC</td>
<td>Fixed field; input can't be modified.</td>
</tr>
<tr>
<td>XLOC</td>
<td>integer</td>
<td>Horizontal position of object.</td>
</tr>
<tr>
<td>YLOC</td>
<td>integer</td>
<td>Vertical position of object.</td>
</tr>
<tr>
<td>TYPE</td>
<td>ST</td>
<td>Indicates that this object can't be linked to a point. ST = Static.</td>
</tr>
<tr>
<td>OBJECT</td>
<td>SGRID</td>
<td>Name of object.</td>
</tr>
<tr>
<td>horizontal</td>
<td>integer</td>
<td>Number of horizontal grid segments (not grid lines).</td>
</tr>
<tr>
<td>vertical</td>
<td>integer</td>
<td>Number of vertical grid segments (not grid lines).</td>
</tr>
<tr>
<td>limitLine1</td>
<td>integer (0-100)</td>
<td>Distance (in percentage) limitLine1 is from grid's lower edge.</td>
</tr>
<tr>
<td>limitLine2</td>
<td>integer (0-100)</td>
<td>Distance (in percentage) limitLine2 is from grid's lower edge.</td>
</tr>
<tr>
<td>URL</td>
<td>N or valid URL address</td>
<td>If a URL address is entered, system is directed to open the specified custom screen or Web page when the object is clicked (http:// is assumed).</td>
</tr>
<tr>
<td>widthDim</td>
<td>integer</td>
<td>Width (horizontal size) of grid; measured in pixels.</td>
</tr>
<tr>
<td>heightDim</td>
<td>integer</td>
<td>Height (vertical size) of grid; measured in pixels.</td>
</tr>
<tr>
<td>borderWidth</td>
<td>integer</td>
<td>Width of border (in pixels).</td>
</tr>
<tr>
<td>borderColor</td>
<td>color name or 6-character HEX string</td>
<td>Color of grid's border.</td>
</tr>
<tr>
<td>backgroundColor</td>
<td>color name or 6-character HEX string</td>
<td>Color of grid.</td>
</tr>
<tr>
<td>fillBackground</td>
<td>Y or N</td>
<td>Y fills grid with color specified in backgroundColor; N makes the grid's background transparent.</td>
</tr>
<tr>
<td>Field Name</td>
<td>Input</td>
<td>Description</td>
</tr>
<tr>
<td>------------</td>
<td>-------</td>
<td>-------------</td>
</tr>
<tr>
<td>Value</td>
<td>N/A</td>
<td>Not used for static objects.</td>
</tr>
<tr>
<td>ADDR</td>
<td>STATIC</td>
<td>Fixed field; input can't be modified.</td>
</tr>
<tr>
<td>XLOC</td>
<td>integer</td>
<td>Horizontal position of object.</td>
</tr>
<tr>
<td>YLOC</td>
<td>integer</td>
<td>Vertical position of object.</td>
</tr>
<tr>
<td>TYPE</td>
<td>ST</td>
<td>Indicates that this object can't be linked to a point. ST = Static.</td>
</tr>
<tr>
<td>OBJECT</td>
<td>IMAGE</td>
<td>Name of object.</td>
</tr>
<tr>
<td>ON (1)</td>
<td>N</td>
<td>Field not used for this object.</td>
</tr>
<tr>
<td>refresh</td>
<td>integer</td>
<td>Rate (in seconds) at which a snapshot from a network camera is updated. Leave at default value of 0 when not adding a camera image.</td>
</tr>
<tr>
<td>image</td>
<td>file name or N</td>
<td>File name of image to display (.gif file is assumed). File must be available in the HT3 image library. Enter an N in this field when adding a snapshot from a network camera.</td>
</tr>
<tr>
<td>camera</td>
<td>camera name or N</td>
<td>User-defined name of network camera. Leave at default value (N) when not adding a camera snapshot.</td>
</tr>
<tr>
<td>URL</td>
<td>N or valid URL address</td>
<td>If a URL address is entered, system is directed to open the specified custom screen or Web page when the object is clicked (http:// is assumed).</td>
</tr>
<tr>
<td>remote</td>
<td>N or valid URL address</td>
<td>Allows the addition of an image file that is located in a remote location (on a computer other than the Hyper Server Module). <strong>Note</strong>: Requires change to Java policy file; contact DFS for more information.</td>
</tr>
</tbody>
</table>
Oval

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Input</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Value</td>
<td>N/A</td>
<td>Not used for static objects.</td>
</tr>
<tr>
<td>ADDR</td>
<td>STATIC</td>
<td>Fixed field; input can't be modified.</td>
</tr>
<tr>
<td>XLOC</td>
<td>integer</td>
<td>Horizontal position of object.</td>
</tr>
<tr>
<td>YLOC</td>
<td>integer</td>
<td>Vertical position of object.</td>
</tr>
<tr>
<td>TYPE</td>
<td>ST</td>
<td>Indicates that this object can't be linked to a point. ST = Static.</td>
</tr>
<tr>
<td>OBJECT</td>
<td>SOVAL</td>
<td>Name of object.</td>
</tr>
<tr>
<td>ON (1)</td>
<td>N</td>
<td>Field not used for this object.</td>
</tr>
<tr>
<td>OFF (0)</td>
<td>N</td>
<td>Field not used for this object.</td>
</tr>
<tr>
<td>INIT</td>
<td>N</td>
<td>Field not used for this object.</td>
</tr>
<tr>
<td>ALARM</td>
<td>N</td>
<td>Field not used for this object.</td>
</tr>
<tr>
<td>URL</td>
<td>N or valid URL address</td>
<td>If a URL address is entered, system is directed to open the specified custom screen or Web page when the object is clicked (http:// is assumed).</td>
</tr>
<tr>
<td>widthDim</td>
<td>integer</td>
<td>Width (horizontal size) of oval; measured in pixels.</td>
</tr>
<tr>
<td>heightDim</td>
<td>integer</td>
<td>Height (vertical size) of oval; measured in pixels.</td>
</tr>
<tr>
<td>borderWidth</td>
<td>integer</td>
<td>Width of border (in pixels).</td>
</tr>
<tr>
<td>borderColor</td>
<td>color name or 6-character HEX string</td>
<td>Color of oval's border.</td>
</tr>
<tr>
<td>backgroundColor</td>
<td>color name or 6-character HEX string</td>
<td>Color of oval.</td>
</tr>
<tr>
<td>fillBackground</td>
<td>Y or N</td>
<td>Y fills oval with color specified in backgroundColor; N makes the object transparent.</td>
</tr>
<tr>
<td>drawBorder</td>
<td>Y or N</td>
<td>Y places a border around the oval; N turns off border.</td>
</tr>
</tbody>
</table>

Pattern

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Input</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Value</td>
<td>N/A</td>
<td>Not used for static objects.</td>
</tr>
<tr>
<td>ADDR</td>
<td>STATIC</td>
<td>Fixed field; input can't be modified.</td>
</tr>
<tr>
<td><strong>XLOC</strong></td>
<td>integer</td>
<td>Horizontal position of object.</td>
</tr>
<tr>
<td>----------</td>
<td>----------</td>
<td>-------------------------------</td>
</tr>
<tr>
<td><strong>YLOC</strong></td>
<td>integer</td>
<td>Vertical position of object.</td>
</tr>
<tr>
<td><strong>TYPE</strong></td>
<td>ST</td>
<td>Indicates that this object can’t be linked to a point. ST = Static.</td>
</tr>
<tr>
<td><strong>OBJECT</strong></td>
<td>PATTERN</td>
<td>Name of object.</td>
</tr>
<tr>
<td>patternType</td>
<td>CHECKER, BRICK, SAND, GRASS, DIAMOND, STEEL, RAIN, EARTH</td>
<td>Pattern’s design. Type the name of the desired pattern in this field (CHECKER, BRICK, SAND, GRASS, DIAMOND, STEEL, RAIN, or EARTH).</td>
</tr>
<tr>
<td>patternSize</td>
<td>integer</td>
<td>Controls the size of the pattern's features; a larger number increases the size of the individual rain drops, bricks, sand particles, etc; a smaller number decreases their size.</td>
</tr>
<tr>
<td>patternSpacing</td>
<td>integer</td>
<td>Controls the spacing between the pattern's features; a larger number increases the space between the individual rain drops, bricks, sand particles, etc; a smaller number makes the features appear closer together.</td>
</tr>
<tr>
<td>backgroundColor</td>
<td>color name or 6-character HEX string</td>
<td>Background color of the object. For the BRICK pattern, this is the color of the mortar between the bricks.</td>
</tr>
<tr>
<td>URL</td>
<td>N or valid URL address</td>
<td>If a URL address is entered, system is directed to open the specified custom screen or Web page when the object is clicked (http:// is assumed).</td>
</tr>
<tr>
<td>widthDim</td>
<td>integer</td>
<td>Width (horizontal size) of object; measured in pixels.</td>
</tr>
<tr>
<td>heightDim</td>
<td>integer</td>
<td>Height (vertical size) of object; measured in pixels.</td>
</tr>
<tr>
<td>foregroundColor</td>
<td>color name or 6-character HEX string</td>
<td>Color of the object's features (for example, the rain drops, particles of sand, blades of grass)</td>
</tr>
<tr>
<td>color2</td>
<td>N</td>
<td>Field not used for this object; leave at default value of N</td>
</tr>
<tr>
<td>angle</td>
<td>integer between 0 and 360</td>
<td>Angle of the object's features; used to make rain drops display at a slant or make bricks vertical instead of horizontal</td>
</tr>
<tr>
<td>animate</td>
<td>Y or N</td>
<td>Used with RAIN and SAND patterns only; when set to Y, rain appears as if it is falling and sand appears as if it is being blown in the wind (animation is only visible when screen is viewed in Custom Screen Viewer unless you select Animate from the Screen menu).</td>
</tr>
</tbody>
</table>
### Rectangle

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Input</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Value</td>
<td>N/A</td>
<td>Not used for static objects.</td>
</tr>
<tr>
<td>ADDR</td>
<td>STATIC</td>
<td>Fixed field; input can't be modified.</td>
</tr>
<tr>
<td>XLOC</td>
<td>integer</td>
<td>Horizontal position of object.</td>
</tr>
<tr>
<td>YLOC</td>
<td>integer</td>
<td>Vertical position of object.</td>
</tr>
<tr>
<td>TYPE</td>
<td>ST</td>
<td>Indicates that this object can't be linked to a point. ST = Static.</td>
</tr>
<tr>
<td>OBJECT</td>
<td>SRECT</td>
<td>Name of object.</td>
</tr>
<tr>
<td>ON (1)</td>
<td>N</td>
<td>Field not used for this object.</td>
</tr>
<tr>
<td>OFF (0)</td>
<td>N</td>
<td>Field not used for this object.</td>
</tr>
<tr>
<td>INIT</td>
<td>N</td>
<td>Field not used for this object.</td>
</tr>
<tr>
<td>ALARM</td>
<td>N</td>
<td>Field not used for this object.</td>
</tr>
<tr>
<td>URL</td>
<td>N or valid URL address</td>
<td>If a URL address is entered, system is directed to open the specified custom screen or Web page when the object is clicked (http:// is assumed).</td>
</tr>
<tr>
<td>widthDim</td>
<td>integer</td>
<td>Width (horizontal size) of rectangle; measured in pixels.</td>
</tr>
<tr>
<td>heightDim</td>
<td>integer</td>
<td>Height (vertical size) of rectangle; measured in pixels.</td>
</tr>
<tr>
<td>borderWidth</td>
<td>integer</td>
<td>Width of border (in pixels).</td>
</tr>
<tr>
<td>borderColor</td>
<td>color name or 6-character HEX string</td>
<td>Color of rectangle's border.</td>
</tr>
<tr>
<td>backgroundColor</td>
<td>color name or 6-character HEX string</td>
<td>Color of rectangle.</td>
</tr>
<tr>
<td>fillBackground</td>
<td>Y or N</td>
<td>Y fills rectangle with color specified in backgroundColor; N makes the object transparent.</td>
</tr>
<tr>
<td>drawBorder</td>
<td>Y or N</td>
<td>Y places a border around the rectangle; N turns off border.</td>
</tr>
</tbody>
</table>

### Resizable Image

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Input</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Value</td>
<td>N/A</td>
<td>Not used for static objects.</td>
</tr>
<tr>
<td>ADDR</td>
<td>STATIC</td>
<td>Fixed field; input can’t be modified.</td>
</tr>
<tr>
<td>--------</td>
<td>---------</td>
<td>-------------------------------------</td>
</tr>
<tr>
<td>XLOC</td>
<td>integer</td>
<td>Horizontal position of object.</td>
</tr>
<tr>
<td>YLOC</td>
<td>integer</td>
<td>Vertical position of object.</td>
</tr>
<tr>
<td>TYPE</td>
<td>ST</td>
<td>Indicates that this object can’t be linked to a point. ST = Static.</td>
</tr>
<tr>
<td>OBJECT</td>
<td>IMAGE_M</td>
<td>Name of object.</td>
</tr>
<tr>
<td>refresh</td>
<td>integer</td>
<td>Rate (in seconds) at which a snapshot from a network camera is updated. Leave at default value of 0 when not adding a camera image.</td>
</tr>
<tr>
<td>image</td>
<td>file name or N</td>
<td>File name of image to display (.gif file is assumed - .jpg and .png files also supported). File must be available in the HT3 image library. Enter an N in this field when adding a snapshot from a network camera.</td>
</tr>
<tr>
<td>camera</td>
<td>camera name or N</td>
<td>User-defined name of network camera. Leave at default value (N) when not adding a camera snapshot.</td>
</tr>
<tr>
<td>URL</td>
<td>N or valid URL address</td>
<td>If a URL address is entered, system is directed to open the specified custom screen or Web page when the object is clicked (http:// is assumed).</td>
</tr>
<tr>
<td>remote</td>
<td>N or valid URL address</td>
<td>Allows the addition of an image file that is located in a remote location (on a computer other than the Hyper Server Module). Note: Requires change to Java policy file; contact DFS for more information.</td>
</tr>
<tr>
<td>widthDim</td>
<td>integer</td>
<td>Width of image measured in pixels.</td>
</tr>
<tr>
<td>heightDim</td>
<td>integer</td>
<td>Height of image measured in pixels.</td>
</tr>
<tr>
<td>constrain</td>
<td>Y/N</td>
<td>Used to constrain the proportions of an image when it is being resized using a handle on the bounding box.</td>
</tr>
<tr>
<td>rotate</td>
<td>integer between 0 and 360</td>
<td>Rotates the image by the number of degrees entered.</td>
</tr>
<tr>
<td>invertV</td>
<td>Y/N</td>
<td>Y flips the image vertically; N keeps the image in its natural orientation.</td>
</tr>
<tr>
<td>invertH</td>
<td>Y/N</td>
<td>Y flips the image horizontally; N keeps the image in its natural orientation.</td>
</tr>
<tr>
<td>alpha</td>
<td>integer between 0 and 100</td>
<td>Changes the transparency/opacity of the image. Smaller values make the image more transparent.</td>
</tr>
<tr>
<td>fcolor</td>
<td>color name or 6-character HEX string</td>
<td>Overlays the image with a colored filter. The default for this field is black, which displays the image in its natural state.</td>
</tr>
<tr>
<td>sheax</td>
<td>integer or decimal value</td>
<td>Skew the image along the X-axis. Values between 0.1 and 1.0 give the best results.</td>
</tr>
<tr>
<td>Field Name</td>
<td>Input</td>
<td>Description</td>
</tr>
<tr>
<td>------------</td>
<td>---------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Value</td>
<td>N/A</td>
<td>Not used for static objects.</td>
</tr>
<tr>
<td>ADDR</td>
<td>STATIC</td>
<td>Fixed field; input can't be modified.</td>
</tr>
<tr>
<td>XLOC</td>
<td>integer</td>
<td>Horizontal position of object.</td>
</tr>
<tr>
<td>YLOC</td>
<td>integer</td>
<td>Vertical position of object.</td>
</tr>
<tr>
<td>TYPE</td>
<td>ST</td>
<td>Indicates that this object can't be linked to a point. ST = Static.</td>
</tr>
<tr>
<td>OBJECT</td>
<td>SRRECT</td>
<td>Name of object.</td>
</tr>
<tr>
<td>ON (1)</td>
<td>N</td>
<td>Field not used for this object.</td>
</tr>
<tr>
<td>OFF (0)</td>
<td>N</td>
<td>Field not used for this object.</td>
</tr>
<tr>
<td>INIT</td>
<td>N</td>
<td>Field not used for this object.</td>
</tr>
<tr>
<td>ALARM</td>
<td>N</td>
<td>Field not used for this object.</td>
</tr>
<tr>
<td>URL</td>
<td>N or valid URL address</td>
<td>If a URL address is entered, system is directed to open the specified custom screen or Web page when the object is clicked (http:// is assumed).</td>
</tr>
<tr>
<td>widthDim</td>
<td>integer</td>
<td>Width (horizontal size) of round rectangle; measured in pixels.</td>
</tr>
<tr>
<td>heightDim</td>
<td>integer</td>
<td>Height (vertical size) of round rectangle; measured in pixels.</td>
</tr>
<tr>
<td>borderWidth</td>
<td>integer</td>
<td>Width of border (in pixels).</td>
</tr>
<tr>
<td>borderColor</td>
<td>color name or 6-character HEX string</td>
<td>Color of round rectangle's border.</td>
</tr>
<tr>
<td>backgroundColor</td>
<td>color name or 6-character HEX string</td>
<td>Color of round rectangle.</td>
</tr>
<tr>
<td>fillBackground</td>
<td>Y or N</td>
<td>Y fills round rectangle with color specified in <strong>backgroundColor</strong>; N makes the object transparent.</td>
</tr>
<tr>
<td>----------------</td>
<td>--------</td>
<td>------------------------------------------------------------------</td>
</tr>
<tr>
<td>drawBorder</td>
<td>Y or N</td>
<td>Y places a border around the round rectangle; N turns off border.</td>
</tr>
<tr>
<td>radius</td>
<td>integer</td>
<td>Larger numbers make the rectangle's corners appear rounder; the image is more circular. Smaller numbers make the rectangle's corners appear sharper; the image is more square.</td>
</tr>
</tbody>
</table>

### Text

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Input</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Value</td>
<td>N/A</td>
<td>Not used for static points</td>
</tr>
<tr>
<td>ADDR</td>
<td>STATIC</td>
<td>Fixed field; input can't be modified.</td>
</tr>
<tr>
<td>XLOC</td>
<td>integer</td>
<td>Horizontal position of object.</td>
</tr>
<tr>
<td>YLOC</td>
<td>integer</td>
<td>Vertical position of object.</td>
</tr>
<tr>
<td>TYPE</td>
<td>ST</td>
<td>Indicates that object is static, e.g., it isn't linked to active point. Fixed field; input can't be modified.</td>
</tr>
<tr>
<td>OBJECT</td>
<td>STEXT</td>
<td>Name of object.</td>
</tr>
<tr>
<td>line 1</td>
<td>text string</td>
<td>First label to display in text object. Can accommodate up to 12 characters.</td>
</tr>
<tr>
<td>line 2</td>
<td>text string</td>
<td>Second label to display in text object. Can accommodate up to 12 characters.</td>
</tr>
<tr>
<td>line 3</td>
<td>text string</td>
<td>Third label to display in text object. Can accommodate up to 12 characters.</td>
</tr>
<tr>
<td>line 4</td>
<td>text string</td>
<td>Fourth label to display in text object. Can accommodate up to 12 characters.</td>
</tr>
<tr>
<td>URL</td>
<td>N or valid URL address</td>
<td>If a URL address is entered, system is directed to open the specified custom screen or Web page when the object is clicked (http:// is assumed).</td>
</tr>
<tr>
<td>widthDim</td>
<td>integer</td>
<td>Width (horizontal size) of text object; measured in pixels.</td>
</tr>
<tr>
<td>heightDim</td>
<td>integer</td>
<td>Height (vertical size) of text object; measured in pixels.</td>
</tr>
<tr>
<td>insetX</td>
<td>integer</td>
<td>Left or right margin (depending on the horizontal setting specified in <strong>justify</strong>) as measured from edge of text object to label; measured in pixels.</td>
</tr>
<tr>
<td>insetY</td>
<td>integer</td>
<td>Top or bottom margin (depending on the vertical setting specified in <strong>justify</strong>) as measured from edge of text object to label; measured in pixels.</td>
</tr>
<tr>
<td>Field Name</td>
<td>Input</td>
<td>Description</td>
</tr>
<tr>
<td>------------------</td>
<td>-----------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>justify</td>
<td>2-character text string</td>
<td>Vertical and horizontal alignment of the label with respect to the text object; horizontal alignment is given first. Horizontal values: C = center; R = right; L = left. Vertical values: M = middle; T = top; B = bottom. (A value of CT would place the text in the center [horizontally] and top [vertically] of the object.)</td>
</tr>
<tr>
<td>textColor</td>
<td>color name or 6-character HEX string</td>
<td>Color of text.</td>
</tr>
<tr>
<td>backgroundColor</td>
<td>color name or 6-character HEX string</td>
<td>Color of text object.</td>
</tr>
<tr>
<td>drawBorder</td>
<td>Y or N</td>
<td>Y places a border around the text object; N turns off border.</td>
</tr>
<tr>
<td>fontSize</td>
<td>integer</td>
<td>Font size to use for text.</td>
</tr>
<tr>
<td>fillBackground</td>
<td>Y or N</td>
<td>Y fills text object with color specified in backgroundColor; N makes the object transparent.</td>
</tr>
<tr>
<td>bold</td>
<td>Y or N</td>
<td>Y uses boldface type for the text; N uses plain type for the text.</td>
</tr>
<tr>
<td>concatenate</td>
<td>Y or N</td>
<td>Y links the text strings in line 1 - line 4 to form one line of text; N places text in lines 1 - line 4 on separate lines.</td>
</tr>
</tbody>
</table>

**Tick Mark**

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Input</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Value</td>
<td>N/A</td>
<td>Not used for static objects.</td>
</tr>
<tr>
<td>ADDR</td>
<td>STATIC</td>
<td>Fixed field; input can’t be modified.</td>
</tr>
<tr>
<td>XLOC</td>
<td>integer</td>
<td>Horizontal position of object.</td>
</tr>
<tr>
<td>YLOC</td>
<td>integer</td>
<td>Vertical position of object.</td>
</tr>
<tr>
<td>TYPE</td>
<td>ST</td>
<td>Indicates that this object can’t be linked to a point. ST = Static.</td>
</tr>
<tr>
<td>OBJECT</td>
<td>TICKMARK</td>
<td>Name of object.</td>
</tr>
<tr>
<td>ON (1)</td>
<td>N</td>
<td>Field not used for this object.</td>
</tr>
<tr>
<td>OFF (0)</td>
<td>N</td>
<td>Field not used for this object.</td>
</tr>
<tr>
<td>image</td>
<td>file name</td>
<td>File name of image to display (.gif file is assumed). File must be available in the HT3 image library.</td>
</tr>
<tr>
<td>ALARM</td>
<td>N</td>
<td>Field not used for this object.</td>
</tr>
<tr>
<td>URL</td>
<td>N or valid URL address</td>
<td>If a URL address is entered, system is directed to open the specified custom screen or Web page when the object is clicked (http:// is assumed).</td>
</tr>
<tr>
<td>-----</td>
<td>------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>widthDim</td>
<td>integer</td>
<td>Width (horizontal size) of object; measured in pixels.</td>
</tr>
<tr>
<td>heightDim</td>
<td>integer</td>
<td>Height (vertical size) of object; measured in pixels.</td>
</tr>
<tr>
<td>tickColor</td>
<td>color name or 6-character HEX string</td>
<td>Color of tick marks.</td>
</tr>
<tr>
<td>stagger</td>
<td>Y or N</td>
<td>Y draws tick marks in staggered lengths; N draws tick marks in equal lengths.</td>
</tr>
<tr>
<td>segments</td>
<td>4, 8, 10, or 16</td>
<td>Number of segments (tick marks) on object.</td>
</tr>
<tr>
<td>direction</td>
<td>L, R, T, B</td>
<td>Direction from which tick marks are drawn. L = tick marks point right; R = tick marks point left; T = tick marks point down; B = tick marks point up.</td>
</tr>
</tbody>
</table>
RGB Color Guide

Use this chart to choose colors for your Screen Builder objects.

Keyboard Shortcuts

The table below lists keyboard shortcuts and a description of their functions. Print out this page to use as a quick reference guide.

The plus (+) sign indicates the keys must be pressed at the same time. Press and continue to hold down the first key listed and then press the next listed key(s).
<table>
<thead>
<tr>
<th>Keyboard Shortcut</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>CTRL + J</td>
<td>to Back - move selected item to the back (bottom) of stack</td>
</tr>
<tr>
<td>CTRL + K</td>
<td>Backward - move selected item back one layer</td>
</tr>
<tr>
<td>CTRL + B</td>
<td>Bottom - align the selected object(s) vertically along the bottom edge of the reference object</td>
</tr>
<tr>
<td>CTRL + N</td>
<td>Center - align the selected object(s) horizontally in the center of the reference object</td>
</tr>
<tr>
<td>CTRL + C</td>
<td>Copy the selected text and place it on the clipboard</td>
</tr>
<tr>
<td>CTRL + X</td>
<td>Cut (remove) the selected text and place it on the clipboard</td>
</tr>
<tr>
<td>Backspace key</td>
<td>Delete selected text or object</td>
</tr>
<tr>
<td>CTRL + D</td>
<td>Duplicate the selected item</td>
</tr>
<tr>
<td>CTRL + Q</td>
<td>Exit Screen Builder</td>
</tr>
<tr>
<td>CTRL + F</td>
<td>Forward - move selected item forward one layer</td>
</tr>
<tr>
<td>CTRL + G</td>
<td>to Front - move selected item to the front (top) of stack</td>
</tr>
<tr>
<td>CTRL + L</td>
<td>Left - align the selected object(s) horizontally along the left edge of the reference object</td>
</tr>
<tr>
<td>CTRL + M</td>
<td>Middle - align the selected object(s) vertically in the middle of the reference object</td>
</tr>
<tr>
<td>CTRL + O</td>
<td>Open an existing file</td>
</tr>
<tr>
<td>CTRL + V</td>
<td>Paste text from clipboard to new location</td>
</tr>
<tr>
<td>CTRL + Y</td>
<td>Remove the selected custom screen from the HT3 server</td>
</tr>
<tr>
<td>CTRL + R</td>
<td>Right - align the selected object(s) horizontally along the right edge of the reference object</td>
</tr>
<tr>
<td>CTRL + S</td>
<td>Save the current file</td>
</tr>
<tr>
<td>CTRL + H</td>
<td>Select Behind - select the object located directly behind the currently selected object</td>
</tr>
<tr>
<td>CTRL + T</td>
<td>Top - align the selected object(s) vertically along the top edge of the reference object</td>
</tr>
<tr>
<td>CTRL + Z</td>
<td>Undo the last action performed</td>
</tr>
</tbody>
</table>
Part IX
9 Virtual Logic Builder

Virtual Logic Builder is a user-friendly application that enables you to construct "ladder logic"-style programs that run on the HT3 central computer. Ladder logic is a graphical (symbols and text) language that is used to plan, maintain and control industrial systems. Each rung of the ladder (hence the name - Ladder Logic) is used to control a single output. (An example of a simple ladder logic program is shown below.)

The ladder logic diagrams - built using groups of rungs and branches - are programs you create to manage complex control functions. These graphical programs are converted into virtual points and auto control points, and are continuously scanned by the system - HT3 is scheduled to complete one program scan every second. The speed of the scanning process enables you to have the most up-to-date information, which, in turn, allows you to react to situations quickly and efficiently.

- Introduction and Overview
- Getting Around Virtual Logic Builder
- Ladder Building Components
- Working with Ladders
- Working with Objects
- Editing Tools
- Appendix
Virtual Logic Builder is a user-friendly application that enables you to construct "ladder logic"-style programs that run on the HT3 central computer. Ladder logic is a graphical (symbols and text) language that is used to plan, maintain and control industrial systems. Each rung of the ladder (hence the name - Ladder Logic) is used to control a single output. (An example of a simple ladder logic program is shown below.)

The ladder logic diagrams - built using groups of rungs and branches - are programs you create to manage complex control functions. These graphical programs are converted into virtual points and auto control points, and are continuously scanned by the system - HT3 is scheduled to complete one program scan every second. The speed of the scanning process enables you to have the most up-to-date information, which, in turn, allows you to react to situations quickly and efficiently.

In traditional ladder logic, the values that flow along rungs and branches are strictly logical, 0 or 1. DFS's Virtual Logic Builder provides the extra flexibility of allowing rungs and branches to hold numeric values, including inputs from analog points and the results of math operations, such as ADD and MAXIMUM.

After a ladder logic program has been built and installed, you can use its virtual points and auto controls in custom screens - graphical representations of your telemetry system that can be used to remotely monitor and control your system. (See the Screen Builder User Guide for more information on building custom screens.)

Example - Ladder Logic Program that Starts a Pump

![Diagram of a ladder logic program that starts a pump]
Opening Virtual Logic Builder

Note: To save ladder logic programs, you must be logged in to HT3 with an account that has Configure Ladder Logic permission. See "Configuring Your System: User Accounts” in the HT3 User Guide for more information on permissions.

1. Click Build on the main HT3 menu.
2. Click Logic on the Build submenu. Logic Builder opens in a new browser window.

Exiting Virtual Logic Builder

To close Virtual Logic Builder, select Close from the File menu.

If the current file has unsaved changes, a dialog box with the message "[file name].vlb not saved. Discard changes?" opens.

- If you want to save the changes to the current file, click Cancel, save your changes, and then quit the program.
- If you don't want to save the changes, click Discard. Any changes made to the current file are lost and Virtual Logic Builder closes.
Getting Around Virtual Logic Builder

See also: Opening Virtual Logic Builder; Exiting Virtual Logic Builder

Before you begin using Virtual Logic Builder, it is helpful to familiarize yourself with the application’s graphical user interface (GUI). The sections listed below describe the components that make up Virtual Logic Builder's GUI - its menus and menu commands, the building area and the Message bar.

➢ The User Interface
➢ Inspector
➢ Menus
  ▪ Analog Menu
  ▪ Compare Menu
  ▪ Digital Menu
  ▪ Edit Menu
  ▪ File Menu
  ▪ Help Menu
  ▪ Ladder Menu
  ▪ Math Menu
  ▪ Module Menu
  ▪ Time/Date Menu

The User Interface

The basic components of Virtual Logic Builder’s GUI (shown below) are:

➢ Menu Bar - Features nine menus with commands. These commands are used to build, test, save and install your virtual ladder logic programs. See Menus for more information.

➢ Building Area - Area where you build your virtual logic programs. When you start Virtual Logic Builder, an empty ladder - represented by two vertical rails, one each on the left and right side of the building area - is displayed.

➢ Message Bar - Displays messages, such as prompting messages and error messages, that provide you with additional information and instructions on Virtual Logic Builder functions. See Message Bar for more information.

➢ Inspector - Displays the selected object's properties. To open Inspector, right click the object, or click the object and then choose Properties from the Edit menu. See Inspector for more information.
Virtual Logic Builder's Inspector

Inspector (shown below) displays the selected object's properties. Inspector's fields change depending upon the type of object selected. See Definition of Inspector Fields for more information on each parameter.

Inspector's left column lists the field names and its right column shows the field's current value. Some input fields, for example, OPER are not editable. Inspector also features a message bar (located at the bottom of the Inspector window). Place your cursor in an input field to view information on the selected field.

To open Inspector:

Right click an object; or select the object and then choose Properties from the Edit menu.

Editing

Inspector features its own editing menu that can be accessed by placing your cursor in one of Inspector's fields and clicking the right mouse button.
Selecting Points to Associate with an Object

Inspector's ADDR button can be used to browse to the point that you want to associate with an object. Note that this method is only available to Examine objects (Digital Examine On, Digital Examine Off, Examine Analog) and control objects (Digital Out, Digital Out Not, Analog Out).

1. Click the ADDR button.

2. Browse to the point you want to use and click OK.

An error message will appear at the bottom of the Inspector window if an analog point is selected for a digital input (Examine On or Off), a digital point is selected for an analog input (Examine Analog), or an input point is selected for an output function.

For more information on using Inspector to define and edit an object's properties, see Working with Objects: Defining and Editing an Object's Properties.

For instructions on how to change an object's name and address without using Inspector, see Shortcut for Changing an Object's Name or Telemetry Address.

Definition of Inspector Fields

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>OPER</td>
<td>Name of selected operator. This field cannot be modified; it is for reference purposes only.</td>
</tr>
<tr>
<td>ADDR</td>
<td>Telemetry address to associate with selected object. For control objects, ADDR would be the destination address - the address to which this object's output is sent.</td>
</tr>
<tr>
<td>NAME</td>
<td>Text string that describes, or names, the selected object. This field cannot be left blank.</td>
</tr>
<tr>
<td>0/UNITES</td>
<td>For digital points, this is the label to display during 0 state. For analog points, this is the unit of measurement (e.g., Degrees, PSI, etc.).</td>
</tr>
<tr>
<td>1/SCALE</td>
<td>For digital points, this is the label to display during 1 state. For analog points, this is the resolution, or minimum change to be reported and enables you to set the number of decimal places.</td>
</tr>
<tr>
<td>DTYPE</td>
<td>Point type. Used with auto control objects. This is the type of point the object's output is being sent to; the destination point type.</td>
</tr>
<tr>
<td>STYPE</td>
<td>Point type. Used with auto control objects. This is the type of point the object is receiving data from; the source point type.</td>
</tr>
<tr>
<td>LOW</td>
<td>Used with auto control objects. This is the low threshold, or control level.</td>
</tr>
<tr>
<td>HIGH</td>
<td>Used with auto control objects. This is the high threshold, or control level.</td>
</tr>
<tr>
<td>PUSH</td>
<td>Used with auto control points. Push enables the system to attempt to maintain output states when the two points are out of sync. (IMPORTANT: With Push enabled, manual control is disabled.)</td>
</tr>
<tr>
<td>INITIAL</td>
<td>Float decimal. Value to which this operator should be set at startup.</td>
</tr>
</tbody>
</table>
LOG | Y or N. Enabling Log allows this object’s changes to be written to the journal. Changes can be viewed using HT3’s Detail Report. To conserve disk space, disable Log for those objects that you don’t need to review status changes for.

For more information on the Detail Report, see "Using Status, Reporting and System Tools: Creating and Viewing Reports" in the HT3 User Guide.

LOCAL | Y or N. Enabling Local confines this object to the Virtual Points database; it isn’t broadcast to the rest of HT3. To conserve disk space, disable Local for objects that are only used in equations (are not "real" telemetry points).

**Menus**

Select a menu from the list below to learn more about its commands.

- **Analog Menu**
- **Compare Menu**
- **Digital Menu**
- **Edit Menu**
- **File Menu**
- **Help Menu**
- **Ladder Menu**
- **Math Menu**
- **Module Menu**
- **Time/Date Menu**

**Analog Menu**

The Analog menu features the following commands:

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Constant</td>
<td>Replace the value of the rung or branch with any specified constant. See Analog Objects: Constant for more information.</td>
</tr>
<tr>
<td>Examine Analog</td>
<td>Replace the value of the rung or branch with the value of an existing analog point. See Analog Objects: Examine Analog for more information.</td>
</tr>
<tr>
<td>Analog Input</td>
<td>Create a virtual user analog input (can be set to any value) that can be used to manually control a point. See Analog Objects: Analog Input for more information.</td>
</tr>
<tr>
<td>Deadband</td>
<td>Used to prevent small input changes from affecting an output. See Analog Objects: Deadband for more information.</td>
</tr>
</tbody>
</table>
### Analog Out
Create an auto control record that outputs from the ladder logic program to an analog control point. See [Analog Objects: Analog Out](#) for more information.

### Virtual Out
Create a simulated output relay for reference elsewhere in ladder logic. (Note: This point can be referenced in any ladder logic program that is installed on the server, not just the ladder where it is initially defined, or generated.) See [Analog Objects: Virtual Out (Analog)](#) for more information.

### Move
Copy (move) the second input value while the first input is true; otherwise, keep the previous value. See [Analog Objects: Move](#) for more information.

### Selector
Output the second input value if the first input is true; otherwise, output the third input value. See [Analog Objects: Selector](#) for more information.

### Total
Sum the absolute value of a numeric input each time a new value arrives. This object has an optional reset input that enables you to reset TOTAL at a specified time. If the reset is left blank, HT3 automatically resets it at the start of each day (midnight). See [Analog Objects: Total](#) for more information.

### Flow
Convert a per-minute analog input, such as gallons per minute, into a totalized measurement, such as total gallons. This object requires a qualifier address. If there is no qualifier address, a Constant with a value of one (1) must be placed on the qualifier input branch. This object also has an optional reset input that enables you to reset Flow at a specified time. If the reset is left blank, HT3 automatically resets it at the start of each day (midnight). See [Analog Objects: Flow](#) for more information.

### PID
Uses a process variable and a set point input, along with gain, integral, derivative, and integral limit (“wind-up”) parameters, to create a process control strategy. See [Analog Objects: PID](#) for more information.

### Compare Menu
The Compare menu features the following commands:

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Equal</td>
<td>Output 1 if both inputs have the same value; otherwise, output 0.</td>
</tr>
<tr>
<td>Even</td>
<td>Output 1 if the input’s value is even; otherwise, output 0.</td>
</tr>
<tr>
<td>Odd</td>
<td>Output 1 if the input’s value is odd; otherwise, output 0.</td>
</tr>
<tr>
<td>Less</td>
<td>Output 1 if the first input’s value is less than the second input’s value; otherwise, output 0.</td>
</tr>
</tbody>
</table>
Greater | Output 1 if the first input's value is greater than the second input's value; otherwise, output 0.  

Less or Equal | Output 1 if the first input's value is less than or equal to the second input's value; otherwise, output 0.  

Greater or Equal | Output 1 if the first input's value is greater than or equal to the second input's value; otherwise, output 0.  

For more information on using these objects in ladder logic programs see Ladder Building Components: Compare Operators.

## Digital Menu

The Digital menu features the following commands:

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
<th>See for more information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Examine On</td>
<td>Retrieve, or sample, the value of an existing Digital point and &quot;and&quot; it with the input value.</td>
<td>Digital Objects: Examine On</td>
</tr>
<tr>
<td>Examine Off</td>
<td>Similar to Examine On, but the retrieved, or sampled, value is inverted with a system-generated &quot;not&quot; equation.</td>
<td>Digital Objects: Examine Off</td>
</tr>
<tr>
<td>Digital Input</td>
<td>Create a virtual User Digital input (can be set to 0 or 1) that can be used to manually control a point.</td>
<td>Digital Objects: Digital Input</td>
</tr>
<tr>
<td>Momentary Input</td>
<td>Create a manual virtual User input that changes state for a specified number of seconds.</td>
<td>Digital Objects: Momentary Input</td>
</tr>
<tr>
<td>Out</td>
<td>Create an auto control that outputs from the program to a control point.</td>
<td>Digital Objects: Out</td>
</tr>
<tr>
<td>Out Not</td>
<td>Create an auto control with the invert parameter set.</td>
<td>Digital Objects: Out Not</td>
</tr>
<tr>
<td>Virtual Out</td>
<td>Create a simulated output relay for reference elsewhere in ladder logic.</td>
<td></td>
</tr>
</tbody>
</table>

Note: If you are familiar with virtual point equations, note that the virtual equation OneShot is named Momentary Input in Virtual Logic Builder. Virtual Logic Builder's One-Shot (DIFU) is another name for the DIFU virtual equation.

See Digital Objects: Momentary Input for more information.
<table>
<thead>
<tr>
<th>Digital Objects: Virtual Out for more information.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Latch</strong> Set or reset the output when either input is true; otherwise, keep the previous value. See Digital Objects: Latch for more information.</td>
</tr>
<tr>
<td><strong>One-Shot (DIFU)</strong> DIFU = Differentiate Up; Momentarily turn on an Output when the state of a specified Input changes from off to on. The Output remains on (true) for the length of time it takes the system to complete one scan of the Virtual Logic Builder (.vlb) program. The One-Shot (DIFU) is reset only when the program scan is complete and the Input’s state changes from ON to OFF. Any change in state during the program scan interval has no affect on the Output.</td>
</tr>
<tr>
<td><strong>Notes:</strong></td>
</tr>
<tr>
<td>• One-Shot (DIFU) uses its Initial value (see Definition of Inspector Fields) to determine the result to produce. Setting Initial to 0 (default setting), results in a change from 0 to 1. Changing Initial to 1, results in a DIFD (Differentiate Down) command, i.e., the Output remains off (false) for one program scan.</td>
</tr>
<tr>
<td>• If you are familiar with virtual point equations, note that the virtual equation OneShot is named Momentary Input in Virtual Logic Builder. Virtual Logic Builder’s One-Shot (DIFU) is another name for the DIFU virtual equation.</td>
</tr>
<tr>
<td>See Digital Objects: One-Shot (DIFU) for more information.</td>
</tr>
<tr>
<td><strong>Time Delay</strong> Delay the output change by a number of seconds (second input, must be a CONSTANT) of continuous first input.</td>
</tr>
<tr>
<td><strong>Note:</strong> Time Delay uses its Initial value (see Definition of Inspector Fields) to determine the result to produce. Setting Initial to 0 (default setting), results in a change from 0 to 1. Changing Initial to 1, results in a Time Delay Off command.</td>
</tr>
<tr>
<td>See Digital Objects: Time Delay for more information.</td>
</tr>
<tr>
<td><strong>Retentive Timer</strong> Delay the output change by the accumulated number of seconds the first input is true.</td>
</tr>
<tr>
<td><strong>Note:</strong> Retentive Timer uses its Initial value (see Definition of Inspector Fields) to determine the result to produce. Setting Initial to 0 (default setting), results in a change from 0 to 1. Changing Initial to 1, results in a Retentive Timer Off command.</td>
</tr>
<tr>
<td>See Digital Objects: Retentive Timer for more information.</td>
</tr>
<tr>
<td><strong>4-State</strong> Combine two logical inputs to create a numeric output with a value from 0 to 3. See Digital Objects: 4-State for more information.</td>
</tr>
</tbody>
</table>
Cycle | Count the number of times a logical input has turned on. See Digital Objects: Cycle for more information.

On Time | Calculate the number of seconds a logical input is in the ON state. See Digital Objects: On Time for more information.

## Edit Menu
Virtual Logic Builder’s Edit menu features commands for standard editing tools, such as Cut and Paste, as well as commands that enable you to test your ladder logic programs, and customize and edit your ladder components.

The Edit menu features the following commands:

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Undo</td>
<td>Reverse the last editing operation. Will redo the last editing operation if it was an undo. For more information, see Using the Undo Command.</td>
</tr>
<tr>
<td>Cut</td>
<td>Remove the selected object(s) and place them on the clipboard. For more information, see How to Cut, Copy and Paste.</td>
</tr>
<tr>
<td>Copy</td>
<td>Copy the selected object(s) and place them on the clipboard. For more information, see How to Cut, Copy and Paste.</td>
</tr>
<tr>
<td>Paste</td>
<td>Insert the clipboard contents at the cursor location. For more information, see How to Cut, Copy and Paste.</td>
</tr>
<tr>
<td>Delete</td>
<td>Permanently remove the selected object(s). For more information, see Deleting Ladder Components.</td>
</tr>
<tr>
<td>Control</td>
<td>Change the value of the selected and installed Digital Input, Analog Input or Momentary Input object. For more information, see Using the Control (Force) Command to Test Your Logic.</td>
</tr>
<tr>
<td>Properties</td>
<td>Open Inspector, which displays the selected object’s properties. For more information, see Getting Around Virtual Logic Builder: Inspector.</td>
</tr>
</tbody>
</table>

## File Menu
The File menu features the following commands:

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>New</td>
<td>Create a new logic program. If a program is already open, it is replaced with a new one and the virtual address prefix is reset (See Settings, below).</td>
</tr>
<tr>
<td>Open</td>
<td>Open a previously created virtual logic program (.vlb file). Note: See the section Saving Ladders for important information on opening and saving files.</td>
</tr>
</tbody>
</table>
**Save**

Save the current virtual logic program. If the program has not been given a file name, you are prompted to enter one. **Note:** See the section [Saving Ladders](#) for important information on opening and saving files.

**Save As**

Save the current virtual logic program after being prompted to enter a file name.

**Notes:**

Saving a file only places it on your local computer; it does not save it to the server. To save a ladder logic program to the server and make it active, you must install it.

See the section [Saving Ladders](#) for important information on opening and saving files.

**Settings**

Change the virtual address prefix and/or the partition number for this program. The virtual address prefix is automatically generated by the system, but it's good practice to change the virtual address prefix to something unique (e.g., VTimer, VSprinkler) to avoid overwriting existing virtual points that have the same system-generated prefix. The prefix is added to all virtual points that do not have user-assigned names. The addresses of these virtual points are formed by numbering them sequentially and then adding the prefix to each (i.e., VTimer1, VTimer2, etc.). See [Working with Ladders: Configuring Ladder Settings](#) for more information.

**Change Station**

Need info on this command...

**Install**

Convert the program to database points and begin running it on the server.

**Note:** You must be logged in to Virtual Logic Builder with an account with Configure Telemetry permission, and your program must be saved before it can be installed.

See [Working with Ladders: Installing and Uninstalling Ladders](#) for more information.

**Updated Setpoints**

Need info on this command...

**Uninstall**

Remove from the server the virtual database points that were created by an installed ladder logic program.

**Note:** To uninstall a file, you must be logged in to Virtual Logic builder with an account with Configure Telemetry permission, and the file must have been previously saved and installed. When a ladder is uninstalled it is only removed from the HT3 server; it isn't removed from your computer.

See [Working with Ladders: Installing and Uninstalling Ladders](#) for more information.
### Help Menu
The Help menu features the following commands:

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>About</td>
<td>Provides the version number and date of release of the version of Virtual Logic Builder you are currently running. Results are displayed in the Message bar.</td>
</tr>
<tr>
<td>Browse Help</td>
<td>Open the Virtual Logic Builder User Guide.</td>
</tr>
<tr>
<td>Test Server</td>
<td>Debugging tool used to test communication with the server. Use this command if you are having problems saving or installing your ladder logic programs, or if the server seems slow. Results are displayed in the Message bar.</td>
</tr>
</tbody>
</table>

### Ladder Menu
The Ladder menu features the following commands:

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rung</td>
<td>Insert a new <strong>rung</strong> at the top of the program or after the selected object. For information on adding rungs, see Adding and Deleting Components: Adding Rungs.</td>
</tr>
<tr>
<td>Branch</td>
<td>Insert a new <strong>branch</strong> at the start of the selected rung or branch. For information on adding branches, see Adding and Deleting Components: Adding Branches.</td>
</tr>
<tr>
<td>Comment</td>
<td>Insert a <strong>comment</strong> at the top of the program or between rungs. For information on adding comments to your ladder, see Working with Ladders: Adding Comments.</td>
</tr>
<tr>
<td>Go To</td>
<td>Jump to a specific line number. For more information on this command, see Adding Cross References to Ladders: Using the Go To Command to Jump to a Specific Line.</td>
</tr>
<tr>
<td>Find</td>
<td>Search for a specific address or description. For more information on this command, see Editing Tools: Using Find and Replace to Locate and Change Addresses and Descriptions.</td>
</tr>
<tr>
<td>Find Again</td>
<td>Repeat the most recent Find operation without the dialog. For more information on this command, see Editing Tools: Using Find and Replace to Locate and Change Addresses and Descriptions.</td>
</tr>
</tbody>
</table>
Cross Reference | Enable or disable the display of reference line numbers below Out (output) objects. For more information on this command, see Working with Ladders: Adding Cross References to Ladders.

Check | Check the current program for completeness and good addresses. For more information on this command, see Working with Ladders: Checking Your Ladder.

Refresh | Sample (once) the values of the ladder’s objects and display all values and colors. For more information on this command, see Working with Ladders: Testing Your Logic.

Animate | Repeatedly sample the values of the ladder's objects and display all values and colors. (Note: This command can only be used on installed ladders.) For more information on this command, see Working with Ladders: Testing Your Logic.

Simulate | Developing and debugging tool that allows you to simulate a ladder program’s logic. In Simulate mode, the Control (Force) command can be used on most objects in a ladder to test the logic without affecting real hardware. For more information on this command, see Working with Ladders: Testing Your Logic.

Stop | Stop an animated display. Choosing an editing command also causes the animation to stop. For more information on this command, see Working with Ladders: Testing Your Logic.

### Math Menu
The Math menu features the following commands:

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add</td>
<td>Output the sum of two inputs.</td>
</tr>
<tr>
<td>Subtract</td>
<td>Output the difference between the first input's value and the second input's value.</td>
</tr>
<tr>
<td>Multiply</td>
<td>Output the product that results when the first input's value is multiplied by the second input's value.</td>
</tr>
<tr>
<td>Divide</td>
<td>Output the quotient that results when the first input's value is divided by the second input's value, or 0 (zero).</td>
</tr>
<tr>
<td>Modulus</td>
<td>Output the modulus (remainder) that results when the first input's value is divided by the second input's value, or 0 (zero).</td>
</tr>
<tr>
<td>Minimum</td>
<td>Output the lesser of two input values.</td>
</tr>
<tr>
<td>Maximum</td>
<td>Output the greater of two input values.</td>
</tr>
</tbody>
</table>
For more information on using these objects in ladder logic programs see Ladder Building Components: Math Operators.

**Module Menu**

The Module menu makes it easier to add points to your ladders by allowing you to select the point from a list instead of manually entering the point's name and telemetry address. With this new feature, you can download module and point information for a station already configured on the system. You can download information for more than one station and select from available stations with the Use command.

After adding an object to your ladder, there are two methods for defining the object's properties, including its telemetry address and point name: via Inspector or Define Module.

Define Module allows you to download all of the configured modules for a specific station. You can then associate a point with an object by simply selecting the object and then choosing a point from a generated list. This list includes the point's type, its telemetry address, and its configured user-defined name.

For information on downloading and adding modules, see Working with Ladders: Downloading Module Information for Use in Ladders.

When you first open Virtual Logic Builder, the Module menu lists one command: Define.

After you have downloaded or added modules, the Module menu will look similar to this:

When you click Define on the Module menu, the Define Module dialog box opens:
The **Define Module** dialog box includes the following boxes and commands.

- **Station** - Enter the number of the station that you want to download or use.
- **Use** - Instructs Virtual Logic Builder to list (use) the modules of the specified station. This enables you to select a station to use when you have downloaded or added more than one station. (The module menu will only list one station at a time).
- **Download** - Allows you to download point information for modules already configured on the server.
- **Cancel** - Cancels the current operation and closes the **Define Module** dialog box.

## Time/Date Menu

The Time/Date menu features the following commands:

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Second</strong></td>
<td>Replace the value of the rung or branch with the number of seconds that have passed in the current minute (0-59).</td>
</tr>
<tr>
<td><strong>Minute</strong></td>
<td>Replace the value of the rung or branch with the number of minutes that have passed in the current hour (0-59).</td>
</tr>
<tr>
<td><strong>Hour</strong></td>
<td>Replace the value of the rung or branch with the number of hours that have passed since midnight (0-23).</td>
</tr>
<tr>
<td><strong>Time of Day</strong></td>
<td>Replace the value of the rung or branch with the number of seconds that have passed since midnight (0-86399).</td>
</tr>
<tr>
<td><strong>Day of Month</strong></td>
<td>Replace the value of the rung or branch with the day of the month (1-31).</td>
</tr>
<tr>
<td><strong>Month of Year</strong></td>
<td>Replace the value of the rung or branch with the month of the year (1-12).</td>
</tr>
<tr>
<td><strong>Year</strong></td>
<td>Replace the value of the rung or branch with the current year.</td>
</tr>
<tr>
<td><strong>Day of Week</strong></td>
<td>Replace the value of the rung or branch with the day of the week (1-7, where Sunday = 1).</td>
</tr>
<tr>
<td><strong>Day of Year</strong></td>
<td>Replace the value of the rung or branch with the day of the year (1-366).</td>
</tr>
<tr>
<td><strong>Week of Year</strong></td>
<td>Replace the value of the rung or branch with the week of the year (1-53).</td>
</tr>
</tbody>
</table>

For more information on using these objects in ladder logic programs see [Ladder Building Components: Time and Date Objects](#).
Ladder Building Components

This section provides an overview of the components used to build ladder logic programs as well as information and instructions on how these components work together to control and monitor your telemetry system.

- The Ladder (Rungs and Branches)
- Comments
- The "And" Function
- The "Or" Function
- Analog Objects
- Digital Objects
- Compare Operators
- Math Operators
- Time and Date Objects

The Ladder (Rungs and Branches)

When you start Virtual Logic Builder, you are presented with an empty ladder. The two vertical lines that appear on either side of the Virtual Logic Builder window are referred to as "rails." The rails and the horizontal lines - rungs and branches - that you add to the ladder logic program form a structure that resembles a ladder, hence the name ladder logic.

Rungs

The first step in building a ladder logic program is to add a rung. Rungs form the base of all ladder logic programs; they hold all of the objects and operators that are used to create the logic. For information on adding rungs to your ladder, see Adding and Deleting Components: Adding Rungs.
Branches

Branches are an integral part of ladder logic programs. Branches are used to build "Or" functions into logic or to connect sections of logic. They hold secondary inputs from objects and operators (such as Move and Less Than) that require more than one input to perform their function. Other objects, such as Time Delay and Cycle Count, need a branch to determine how long to delay sending output or when to reset.

When building logic with branches, you need to plan ahead. Usually it is best to create the top rung, including necessary objects, all the way across, then add the branches below. Always keep at least one object to the right of each junction, otherwise you will have to delete the branch and re-create it in the new position.

For information on adding branches to your ladder, see Adding and Deleting Components: Adding Branches.

Comments

Comments can be added to your ladder logic programs to provide information on the function of a particular section of logic.
Comments can be inserted at the top of the diagram or between rungs.

Each comment can hold up to 200 characters of text.

See Working with Ladders: Adding Comments for more information on adding comments to your ladder logic programs.

The "And" Function

See also: The "Or" Function.

The "and" function is implied in ladder logic. "And" isn't an object or operator that is inserted in a ladder logic diagram.

When two inputs are placed next to each other on a rung, there is an implied "and" between them - if the first input and the second input are both true, then their output is true. All other combinations result in a false, or 0, output value.

<table>
<thead>
<tr>
<th>Value of First Input</th>
<th>Value of Second Input</th>
<th>Output / Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>0</td>
<td>0 (False)</td>
</tr>
<tr>
<td>0</td>
<td>1</td>
<td>0 (False)</td>
</tr>
<tr>
<td>0</td>
<td>0</td>
<td>0 (False)</td>
</tr>
<tr>
<td>1</td>
<td>1</td>
<td>1 (True)</td>
</tr>
</tbody>
</table>

Examine objects (Examine On, Examine Off and Examine Analog) are used to construct “and” statements.

By default, the left edge of each rung has the value 1 (one). When you place an Examine on an empty rung, the output (portion of the rung extending from the right side of the Examine) is equal to the current value of the Examine. Placing another Examine on the rung creates an “and” statement.

The statement functions as follows:

Sample the value of the first Examine (Pump 1 Fail) and the value of the second Examine (Pump 2 Fail). If both the first input “and” the second input are true (1), then the output is true (Pump Override's value becomes true). Otherwise, the output is false.
More than one Examine can be placed on a rung or branch, but the final output is true only if the value of all of the Examine objects is true.

### The "Or" Function

See also: The "And" Function.

The "or" function is implied in ladder logic. "Or" isn't an object or operator that is inserted in a ladder logic diagram.

When two inputs are connected by a branch, there is an implied "or" between them - if the first input or the second input is true, then their output is true. If both inputs are false, then their output will be false.

<table>
<thead>
<tr>
<th>Value of First Input</th>
<th>Value of Second Input</th>
<th>Output / Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>0</td>
<td>1 (True)</td>
</tr>
<tr>
<td>0</td>
<td>1</td>
<td>1 (True)</td>
</tr>
<tr>
<td>0</td>
<td>0</td>
<td>0 (False)</td>
</tr>
<tr>
<td>1</td>
<td>1</td>
<td>1 (True)</td>
</tr>
</tbody>
</table>

Examine objects (Examine On, Examine Off and Examine Analog) and branches are used to construct "or" statements.

The first Examine and an output object are placed on an empty rung. A branch is placed on the diagram. The branch starts just before the first Examine and ends just before the output. Another Examine is placed on the branch. The statement functions as follows:

Sample the value of the first Examine and the value of the second Examine. If the first Examine or the second Examine is true (1), then the output is true. Otherwise, the output is false.
More than one branch and Examine can be placed on a rung, but the final output is true only if the value of at least one of the Examine objects is true.

**Analog Objects**

- Analog Input
- Analog Out
- Constant
- Deadband
- Examine Analog
- Flow
- Move
- PID
- Selector
- Total
- Virtual Out

**Analog Input**

Virtual Logic Builder features one Analog Input object. The Analog Input is a virtual user analog input (can be set to any value) that can be used to manually control a point.

The typical use of an input object is to provide some type of operator control or input into the logic. After testing and installing, you enable operator control by configuring the input objects in a custom screen. (See the Screen Builder User Guide).
Analog Input objects remain at the value set through the Control command until they are manually reset from the Control command.

**Notes:**

- Analog input objects require a new virtual address. The address must start with the letter "V" and cannot be more than 12 characters long.

- To enable this object to keep its value following a reboot of the Hyper SCADA Server, ensure it is configured as described in Retain Value After HSS Restart. **(Note:** Analog virtual objects no longer need to be scaled. Beginning with HT3 3.0.3, analog virtual objects are stored in the journal as floating point values.)

- If you need to use the value of an Analog Input more than once in the current ladder logic program or in another ladder logic program, assign it a unique virtual address. Use an Examine Analog object to retrieve the object's value when it is needed.

**Analog Out**

Virtual Logic Builder features one analog output. This output is an auto control record that outputs from the ladder logic program to a specified analog control point.

**Note:** Output objects require an existing, configured telemetry address.

To view a simple example of how OUT objects can be used, see Ladder Logic Examples: Using Output Objects.

**Constant**

The Constant object enables you to replace the value of a rung or branch with any specified constant value.

Constant can be assigned a numeric value that is no more than 10 characters long, including a decimal point.

To assign a value to a Constant object, double click it. The default or existing value is highlighted and you can type in a new value. Press the Enter key when you are finished typing the new value.

To see how a Constant object can be used in a ladder logic program, see Ladder Logic Examples: Using Examine Objects and the Ladder Logic Examples: Using Output Objects.

**Deadband**
The Deadband object can be used to prevent small input changes from affecting an output. This output is typically connected to an auto-control, which minimizes the effect on radio traffic.

The second input to the Deadband object gives the size of the deadband. If the difference between the previous output and the first input is greater than the deadband, the first input is copied to the output. Otherwise the output remains unchanged.

Note: When using a Deadband with a PID object, set the Deadband to a small value. A large deadband will prevent the PID algorithm from working properly.

An example of a Deadband used in conjunction with a PID object, can be found in the section that describes the PID.

### Examine Analog

Virtual Logic Builder features one Analog Examine object that queries for the current value of a real or virtual analog point. The Examine Analog object replaces the value of a rung or branch with the value that is returned for the analog point.

When Virtual Logic Builder reaches an Examine object, it searches the database for the point and assigns the point’s current value to the Examine object.

Note: Examine objects require an existing, configured telemetry address. This can be the address of a real telemetry point or the address of a virtual point that was configured somewhere else in the current ladder logic program, or in another installed ladder logic program.

To view a simple example of how EXAMINE objects can be used, see Ladder Logic Examples: Using Examine Objects.

### Flow

Flow converts a per-minute analog input, such as gallons per minute, into a totalized measurement, such as total gallons. This object requires a qualifier address on the second input. If there is no qualifier address, CONSTANT with a value of one (1) must be placed on the qualifier input branch. This object also has an optional reset input that enables you to reset FLOW at a specified time. If the reset is left blank, HT3 will automatically reset it at the start of each day (midnight).

Notes:

- A new virtual address is optional for this object. It is generated by the system when necessary.
- To enable this object to keep its value following a reboot of the Hyper SCADA Server, ensure it is configured as described in Retain Value After HSS Restart. (Note: Analog virtual objects no longer need to be scaled. Beginning with HT3 3.0.3, analog virtual objects are stored in the journal as floating point values.)
Move

Move
  If
  Then

Move and Selector are used to construct conditional statements. They test the first input to see if it is true. If it is true, one course of action is taken. If it is not true, another action is taken.

The Move object copies (moves) the value of the second input while the first input is true; otherwise, it keeps the previous value.

Move is an If-Then statement and requires two inputs. The first input is the test, or conditional statement. The second input states what happens when the first input is true.

The Move logic statement in words would be:

- If the first input is true, then the second input's value becomes the output. If the first input is not true, then the first input's value is retained as the output.

Notes:

- New virtual addresses are optional for these objects. They are generated by the system when necessary.

- To enable this object to keep it's value following a reboot of the Hyper SCADA Server, ensure it is configured as described in Retain Value After HSS Restart. (Note: Analog virtual objects no longer need to be scaled. Beginning with HT3 3.0.3, analog virtual objects are stored in the journal as floating point values.)

To see how the Move object can be used in a ladder logic program, see Ladder Logic Examples: Using the Move Object.

PID

PID
  PID
  SM

The PID object uses a process variable and a set point input, along with gain, integral, derivative, and integral limit ("wind-up") parameters, to create a process control strategy. PID features three inputs: Process Variable, Setpoint, and Manual (optional).

- Process Variable is the input you are controlling. For example, the level of a tank.

- Setpoint is the value at which you are trying to keep the process variable (for example, the desired tank level).
Manual is only necessary when the process variable has a manual switch that can be used to turn off automatic control. It is important to connect the manual switch to the PID object, because when the two are connected and the process variable is in manual mode, the PID object is able to zero the integral part of the PID object to prevent accumulation of meaningless error values. (Error is the difference between the current value of the process variable and the set point value.)

To set the PID's parameters, select the object and open Inspector.

**IMPORTANT**: The algorithm used by Virtual Logic Builder's PID object uses the Integral and Derivative numbers in terms of seconds, not minutes.

- **Gain** - Gain is both the proportional component and the overall gain. Gain can be a positive or negative number. A negative gain makes the PID "reverse acting." Gain is set using a Constant.

- **Integral** - Integral is typically a small, positive decimal number. The Integral part of the PID algorithm sums all previous errors (integration) and multiplies this by the integral to affect the output value. Integral is set using a Constant.

- **Derivative** - Derivative is typically a small, positive decimal number. The Derivative part of the PID algorithm evaluates the process variable's rate of change in order to prevent any oscillation caused by integration. Deriv can be left at 0 (zero) if desired. Derivative is set using a Constant.

- **Formula** - For future use. At this time, Formula must be kept at its default value of 1 (one).

- **Option** - Option, a small, positive number, is the integral limit, also known as "wind-up." Option is used to restrict the maximum effect of the integral component. Option is set using a Constant.

Below is an example of a PID object used in conjunction with a Deadband.

**Selector**

Selector and Move are used to construct conditional statements. They test the first input to see if it is true. If it is true, one course of action is taken. If it is not true, another action is taken.
The Selector object outputs the second input value if the first input is true; otherwise, it outputs the third input value.

Selector is an If-Then-Else statement and requires three inputs.

- The first input is the test, or conditional statement.
- The second input states what happens if the first input is true.
- The third input states what happens if the first input is not true.

The Selector logic statement in words would be:

- If the first input is true, then the second input's value becomes the output. Else, if the first input is not true, then the third input's value becomes the output.

**Notes:**

- New virtual addresses are optional for these objects. They are generated by the system when necessary.
- To enable this object to keep its value following a reboot of the Hyper SCADA Server, ensure it is configured as described in Retain Value After HSS Restart. (Note: Analog virtual objects no longer need to be scaled. Beginning with HT3 3.0.3, analog virtual objects are stored in the journal as floating point values.)

### Total

Total sums the absolute value of a numeric input each time a new value arrives. This object has an optional reset input that enables you to reset TOTAL at a specified time. If the reset is left blank, HT3 will reset it at the start of each day (midnight).

**Notes:**

- A new virtual address is optional for this object. It is generated by the system when necessary.
- To enable this object to keep its value following a reboot of the Hyper SCADA Server, ensure it is configured as described in Retain Value After HSS Restart. (Note: Analog virtual objects no longer need to be scaled. Beginning with HT3 3.0.3, analog virtual objects are stored in the journal as floating point values.)

### Virtual Out (Analog)
Virtual Logic Builder features one analog virtual output object. (The value of a virtual object is calculated using logic; it isn't the result of reading the status of real, hardware I/O.)

When a ladder logic program is installed, all of its virtual outputs are converted to virtual points and are added to the HT3 Virtual Points database. These virtual points are then available for use in any other ladder logic programs that you create.

Notes:

- Virtual Out objects require a new virtual address. The address must start with the letter "V" and cannot be more than 12 characters long.

- To enable this object to keep its value following a reboot of the Hyper SCADA Server, ensure it is configured as described in Retain Value After HSS Restart. **(Note:** Analog virtual objects no longer need to be scaled in order to keep their value after a restart. Beginning with HT3 3.0.3, analog virtual objects are stored in the journal as floating point values.)

- If you need to use the value of an analog Virtual Out more than once in the current ladder logic program or in another ladder logic program, assign it a unique virtual address. Use an Examine Analog object to retrieve the object's value when it is needed.

**IMPORTANT:** Virtual points created in Virtual Logic Builder should only be edited from within Virtual Logic Builder. If you attempt to edit virtual points using Configuration Editor, the changes may not be reflected the next time you open your ladder logic program in Virtual Logic Builder and may adversely affect the ladder logic program's function.

To see examples of how VIRTUAL OUTS are used in ladder logic programs, see Ladder Logic Examples: Using Examine Objects and Ladder Logic Examples: Using Output Objects.
Digital Objects

- 4-State
- Cycle
- Digital Input
- Examine Off
- Examine On
- Latch
- Momentary Input
- On Time
- One-Shot (DIFU)
- Out
- Out Not
- Retentive Timer
- Time Delay
- Virtual Out

4-State

The 4-State object combines two logical inputs to create a numeric output with a value from 0 to 3.

4-STATE retrieves the current status of two digital points (inputs) and produces an output state, from 0 - 3, based on the conditions shown in the table below.

<table>
<thead>
<tr>
<th>Value of First Input</th>
<th>Value of Second Input</th>
<th>Combined Output</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>1</td>
<td>0</td>
<td>1</td>
</tr>
<tr>
<td>0</td>
<td>1</td>
<td>2</td>
</tr>
<tr>
<td>1</td>
<td>1</td>
<td>3</td>
</tr>
</tbody>
</table>

Notes:

- New virtual addresses are optional for these objects. They are generated by the system when necessary.
• To enable this object to retain its value following a reboot of the Hyper SCADA Server, ensure it is configured as described in Retain Value After HSS Restart.

**Cycle**

The Cycle object counts the number of times a logical input has turned on.

This object features an optional reset input (a specific time to reset the timer). If left blank, HT3 automatically resets the timer at midnight.

**Notes:**

- A new virtual address is optional for this object. It is generated by the system when necessary.
- To enable this object to retain its value following a reboot of the Hyper SCADA Server, ensure it is configured as described in Retain Value After HSS Restart.

To see how the Cycle object can be used in a ladder logic program, see Ladder Logic Examples: Using the Cycle Object.

**Digital Input**

Virtual Logic Builder features two digital input objects: Digital Input and Momentary Input.

The typical use of an input object is to provide some type of operator control or input into the logic. After installing and testing, you enable operator control by configuring the input objects in a custom screen. (See the Screen Builder User Guide).

Digital Input objects remain at the state set through the Control (Force) command until they are manually reset from the Control (Force) command. See Testing Your Logic for more information.

**Notes:**

- The Digital Input object requires a new virtual address. The address must start with the letter "V" and cannot be more than 12 characters long.
- The Digital Input object must be the first object on the rung in order for it to be used in "and" functions (see example below).
- To enable this object to retain its value following a reboot of the Hyper SCADA Server, ensure it is configured as described in Retain Value After HSS Restart.
- If you need to use the value of an Digital Input more than once in the current ladder logic program or in another ladder logic program, assign it a unique virtual address. Use an Examine Off or Examine On object to retrieve the object's value when it is needed.
Examine Off

Virtual Logic Builder features two digital Examine objects that fetch the current value of a real or virtual point: Examine Off and Examine On.

When Virtual Logic Builder reaches an Examine object, it searches the database for the point and assigns its current value to the Examine object.

Examine Off inverts the current value of the point.

- If the current value of the point is 0, Examine Off inverts the value so that it becomes 1.

Note: Examine On requires an existing, configured telemetry address. This can be the address of a real telemetry point or the address of a virtual point that was configured somewhere else in the current ladder logic program in another installed ladder logic program.

To view a simple example of how Examine objects can be used, see Ladder Logic Examples: Using Examine Objects.

Examine On

Examine On retrieves the value of an existing digital point and "ands" it with the input value.

Virtual Logic Builder features two Digital Examine objects that fetch the current value of a real or virtual point: Examine On and Examine Off (Examine Off inverts the current value of the point).
When Virtual Logic Builder reaches an Examine object, it searches the database for the point and assigns its current value to the Examine object.

**Note:** Examine On requires an existing, configured telemetry address. This can be the address of a real telemetry point or the address of a virtual point that was configured somewhere else in the current ladder logic program in another installed ladder logic program.

To view a simple example of how Examine objects can be used, see [Ladder Logic Examples: Using Examine Objects](#).

## Latch

Latch sets or resets the output when either input is true; otherwise, it keeps the previous value.

Latch is used to set and reset a digital output, or auto control. It requires two inputs (conditions).

- The first input provides HT3 with the conditions for setting the point.
- The second input gives HT3 the conditions for resetting the point.

Each time the ladder logic program is scanned, these input conditions are evaluated.

- If either is true, the auto control point's state changes from 0 to 1 (Set) or 1 to 0 (Reset).
- If neither condition is true, the auto control retains its previous value (the point's state does not change).
- In the event that both conditions are true, the Set command overrides the Reset command.

**Notes:**

- New virtual addresses are optional for these objects. They are generated by the system when necessary.
- To enable this object to retain its value following a reboot of the Hyper SCADA Server, ensure it is configured as described in [Retain Value After HSS Restart](#).

To see a Latch object in use, see [Ladder Logic Examples: Using the Latch Object](#).

## Momentary Input

Virtual Logic Builder features two digital input objects: Momentary Input and Digital Input.
The typical use of an input object is to provide some type of operator control or input into the logic. After testing and installing, you enable operator control by configuring the input objects in a custom screen. (See the Screen Builder User Guide).

Momentary Input is a manual input that enables you to temporarily change its state to the opposite of its initial value. A Constant that indicates the number of seconds that the Momentary Input is to stay on must be placed before Momentary Input.

Notes:

- The Momentary Input object must be the first object on the rung in order for it to be used in "and" functions (see example below).
- To enable this object to retain its value following a reboot of the Hyper SCADA Server, ensure it is configured as described in Retain Value After HSS Restart.
- If you need to use the value of a Momentary Input more than once in the current ladder logic program or in another ladder logic program, assign it a unique virtual address. Use an Examine Off or Examine On object to retrieve the object’s value when it is needed.

### On Time

The On Time object calculates the number of seconds a logical input is in the ON state.

This object features an optional reset input (a specific time to reset the timer). If left blank, HT3 automatically resets the timer at midnight.

Notes:

- A new virtual address is optional for this object. It is generated by the system when necessary.
To enable this object to retain it's value following a reboot of the Hyper SCADA Server, ensure it is configured as described in Retain Value After HSS Restart.

One-Shot (DIFU)

\[
\text{DIFU} \quad \text{DIFU}
\]

One-Shot (DIFU) momentarily turns on an Output when the state of a specified input changes from OFF to ON. The Output remains on (true) for the length of time it takes the system to complete one scan of the ladder logic program. The One-Shot (DIFU) is reset only when the program scan is complete and the Input’s state changes from ON to OFF. Any change in state during the program scan interval has no affect on the Output.

Changing the INITIAL value to 1, causes the DIFU to behave as a DIFD, i.e., the Output remains off (false) for one program scan.

To use a One-Shot (DIFU) in a ladder logic program, place it directly after a digital Input.

Notes:

- DIFU = Differentiate Up
- DIFD = Differentiate Down
- New virtual addresses are optional for these objects. They are generated by the system when necessary.
- To enable this object to retain it’s value following a reboot of the Hyper SCADA Server, ensure it is configured as described in Retain Value After HSS Restart.

Out

Virtual Logic Builder features two digital outputs: Out and Out Not (Out Not is used to invert the relationship between the control point and the monitor point).

These outputs are auto controls that output from the ladder logic program to a specified digital control point.

Note: Out objects require an existing, configured telemetry address.

To view a simple example of how Out objects can be used, see Ladder Logic Examples: Using Output Objects.

Out Not
Virtual Logic Builder features two digital outputs: Out Not and Out.

These outputs are auto controls that output from the ladder logic program to a specified digital control point.

Out Not is an auto control with the invert parameter set. Typically, the control point exactly follows the state of the point it is monitoring. Using Out Not, enables you to invert, or reverse, this relationship.

**Note:** Out objects require an existing, configured telemetry address.

To view a simple example of how Out objects can be used, see Ladder Logic Examples: Using Output Objects.

## Retentive Timer

![](image)

Retentive Timer is used to delay an output change by the accumulated length of time (measured in seconds) that the first input remains true. The second input for this object is the length of time (in seconds) to delay output.

Retentive Timer's second input must be a [Constant](#) with an assigned value equal to the number of seconds you wish to delay an output change.

This object also features an optional reset input; a specific time to reset the timer. If left blank, HT3 automatically resets the timer at midnight.

**Notes:**

- A new virtual address is optional for this object. It is generated by the system when necessary.
- To enable this object to retain it’s value following a reboot of the Hyper SCADA Server, ensure it is configured as described in Retain Value After HSS Restart.

## Time Delay

![](image)

The Time Delay object is used to delay an output change by a specific length of time (second input; measured in seconds) as long as the first input remains true.

Time Delay's second input must be a [Constant](#) with an assigned value equal to the number of seconds you wish to delay an output change.

**Notes:**

- A new virtual address is optional for this object. It is generated by the system when necessary.
Virtual Logic Builder

- To enable this object to retain it's value following a reboot of the Hyper SCADA Server, ensure it is configured as described in Retain Value After HSS Restart.

Virtual Out (Digital)

Virtual Logic Builder features one digital Virtual Out object. The Virtual Out object is used to create a simulated output relay for reference elsewhere in ladder logic.

When a ladder logic program is installed, all of its Virtual Outs are converted to virtual points and are added to the HT3 Virtual Points database. These virtual points are then available for use in any other ladder logic programs that you create.

**IMPORTANT**: Virtual points created in Virtual Logic Builder should only be edited from within Virtual Logic Builder. If you attempt to edit virtual points using Configuration Editor, the changes may not be reflected the next time you open your ladder logic program in Virtual Logic Builder and may adversely affect the ladder logic program's function.

**Notes**:

- Virtual Out objects require a new virtual address. The address must start with the letter "V" and cannot be more than 12 characters long.

- This point can be referenced in any ladder logic program that is installed on the server, not just the ladder where it is initially defined, or generated.

- To enable this object to retain it's value following a reboot of the Hyper SCADA Server, ensure it is configured as described in Retain Value After HSS Restart.

- If you need to use the value of a digital Virtual Out more than once in the current ladder logic program or in another ladder logic program, assign it a unique virtual address. Use an Examine Off or Examine On object to retrieve the object's value when it is needed.

To see examples of how Virtual Outs are used in ladder logic programs, see Ladder Logic Examples: Using Examine Objects and Ladder Logic Examples: Using Output Objects.

Compare Operators

Virtual Logic Builder features seven Compare operators.

<table>
<thead>
<tr>
<th>Equal</th>
<th>Equal</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Output 1 if both inputs have the same value; otherwise, output 0.
**Even**

Output 1 if the input's value is even; otherwise, output 0.

**Odd**

Output 1 if the input's value is odd; otherwise, output 0.

**Less**

Output 1 if the first input's value is less than the second input's value; otherwise, output 0.

**Greater**

Output 1 if the first input's value is greater than the second input's value; otherwise, output 0.

**Less or Equal**

Output 1 if the first input's value is less than or equal to the second input's value; otherwise, output 0.

**Greater or Equal**

Output 1 if the first input's value is greater than or equal to the second input's value; otherwise, output 0.

Virtual Logic Builder’s Compare operators function in much the same way that the Math operators do. They evaluate two inputs (Even and Odd require only one input) and perform the designated function to produce an output. However, Compare operators output a 1 or 0 (true or false) instead of a numeric value.

All of the operators, with the exception of Even and Odd, require a second input. Even and Odd evaluate the input and output a 1 (one) if the statement is true. All of the other operators compare two inputs and output a 1 (one) if the comparison is true.

**Notes:**

- New virtual addresses are optional for these objects. They are generated by the system when necessary.
- To enable this object to retain it’s value following a reboot of the Hyper SCADA Server, ensure it is configured as described in **Retain Value After HSS Restart**.

To see a Compare operator in use, see Ladder Logic Examples: Using Examine Objects and Ladder Logic Examples: Using Output Objects.

**Math Operators**

Virtual Logic Builder features seven Math operators.

**Add**

Output the sum of two inputs.
### Subtract
Output the difference between the first input's value and the second input's value.

### Multiply
Output the product that results when the first input's value is multiplied by the second input's value.

### Divide
Output the quotient that results when the first input's value is divided by the second input's value, or 0 (zero).

### Modulus
Output the modulus (remainder) that results when the first input's value is divided by the second input's value, or 0 (zero).

### Minimum
Output the lesser of two input values.

### Maximum
Output the greater of two input values.

Each takes two inputs and performs its designated function and produces an output, e.g., Add retrieves the first input's value and adds it to the second input's value; Divide retrieves the first input's value and divides it by the second input's value; Minimum outputs the lesser value of the two inputs.

Math operators output numeric, or analog values. Divide outputs 0 if one or both of the inputs are zero. **Modulus, explained below**, outputs 0 if there is no remainder.

**Notes:**
- New virtual addresses are optional for these objects. They are generated by the system when necessary.
- To enable this object to retain its value following a reboot of the Hyper SCADA Server, ensure it is configured as described in [Retain Value After HSS Restart](#).

**Modulus**
Modulus uses integer division to divide the first input by the second input and returns the remainder (i.e., the portion of the first input that isn’t evenly divided by the second input). Modulus outputs 0 if there is no remainder. For example, dividing 15 by 6 returns a remainder of 3.

\[
\begin{array}{c}
2 \\
6 \overline{15} \\
3
\end{array}
\]

The Modulus equation, above, would look like this when done in ladder logic.
Time and Date Objects

Virtual Logic Builder features four Time and six Date objects.

<table>
<thead>
<tr>
<th>Object</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Second</td>
<td>Replace the value of the rung or branch with the number of seconds that have passed in the current minute (0-59).</td>
</tr>
<tr>
<td>Minute</td>
<td>Replace the value of the rung or branch with the number of minutes that have passed in the current hour (0-59).</td>
</tr>
<tr>
<td>Hour</td>
<td>Replace the value of the rung or branch with the number of hours that have passed since midnight (0-23).</td>
</tr>
<tr>
<td>Time of Day</td>
<td>Replace the value of the rung or branch with the number of seconds that have passed since midnight (0-86399).</td>
</tr>
<tr>
<td>Day of Month</td>
<td>Replace the value of the rung or branch with the day of the month (1-31).</td>
</tr>
<tr>
<td>Month of Year</td>
<td>Replace the value of the rung or branch with the month of the year (1-12).</td>
</tr>
<tr>
<td>Year</td>
<td>Replace the value of the rung or branch with the current year.</td>
</tr>
<tr>
<td>Day of Week</td>
<td>Replace the value of the rung or branch with the day of the week (1-7, where Sunday = 1).</td>
</tr>
<tr>
<td>Day of Year</td>
<td>Replace the value of the rung or branch with the day of the year (1-366).</td>
</tr>
<tr>
<td>Week of Year</td>
<td>Replace the value of the rung or branch with the week of the year (1-53).</td>
</tr>
</tbody>
</table>

The time and date objects, when placed on a rung or branch, replace the rung’s or branch’s value with their own current value. Time and Date objects are useful when you need an event to occur at a certain time (e.g., you want to have an irrigation system come on and go off on certain days at specific times.) Time and Date objects do not require any inputs.

Notes:

- New virtual addresses are optional for these objects. They are generated by the system when necessary.

- To enable this object to retain it's value following a reboot of the Hyper SCADA Server, ensure it is configured as described in Retain Value After HSS Restart.
To view a simple example of how Time/Date objects can be used, see Ladder Logic Examples: Using Time/Date Objects.
Working with Ladders

Creating a New Ladder

To create a new ladder, choose New from the File menu.*

Opening an Existing Ladder

1. Choose Open from the File menu.

2. Browse to the file you want to open and click Open.* (Virtual Logic Builder files can only be opened from specific directories.)

* Note: Only one Virtual Logic Builder file can be open at a time. If a file with unsaved changes is already open and you attempt to open another one, a dialog box with the message "[file name].vlb not saved. Discard changes?" appears. If you want to save the changes to the current file, click Cancel, save your changes, and then open another file. If you don't want to save the changes, click Discard. IMPORTANT: You cannot reverse (undo) discarded changes.

See the following sections for additional information on creating and working with ladders.

- Saving Ladders
- Configuring Ladder Settings
- Downloading and Module Information for Use in Ladders
- Adding Comments
- Adding Cross References to Ladders
- Checking Your Ladder
- Testing Your Logic
- Installing and Uninstalling Ladders
- Printing Ladders
- Creating Similar Diagrams Quickly
- Deleting All Logic Generated by a Ladder Logic Program
Saving Ladders

When you save a Virtual Logic Builder file, it is placed on your local machine or server. No changes are made to HT3’s Virtual Points database until the ladder is installed. Note that Virtual Logic Builder files can only be saved in specific directories.

- **Save vs. Install**
- **The .vlb File**
- **Where to Save Workstation Files**
- **Saving Ladders**

Save vs. Install

Saving a file only places it on your local computer; it does not save it to the server. To save a ladder logic program to the server and make it active, you must install it. When a ladder logic program is installed, the diagram is converted to database points and it begins running on the server. To install a ladder, you must be logged in to Virtual Logic Builder with an account with Configure Telemetry permission, and your program must be saved. For more information on permissions, see "Configuring Your System: User Accounts" in the HT3 User Guide.

The .vlb File

Ladder logic programs are stored as ordinary files on your workstation computer, or a server attached to it. All Virtual Logic Builder file names end in the extension "".vlb"" (for example, "myladder.vlb").

When ladder logic programs are installed, the objects and operators they contain are converted into virtual points and auto controls. These items are stored separately in the Virtual Points database and the Auto Controls database, which are controlled by the HT3 server.

The .vlb file on your workstation contains a copy of this information. This copy is used when you make changes to your ladder logic program.

After making any changes to a ladder logic file, you must install the file again in order to update the Virtual Points and Auto Controls databases. To keep this duplicate information properly synchronized, you must ONLY edit the most up-to-date copy of your .vlb file.

Where to Save Workstation Files

Virtual Logic Builder files can only be saved in and opened from one of the directories listed below (or a subfolder of one of these directories). If you try to save a file to a different directory, you will get an "I/O error writing file ..." error. Attempting to open a file from a different directory results in an "I/O error reading file ..." error.

- Windows 95/98/ME - For computers running Windows 95/98/ME, the files can only be saved to the C:\My Documents directory.
Windows 2000 / NT / XP / Vista / 7 - For computers running these versions of the Windows operating system, the files can only be saved to the home directory (C:\Documents and Settings) of the user that is currently logged in. For example, C:\Documents and Settings\jane, where jane is the Windows user name of the individual currently logged in.

The Java policy file that you installed on your computer when it was first set up to connect to HT3 controls where files can be saved to and opened from. The Java policy file is designed to protect your computer from "hostile" Java applets that could try to access or damage the data on your computer (for example, to insert a virus). The HT3 policy file gives HT3's Java applets permission to write to specific directories on your computer. In effect, the policy file says that only Java applets from this server can write to this computer's drive; and this server can only write to this specific directory (and any subfolders of the directory).

If you want to keep your ladder files in their own directory, you can create a folder within one of the valid directories listed above and save the files there. If you need to store a Virtual Logic Builder file in another location (for example, a backup location on your network server), save the file to the correct directory (i.e., My Documents or Documents and Settings) and then copy it to the backup location. Additionally, to open a file that is stored in another directory, you must first copy the file to a valid directory (i.e., My Documents or Documents and Settings).

**Saving Ladders**

When you save a Virtual Logic Builder file, it is placed on your local machine or server. No changes are made to HT3’s Virtual Points database until the ladder is installed. Note that Virtual Logic Builder files can only be saved in specific directories.

It is important to frequently save your ladder logic programs as you are working on them. If there is a power outage or your computer "crashes," you will only have to reconstruct the portion you created after the last save.

**Saving a New Ladder**

1. Check your ladder logic diagram.
2. Choose Save As from the File menu.
3. In the Save As dialog box, enter a file name for this ladder, being sure to include the .vlb extension. For example, myfile.vlb.
4. Click Save. The Message bar displays "[file name] saved ([##] bytes)." Where [file name] is the name you assigned to the file and [##] represents the size of the file.

**Creating a Duplicate of an Existing Ladder**

There may be times when you want to create a ladder logic program that is very similar to an existing one. You can do this quickly using Save As to create a duplicate of the original ladder logic program. You can then make any necessary changes to points referenced in the duplicate program so that they reflect the correct point addresses.

1. Open the file you want to duplicate.
2. Change the file's virtual prefix (See Configuring Ladder Settings).
3. Check your ladder logic diagram.
4. Choose **Save As** from the **File** menu.

5. In the **Save As** dialog box, enter a new file name for this duplicate ladder, being sure to include the .vlb extension. For example, myfile.vlb.

6. Click **Save**. The Message bar displays "[file name] saved ([##] bytes)." Where [file name] is the name you assigned to the file and [##] represents the size of the file.

### Configuring Ladder Settings

The **Settings** command enables you to:

- Assign a **Virtual Prefix** for all unnamed virtual points contained in a ladder.
- Assign all virtual points contained in a ladder to a specific **partition**.

HT3 automatically assigns a prefix to new ladder logic programs, but it is good practice to change the prefix to something unique in order to avoid virtual point address conflicts, or duplication. When you **Check** your ladder logic programs, any conflicts that exist are displayed in the Message bar ("error, virtual addresses in use: [list of virtual addresses]"). This message is telling you that a virtual point with that address already exists. If you disregard this message and install your ladder without changing the virtual prefix, the existing virtual point with that address is replaced by the new one. Any other Virtual Logic Builder files that reference the existing point may no longer function properly.

1. Choose **Settings** from the **File** menu. The **Settings** dialog box opens. The system-generated prefix and default partition number are displayed.

2. Verify that **Server** is selected.

3. Enter a **virtual prefix** (must start with the letter "V").

4. If required, enter a **partition number**.

5. Click **Change**.
Virtual Prefix

When a ladder is installed, a virtual point is created for each object (except rungs and branches) contained within the ladder. All objects (virtual points) that do not have user-assigned names, are given system-generated names, or addresses. System generated addresses are formed by numbering each point sequentially and then adding the virtual prefix to each (i.e., VTimer1, VTimer2, etc.). The virtual prefix is automatically generated by the system, but it's good practice to change the prefix to something unique (e.g., VTimer, VSprinkler) to avoid overwriting existing virtual points that have the same system-generated prefix.

Partition

If you are running a partitioned system, you can assign all virtual points contained in a ladder to a specific partition. By default, Virtual Logic Builder assigns all ladders to Partition 0. Assigning a ladder to a partition only affects how virtual point alarms are displayed; it ensures that the alarm is displayed under its correct partition. Virtual points for a particular partition are still available to the entire system with regards to displaying status, including them in custom screens and other ladder programs, etc.

Downloading Module Information for Use in Ladders

The Define Module command allows you to download all of the configured modules for a specific station. You can then associate a point with an object by simply selecting the object and then choosing a point from a generated list. This list includes the point's type, its telemetry address, and its configured user-defined name.

- Using Define to Download Modules to the Module Menu
- Associating a Point with a Ladder Object
- Using Modules from a Different Station

Using Define to Download Modules

When you first open Virtual Logic Builder, the Module menu lists one command: Define.

<table>
<thead>
<tr>
<th>Module</th>
</tr>
</thead>
<tbody>
<tr>
<td>Define</td>
</tr>
</tbody>
</table>

After you have downloaded or added modules, the Module menu will look similar to this:
To download modules from a specific station:

1. Click **Define** to open the **Define Module** dialog box.

2. In the **Define Module** dialog box, enter a station number and click **Download**. All of the modules configured for that station are now listed in the Module menu.

Associating a Point with a Ladder Object

1. Click the Module menu and select the module that contains the point you want to use. (If the point is from a module at a station not listed in the Module menu, see Using Modules from a Different Station.)

2. A dialog box listing all of the module's points is opened.

3. To associate a point with a ladder object, select the object and then choose a point from the list. This list includes the point's type, its telemetry address, and its user-defined name.
Using Modules from a Different Station

The Module menu only lists the modules for a single downloaded station; modules for other downloaded stations are not listed but are still accessible. If your ladder uses points from more than one station, you can use the Use button in the Define Module dialog box to select the station that contains the point you need.

For example, if you download or add modules for station 1, then download or add modules for station 2, the station 2 modules would be listed in the Module menu. The station 1 modules are hidden, but can be recalled with the Use button.

To select a station to work with:

1. Select Define from the Module menu. The Define Module dialog box opens.
2. In the Station box, enter the number of the station you want to use.
3. Click Use.

Adding Comments

Comments can be added to your ladder logic programs to describe what the ladder logic program does or to provide information on the function of a particular section of logic.

- Comments can be inserted at the top of the diagram or between rungs.
- Each comment can hold up to 200 characters of text.

Adding a Comment

Comments are left-aligned and can be placed above or below a rung; they can’t be inserted in the middle of a rung.

1. Select the location for the comment:
   - To place a comment at the top of your ladder logic diagram, verify that nothing is selected (rung, object or operator), and then add your comment.
   - To place a comment below a particular rung, select the last object on the rung and then add your comment.
2. Choose Comment from the Ladder menu.
3. Add text to comment using one of the methods below.

   - Double click the comment or select the comment and press the Tab key. The default or existing text is highlighted. Enter the new text.
   - Right click the comment to open Inspector. Type the desired text in the Name box and press the Enter key.

4. Assign a line number to a comment using one of the methods below.

   - Select the comment and press the Tab key twice. The default or existing line number is highlighted. Enter the new line number.
   - Right click the comment to open Inspector. Type the desired line number in the ADDR box and press the Enter key.

### Adding Cross References to Ladders

Virtual Logic Builder’s Cross References feature, used in conjunction with the Go To command, can help you easily find and jump to the location(s) where a specific output object’s address appears again.

Cross references are displayed below all output objects and list the other line numbers where this particular address appears. You can use the Go To command to jump to the line numbers that are listed below the object.
Turn On Cross References

1. Choose Cross References from the Ladder menu.

2. The Message bar displays "References are displayed below OUT objects" and a check mark appears beside the Ladder menu’s Cross References command. Displayed below each output object is "refs: [#]", where [#] is the line number where this object's address is referenced. If the address appears on multiple lines, all the line numbers are listed. If an output object's address doesn't appear anywhere else in the program, nothing is listed below it.

Turn Off Cross References

1. Choose Cross References from the Ladder menu.

2. The Message bar displays "Cross References are now off." The check mark next to the Cross References command and the line numbers listed below the output objects disappear.

Using the Go To Command to Jump to a Specific Line

Go To enables you to quickly move from your current location in a ladder logic program to a specified line number. Go To, used in conjunction with Cross References, can be used to jump to line numbers where particular output object addresses appear.

1. Choose Go To from the Ladder menu.

2. In the Go To dialog box, enter the line number you want to jump to and click OK. Virtual Logic Builder jumps to the desired line number.
Checking Your Ladder

The **Check** command examines your ladder logic programs and returns error messages if Virtual Logic Builder encounters any problems as it scans the diagram, from beginning to end.

Check inspects the program for:

- Completeness - Do all objects that require addresses or inputs have them?
- Valid addresses - Are all assigned object addresses configured; do any system-generated virtual addresses conflict with existing ones?

If Virtual Logic Builder finds any errors in the program, an error message displays in the Message bar and the object in question is surrounded by a blue line. After you correct an error, you must check the program again to see if any others exist. Virtual Logic Builder displays the error messages one-by-one in the order in which they occur; it does not display *all* the errors at once.

**IMPORTANT**: Always check your ladder logic programs before saving and installing them.

Testing Your Logic

**Using the Control (Force) Command to Test Your Logic**

One way to test your logic is to temporarily insert user controls (Digital Input, Analog Input or Momentary Input objects) at key locations and manually change their value or state using the Control (Force) command to see what happens downstream. User control objects ignore the value coming in on their rung or branch.

Control doesn't change the state or value of any real telemetry points. It is simply a way to test how different conditions affect the rest of your ladder logic program.

Control can only be used with input objects. You must be logged in and the ladder logic program that contains the object you want to control must have been either checked or installed.

**Controlling an Object**

1. Select the object you want to control.
2. Choose **Control (Force)** from the **Edit** menu. The **Control** dialog box opens and the Message bar displays "Enter the new value for [object address]." Where [object address] is the virtual address of the object you want to control.
3. Enter the desired digital state (0 or 1) or analog value, and click OK. The Message bar displays "Setting control [object address] to [state or value]." Where [object address] is the virtual address of the object you are controlling and [state or value] is the desired digital state/analog value. To exit the Control dialog box without changing the object's state or value, click Cancel.

After the object's state or value has been set as indicated in the Control dialog box, you can see its effect by checking the ladder logic program.

Using Control (Force) with Animate and Simulate
The Control (Force) command can be used in conjunction with Animate and Simulate. Animate requires that the ladder be installed on the server. It uses real data from the server to show you how a change in value affects the executing logic. Keep in mind that with Animate the controls you exercise affect the real hardware.

If you want to test your logic without installing the ladder and affecting the server's data or field hardware, you can use the Simulate command. Simulate, when used with the Control (Force) command, allows you to change an object's value without affecting anything outside the ladder logic program; the changes only occur within Virtual Logic Builder.

If you want to use the Momentary Input for testing, you need to insert a constant (e.g., 1) before it. Momentary Input uses the input value as the number of seconds to stay on.

Refresh and Animate
The Refresh and Animate commands (both available from the Ladder menu) are similar in that they retrieve the current state or value of the telemetry points contained in a ladder logic program and display them on the screen. In this way, you can see your ladder logic in action and determine if any changes need to be made.

The difference between Refresh and Animate is in how they retrieve, or sample, the data.

Refresh
Refresh is a static representation, like taking a snapshot. Refresh shows you what the states and values were when you clicked Refresh. Any changes that occur after the "snapshot" is taken are not reflected on the screen.

Animate
Animate is a live-action representation of your telemetry. It reflects and displays any changes in state or value as they occur, and it will continue to retrieve data until you either select the Stop command or select an editing command.

With Animate, you can affect the logic as it executes by controlling the ladder's input points (Digital Input, Analog Input, Momentary Input) using the Control (Force) command.

To use Animate, the ladder must be installed on the server.
Simulate

The Simulate command is useful when developing and debugging programs, because it allows you to simulate a ladder program's logic without installing the ladder and affecting real hardware. When Simulate is turned on, you can use the Control (Force) command to change the value of an object and see how it affects the operation of the ladder. Simulate enables you to determine if the results are what you expected and desired before installing the ladder program on the server.

Installing and Uninstalling Ladders

Installing a Ladder

After a ladder logic program has been saved and checked, it is ready to be install. When a ladder logic program is saved, it is only placed on your local computer or server. No changes are made to HT3’s Virtual Points database until the ladder logic program has been installed.

To install a ladder logic program, you must log in to Virtual Logic Builder with an account with Configure Telemetry permission. See "Configuring Your System: User Accounts" in the HT3 User Guide.

1. Open the ladder you want to install.

2. Choose Install from the File menu. The Message bar flashes "updating..." while the ladder logic program is being installed. If any errors are encountered during the installation process, they are displayed in the Message bar.

3. When HT3 is finished installing the ladder logic program, the Message bar displays "installed successfully."

Uninstalling a Ladder

Uninstalling a ladder logic program only removes it from the HT3 server, not from the local machine on which it was created. Additionally, uninstalling a ladder removes all the virtual points contained in the ladder logic program.

To uninstall a ladder logic program, you must log in to Virtual Logic Builder with an account with Configure Telemetry permission. See "Configuring Your System: User Accounts" in the HT3 User Guide.

**IMPORTANT:** When a ladder is uninstalled, all virtual points that were created in the program are deleted from the HT3 server. Any other ladder logic programs that reference these virtual points will not function properly after the source ladder is removed.

1. Open the ladder you want to uninstall.

2. Choose Uninstall from the File menu. If any errors are encountered during the uninstall process, they are displayed in the Message bar.

3. When HT3 is finished uninstalling the ladder logic program, the Message bar displays "uninstalled successfully."
Printing Ladders
To print your Virtual Logic Builder ladder logic program:

1. Choose Print from the File menu.
2. Select a printer from the Print dialog box and click OK.

Duplicating a Ladder
If your system has multiple stations that use the same process, you can create one ladder and then duplicate it for the other stations.

- Use a known-working ladder as a template.
- Before saving and installing the ladder, you must assign a unique virtual address prefix for all the system-generated addresses in the ladder.

To use a ladder as a template:

1. Create a ladder logic program for one station, check that it is working properly, save it, and install it.
2. For each additional station:
   A. Choose Settings from the File menu and assign a unique virtual address prefix.
   B. Check your ladder logic program.
   C. Choose Save As from the File menu and give the ladder a different file name.
   D. Choose Install from the File menu.

Deleting All Logic Generated by a Ladder Logic Program
Follow the steps below to delete all the logic that is generated by a ladder logic program, including the virtual points contained within it. Note that uninstalling a ladder logic program only removes it from the HT3 server, not from the computer it was created and saved on.

**IMPORTANT:** Any virtual points created in the program you are removing will be deleted from the HT3 server. Any other ladder logic programs that reference these virtual points will not function properly after the source ladder is removed.

To uninstall the ladder and remove its virtual points from the HT3 server:

1. Log in to Virtual Logic Builder.
2. Choose Open from the File menu and select the program you want to remove.
3. Choose Uninstall from the File menu.
Working with Objects

- Establishing a Naming Convention
- Object Address Requirements
- Adding and Deleting Components
- Defining an Object's Properties
- Editing an Object
- Selecting and Moving Objects

Establishing a Naming Convention

Before you begin building ladder logic programs, it's a good idea to decide how you are going to name your objects. Should you use ALL CAPS, all lowercase or Title Case. Should you include spaces (well level), hyphens (well-level) or underscores (well_level).

Taking this step creates uniformity in your programs and makes it easier to search for objects by name. Because Virtual Logic Builder's Find command is case sensitive, having a consistent naming scheme will make it easier to find the objects you are looking for.

Object Address Requirements

- Examine objects (Examine Analog, Examine Off, Examine On) and Out objects (Analog Out, Out, Out Not) require an existing telemetry address.

- Input objects (Analog Input, Digital Input, Momentary Input) and Virtual Out objects (Virtual Out Analog, Virtual Out Digital) require a new virtual address.

- New virtual addresses are optional for all other objects. They are generated by the system when necessary.

Adding and Deleting Components

Adding Components

Keep in mind that when a new component is added to a ladder logic diagram, the new component is always placed to the RIGHT of the selected component. You need to plan ahead when designing ladder logic diagrams to ensure that components are added in the correct order.

Adding Rungs

Before any objects or operators can be added to a ladder logic diagram, a rung must be inserted (choose Rung from the Ladder menu). After inserting a rung, choose an object or operator from the Digital, Analog, Math, Compare or Time/Date menu.
• To add a rung, choose Rung from the Ladder menu.

A rung appears at the top of the program and the Message bar displays "RUNG created." The rung is surrounded by bright blue lines to show that it is selected. The number to the left is the line number where the rung is located.

To deselect the rung, move your mouse pointer to another position on the program and click.

You can move the rung up and down on the rails by selecting the rung, holding down the left mouse button (the pointer becomes a four-headed arrow) and dragging the rung to another location.

To add additional rungs to your ladder logic diagram:

• Below a rung - Select the last component on the rung and choose Rung from the Ladder menu. The new rung is inserted directly below the selected rung.

• At the top of the diagram - Verify that no components are selected and choose Rung from the Ladder menu. The new rung is inserted at the very top of the ladder logic diagram.

Adding Branches
Branches are an integral part of ladder logic diagrams. Branches are used to build "or" functions into logic or to make use of some logic to the left of the branch several times. They hold secondary inputs from objects and operators, such as Move and Less Than, that require more than one input to perform their function. Other objects, such as Time Delay and Cycle, need a branch that tells them how long to delay sending output or when they should reset.

When building logic with branches, you need to plan ahead. Usually it is best to create the top rung, including necessary objects, all the way across, then add the branches below. Always keep at least one object to the right of each junction, otherwise you will have to delete the branch and re-create it in the new position.

To add a branch:

1. Add the objects that are to be the starting point and ending point for the branch (see example below).

2. Select the rung or branch that holds the starting point and choose Branch from the Ladder menu. The beginning of the branch appears to the left of the starting point and is connected to the rung or branch; the mouse pointer becomes a cross-hair.

3. Drag the cross-hair to the ending point and click. The complete branch appears on the diagram.

Notes:

• For consistent results, always start a branch to the left of the starting point.
• If you try to connect a branch to an object other than a rung or BRANCH, the Message bar displays "cannot insert BRANCH here."

Adding Objects and Operators
To add components (other than a rung) to a ladder logic diagram, you must first select a component - rung, branch, object or operator. If you don't select a component, the Message bar displays "select an object first."

When new components are added, they are placed to the right of the selected object.

• If you select an object, such as Examine Analog, and add another component, such as Virtual Out, the Virtual Out object is inserted to the right of the Examine Analog object.

• If you select an empty rung or branch, the new component is added directly onto the selected rung or branch.

• If you select a rung or branch that already contains components, the new component is added to the very beginning of the rung or branch.

Defining an Object's Properties
After adding an object to your ladder, there are two methods for defining the object's properties, including its telemetry address and point name:

• Entering information through Inspector

• Downloading module Information from the HT3 server (see Downloading Module Information for Use in Ladders).

Defining an Object Through Inspector
You can manually enter all of the point's information in the Inspector window.

See Getting Around Virtual Logic Builder: Inspector for descriptions of each of Logic Inspector's fields.

1. Right click an object; or select the object and then choose Properties from the Edit menu.
2. In the Inspector window, type the point's name and any other necessary information in the configuration boxes. You can select a point address to associate with the object using the ADDR button.

Inspector features its own Edit menu. See also Editing an Object and Getting Around Virtual Logic Builder: Inspector.

Using the ADDR Button to Select Points to Associate with an Object

Inspector's ADDR button can be used to browse to the point that you want to associate with an object. Note that this method is only available for Examine objects (Digital Examine On, Digital Examine Off, Examine Analog) and control objects (Digital Out, Digital Out Not, Analog Out).

1. Click the ADDR button.
2. Browse to the point you want to use and click OK.

An error message will appear at the bottom of the Inspector window if an analog point is selected for a digital input (Examine On or Off), a digital point is selected for an analog input (Examine Analog), or an input point is selected for an output function.

Editing an Object

IMPORTANT: You must use Virtual Logic Builder to make edits to virtual points or auto control points that were created in or generated by Virtual Logic Builder. Do not use Configuration Editor to make changes to these points. Edits made with Configuration Editor do not affect your Virtual Logic Builder file. Any changes made using Configuration Editor will not be reflected the next time you open your ladder logic program in Virtual Logic Builder and may adversely affect the program's function. You can use Configuration Editor to add other auto controls that were not created in or generated by Virtual Logic Builder. You should not use the Configuration Editor to change auto controls that were generated by Virtual Logic Builder.

To change an object's properties, you need to access Inspector. This can be accomplished one of two ways:
• Select the object and then choose **Properties** from the **Edit** menu.

• Right click the object.

After Inspector opens

1. Place your cursor in the field that contains the data you want to change and delete any existing data.

2. Type your changes and press the Enter key. You can use the **ADDR button** to change the point address assigned to the object.

**Inspector's Edit Menu**

Inspector features an editing menu that can be accessed by placing your cursor in one of the parameter fields and clicking the right mouse button.

This editing menu contains the following commands:

- **Undo** - Reverse the last editing operation. Will redo the last editing operation if it was an undo.
- **Cut** - Remove the selected text and place it on the clipboard.
- **Copy** - Copy the selected text and place it on the clipboard.
- **Paste** - Copy the selected text and place it on the clipboard.
- **Delete** - Permanently remove the selected text.
- **Select All** - Select all the text contained in the current field.

For more information on Inspector and its fields, see [Getting Around Virtual Logic Builder: Inspector](#).

**Shortcut for Changing an Object's Name or Telemetry Address**

To quickly change an object's name or telemetry address without launching Inspector or using the point list generated by Define Module:

1. Double click the object. The **Addr** field becomes active.
2. With the default or existing address highlighted, type the new address and then press the Tab key. The **Name** field becomes active.

3. With the default or existing name highlighted, type the new name and press the Enter key.

---

**Selecting and Moving Objects**

Before an object can be manipulated or edited in any way, you must first select it. Selecting an object is simply a matter of clicking it. When an object has been selected it is surrounded by a bright blue line and the Message bar displays "[object name] selected."
Selecting Multiple Objects

It is also possible to select multiple objects so that an action can be simultaneously performed on the group. This is useful when you want to copy a group of objects to a new location or need to delete a group of objects. Instead of selecting and copying/deleting each item, you select all the objects and then perform the function.

To select a group of objects: click on any object in the group, then hold down the Shift key and click on the second, third, fourth, etc. As you click on objects, the Message bar displays "1 objects selected," "2 objects selected," etc. When you have finished selecting objects, perform the desired command.

Dragging (Moving) Objects

You can move rungs and branches vertically by selecting the rung or branch and, while holding down the left mouse button, drag it up or down. For finer control of movement, select the rung or branch and, while it is still selected, use the arrow keys on the keyboard to move it up or down.

You can use the same methods to move other ladder logic objects, except that other objects can only be moved horizontally along the rung or branch they are positioned on.
Editing Tools

- Using the Undo Command
- How to Cut, Copy and Paste
- Deleting Ladder Components
- Using Find and Replace to Locate and Change Addresses and Descriptions

Using the Undo Command

The **Undo** command is used to reverse an editing action, such as **Cut** or **Paste**, or to remove an item that you mistakenly added to your ladder logic diagram. Undo only reverses the last action taken; you can't undo an action taken, for example, three steps ago.

To reverse the last action performed, choose **Undo** from the **Edit** menu.

If the last action can't be reversed, the Message bar displays "UNDO not available."

You can also reverse an undo (perform a redo) by simply choosing **Undo** from the **Edit** menu again.

How to Cut, Copy and Paste

The **Edit** menu's **Cut**, **Copy** and **Paste** commands can be used to perform such actions as moving an object from one location to another or making a duplicate of an object. Groups of objects can be cut or copied, and pasted by selecting multiple objects.

Cut or copy an object and paste it in a new location

1. Select the object you want to cut or copy.
2. Choose **Cut** or **Copy** from the **Edit** menu.
3. Select where you want to insert the object and choose **Paste** from the **Edit** menu. (Review [Working with Objects: Adding and Deleting Components](#) for more information on how Virtual Logic Builder determines where an object is placed.)

Inspector features its own editing menu. For more information on using Inspector’s editing menu, see [Working with Objects: Editing an Object](#).

Deleting Ladder Components

The Delete command is used to delete ladder logic components, such as branches, objects and operators.

1. Select the object to be deleted.
2. Choose **Delete** from the **Edit** menu.
When deleting objects that are related, or connected, to one another, you must delete the objects in the reverse order in which they were added. For example, your ladder logic diagram has an Equal operator whose second input is a Branch that contains a Constant.

When these objects were added they were added in the following order: Equal, branch, Constant. The objects must be deleted in the exact opposite order: Constant, branch, Equal. If you attempt to delete the branch before the Constant, the Message bar displays "Error, related object(s) are not selected."

You can also select multiple objects and simultaneously perform a delete on all of the selected objects. See Working with Objects: Selecting and Moving Objects for more information.

Inspector features its own menu that must be used to perform editing actions. For more information on using Inspector’s editing menu, see Working with Objects: Editing an Object.

Using Find and Replace to Locate and Change Addresses and Descriptions

Use the Find and Find Again commands to search your ladder logic programs for occurrences of a particular address or description. For example, to locate each object that has 10A5 as its address or includes Pump in its name. Optionally, you can replace the search string using the Replace and Replace Again commands.

Find is case sensitive. For this reason, you should be consistent in how you name your objects. Determine a naming convention (all caps, all lowercase, title case, etc.) and stick with it. Being consistent will save you time and frustration when you are trying to locate an object in a ladder logic diagram that has numerous rungs.

Find (and Replace)

1. Choose Find from the Ladder menu.
2. In the **Find** dialog box, enter the character string you want to search for in the **Find What String** box.

3. Choose where you want to search: click **Address** to search the ADDR field; click **Description** to search the NAME field.

4. Choose how you want to search:
   - **Equals** finds strings that exactly match your search string. For example, to find objects with the address 1B1, type the full and exact address (1B1) in the **Find What String** box.
   - **Contains** finds strings that include your search string. For example, selecting **Description** and entering the word Well as the search string, finds Wet Well Level #1 and Wet Well Level #2.
   - **Starts With** finds strings that begin with the same characters as your search string. For example, selecting Address and entering 1B as the search string, finds 1B1, 1B2 and 1B3.
   - **Ends With** finds strings that end with the same characters as your search string. For example, selecting Description and entering the word Level as the search string, finds Low Level, Lag Level and Lead Level.

5. Click **Find** to begin your search. Virtual Logic Builder jumps to the first occurrence of the string. If the string is not found, the Message bar displays "not found."

6. To replace the search string with another string, enter the desired string (address or description) in the **Replace with** box and click **Replace**.

**Note:** If you use the **Find** command, the Ladder menu will display the **Find Again** command. If you use the **Replace** command, the Ladder menu will instead display the **Replace Again** command.

**Find Again (and Replace Again)**

- The **Find Again** command (choose **Find Again** from the Ladder menu) searches for the next occurrence of the most recent Find operation.

- The **Replace Again** command (choose **Replace Again** from the Ladder menu) searches for the next occurrence of the most recent Find operation and replaces the string with the string entered in the **Replace with** box.

**Notes:**
• The **Find Again** command will only be displayed in the **Ladder** menu after you've performed a Find; the **Replace Again** command will only be displayed after you've performed a Replace.

• Find Again doesn't open the **Find** dialog box and doesn't require you to enter any information. If there is another occurrence of the string, Virtual Logic Builder jumps to that location. If there aren't any more occurrences of the string, the Message bar displays "not found."
Appendix

- Ladder Logic Examples
  - Using Examine Objects
  - Using Output Objects
  - Using Time/Date Objects
  - Using the Cycle Object
  - Using the Latch Object
  - Using the Move Object

- Sample Ladder - Irrigation System

- Editing Virtual Points and Auto Controls

- Timer and Counter Resets

- Retain Value After HSS Restart

- Keyboard Shortcuts

Ladder Logic Examples

- Using Examine Objects
- Using Output Objects
- Using Time/Date Objects
- Using the Cycle Object
- Using the Latch Object

Using Examine Objects

In this example, we create a ladder logic diagram that determines if a high well level condition exists by taking the following steps:

- Retrieve the value of a point that measures the level of a well.

- Determine if the well level is greater than or equal to a constant value.

- Output the result of the comparison to a virtual point. If the above statement is true, the virtual point will have a digital value of 1. If the above statement is not true, the virtual point will have a digital value of 0. This virtual point will then be used in another equation (See the Using Output Objects example) to determine if a pump should be turned on.
1. Start Virtual Logic Builder and create a new ladder logic diagram.

2. Add a rung.

3. Add an Examine Analog object and assign it the existing telemetry address 3A52 (address of point that measures well level). Name the object "Well Level."

4. Add a Greater or Equal operator to the right of Well Level. Move the Greater or Equal operator to the right so there is sufficient room between it and Well Level.

5. Add a branch that begins to the left of Well Level and ends at Greater or Equal.

6. Add a Constant to the branch. Set the value of the Constant to 45.000.

7. Select the Greater or Equal operator and add a Virtual Out. Assign the Virtual Out object the new virtual address V_HWELL. Change the name of the Virtual Out object to "High Well."

### Using Output Objects

In this example, we create a ladder logic diagram that turns on a pump if a high well level condition exists by taking the following steps:

- Retrieve the value of a virtual point that outputs a 1 (well level is high) or 0 (well level is not high).
- Determine if the above virtual point is "true" has a value of 1 by comparing its value to a constant (1).
- Output the result to an auto control point. If the output from the comparison is true (equal to 1), the pump is turned on.

This diagram uses the virtual point High Well (virtual address V_HWELL) that was created in the Using Examine Objects example.
1. Start Virtual Logic Builder and create a new ladder logic diagram.

2. Add a rung.

3. Add an Examine On object. Assign Examine On the existing virtual address V-HWELL. Change its name to "High Well."

4. Add an Equal operator to the right of High Well. Move Equal to the right so that there is sufficient room between it and High Well.

5. Add a branch that begins to the left of High Well and ends at Equal.

6. Add a Constant to the branch. Set the value of the Constant to 1.

7. Add a digital Out to the right of Equal. Assign it the existing telemetry address 3A65 (address of the auto control that turns on the pump). Change the name of the Out object to "Pump 1 Start."

**Using Time/Date Objects**

In this example, we create a ladder logic diagram that determines if today is Monday by taking the following steps:

- Retrieve the current day of week value (possible values are 1 - 7, where 1 = Sunday).
- Check if current day is equal to 2 (Monday).
- Output the result of this comparison to a virtual point. If the above comparison is true (today is Monday), then the output is 1. If the comparison is not true, then the output is 0.
2. Add a rung.

3. Add a Day of Week object.

4. Add an Equal operator to the right of Day of Week.

5. Add a branch that begins to the left of Day of Week and ends at Equal.

6. Add a Constant to the branch. Set the value of the Constant to 2.

7. Add an analog Virtual Out to the right of Equal. Assign it the new virtual address V_MONDAY. Change the name of the analog Virtual Out to "Monday?".

**Using the Cycle Object**

In this example, we create a ladder logic diagram that counts the number of times a pump has come on during a 24-hour period by taking the following steps:

- Retrieve the current state of Pump1 and adds a 1 to Cycle if Pump1 is on.
- Reset Cycle at midnight.
- Output the total to an analog Virtual Out that is given the new virtual address V_PUMP1ON.

Using the Latch Object

In this example, we create a ladder logic diagram that turns on a sprinkler at 9:00 AM and turns it off at 10:00 AM by taking the following steps:

1. Start Virtual Logic Builder and create a new ladder logic diagram file.

2. Add a rung.

3. Add an Examine On object. Assign Examine On the existing telemetry address 10B2. Change its name to "Pump 1."

4. Add a Cycle object to the right of Pump 1. Move Cycle to the right so that there is sufficient room between it and Pump 1. ([Note: By not adding a branch with a timer to Cycle's second input, we force HT3 to automatically reset Cycle at midnight.]

5. Add an analog Virtual Out to the right of Cycle. Assign Virtual Out the new virtual address V_PUMP1ON. Change the Virtual Out's name to "Pump1 On Count." Set this object's Log field to Y. Doing this enables us to track and view cycle count changes using HT3's Detail Report.

**Using the Latch Object**

In this example, we create a ladder logic diagram that turns on a sprinkler at 9:00 AM and turns it off at 10:00 AM by taking the following steps:
- Create the conditions for setting and resetting the Latch.
- Use these conditions for the set and reset inputs for the Latch.
- Send output from the Latch to the auto control point named Sprinkler Start.

1. Start Virtual Logic Builder and create a new ladder logic diagram file.

2. Create the Set Latch condition. An auto control point is SET when the current hour is equal to 15, current minute is equal to 10 and current second is equal to 01. (See the Using Time/Date Objects example). The result of the first condition (Hour = 15) is output to the Examine On object VCON1. The result of the second condition (Minute = 10) is output to the Examine On object VCON2. The result of this evaluation is output to a digital Virtual Out object. The Virtual Out object is given the new virtual address V_SET and is renamed "SET." When Second = 01 and both VCON1 and VCON2 are true, the latch is SET.

3. Create the Reset Latch condition. An auto control point is RESET when current hour is equal to 10, current minute is equal to 0 and current second is equal to 0. (See the Using Time/Date Objects example). The result of the first condition (Hour = 15) is output to the Examine On object VCON3. The result of the second condition (Minute = 15) is output to the Examine On object VCON4. The result of this evaluation is output to a digital Virtual Out object. The Virtual Out object is given the new virtual address V_RESET and is renamed "RESET." When Second = 01 and both VCON3 and VCON4 are true, the latch is RESET.

4. Add a rung below the Reset Latch condition.

5. Add an Examine On object. Assign it the virtual address V_SET (created in step 2, above) and rename it "SET."

6. Add a Latch to the right of SET.

7. Add a branch that starts to the left of SET and ends at the Latch.
8. Add an Examine On object to the branch. Assign it the virtual address V_RESET (created in step 3, above) and rename it "RESET."

9. Add a digital Out to the right of the Latch. Assign it the real, existing telemetry address 1A1 (address of the point that controls the sprinklers) and rename it "Start Device."

Using the Move Object

In this example, we create a ladder logic diagram that turns on a pump if the well level reaches a certain depth by taking the following steps:

- Retrieve the current value for the well level.
- Determine if the current level is less or equal to a constant value.
- If current well level is less than or equal to the constant, a 1 is output, which starts a pump. If current well level is not less than or equal to the constant, a 0 is output.

1. Start Virtual Logic Builder and create a new ladder logic diagram file.

2. Add a rung and move it down a little.

3. Add an Examine Analog object. Assign it the real, existing telemetry address 1A52 (address of point that measures level of well) and rename it "Well Level."

4. Add a Less or Equal object to the right of Well Level.

5. Add a branch that begins to the left of Well Level and ends at Less or Equal.

6. Add a Constant to the branch and set its value to 15.000 (the level at which we want the pump to come on).

7. Add a Move object to the right of Less or Equal.

8. Add a branch that begins to the left of the Well Level/Less or Equal branch and ends at the Move object.

9. Add a digital Out to the right of the Move object. Assign it the real, existing telemetry address 1A65 (address of point that starts pump) and rename it "Pump1 Starter."
Sample Ladder - Irrigation System

This ladder uses logic to turn on an irrigation system every Monday at 9:00am and turns it off at 10:00am.

We create two sections of logic:

- Compare the current date and time to the conditions we've set and outputs the results (true or false) to virtual points.

- Retrieve and evaluate the current value of the virtual points. If they are all true, turn the sprinklers on or off.

Step 1: Compare Current Date to Conditions We've Set

In this section, we create our comparisons. Is today Monday? Is the current hour 9 AM? etc. The results of these comparisons are output to virtual points. If the comparison is true, a 1 is output to the virtual point. If the comparison is not true, a 0 is output.

1. Add a Comment - "Comparisons for Turning on/off Sprinklers" - that identifies the function of this section of logic.

2. Add a rung below the Comment.

3. Add a Day of Week object.

4. Add an Equal operator to the right of the Day of Week object.
5. Add a branch that begins to the left of the Day of Week object and ends at the Equal object.

6. Add a Constant to the branch. Assign the Constant a value of 2 (Monday = 2).

7. Add a digital Virtual Out object to the right of the Equal object. Assign the Virtual Out object the new virtual address V_MONDAY and name the object "Monday?".

Steps 2-7 retrieve the current value of Day of Week and compare it to the constant 2 (Monday = 2). If they are equal (i.e., the comparison is true), a 1 (one) is output to V_MONDAY. If they are not equal, a 0 (zero) is output. This same basic format is used to create the other compare equations. (Refer to the diagram above.)

**Step 2: Retrieve and Evaluate Current Value of Virtual Points**

In this section, we evaluate if the conditions for turning the irrigation system on or off are true. The values of each of the virtual points is sampled.

- If all of them have a value of 1 (condition is true), then a 1 is output to the auto control point for our irrigation system.
- If any point has a 0 (false) value, the entire equation becomes false and a 0 is output.

1. Add a Comment - "Evaluation for Turning On Sprinklers" - that identifies the function of this section of logic.

2. Add a rung below the Comment.

3. Add a digital Examine On object to the rung. Assign the Examine On object the address V_MONDAY and name the object "Monday?".

4. Add a digital Examine On object to the right of Monday? (V_MONDAY). Assign it the address V_HOUR_9 and name it "Hour=9?".
5. Add a digital Examine On object to the right of Hour=9? (VHOUR_9). Assign it the address VMIN_0 and name it "Min=0?".

6. Add a digital Examine On object to the right of Min=0? (VMIN_0). Assign it the address VSEC_0 and name it "Sec=0?".

7. Add a digital Out object to the right of Sec=0? and assign it the address 1B1 (the address of the auto control point that controls the irrigation system).

The same basic format is used to create the evaluation equation for turning off the sprinklers. (Refer to the diagram above.) The major difference is the use of an Out Not object to receive the result of our evaluation. The Out Not object inverts the value that it receives. So, if all the conditions are true, Out Not sends a 0 (false) instead of a 1 and turns off the sprinklers.

**Editing Virtual Points and Auto Controls**

*You must* use Virtual Logic Builder to make edits to virtual points or auto control points that were created in or generated by Virtual Logic Builder. Do *not* use Configuration Editor to make changes to these points. Edits made with Configuration Editor do not affect your Virtual Logic Builder file. Any changes made using Configuration Editor will not be reflected the next time you open your ladder logic program in Virtual Logic Builder and may adversely affect the program's function.

You can use Configuration Editor to add other auto controls that were not created in or generated by Virtual Logic Builder. You should not use the Configuration Editor to change auto controls that were generated by Virtual Logic Builder.

**Timer and Counter Resets**

- **Time Delay** automatically resets when the first input goes false.

- **Retentive Timer** has an optional reset input. If it is left blank, Retentive Timer resets itself after a minimum width output pulse. This is similar to how the One-Shot (DIFU) functions.

- **Cycle, On Time, Total** and **Flow** have optional reset inputs. If the reset input is left blank, HT3 will reset the object at the start of each day (midnight).

**Retain Value After HSS Restart**

To enable any virtual object/point to resume its previous value after a telemetry restart (i.e., read the value from the journal log):

- The object must have a configured virtual address. (The address must start with the letter V and cannot be more than 12 characters long.)

- The object's INITIAL value must be set to NULL.

- LOCAL must be set to N. (Disabling LOCAL makes the virtual point available to HT3; it isn't confined to the ladder.)

- LOG must be set to Y. (Enabling LOG allows this object's changes to be written to the journal.)
Note: Analog virtual objects no longer need to be scaled. Beginning with HT3 3.0.3, analog virtual objects are stored in the journal as floating point values.

Keyboard Shortcuts
Some of Virtual Logic Builder’s menu commands feature keyboard shortcuts. The table below lists, in alphabetical order, Virtual Logic Builder commands that have keyboard shortcuts. You can print out this page to use as a quick reference guide.

The plus (+) sign indicates the keys must be pressed at the same time. Press and continue to hold down the CTRL key and then press the next listed key.

<table>
<thead>
<tr>
<th>Command</th>
<th>Shortcut</th>
</tr>
</thead>
<tbody>
<tr>
<td>Animate</td>
<td>CTRL + A</td>
</tr>
<tr>
<td>Check</td>
<td>CTRL + K</td>
</tr>
<tr>
<td>Control</td>
<td>CTRL + T</td>
</tr>
<tr>
<td>Copy</td>
<td>CTRL + C</td>
</tr>
<tr>
<td>Cut</td>
<td>CTRL + X</td>
</tr>
<tr>
<td>Delete</td>
<td>Backspace key</td>
</tr>
<tr>
<td>Exit</td>
<td>CTRL + Q</td>
</tr>
<tr>
<td>Find</td>
<td>CTRL + F</td>
</tr>
<tr>
<td>Find Again</td>
<td>CTRL + G</td>
</tr>
<tr>
<td>Go To</td>
<td>CTRL + J</td>
</tr>
<tr>
<td>Install</td>
<td>CTRL + I</td>
</tr>
<tr>
<td>Open</td>
<td>CTRL + O</td>
</tr>
<tr>
<td>Paste</td>
<td>CTRL + V</td>
</tr>
<tr>
<td>Print</td>
<td>CTRL + P</td>
</tr>
<tr>
<td>Refresh</td>
<td>CTRL + R</td>
</tr>
<tr>
<td>Save</td>
<td>CTRL + S</td>
</tr>
<tr>
<td>Stop</td>
<td>CTRL + . (period key)</td>
</tr>
<tr>
<td>Undo</td>
<td>CTRL + Z</td>
</tr>
</tbody>
</table>
Part X
10 Appendix

- External Status Points
- Modbus Emulation
- Registry Editor
- MySQL
External Status Points

HT3 has built-in external status points that monitor the health of the system, including the HSU’s AC power, voltage of the backup battery, and the occurrence of daily data and configuration backups. Many of these points are included in the System Statistics screen included with HT3.

Additionally, HT3 incorporates an SQL database backend that is based on the database server engine MySQL that enables it to import status from third party software via an ODBC connection. With this feature, another piece of software can collect telemetry data and provide the status to HT3 via the rt_xstatus table.

Once external status has been collected, the data can be used in custom screens and virtual logic the same way local physical I/O points are used. All external status points can be configured to issue alarms. These alarms can be used in alarm reports and will appear in alarm logs. Please note, however, that external points themselves are not logged and cannot be used in trends.

For more information on HT3’s MySQL tables, see the section MySQL.

**IMPORTANT:** Points configured as external points in HT3 should match their actual configuration in the source software package. Failure to do so may produce unexpected results.

Refer to the sections below for information on using HT3’s external points table.
- Built-in External Status Points
- rt_xstatus Table Structure
- External Status Examples
- Configuring External Points
- External Point Alarms

Built-in External Status Points

**IMPORTANT:** You should not change the point type for any of these built-in external status points. Doing so will cause the point’s status to be incorrectly displayed/reported.

To configure an alarm for an external status point, follow the same procedure used for local HT3 points. See Alarms for more information.

External Status points are listed in Configuration Editor in the branch named “External Points.” Note that some of these points (e.g., X_TAKEOVER and XSYS_2ND_HSM) apply to redundant systems only.

HT3 features the following built-in external status points:

<table>
<thead>
<tr>
<th>Point Name</th>
<th>Description</th>
</tr>
</thead>
</table>

---
<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>XSYS_2ND_HSM</td>
<td>Indicates status of redundant HSM (Did the acting primary Hyper Server Module get a response when it sent a network ping to the secondary HSM?). This is a digital point with states of FAILED or OK.</td>
</tr>
<tr>
<td>X_ACPOWER</td>
<td>Indicates the AC power status of the active Hyper Server Module (HSM). This is a digital point with states of OFF or ON.</td>
</tr>
<tr>
<td>X_PW_BACKUP</td>
<td>Indicates the success or failure of the most recent backup to the Windows workstation that has been configured as the remote backup location. This is a digital point with states of FAILED or CURRENT.</td>
</tr>
<tr>
<td>X_TAKEOVER</td>
<td>Monitors the occurrence of a takeover by the system's optional redundant HSM. This is a digital point with states of NORMAL or TAKEOVER.</td>
</tr>
<tr>
<td>XSYS_CF_G_DRV</td>
<td>Number of configured drivers</td>
</tr>
<tr>
<td>XSYS_CF_G_PNT</td>
<td>Number of configured points</td>
</tr>
<tr>
<td>XSYS_CF_G_STN</td>
<td>Number of configured stations</td>
</tr>
<tr>
<td>XSYS_CP_U_AVG</td>
<td>Average CPU load</td>
</tr>
<tr>
<td>XSYS_CP_U_C</td>
<td>CPU temperature measured in celcius</td>
</tr>
<tr>
<td>XSYS_CP_U_F</td>
<td>CPU temperature measured in fahrenheit</td>
</tr>
<tr>
<td>XSYS_DR_VLP_0</td>
<td>Loop time of driver 0 (measured in seconds); loop time is also available in minutes (XSYS_DRVMIN0) and seconds (XSYS_DRVSEC0)</td>
</tr>
<tr>
<td>XSYS_DR_VLP_1</td>
<td>Loop time of driver 1 (measured in seconds); loop time is also available in minutes (XSYS_DRVMIN1) and seconds (XSYS_DRVSEC1)</td>
</tr>
<tr>
<td>XSYS_DR_VLP_2</td>
<td>Loop time of driver 2 (measured in seconds); loop time is also available in minutes (XSYS_DRVMIN2) and seconds (XSYS_DRVSEC2)</td>
</tr>
<tr>
<td>XSYS_DR_VLP_3</td>
<td>Loop time of driver 3 (measured in seconds); loop time is also available in minutes (XSYS_DRVMIN3) and seconds (XSYS_DRVSEC3)</td>
</tr>
<tr>
<td>XSYS_DR_VLP_4</td>
<td>Loop time of driver 4 (measured in seconds); loop time is also available in minutes (XSYS_DRVMIN4) and seconds (XSYS_DRVSEC4)</td>
</tr>
<tr>
<td>XSYS_DR_VLP_5</td>
<td>Loop time of driver 5 (measured in seconds); loop time is also available in minutes (XSYS_DRVMIN5) and seconds (XSYS_DRVSEC5)</td>
</tr>
<tr>
<td>XSYS_DR_VLP_6</td>
<td>Loop time of driver 6 (measured in seconds); loop time is also available in minutes (XSYS_DRVMIN6) and seconds (XSYS_DRVSEC6)</td>
</tr>
<tr>
<td>Variable</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------</td>
<td>------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>XSYS_DRVLP_7</td>
<td>Loop time of driver 7 (measured in seconds); loop time is also available in minutes (XSYS_DRVMIN7) and seconds (XSYS_DRVSEC7)</td>
</tr>
<tr>
<td>XSYS_DRVMIN0</td>
<td>The calculated minute portion of the point XSYS_DRVLP_0</td>
</tr>
<tr>
<td>XSYS_DRVMIN1</td>
<td>The calculated minute portion of the point XSYS_DRVLP_1</td>
</tr>
<tr>
<td>XSYS_DRVMIN2</td>
<td>The calculated minute portion of the point XSYS_DRVLP_2</td>
</tr>
<tr>
<td>XSYS_DRVMIN3</td>
<td>The calculated minute portion of the point XSYS_DRVLP_3</td>
</tr>
<tr>
<td>XSYS_DRVMIN4</td>
<td>The calculated minute portion of the point XSYS_DRVLP_4</td>
</tr>
<tr>
<td>XSYS_DRVMIN5</td>
<td>The calculated minute portion of the point XSYS_DRVLP_5</td>
</tr>
<tr>
<td>XSYS_DRVMIN6</td>
<td>The calculated minute portion of the point XSYS_DRVLP_6</td>
</tr>
<tr>
<td>XSYS_DRVMIN7</td>
<td>The calculated minute portion of the point XSYS_DRVLP_7</td>
</tr>
<tr>
<td>XSYS_DRVSEC0</td>
<td>Number of seconds remaining after minute portion of XSYS_DRVLP_0 has been calculated</td>
</tr>
<tr>
<td>XSYS_DRVSEC1</td>
<td>Number of seconds remaining after minute portion of XSYS_DRVLP_1 has been calculated</td>
</tr>
<tr>
<td>XSYS_DRVSEC2</td>
<td>Number of seconds remaining after minute portion of XSYS_DRVLP_2 has been calculated</td>
</tr>
<tr>
<td>XSYS_DRVSEC3</td>
<td>Number of seconds remaining after minute portion of XSYS_DRVLP_3 has been calculated</td>
</tr>
<tr>
<td>XSYS_DRVSEC4</td>
<td>Number of seconds remaining after minute portion of XSYS_DRVLP_4 has been calculated</td>
</tr>
<tr>
<td>XSYS_DRVSEC5</td>
<td>Number of seconds remaining after minute portion of XSYS_DRVLP_5 has been calculated</td>
</tr>
<tr>
<td>XSYS_DRVSEC6</td>
<td>Number of seconds remaining after minute portion of XSYS_DRVLP_6 has been calculated</td>
</tr>
<tr>
<td>XSYS_DRVSEC7</td>
<td>Number of seconds remaining after minute portion of XSYS_DRVLP_7 has been calculated</td>
</tr>
<tr>
<td>XSYS_DTDAY</td>
<td>Current day</td>
</tr>
<tr>
<td>Variable</td>
<td>Description</td>
</tr>
<tr>
<td>----------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>XSYS_DT_HR</td>
<td>Current hour</td>
</tr>
<tr>
<td>XSYS_DT_MIN</td>
<td>Current minute</td>
</tr>
<tr>
<td>XSYS_DT_MON</td>
<td>Current month</td>
</tr>
<tr>
<td>XSYS_DT_YR</td>
<td>Current year</td>
</tr>
<tr>
<td>XSYS_HD_FREE</td>
<td>Amount of free hard drive space (measured in gigabytes)</td>
</tr>
<tr>
<td>XSYS_HD_PCT</td>
<td>Amount of used hard drive space as a percentage of total hard drive space</td>
</tr>
<tr>
<td>XSYS_HD_TOT</td>
<td>Total hard drive space (measured in gigabytes)</td>
</tr>
<tr>
<td>XSYS_HD_USED</td>
<td>Amount of used hard drive space (measured in gigabytes)</td>
</tr>
<tr>
<td>XSYS_ME_M_CCH</td>
<td>Memory cache (measured in megabytes)</td>
</tr>
<tr>
<td>XSYS_ME_M_FR</td>
<td>Amount of free memory (measured in megabytes)</td>
</tr>
<tr>
<td>XSYS_ME_M_PCT</td>
<td>Amount of used memory as a percentage of total memory</td>
</tr>
<tr>
<td>XSYS_ME_M_TOT</td>
<td>Total memory space (measured in megabytes)</td>
</tr>
<tr>
<td>XSYS_ME_M_USE</td>
<td>Amount of used memory (measured in megabytes)</td>
</tr>
<tr>
<td>XSYS_TCP_P_CON</td>
<td>Number of current active TCP connections. This number includes all workstations currently logged into the system as well as network devices, such as Network Interface Modules (NIM), communicating with the Hyper SCADA Server over the network.</td>
</tr>
<tr>
<td>XSYS_UP_DAYS</td>
<td>Used in conjunction with XSYS_UP_HRS and XSYS_UP_MIN to report the number of days, hours and minutes the active Hyper Server Module has been running since its last reboot.</td>
</tr>
<tr>
<td>XSYS_UP_HRS</td>
<td>Used in conjunction with XSYS_UP_DAYS and XSYS_UP_MIN to report the number of days, hours and minutes the active Hyper Server Module has been running since its last reboot.</td>
</tr>
<tr>
<td>Field Name</td>
<td>Definition</td>
</tr>
<tr>
<td>-----------------</td>
<td>------------</td>
</tr>
<tr>
<td>address</td>
<td>Char(12)</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td>type</td>
<td>Char(2)</td>
</tr>
<tr>
<td>value</td>
<td>Float (15,5)</td>
</tr>
<tr>
<td>oldvalue</td>
<td>Float (15,5)</td>
</tr>
</tbody>
</table>
Configuring External Points

**IMPORTANT**: Points configured as external points in HT3 should match their actual configuration in the source software package. Failure to do so may produce unexpected results.

The sections below provide instructions for adding external analog points and external digital points.

### Adding an External Analog Point

1. Open Configuration Editor.

2. On the Configuration Editor tree, right click `External Points`.

3. Click `New` on the pop-up menu.

4. In the **New external point** dialog box, select the point’s type from the drop-down list and enter the point's address in the **Address (Tag Name)** box. **Address (Tag Name)** must start with an X and be a maximum of 12 characters (for example, Xwell_level).

5. Click **Ok**. The point is added to the list of External Points and its default properties appear in the right panel. The name of the point is listed as New until you provide it with a descriptive name.

6. Configure the following properties (below is an example of a configured point named Well Level):
- **Name** - User-defined name of this point. The point's name can be a maximum of 20 characters. (Ex. Well Level, Phase AC Voltage)

- **Low Raw Value** - Number sent over air by card of wired device. This value is determined by the number of bits on the card. (0 milliamp = 0 raw, 4 milliamps = 820 raw). Type a value in the **Low Raw Value** box or use the slider to set the value.

- **Low Engineering Value** - Low value of the wired device's span. This is the number that is displayed on screen. Typically, this value is 0 (zero).

- **High Raw Value** - Number sent over air by card of wired device. This value is determined by the number of bits on the card (20 milliamps = 4095). Type a value in the **High Raw Value** box or use the slider to set the value.

- **High Engineering Value** - Full range of wired device. This is the number that is displayed on screen. Typically, this value is 100 (equal to 20 milliamps).

- **Resolution** - Minimum change to be reported (in engineering units). Type a value in the **Resolution** box or click the arrow to the right of the box to use the built-in calculator to compute the resolution. [Note: The minimum resolution recognized by HT3 is 4 (four) raw units.]

- **Units** - Units of measurement for this point. (Ex. FT, %, DegF)

- **Qualifier (analog inputs only)** - An address entered in this box tells the system to only gather report data when the qualifier address (point) is on. When this box is left empty, the point is always "qualified" and all data is used for report. Enter a telemetry address in the **Qualifier** box or use the **Browse** button to locate the qualifier.

- **Slew Rate (control points only)** - Slew rate of point. Must be a value between 0 (default) and 8. A slew rate of 0 results in fast, abrupt changes of voltage or current. Larger numbers let the change occur more slowly and smoothly. Use the slider to set the value for slew rate.

7. Verify that all the information entered is correct. Right click the new point and select **Save** from the pop-up menu. The status bar displays the message "Save was successful."
8. Collapse and expand the External Points list. The point is now listed with its user-defined name. The point’s address (Tag Name) appears in parentheses. Repeat the steps above to configure additional points.

**IMPORTANT:** When configuration is complete, [Update Polling](#) must be performed.

### Adding an External Digital Point

1. [Open Configuration Editor](#).
2. On the Configuration Editor tree, right click [External Points](#).
3. Click [New](#) on the pop-up menu.

4. In the [New external point](#) dialog box, select the point’s type from the drop-down list and enter the point’s address in the [Address (Tag Name)](#). Address (Tag Name) must start with an X and be a maximum of 12 characters (for example, Xsprinkler).

5. Click [OK](#). The point is added to the list of External Points and its default properties appear in the right panel. The name of the point is listed as New until you provide it with a descriptive name.

6. Configure the following properties (below is an example of a configured point named Sprinkler Pump Start):
**Name** - User-defined name of this point. The point's name can be a maximum of 20 characters (ex. Pump Run, Pump #3 Status).

**Low state label** - User-defined label that describes the point's "low" state. Low state label can be a maximum of 8 characters (ex. Off, OK). For a digital pulse point, enter the units of measurement for this point (ex. .1 Ft).

**High state label** - User-defined label that describes the point's "high" state. High state label can be a maximum of 8 characters (ex. On, Running). For a digital pulse point, enter the scale (amount per pulse) for this point (ex. .1).

7. Verify that all the information entered is correct. Right click the new point and select **Save** from the pop-up menu. The status bar displays the message "Save was successful."

8. Collapse and expand the External Points list. The point is now listed with its user-defined name. The point's address (Tag Name) appears in parentheses. Repeat the steps above to configure additional points.

**IMPORTANT**: When configuration is complete, **Update Polling** must be performed.

### External Point Alarms

To configure an alarm for an external status point, follow the same procedure used for local HT3 points. See **Alarms** for more information.
Modbus Emulation

Modbus emulation enables the Hyper SCADA Server (HSS) to respond as a Modbus TCP client by allowing DFS-type points to be queried as registers via the Modbus TCP protocol.

To accomplish this, the system assigns selected DFS points to available registers in the correct range for their I/O type.

<table>
<thead>
<tr>
<th>DFS I/O Type</th>
<th>Modbus I/O Type</th>
<th>Register Range</th>
</tr>
</thead>
<tbody>
<tr>
<td>Digital Outputs (DO)</td>
<td>Coils</td>
<td>00001-09999</td>
</tr>
<tr>
<td>Digital Inputs (DI)</td>
<td>Inputs</td>
<td>10001-19999</td>
</tr>
<tr>
<td>Analog Inputs (AI)</td>
<td>Input Registers</td>
<td>30001-39999</td>
</tr>
<tr>
<td>Analog Outputs (AO)</td>
<td>Holding Registers</td>
<td>40001-49999</td>
</tr>
</tbody>
</table>

This process creates a Modbus emulation map of DFS points and their assigned registers. HT3 uses this point-to-register map when it receives a Modbus TCP query. When the HT3 system receives such a query, it scans the Modbus emulation map to locate the register and its corresponding DFS-type point.

Nothing other than the Modbus emulation map is required to use this feature. As long as something has been mapped in the Modbus emulation map, the HSS will respond as a Modbus TCP slave on its IP address.

When creating the Modbus emulation map, you can assign all of the selected points to a single device, or you can add multiple devices (up to 251 total devices) and organize the selected points under these devices as desired.

Refer to the sections below for information on using HT3’s Modbus emulation.

- Modbus Message Support
- Creating a Modbus Emulation Map
  - Adding a Device
  - Mapping I/O
- Removing Points from the Modbus Emulation Map
- Viewing and Printing the Modbus Emulation Map

Modbus Message Support

HT3’s Modbus Emulation supports Modbus message codes 01, 02, 03, 04, 05, and 06.

- 01: read coils
- 02: read discrete inputs
- 03: read holding registers
04: read input registers
05: write single coil
06: write single register

At this time, Modbus emulation does not support Modbus message code 15 (write multiple coils) or 16 (write multiple registers).

Creating a Modbus Emulation Map

The Modbus emulation utility can be found in Configuration Editor.

Mapping a device requires that you:

- Add devices
- Map I/O

Adding a Device

1. Open Configuration Editor.
2. Right click Emulation (Modbus) at the bottom of the Configuration Editor tree.
3. Enter a number for the device (1-251) and click OK.

The device is added to the tree.
4. Continue adding devices as desired. When you are finished adding devices, map the I/O as described in the next section.

**Mapping I/O**

1. On the Configuration Editor tree, double click the device you want to map the I/O to. This expands the device branch to display the headings "Coils,” “Inputs,” ”Input Registers,” and ”Holding Registers.”

2. Click the heading that corresponds to the I/O type you want to map (Coils, Inputs, Input Registers, or Holding Registers). The Modbus emulation map for the selected I/O type will be displayed in the right panel. (The map will be empty if this is the first time I/O has been mapped.) To the right of the table are Add and Remove buttons.
3. Click the **Add** button to open the Address Selection Tool. Use the tool to browse to the points you want to emulate.

Select multiple points using your keyboard’s SHIFT and CTRL keys. When you are finished selecting points, click **OK**. The points are added to the Modbus emulation map.

4. When you select an entry in the map, details on that entry are displayed below the Modbus emulation map. Details include the Modbus address (device number and register), DFS address (station number, module letter, and point number), I/O type, and user-defined name.
Removing Points from the Modbus Emulation Map

Removing a single point

1. [Open Configuration Editor]

2. On the Configuration Editor tree, click Emulation (modbus) to open a list of devices.

3. Select the device that contains the point you want to remove from the map.

4. Select the point's I/O type (Coils, Inputs, Input Registers, or Holding Registers).

5. Locate the point and select it to highlight its row.

6. Click the Remove button. The point is removed from the Modbus emulation map.

Removing multiple points

[Open Configuration Editor]

On the Configuration Editor tree, click Emulation (modbus) to open a list of devices.

Select the device that contains the points you want to remove from the map.

Select the points' I/O type (Coils, Inputs, Input Registers, or Holding Registers).

Use the SHIFT key to select a range of contiguous points, or use the CTRL key to select a range of non-contiguous points. All of the selected points should now be highlighted.

Click the Remove button. The points are removed from the Modbus emulation map.
Removing a device
To remove all of the points assigned to a device as well as the device itself:

1. Open Configuration Editor
2. On the Configuration Editor tree, click Emulation (modbus) to open a list of devices.
3. Right click the device and select Delete from the pop-up menu.
4. Click Yes to confirm.

Viewing and Printing the Modbus Emulation Map
To view a complete list of mapped points:

1. Click Reports on the HT3 main menu.
2. Click Modbus Map on the Reports submenu.

For each mapped point, the table lists station number, station name, point name, point address, Modbus device number and Modbus register. Analog registers include the point's low and high range values and unit of measurement; digital registers include the point's 0 and 1 labels.

Directly above the map on the right side is a link to a printer-friendly version of the map.
Registry Editor

**WARNING**: Use extreme caution when editing the HT3 registry. You can render the HT3 system useless by incorrectly editing records. Many of these settings can only be changed by DFS personnel. All others require that the user be logged in as MGR.

To open the registry editor:

1. Click **Configure** on the HT3 main menu.
2. Click **System** on the Configure submenu.

The registry editor includes the following sections:

**DEFAULT_SCREENS**
All settings in this category affect the color scheme of the default screens and should not be changed.

**DRIVERS**
(DFS Only!) All settings in this category should only be modified by DFS personnel. Driver settings affect communications and device behavior.

**HT3_MOBILE**
**HT3_MOBILE_REFRESH**: Interval at which new data is retrieved from your HT3 system. The default refresh rate is 30 seconds. The refresh rate can also be changed from the "Options" page of HT3 Mobile.

**MOBILE_KEY**: (DFS Only!) Encrypted 32 byte key that activates HT3 Mobile on an HT3 system. This key can only be entered by DFS and must not be changed without the assistance of DFS personnel. Changing this key without authorization from DFS will cause HT3 Mobile to stop running.

**MOBILE_TIMEOUT**: Length of time HT3 Mobile is allowed to run without any activity before requiring the user to login again. The default session timeout is set at 300 seconds (5 minutes). Timeout can also be changed from the "Options" page of HT3 Mobile.

**SYMPHONY**
(DFS Only!) **SYMPHONY_KEY** is an encrypted 32 byte key that activates Symphony on an HT3 system. This key can only be entered by DFS and must not be changed without the assistance of DFS personnel. Changing this key without authorization from DFS will cause Symphony to stop running.

**SYSTEM**
**STATS**: **STATS_REFRESH_RATE**: Defaults to 60 and should not be changed at this time

**TIME_AND_DATE**:
- **TIME_SYNC_METHOD**: This can be set to MANUAL, INTERNET, or IP_ADDRESS/HOSTNAME
  - Manual relies on the user to set the date and time using the Set Time and Date function. Type the word MANUAL in the field and click Submit.
- Internet syncs the HSS clock with internet time servers. Internet access and a default route are required. Type the word INTERNET in the field and click Submit.
- IP address (actual IP address, not the word) or hostname uses a local time server at the given IP address/hostname. Type either the IP address or hostname of the local time server and click Submit.

- **TIME_ZONE**: This can be set to Eastern, Central, Mountain or Pacific. (IMPORTANT: This setting is case sensitive; the selected time zone must be typed with the first letter capitalized and the rest of the word lower case.)

**JNL_FLOAT_DATE**: (DFS Only!) This setting only applies to systems that have been upgraded to HT3 version 3.0.3 from any version of HyperTAC II or an HT3 version earlier than 3.0.3. This date represents the first day the system officially runs HT3 version 3.0.3 or newer. It is assumed that all journals prior to this date are in the old (raw) format. New systems that are initially installed at HT3 version 3.0.3 or newer will not have journal conversion date and should leave this field blank. For customers with a journal conversion date, this field must not be altered.

**SYSTEM_NAME**: (DFS Only!) Short description of this system (e.g., MELB_WWTP or CORAL_PLANT). Note to DFS Personnel: The system name must be unique for each customer and be 16 characters or less.
MySQL

HT3 incorporates an SQL database backend that is based on the database server engine MySQL. MySQL is ODBC (Open DataBase Connectivity) compliant, which allows external ODBC capable applications, such as Microsoft Access, to query the HyperTACII database for current status and set control points. You can query the database using Microsoft Excel and create your own custom reports.

For more information on MySQL read the MySQL documentation at: http://www.mysql.com/documentation/index.html.

Refer to the following sections for information on HT3’s database table structure and using third-party software to access HT3 data:

- **Downloading and Installing the MySQL ODBC Driver**
- **Overview of HT3’s MySQL Tables**
- **Real-Time Tables - Descriptions and Structure**
- **Configuration Tables - Descriptions and Structure**
- **Journal and Log Tables - Descriptions and Structure**
- **Retrieving Data from HT3’s Tables**

**Downloading and Installing the MySQL ODBC Driver**

Before you can begin using third-party software to access the data in HT3’s tables, the MySQL ODBC driver must be installed on your local machine. Visit MySQL.com to download the appropriate driver for your operating system:

http://www.mysql.com/downloads/connector/odbc/

Review the instructions at MySQL.com when installing the driver. You will need the following information to configure the driver to connect to HT3.

- **Windows DSN name**: This can be any name, but we recommend naming it HT3 for consistency.
- **MySQL host (name or IP)**: IP address of the Hyper Server Module (HSM).
- **MySQL database name**: Type hypertacii in this field. hypertacii is the name of HT3’s MySQL database.
- **Username and Password** - Contact DFS’ Service Department at 321-259-5009.
Overview of HT3's MySQL Tables

HT3’s SQL tables fall into three categories:

- Real-time tables
- Configuration tables
- Journal and log tables

Table data is maintained indefinitely. If hard disk space becomes an issue, a purging routine can be run. Contact DFS for more information.

Real-time Tables

Real-time tables contain up-to-the-moment information. They contain the information needed to carry out such actions as viewing status, performing controls, and acknowledging alarms.

- `rt_status` - status information on all points in the HT3 system.
- `rt_control` - information on all HT3 control points; enables the control of these points.
- `rt_alarm` - information on all HT3 points that have alarms configured; enables alarm acknowledgment.
- `rt_xstatus` - status information on all external status points in the HT3 system.

For more information on HT3’s real-time tables, see Real-time Tables - Descriptions and Structure.

Configuration Tables

Configuration tables contain information on all components of your HT3 telemetry system.

- `alarm` - alarms
- `anapnt` - analog points
- `autocontrol` - points with auto controls configured
- `digpnt` - digital points
- `driver` - drivers
- `keydef` - keyword definitions
- `keyword` - points that are linked to keywords
- `partition` - partitions
- `reports` - saved report parameters
- `sch_callout` - alarm callout schedules
- `sch_control` - points that are configured for scheduled controls
- **screen** - individual objects present in custom screens
- **station** - stations
- **trend** - saved trends
- **users** - users

For more information on HT3’s configuration tables, see *Configuration Tables - Descriptions and Structure*.

### Journal and Log Tables

Journal and log tables contain information on actions that have taken place in the HT3 system, including who has accessed the system, alarms and radio errors that have occurred, and changes in status.

- **accesslog** - information on who accessed the HT3 system and what actions they took
- **alarmlog** - alarms that have occurred and actions that were taken in response to them
- **commentlog** - provides a place for logging important information that doesn't appear in any other tables
- **controllog** - information on all controls that were initiated
- **journal** - records changes in status; one journal is created every day
- **radioerrlog** - information on radio errors that have occurred

For more information on HT3’s journal and log tables, see *Journal and Log Tables - Descriptions and Structure*.

### Real-Time Tables - Descriptions and Structure

#### Status Table (rt_status) Description

The rt_status table contains real-time status information on all points in the HT3 system.
### Field Name | Description / Structure
---|---
address | Corresponding hardware or virtual point address. Type = Char (12).
type | Corresponding point’s type. AI (analog input); AO (analog output); DI (digital input); DO (digital output); or PI (pulse input). Type = Char(2).
value | Current engineering value. Type = Float(15,5).
raw | Current raw value. Type = Smallint(5) unsigned.
stamp | Time stamp of when point's status changed or was last recorded. DFS digital points use time tagging; therefore, the time stamp may be earlier than the actual time the status was recorded. Type = Datetime.
reliability | An integer from 0-10 reflecting the reliability of this status record. 10 is completely reliable. 0 is completely unreliable. Type = Tinyint(4).
dnum | Driver number of corresponding point. dnum is 0 (zero) if the corresponding point is a virtual point. Type = Tinyint(3) unsigned.
snum | Station number of corresponding point. snum is 0 (zero) if the corresponding point is a virtual point. Type = Smallint(5) unsigned.
mchar | Module letter of corresponding point. mchar is V if the corresponding point is a virtual point. mchar is . (period) if corresponding point is under a Modbus driver. Type = Char(1).
pnum | Point number of corresponding point. pnum is 0 (zero) if the corresponding point is a virtual point. Type = Mediumint(8) unsigned.

### Control Table (rt_control) Description

The rt_control table contains real-time status information on all HT3 control points.

```
mysql> describe rt_control;
+--------+------+
| Field  | Type |
|--------+------|
| address| char[12] |
| type   | char(2) |
| setvalue | float15.5, 5 | YES, NO, or NUL |
| controlled | char(1) |
+--------+------+
5 rows in set (0.00 sec)
```

### Field Name | Description / Structure
---|---
address | Corresponding hardware or virtual point address. Type = Char(12).
type | Corresponding point’s type. DO (digital output) or AO (analog output). Type = Char (2).
setvalue | Engineering value at which point is to be set. Type = Float(15,5).
controlled | 'Y' or 'N' to notify server to control a point. Type = Char(1).

---

HT3 Version 3.1.6 | © 2013 Data Flow Systems, Inc.
**controlled_by**  
User name of individual who controlled the point. Must be a valid HT3 login with control permissions. This user name, along with the time and the point address, is entered in the control logs whenever a control point’s value is manually set. Type = Char(8).

---

**Alarm Table (rt_alarm) Description**

The rt_alarm table provides real-time status information on all HT3 alarms.

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description / Structure</th>
</tr>
</thead>
<tbody>
<tr>
<td>address</td>
<td>Corresponding hardware or virtual point address. Type = Char (12).</td>
</tr>
<tr>
<td>type</td>
<td>Alarm type. A (analog); D (digital); or O (offline). Type = Char(1). <strong>Note:</strong> Pulse values are treated like analog values.</td>
</tr>
<tr>
<td>address_text</td>
<td>Full text name of alarm. Address_text consists of the station name and the point name. If the corresponding point is a virtual point, only the point name is displayed in the address_text field. If the point is offline, the address_text field displays the station name and module letter. Type = Char(40).</td>
</tr>
<tr>
<td>alarm_text</td>
<td>For digital points, the Alarm States label is displayed. For analog points, a system generated High or Low is displayed. Type = Char(20).</td>
</tr>
<tr>
<td>value</td>
<td>Current value of point. For digital points, value is 1 (one) or 0 (zero). For analog points, an engineering value is required. Type = Float(15,5).</td>
</tr>
<tr>
<td>date_time</td>
<td>Date and time that alarm occurred. Type = Datetime.</td>
</tr>
<tr>
<td>time</td>
<td>Time that alarm occurred, measured and recorded in seconds past midnight of current day. Type = Mediumint(8) unsigned.</td>
</tr>
<tr>
<td>partition</td>
<td>Partition number to which this point is assigned. <strong>Partitions</strong> are logical groups of stations, for example, Fresh, WW, Reuse, or Stormwater. Type = Tinyint(3) unsigned.</td>
</tr>
<tr>
<td>state</td>
<td>Current alarm state of point. Alarm (point is in active alarm state); clear (alarm has cleared); ack (alarm has been acknowledged). Type = Enum('alarm', 'clear', 'ack').</td>
</tr>
<tr>
<td>ack_by</td>
<td>HT3 User Name of individual who acknowledged alarm. Type = Char(12).</td>
</tr>
<tr>
<td>Field Name</td>
<td>Description / Structure</td>
</tr>
<tr>
<td>------------</td>
<td>--------------------------</td>
</tr>
<tr>
<td>address</td>
<td>Address (TAG NAME) of external point. This MUST start with ‘X’ and should describe the value it represents. Type = Char(12).</td>
</tr>
<tr>
<td>type</td>
<td>DI, DO, AI, AO. Type = Char(2).</td>
</tr>
<tr>
<td>value</td>
<td>Current engineering value of point. Update this field to change values. Type = Float(15,5).</td>
</tr>
<tr>
<td>oldvalue</td>
<td>Last engineering value of point. Used internally by HT3. Do NOT alter this field. Type = Float(15,5).</td>
</tr>
</tbody>
</table>
## Configuration Tables - Descriptions and Structure

### Alarm Table (alarm) Description

Alarms are used to alert operators to the status of equipment that needs attention. Once configured, alarms can be viewed and acknowledged using HT3’s [Alarm Viewer](#). The ability to view and acknowledge alarms is based on the user’s permission level. For more information on permission levels, see [Users Table Description](#).

![Image of Alarm Table](image)

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description / Structure</th>
</tr>
</thead>
<tbody>
<tr>
<td>address</td>
<td>Corresponding hardware or virtual point address. Type = Char (20).</td>
</tr>
<tr>
<td>low</td>
<td>Analog points: Level (engineering value) at which the specified point enters a low alarm state. Enter 0 (zero) in this field if a low alarm is not required. To set an alarm level of 0 (zero), enter a small number, for example, .01. This is necessary because entering 0 (zero) disables the low alarm. Digital points: Place a 1 (one) in this field if you want the point to alarm when it is OFF. If a 1 (one) is placed in this field, high must be set to 0 (zero). Type = Float(15,4).</td>
</tr>
<tr>
<td>high</td>
<td>Analog points: Level (engineering value) at which the specified point enters a high alarm state. Enter 0 (zero) in this field if a high alarm is not required. Digital points: Place a 1 (one) in this field if you want the point to alarm when it is ON. If a 1 (one) is placed in this field, low must be set to 0 (zero). Type = Float(15,4).</td>
</tr>
<tr>
<td>delay</td>
<td>Amount of time (in seconds) that the specified point is allowed to be in an alarm state before becoming an alarm. Type = Mediumint(8) unsigned.</td>
</tr>
</tbody>
</table>
### Analog Point Table (anapnt) Description

The anapnt table contains configuration information for each analog point in the HT3 telemetry system.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>snooze</td>
<td>Amount of time (in seconds) allowed to pass before an acknowledged alarm that is still active is reannounced. (<em>Note:</em> The alarm is reannounced only if the point is still in an alarm state.) Type = Mediumint(8) unsigned.</td>
</tr>
<tr>
<td>type</td>
<td>Type of alarm. A (analog), D (digital), or O (offline). Type = Char(1).</td>
</tr>
<tr>
<td>callout</td>
<td>Indicates if the system is to send out an alarm announcement by telephone. Type = Enum('No','Yes')</td>
</tr>
<tr>
<td>notify</td>
<td>Indicates if the system is to send an alarm cleared announcement when the monitored point leaves the alarm state. Type = Enum('No','Yes') (<em>Note:</em> This feature will be available in a future version.)</td>
</tr>
<tr>
<td>inside</td>
<td>Analog alarms only. Creates an alarm state within the low and high alarm levels, as set above. The default is outside the levels. Type = Enum('No','Yes')</td>
</tr>
<tr>
<td>voice</td>
<td>Indicates if the system is to announce an alarm locally (at terminal). Type = Enum ('No','Yes')</td>
</tr>
<tr>
<td>email</td>
<td>Indicates if the system is to send out an alarm announcement to an email address. Type = Enum('No','Yes')</td>
</tr>
<tr>
<td>page</td>
<td>Indicates if the system is to send out an alarm announcement to a pager. Type = Enum('No','Yes')</td>
</tr>
<tr>
<td>partition</td>
<td>Partition number to which the corresponding point is assigned. <em>Partitions</em> are logical groups of stations, for example, Fresh, WW, Reuse, or Stormwater. Partition is 0 (zero) of the corresponding point is a virtual point. Type = Tinyint(3) unsigned.</td>
</tr>
<tr>
<td>dnum</td>
<td>Driver number of corresponding point. dnum is 0 (zero) if the corresponding point is a virtual point. Type = Tinyint(3) unsigned.</td>
</tr>
<tr>
<td>snum</td>
<td>Station number of corresponding point. snum is 0 (zero) if the corresponding point is a virtual point. Type = Smallint(5) unsigned.</td>
</tr>
<tr>
<td>mchar</td>
<td>Module letter of corresponding point. mchar is V is the corresponding point is a virtual point. mchar is . (period) if corresponding point is under a Modbus driver. Type = Char(1).</td>
</tr>
<tr>
<td>pnum</td>
<td>Point number of corresponding point. pnum is 0 (zero) if the corresponding point is a virtual point. Type = Mediumint(8) unsigned.</td>
</tr>
<tr>
<td>Field Name</td>
<td>Description / Structure</td>
</tr>
<tr>
<td>------------</td>
<td>-------------------------</td>
</tr>
<tr>
<td>address</td>
<td>Corresponding hardware or virtual point address. Type = Char (20).</td>
</tr>
<tr>
<td>name</td>
<td>User-defined name of this point. (Ex. Well Level, Phase AC Voltage) Type = Char (20).</td>
</tr>
<tr>
<td>type</td>
<td>Type of point being configured. AI (analog input) or AO (analog output). Type = Char (2).</td>
</tr>
<tr>
<td>loweng</td>
<td>Low value of the wired device's span. Typically, this value is 0 (zero). Type = Float (15,4).</td>
</tr>
<tr>
<td>lowraw</td>
<td>Number transmitted via radio or network by the wired device's card. This value is determined by the number of bits on the card. (0 miliamp = 0 raw, 4 miliamps = 820 raw).* Type = Smallint(5) unsigned.</td>
</tr>
<tr>
<td>hieng</td>
<td>Full range of wired device. Typically, this value is 100 (equal to 20 miliamps). Type = Float(15,4).</td>
</tr>
<tr>
<td>hiraw</td>
<td>Number transmitted via radio or network by the wired device's card. This value is determined by the number of bits on the card. (20 miliamps = 4095)* Type = Smallint(5) unsigned.</td>
</tr>
<tr>
<td>resolution</td>
<td>Minimum change to be reported (in engineering units). Type = Float(15,4).</td>
</tr>
<tr>
<td>units</td>
<td>Units of measurement for this point. (Ex. FT, %, DegF) Type = Char (10).</td>
</tr>
<tr>
<td>slew</td>
<td>Slew rate of point. Must be a value between 0 (default) and 8. Entering 0 causes fast, abrupt changes of voltage or current. Larger numbers let the change occur more slowly and smoothly. (Note: Only used on control points.) Type = Tinyint(3) unsigned</td>
</tr>
<tr>
<td>qual</td>
<td>If an address (qualifier address) is entered in this field, the system only gathers report data when the qualifier address is on. If left at the default value, point is always qualified and all data is used for report. Type = Char (20).</td>
</tr>
<tr>
<td>dnum</td>
<td>Driver number of corresponding point. dnum is 0 (zero) if the corresponding point is a virtual point. Type = Tinyint(3) unsigned.</td>
</tr>
</tbody>
</table>
snum | Station number of corresponding point. snum is 0 (zero) if the corresponding point is a virtual point. Type = Smallint(5) unsigned.

mchar | Module letter of corresponding point. mchar is V if the corresponding point is a virtual point. mchar is . (period) if corresponding point is under a Modbus driver. Type = Char(1).

pnum | Point number of corresponding point. pnum is 0 (zero) if the corresponding point is a virtual point. Type = Mediumint(8) unsigned.

Auto Control Table (autocontrol) Description

Auto controls automate and facilitate the controlling of hardware in the field. Configuring an auto control instructs the system to perform a certain function when a specific event occurs. For example, when a well reaches a specified high level, a pump is turned on to reduce the water level. This occurs automatically; the point doesn’t need to be manually monitored.

Field Name | Description / Structure
--- | ---
address | Corresponding hardware or virtual point address. Type = Char (20).
dtype | I/O type of the controlled (monitored) point. DO (digital output) or AO (analog output). Type = Char (2).
source | Address of the controlling (monitoring) point. Type = Char (20).
stype | I/O type of the controlling (monitoring) point. DO (digital output), DI (digital input), AO (analog output), or AI (analog input). Type = Char (2).
low | Low control level for this auto control. Determined as follows:

<table>
<thead>
<tr>
<th>Source Type</th>
<th>Output Type</th>
<th>Low Control Level</th>
</tr>
</thead>
<tbody>
<tr>
<td>DI/DO</td>
<td>DO</td>
<td>0</td>
</tr>
<tr>
<td>AI/AO</td>
<td>DO</td>
<td>Off level (0 state)</td>
</tr>
<tr>
<td>AI/AO</td>
<td>AO</td>
<td>0</td>
</tr>
<tr>
<td>DI/DO</td>
<td>AO</td>
<td>output of 0 state</td>
</tr>
</tbody>
</table>
high | High control level for this auto control. Type = Float(15,4).
Determined as follows:

<table>
<thead>
<tr>
<th>Source Type</th>
<th>Output Type</th>
<th>Low Control Level</th>
</tr>
</thead>
<tbody>
<tr>
<td>DI/DO</td>
<td>DO</td>
<td>1</td>
</tr>
<tr>
<td>AI/AO</td>
<td>DO</td>
<td>On level (1 state)</td>
</tr>
<tr>
<td>AI/AO</td>
<td>AO</td>
<td>1</td>
</tr>
<tr>
<td>DI/DO</td>
<td>AO</td>
<td>output of 1 state</td>
</tr>
</tbody>
</table>

invert | Typically, the control point exactly follows the state of the monitor point to which it is assigned. Setting invert to ‘Yes’ enables the system to invert, or reverse, this relationship. Type = Enum(‘No’, ’Yes’)

push | Setting push to ‘Yes’ enables the system to attempt to maintain output states when the two points are out of sync. With push enabled, manual control is disabled. Type = Enum(‘No’, ’Yes’)

dnum | Driver number of corresponding point. dnum is 0 (zero) if the corresponding point is a virtual point. Type = Tinyint(3) unsigned.

snum | Station number of corresponding point. snum is 0 (zero) if the corresponding point is a virtual point. Type = Smallint(5) unsigned.

mchar | Module letter of corresponding point. mchar is V is the corresponding point is a virtual point. mchar is . (period) if corresponding point is under a Modbus driver. Type = Char(1).

pnum | Point number of corresponding point. pnum is 0 (zero) if the corresponding point is a virtual point. Type = Mediumint(8) unsigned.

**Digital Point Table (digpnt) Description**
The digpnt table contains configuration information for each digital point in the HT3 telemetry system.

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description / Structure</th>
</tr>
</thead>
<tbody>
<tr>
<td>address</td>
<td>Corresponding hardware or virtual point address. Type = Char (20).</td>
</tr>
</tbody>
</table>
### Driver Table (driver) Description

A driver is the program that interfaces between the HT3 system and the hardware in the field. The driver reads the information that has been entered into the database, translates it into a "language" that the hardware understands, and then communicates with the hardware. HT3 supports querying the following drivers:

- **DFS** - Standard DFS driver. This driver is used to enable network to radio-based communication between the central computer and DFS radio RTUs (Remote Terminal Units).
- **MOD** - Modbus driver. Modbus driver. This driver is used to enable network to radio-based communication between the central computer and Modbus PLCs.
- **NIM** - Network Interface Module driver. This driver is used to enable network to network-based communication between the central computer and DFS network RTUs.

For more information on drivers, read the [overview on drivers](#) for information on the types of drivers available in the HT3 system and their specific applications.

<table>
<thead>
<tr>
<th>name</th>
<th>User-defined name of this point (for example, Low Level or High Well). Type = Char (20).</th>
</tr>
</thead>
<tbody>
<tr>
<td>type</td>
<td>Type of point being configured. DI (digital input) or DO (digital output). Type = Char (2).</td>
</tr>
<tr>
<td>label0</td>
<td>User-defined label that describes the point's &quot;zero&quot; state (for example, Off or OK). For a digital pulse point, enter the units of measurement for this point (for example, .1 Ft). Type = Char(10).</td>
</tr>
<tr>
<td>label1</td>
<td>User-defined label that describes the point's &quot;one&quot; state (for example, On or High). For a digital pulse point, enter the scale (amount per pulse) for this point (for example, .1). Type = Char(10).</td>
</tr>
<tr>
<td>dnum</td>
<td>Driver number of corresponding point. dnum is 0 (zero) if the corresponding point is a virtual point. Type = Tinyint(3) unsigned.</td>
</tr>
<tr>
<td>snum</td>
<td>Station number of corresponding point. snum is 0 (zero) if the corresponding point is a virtual point. Type = Smallint(5) unsigned.</td>
</tr>
<tr>
<td>mchar</td>
<td>Module letter of corresponding point. mchar is V is the corresponding point is a virtual point. mchar is . (period) if corresponding point is under a Modbus driver. Type = Char(1).</td>
</tr>
<tr>
<td>pnum</td>
<td>Point number of corresponding point. pnum is 0 (zero) if the corresponding point is a virtual point. Type = Mediumint(8) unsigned.</td>
</tr>
<tr>
<td>Field Name</td>
<td>Description / Structure</td>
</tr>
<tr>
<td>------------</td>
<td>-------------------------</td>
</tr>
<tr>
<td>driver_num</td>
<td>System assigned number and cannot be modified. Type = Tinyint(3) unsigned.</td>
</tr>
<tr>
<td>name</td>
<td>User-defined name of this driver. Type = Char (20).</td>
</tr>
<tr>
<td>type</td>
<td>Type of driver being configured. DFS (standard DFS driver), MOD (Modbus driver), or NIM (Network Interface Module driver). Type = Char (2).</td>
</tr>
</tbody>
</table>
| port       | Based on driver type. Type = Char(30).  
  
  - **DFS or MOD driver** - port is the complete IP address of the CTU’s NIM/FIM. Enter the entire IP address (network address + NIM/FIM’s node address + number of NIM/FIM port to which the RIM is connected). For example, 207.243.62.251.1 would correspond to a network address of 207.243.62, a node address of 251, and a port number of 1.  
  
  - **NIM driver** - port is the first three octets of the network on which the NIMs/FIMs are located, followed by 255 (for example, 207.203.26.255). The number 255 denotes a Class C network that can hold 1-254 network addresses. |
<p>| bakport    | DFS driver only. The complete IP address of the CTU’s backup NIM/FIM. This is only used if the HSS has been configured for complete redundancy. If not using redundant centrals (see auto_switch below), this address must be the same as port. (<strong>Note:</strong> auto_switch must be enabled in order for bakport to be used.) Type = Char(30). |
| auto_switch| DFS driver only. Indicates if a redundant central is in use. Type = Enum('No','Yes') |
| auto_time  | DFS driver only. Number of seconds past midnight when the system switches to the redundant central. Value must be between 0 and 86399. (<strong>Note:</strong> auto_switch must be set to 'Yes' for the switch to occur.) Type = Int(10) unsigned. |
| auto_stations | Percentage of station-offline occurrences that causes a switch between centrals. Value must be between 10 and 100. (<strong>Note:</strong> auto_switch must be set to 'Yes' for the switch to occur.) Type = smallint(5) unsigned. |</p>
<table>
<thead>
<tr>
<th>Keyword</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>hipri</strong></td>
<td>DFS driver only. Number of times the system asks for status in one polling loop. Default setting is 2. Type = Tinyint(3) unsigned.</td>
</tr>
<tr>
<td><strong>lopri</strong></td>
<td>DFS driver only. Number of polling loops the system makes before requesting status. Default setting is 4. Type = Tinyint(3) unsigned.</td>
</tr>
</tbody>
</table>
| **baud** | DFS and MOD drivers only. Type = Mediumint(8) unsigned.  
- **DFS driver** - Rate of data transmission (number of bits of information transmitted per second). This is determined by the type of RIM installed at the CTU. Must be either 1200 or 9600.  
- **MOD driver** - Rate of data transmission (number of bits of information transmitted per second). This is determined by the type of Modbus radio equipment installed at the CTU. Select 1200, 9600, 19800, or 38400 from the drop-down list. |
| **parity** | Method of checking for errors in data transmissions. DFS and MOD drivers only. Valid parity settings are None, Odd, and Even. Type = Char(4). |
| **stop_bits** | Number of bits used to indicate the end of a data transmission. DFS and MOD drivers only. Valid stop_bits settings are 1 and 2. Type = Tinyint(3) unsigned. |
| **aux1** | DFS and MOD drivers only. Type = Smallint(5) unsigned.  
- **DFS driver** - Enter 1 (one) in this field to enable a station to be polled for full status after a successful control. Set aux1 to 0 (zero) to disable this action.  
- **MOD driver** - Maximum number of coils (digital outputs) polled for status at one time. Must be a number between 1 and 50. |
| **aux2** | DFS and MOD drivers only. Type = Smallint(5) unsigned.  
- **DFS driver** - Minimum time (in seconds) that must elapse before starting a new polling loop.  
- **MOD driver** - Maximum number of digital inputs polled for status at one time. Must be a number between 1 and 50. |
| **aux3** | MOD driver only. Maximum number of holding registers (analog inputs) polled for status at one time. Must be a number between 1 and 50. Type = Smallint(5) unsigned. |
| **aux4** | MOD driver only. Maximum number of input registers (analog outputs) polled for status at one time. Must be a number between 1 and 50. Type = Smallint(5) unsigned. |
| **aux5** | MOD driver only. Maximum number of coils (digital outputs) set at one time. Limited to 1 at this time. Type = Smallint(5) unsigned. |
| **aux6** | MOD driver only. Maximum number of registers set at one time. Limited to 1 at this time. Type = Smallint(5) unsigned. |

**Keyword Tables (keydef and keyword) Descriptions**
HT3 lets you generate reports that provide a clear picture of what is happening at monitored stations and of the performance of equipment at those stations. Keywords simplify the reporting process by allowing you to logically group together specific types of points (i.e., lift station pumps, analog flow meters). For example, a keyword can be created that includes the addresses for all lift station pumps. You can then create a report that shows how long and how many times a digital event occurred - when the pumps came on and went off, and how long each of these events occurred. Keywords allow you to create reports based on just one keyword. This eliminates the need to type individual addresses for each point.

There are two tables that define how keywords are associated, or linked, to reports and telemetry points. The **keydef** table defines the keyword and links it to a particular report. The **keyword** table links keywords contained in the **keydef** table to particular point addresses.

### Keyword Definition Table (keydef) Description

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description / Structure</th>
</tr>
</thead>
<tbody>
<tr>
<td>keyword</td>
<td>User-defined name of this keyword. keyword is case sensitive and cannot contain any special characters or spaces (use only letters and numbers). Examples of keywords are PUMP, DFLOW, and RAIN. Type = Char(20).</td>
</tr>
<tr>
<td>type</td>
<td>Type of report to associate with this keyword. Valid types are DETAIL, RADIO ERROR, DERIVED FLOW, ACTIVITY, ANALOG, and PULSE. Type = Char (20).</td>
</tr>
</tbody>
</table>

### Keyword-Point Association Table (keyword) Description

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description / Structure</th>
</tr>
</thead>
<tbody>
<tr>
<td>keyword</td>
<td>keyword to which the corresponding point address is associated. Type = Char(20).</td>
</tr>
<tr>
<td>address</td>
<td>address of point being linked to keyword. Type = Char (20).</td>
</tr>
</tbody>
</table>

### Partition Table (partition) Description
Partitions are logical divisions of telemetry information. Partitioning allows RTUs in a telemetry system to be configured in any one of four separate partitions; one telemetry system can be shared by four different departments (for example, Wastewater Collections, Reclaimed Water Distribution, Water Treatment Plant, and Storm Water Control). When an operator is given permission to access a particular partition (see Users Table Description) and logs in to the system, the components and users of the other partitions are not seen. This feature makes it appear as if the system only serves the segment that the operator has accessed. Since all four partitions can use the same central computer, software, networks, radio frequencies, CTUs, RTUs, etc., the cost-effectiveness of this feature becomes a valuable asset.

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description / Structure</th>
</tr>
</thead>
<tbody>
<tr>
<td>num</td>
<td>Number assigned to this partition. The default is 0 (zero). Type = tinyint(3) unsigned.</td>
</tr>
<tr>
<td>Name</td>
<td>Unique, user-defined name given to this partition. Partition names are case sensitive and cannot contain special characters or spaces (use only numbers and letters). Type = Char (20).</td>
</tr>
</tbody>
</table>

### Saved Reports Table (reports) Description

The reports table provides information on reports whose parameters have been saved via HT3’s Report Request Form. The user-defined name and a list of the report’s parameters are supplied.

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description / Structure</th>
</tr>
</thead>
<tbody>
<tr>
<td>name</td>
<td>User-defined name of the saved report parameters. Type = varchar(40).</td>
</tr>
<tr>
<td>params</td>
<td>Parameters of this saved report. Type = text.</td>
</tr>
</tbody>
</table>

### Alarm Call Out Schedule Table (sch_callout) Description

The sch_callout table, used in conjunction with the alarms table, provides the system with a list of telephone numbers to call in the event an alarm situation occurs. (Note: You must enable callout for each point in the alarms table that you want to include in the call out list.)
Each record in the sch_callout table assigns a telephone number to a partition and an hour of the day. The number is also assigned a rank between 1 (one) and 8 (eight). A telephone number assigned a rank of 1 is the first number that the system calls when an alarm that is set up for call out occurs. The system tries each telephone number in succession until the correct Answer Code is entered and the alarm is acknowledged. (The Answer Code is a four-digit number provided by DFS. For information on Answer Code options, contact DFS.)

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description / Structure</th>
</tr>
</thead>
<tbody>
<tr>
<td>partition</td>
<td>Partition number to which this alarm callout record is assigned. Partitions are logical groups of stations, for example, Fresh, WW, Reuse, or Stormwater. Type = Tinyint(3) unsigned.</td>
</tr>
<tr>
<td>hour</td>
<td>Hour of the day (0 - 23) to which this alarm callout record is assigned. Type = Tinyint(unsigned). Telephone number of this alarm callout record. Do not enter spaces or hyphens. If the telephone system requires a 9 (nine) to be dialed to get an outside line, enter 9, a comma, and then the telephone number. For example, 9,1234567. The comma tells the system to pause before dialing the rest of the telephone number. Type = Varchar(50).</td>
</tr>
<tr>
<td>number</td>
<td>Telephone number of this alarm callout record. Do not enter spaces or hyphens. If the telephone system requires a 9 (nine) to be dialed to get an outside line, enter 9, a comma, and then the telephone number. For example, 9,1234567. The comma tells the system to pause before dialing the rest of the telephone number. Type = Varchar(50).</td>
</tr>
<tr>
<td>rank</td>
<td>Number between 1 and 8 that provides the system with the order in which each number is dialed. Assigning a rank of 1 to a number means that it is the first number the system attempts to reach. If the system cannot get through to a number, it tries the number assigned to the same hour with the next higher rank. Type = Tinyint(unsigned).</td>
</tr>
</tbody>
</table>

Scheduled Control Table (sch_control) Description

Scheduled controls are used when you want an event to automatically occur on certain scheduled days and/or times. For example, a sprinkler system that turns on at 5:00 AM and turns off at 7:00 AM every Monday, Wednesday, and Friday.
You can configure a digital point to come on at a specific time and go off at a specific time. An analog point can be configured to reach a desired engineering value on certain days and/or times. **(Note:** To schedule a digital point to come on and go off at certain times, you must create a record that turns the point on and another record that turns the point off.)

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description / Structure</th>
</tr>
</thead>
<tbody>
<tr>
<td>id</td>
<td>Unique ID number that is automatically assigned to this scheduled control record. This allows a scheduled control to be queried by its id Type = Int(10) unsigned.</td>
</tr>
<tr>
<td>address</td>
<td>Corresponding hardware or virtual point address. Type = Char (12).</td>
</tr>
<tr>
<td>type</td>
<td>Type of the point being controlled. AO (analog output) or DO (digital output). Type = Char(2).</td>
</tr>
<tr>
<td>value</td>
<td>Value at which point is to be set when control occurs. For digital points, value is 1 (one) or 0 (zero). For analog points, an engineering value is required. Type = Float (15,5).</td>
</tr>
<tr>
<td>sun</td>
<td>Indicates if point is to be controlled on this day of the week. Y (yes) or N (no). Type = Char(1).</td>
</tr>
<tr>
<td>mon</td>
<td>Indicates if point is to be controlled on this day of the week. Y (yes) or N (no). Type = Char(1).</td>
</tr>
<tr>
<td>tue</td>
<td>Indicates if point is to be controlled on this day of the week. Y (yes) or N (no). Type = Char(1).</td>
</tr>
<tr>
<td>wed</td>
<td>Indicates if point is to be controlled on this day of the week. Y (yes) or N (no). Type = Char(1).</td>
</tr>
<tr>
<td>thu</td>
<td>Indicates if point is to be controlled on this day of the week. Y (yes) or N (no). Type = Char(1).</td>
</tr>
<tr>
<td>fri</td>
<td>Indicates if point is to be controlled on this day of the week. Y (yes) or N (no). Type = Char(1).</td>
</tr>
<tr>
<td>sat</td>
<td>Indicates if point is to be controlled on this day of the week. Y (yes) or N (no). Type = Char(1).</td>
</tr>
<tr>
<td>ctrltime</td>
<td>Time of day that point is to be controlled. Type = time.</td>
</tr>
</tbody>
</table>
Custom Screen Table (screen) Description

Custom screens are created using HT3’s Screen Builder application. With Screen Builder you can create a graphical representation of your telemetry system. By building a screen - using text, images, objects, and animation - and then linking the screen’s components to actual telemetry points, you can get a quick, real-time view of your operation.

**IMPORTANT**: Custom screens should only be created and edited using HT3’s Screen Builder application.

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description / Structure</th>
</tr>
</thead>
<tbody>
<tr>
<td>name</td>
<td>Name of the screen to which this object belongs. Type = Varchar(20).</td>
</tr>
<tr>
<td>width</td>
<td>Width (horizontal size) of this object; measured in pixels. Type = Smallint(5) unsigned.</td>
</tr>
<tr>
<td>height</td>
<td>Height (vertical size) of this object; measured in pixels. Type = Smallint(5) unsigned.</td>
</tr>
<tr>
<td>rank</td>
<td>This object's rank among all layered objects that appear in the custom screen referred to above (name). Lower ranked objects are positioned further back on the screen. Type = Smallint(5) unsigned.</td>
</tr>
<tr>
<td>Address</td>
<td>Address of point to which this object is linked. Type = Varchar(12).</td>
</tr>
<tr>
<td>xloc</td>
<td>Horizontal position of this object. Type = Smallint(5) unsigned.</td>
</tr>
<tr>
<td>yloc</td>
<td>Vertical position of this object. Type = Smallint(5) unsigned.</td>
</tr>
<tr>
<td>Type</td>
<td>Type of point to which this object is linked. Valid types are AO (analog output), AI (analog input), DO (digital output), DI (digital input), DP (pulse), and ST (static). Type = Char(2).</td>
</tr>
<tr>
<td>object</td>
<td>This record’s object type. Type = Varchar(8). See Screen Builder’s documentation for information on valid object types.</td>
</tr>
</tbody>
</table>
### Station Table (station) Description

The station table contains configuration information for each station in the HT3 telemetry system. This includes the driver number and partition number, polling priority, and the types of modules located at the station.

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description / Structure</th>
</tr>
</thead>
<tbody>
<tr>
<td>station</td>
<td>Type = Smallint (5) unsigned.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------</td>
<td>--------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>dnum</td>
<td>Driver number under which this station is located. Type = Tinyint(3) unsigned.</td>
</tr>
<tr>
<td>snum</td>
<td>Logical address of the station being added. This address is determined at the site. If the station</td>
</tr>
<tr>
<td></td>
<td>being added falls under a NIM driver and the NIM is located at a station, snum must be the NIM's node</td>
</tr>
<tr>
<td></td>
<td>address. Type = Smallint(5) unsigned.</td>
</tr>
<tr>
<td>Type</td>
<td>Type of station being added. Must match driver type. Valid types are DFS, MOD, MOT, and NIM.</td>
</tr>
<tr>
<td></td>
<td>(Note: This field is case sensitive. Use all caps when entering information.) Type = Char(3).</td>
</tr>
<tr>
<td>name</td>
<td>User-defined name of the station (for example, the station's street address, lift station number,</td>
</tr>
<tr>
<td></td>
<td>or the name of area being serviced) Type = Char(20).</td>
</tr>
<tr>
<td>priority</td>
<td>(DFS RTU stations only) Polling priority of this station. Allows the station to be polled more or</td>
</tr>
<tr>
<td></td>
<td>less than average. Valid priority settings are Low, Normal, and High.</td>
</tr>
<tr>
<td>Partition</td>
<td>Partition number to which this station is assigned. Partitions are logical groups of stations, for</td>
</tr>
<tr>
<td></td>
<td>example, Fresh, WW, Reuse, or Stormwater. Type = Tinyint(3) unsigned.</td>
</tr>
<tr>
<td>offlinecnt</td>
<td>Number of consecutive polling errors allowed to occur before an offline status is returned. Value</td>
</tr>
<tr>
<td></td>
<td>must be between 1 and 99. Type = Tinyint(3) unsigned.</td>
</tr>
<tr>
<td>retries</td>
<td>Number of control attempts allowed before a control is considered failed. Retries must be a number</td>
</tr>
<tr>
<td></td>
<td>between 1 (one) and 8 (eight). Type = Tinyint(3) unsigned.</td>
</tr>
<tr>
<td>timeout</td>
<td>Amount of time (in mSec) to wait for a station to reply. Value must be between 200 and 15000.</td>
</tr>
<tr>
<td>pollrate</td>
<td>(Modbus and DFS NIM stations only) Length of time (in seconds) that must elapse before polling this</td>
</tr>
<tr>
<td></td>
<td>station again. Type = Mediumint(8) unsigned.</td>
</tr>
<tr>
<td></td>
<td>• DFS NIM stations - Value must be between 2 and 9999.</td>
</tr>
<tr>
<td></td>
<td>• Modbus stations - Value must be between 10 and 9999.</td>
</tr>
<tr>
<td>digipeat1 - digipeat4</td>
<td>(DFS drivers only.) Station path through which the signal is to be routed. These fields are used when radio frequencies are blocked by some sort of obstruction or when the distance to be traveled is greater than that which can be covered by one direct signal. Enter the address of each point in the path in the four Digipeat fields.</td>
</tr>
<tr>
<td>volume</td>
<td>Calculated volume for a well (in gallons). Used only for Derived Flow Reports.</td>
</tr>
<tr>
<td>modA - modO, modR</td>
<td>Type of module located at this module address. Valid entries are: AMM001, AMM002, ACM001, DCM001, DCM002, DCM031, DCM032, and PCU001.</td>
</tr>
</tbody>
</table>

**Saved Trends Table (trend) Description**

The trend table provides information on reports whose parameters have been saved via HT3’s Report Request Form. The user-defined name and a list of the report's parameters are supplied.
### Users Table (users) Description

The users table contains data, including login information (login name and password) and permission levels (no access, view only, full access) for each individual that can access the HT3 system.

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description / Structure</th>
</tr>
</thead>
<tbody>
<tr>
<td>login</td>
<td>Unique name given to each user account. Login must be between 2 and 8 characters (letters and/or numbers). Type = Varchar(8).</td>
</tr>
<tr>
<td>passwd</td>
<td>Unique password assigned to each user account. Password must be between 2 and 8 characters (letters and/or numbers). Users with permission to configure telemetry, see cfg_telemetry below, can change any user's password. MGR - when logged into the central computer - is the only user who can display the actual passwords (Note: If MGR is logged into a Windows workstation, passwords are not displayed). Type = Varchar(8).</td>
</tr>
<tr>
<td>skin_id</td>
<td>HyperTACII systems only. Name of the skin (customized user interface) assigned to this user. Type = Mediumint(8) unsigned.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-------------</td>
<td>-----------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>printer</td>
<td>Name of the printer to which this user is assigned. Reports printed by this user, except those printed from the browser itself, are routed to the selected printer. Type = Varchar(8).</td>
</tr>
<tr>
<td>partition</td>
<td>Name of the partition to which this user is assigned. Partitions are logical groups of stations the user is allowed to access, for example, Fresh, WW, Reuse, or Stormwater. Main is the default if only one partition is configured. (Note: A user cannot be assigned to more than one partition. To grant an individual permission to more than one partition, configure a different user for each partition to which they should have access, for example, Joe1 has access to Partition 1 and Joe2 has access to Partition 2.) Type = Tinyint(3) unsigned.</td>
</tr>
<tr>
<td>control</td>
<td>Indicates if this user has permission to control hardware in the field via HT3 Type = Enum('No','Yes').</td>
</tr>
<tr>
<td>ack</td>
<td>Indicates if this user has permission to acknowledge alarms that occur in their assigned partition. Type = Enum('No','Yes').</td>
</tr>
<tr>
<td>shutdown</td>
<td>Indicates if this user has permission to shut down the HT3 system. Type = Enum ('No','Yes').</td>
</tr>
<tr>
<td>cfg_users</td>
<td>Indicates the user's level of permission for configuring users. No indicates that the user can not view or configure user information. View indicates user can only view user information. Yes indicates user has full access to user information. Type = Enum('No','View','Yes').</td>
</tr>
<tr>
<td>cfg_telemetry</td>
<td>Indicates the user's level of permission for configuring telemetry (drivers, partitions, stations, modules, points, alarms, and auto controls). No indicates that the user can not view or configure telemetry information. View indicates user can only view telemetry information. Yes indicates user has full access to telemetry information. Type = Enum('No','View','Yes').</td>
</tr>
<tr>
<td>cfg_virtual</td>
<td>Indicates the user's level of permission in Virtual Logic Builder. No indicates that the user can not access Virtual Logic Builder. View indicates user can only view ladder logic programs created in Virtual Logic Builder. Yes indicates user has full access to Virtual Logic Builder. Type = Enum('No','View','Yes').</td>
</tr>
<tr>
<td>cfg_controls</td>
<td>Indicates the user's level of permission for configuring scheduled controls. No indicates that the user can not view or configure scheduled controls. View indicates user can only view scheduled controls information. Yes indicates user has full access to scheduled controls information. Type = Enum('No','View','Yes').</td>
</tr>
<tr>
<td>cfg_screens</td>
<td>Indicates the user's level of permission in Screen Builder. No indicates that the user can not access Screen Builder. View indicates user can only view custom screens created in Screen Builder. Yes indicates user has full access to Screen Builder. Type = Enum('No','View','Yes').</td>
</tr>
<tr>
<td>cfg_voice</td>
<td>Indicates the user's level of permission for configuring the system for alarm call out and Hyper411 (call in) access. No indicates that the user can not access alarm call out and Hyper411 information. View indicates user can only view alarm call out and Hyper411 information. Yes indicates user has full access to alarm call out and Hyper411 information. Type = Enum('No','View','Yes').</td>
</tr>
</tbody>
</table>
Journal and Log Tables - Descriptions and Structure

Access Log (accesslog) Table Description

The accesslog table contains information on who accessed the HT3 system and what actions they took.

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description / Structure</th>
</tr>
</thead>
<tbody>
<tr>
<td>access_time</td>
<td>Date and time that user logged in to the system. Type = Datetime.</td>
</tr>
<tr>
<td>user</td>
<td>Login name of user. Type = Varchar(8).</td>
</tr>
<tr>
<td>action</td>
<td>Action taken by user. Type = Varchar(8). Valid entries are:</td>
</tr>
<tr>
<td></td>
<td>• shutdown - HT3 was shutdown by user</td>
</tr>
<tr>
<td></td>
<td>• startup - HT3 was started by user</td>
</tr>
<tr>
<td></td>
<td>• login - user logged into HT3</td>
</tr>
<tr>
<td></td>
<td>• logout - user logged out of HT3</td>
</tr>
<tr>
<td></td>
<td>• config - user made changes to HT3’s telemetry configuration</td>
</tr>
<tr>
<td>description</td>
<td>Provides additional information on actions taken by user. If action is shutdown, startup, login, or logout, the description field shows the terminal or IP address of the location where the action was initiated. If action is config, the description field gives a brief description of what configuration changes were made. Type = Varchar(30).</td>
</tr>
</tbody>
</table>

Alarm Log (alarmlog) Table Description

The alarmlog table contains information on alarms that have occurred and actions taken in response to them. Information includes time alarm occurred or action was taken, address of station, module, or point that experienced alarm, and action taken (for example, alarm was acknowledged).
<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description / Structure</th>
</tr>
</thead>
<tbody>
<tr>
<td>alarm_time</td>
<td>Date and time that alarm or alarm action occurred. Type = Datetime.</td>
</tr>
<tr>
<td>Address</td>
<td>Complete qualified address of the point (driver + station + module + point). For example 1014A1 for a point at Driver 1, Station 14, Module A, Point 1). Type = Varchar(12).</td>
</tr>
</tbody>
</table>
| action     | Value dependent on type of telemetry item - module, station, or point. Type = Varchar(7). For modules and stations, possible actions are:  
  - offline - module or station went offline  
  - online - module or station came online  
  - ack - alarm at module or station was acknowledged  
  - phone - system telephoned to alert that there was an alarm at the module or station  
  - snooze - alarm at module or station was still active after snooze time  
For points, possible actions are:  
  - alarm - point went into an alarm state  
  - clear - alarm at point cleared  
  - ack - alarm at point was acknowledged  
  - phone - system telephoned to alert that there was an alarm at the point  
  - snooze - alarm at point was still active after snooze time passed |
| source     | Provides additional information on the alarm's action. Type = Varchar(25).  
  - For action = offline, online, alarm, or clear, source is the value that caused or cleared the alarm [raw value for analog points, 1(one) or 0 (zero) for digital points].  
  - For action = ack, source is the login name of the user who acknowledged the alarm.  
  - For action = phone, source is the telephone number that the system called. |
| snum       | Station number of corresponding point. snum is 0 (zero) if the corresponding point is a virtual point. Type = Smallint(5) unsigned. |
mchar | Module letter of corresponding point. mchar is V if the corresponding point is a virtual point. mchar is . (period) if corresponding point is under a Modbus driver. Type = Char(1).

pnum | Point number of corresponding point. pnum is 0 (zero) if the corresponding point is a virtual point. Type = Mediumint(8) unsigned.

Comment Log (commentlog) Table Description

The commentlog table contains observations or explanations on subjects related to the system’s or utility’s operation. It provides a place for logging important information that doesn’t appear in any other tables. For example, a comment could explain that a particular station was undergoing repair and as a result a large number of alarms were being generated. Environmental conditions (for example, heavy rain) could be logged.

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description / Structure</th>
</tr>
</thead>
<tbody>
<tr>
<td>comment_time</td>
<td>Date and time that comment was created. Type = datetime.</td>
</tr>
<tr>
<td>user</td>
<td>Login name of user. Type = varchar(8).</td>
</tr>
<tr>
<td>comment</td>
<td>Text of comment. Type = varchar(255).</td>
</tr>
<tr>
<td>station</td>
<td>Station number associated with this comment. Type = int(5). Station number will be zero if no station was selected for the comment when it was created.</td>
</tr>
</tbody>
</table>

Control Log (controllog) Table Description

The controllog table contains information on all controls that were initiated. Information includes the time action was initiated, the address of the controlled point, the user who took the control action, and the result of the action (attempted, passed, failed).

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description / Structure</th>
</tr>
</thead>
<tbody>
<tr>
<td>control_time</td>
<td>Date and time that alarm occurred. Type = Datetime.</td>
</tr>
</tbody>
</table>
### Journal (journal) Table Description

Journals record changes in status. Each time a digital point’s value goes from 1 (one) to 0 (zero) or an analog point’s value changes, an entry is recorded in the journal table.

The system creates one journal per day. The name of journal tables following the following format: journal_YYYYMMDD. For example, journal_20100604 for a journal created on June 4, 2010.

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description / Structure</th>
</tr>
</thead>
<tbody>
<tr>
<td>journal_time</td>
<td>Time of day that the status event was logged. Type = Time.</td>
</tr>
<tr>
<td>address</td>
<td>Complete qualified address of the point (driver + station + module + point). For example 1014A1 for a point at Driver 1, Station 14, Module A, Point 1). Type = Varchar(12).</td>
</tr>
</tbody>
</table>
value | Status recorded for the given address at the time journal_time. Analog points are logged in engineering units; digital points are logged as 1 or 0. Type = float.

Radio Error Log (radioerrlog) Table Description

The radioerrlog contains information on radio errors that have occurred. Information includes time of error, station that experienced error, and a description of the error.

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description / Structure</th>
</tr>
</thead>
<tbody>
<tr>
<td>error_time</td>
<td>Date and time that error was recorded. Type = Datetime.</td>
</tr>
<tr>
<td>station</td>
<td>Station number of corresponding point. snum is 0 (zero) if the corresponding point is a virtual point. Type = Smallint(5) unsigned.</td>
</tr>
<tr>
<td>module</td>
<td>Module letter of corresponding point. mchar is V is the corresponding point is a virtual point. mchar is . (period) if corresponding point is under a Modbus driver. Type = Char(1).</td>
</tr>
<tr>
<td>type</td>
<td>Integer value that represents the type of radio error being reported. Type = Tinyint (3) unsigned.</td>
</tr>
<tr>
<td>description</td>
<td>Text description of radio error being reported. Type = Varchar(60). Possible entries are:</td>
</tr>
</tbody>
</table>

- 1 - No response.
- 2 - Abort response; did not receive a complete response
- 3 - Bad address format
- 4 - Bad message format
- 5 - Checksum or CRC error
- no response
- abort response
- bad address format
- bad message format
- checksum or crc error
Retrieving Data from HT3's Tables

All points in a HT3 system are available to ODBC requests. Once connected, you can retrieve the current status of a point or control a point. You can also view configuration information and journal and log entries.

Status Queries

You can query the status table to retrieve information such as the raw value, time stamp, and reliability or a point. You can use ODBC syntax to select multiple entries with wildcards and can also sort results using ORDER BY.

For example:

You would use the following ODBC syntax to retrieve the current value of point 127C4:

```sql
select value from status where address = '127C4'
```

You would use the following ODBC syntax to retrieve the current value of point 127C4 and check the raw value, time stamp, and reliability of the point:

```sql
select value, raw, stamp, reliability from status where address = '127C4'
```

Control Queries

Control points can be externally controlled using the rt_control table. In order to control a point using an external ODBC application, you must provide four arguments:

- Address of the point to control
- Value to which to set the point
- 'Y' to tell the system to control the point
- Valid HT3 login name with control permissions

External ODBC controls work exactly like local manual controls. If a valid login with permissions is not included in each control query, the control fails and an entry is recorded in the Control Log (controllog) with the code FPRM (failed permissions).

The controlled flag (in the rt_control table) tells the HT3 server that the control record should be processed. After processing, the system automatically clears the controlled field and the controlled_by field. This means that a subsequent control for that point will always require a controlled flag and a valid login in the control query.

Do not forget the "where" clause when performing controls or EVERY control point in the system will be controlled to that value. After the control is performed, the system clears the controlled flag (sets controlled equal to N) and sets the controlled_by field to NONE. Check the status table for confirmation after submitting a control request. When status.value equals control.setvalue, the control was completed.
During startup, all control points are entered into the MySQL control database and are available for external control except auto control points with the push set to "Y." These auto control points can not be externally controlled.

You would use the following ODBC syntax to set an analog set point at telemetry address '34G9' to 22.6:

```
update control set setvalue=22.6, controlled='Y',
controlled_by='MGR' where address = '34G9'
```

**External Status Queries**

Third party software can update status of HT3 external points by issuing update commands. ONLY the value field should be updated. The records are inserted into the rt_xstatus table upon startup. External points are configured using the Configuration Editor interface. See "Configuring External Points," below for further information. One record exists for every external point configured. The address and type fields should only be changed via the Configuration Editor. Once status is set via the rt_xstatus table, the rt_status table will be updated accordingly. Applications should retrieve status of these points via the rt_status table and any resulting alarms from the rt_alarm table.

You would use the following ODBC syntax to update the value of an external point with address(TAG) X34.10016 to 15.6.

```
update rt_xstatus set value = 15.6 where address = 'X34.10016';
```

You would use the following ODBC syntax to update the value of 'XMAIN_PUMP' to the 1 state. **Note:** External point addresses do not have to follow any format except that they must start with 'X' and be less than or equal to 12 characters.

```
update rt_xstatus set value = 1 where address = 'XMAIN_PUMP';
```